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Wprowadzenie

Dzi$ wszyscy jestesmy typografami. Kazdy wie (albo wydaje mu sie, ze wie),
co oznacza stowo font, a wigkszos¢ ludzi ma jaka$ opinie na temat fontéw, ktére
lubig i ktérych nie lubig. Typografia przestata by¢ tajemna sztuka uprawiana
przez mrukliwych ludzi o palcach poczernionych farba — jest raczej umiejetnos-
cig wykorzystywana na co dzien. Podejmujemy decyzje typograficzne kazdego
dnia — zaréwno wtedy, gdy decydujemy, ktéry kawatek zadrukowanego papieru
wolimy przeczyta¢, jak i wtedy, gdy sami tworzymy kolejna zadrukowana kartke,
a nawet wowczas, gdy w jakis sposéb reagujemy na ogladana wlaénie reklame —
$wiadomie lub nieswiadomie.

Ta demokratyzacja typografii jest powszechna; kazdy moze bra¢ w niej udziat.
Jednak aby dobrze w czyms$ uczestniczy¢, dobrze jest wiedzie¢ co nieco — wraz
z mozliwosciami przychodzi odpowiedzialnosé. Jeéli ktoé juz uzywa InDesigna
albo zaczyna go uzywaé, ma w reku perfekcyjne narzedzie do tworzenia ukta-
déw o dowolnej wielkosci i ztozonoéci. Warto pamietaé, ze koncepcje lezace
u podstaw programu nie pojawily sie wraz z jego pierwsza wersja w 1999 roku.
Sam InDesign jest jeszcze bardzo miodym tworem, ale zasady, na ktérych zostat
oparty, sa cze$cia wielkiej i dlugiej tradycji. InDesign jest kolejna, najnowsza, ale
na pewno nie ostatnig czescig ciggu rozwoju technicznego, siegajacego wstecz
do pietnastego wieku, gdy wynaleziono ruchome czcionki, w ktérym by¢ moze
najwigkszym skokiem bylo stworzenie jezyka PostScript w latach osiemdziesia-
tych minionego stulecia. Terminologia i konwencje typograficzne, wokét ktérych
zbudowano ten program, ewoluowaly przez pokolenia. Kroje pism dostepne
w menu fontéw — nawet te postmodernistyczne — sa blisko spokrewnione
z ksztaltami liter wyrytych na kolumnie Trajana blisko 2000 lat temu.

Kazdy nowy lub okazjonalny uzytkownik programu zapewne zadat sobie
cho¢ raz pytanie: po co s3 te wszystkie opcje i kontrolki? Czemu stuza i dla-
czego tu sie znalazly? A przede wszystkim najwazniejsze: jak powinienem ich
uzywac i dlaczego? Ta ksigzka stanowi prébe odpowiedzi na te pytania. Nie
jest to po prostu podrecznik uzytkowania InDesign. A poniewaz nie da sie
moéwic o funkcjach tego programu bez przedyskutowania historii typografii
i przedstawienia najlepszych (a niekiedy takze najgorszych) doswiadczen, jest
to réwniez ksigzka o tym, dlaczego pewne rozwiazania sprawdzaja sie lepiej
od innych.

Czegsto powtarza sie maksyme, ze dobra typografia jest ,niewidzialna” —
zamiast zwraca¢ uwage na siebie sama, typografia powinna stuzy¢ stowom,
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ktore przedstawia. Stanley Morison, ktéry w latach trzydziestych xx wieku
dat nam kréj Times (zaprojektowany dla The Times of London, cho¢ gazeta juz
go nie uzywa), powiedzial: ,Aby nowa czcionka odniosta sukces, musi by¢ tak
dobra, aby jedynie nieliczni rozpoznali jej nowatorstwo”.

Moze si¢ wiec zdawad, ze typografia jest zadaniem niewdzigcznym. Gdzie
uznanie? Stawa? Niewielu jest powszechnie znanych typograféw, a i ci zyja
w praktycznej anonimowosci. Tym niemniej typografia jest szlachetna dzie-
dzina. Jedlilitery sa cegtami i zaprawa komunikacji, wéwczas my, typografowie,
jestesmy architektami. Skromny i niepozorny budynek moze pozosta¢ nie-
zauwazony przez wielu, ale kazdy bez trudu zauwazy brzydki i niezgrabny.
Podobnie jest z typografia: dobre projekty spetniaja swoje cele i nie wywo-
tuja komentarzy, ale zla typografia na pewno zostanie zauwazona, cho¢ wielu
krytykéw nie bedzie umialo powiedzie¢, co jest zle. Ta ksigzka méwi tez, jak
unika¢ brzydkiego i nieprzemyslanego uktadania tekstu — wielki i niezbedny
krok w kierunku tworzenia pieknych rzeczy.

Kto powinien przeczytac te ksigzke?

Ksiazka zajmuje si¢ gléwnie typografia jezyka angielskiego — nie dlatego, ze jest
ona najwazniejsza, ale dlatego, ze te wlasnie znam. Koncentruje sie raczej

na publikacjach drukowanych, nie ekranowych, cho¢ wiele z przedstawionych

technik w réwnym stopniu dotyczy typografii stron Web. Wigkszoé¢ wskazéwek
i przykladéw dotyczy konwencji typograficznych stosowanych w czasopismach

i ksigzkach. Techniki oméwione w ksigzce maja poméc w tworzeniu stron

iukladéw zgodnych ze standardami typograficznymi poprzez stosowanie sie

do pewnego zestawu ,regul”. Moje podejscie jest raczej praktyczne, niz ekspe-
rymentalne. Reguly, ktére przedstawiam, nie maja na celu usztywniania ani

ograniczania kreatywnosci — nalezy je traktowac jako dobry punkt wyjécia.
Opanuj reguly. Pézniej, jesli zechcesz, mozesz je tama¢ — ale réb to §wiadomie,
wiedzac, dlaczego je tamiesz. Cokolwiek jednak uczynisz, nie ignoruyj ich.

Powinienem tez podkresli¢, ze cho¢ ksigzka zostata napisana z mysla o Adobe
InDesign ¢S5, wiekszo$é przedstawionych w niej technik i rozwigzan ma zasto-
sowanie takze we wczeéniejszych wersjach programu. Skréty klawiszowe dla
polecen programu podaje w wersjach dla komputeréw Macintosh i Windows
(zawsze w tej kolejnosci), na przyktad Cmd+Option+W/ Ctrl+Alt+W.

Mam nadzieje, ze InDesign i tekst stanie si¢ wazng i czesto przegladana
pozycja w bibliotekach Czytelnikéw. Z niecierpliwoscia czekam na Wasze opinie
i e-maile z komentarzami, poprawkami lub sugestiami.

— Nigel French
nigel@nigelfrench.com



RozpziAE 1

Zaczynamy

JESLI CHODZI O TEKST, zachowujemy sie nieraz jak dziecko w sklepie z zabaw-
kami. Nasze listy fontow sa rozbudowane i uwodzicielskie; zawieraja dorobek
setek lat historii pisma i odzwierciedlaja wktad najrozmaitszych kultur, ruchéw
artystycznych, ekscentrycznych osobnikdw czy systeméw komunikacji masowej.
Jednak majac tak wiele czcionek zaledwie o kliknigecie mysza, coraz czesciej

czujemy, Ze to bogactwo bardziej przyttacza nas niz inspiruje.
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Kroje pisma sq tym dla
pisanych stéw, czym
dialekty sq dla réznych
jezykoéw.

— Steven Heller

Typografia to dwuwy-
miarowa architektura,
oparta na do$wiad-
czeniu i wyobrazni,
ograniczana przez
regutly i czytelnosé.

- Hermann Zapf

Typografia to ukryte
narzedzie manipulacji
spolecznej.

- Neville Brody

Kazdy z nas poczut kiedys oniesmielenie dtugoscia listy fontéw dostepnych
na swoim komputerze. Kto$ podobny do mnie zapewne nie raz spedzit wieksza
czes¢ dnia, eksperymentujac z tym lub innym, kuszaco nazwanym krojem,
wybranym niemal losowo sposréd tysiecy osiagalnych, aby na koniec stwier-
dzi¢, ze rezultaty nie s3 satysfakcjonujace — choé tak naprawde nie umiejac
powiedzie¢ dlaczego. Mam nadzieje, ze dzieki tej ksiazce dni takie beda zda-
rzaly sie rzadziej.

Zanim jednak przejdziemy do praktycznych szczeg6téw zasad wybierania
czcionek i uzywania ich w InDesignie, musimy pozna¢ przynajmniej czeé¢ spo-
$réd podstawowych terminéw i konwencji typograficznych. Aby méc dobrze
zlozy¢ tekst, trzeba pamieta¢, ze InDesign jest zaledwie narzedziem i — cho¢
niewatpliwie jest to wspaniate narzedzie do tego celu — jego cala sita nie na wiele
sig zda, jesli nie zrozumiemy istoty naszego ,budulca”. Skuteczne korzystanie
z programu wymaga zrozumienia, jak czcionki dziatajg — a w tym celu musimy
cofnac sig do ich historii, poja¢, jak sa mierzone, klasyfikowane, a takze jakie
komunikaty moga przekaza¢ odbiorcom. No i, co oczywiste, musimy swobodnie
poruszac sig¢ w interfejsie programu. W szczegélnosci za§ musimy wiedzie¢,
gdzie znalez¢ dotyczace czcionek narzedzia i preferencje, jak ptynnie porusza¢
sig¢ po dokumentach i jak zaplanowac¢ i zastosowa¢ skuteczna technike pracy
z tekstem.

Kroje pisma mogg nieé¢ z sobg — intencjonalnie lub nie — symbolike i zna-
czenia. We wspaniatym filmie dokumentalnym Gary’ego Hustwita Helvetica
(2007) graficzka Paula Scher méwi o swoich negatywnych skojarzeniach z naj-
bardziej wszgdobylskim krojem na $wiecie, nazywajac go ,fontem korporacyjnej
Ameryki”. Przez zaciénigte zgby przedstawia Helvetike jako font wojny wiet-
namskiej i obu wojen w Zatoce. Z drugiej strony, w innej czesci filmu jedna
z najjaéniej blyszczacych gwiazd typografii wychwala pigkno i ponadczasowos¢
tego kroju. Czcionki dziela ludzi.

Pozostajac przy Helvetice, czy jej réwnie rozpowszechnionym klonie Arialu
jako przykladzie, ktos moglby stwierdzi¢, ze ich stosowanie stato sie wrecz

»naturalne”, gdyz spotykamy je wszedzie jako ,domyslne” — wybér, ktéry wisto-
cie nie wymaga zadnego $wiadomego wyboru. Jednak nie tylko Helvetica niesie
z soba taki kulturowy bagaz. Kazdy, kto spedzit wigcej niz kilka godzin pracu-
jac z czcionkami, wyksztalcil sobie poglad, dlaczego lubi lub nienawidzi tego
lub innego kroju — i bardzo czesto nie ma w tym zadnej ,winy” samego fontu.
Wezmy ekstremalny przyktad: Fette Fraktur dla wielu kojarzy sie z nazizmem,
cho¢ bardzo podobne kroje typu Blackletter czy Fraktur byly uzywane przez
setki lat, zanim narodowi socjalisci wybrali te czcionke jako swéj $rodek wyrazu.
Inne kroje, niegdys modne, moglty wpas¢ w putapke konkretnego okresu
historycznego — doskonale, jesli chcemy wywota¢ skojarzenia z dang era, ale
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zgrzytajace, jesli umie$cimy je w odmiennym kontekscie. Niektére kroje zostaty
nadmiernie wyeksploatowane przez agresywne kampanie reklamowe i nic nie

mozemy poradzié, ze kojarza sie z okreslonym produktem. Inne — jak przebéj

zbyt czesto nadawany w radiu — z atrakcyjnego ,smaczku” przemienily sie w co$

irytujacego, jak zgrzytanie po szybie. Co wigcej, na §wiecie jest wielu purytan-
skich typografow, ktérzy nie beda mogli sie powstrzymac przed wytknigciem

niewlasciwosci historycznej uzycia bezszeryfowego kroju English z péznych

lat dwudziestych w ksigzce o rosyjskiej sztuce wczesnych lat dwudziestych.

Jesli nawet przesadzam, to nie az tak bardzo. W rzeczywistosci nie jestesmy
w stanie przewidzie¢, jak czytelnicy zareaguja na dokonany przez nas wybér
kroju, a im $mielsze beda nasze wybory, tym wigksza szansa, ze kogo$ ziry-
tujemy. Dlatego tez warto uzbroi¢ sie w solidna wiedze o historii typografii,
dobre rozumienie krojéw, ktérych uzywamy najczesciej, a przede wszystkim
miec¢ swiadomos¢ konotacji, jakie niektére kroje niosa ze soba. Bibliografia
na koncu ksigzki zawiera wiele doskonatych zrédet, z ktérych mozna nauczyé
sie wiecej na temat czcionek.

Moje osobiste upodobania estetyczne w dziedzinie czcionek s3 minimali-
styczne, cho¢ by¢ moze kto$ mégtby nazwac to lenistwem: skoro mniej znaczy
lepiej, by¢ moze dam sobie rade znajac mniej krojéw pisma. Jakby jednak nie
patrze(, lepsza rzecza jest zna¢ i rozumieé dobrze kilka krojéw, niz mie¢ liste

fontéw diuga na kilometr i jedynie powierzchownie zna¢ kroje, ktére sie na niej
znajduja.

Typografia jest tym,
co nadaje wyglgd
jezykowi.

— Ellen Lupton

Obecnie istnieje réwnie
wiele odmian liter, jak
rodzajow glupcow.

- Eric Gill

RYSUNEK 1.3 ,Uklad okre-
sowy czcionek” - plakat
dostepny na stronie www.
squidspot.com
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Kreska pionowa
(trzon)

RYSUNEK 1.1 Elementy skladowe
litery:

Kreska pionowa (trzon): inaczej
kreska gtéwna, pionowa, mniej
wigcej prosta czec litery, takiej jak
kczyD.

Wydtuzenie dolne: czes¢ malej
litery, takiej jak g, j, p lub g, siegajaca
ponizej linii bazowej,

Nachylenie osi: kierunek wy-
Znaczany przez zmiany grubosci
zakrzywionych linii (od grubych

do cienkich), (kierunek pochylenia
pidra).

Oko: inaczej punca, wewnetrzna
«pusta” przestrzen litery. A, a, B, b, D,
d, e, g, O, 0 - wszystkie te litery (i nie
tylko te) maja oka (nie nalezy myli¢
z oczkiem, ktorym to terminem
okresla sie kompletny ksztatt litery).
Brzuszek: zaokraglona czeéc litery.
Wydluzenie gérne: czes¢ malej
litery, takiej jak b, d, f, h czy k, ktéra
wystaje ponad srodkowa linie pisma
(wysokos¢ x).

Wysokos¢ wersalikéw: wysokosé
wielkich (nieakcentowanych) liter.
Linia srednia pisma: inaczej me-
diana, wyimaginowana linia na wy-
sokosci litery x, w ktorej mieszczg sie
gtéwne czesci matych liter.

Linia bazowa: wyimaginowana
linia, na ktorej,stoja” litery.
Wysokos¢ x: wysokosé giéwnej
czesci matych liter. Litera x zostata
wybrana jako reprezentant, gdyz jej
kreski zwykle dotykaja, ale nie prze-
kraczajq tej wysokosci.

Wydtuzenia dolne

Oko

Linia wersalikéw

Linia $rednia pisma
(mediana)

Linia bazowa

Brzuszek

Wybér kroju pisma moze wzmocni¢ (lub ostabi¢) znaczenie tekstu, nad
ktérym pracujemy. Ma takze zwiazek ze spelnieniem oczekiwan i dopasowa-
niem si¢ do gustéw naszych odbiorcéw. W éwiecie doskonatym mieliby$my
czas na dokladng lekture i analize tekstéw, ktére otrzymujemy jako surowy
material. W praktyce, zaleznie od dtugosci opracowywanych dokumentéw,
moze si¢ to okazac trudne lub wrecz niemozliwe, ale zawsze powinnismy
przynajmniej mie¢ orientacje co do zamierzonego charakteru przekazu.

Anatomia i klasyfikacja czcionek

Aby méc ze zrozumieniem rozmawia¢ o czcionkach?’, musimy najpierw
ustali¢ wspélny stownik. Rysunek 1.1 w uproszczeniu przedstawia elementy
konstrukcyjne liter.

Typografia jest nieuniknienie dziedzina pedantyczna i w wielkim stopniu
zalezy od drobnych detali. Wyjasnijmy zatem niektére terminy, ktérych
bedziemy czesto uzywac. Krdj pisma (typeface) to kompletny alfabet, zawie-
rajacy litery, cyfry, znaki przestankowe i akcenty, w réznych odmianach
wagowych i wielkosciach®. Czcionka to okreslona odmiana i wielkos¢ tego
kroju. Na przyktad Adobe Garamond Pro to kréj pisma. Adobe Garamond
Pro Regular 10 pt to czcionka. Terminy te czesto uzywane s3 zamiennie,

1 Angielskie stowo type jest nader wieloznaczne — zaleznie od kontekstu jego
odpowiednikiem moze byé tekst, pismo, czcionka (w sensie zbioru znakow), ale tez
czcionka (w znaczeniu pojedynczej, metalowej litery). Purysta zapewne zaprote-
stuje przeciw uzyciu stowa czcionka w znaczeniu elektronicznie opisanego zbioru
znakéw, ale uzywam tego wyrazu, gdyz takie znaczenie juz sie rozpowszechnito,
a ponadto nie ma lepszego odpowiednika (wszystkie przypisy pochodza od
ttumacza).

2 Czgsto mozna tez spotkac stowo ,pismo” w znaczeniu ,kréj pisma” — takze w tej
ksigzce niekiedy uzywam go zamiennie.

_ Linia wydtuzeri gérnych

- Linia wydtuzen dolnych
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TTrTT

Szeryfowy Bezszeryfowy Szeryfy klinowe Szeryfy proste Szeryfy wlosowe
Adobe Garamond Pro Myriad Pro Hoefler Text Chaparral Pro Bauer Bodoni
ale typografowie kochaja dzieli¢ wlos na czworo i ja nie stanowie tu wyjatku.  RYSUNEK 1.2 Réznica

pomiedzy czcionkami sze-
ryfowymi i bezszeryfowymi
wszystkie rozmiary w jednym pliku, nazywanym fontem. Stad stowo to staje oraz przyklady réznych typéw
szeryfow

Dodatkowym utrudnieniem jest fakt, ze elektroniczne wersje pism zawieraja

si¢ synonimem czcionki, ale nie kroju, gdyz nadal r6zne odmiany wagowe lub
szerokosciowe kroju umieszczane s3 w réznych plikach (fontach).

Podstawowe rozréznienie, jakie mozemy zastosowa¢ dla poszczegélnych
krojow pisma, to podzial na kroje szeryfowe (serif) i bezszeryfowe (sans serif).
Wiekszos¢ istniejacych czcionek wpada w jedna lub druga z tych kategorii.

Szeryfy to te male ,haczyki” na konicach kresek tworzacych litere. Kroje
bezszeryfowe ich nie maja (sans oznacza ,bez” w jezyku francuskim).

Po ustaleniu tego podstawowego podziatu sprébujmy pogtebi¢ nasza kla-
syfikacje. Nie istnieje zaden ogélnie uznawany standard klasyfikowania
czcionek — zamiast tego istnieje wiele naktadajacych sie wzajemnie specyfikaciji.
W tej ksigzce bede sie postugiwal uproszczonga klasyfikacja Adobe, prezentujac
przyktady krojéw z kazdej kategorii.

Classical
Renesansowe (Venetian Oldstyle) H I STORY

Nazwa angielska tej grupy czcionek wynika z faktu, ze s3 one oparte na krojach B enaissance

Zywan owi CQ.UtY
w XIV i XV wieku, Cechy wyrézniajace to: T
= Pochyle przekreélenie w malej literze e RU S T

®  0Os$ nachylona pod katem odpowiadajacym kresleniu liter szeroko écietym

pochylonym piérem (nieznacznie pochylona w lewo) u]_ et

= Niewielki kontrast pomiedzy cienkimi a grubymi kreskami
® Przyklady: Adobe Jenson, Berkeley Oldstyle, Centaur

liter uzywanych przez skrybéw i wezesnych typograféw z pétnocnych Wioch

RYSUNEK 1.4 Wczesna anty-
kwa renesansowa



Understanding
Venerable

FORMALcalm
Magnificent

ersatile
graceful

RYSUNEK 1.5 Kroje
poZnorenesansowe

7
A

oumal
=

RYSUNEK 1.6 Pisanki

Confident

Strong C 001
Levelheaded

. Senous

rational

UNDERSTATED

RYSUNEK 1.7 Antykwa
barokowa
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Péznorenesansowe (Garalde Oldstyle)

Kroje te powstaly w okresie péznego Renesansu i obejmuja niektére sposréd

najlepszych krojéw uzywanych do dzis. Angielska nazwa pochodzi od dwéch

wielkich typograféw tego okresu — Garamonda i Aldusa. Ich cechy wyréznia-
jace to:

® Poziome przekreslenie w malej literze e

® Nieco wigkszy kontrast pomigdzy cienkimi i grubymi liniami niz w kro-
jach wczesnorenesansowych

® Wigksze nachylenie osi pisma (w lewo)

® Gladkie szeryfy

= Przyklady: Adobe Garamond, Bembo, Minion Pro

Pisanki (Script)

Kroje tego typu nasladuja pismo reczne, zatem litery w nich sa laczone ze sobg.
Z tego wzgledu pisma takie wymagaja szczegélnej uwagi przy dobieraniu ker-
ningdéw i nigdy nie powinno si¢ w nich sktada¢ tekstu samymi wersalikami.
Patrzac historycznie, ,osobista” natura recznego pisma stoi w sprzecznosci

z koncepcja czcionek i pisma cyfrowego. W pismie recznym, ktére te kroje

maja nasladowa¢, zadne dwie litery a nie beda dokladnie takie same, ale gdy
uzyjemy fontu, to wiaénie bed. Od niedawna jednak pojawily sie mozliwosci

techniczne ominigcia tego problemu, a w raz z nimi pewna liczba przepieknych

krojéw zawierajacych wielka liczbe alternatywnych gliféw dla poszczegélnych

kombinacji liter, co pozwala na stworzenie unikatowych i osobistych napiséw.
Wigcej informacji zawiera rozdziat 6, ,Drobne (ale wazne) szczegéty”.

® Przyklady: Bickham Script Pro, Champion Script Pro, Raniscript

Antykwa barokowa (Transitional)

Kolejnym ruchem, oddalajacym czcionki od ksztattu liter pisanych recznie,
byto powstanie pierwszych krojéw, ktére narysowano od razu jako wzory
do odbicia na papierze. Stanowily one zatem przejécie (ang. transition) pomie-
dzy krojami renesansowymi a krojami modernistycznymi, ktére pojawity sie
pozniej, i mozna w nich zauwazy¢ cechy wspélne dla obu kategorii. Cechy
wyrdzniajace to:

® Pionowa lub prawie pionowa o$ pisma

® Poglebiony kontrast pomigdzy cienkimi i gléwnymi liniami
® Szeryfy sj cienkie, plaskie i wygladzone

Przyklady: Baskerville, Perpetua, Stone Serif
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Antykwa klasycystyczna (Modern, Didone)

Nazwa angielska pochodzi od nazwisk Firmina Didota (1764-1836) i Giam-
battisty Bodoniego (1740-1813). Kroje te stanowily reakcje na usprawnienia
w technologii produkcji papieru, druku i introligatorstwa, ktére pojawily sie
pod koniec xvii1 wieku. Postep ten pozwolit zaprojektowaé pisma, w ktérych
wystepowaly silne pionowe akcenty i cienkie linie wlosowe. Cechy wyréznia-

jace to:

® Duzy kontrast pomiedzy grubymi i cienkimi liniami

®= Pionowa o$

®  Mechanistyczny” wyglad — litery sa raczej konstruowane niz
rysowane

® Bardzo cienkie, ,wlosowe” szeryfy

Przyklady: Bodoni, Didot, Fenice

Egipcjanki (Slab Serif)

Do konca xvii1 wieku podstawowym przeznaczeniem czcionek byty ksigzki.
Jednak wraz z rewolucja przemystowa pojawily sie nowe zastosowania
druku — plakaty, ogloszenia i inne formy reklamy, ktére potrzebowaly bardziej
krzykliwych, rzucajacych sie w oczy krojow, ktére zapewnityby sukces w ostrej
rywalizacji. Nazwa ,egipcjanki” pochodzi od powszechnego entuzjazmu, jaki
w owym czasie wzbudzaty odkrycia archeologiczne. Cechy wyrézniajace to:

® Ciezkie, ,kwadratowe” szeryfy

® Stosunkowo réwnomierne grubosci kresek

® Solidnosé

® Przyklady: Clarendon, Memphis, Chaparral Pro

Kroje bezszeryfowe (Sans Serif)

William Caslon 1v (prapraprawnuk ,pierwszego” Williama Caslona) zaprojek-
towal swoj pierwszy bezszeryfowy kréj juz w 1816 roku, ale dopiero w koricu
X1X wieku kroje takie zaczely by¢ powszechnie uzywane.

Kategorie te mozna podzieli¢ na: groteski (na przyklad Helvetica), o sto-
sunkowo jednolitej grubosci linii, zwracajace uwage ,neutralnym” wygladem;
kroje geometryczne (Futura), w ktérych ksztalty liter budowane sa z figur
geometrycznych (lub prawie), a kreski maja stala grubos¢; oraz humanistyczne
(Gill Sans), w ktérych ksztalty liter sa wzorowane na tradycyjnych proporcjach,

za$ grubosci kresek sa modulowane.

= Przyklady: Futura, Helvetica, Gill Sans

Pse]gf},lme
Stylish 44,

Reserve{i
GLAMOUR

Refined o

Expensive

RYSUNEK 1.8 Antykwa
klasycystyczna

Victorian
SOLID egyptian
Optimism
Persuasion

Industrial

RYSUNEK 1.9 Egipcjanki

PROGRESSIVE
o Unadorned

simple

€ minimalist
o

Neutral "o
£ PUres
O Architect

RYSUNEK 1.10 Kroje
bezszeryfowe

porary

te



FILM SHOW
ERREATEST

Charisma

IMPAC+HFUL
Personality

RYSUNEK 1.11 Kroje
dekoracyjne

Wianuscript
Avbey Wietal
Demon News
Head banger

Biere

RYSUNEK 1.12 Kroje
gotyckie

Retro

Typewriter
Bank Charges
Low-F1
Machine
Default

RYSUNEK 1.13 Kroje
statopozycyjne
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Dekoracyjne

Ta kategoria to ,ogélny worek” dla tych krojéw, ktérych podstawowym zada-
niem jest przykucie uwagi czytelnika. Najbardziej efektywne, gdy s3 uzywane

w wielkich stopniach jako nagléwki, tytuly czy wykrzykniki. Poniewaz s3 tak

ekspresyjne i maja sktonnos¢ do odzwierciedlania biezacej mody, zwykle dosé¢

krétko pozostaja w uzyciu.

® Przyklady: Arnold Bocklin, Rosewood, Industria

Gotyckie (Blackletter)

Angielska nazwa wynika z faktu, ze kroje te wydaja sie wyjatkowo ,czarne”
na zadrukowanej stronie. Mozna tez spotka¢ okreslenie ,Old English”, za$
w Niemczech kategoria ta nosi nazwe Fraktur. Ich uzycie moze sugerowac
fakt, ze czasopismo jest konserwatywne i oparte na autorytetach. Zdarzylo
si¢ jednak, ze Fette Fraktur, kréj zaprojektowany w potowie XI1x wieku, miat
to nieszczeicie, ze zostal przyjety jako podstawowy kréj przez NSDAP (w opo-
zycji do ,nie-niemieckich” krojéw bezszeryfowych faworyzowanych wéwczas
przez Bauhaus i inne radykalne ruchy artystyczne tego okresu). Co interesujace,
Trzecia Rzesza przestala stosowac kroje tego typu w 1941 roku, gdy wyszly
na jaw zydowskie wptywy w projektach tych czcionek, ale nadal trudno jest
patrzec na takie pisma bez negatywnych skojarzen.

® Przyklady: Fette Fraktur, Goudy Text, Lucida Blackletter

Statopozycyjne (Monospaced)

Niemal we wszystkich krojach pisma odstepy pomiedzy literami sa propor-
cjonalne do ich wizualnej szerokosci. Kroje stalopozycyjne jednak zapewniaja

te sama szeroko$¢ dla kazdego znaku. Sa niekiedy wykorzystywane do skladania

tekstéw w formularzach, gdy wymagana jest okreslona pozycja poszczegol-
nych znakéw, badz do odrézniania wierszy kodu komputerowego od tekstu

podrecznika (jakkolwiek istnieja tez podobnie ,technicznie wygladajace” kroje

proporcjonalne, jak Letter Gothic). Courier jest réwniez uzywany do zasygna-
lizowania braku konkretnego fontu. Dla przyktadu — InDesign zazwyczaj jest

w stanie zasymulowac wyglad brakujacego fontu na ekranie, ale nie moze tego

samego dokona¢ podczas drukowania. Wydruk dokumentu, ktéry odwotuje

si¢ do niedostgpnych fontéw, powoduje uzycie czcionki Courier w tym miejscu.
Konwencja ta zostala zaakceptowana przez wszystkie aplikacje do sktadu tekstu,
gdyz Courier wyglada tak ,niewltasciwie”, ze nie mozna tego przeoczy¢ i uzyt-
kownik po prostu poczuje si¢ zmuszony do poprawienia tego stanu rzeczy.

® Courier, OCR A, Letter Gothic



Ornamenty

Fonty tego typu zawieraja elementy dekoracyjne, ktérych mozna uzy¢ w celu
uatrakcyjnienia dokumentéw. Niektére fonty Open Type zawieraja znaki orna-
mentowe jako czes¢ ich rozszerzonego zestawu znakéw.

® Przyklady: Minion Pro Ornaments, Adobe Caslon Ornaments, Wood
Type Ornaments

Symbole, ,dingbat” lub Pi

Oprocz ,zwyklych” pism istnieje réwnolegty wszechswiat krojéw, ktére nie
zawieraja liter, lecz piktogramy. Takie obrazkowe fonty moga by¢ zaréwno
zabawne, jak i praktyczne, udostepniajac takie przydatne znaki, jak punk-
tory, ,dymki”, znaczniki, gwiazdki lub strzatki. Rozszerzaja zakres dostepnych
znakéw, pomagajgc w tworzeniu zapisu nutowego, map, wzoréw matematycz-
nych i wwielu innych, najbardziej réznorodnych zastosowaniach. David Carson,
enfant terrible typografii z lat dziewieédziesiatych minionego stulecia, zastynat
skladajac artykut — wywiad z Bryanem Ferry — dla magazynu Raygun uzywa-
jac wylacznie fontu Zapf Dingbats. ,To nie jest warte czytania — dlaczego nie
zrobi¢ tego w Zapf Dingbats?”

® Przyklady: Symbol, Zapf Dingbats, Carta

Dlaczego niektére fonty wygladaja na wieksze od innych?

Jesli wybierzemy kilka réznych krojéw i nadamy im ten sam stopien w punk-
tach, odkryjemy, ze niektére sa wigksze od innych. Jest to spadek po czasach,
gdy w uzyciu byty metalowe czcionki. Wielkoéé wyrazona w punktach odnosi
si¢ bowiem do rozmiaru metalowego klocka, ktéry byt nosnikiem litery.
Niektére kroje zajmowaly wieksza czeéé tego klocka, niz inne. Dzi$ wymiar
w punktach nie odwotuje sie juz do rozmiaréw metalowej czcionki, ale jego
cyfrowego réwnowaznika: obramowujacego prostokata, otaczajacego kazda
litere. Mierzymy przestrzen, wewnatrz ktérej ,zyje” znak, a nie same litery.
Podobnie jak w czasach metalu, niektére kroje zajmuja wigksza czesé tego wyi-
maginowanego prostokata, niz inne, a tym samym przy identycznym stopniu
wydaja si¢ wigksze. Dlatego tez nigdy nie nalezy zdawac¢ si¢ na same liczby,
ale zaufaé wlasnym oczom.

Tu uwaga, ktéra moze wyda¢ sie oczywista, ale ktéra warto przypomnie¢:
trudno jest dokladnie ocenié¢ wielkos¢ (i inne aspekty) uzytego kroju tylko
na ekranie. O ile tworzony dokument nie jest przeznaczony jedynie do uzytku
ekranowego, zawsze lepiej wykona¢ prébny wydruk, niz zdawac sig tylko na to,
co widaé na monitorze.

Rozdziat 1 Zaczynamy ‘ 9
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RYSUNEK 1.16 Metalowa
czcionka. Wielko$¢ w punktach
dotyczy pionowego wymiaru
catego klocka’, a nie rozmia-
row oczka litery (glifu).
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RYSUNEK 1.17 Ten sam tekst
zlozony tym samym stopniem
z tg samg interlinia, ale roz-
nymi fontami, demonstruje,
ze niektdre fonty s wieksze”
od innych.

RYSUNEK 1.18 Wybor réz-
nych ,Garamondoéw’, wszystkie
w wielkosci 30 punktdw, oraz
demonstracja réznic w wygla-
dzie jednego znaku.

Myriad Pro 9/1

Gdy Gregor Samsa obudzit sie pewnego
rana z niespokojnych snéw, stwierdzit,
Ze zmienit sie w t6zku w potwornego
robaka. Lezat na grzbiecie twardym jak
pancerz, a kiedy uni6st nieco gtowe,
widziat swoj sklepiony, brazowy, po-
dzielony sztywnymi tukami brzuch, na
ktérym ledwo mogta utrzymac sie cat-
kiem juz zedlizgujaca sie kotdra. Liczne,
w poréwnaniu z dawnymi rozmiarami,
zatosnie cienkie nogi migaty mu bezrad-
nie przed oczami.

Adobe Caslon Pro 9/1

Gdy Gregor Samsa obudzil si¢ pewnego
rana z niespokojnych snéw, stwierdzit, ze
zmienil si¢ w 16zku w potwornego robaka.
Lezal na grzbiecie twardym jak pancerz,
a kiedy uniést nieco glowe, widzial swéj
sklepiony, brazowy, podzielony sztywnymi
tukami brzuch, na ktérym ledwo mogta
utrzymac¢ si¢ caltkiem juz zeslizgujaca si¢
koldra. Liczne, w poréwnaniu z dawnymi
rozmiarami, Zalosnie cienkie nogi migaly
mu bezradnie przed oczami.

Co kryje sie pod nazwg?

Wiele nazw krojéw pisma nalezy do przestrzeni publicznej, zas wiele sposréd

samych pism, ktérych uzywamy, stanowi odrodzone lub nowo zinterpretowane

kopie starych oryginaléow. Kazdy, kto dysponuje oprogramowaniem do two-

rzenia fontéw, moze stworzyc¢ nowy krdj i nazwac go ,Garamond” — samo to,

ze co$ nazywa si¢ Garamondem, nie znaczy, ze bedzie on podobny do czegos,

co ktoé inny nazwal Garamondem. Realizacje krojéw moga sie znacznie réznié

pomiedzy soba, podobnie jak rézne interpretacje tej samej piosenki — czesto

tatwiej jest uchwycié réznice, niz podobieristwa pomiedzy poszczegdlnymi

wersjami! Dlatego trzeba zawsze jednoznacznie okresli¢, ktérego Garamonda

zamierzamy uzy¢ i ktéry producent go dostarczyl.

uncopywritable

Adobe Garamond Pro

uncopywritable

ITC Garamond

uncopywritable dddaa

Simoncini Garamond

uncopywritable

Garamond

uncopywritable

Stempel Garamond



Mapa InDesign: gdzie znalez¢ opcje czcionek?
Niemal wszystko, co znajdziemy w InDesignie, dotyczy czcionek w jakims$
stopniu, ale w tym miejscu chcialbym skoncentrowaé sie na najczeéciej uzywa-
nych menu i opcjach zwigzanych z pismem. Przedstawie réwniez preferencje
programu, ktére maja wplyw na zachowanie czcionek. Podobnie jak w wielu
innych zaawansowanych aplikacjach projektowych, zazwyczaj istnieje wiecej niz
jedna droga osiaggniecia jakiegos celu. Niekiedy jest to tylko kwestia wtasnych
przyzwyczajen lub wygody. W innych przypadkach pojawily si¢ nowe funkgje,
ktére usprawniaja dotychczasowe, jednak w celu unikniecia nieporozumien
i alienacji starych weteranéw dotychczasowe opcje menu nadal s3 dostepne.
Kazdy z nas pracuje inaczej, a InDesign wrecz zacheca do dopasowania go
do wlasnych upodobar.

Istnieje kilka opcji preferencji dotyczacych czcionek. Na razie chce jedynie
wskazaé, gdzie je mozna znalez¢ i zasugerowa¢ kilka zmian w domyélnych
ustawieniach fabrycznych. Kazda z tych opcji zajme sie bardziej szczegétowo
pdzniej, w odpowiednich rozdziatach.

Dokonujac zmian w preferencjach InDesigna, trzeba mie¢ na uwadze, ze maja
one wplyw jedynie na aktualnie otwarty dokument. Jeéli chcemy, aby zmiany
te miaty wplyw na wszystkie nowe dokumenty, ktére utworzymy pézniej, nalezy
je wykonad bez zadnego otwartego dokumentu — w takiej sytuacji staja sie

one standardowymi ustawieniami aplikacji. Spoéréd opcji dotyczacych pisma
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RYSUNEK 1.19 Karta Jed-
nostki i skoki okna dialogo-
wego Preferences.

(A) Ruler Units (Jednostki
miarki) (obramowane):
Punkty sa standardem
typograficznym. Czyz nie
tatwiej jest okresli¢ wciecie
jako 12 pt (lub 1 pica), a nie
4,233 milimetra?

Keyboard Increments (Skoki
klawiatury) (obramowane):
Stopien i interlinia moga by¢
zwiekszane badz zmniejszane
skrotami klawiszowymi. Mniej-
szy skok zapewnia wiekszg
kontrole, szczegdlnie podczas
wymiarowania drobnego
tekstu. Przytrzymanie klawisza
Option/Alt podczas wymiaro-
wania powoduje pieciokrotnie
wiekszy skok wartosci od zde-
finiowanego w tym miejscu.
Baseline Shift (Przesunie-
cie linii bazowej): Skrot
klawiszowy zmieniajacy
potozenie linii bazowej

to Shift+Option / Alt+strzatka
(w gore lub w dot). Nie jest

to wprawdzie opcja, ktorej
czesto bedziemy uzywac, ale
domyéina wartosc 2 pt jest

na pewno zbyt duza.
Kerning/Tracking
(Kerning / swiatlo): Ta war-
tosc okresla skok uzywany
przy recznym ustawianiu
Swiatet za pomoca klawiatury:
Option/ Alt+strzatka w lewo
zmniejsza swiatto pomiedzy
zaznaczonymi literami, za$
Option / Alt+strzatka w prawo
- zwigksza. Dla bardziej precy-
zyjnej (czytaj: lepszej) kontroli
nalezy zmienic te wartosc

na najmniejsza dostepna war-
tos¢, czyli1/1000 firetu (em).
Jedli potrzebny bedzie wiekszy
skok, mozna uzy¢ klawisza
Cmd/ Ctrl, powodujacy skok

o pieciokrotng wartosc.
Globalny system miar mozna
szybko zmieni¢ z menu pod-
recznego, wyskakujgcego

po kliknieciu prawym klawi-
szem myszy skrzyzowania obu
linijek (B).
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WSKAZOWKA: Bez
wzgledu na wybrany system
miar, we wszystkich polach
numerycznych okien dialo-
gowych i palet InDesigna
mozna zawsze wprowadzic¢
wielkosci w innych jednost-
kach, podajac je jawnie.
Jedli na przyktad uzywamy
punktow jako podstawowej
jednostki, ale chcemy nadac
ramce ksztatt kwadratu

o boku s0 mm, wystarczy
zaznaczyc te ramke i wpisac
50 mm w polach wysokosci

i szerokosci palety steruja-
cej. InDesign automatycznie
przeliczy te wartosc na jej
rownowarto$¢ w punktach.

RYSUNEK 1.20 Trzy zrzuty
ekranowe z FontLab Studio,
programu do projektowania
czcionek, pokazujace rézne
szerokosci znakéw wewnatrz
firetowego kwadratu.

(w mniejszym lub wiekszym stopniu), nastepujace stajg sie domyslne dla wszyst-
kich nowych dokumentéw, jesli zostana ustawione bez zadnego otwartego
dokumentu: General (Ogélne), Interface (Interfejs), Type (Tekst), Advanced Type
(Tekst zaawansowany), Composition (Skiad), Units & Increments (Jednostki i skoki),
Grids (Siatki) oraz Guides & Pasteboard (Linie pomocnicze i stét montazowy).
Jezeli chcemy powaznie podchodzi¢ do naszej pracy z tekstem, sugeruje, aby
przyzwyczaic si¢ do pracy w punktach (albo w pica, dla ktérych punkty s3 jed-
nostka podrzedna). Punkt jest typograficzng jednostka miary, ktéra wywodzi sie
z poczatkéw XVIII wieku. Sg tajemnicze i niedziesietne, ale istnieje co najmniej
jeden powéd, aby ich uzywaé. Jako ze wielkosci czcionek nader rzadko wyra-
zane s3 w czymkolwiek innym, niz w punktach, wygodnie jest okresla¢ w nich
odlegtosci dotyczace tekstu, takie jak interlinia (odlegto$¢ pomiedzy wierszami
tekstu), wcigcia, odstepy pomiedzy akapitami czy miedzy tamami. W Stanach
Zjednoczonych wielkosci margineséw i szerokosci taméw zazwyczaj okresla sie

w pica; w Europie wymiary te czesciej s3 podawane w milimetrach.

Pica i punkty w pigutce

6 pica =1cal = 25,4 mm

12 punktéw =1 pica

72 punkty = 1 cal

1 picai 6 punktéw = 1p6; alternatywnie wielkos¢ te mozna wyrazi¢ jako op18
lub 18 pt

6 punktéw = op6, p6 lub 6 pt

Typografia dysponuje ponadto jednostkami wzglednymi. Dwie najczesciej spo-
tykane to firet (em) — wielko$¢ réwna biezacemu stopniowi pisma, tak wiec dla
tekstu 10-punktowego firet bedzie réwny 10 punktom — oraz pétfiret (en), sta-
nowiacy, jak sig tatwo domysli¢, potowe firetu. Inng czesto uzywana jednostka
jest tysigczna (1/1000 firetu), uzywana przy okreslaniu wiatet miedzyliterowych
i kerningu. Aby lepiej zrozumie¢ sens tej jednostki, warto wiedzie¢, ze kazdy
znak kroju pisma jest projektowany wewnatrz kwadratu o boku jednego firetu,

S ——— — N ———
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podzielonego na tysieczne. Wlaéciwy znak zajmuje okreslong szerokos¢ (set
width), stosownie do jego ksztaltu, na przyklad litera m bedzie niewatpliwie
szersza, niz i. Najszerszym znakiem w calym kroju bedzie zazwyczaj kreska
firetowa (pauza), ktéra zajmuje petne 1000 jednostek. Kerning i modyfikowanie
$wiatel wiaze si¢ z dopasowywaniem tych wzglednych wielkosci albo w celu
stworzenia iluzji perfekcyjnego dopasowania, albo tez (w przypadku $wiatel)
nadania tekstowi ,gestszego” lub ,lzejszego” wygladu.

Panel narzedziowy

Przy calym bogactwie dostepnych narzedzi, wigkszos¢ czasu spedzamy uzy-
wajac jedynie dwéch z nich: Zaznaczanie (Selection Tool) oraz Tekst (Type Tool).
Zaznaczania (czyli strzatki) uzywamy (oprécz innych zadan) do przesuwania,
wymiarowania i przelewania ramek tekstowych. Narzedzie Tekst stuzy do for-
matowania i edytowania tresci wewngtrz tych ramek. Podczas pracy co chwile

= T Type Tool T
@M«ma!ﬂh‘l‘oﬂ ShiftaT

Zarnaczanie (V, Esc)

Bezpodrednie zaznaczanie (A)
Strona (Shift+P) m & ) v 7
A "
Odstep 1) g_ Add Anchor Point Tool -
Delete Anchor Point Tool -
Tekst (T,
! ]\ Convert Direction Point Tool Shift+C
Linia (\)
Pidro (P) Q = _F Pencil Tool N
Oldwek (N) I Smoath Tool
Ramka prostokatna (F) " e

Prostokat (M)

Nozyczki (C) ] = (F] Rectangle Frame Tool F

Transformacje (E) @ ENipse Frame Tool

Srecubunr e/ il

Gradient (G) 3 Polygon Frame Tool
Wtapianie gradientowe (Shift+G)
Notatka !n - E Recrangle Tool M
Miarka (K} (@ Blipse Tool L
Raczka (H) {2 Potygon Tool
Lupka (2)
Wypelnienie (X) Obrys (0 N Eyedropper Tool |
i u &7 Measure Tool K

Formatowanie wplywa na kontener/tekst
Zastosuj kolor ()

[ Apply Gracient
= [ Apply None /. Num /

- oo

G Preview
(@ Bleed

@ s

& Presentation

E=E

Podglad (W)

WSKAZOWKA: Przy
korzystaniu zdowolnego
narzedzia innego niz Tekst
nacisniecie spacji powo-
duje chwilowa zmiane

na narzedzie Raczka (Hand);
przefaczenie na state
zapewnia klawisz ,H". Jesli
jednak uzywamy narzedzia
Tekst, przytrzymanie spacji
spowoduje wstawienie

w miejscu kursora catego
mndstwa spacji. Na pozor
jest to oczywiste, ale mozna
sie zdziwic, jak fatwo popel-
ni¢ taka pomytke. Podczas
edytowania tekstu mozna
chwilowo wywotac narze-
dzie Raczka, przytrzymujac
klawisz Option/Alt. Przy
szybkiej pracy fatwo mozna
zapomnied, kiedy nalezy
uzyc ktérego klawisza, stad
warto utrwalic¢ sobie skrot
Option/Alt+spacja, ktory
bedzie dziatat w kazdej
sytuacji.

RYSUNEK 1.21 Panel narzedziowy.
Aby uzyskac dostep do dodatkowych
narzedzi pokazanych po prawej, nalezy
klikng¢ i przytrzymac odpowiedni
przycisk, po czym wybra¢ wlasciwa
odmiane z menu wyskakujacego. Na-
rzedzia zawierajace odmiany oznaczone
sg matym czarnym tréjkatem w prawym
dolnym rogu.
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UWAGA: Skroty klawiszowe
podawane s3 zgodnie

z konwencjg ,wersja

dla Mac OS /wersja dla
Windows". Przypomnijmy
tylko, ze odpowied-

nikiem klawisza Cmd

na Macintoshu jest klawisz
Ctrl w komputerach PC,

a klawiszowi Option
odpowiada lewy klawisz
Alt. Prawy klawisz Alt (Gr Alt
na niektorych klawiaturach)
z komputeréw PC nie ma
jednoznacznego odpowied-
nika w systemie Mac OS,
podobnie jak ,nowe
wynalazki”, czyli klawisze
Windows.

WSKAZOWKA: Jeili
rozdzielczo$¢ ekranu jest
naprawde wysoka (ponad
1600 pikseli w poziomie),
paleta zawiera zawsze
wszystkie dostepne opcje,

a oba widoki réznia sie tylko
kolejnoscia.

WSKAZOWKA:

Zawartos¢ menu mozna
wyswietli¢ w porzadku alfa-
betycznym, przytrzymujac
klawisze Cmd+Shift+Option
(Ctrl+Shift+Alt w Windows)
podczas wybierania

menu. Opcja ta moze by¢
przydatna, jesli szukamy
rzadko uzywanej funkgji

i nie mozemy jej dostrzec,
cho¢ wiemy, ze tam jest.

To drobna sprawa, w istocie
nigdy nie uzylem tej opcji
w praktyce, ale mifo jest
wiedzie¢, ze jest dostepna.

trzeba przechodzi¢ od jednego narzedzia do drugiego i z powrotem, warto zatem
wiedziec, ze istnieja poreczne sposoby przetaczania sie pomiedzy nimi.

Aby zmienic ksztalt lub wielkos¢ ramki tekstowej majac wybrane narzedzie
Tekst, wystarczy przytrzymaé klawisz Cmd/ Ctrl, aby chwilowo przelaczyé
narzedzie w tryb strzatki. Dopéki przytrzymujemy ten klawisz, mozemy prze-
suwac lub zmienia¢ wielkosci ramki, ciaggnac ja cala lub ktérys z uchwytéw.
Po zwolnieniu klawisza narz¢dzie zmieni si¢ ponownie na tryb edycji tekstu.

Gdy uzywamy narzedzia zaznaczania, podwéjne klikniecie ramki teks-
towej zmienia kursor w narzedzie Tekst, wstawiony w miejscu podwdjnego
klikniecia.

Warto tez przypomniec skréty klawiszowe aktywujace te narzedzia. T przela-
czaw tryb edycji tekstu z kazdego innego narzedzia, zas Esc powoduje przejicie
do trybu zaznaczania z trybu edycji (strzatke mozna uaktywni¢ réwniez klawi-
szem V, ale ta opcja — co oczywiste — nie dziala w trybie edytowania tekstu).

Paleta sterujgca

Paleta sterujaca (Control, Sterowanie w polskiej wersji interfejsu programu)
to prawdziwy kameleon, zmieniajacy wyglad i zawartos¢ zaleznie od wybranego
narzedzia i zaznaczonego obiektu. Gdy uzywamy narzedzia tekstowego, paleta
moze prezentowac jeden z dwéch widokéw — formatowania znakéw lub forma-
towania akapitéw. Jesli dysponujemy dostatecznie duzym (czytaj — wysokiej
rozdzielczosci) ekranem, w pierwszym trybie po prawej pojawi sie skrécona
lista opcji akapitowych, a po zmianie widoku na prawo od opcji akapitowych
pojawi si¢ czes¢ opcji znakowych.

Warto zauwazy¢, ze wyglad palety mozna dostosowa¢. Jesli nie mozemy
znalez¢ opcji, o ktérej wiemy, ze powinna gdzies tu by¢ — z taka sytuacja zwykle
mamy do czynienia, gdy siadamy przy klawiaturze cudzego komputera — warto
sprawdzi¢ ustawienia wybierajac polecenie Customize (Dostosuj) na koncu
menu podrecznego palety.
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Wersaliki, indeks gorny, Skalowanie .
Formatowanie  Krdj Podkreslenie w pionie e Styl znakowy
znakow Stopier pisma Kerning | Skalowanie w poziomie
[Winion Pro gi-;.,.[:zpi ] Iﬁ'r P | Ay swerks W) | P S o0k W T e A one) g”
q | i WpF o™ vy I @ mE rEF | (ewwwm )
Formatowanie Interdinia Swiatlo Pochylenie (fatszywa kursywa)
akapitéw  Styl czcionki Kapitaliki, indeks dolny, Przesuniecie Stownik
przekreslenie linii bazowej
Wyrdwnanie: do lewej,
do érodka, do prawej,
do grzbietu Weiecie z lewej / z prawej Odstep przed /odstep po Styl akapitowy Liczba tamow
Lista wypunktowana Nie rownaj do siatki | Dzielenie taméw
A1 == n‘-;.npz' g oa ] E Eow ln.;. iq*. T w—rr— ‘ """" H
. §E S g5 —fowl IE™ 10 e gLy . fg ¥ Hyoheoate W!m:‘l}p‘ ;, 31984 51
I Llsta Réwnajdosiatki | Pozycja kursora
Justowanie do lewej, Wciecie pierwszego / Inicjat ~ numerowana Odstep
do srodka, do prawej, ostatniego wiersza wpuszczony: Dzielenie miedzytamowy
wyréwnanie od grzbietu liczba wierszy / Wyrazow
liczba znakéw
OpenType » RYSUNEK 1.22 Paleta sterujaca, po-
v Ligatures kazujaca opcje formatowania znakow
*" ‘ (gora) i akapitow (nizej). Przefaczenie
Underline Options.... pomiedzy tymi trybami umozliwia
Strikethrough Options... skrét Cmd-+Option+7 / Ctrl+Alt+7.
No Break Pol.(azan.a nizej (w kotku) llkona znaj-
dujaca sie na prawym koricu palety
v Adobe Paragraph Composer otwiera menu (widoczne obok), zawie-
Adobe Single-line Composer : aom” rajace wiekszos¢ opcji formatujacych.
» [ Paragraph Umozliwia ono rowniez dostosowanie
Only Align First Line to Grid I |
. » © Tables wygladu palety.
Balance Ragged Lines |» #Aspread Naciéniecia klawisza Tab lub Shift+Tab
Justification. .. < 0% [» B Other powoduja‘cykliczne przechodzenie
Keep Options... 32K przez kolejne pola palety (w przéd

Span Columns...
Hyphenation...

GREP Styles...
Paragraph Rules...

v Dock at Top
Dock at Bottom
Float

Customize...

Drop Caps and Nested Styles... %R

Bullets and Numbering...

X%

i w tyt odpowiednio). Przy zaznaczo-
nym polu mozna wpisa¢ nowa wartos¢
albo uzy¢ strzatek w gore i w dot, aby
krokowo zwieksza¢ lub zmniejsza¢
odpowiednie wartosci.



16 [ InDesign i tekst

WSKAZOWKA: Jezeli
wyswietlane na ekra-

nie czcionki wydaja sie
zrastrowane, oznacza

to zazwyczaj, Ze przelaczy-
lismy sie w tryb Fast Display
(Szybkiego wyswietlania),
czyli tryb niskiej rozdziel-
czosci. W takim wypadku
nalezy wybra¢ polecenie
View > Display Performance
(Widok > Jakos¢ wyswiet-
lania) i wybra¢ tryb Typical
albo High Quality (Typowy
lub Wysokiej jakosci). Jesli
dysponujemy szybkim
komputerem, tryb wysokiej
jakosci zapewni, Ze ilustracje
zawsze beda wyswietlane
w petnej rozdzielczosci
(zauwazmy, ze to ustawie-
nie nie ma wplywu na to,
jak dokument bedzie
drukowany). W celu
ustawienia tego trybu jako
preferowanego dla aplikacji
mozna uzyc¢ opcji dostep-
nej w oknie Preferences

> Display Performance

bez zadnego otwartego
dokumentu.

Profesjonalna typografia w Adobe InDesign

Wyswietlanie strony

Istnieje kilka sposobéw przegladania i poruszania sie po dokumentach

InDesigna — niektére lepsze od pozostatych. Cho¢ mamy do dyspozycji dzie-

siatki opcji, wiekszos¢ z nas niemal wszystko, robi uzywajac zaledwie trzech
skrétéw:

1.

Powigkszanie i zmniejszanie: Cmd/ Ctrl+spacja. Jesli cenimy wlasny
wzrok, lepiej powigkszy¢ widok podczas edytowania tekstu. Nie ma sensu

wilepianie si¢ w ekran, na ktérym ledwo mozna co$ odczytaé. Mozna

oczywiscie zawsze wybraé narzedzie powigkszania Zoom ( Q, ) z panelu

narzedzi, ale lepiej oszczedzi¢ sobie wysitku. Przytrzymanie klawisza

Cmd/Ctrlijednoczesne nacisnigcie spacji przetacza aktualne narzedzie

na Zoom; kursor zmieni sig na ikong lupy ze znakiem plus. Nastepnie,
zamiast klikania w celu stopniowego powigkszania widoku, mozemy

klikna¢ i pociagna¢, aby zaznaczy¢ prostokat, ktéry chcemy powiek-
szy¢ do rozmiaréw roboczego okna. Dodatkowe przytrzymanie klawisza

Option/Alt powoduje stopniowe zmniejszanie powiekszenia z kazdym

kliknigciem myszg, przy czym obraz jest centrowany wzgledem kliknie-
tego punktu.

Przesuwanie widoku: Option/Alt+spacja. Przy powiekszonym widoku,
gdy nie jest widoczna cala strona, czesto chcieliby$my przesunaé obraz

w te lub inng strong. Przytrzymanie klawisza Option i spacji (Alti spacji

w systemie Windows) przelacza chwilowo na narzedzie Hand (Raczka)

(42 ), pozwalajace przesuwaé strone lub rozkladéwke wewnatrz okna apli-
kacji. Narzedzie to pozwala tez na szybkie przesuwanie kolejnych stron

przy zmniejszonym powigkszeniu. Szkoda czasu na zabawe z paskami

przewijania — trudno jest wyczu¢ ich ,wrazliwos¢” i tylko stracimy czas,
usitujac trafi¢ doktadnie tam, gdzie bysmy chcieli.

Dopasowanie do okna: Cmd/ Ctrl+o lub Cmd+Option+o/ Ctrl+Alt+o

(zero). Skréty te powoduja odpowiednio dopasowanie powiekszenia tak,
aby w oknie dokumentu zmiescila sie cata strona lub cala rozktadéwka.
To najszybszy sposéb przywrécenia ogélnego widoku po wczedniejszym

powigkszaniu lub zmniejszaniu widoku.

Alternatywg dla tego triumwiratu skrétéw sterujacych wyswietlaniem jest

funkcja Power Zoom. Po przetaczeniu sie w tryb raczki (z panelu narzedzi lub

chwilowo skrétem klawiszowym) trzeba klikna¢ i przytrzymac klawisz myszy

przez chwilg. Obraz ulegnie lekkiemu zmniejszeniu i na ekranie pojawi sig czer-

wona ramka, ukazujaca obszar, ktéry zostanie dopasowany do biezacego okna

dokumentu. Mozemy nastepnie przesuna¢ te ramke, aby zmieni¢ wyswietlany

obszar. W celu zmiany stopnia powigkszenia mozemy (nadal przytrzymujac
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RYSUNEK 1.23 Panel Pages w typowej orientacji, ukazu-
jacy miniatury osmiostronicowego dokumentu ze stronami
widzacymi (A). Niektorzy uzytkownicy wola zmienic opcje
panelu, aby miniatury byty wyswietlane poziomo, co moze
zapewnic bardziej ekonomiczne wykorzystanie powierzchni
ekranu (B), (C), (D). Przegladanie dokumentu umozliwia row-
niez menu Layout (E), skroty klawiszowe oraz lista rozwijana
Pages w lewym dolnym narozniku okna dokumentu (F).
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WSKAZOWKA: Mozna
utworzyc skrét klawiszowy
do wiasnego, niestandardo-
wego obszaru roboczego,
uzywajac menu Edit >
Keyboard Shortcuts (Edycja

> Skréty klawiaturowe).
Poniewaz nie jest mozliwe
nadpisanie domyélnych
zestawow skrotow, nalezy
najpierw klikngé New

set (Nowy zestaw), aby
utworzy¢ kopie zestawu
domysinego. Nastepnie

z listy Product Area (Obszar
produktu) wybieramy
Window Menu (Menu Okno).
W oknie ponizej pojawi sie
dtuga lista wszelkich pole-
cen, ktére wchodza w skiad
tego menu. Po przewinig-
ciu znajdziemy tam opcje
Workspace: Load 1st User
Workspace (Przestrzen robo-
cza: Zataduj 1. przestrzen
robocza uzytkownika). Teraz
klikamy w polu New Shortcut
(Nowy skrét), po czym naci-
skamy sekwencje klawiszy
dla nowego skrotu. M6j
ulubiony wybar to Ctrl+F12
(klawisz Ctrl jest czwartym,
rzadko uzywanym modyfi-
katorem na Macu). Na liscie
Context nalezy pozostawic
wartos¢ Default (Domysinie),
aby skrot dziatat w kazdej
sytuacji. Po kliknieciu Assign
(Przypisz) nowy skrét zosta-
nie utworzony i dotgczony
do nowo utworzonego
zestawu.

przycisk myszy) uzy¢ klawiszy strzalek — strzatka w gére powieksza ramke
(zmniejszajac stopien powigkszenia), za$ strzatka w d6t przeciwnie, zmniejsza
ramke, tym samym zwiekszajac powiekszenie.

W trybie edycji tekstu przydatne sa skréty Cmd/ Ctrl+2 oraz Cmd/ Ctrl+4,

ktére zmieniaja stopieni powigkszenia odpowiednio do 200 i 400 procent.

Poruszanie sie pomiedzy stronami

Jesli nasz dokument zawiera tylko kilka stron lub rozktadéwek, wystarcza-
jacym narzedziem do przemieszczania si¢ pomigdzy nimi jest Raczka. Dla
dtuzszych dokumentéw wygodniejsze jest uzycie panelu Pages (Strony), menu
wyskakujacego dostgpnego w lewym dolnym rogu okna dokumentu lub opcje
dostepne w menu Layout (Uktad).

Przy korzystaniu z panelu Pages do przemieszczania sig pomigdzy stronami
w ukladzie rozktadéwek podwéjne klikniecie numeréw stron powoduje dopa-
sowanie do wielkosci okna obydwu zaznaczonych stron (rozkladéwki), zaé
podwdjne klikniecie ikony strony dopasuje i wycentruje te wlasnie strone.

Tworzenie przestrzeni roboczej

Mnogos¢ paneli kontrolnych w programie jest tak wielka, ze mozna odnieéé
wrazenie, iz rozmnazaja sig jak kréliki, gdy tylko na moment odwrécimy gtowe.
Wigkszej czeéci z nich bedziemy uzywaé bardzo rzadko — lub wrecz nigdy, bez
wzgledu na to, jak blyskotliwe s3 nasze dokonania. Na szczeécie InDesign
oferuje niespotykany wczesniej poziom kontroli nad srodowiskiem roboczym,
umozliwiajgc zapisanie — i przywrécenie w pézniejszym terminie — widocz-
noéci, polozenia i pogrupowania paneli. Nazwy obszaréw roboczych widoczne
s3 w postaci listy wyboru w prawej czesci paska menu (obok pola wyszukiwania
w systemie pomocy), a takze w podmenu Workspace (Obszar roboczy) menu
Window (Okno). Mozliwe jest tez przypisanie niestandardowego skrétu kla-
wiszowego do wybranego obszaru roboczego i szybkie przetaczanie pomiedzy
réznymi widokami.

Na poczatek warto rozmiesci¢ te panele, ktérych bedziemy uzywaé, w sposéb,
ktéry zapewni najwieksza wygode i sprawnos¢ dziatania. Grupujac panele,
warto dobierac je tak, aby nie 1aczy¢ ze sobg takich, ktére beda uzywane réw-
noczesnie lub jeden po drugim. Panele, z ktérych korzystamy rzadko lub nigdy,
najlepiej ukry¢ (zawsze bedzie mozna wywotac¢ je ponownie z menu Window).
Po wybraniu wlasciwych przesuimy je w odpowiednie miejsca albo zadokujmy.
Po osiagnieciu zadowalajacego rozmieszczenia paneli mozemy wybraé polecenie
New Workspace z menu Window lub listy wyboru i zapisa¢ swéj obszar roboczy
pod czytelna i fatwa do rozpoznania nazws.
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InDesign zawiera pewnga liczbe wstepnie zdefiniowanych obszaréw robo-
czych. Obszar Typography (Typografia) jest niezlym wyborem na poczatek,
ale niewatpliwie wymaga dostosowania. Méj typowy wybér to uzupelnienie
zawartych w nim paneli o Object Styles (Style obiektéw), Info (Informacje), Links
(Eacza), Scripts (Skrypty) oraz Align (Wyréwnanie). Zamykam natomiast panele
Paragraph (Akapit) i Character (Typografia), gdyz nie oferuja niczego, czego nie
zawieralaby paleta sterujaca.

Po zapisaniu obszaru roboczego mozna go ponownie zatladowa¢é w dowolnym

D
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RYSUNEK 1.24 Budowanie obszaru roboczego

do pracy z tekstem: (A) méj preferowany obszar ro-
boczy, zmodyfikowana wersja wstepnie zdefiniowa-
nego obszaru Typografia. Mozna tez utworzy¢ skrot
do szybkiego tadowania obszaru roboczego (B, C)
albo po prostu wybiera¢ go z listy wyboru (D).

WSKAZOWKA: Naciéniecie
klawisza Tab (poza trybem
edycji tekstu!) powoduje
ukrycie lub ponowne
wyswietlenie wszystkich
paneli. Nacisniecie Shift+Tab
powoduje ukrycie wszyst-
kich paneli oprécz palety
sterujacej i panelu narzedzi.

momencie, wybierajac go z listy wyboru lub menu Window > Workspaces. Powrét

do oryginalnych ustawien obszaru (zaréwno predefiniowanego, jak i wtasnego)

umozliwia opcja Reset dostepna w liscie wyboru.



ROzZDzIAL 2

Wprowadzanie tekstu

TYPOGRAFIA ZACZYNA SIE OD JEDNEGO ZNAKU. Wprowadzanie tekstu do doku-
mentu jest fundamentalng czynnoscia, kto wie, czy nie najwazniejszg ze wszyst-
kich, ktére wykonujemy w InDesignie. Istnieje wiele sposobéw umieszczenia
tekstu na projektowanej przez nas stronie i od czasu do czasu uzywamy kazdego

z nich. Zacznijmy od najbardziej elementarnych czynnosci.
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WSKAZOWKA: Wyglad
kursora tekstowego stanowi
wizualng podpowiedz,

co mozna zrobic. Jesli kursor
jest otoczony kropkowa-
nym prostokatem, mozemy
kliknac i przeciagnac, aby
utworzy¢ nowa ramke.
Jezeli przesuniemy kursor
nad istniejaca, pusta ramke,
jego ksztatt sie zmieni, syg-
nalizujac, ze mozna wstawic
tekst do tej ramki.

WSKAZOWKA: Funkcja
Smart Cursor wyswietla
wysokosc i szerokos¢ ramki
w trakcie przeciggania.
Mozliwe jest réwniez precy-
zyjne okresdlenie wymiarow
ramki za posrednictwem
po6l numerycznych w pale-
cie sterujace;j.

children to retreat to;
I writeadventure

A B C

RYSUNEK 2.1 Kursor teks-
towy: kropkowany prostokat
wokét kursora sygnalizuje
mozliwos¢ utworzenia nowej
ramki za pomoca klikniecia

i przeciagniecia (A); owalne
otoczenie kursora (B) pojawia
sig, gdy kursor znajduje sie
ponad pustg ramka, do ktorej
mozemy ,wlac" tekst. Podczas
importowania (,umieszcza-
nia®) tekstu kursor zmienia
ksztatt na,zatadowany

tekst” (C).

Tworzenie ramek tekstowych

Ramki tekstowe s3 ,pojemnikami”, ktére przechowuja nasz tekst. Kazdy nie-
zalezny fragment tekstu nazywamy watkiem (story). Watek moze zawiera¢
pojedynczy znak, ale moze tez rozciagga¢ si¢ na setki stron i setki potaczonych
ze sobg (,powatkowanych”) ramek. Dokument InDesigna czesto zawiera wiele
watkéw — na przyktad gdy jest to gazeta lub inne czasopismo. Ramke tekstowa
mozna utworzy¢ dowolng z nastepujacych metod:

® Narysowac ja przy uzyciu narzedzia Frame (Ramka) albo Shape (Ksztatt),
po czym wybrac narzedzie Type (Tekst) i klikna¢ wewnatrz nowego obiek-
tu, aby aktywowa¢ go jako ramke tekstowa.

® Utworzy¢ ja ,w locie”, klikajac i przeciagajac na stronie lub stole mon-
tazowym narzedziem Tekst, aby okresli¢ wysokosé i szerokos$é ramki.
Po zwolnieniu przycisku myszy migajacy kursor tekstowy pojawi sie
w lewym gérnym rogu ramki i mozemy rozpocza¢ pisanie.

® Uzy¢ polecenia File > Place (Plik > Umies¢) albo skrétu klawiaturowego
Cmd (Ctrl)+D, aby zaimportowaé dokument tekstowy. Po jego wezytaniu
kursor zmieni postaé na zaladowany tekst. Kliknigcie na stronie spowoduje
wlanie tekstu i automatyczne utworzenie ramki tekstowej dopasowanej
do zdefiniowanych margineséw.

O ile nie dokonali$my zmian w domyslnym stylu akapitowym [Basic Paragraph]
(w wersji polskiej nosi on nazwe [Podstawowy akapitowy]), domyélna czcionka
bedzie Minion Pro Regular w stopniu 12 punktéw. Poniewaz dopiero bedziemy
nadawaé formatowanie naszemu tekstowi, nie ma tak naprawde znaczenia,
od czego zaczniemy. Jesli jednak chcieliby$§my zmieni¢ domyslna czcionke,
mozemy to zrobi¢. W tym celu nalezy otworzy¢ panel Paragraph Styles (Style
akapitowe), prawym klawiszem myszy klikna¢ [Basic Paragraph] i wybra¢ Edit
(Edytuj). Z listy opcji po lewej stronie okna dialogowego wybierzemy Basic
Character Formats (Podstawowe formatowanie znakowe) — teraz bedzie mozna
wybrac inny kréj, odmiane, wielkos¢ i dowolne inne atrybuty czcionki. Mozna

q
;_ Apply "[Basic Paragraph]"

Copy to Group...
RYSUNEK 2.4
RYSUNEK 2.2 Smart RYSUNEK 2.3 Edytowanie stylu Wyréwnywanie kur-

Cursor ukazujacy wymiary
tworzonej ramki.

[Basic Paragraph] umozliwia
zmiane domysinej czcionki.

sora tekstowego
do prowadnic.



tez zmieni¢ inne cechy stylu akapitowego, takie jak wyréwnanie, wciecia czy
opcje dzielenia wyrazéw. Realnie patrzac jednak, zaden dokument nie uzywa
wprost stylu [Basic Paragraph]. Stanowi on zazwyczaj jedynie punkt wyjécia,
od ktérego rozpoczynamy formatowanie tekstu.

Przelewanie tekstu

Jakkolwiek mozliwe jest wpisywanie tekstu bezposrednio w InDesignie,
zazwyczaj mamy do czynienia z tekstem juz przygotowanym w dedykowanym

programie do edycji tekstéw, takim jak Microsoft Word lub redakcyjny ,.kuzyn”

InDesign — Adobe InCopy. Dla przykladu, ksiazke te oryginalnie napisatem
w programie Word (nie by to méj wybér, ale redaktorzy nalegali). Niewatpliwie,
gdy dokumenty musza przechodzi¢ tam i z powrotem w cyklu przegladéw
i poprawek, wygodniej jest uzy¢ specjalizowanego programu, takiego jak Word,
ze wzgledu na takie jego funkcje, jak komentarze lub $ledzenie zmian (choé¢
mozna zauwazy¢, ze najnowsza wersja InDesigna réwniez dysponuje takimi
funkcjami).

Nasze zadanie jako projektantéw uktadu to zaimportowanie przygotowa-
nego tekstu do InDesigna, gdzie bedziemy d3zy¢ do tego, aby - zestawiony
wraz z obrazami i przelewany z famu do famu i ze strony na strone — wygladat
wspaniale.

Aby zaimportowac — lub tez umiescié¢ — plik tekstowy, nalezy uzy¢ polecenia
File > Place (lub skrétu Cmd/ Ctrl+D), nastepnie zlokalizowa¢ wiasciwy plik
i klikna¢ Open (Otworz). Kursor zmieni sie na posta¢ zatadowang, ukazujac
kilka pierwszych sléw pobranego tekstu.

Majac zaladowany kursor, mozemy albo kliknagé wewnatrz istniejacej ramki,
albo utworzy¢ nowa ramke, klikajac w pustej czesci strony dokumentu. Punkt,
w ktérym klikniemy, stanie sie gérng krawedzia nowej ramki. Szerokos¢
ramki jest zdeterminowana przez ustawienia margineséw i taméw strony.
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WSKAZOWKA: Podczas
przeciggania w celu
utworzenia ramki teksto-
wej mozna wykorzystac
prowadnice do uzyskania
precyzyjnego dopasowania.
Prowadnice sa wyswiet-
lane pod warunkiem,

ze ekran pracuje w trybie
Normal (Zwykty). W razie
potrzeby prowadnice
mozna wyswietli¢ skrotem
Cmd/ Ctrl+; (Srednik).
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RYSUNEK 2.7 Anatomia
ramki tekstowej

—_— . : Uchwyt
Port During my lifetime I have dedicated myself to wymiarowania

wejéciowy this struggle of the African people. I have fought

against white domination, and I have fought

against black domination. I have cherished the

dideal of a democratic and free society in which

all persons live together in harmony and with

equal opportunities. It is an ideal which I hope

to live for and to achieve. But if needs be, it is an

ideal for which I am prepared to die. ——Port

— Nelson.Mandela, April 20, 1964. wyléclowy

Aby dopasowac gérna krawedz ramki do gérnego marginesu (albo do recznie wstawionej
prowadnicy), wystarczy przesuna¢ kursor w poblize prowadnicy, az strzatka stanowiaca
czes¢ kursora zmieni kolor z czarnego na bialy — jest to sygnat, ze klikniecie w tym
miejscu ,,przyklei” ramke do tej prowadnicy.

Kazda ramka tekstowa zawiera port wejsciowy oraz port wyjsciowy, ktére pozwalaja
tworzy¢ polaczenia pomiedzy kolejnymi ramkami. Pusty port oznacza, ze dana ramka
stanowi odpowiednio poczatek lub koniec watku. Niebieska strzatka wewnatrz portu syg-
nalizuje, ze ramka jest polagczona z inng — poprzednia lub kolejna. Czerwony znak plus
w porcie wyjsciowym informuje, Ze istnieje tekst nie mieszczacy sie w ramce — inaczej
méwigc, ze pewna czes¢ tekstu nie jest nigdzie umieszczona. Aby wlac nieumieszczony
tekst, nalezy klikna¢ czerwony znak plus narzedziem zaznaczania, aby ponownie ,nata-
dowa¢” kursor, przej$é do miejsca, w ktérym chcemy kontynuowa¢ przeplyw tekstu,
i kliknaé u géry nowego tamu lub strony, bagdz wewnatrz istniejacej ramki tekstowe;j.

Na co zwraca¢ uwage podczas wlewania tekstu

Opcja Replace selected item (Zastap wybrany element) w oknie dialogowym Place
(Umiesc): Jesli opcja ta jest zaznaczona i mamy wybrana ramke tekstowa (narzedziem
zaznaczania), importowany tekst zastapi aktualng zawartos¢ tej ramki. Jesli w tym momen-
cie jestesmy w trybie edycji tekstu (aktywne narzedzie Tekst i kursor umieszczony w ramce
tekstowej), nowy tekst zostanie wlany poczynajac od tego punktu wewnatrz watku. Obie
te mozliwosci bywaja przydatne, ale jesli otrzymany rezultat nie jest zgodny z zamie-
rzeniami, mozna uzy¢ Cmd/Ctrl+Z, aby przywrdcic oryginalny stan zaznaczonej ramki.
Dodatkowo przeniesie nas to do trybu zatadowanego kursora, pozwalajac na wlanie
tekstu we wiasciwe miejsce. No i oczywiscie mozna po prostu wcze$niej wytaczy¢ oma-
wiang opcje.

Anulowanie zaladowanego kursora tekstowego: Jesli okaze sig, Ze nie jesteSmy jeszcze
gotowi do wlania nowego tekstu, mozemy ,oprézni¢” kursor, naciskajac klawisz Esc.




Alternatywnie mozna klikna¢ i przeciagna¢ natadowanym kursorem, wyzna-
czajac wielkos¢ nowej ramki — po zwolnieniu przycisku myszy tekst wleje sie
do zaznaczonego obszaru.

Majac aktywne narzedzie zaznaczania, mozemy szybko przejs¢ do edycji
tekstu w ramce, klikajac ja dwukrotnie — program przetaczy sie na narzedzie
Tekst, wstawiajac kursor w miejscu kliknigcia. Podczas edycji mozna chwilowo
przelaczy¢ si¢ do narzedzia zaznaczania, przytrzymujac klawisz Cmd/ Ctrl.
Po jego zwolnieniu powrécimy do narzedzia tekstowego.

W celu przesuniecia ramki tekstowej nalezy klikna¢ ja narzedziem zazna-
czania i przeciggna¢ w inne miejsce. Aby zmieni¢ wielkos¢ ramki, nalezy
narzedziem zaznaczania pociagna¢ za jeden z naroznych uchwytéw.

Rodzaje przelewania tekstu

Reczne przelewanie dodaje tekst do jednej ramki na raz. Przeplyw tekstu zatrzy-
muje sie na koricu ramki (lub na koricu serii potaczonych ramek, jeéli pierwsza

kliknigta byla juz czeicia takiej sekwenciji). Aby kontynuowa¢ wlewanie tekstu,
trzeba ponownie zatadowa¢ kursor. Ten tryb jest najbardziej przydatny przy

krétkich fragmentach tekstu. Jest to opcja domysina.

Automatyczne wlewanie (Shift) powoduje wlanie catego tekstu, dodajac kolejne

strony i ramki w razie potrzeby. Tryb ten jest najwygodniejszy przy pracy z doku-
mentami jednotamowymi, zawierajacymi jeden gtéwny watek — przykladem

moze byc ksigzka beletrystyczna lub opowiadanie. Nie jest to polecana opcja

przy skfadzie wielotamowym, w ktérym ma sie pojawic wiele ilustracji, gdyz

wlewa tekst we wszystkie dostepne tamy, bez wzgledu na to, czy zawierajg juz
one (lub maja zawierac) inng tres¢.

Wiewanie pélautomatyczne (Option/Alt) dziata podobnie jak tryb reczny,
ale po wypelnieniu ramki pozostawia nam zatadowany kursor, oszczedzajac
koniecznosci klikania czerwonego znaku plus na koricu wlasnie wypetnionej

ramki. Mozna wiec od razu kontynuowac wlewanie tekstu w kolejne ramki. Tryb

ten jest najwygodniejszy przy umieszczaniu tekstu w ukladzie wielotamowym,
takim jak gazeta lub czasopismo.

Automatyczne wlewanie z ustalong liczba stron (Shift+Option lub Shift+Alt)
dziata analogicznie do wlewania automatycznego, ale bez tworzenia nowych

stron. Méwiac inaczej, tworzone s3 nowe ramki na juz istniejacych stronach, ale
liczba stron nie jest powiekszana. Tryb ten jest przydatny, jesli dokument ma

zawierac z gory okreslona liczbe stron i zostaty one juz utworzone.
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Automatyczny
15

Pétautomatyczny

Automatyczny
ze stalg liczba stron

RYSUNEK 2.8 Kursory
wlewania tekstu
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RYSUNEK 2.9 Powiadomienie inspekcji wstepnej o wy-
krytym bledzie (powyzej) oraz panel Inspekcji wstepnej,

ukazujacy nieumieszczony tekst.

Ponowne inteligentne wlewanie tekstu (Smart text reflow) powoduje automa-
tyczne dodawanie lub usuwanie stron w miare powigkszania lub skracania tekstu.
Nie jest trybem pracy narzedzia, ale opcja dostepng w preferencjach programu.
Aby uaktywnic te opcje, nalezy wybra¢ Preferences > Type (Preferencje > Tekst)
i usung¢ znacznik z pola wyboru Limit to Master Text Frames (Ogranicz do ramek
strony wzorcowej). Nowe strony dodawane na koricu dokumentu oparte beda
na stronie wzorcowej zastosowanej do ostatniej istniejacej strony. Zaznaczenie
opcji Delete Empty Pages (Usun puste strony) spowoduije, ze strony, na ktorych nie
ma zadnej tresci, zostang usunigte samoczynnie. Warto zwrocic¢ uwage, Zze opcja
ta dziala dopiero wéwczas, gdy dokument zawiera przynajmniej dwie pofagczone
ramki na co najmniej dwoch stronach.

Inspekcja wstepna

Funkcja Inspekcji wstepnej w Adobe InDesign pozwala zlokalizowa¢ potencjalne
biledy, takie jak nieumieszczony tekst. W takiej sytuacji w pasku stanu aplikacji
po lewej stronie wyswietlana jest czerwona kropka z komentarzem informujacym
o liczbie wykrytych btedéw. Podwéjne klikniecie tej kropki otwiera panel Preflight
(Inspekcja wstepna), w ktérym mozna znaleZ¢ informacje o rodzaju i miejscu
wystapienia btedu, wraz z mozliwoscig bezposredniego skoku do adpowiedniej
strony dokumentu.

3
4 ‘

4 €2 [ rw Ta]
PREFLIGHT
Moo Profie: ( Basic) workiog) 5
Error |page |
w TEXT (1)
W Overset text (1) /-—4\
Text Frame { 1
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Przecigganie i upuszczanie plikow tekstowych

Oprécz mozliwosci umieszczania tekstu za posrednictwem polecenia File > Place,
pliki tekstowe mozna przeciagnaé do okna dokumentu InDesigna z Findera

systemu Mac OS X, Eksploratora Windows albo z Bridge — dotaczonego do

InDesigna uniwersalnego narzedzia, bedacego swoistym ,szwajcarskim scyzory-
kiem” do wszystkiego. Zaleznie od wielkoéci uzywanego monitora (rozwiazanie

to sprawdza sie lepiej, gdy mamy naprawde spora ,przestrzen zyciowa”) moze

to by¢ wygodniejsza, szybsza i bardziej intuicyjna metoda pracy. Jesli szczesli-
wie mamy do dyspozycji dwa monitory, mozemy umie$cié Bridge na monitorze

pomocniczym i przeciaggad elementy tresci do okna InDesigna w miare postepéw,
co zdecydowanie moze przyspieszy¢ prace. W razie braku drugiego monitora

mozna przelaczy¢ Bridge w tryb kompaktowy, aby jego okno zawartoéci pozo-
stawalo zawsze widoczne. Mozna tez uzy¢ panelu Mini Bridge, ktéry dziata jak
integralna przegladarka plikéw wbudowana w InDesign. Bez wzgledu jednak
na wybranga opcje, mozna przeciagad tekst i ilustracje do dokumentu tak tatwo,
ze tworzony dokument niemal samoistnie zacznie nabiera¢ ksztattu.

W przypadku dokumentéw takich jak informatory, czasopisma lub gazety,
ktoére sktadaja sie z licznych, odrebnych tekstéw, mozliwosé jednoczesnego wsta-
wienia kilku plikéw (tekstowych lub graficznych) moze znacznie oszczedzié czas.
We wczeéniejszych wersjach bylo to mozliwe przy przeciaganiu i upuszczaniu
plikéw z Bridge i w wersji cs5 nadal mozemy tak robi¢, ale wygodniejsze jest
wykorzystanie Mini Bridge, ktéry jest naturalna czeécia interfejsu InDesigna.

Panel Mini Bridge mozna wywotla¢ z menu Window (Okno). Po jego wy$wiet-
leniu mozna przeglada¢ zawartos¢ dysku. Wielko$é miniatur mozna regulowa¢
przy uzyciu suwaka w dolnej czesci panelu. W celu zaznaczenia kilku plikéw
nalezy przytrzyma¢ klawisz Shift, jesli zaznaczane sa kolejne pliki, albo
Cmd/ Ctrl, aby zaznacza¢ pliki nie sasiadujace ze soba. Po przeciagnigciu minia-
tury jednego z zaznaczonych plikéw do okna dokumentu InDesigna pojawi
sig¢ kursor zatadowanego tekstu (albo kursor ilustracji, o ile przeciaggniemy
pliki graficzne), ukazujacy liczbe zatadowanych plikéw. Wyswietlany pocza-
tek tekstu nalezy do pierwszego odczytanego pliku — mozemy przetaczy¢ sie
na kolejny/ poprzedni plik w kolejce, uzywajac klawiszy ze strzatkami.

Jesli zawczasu zaplanowali$my rozmieszczenie poszczegélnych tekstéw — czy
to w formie papierowego szkicu, czy tez wstepnie przygotowujac potaczone juz
ze soba ramki, wstawianie wielu plikéw jednoczesnie moze przeksztalcié pusta
strong w prawie gotowy dokument zaledwie kilkoma kliknieciami. Jedyne,
na co trzeba zwraca¢ uwage podczas wlewania tekstu, to ksztatt kursora — jesli
jest on ,zaokraglony” (otoczony nawiasami), nowy tekst znajdzie sie w istnie-
jacej ramce tekstowej. Gdy jest otoczony kropkowany prostokatem, mozemy
utworzy¢ nowa ramke.
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RYSUNEK 2.10 Przegladanie
folderu zawierajgcego pliki
tekstowe w Mini Bridge.

Ksw ApplePie

Prep Time: 30 Min
Cook Time: 1 Hr
Ready in:1 Hr30 Min
Servings: &
Ingredient= 1159
ursaked butter 259

RYSUNEK 2.11 Kursor teks-
towy z zatadowana kolejka
kilku plikow.
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Mary had a And everywhere Mty
little lamb, /that Mary went, et >
whose fleece was / the lamb was Zoomin x-
pure as snow. sure to go. o Fit Sread n Window 40
Actual Size x1
. Entire Pasteboard (%0
Rotate Spread »
RYSUNEK 2.12 Wyswietlanie watkow pokazuje, Screen Mode N |
ktére ramki sg potaczone ze soba. Display Performance >
Show Rulers #R
» Hide Frame Edges ~%H
Grids & Guides > Show Text Threads “C3Y
Stracture » Show Assigned Frames
Story Editor » Hide Hyperlinks
{  Hide Notes

Profesqonalna typograﬂa w Adobe InDe5|gn

Wiazanie ramek tekstowych

Kontynuowanie tekstu z jednej ramki w kolejnej (przeptywanie tekstu) nazy-
wane jest niekiedy wgtkowaniem lub wigzaniem. Istnieje kilka typowych technik
zwigzanych z watkowaniem ramek:

Tworzenie watku. Wybranie ramki zawierajacej nieumieszczony tekst i klik-
nigcie portu wejéciowego lub wyjsciowego, aby ponownie ,natadowa¢” kursor
(zazwyczaj bedzie to port wyjsciowy, gdyz pragniemy raczej kontynuowa¢
z miejsca, w ktérym przerwaliémy). Z takim kursorem mozemy nastepnie
przejé¢ do nastepnego famu albo na kolejng strong, po czym kliknaéi przeciag-
nac w celu stworzenia nowej ramki lub kliknaé wewnatrz pustej ramki. Tekst
przeplynie z poprzedniej ramki do kolejnej.

Wyswietlanie watkow tekstowych

Niekiedy przydatna jest mozliwos¢ wizualnego sprawdzenia, jak tekst przeplywa
z ramki do ramki (inaczej méwiac, ktéra ramka jest ta nastepna/ poprzednia).
Polecenie Show Text Threads (Pokaz watki tekstu), dostepne w menu View > Extras
(Widok > Dodatki), powoduje wyswietlenie linii faczacych odpowiednie porty
(wyjsciowy i wejsciowy) wybranej ramki z kolejnymi/poprzednimi. Przeplyw
tekstu nie zawsze jest oczywisty, szczegdinie w ukladzie gazetowym, gdzie tre$¢
moze przeskakiwa¢ pomiedzy réznymi czesciami strony, a nawet nastrone, ktéra
nie jest bezposrednia kontynuacja biezacej.

Hide Content Grabber
Hide Live Corners




Usuwanie ramki z watku. Zaznaczenie ramki i naci$niecie klawisza Delete
kasuje ramke. Nie musimy martwic si¢ o znajdujacy sie w niej tekst — czynnoé¢
ta usuwa pojemnik, ale nie jego zawartos¢.

Przerywanie watku. Podwéjne klikniecie portu wejéciowego ramki powoduje
odlaczenie jej od watku (i wszystkich ramek nastepujacych po niej). Ramka
ta nadal bedzie na swoim miejscu, ale juz pusta — jakkolwiek wypelniajacy ja
dotad tekst nie zostal usuniety, a jedynie stat sig tekstem nieumieszczonym,
dostepnym w poprzedniej (obecnie ostatniej) ramce watku.

Laczenie ramek, ktére nie s3 czescia tego samego watku. Jesli nasz tekst
zajmuje wiele ramek, zazwyczaj preferowane jest utrzymanie ich powigza-
nia ze soba, zamiast rozdzielania tekstu pomiedzy wiele oddzielnych ramek.
Zwatkowane ramki mozna wspélnie zaznaczy¢, sprawdzi¢ w nich pisownie lub
przeglada¢ w Edytorze watkéw jako jednolita caloéé. Mozna réwniez w razie
potrzeby wyeksportowa¢ watek jako jeden plik dla innych celéw, na przyktad
umieszczenia na stronie Web, bez koniecznosci sklejania wielu fragmentéw
w calo$é. Moze tez sie zdarzy¢, ze bedziemy chcieli ponownie potaczy¢ wezes-
niej rozdzielone fragmenty lub po prostu ztaczy¢ dwa teksty w jeden. W tym
celu nalezy klikna¢ port wyjéciowy ostatniej ramki pierwszego watku, po czym
klikna¢ pierwsza ramke drugiego watku. Moze to spowodowaé przelanie sie
tekstu, gdy tres¢ z drugiego watku wypelni cale wolne miejsce, ktére pozosta-
walo na koricu pierwszej ramki.

Tworzenie tytutu rozciagajacego sie na kilka taméw. Funkcja Span columns
(Odstepy kolumn'), nowa w wersji InDesign ¢S5 (oméwiona szerzej w dalszej
czesci tego rozdzialu) pozwala uniknaé koniecznosci recznego ustawiania
tytuléw w poprzek wielu taméw. Ta technika jednak nadal jest uzyteczna, jesli
chcemy méc stosowaé tamy o niejednolitej szerokosci lub wykorzysta¢ niektére
z nich jako puste miejsce albo zarezerwowac¢ je na lid lub ilustracje.

Aby utworzy¢ tytul rozciggajacy sie w poprzek kilku taméw (bez korzystania
z funkcji Span columns), nalezy wykonaé nastepujace dziatania:

1. Utwérz nowa prowadnice pozioma w miejscu, w ktérym ma sie zaczaé
pierwszy akapit wtasciwego tekstu (nie tytul). W tym celu pociagnij mysza
z poziomej linijki w d61 do wiasciwej pozyciji.

2. Dopasuj gorna krawedz kazdej ramki tekstowej do tej prowadnicy.

1 W polskiej wersji interfejsu mamy tu niewatpliwy btad przektadu — span oznacza
»obejmowac” lub ,rozciggac si¢”, zas column w polskiej terminologii typograficznej
to ,fam”, zatem funkcja ta powinna nosi¢ nazwe ,Obejmowanie taméw” lub podobna.
Takich niescistoéci lub wrecz bledéw ttumaczenia jest w polskiej wersji programu
bardzo duzo. Z tego wzgledu postuguje si¢ gléwnie terminami angielskimi.
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WSKAZOWKA: Przed
pofaczeniem watkoéw warto
upewnic sie, czy pierwszy

z nich korczy sie znakiem
korica akapitu (1) i dodac go
w razie potrzeby. W prze-
ciwnym razie pierwszy
akapit drugiego watku
zostanie ,doklejony”

do ostatniego akapitu
pierwszego watku, przyjmu-
jac jego styl akapitowy.
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RYSUNEK 2.13 Rozciaganie
tytutu na kilka lamdw.
Niezaleznie od istnienia nowej
funkgji Span Columns, ta tech-
nika nadal jest uzyteczna przy
stosowaniu nieregularnego
ukladu famoéw i wielu powia-
zanych ramek tekstowych.,

U gory: przed rozciggnieciem
tytutu na kilka taméw, u dotu:
po rozciggnieciu.

WSKAZOWKA: Opcja View
> Extras > Show Frame Edges
(Widok > Dodatki > Pokaz
krawedzie ramek) powoduje
wyswietlanie ramek jako
cienkich prostokatow, dzieki
czemu sg widoczne nawet
wowczas, gdy nie zawie-
raja zadnej tresci. Opcje

te mozna wiaczyc lub wyta-
czy¢ skrgtem Cmd/ Ctrl+H.

Profesjonalna typografia w Adobe InDesign
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3. Zaladuj kursor tekstowy, klikajgc port wejsciowy pierwszej ramki

tekstowej.

4. Kliknij i pociagnij, aby utworzy¢ ramke rozciagajaca sie na wszystkie

lamy, nadajac jej wysokos¢ w przyblizeniu odpowiadajaca spodziewanej

wielkosci tytulu. Akapit tytutu (albo taka jego czeéé, ktéra sie zmiesci)

pojawi sig¢ w tej ramce. W razie potrzeby mozna nastepnie dopasowa¢

wysokoéé ramki tytulowej.

Watkowanie pustych ramek tekstowych. Wiele oséb woli narysowac¢ sobie

i powiaza¢ ze soba ramki, zanim umiesci w nich tekst, tworzac ,szkielet”

dokumentu. W celu utworzenia serii powiagzanych ze soba pustych ramek

mozemy narysowal pierwsza z nich narzedziem Tekst, nastepnie klikna¢

jej port wyjsciowy, aby ,naladowac” kursor (choé¢ nie ma w niej jeszcze zad-

nego tekstu), po czym narysowac kolejna ramke. Jeéli przytrzymamy klawisz

Option/Alt, po utworzeniu nowej ramki nadal bedziemy mieli ,natadowany”

kursor i mozemy od razu przej$¢ do tworzenia kolejnej ramki. Aby zasymu-

lowa¢ wyglad naszego ukladu, mozemy wypelni¢ powigzane ramki tekstem

zastepczym (placeholder).
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Indywidualne ramki czy ramki wielotamowe?

Zatézmy, ze chcemy utworzy¢ dokument w ukladzie trzytamowym. Mozna to osiggna¢ dwiema metodami:
1) utworzy¢ pojedyncza ramke tekstowg i podzieli¢ jg na trzy tamy; 2) utworzy¢ trzy oddzielne ramki, kazda
o szerokosci jednego famu, i potaczyc je w watek. Wybor metody ma wplyw na to, jak bedziemy p6zniej mody-
fikowac ten ukiad. Pojedyncza ramka podzielona na tamy pozwala jednym ruchem okresla¢ potozenie gérnej
i dolnej krawedzi wszystkich taméw — a dzieki funkcji Span Columns mozemy réwniez rozszerzaé tytuly (lub
inne wybrane akapity) na wiecej niz jeden lam, wszystko wewnatrz pojedynczej ramki. Majac trzy oddzielne
ramki mozemy niezaleznie okre$la¢ wymiary poszczeg6inych taméw, co moze by¢ uzyteczne, jesli chcieliby$my,

aby te tamy zaczynaly sie lub koriczyly w réznych pozycjach.
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W wersji CS5 pojawila sie nowa technika tworzenia wielu powigzanych ramek
przy uzyciu narzedzia Tekst. Po kliknieciu i pociggnieciu (bez zwalniania przyci-
sku myszy) naci$nijmy klawisz strzatki w prawo — zamiast jednej ramki pojawia
si¢ dwie, wypelniajace zakreslona przestrzen. Kolejne przyciéniecie strzatki
zwigksza liczbe ramek, za$ strzatka w lewo powoduje ponowne zmniejszenie
ich liczby. Po zwolnieniu przycisku myszy otrzymamy wybrang liczbe ramek
polaczonych w watek.

Dzielenie watkowanego tekstu na oddzielne ramki tekstowe. Serie ramek
tworzgcych watek tekstowy mozna rozdzieli¢ na indywidualne, niepowia-
zane ze sobg ramki, uzywajac skryptu SplitStory dotaczonego do programu.
W tym celu najpierw trzeba wyswietli¢ panel Scripts (Skrypty), dostegpny w menu
Windows > Utilities (Okno > Narzedzia). W panelu tym nalezy rozwina¢ kolejno

RYSUNEK 2.14 Przyktad

po lewej ukazuje dwie ramki
pofaczone ze soba; po prawej
mamy pojedyncza ramke
podzielong na dwa famy.

RYSUNEK 2.15 Dodawanie
tamow (tylko CSs). Dodatkowe
ramki tekstowe mozna two-
rzyc, przeciagajac kursor

i jednoczesnie naciskajac kla-
wisz strzatki w prawo. Klawisz
strzatki w lewo przycisniety
podczas przeciaggania kursora
usuwa ramki.



Mary, Mary,
quite contrary,

Mary, Mary,
Qquite-contraryy .

RYSUNEK 2.16 Skrypt
SplitStory.jsx umozliwia po-

‘How-does your

garden grow? _ ,

‘With silver bells, .

and.cockle shells ' . B

‘And pretty maids

How-does -your allin.a.row#
garden grow

With silver bells,

and-cockle shells

dzielenie watku na indywidu-

alne ramki.

RYSUNEK 2.17 Obejmowanie

i dzielenie famow. Przykiad
ukazuje dwa sposoby dzia-
fania: przy uzyciu gadzetu

w palecie sterujacej (A) oraz

okna dialogowego Span
Columns (B).

T s -

Mo Break “N

And pretty maids,
allin-a row:

foldery Application i Samples. Po zaznaczeniu ramek tworzacych watek nalezy

dwukrotnie klikna¢ plik SplitStory.jsx w panelu.

Rozcigganie i taczenie tamow

Przy pracy z uktadem wielolamowym czesto mamy do czynienia z sytuacja,

gdy jakis tytul powinien rozcigga¢ si¢ na (,obejmowac”) dwa lub wiecej taméw

tekstu. W InDesign ¢S5 mamy do dyspozycji funkcjg Span Columns, ktérg mozna

wywolac z menu palety Paragraph albo z menu palety sterujacej. Mozna tez uzy¢

w tym celu gadzetu dostgpnego w palecie (jednak wéwczas nie mamy dostepu

do czesci opcji szczegblowych).

Simply Delicious Apple Pie
|

Preparation Time: 30 Minutes Cook Time: 1 Hour
Ready In: 1 Hour 30 Min Servings: 8

The Pie Crust

115 g unsalted butter 1 teaspoon salt
25 g all-purpose flour 1 egg yolk
60 ml water

_} water to prevent
tting creamed
e flour, salt, and

fat lumps no

(e i

Iu: Se7.085

A

Split the dough into 1
amounts. Pat them it
flattening them sligh
them in plastic wrap.
needs to rest in the n
at least 30 minutes te
liquid, and to become

Dust a clean, dry surface with flour;
remove and unwrap one of the
discs of dough from the refrigerator.

Flattan tha danah clinhthe writh wane



Jesli chcemy podzieli¢ akapit (lub kilka akapitéw) na wezsze ,podrzedne”
tamy, mozna to wykona¢ na poziomie samego akapitu, co jest doskonatym
rozwigzaniem, jesli w szerokim lamie pojawia si¢ dluga lista krétkich (na przy-
kiad jednowyrazowych) haset.

Opcje obejmowania lub dzielenia taméw moga zostaé wlaczone do definicji
stylu akapitowego. Wiecej informacji na ten temat zawiera rozdziat 12, ,Glo-
balne formatowanie przy uzyciu stylow”.

Korzystanie z tekstu zastepczego

Uzycie zastepczego (fikcyjnego) tekstu dla zasymulowania wygladu docelo-
wego tekstu ma dluga tradycje. Dawni projektanci zwykli uzywaé w tym celu

fragmentu pseudolacifiskiego tekstu zwanego ,Lorem ipsum”. Jest on oparty

na tekscie Cycerona ,,O granicach dobra i zla”, powstalym w 45 roku p.n.e., ale

ze zmienionym ukladem stéw i zdan, aby lepiej przyblizaé wyglad ,przecigtnego”
artykutu. Tekst taki pozwala klientowi zapozna¢ sie z koncepcjami projektanta,
nie odwracajac jego uwagi treécia, jako ze jest nie tylko niezrozumiaty, ale —
w istocie — pozbawiony jakiegokolwiek sensu. O ironio, uzycie Lorem ipsum

niekiedy zmusza projektanta do wyjasniania klientowi, dlaczego prezentowany

tekst jest napisany po lacinie.

InDesign zawiera wbudowany losowy generator tekstu, ktéry tworzy tekst
zastepczy podobny, ale rézniacy sie od klasycznego Lorem ipsum. W celu zasto-
sowania tekstu zastepczego nalezy wstawi¢ kursor tekstowy do ramki, po czym
uzy¢ polecenia Type > Fill with Placeholder Text (Tekst > Wypelnij tekstem zastep-
czym). Ramka (lub seria polaczonych ramek) zostanie wypelniona fikcyjnym
tekstem o objetosci wynikajacej z aktualnie wybranego stylu. Funkcji mozna
uzy¢ ponownie, jesli po zmianie wielkosci pisma lub wymiaréw ramek tekst
zastepczy przestanie wypelniaé ramki.

Korzystanie z miniatur

Zanim zaczniemy prace, cz¢sto warto poswieci¢ nieco czasu na przygotowanie
odrecznego szkicu projektowanego ukladu, zamiast tworzyé go bezposrednio
w komputerze. Bez wzgledu na to, jak sprawnie umiemy pracowaé mysza i skré-
tami klawiszowymi, szybciej (i swobodniej) jest postuzy¢ sie¢ otéwkiem i kartka
papieru. Szkice pozwalajg wstepnie wyeliminowac rézne glupie pomysly, ktére
kazdemu od czasu do czasu przychodza do glowy — a przez ktére czesto musimy
si¢ przedzierad, zanim dojdziemy do wlasciwych rozwiazan. W oparciu o szkic
mozna nastepnie skonstruowac ,szkielet” ramek tekstowych i graficznych,
zaplanowa¢ przeplyw tekstu i wypelni¢ tekstem zastepczym, zanim bedzie
dostepna wlasciwa tresé. Dla lepszego panowania nad praca warto rozmies-
ci¢ ramki tekstowe i graficzne na oddzielnych warstwach (wiecej informacji
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WSKAZOWKA: Mozliwe
jest utworzenie wlasnego
tekstu zastepczego poprzez
przygotowanie pliku
tekstowego zawierajacego
pozadany tekst i umiesz-
czenie go pod nazwg
«placeholder.txt” w kata-
logu aplikacji InDesign.

Od tego momentu

uzycie polecenia Fill with
Placeholder Text spowoduje
wstawienie zawartosci tego
pliku. Tradycjonalisci, ktérzy
chcieliby uzywac ,praw-
dziwego” Lorem ipsum,
moggq odwiedzic strone
lipsum.com, udostepniajacy
generator tworzacy Lorem
ipsum o zadanej dtugosci,
jak rowniez dowiedzie¢

sie wiecej o tym przodku
wszystkich zastepczych
tekstow.
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Font
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Paragraph URT
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Character Styles aXRF1L
Paragraph Styles e
Create Outiings GHO
Find Font...
Change Case

Type on a Path

vy ¥ ¥

Notes
Track Changes

Insert Footnote
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Insert Special Character
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Insert Break Character
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RYSUNEK 2.18 Wypelnianie
ramki tekstem zastepczym

WSKAZOWKA: Jako punkt
wyjscia dla tworzenia szki-
céw, mozna wydrukowac
obraz strony, zawierajacy
widoczne (drukowane) linie
marginesoéw i prowadnice
tamow. W tym celu nalezy
w oknie dialogowym druku
zaznaczy< opcje Print Blank
Pages (Drukuj puste strony)
i Show Wisible Guides and
Grids (Drukuj widoczne linie
pomocnicze i siatki linii
bazowych).

| | e
| | ——— -
| | = i .....|
' B R
| e | 5 :
| - | b ‘:.—s..n...._
i- | o }
== | S|
| |
Az | B |
' |EET X
s g e | | B
|

RYSUNEK 2.19 Dwustronicowa rozkfadéwka z zasymulowanym wypelnieniem tekstem zastepczymi
i zastepczymi ramkami ilustracji.

zawiera rozdzial 14, ,Strony, marginesy, tamy i siatki”) — w ten sposéb tatwo
bedzie mozna od razu po kolorze przypisanym do warstwy okresli¢, czym jest
dana ramka.

Wklejanie tekstu

Inna metoda wprowadzania tekstu jest jego skopiowanie z innej aplikacji
i wklejenie w dokumencie InDesigna. Stuzy do tego standardowe polecenie
Paste (Wklej), jak réwniez powszechnie znany skrét Cmd/ Ctrl+V. To, czy
wraz z tekstem przeniosa sig jego atrybuty formatujace, zalezy od ustawien
w preferencjach. Opcje odpowiedzialne za to zachowanie znajdziemy w sekeji
Clipboard Handling (Obstuga schowka). Wybranie opcji All Information (Wszystkie
informacje) spowoduje kopiowanie kroju, odmiany i wielkosci czcionki, styléw,
koloréw kopiowanego tekstu (naturalnie o ile Zrédtowa aplikacja obstuguje
taka réznorodnos¢). Ustawienie to mozna pominaé doraznie, uzywajac pole-
cenia Edit > Paste Without Formatting (Wklej bez formatowania) albo skrétu
Cmd+Shift+V/ Ctrl+Shift+V. Wklejony tekst zostanie dotaczony bezposrednio
w miejscu kursora, o ile znajdujemy sie w trybie edycji tekstu. W przeciwnym
razie pojawi si¢ zaladowany kursor tekstowy, pozwalajacy wla¢ tekst w istniejaca
ramke lub utworzy¢ nowa.
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RYSUNEK 2.20 Miniatury rozktadéwek 8-stronicowego dokumentu,
Jkazujace prowadnice i siatke bazowa.

Kopiowanie i wklejanie — z formatowaniem lub bez — zazwyczaj dziata

doskonale, ale niekiedy powoduje dziwne efekty, jesli w tekécie wystepuja

znaki specjalne. Preferowang technika powinno by¢ zawsze umieszczanie

tekstu z pliku. Wklejanie jest tak naprawde potrzebne tylko wtedy, gdy kopiu-

jemy male fragmenty z wiekszej calosci, na przyktad z wiadomosci e-mail lub
dokumentu PDF.

sty Potminee
Aupearance of Mack
Vite Mandiirg

] g

& Al Information (Index Markers, Swatehes, Styles, etc.)
(73 Texx Only il |

|

Undo Typing ®Z
Redo onz §
Cut x
Copy *C
Paste ny

Paste without Formatting
Paste Into TRV
Paste in Place
Clear

Duplicate

RYSUNEK 2.21 Polecenie
Paste without Formatting
usuwa informacje formatujace
z kopiowanego tekstu.
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Prostokaty i ramki prostokatne: gdzie jest réznica?

InDesign zawiera dwa narzedzia, ktére zasadniczo wykonuja to samo zada-

RYSUNEK 2.22 Usuniecie
znacznika przy opcji Type Tool
Converts Frames (Narzedzie
Tekst konwertuje ramki

na tekstowe) zabezpiecza
przed przypadkowa zmiang ra-
mek graficznych na tekstowe.

nie: Rectangle (Prostokat), wraz ze stowarzyszonymi z nim narzedziami Ellipse
(Elipsa) i Polygon (Wielokat), oraz Rectangle Frame (Ramka prostokatna) i jej uzu-
petnienia. Co je odréznia? Niewiele. Ksztatty narysowane przy uzyciu narzedzi
ramek zawieraja symbol , X", sugerujacy, ze ,co$” nalezy w nich umiesci¢. Ksztalty
rysowane narzedziami Prostokat, Elipsa i Wielokat nie zawieraja tego symbolu
i w zamierzeniu maja by¢ obiektami graficznymi ,samymi w sobie”. Jednak nic
nie powstrzymuije nas przed umieszczeniem grafiki lub tekstu wewnatrz takiego
ksztattu — klikniecie ksztattu (lub ramki graficznej) narzedziem tekstowym spo-
woduje, Ze od tego momentu bedzie on ramka tekstowa! Analogicznie, nie jest
trudne przetworzenie ramki tekstowej (jak dtugo nie zawiera tekstu) w ramke
graficzng lub ksztatt. Niekt6rzy wola jednak, aby ramki tekstowe nimi pozosta-
waty, a ramki graficzne nadal byty ramkami graficznymi, zatem istnieje ustawienie
preferenciji, ktére wylacza automatyczne konwertowanie ramek graficznym
narzedziem tekstowym.

Jesli zachodzi potrzeba zmiany ksztattu wybranego obiektu, na przyktad
z prostokata na elipsg, mozna to zrobic poleceniem Object > Convert Shape (Obiekt
> Konwersja ksztattu).

The shape
of things
to come

[ Object S

The Transform >
shape of | N 0 s
things to Sl g

come

Interactive

RYSUNEK 2.23 Polecenie
Convert Shape pozwala zmie-
ni¢ ksztatt ramki tekstowej.

Paths
Pathfinder
Convert Shape
Convert Point

Display Performance

Rectangle -

Rounded Rectangle

Beveled Rectangle

Inverse Rounded Rectangle |
Ellipse

Triangle

Polygon

Line

Orthogonal Line

Importowanie tekstu zdokumentu Word

Przy umieszczaniu pliku w formacie Microsoft Word albo Rich Text Format
(RTF) mamy do dyspozycji poszerzone mozliwosci decydowania, jak ten tekst
zostanie wprowadzony do dokumentu InDesigna. Wybieramy polecenie File >
Place (Cmd+D lub Ctrl+D). Pojawi si¢ okno dialogowe umozliwiajace wskazanie
wtadciwego pliku. W dolnej czgéci okna dostepnych jest kilka opcji dodatkowych.
Jesli zaznaczymy pole wyboru Show Import Options (Pokaz opcje importu),
wskazemy odpowiedni plik i klikniemy Open, zostanie wyswietlone okno
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dialogowe Microsoft Word Import Options (Opcje importu programu Microsoft
Word). Mozemy tu okresli¢, czy chcemy (lub nie) importowaé utworzone w tym
programie przypisy dolne i konicowe, spis tresci lub znaczniki skorowidza.
Wybranie opcji Preserve Styles and Formatting from Text and Tables (Zachowaj
style i formatowanie tekstu i tabel) spowoduje, ze wraz z tekstem zostana wczy-
tane wszystkie informacje formatujace (style i zmiany lokalne). Zaleznie od tego,
jak przygotowano ostylowanie zr6dlowego dokumentu, opcja ta moze by¢
blogostawieristwem lub przekleristwem. W najlepszym wariancie, o ile nazwy
stylow uzywane w dokumencie Word s3 identyczne do nazw juz zdefiniowanych
w dokumencie InDesigna, ustawienia styléw InDesign maja pierwszenistwo,
zatem cale formatowanie zostalo juz zrobione i bedziemy mogli wczesniej
p6j$¢ domu. Informacje, jak wykonaé mapowanie styléw akapitowych i znako-
wych programu Word na ich odpowiedniki w InDesignie, zawiera rozdziat 12,
-Globalne formatowanie przy uzyciu styléw”.

lMi“d. - e s d N e bt A A b L i Ltk e S

® Table of Contents Text ¥ Footnotes i

ol S Tea Whbiota™ o o
Optiong —— s S e T [ R

© Use Typographer's

Korzystanie z edytora watkow

inDesign udostepnia alternatywny tryb przegladania i redagowania tekstu.
W Edytorze watkow tekst jest wyswietlany w postaci pojedynczego, cigglego
bloku, przy uzyciu jednego fontu o ustalonej wielkosci. W celu wyswietlenia
rekstu w edytorze watkéw nalezy zaznaczy¢ ramke tekstowa dowolnym narze-
dziem, po czym wybrac polecenie Edit > Edit in Story Editor (Edycja > Edytuj
w edytorze watkéw) albo uzyé skrétu Cmd/ Ctrl+Y.

Istnieje kilka powodéw, dla ktérych moglibyémy chcieé korzystaé z edytora
watkow. Najwazniejszym z nich jest to, ze edytowanie tekstu, a szczegélnie
iego dluzszych fragmentéw, jest znacznie szybsze bez koniecznosci odswie-
zania na biezgco grafiki, zmian ukladu taméw czy wygladu. Nie musimy sie
przejmowac przenoszeniem obszaru roboczego, zmianami powiekszenia ani
przechodzeniem ze strony na strong — w tym trybie prezentowana jest ,czysta
tre$¢”. Dowolne zmiany wykonywane w edytorze watkéw sa natychmiast
odzwierciedlane w trybie podgladu uktadu i vice versa. Mozna w ten sposéb
nie tylko szybko dokonywaé zmian w samym tekscie, ale réwniez nadawac¢
style akapitowe lub znakowe.

RYSUNEK 2.24 Opcje okna
dialogowego Word Import
Options umozliwiaja okresle-
nie, jakie elementy i formato-
wanie dokumentu maja zostac
przekazane do InDesign.



38 InDesign i tekst  Profesjonalna typografia w Adobe InDesign

RYSUNEK 2.25 Tekst wy-
swietlany w edytorze watkow
(po lewej); ten sam tekst w wi-
doku uktadu z wigczong wi-
docznoscia linii pomocniczych
(po prawej).

Jeslilewa kolumna wyswietlajaca nazwy zastosowanych styléw nie jest widoczna,
nalezy uzy¢ polecenia View > Story Editor > Show Style Name Columns (Widok >
Edytor watkéw > Pokaz kolumne nazwy stylu). Polecenie Show Depth Ruler
(Pokaz miarke glebi) wy$wietla pionowa miarke na lewo od wlasciwego tekstu
w edytorze watkéw, ktéra ukazuje dtugosé pojedynczej szpalty tekstu w aktu-
alnie uzywanych jednostkach (np. w punktach, jesli zgodnie z wcze$niejszymi
zaleceniami wybrali$my je jako jednostke domysIng). Powrét do widoku uktadu
umozliwia skrét Cmd+W/ Ctrl+W.

Zmiang wygladu tekstu w edytorze watkéw umozliwia polecenie Preferences >
Story Editor Display (Preferencje > Wyswietlanie edytora watkéw).

Korzystanie z edytora watkéw mozna poréwnaé do otwarcia maski samo-
chodu w celu obejrzenia silnika. Mozna w ten sposéb zobaczy¢ i latwiej uzyskaé
dostep do elementéw, ktére s3 ukryte lub trudne do zauwazenia w zwyktym
trybie: znacznikéw wstawionych grafik i zakotwiczonych obiektéw, zmiennych
tekstowych, hipertaczy, niedrukowalnych notatek, znacznikéw indeksowych
lub tagéw XML. Edytor watkéw umozliwia tez edycje tekstu niemieszczacego
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sie, }acznie z zawartoscig komérek tabel (jest to nowa cecha wersji

css). Tekst taki jest wyrézniany czerwong kreska na lewo od tresci  Text Display Options il
oraz komentarzem Overset text (Niemieszczacy sig). Dzigki temu, Font: Letter CothicSid @4 [12pt  8)
- , - . . . Line Spacing: Singlespace E

ze edytor watkéw ujawnia rzeczy, ktére nie s3 dostepne w zwy- :

P - s . . oS Cotol 9 Nack Sphina of
ktym trybie, jest uzyteczny przy rozwigzywaniu probleméw Background: p?;ck quar
. . . . R R . . B e Judge my
kompozycyjnych, jak nieoczekiwane ztamania wiersza lub poja- Thadre: rinkonPupir

# Enable Anti-aliasing

.Tm: E Mﬁih____-_-- 9

dlaczego tekst tajemniczo ,ucieka” z ramki tekstowej (zapewne I e

wiajace sie ,znikad” wielkie odstepy. Jesli chcemy zrozumie¢,

z powodu niewlasciwego ustawienia opcji Keep), uzyjmy edytora RYSUNEK 2.26 Ustawienia preferencji okreslaja
wyqlad tekstu w edytorze watkow. Nie maja one
wplywu na to, jak bedzie on wygladat w widoku
uktadu lub po wydrukowaniu,

watkow!

Sprzatanie tekstu

Po umieszczeniu pliku tekstowego w dokumencie pierwsza rzecza do zrobie-
nia — zanim zaczniemy w ogoéle pracowa¢ nad formatowaniem — jest jego
wyczyszczenie. Projektanci zwykle pracuja z plikami tekstowymi przygoto-
wanymi przez kogo$ innego. W $wiecie doskonatym pliki te bylyby czyste jak
sniegi tak minimalistyczne jak meble projektowane przez mistrzéw Bauhausu.
Niestety, jest to rzadki przypadek, o ile w ogéle zdarza sie kiedykolwiek. Ludzie
za$miecaja swoje dokumenty wszelkiego rodzaju zbednymi ozdobnikami, czesto
mylnie) sadzac, Ze w ten sposéb pomagaja nam we wlaéciwym sformatowaniu
pracy. Dodatkowe korice wierszy, wielokrotne tabulatory, spacje (niekiedy
uzywane w celu wyjustowania wierszy) — wszystko to musi zosta¢ usuniete.
Oczywiscie, mozna powiedzie¢, ze nalezy raczej zawczasu uprzedzi¢ klienta

bullet

Dash Dash to Em-dash

Straight Double to Typographers Quote
Straight Single to Typographers Quote

Dash to En-dash
fix last lines
Multiple Return to Single Return

Multiple Space to Single Space
Phone Number Conversion {dot format)
Remove Trailing Whitespace

(4] il Drop Shadow 1
| Overprint Black Stroke I 1
Query ¥ [Custom] I

- Find what: ( Done ) {

| RYSUNEK 2.27 Korzystanie ze wstepnie zde-
| finiowanego zapytania GREP w celu usuniecia
1 zbednych spacji z dokumentu.




40 InDesign i tekst  Profesjonalna typografia w Adobe InDesign

RYSUNEK 2.28 Skrypt
FindChangeByList to najszyb-
sza metoda wymiecenia zbed-
nego spacjowania z watku lub
dokumentu.

(autora, redaktora), jak powinien wyglada¢ tekst, i by¢ moze nawet uda sie
osiagna¢ pozadany efekt. Ale nawet przy najlepszej komunikacji i najlepszych
intencjach, nadal musimy wykona¢ porzadki w otrzymanym tekscie, nawet
wtedy, gdy jest to plik wykonany przez nas samych. Na szczescie istnieje moz-
liwoé¢ szybkiego i fatwego nadania wlasciwego ksztattu otrzymanym tekstom.
Dobrym punktem wyjscia s wstepnie zdefiniowane zapytania GREP.

Najszybsza metoda czyszczenia tekstu jest skrypt FindChangeByList. Jak
kazdy skrypt w programie InDesign, jest zdefiniowany jako sekwencja czyn-
nosci, ktérag mozna powtérzyé pojedynczym kliknigciem. Mozna tez tworzy¢
wlasne skrypty w jezyku JavaScript (albo AppleScript lub Visual Basic dla
$rodowisk Macintosh i Windows odpowiednio), ale na szczescie istnieje pewna
liczba przydatnych skryptéw przyktadowych, z ktérych mozemy korzystaé bez
konieczno$ci uczenia sie jezykéw skryptowych.

Panel Scripts wyswietlany jest poleceniem Window > Utils > Script (Okno >
Uzytki > Skrypty)”. Po wyswietleniu panelu nalezy przejé¢ do folderu Application,
nastepnie Samples i na koniec otworzy¢ folder JavaScript. Po podwéjnym klik-
nigciu wpisu FindChangeByList w mgnieniu oka ten drobny klejnot wykona
seri¢ zamian w zaznaczonym fragmencie, watku lub calym dokumencie. Aby
zobaczy¢, co dokladnie robi — a takze w celu jego dopasowania do naszych
potrzeb — mozemy otworzy¢ folder FindChangeSupport wewnatrz folderu
skryptéw i nastepnie klikna¢ prawym klawiszem plik FindChangeSupport.txt,
aby wyswietli¢ go w Finderze lub Eksploratorze Windows. Nastepnie mozna
otworzy¢ ten plik w dowolnym edytorze i zmieni¢ zawarta w nim liste regut
zamiany. Najwygodniejsza metoda zachowania poprawnosci sktadni jest sko-
piowanie jednej z istniejacych regul i zmienianie jej zawartosci.

Nawet jesli ktos nie czuje si¢ dostatecznie biegty, aby zmienia¢ zawartos¢
tego pliku, on sam pozwala usungé wiele ,$mieci”, takich jak wielokrotne spacje,
zamieni¢ dywizy na prawdziwe myslniki i wiele innych. Warto tu jednak doda¢
slowo ostrzezenia, dotyczace zreszta korzystania z dowolnych skryptéw: Jesli
sprobujemy uzy¢ opcji Undo (Cofnij) po wykonaniu skryptu, okaze sie czesto,
ze musimy naciska¢ Ctrl+Z wiele, wiele razy, zanim powrécimy do stanu pier-
wotnego. Wynika to z faktu, ze skrypt stanowi sekwencje dziatan, zag Undo cofa
tylko jeden krok z tej sekwencji za kazdym razem. Aby méc pracowa¢ bezpiecz-
nie, lepiej zapisac prace, zanim uruchomimy skrypt. Dzigki temu mozna bedzie
tatwo powréci¢ do poprzedniego stanu, uzywajac polecenia Revert (Przywré¢),
jesli efekty okaza sie niezgodne z zamierzeniami.

2 We wczedniejszych (do cs4) wersjach programu InDesign opcja ta jest dostepna
w podmenu Automation.
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RYSUNEK 2.29 Seria zapytan

Jarep,  {fincWhat:® o7} {changeTo:" “} {includef strue, incl 'oges :true,
! 1ncludeHiddeniayers itrue, wholeWord:false} Find oll double spoces and reploce with single spaces. wykonywanych przez skrypt
jarep,  {findWhat:"\r "} {changeTo:"\r"} {includef strue, incl 'oges:true, Fi‘ndChangeByUsr, zawarta
| inc ludeHidderd ayers :true, wholeWord:false} Find all returns followed by o spoce And reploce with single returns. o .
wep,  {findWhat:® \re} {changeTo:"\r"} {includeFootnotes:true, deMosterPoges itrue, w domysinym pliku steruja-
ncludeH iddend ayers ;true, wholeYord:false} Find all returns followed by o spoce ond reploce with single returns. cym. Plik ten mozna dOWUh'IiE
arep,  {findWhat:=\tits"} {changeTo:"\t"} {includeFootnotes:true, inclL oges (Lrue, . . 5
includeHidderLayersitrue, wholevord:false} Find all double tab choracters ond replace with single tab characters. modyfikowac, a takze mozna
arep. {f ind¥hat : =™} {changeTo:"\r"} {includeFootnotes:true, includeMasterPoges:true, stosowac wiele réinyth p|i|“5w
wnc ludeHidderLayers:true, wholeWord:false} Find all returns followed by o tob charocter ond reploce with single .
eturns. z regutami.
(arep. {find¥hat:=\thr=} {changeTo:"\r"} {includeFootnotes: true, incl oges itrue,
g ludeHiddenlayers:true, vwhole¥ord:folse} Find all returns followved by o tob charocter ond reploce with single
returns.
Frep.  {find¥hat:"\rirs"} {changeTo:"\r"} {includeFootnotes:true, 0ges true,
mc ludeHiddenLayerstrue, wholeWord:folse} Find all double returns aond reploce with single returns.
teat {find¥hat == - "} {changeTo:"*<"} {includeFootnotes:true, includeMosterPoges:true,
ncludeHiddenLayers:true, wholedord:false} Find all spoce-dash-spoce ond reploce with on en dash.
Text {findhat :*--"} {changeTo:"*_"} {includeFootnotes:true, includeMosterPoges:trus, includeHiddenlLayers:true,
vholedord:false} Find all dosh-dash and reploce with an em dash.
spacja
y P .

Wyswietlanie ukrytych znakéw 9 roniec akapitu

Widocznos¢ ukrytych znakéw znacznie ufatwia rozwigzywanie potencjalnych =1 wymuszone zlamanie wiersza

probleméw, gdyz w tym trybie mozemy zobaczy¢ wymuszone zlamania wier- T

tal tor

sza, tabulatory i wielokrotne spacje (a takze inne niewidoczne znaki), ktére
moze zawierac nasz tekst. Przelgczanie wyswietlania ukrytych znakéw umoz-
liwia polecenie Type > Show/Hide Hidden Character (Tekst > Pokaz / Ukryj znaki
ukryte). Zmiane mozna tez wykona¢ w dowolnej chwili uzywajac opdji Hidden
Characters (Znaki ukryte) w gadzecie opcji wyswietlania w pasku menu, albo
skrétem Cmd+Option+ (Ctrl-+Alt+l).

-

tabulator réwnany do prawe;
spacja firetowa

spacja polfiretowa

spacja cienka

T weciecie do tego miejsca

RYSUNEK 2.30 Niektdre cze-
sto uzywane znaki ukryte.
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Formatowanie znakow

PALETA STERUJACA OFERUJE OGROMNE BOGACTWO OPCJI — niektore sg oczywiste,
ale inne znacznie mniej. Ich rozmieszczenie odzwierciedla ewolucje od przed-
cyfrowych czaséw. Aby méc osiagnad najlepsze rezultaty, musimy zdawac sobie
sprawe z licznych konwencji zwigzanych ze stosowaniem tych opcji. Przegla-
dajac elementy sterujgce formatowaniem znakéw, bede starat sie pokazac,
jakie historyczne precedensy kryja sie za poszczegélnymi przyciskami i jakie

sg uwarunkowania estetyczne stosowania poszczegolnych cech i opciji.
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Metody zaznaczania tekstu

Zanim mozliwe stanie si¢ formatowanie tekstu, musimy go najpierw zaznaczy¢.

Ponizsza lista zawiera niektére skréty przydatne przy zaznaczaniu tekstu

i poruszaniu si¢ wewnatrz watkéw tekstowych:

® Zaznaczenie jednego stowa: podwéjne klikniecie tego stowa.

Zaznaczenie jednego wiersza: potréjne klikniecie w tym wierszu
(zalezne od ustawien preferencji).

Zaznaczenie do poczatku wiersza: Shift+Home.

Zaznaczenie do konica wiersza: Shift+End.

Zaznaczenie do poczatku akapitu: Cmd/ Ctrl+Shift+strzatka w gére.
Zaznaczenie do korica akapitu: Cmd/ Ctrl+Shift+strzatka w dét.
Usunigcie jednego stowa na prawo albo lewo od kursora:

Cmd/ Ctrl+Delete albo Backspace.

Przeniesienie kursora na poczatek lub koniec watku: Cmd/ Ctrl+Home
lub End.

Zaznaczenie tekstu od pozycji kursora do poczatku lub korica watku:
Cmd+Shift+Home lub End / Ctrl+Shift+Home lub End.

Przeniesienie kursora na poczatek wiersza: Home.

Przeniesienie kursora na koniec wiersza: End.

Przesuniecie kursora o jeden wyraz w lewo: Cmd/ Ctrl+strzatka w lewo.
Przesunigcie kursora o jeden wyraz w prawo: Cmd/ Ctrl+strzatka

W prawo.

Przeniesienie kursora na poczatek nastepnego akapitu:

Cmd/ Ctrl+strzatka w dét.

Przeniesienie kursora na poczatek poprzedniego akapitu:

Cmd/ Ctrl+strzatka w gére.



Opcje formatowania znakéw

W tym podrozdziale przyjrzymy sie blizej podstawowym opcjom dostepnym
w palecie sterujacej w sekcji Character Formatting Controls (Sterowanie forma-
towaniem typografii).

Czcionka

W celu zmiany czcionki uzywanej w zaznaczonym fragmencie tekstu mozemy
uzy¢ listy rozwijanej Font (Czcionka) w palecie sterujacej. Podczas edycji tekstu,
gdy sekcja formatowania znakéw jest aktywna, mozemy bezposrednio przeji¢
do listy Font, uzywajac skrétu Cmd+6/ Ctrl+6. Jeéli teraz zaczniemy wpisywac
nazwe fontu, InDesign wstawi do pola najblizsza pasujaca nazwe. Mozemy
poruszac si¢ pomiedzy poszczegdlnymi pozycjami na licie przy uzyciu strza-
tek w gére lub w doét. Klikniecie przycisku obok listy powoduje rozwiniecie jej
z jednoczesnym ukazaniem przyktadu (kilka znakéw) wygladu danej czcionki.
Naturalnie nie moze to zastapi¢ porzadnego katalogu czcionek, takiego jak
FontBook: Digital Typeface Compendium (FontShop International). Mozna jednak
przegladac wzory czcionek w takich witrynach, jak http://store.adobe.com/type,
w tym wypadku prezentujacej czcionki z Adobe Type Library.

Czcionki na li$cie zaopatrzone s3 w dodatkows ikone, sygnalizujaca rézne
typy fontéw:

0 OpenType
@ Type1
T TrueType

Funkcje podgladu mozna wytaczyé w ustawieniach preferencji. Mozna tam
réwniez okresli¢ wielkos¢, w jakiej wyswietlane sa przyktady.

Tm Ws ............................................ o
 Use Typographer's Quotes [
™ Type Tool Converts Frames to Text Frames { WhatTheFont
# Automatically Use Correct Optical Size ;
# Triple Click to Select a Line : .
| Apply Leading to Entire Paragraphs

E Adjust Spacing Automatically When Cutting and Pasting Words

E Font Preview Size: F_lum E !

Subwmic a0 Image ol

RYSUNEK 3.1 Opcja Font Preview Size (Rozmiar podgladu B

czcionki) w preferencjach tekstu. | Tips for optimal results:

RYSUNEK 3.2 Narzedzie WhatTheFont, umozliwiajace

|

| Seen a font in use and want to know what it is?

| Subrwit an image to WhatTheFant 1o find the closest marches in car database, O, lat choak -
draged font enthuslasts lend 2 hand im the WhatThefart Fo

Submit Your IMage DEre sweews “ie s 398 For et reswis sor 150 =g o s o5

| Upload & file: [ chesse i s e swisoes

Uphssd  Chiwater sebection
. 4
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WSKAZOWKA: Jesli zoba-
czymy gdzies kroj czcionki,
ktory nam sie podoba

i chcemy ustali¢, co to jest,
mozna wykorzystac
mechanizm rozpoznawania
fontéw udostepniany przez
witryne MyFonts http:/new.
myfonts.com/WhatTheFont.
Po zatadowaniu bitmapy

z fragmentem tekstu
mechanizm ten sprébuje
znalez¢ mozliwie podobny
kréj wérdd wszystkich
dostepnych w tej witry-
nie. Jesli automatyczne
rozpoznawanie nie da
zadowalajacego efektu,
mozna sprobowad wystac
skanowany obraz na ktéres
forum typograficzne

(na przyktad WhatTheFont
Forum), ktérego cztonkowie
moga pomoc w rozpozna-
niu danego kroju. Istnieje
nawet aplet WhatTheFont
dla iPhone.

identyfikacje czcionek w trybie online.
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RYSUNEK 3.3 Krdj Univers
Adriana Frutigera

Styl czcionki'

Wybér réznych styléw czcionek — takich jak np. wyttuszczone lub pochylone —
w ramach tej samej rodziny krojéw pozwala na zastosowanie wyréznier lub
oznaczenie hierarchii przy jednoczesnym zachowaniu ciaglosci stylistycznej.
InDesign nie umozliwia stosowania ,falszywych” odmian wytluszczonych ani
kursywy — nie znajdziemy w nim przyciskéw B czy I, powodujacych pogrubienie
lub pochylenie tekstu. Zamiast tego dostepna jest lista styléw, ktére zawiera
dana rodzina. Jesli dla wybranego kroju istnieja odmiany italic i bold (kur-
sywaiwytluszczenie), mozna je zaaplikowa¢, uzywajac skrétéw klawiszowych
Cmd/Ctrl+I oraz Cmd/ Ctrl+B.

Kréj czcionki (rodzina fontéw) moze zawierac bardzo wiele odmian (stylow),
a ich nazwy moga by¢ najrozmaitsze, zaleznie od upodoban, a nawet fantazji
ich twércéw. Czcionka, ktéra nie jest pochyla, zwykle okreslana jest terminem
roman’. Najbardziej ,normalny” (przeznaczony dla podstawowego tekstu) styl
zazwyczaj nazywa sig regular, ale mozna tez spotkac kroje, w ktérych ta odmiana
nosi nazwe book albo medium. Terminy italic i oblique dotycza odmian pochytych,
przy czym ta druga jest spotykana w niektérych krojach bezszeryfowych®.
Okreélenia takie, jak ligth (lekki), semibold (pétgruby), bold (gruby) czy black
(czarny) dotycza wagi czcionki (optycznego ,cigzaru” czy tez stopnia zaczer-
nienia) i ich sens jest oczywisty. Z rzadziej spotykanych okresleri wagi warto
wymienic heavy (cigzki) oraz extra bold (bardzo gruby). Wreszcie mamy terminy
okreslajace wzgledna szerokos¢ danej odmiany (w stosunku do wersji ,normal-
nej”): condensed oznacza czcionke zwezona, zas extended — poszerzona. Inna
metoda okreslania wagi i szerokoéci w obrebie rodziny czcionek jest poprzedze-
nie nazw odmian prefiksem numerycznym. Pierwszym krojem uzywajacym tej
konwencji byt Univers, zaprojektowany przez Adriana Frutigera w 1957 roku.
Im wigksza liczba, tym ci¢zsza odmiana kroju. Liczby nieparzyste wskazuja
odmiany proste (roman), za$ liczby parzyste — pochylone, jakkolwiek w now-
szych wydaniach kroju Univers pochylone odmiany s3 identyfikowane stowem
oblique, a nie numerem.

1 Wtasciwa nazwa to odmiana kroju, jednak w wigkszosci spolonizowanych programéw
(réwniez w Adobe InDesign €s5) wystepuje termin ,styl czcionki”.

2 W polskiej tradycji typograficznej kroje takie nazywane s antykwami.

3 Réznica pomigdzy prawdziwa kursywa (italic) a krojami pochylonymi, okreslanymi
stowem oblique, jest glgbsza. Kursywy uzywaja odmiennego ksztattowania niektérych
liter i — méwiac w najwigkszym skrécie — wyewoluowaly z kaligraficznego pisma
recznego. Kroje pochylone powstaja przez ,mechaniczne” pochylenie antykwy, przy
czym zwykle korygowane sa grubosci kresek i swiatta wewnetrzne, zatem nie s3 one
réwnowazne czcionce znieksztalconej, ale nie s3 tez prawdziwymi kursywami.



Italiki

Kursywy, zwane tez italikami ze wzgledu na fakt, ze wyewoluowaly we Wioszech, stuza
zwykle jako uzupelnienie ich prostych odpowiednikéw. Wiekszoé¢ fontéw dysponuje
odpowiadajagcymi im italikami. Nazwa firmy, ktéra stworzyta poprzednik programu
InDesign, PageMaker, pochodzi od imienia Aldusa Manutiusa (1449-1515), weneckiego
drukarza, ktory jako pierwszy uzyt kursywy w druku w poczatkach xvi wieku.

Italiki s3 oddzielnymi krojami rzadzacymi si¢ wtasnymi prawami — nie s3 to po
prostu pochylone wersje antykwy. Gdy powstawaly, byly traktowane jako co$ catko-
wicie odrgbnego od form krojow prostych. Z czasem zaczeto taczyé kursywy w pary
z pasujagcymi antykwami, ale nadal zachowaly wezsze proporcje i unikatowe ksztatty
niektérych liter.

Kursywy moga mie¢ wiele réznorodnych zastosowan:

= Wyrdznienia.

® Zaznaczenie obcojezycznych stéw lub zdan, o ile wyrazy te nie sa na tyle pow-
szechne, ze nie wymagaja odrézniania (napiszemy na przyktad da capo al fine,
ale kotlet de volaille juz nie wymaga kursywy). Konwencja taka moze zmienia¢
sie z uptywem czasu — dobrym sposobem upewnienia sig, czy wyrdznienie jest
jeszcze potrzebne, jest sprawdzenie, czy dany wyraz pojawit sie juz w stowniku
naszego jezyka.

® Wzmiankowane w tekscie tytuly ksiazek, filméw, czasopism czy dziet sztuki.

® W pisanym dialogu zaznaczenie, ze dana fraza jest tylko pomyslana, a nie

wypowiedziana przez posta¢ literacka.

Typowym (i stusznym) zaleceniem jest unikanie sktadania dtuzszych fragmentéw
tekstu przy uzyciu kursywy. Kaligraficzny bieg tych krojéw powoduje, ze tekst wydaje
sig ,przyspieszony”. Moze sie tez zdarzy¢, ze nadmiernie dekoracyjne znaki przyciagna
zbyt wielka uwage, odwracajac ja od wtasciwej tresci. Przy nadmiernym uzyciu uni-
kalnos¢ kursywy zostanie utracona. Mozliwe tez, ze trudniej jest czytaé dtugi tekst
zlozony kursywa po prostu dlatego, ze nie jesteémy do tego przyzwyczajeni.

How razorback-jumping frogs

How razorback-jumping frogs
can level six piqued gymnasts!  Helvetica Oblique

can level six piqued gymnasts! Chaparral Pro Italic
How razorback-jumping frogs
can level sixpfquedgymnasts! Fatszywa kursywa (Chaparral Pro)
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RYSUNEK 3.4 Po lewej: porownanie form liter w antykwie i kursywie (Adobe Caslon Pro). Po prawej od géry: prawdziwa kursywa (italic),

fatszywa kursywa (zwré¢my uwage na inny ksztatt liter, szczegélinie dobrze widoczny w a i ) oraz kroj pochylony (oblique).
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RYSUNEK 3.5 Zestawianie
réznych wag w obrebie
rodziny czcionek. Od géry:
regular i bold, light i semi-
bold, regular i semibold.
Dwie gérne pary zapewniaja
wyrazny kontrast, w ostat-
niej parze odmiany s3 zbyt
podobne.

Istnieje wiele sposobéw
wyrdzniania tekstu.
Najczgstsze jest stoso-
wanie wytluszczenia
lub kursywy, ale moina
tez uzy¢ innego koloru
lub podséwietlenia. Bez
wzgledu jednak na wy-
brang metodg, zawsze
wystarczy tylko jeden
sposdb, aby wprowadzié
wyréznienie. Na przy-
ktad nadmiarowe jest
uzycie jednoczesnie
wytluszczenia i kur-
sywy albo wytluszcze-
nia z dodatkowym
kolorem.

RYSUNEK 3.6 Rdzne sposoby
tworzenia wyréznien

Wyttuszczenie

Kroje wyttuszczone lub pogrubione (bold) zazwyczaj sa stosowane do nagtéw-
kéw, tytuléw i podtytuléw, pozwalajac okresli¢ hierarchie. Sa réwniez czesto
wykorzystywane (szczegélnie w czasopismach) do wyrézniania pomocniczego
tekstu, takiego jak uwagi na marginesie, podpisy lub cytaty, poprzez zastoso-
wanie odmiany bold lub semibold czcionki uzywanej dla zasadniczego tekstu.

W wigkszych rodzinach krojéw moze istnie¢ kilka odmian pogrubionych,
od pélgrubej (semibold) po extra bold lub heavy. Majac do dyspozycji wiele odmian
tej samej rodziny (co wida¢ w menu styléw fontu), nalezy zwykle stosowa¢
odmiany réznigce sig co najmniej o dwa ,kroki”, aby osiagna¢ wtasciwy kontrast.
Na przyklad jako dopelnienia dla odmiany regular uzyjemy wersji bold, a dla
odmiany light — semibold. Zestawienie wersji regular i semibold zazwyczaj nie
zapewni dostatecznego kontrastu.

Wykorzystanie odmiany grubej zamiast kursywy do wyrézniania fragmentéw
tekstu jest decyzja estetyczna. Jesli juz uzywamy pogrubies, rébmy to z umia-
rem. Gdy wszystko jest wyr6znione, nic nie jest wyréznione. Pogrubienia tekstu
tamig cigglos¢ tekstu i nadaja tresci ton ,dydaktyczny”. Oko skacze odruchowo
do tekstu pogrubionego jako czego$ oddzielnego, a nie traktuje wyréznienia
jako ciaglego elementu tresci, tak jak to jest w przypadku kursywy zlewajacej
sie¢ harmonijnie z antykws.

Z perspektywy historycznej, stosowanie krojéw grubych moze podwaza¢
wrazenie autentycznosci drukowanej strony, gdyz az do X1X wieku nie istniato
cos takiego jak pogrubiona czcionka. Do wyréznieri drukarze stosowali kapi-
taliki lub kursywe. Jak pisze Robert Bringhurst w swej nieocenionej ksigzce
Elementarz stylu w typografii®, niewtaéciwie uzywane odmiany pogrubione
»przyczyniaja si¢ do powstawania niezamierzonych anachronizméw, jakby
do scenografii do Kréla Leara wprowadzi¢ silnik parowy lub faks”.

Stopien pisma

Oprécz okreslania stopnia pisma® (rozmiaru czcionki) za pomoc pola nume-
rycznego w palecie sterujacej, mozna réwniez zmienia¢ wielkos¢ zaznaczonego
tekstu skrétami klawiszowymi. Cmd/ Ctrl+Shift+> zwigksza stopier pisma
o warto$¢ zdefiniowana w preferencjach programu. Cmd/ Ctrl+Shift+< powoduje
zmniejszenie stopnia o te samg wielkos¢. Przytrzymanie dodatkowo klawisza
Option/Alt sprawia, ze wielkos¢ skoku zwigkszana jest pieciokrotnie.

4 Wyd. polskie Design Plus, Krakéw 2007, s. 62.

5 W polskiej wersji interfejsu InDesigna stosowany jest termin ,rozmiar czcionki”,
jednak wlasciwy termin typograficzny w jezyku polskim to ,stopier pisma” — pojecia
te nie s3 rbwnowazne i nie powinny by¢ uzywane zamiennie.
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Jesli pominiemy Shift i naciéniemy tylko Cmd/ Ctrl wraz z klawiszem <
lub >, spowoduje to przeskalowanie zaréwno wielkoéci tekstu, jak i catej ramki
w tym samym momencie. Skalowanie to odbywa sie wzgledem rozmiaréw ramki

0 1% za kazdym razem), a nie rozmiaréw czcionki®,

Gdy formatujemy pojedyncze stowo lub wiersz nagtéwka, czesto tatwiej jest
iednoczesnie dopasowywac wielkos¢ czcionki i ramki. W tym celu najpierw nary-
sujmy pusta ramke narzedziem Tekst, po czym wpiszmy do niej wlasciwg tresé.
Jesli ramka jest wieksza, niz to niezbedne do pomieszczenia tekstu, mozemy
kliknac ikone Fit Frame to Content (Dopasuj ramke do zawarto$ci) w palecie
sterujacej albo uzyé skrétu Cmd+Option+C/ Ctrl+Alt+C. Spowoduje to doktadne
dopasowanie ramki do zawartego w niej tekstu. Aby recznie (na oko) przeska-
lowad ramke z tekstem, nalezy przytrzymaé klawisze Cmd+Shift/ Ctrl+Shift
podczas przeciagania jednego z uchwytéw na rogach. Spowoduje to jednoczesne
skalowanie zawartosci (rozmiaru czcionki) wraz ze zmiana wielkoéci ramki
i zachowanie proporcji. Zmiane rozmiaréw ramki wraz z zawartoécia umozliwia
tez narzedzie Scale (Przeksztatcanie swobodne).

Typowe stopnie pisma i terminy uzywane do ich opisu

Tekst gtéwny (body text lub body copy) to tekst tworzacy wieksza czeéc ksiazki
lub artykutu (zazwyczaj w stopniu od 8 do 12 punktéw) i niosacy zasadnicza
tres¢. Wybierajac rozmiar czcionki dla tekstu gtéwnego, zwykle nalezy siggna¢
po wielkosci mniejsze, niz by sie wydawalo na pierwszy rzut oka. Zbyt duzy
stopien nadaje stronie wyglad amatorski i niezdarny. Jakkolwiek domy$lna
wielkoscig w InDesignie jest 12 punktéw (i wyglada to catkiem dobrze na ekra-
nie), zapewne bedzie to zbyt duzo po wydrukowaniu. Dobrym punktem wyjscia
zazwyczaj jest 10 punktéw, po czym wielkoé¢ te mozna nieco powigkszy¢ lub
zmniejszy¢, stosownie do charakterystyki wybranego fontu (a takze potrzeb
i rodzaju planowanych odbiorcéw).

Pismo tytulowe (display) to tekst w duzym rozmiarze (zazwyczaj 18 punk-
téw i wigcej), ktérego gléwnym celem jest bycie dostrzezonym, przyciggniecie
uwagi czytelnika. Choé rozmiar zazwyczaj sygnalizuje przeznaczenie takiego
tekstu, nie zawsze musi tak by¢. Na przyktad zmniejszony tytul moze réwniez
przyciggnad uwage — wlasnie dlatego, ze jest to nieoczekiwane.

Podtytuly (subhead) pozwalaja podzieli¢ tres¢ na mniejsze fragmenty, ktére
sq bardziej atrakcyjne wizualnie niz ciag nieodréznialnych akapitéw. Z jednej

6 Warto tu zauwazy¢, ze skalowanie tekstu w ramce nastepuje jedynie wéwczas, gdy
ramka ta jest izolowana — nie jest polaczona z zadng inna. W przypadku ramek
stanowiacych czeéé dluzszego watku skalowanie dotyczy tylko samej ramki i nie
ma wplywu na stopien pisma zawartego w niej tekstu.
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RYSUNEK 3.7 Wykorzystanie
whbudowanej skali stopni
pisma do utrzymania harmonii
pomiedzy réznymi wielkos-

ciami czcionek.
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Tytul

Podtytul
Tekst glowny
Podpis

RYSUNEK 3.8 Typowe
wielkosci ztozone fontem
Chaparral Pro:

Tytut - Bold 24 pt,

Podtytut - Bold 12 pt,

Tekst gtdwny - Regular 10 pt,
Podpis - Semibaold 8 pt.

I~ When Scaling -

() Apply to Content
@ Adjust Scaling Percentage

A

37 s g

ﬁ 2119233 pt g

Stroke Styles...

Clear Transformations
Redefine Scaling as 100%

+ Dimensions Include Stroke Weight
v Transformations are Totals
+ Show Content Offset

« Dock at Top
Daock at Battom
Float

Customize...

C

RYSUNEK 3.9 Wybranie
opcji Adjust Scaling Percentage
w karcie General Preferences
(A) powoduje wyswietlanie
stopnia pisma w nawiasach,
jesli ramka wraz z zawartos-
cig zostanie przeskalowana,
co moze prowadzic do niejed-
noznacznosci i pomytek (B).
Aby usunac takie niepozadane
efekty, mozna zaznaczy¢
ramke, po czym wybra¢ pole-
cenie Redefine Scaling as 100%,
aby wyswietlac prawdziwe
wielkosci czcionek (C).

strony zapewniaja réznorodnosc i atrakcyjnos¢ wygladu strony, z drugiej za$
funkcjonuja jako sygnaly nowych tresci przekazywanych przez tekst. Podtytuty
moga uzywac tego samego lub bardzo zblizonego stopnia pisma, co tekst gléwny,
ale odrézniac si¢ krojem lub waga, albo tez moga by¢ o punkt lub dwa wieksze
od niego.

Podpisy (caption) ulatwiaja interpretowanie ilustracji i zazwyczaj sa sktadane
czcionka o punkt lub dwa mniejsza od gléwnego tekstu. W naszym $wiecie
nasyconym tre$ciami wizualnymi to podpisy s3 tym, na co niezdecydowany
lub $pieszacy sig czytelnik zwréci uwage, zanim zapozna sie z wlasciwg tres-
cig — lub zrezygnuje.

Wielkie czy mate litery?

Podczas gdy wersaliki (wielkie litery, zwane tez majuskutami) ewoluowaty
od czaséw rzymskich inskrypcji, uzywajacych kroju liter zwanego kapitala,
az do konica Vil wieku naszej ery nie bylo nic takiego, jak mate litery. Zastuga
ich stworzenia przypisywana bywa Alcuinowi z Yorku, czotowemu doradcy

Stopien pisma w nawiasach

Domysinie, jesli przeskalujemy ramke tekstowa, wraz z nig skalowany jest zawarty
w niej tekst. Na przyktad jesli podwoimy rozmiary ramki zawierajacej tekst w stop-
niu 20 punktoéw, wielkos¢ czcionki zmieni sie na 40 punktow.

Istnieje (zdecydowanie niezalecane) ustawienie preferencji, ktére zmienia
to zachowanie. Jesli na karcie General (OgélIne) preferencji programu zmienimy
ustawienie When scaling (Podczas skalowania) z domysinego ustawienia Apply
to Content (Zastosuj do zawartosci) na Adjust Scaling Percentage (Dopasuj pro-
cent skalowania), pole rozmiaru czcionki bedzie po przeksztatceniu wyswietlato
zaréwno oryginalng wielkosc, jak i przeskalowana, np. ,20 pt (40)".

Domyéinie przy wiaczonej opcji Apply to Content pola numeryczne skalowa-
nia wyswietlajg 100% po przeksztatceniu tekstu. Wiaczenie opdji Adjust Scaling
Percentage powoduje, ze w opisanym przykfadzie w polach tych pojawi sie war-
tos¢ 200%.

Opcja ta pojawita sie w celu umozliwienia monitorowania modyfikacji wiel-
kosci ramek — co moze by¢ przydatne, jesli zajdzie potrzeba przywrécenia ory-
ginalnej wielkosci ramki i tekstu. W praktyce jednak zazwyczaj tylko wprowadza
w biad i irytuje uzytkownikéw.

Jesli dostalismy od kogo$ dokument, w ktérym stopnie pisma zawieraja liczby
w nawiasach, i chcielibysmy, aby pokazywaty one ,prawdziwe” wielkosci, mozemy
uzyc polecenia Redefine Scaling as 100% (Przedefiniuj skale na 100%). Polecenie
to nie zmienia wymiaréw ani wygladu przeskalowanej ramki.
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Karola Wielkiego w sprawach koscielnych i edukacyjnych, ktéry dostrzegt
potrzebe standaryzacji tekstéw liturgicznych — stad pierwsze pismo nie wzo-
rowane na rzymskich kapitatach nazywane jest minuskulg karoliriskq’. Wraz
z wynalezieniem w Europie prasy drukarskiej okolo 1450 roku (cho¢ maszyny
takie istnialy juz od dawna w Chinach i Korei) rozpowszechnily sie ruchome
czcionki i jednoczesne korzystanie zaréwno z majuskuly, jak i minuskuty®
(i zarazem pojawilo sie pojecie rejestru jako zakresu znakéw obejmujacego badz
jedna, badz druga grupe)®. Obecnie niemal wszystkie fonty zawieraja zaréwno
wielkie, jak i male litery, ale istnieje pewna liczba fontéw okresélanych jako
unicase (jednorejestrowe) lub unicameral. Na przyklad Trajan, zaprojektowany
przez Carol Twombly (1959- ), zawiera tylko formy majuskulowe, podczas gdy
Universal Herberta Bayera (1900-1985) udostepnia tylko mate litery. W istocie
Bayer, jeden z gléwnych reprezentantéw Bauhausu, forsowat koncepcje catko-
witego porzucenia wielkich liter jako niepotrzebnych.

Dluzszy, zwarty tekst zlozony jednym rejestrem moze sprawia¢ trudnos¢
w czytaniu. Tekst zlozony samymi wielkimi literami jest znacznie mniej
czytelny, niz ,zwykly” sktad taczacy zaré6wno wielkie, jak i mate litery, gdyz
ksztalty wszystkich stéw sa podobne i mozna je odrézni¢ tylko po dtugosci.
Ludzie rozpoznaja stowa jako ksztalty — wydtuzenia gérne i dolne pomagaja
w szybkim identyfikowaniu liter i przyspieszaja czytanie. Ponadto tekst zlo-
zony samymi wersalikami wydaje si¢ nieproporcjonalnie duzy w zestawieniu
ze zwyklym ,mieszanym” tekstem — stad powstata potrzeba stworzenia kapi-
talikéw. Podobnie jak krzyk nie zwieksza jasnoéci komunikatu, zlozenie tekstu
wersalikami nie sprawi, ze informacja bedzie bardziej przekonywujaca. Z drugiej
jednak strony, tekst ciagly zlozony samymi malymi literami utrudnia rozpo-
znanie poczatkéw zdan i tak naprawde jest odpowiedni jedynie wéwczas, gdy
kto$ nazywa sie k. d. lang, bell hooks lub e. e. cummings™’.

7 Matle litery, czyli minuskuly, bywaja tez nazywane literami tekstowymi.

8 Angielskie nazwy odpowiednich rejestréw wywodzg sie z poczatkowego okresu
rozwoju druku. Drewniane, a p6Zniej metalowe czcionki grupowane byty w kasztach,
czyli drewnianych skrzynkach (ang. case), przy czym czcionki majuskutowe umiesz-
czano w wyzszej (ang. upper), za$ czesciej uzywane czcionki minuskutowe — nizszej
(ang. lower) kaszcie. W jezyku polskim niestety nie ma odpowiednika czasownika
casing, uzytego przez autora na tytul tego podrozdziatu.

9 Mozna zauwazy¢, ze — skoro majuskuty i minuskuty pochodzg z réznych histo-
rycznych zrédel — pojedynczy krdj nie powinien zawiera¢ znakow z obu rejestréw.
W istocie czcionki uzywane przez pierwszych drukarzy nie byly ujednolicone pod
tym wzgledem, ale juz wczesne projekty takich typograféw, jak Garamond lub Aldus,
zawieraly zaréwno wielkie, jak i mate litery.

10 Wymienione osoby zastynely m.in. z tego, ze domagaty sie zawsze, by ich nazwiska
pisaé wylacznie matymi literami.

THE
GREATEST
SHOW ON
EARTH

graphic design
architecture
interior design

RYSUNEK 3.10 Trajan

i Universal, dwa przyklady
krojow zawierajacych tylko
jeden rejestr.
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RYSUNEK 3.11 Ksztalty stow
tworzone przez wydtuzenia
gorne i dolne matych i wiel-
kich liter sprawiaja, ze tekst
jest tatwiejszy do odczytania,
podczas gdy stowa napisane
samymi wielkimi literami two-
rzg ksztatty, ktore sg zasadni-
czo identyczne (u gory).

Ten sam tekst ztozony samymi
wersalikami jest trudniejszy
do odczytania — a dodatkowo
Zajmuje znacznie wiecej miej-
sca (obok).

RYSUNEK 3.12 Tytut ztozony
wersalikami z interlinig auto-
matyczna (na gdrze) i zmniej-
szong (na dole).

During my lifetime I have dedicated
myself to this struggle of the African
people. I have fought against white
domination, and I have fought against
black domination. I have cherished
the ideal of a democratic and free
society in which all persons live
together in harmony and with equal
opportunities. It is an ideal which I
hope to live for and to achieve. But if
needs be, it is an ideal for which I am
prepared to die.

— Nelson Mandela, April 20,1964

DURING MY LIFETIME 1
HAVE DEDICATED MYSELF
TO THIS STRUGGLE OF THE
AFRICAN PEOPLE.I HAVE
FOUGHT AGAINST WHITE
DOMINATION, AND I HAVE
FOUGHT AGAINST BLACK
DOMINATION.I HAVE
CHERISHED THE IDEAL OF
A DEMOCRATIC AND FREE
SOCIETY IN WHICH ALL
PERSONS LIVE TOGETHER
IN HARMONY AND WITH

Niezaleznie od powyzszych zastrzezen, wersaliki moga by¢ uzyteczne przy

sktadaniu nagtéwkéw i podtytuléw. Poniewaz jednak nie ma w nich wydtuzen

dolnych, konieczne moze by¢ zmniejszenie interlinii. Dla krojéw szeryfowych

mozemy zwigkszy¢ $wiatla migdzyliterowe, aby uzyska¢ elegancki i czytelny

wyglad; przeciwnie, w krojach bezszeryfowych przydatne bedzie zmniejszenie

$wiatel, co da ,solidny”, gesty obraz.

JEDEN MALY KROK DLA CZLOWIEKA
WIELKI SKOK DLA LUDZKOSCI

JEDEN MALY KROK DLA CZLOWIEKA
WIELKI SKOK DLA LUDZKOSCI
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Jesli tekst zostal oryginalnie wpisany matymiliterami lub zwyklym  Emg
Font

~mieszanym” ukladem, mozna latwo przeksztalcié¢ go na wersa- i >
liki, uzywajac ikony TT w palecie sterujacej, uzywajac skrétu Famiid .
Cmd/ Ctrl+Shift+K albo siegajac po polecenie Type > Change Case e ﬁﬂl.;
(Tekst > Zmien wielkosc¢ liter). Nieszczesliwie, odwrotny zabieg nie o
Character Styles Q¥F11 |
jest taki prosty, gdy otrzymany tekst zostal wpisany z uzyciem klawi- 7 Parigreh stves s )
s T P e P = . - Create Outlines +x0
sza Caps Lock (samymi wielkimi literami). Jesli sprébujemy zamienié Find Font... S
. . L i1 . : : : . A
taki tekst na wielkosci liter takie, jak w zdaniu, InDesign zinter- 1, .., e L lowercse |
' Title Case |

pretuje kazda kropke, znak zapytania i wykrzyknik (a takze koniec Notes

akapitu) jako koniec zdania. Moze to prowadzi¢ do nieoczekiwanych

zmian wielko$ci, jesli te znaki wystepuja w innych znaczeniach, na przyktad
w skrétach, nazwach plikéw czy adresach URL. Dodatkowo nazwy wiasne beda
zawiera¢ same male litery, cho¢ powinny by¢ pisane wielka liters.

Rézne wydawnictwa i szkoly typograficzne preferuja odmienne podejscia
doboru wielkosci liter dla tytuléw rozdzialéw, nagtéwkéw i podtytutéw. Styl
.wielkoliterowy” (Up Style), w ktérym kazde stowo (oprécz spéjnikéw) pisane
jest wielka litera, jest szczegélnie popularny w USA. Styl Down, bardziej rozpo-
wszechniony w anglojezycznych wydawnictwach europejskich, uzywa wielkich
liter tylko dla pierwszego znaku i poczatkéw ,waznych” rzeczownikéw. Latwo
dostrzec, ze styl ten daje silniejszy przekaz edytorski, gdyz nikt nie musi sie
domysla, czy dany wyraz jest wazny, czy nie, ale tez wymaga wiekszego wysitku
od redaktora tekstu. Inng zalet3 tego podejécia jest fakt, ze tak ztozony tytut
zawiera wiecej stéw pisanych malj litera, zatem pojawiaja si¢ w nim czeéciej
widywane formy stow™’.

Istnieje jeszcze jedno podejécie do stosowania wielkich i matych liter,
nazywane niekiedy CamelCase (,tekst garbaty”), dotyczace nie tyle tytutéw
lub nagtéwkéw, ile nazw produktéw. Polega ono na pisaniu bez odstepéw
sléw lub nawet fraz, przy czym kazda pierwsza litera sklejanych stéw jest
kapitalizowana. Przyktadami takich nazw moga by¢ PlayStation, MySpace
i — oczywiscie — InDesign.

11 Wjezyku polskim zalecane jest sktadanie tytuléw tak samo jak tekstu zasadniczego,
zatem kapitalizowana jest tylko pierwsza litera (oraz — co oczywiste — nazwy wlasne
lub imiona czy tez nazwiska). Stosowanie obydwu anglojezycznych styléw tytutow
uwazane jest za btad.

RYSUNEK 3.13 Opcje Change
Case zawieraja przykfad,

jak tekst bedzie wygladat

po przemianie.
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RYSUNEK 3.14 Kapitaliki:
gorny przykiad to fatszywe"”
kapitaliki, utworzone jako
wielkie litery o wielkosci
zmniejszonej do 70%.
Zwrddmy uwage, ze sg one
J2ejsze” niz wersaliki na po-
czatku poszczegdinych stow.
Ponizej — prawdziwe kapitaliki
z fontu OpenType.

InDesign i tekst  Profesjonalna typografia w Adobe InDesign

Kapitaliki

Kapitaliki (small caps) to litery o formach majuskutowych, ale wysokosci zbli-
zonej do x-height, przez co nie przygtuszaja zwyklych matych i wielkich liter,
ktére im towarzysza. Kapitaliki s3 gléwnie spotykane w krojach szeryfowych
i niemal wylacznie prostych (roman). Kapitaliki moga by¢ stosowane do réz-
nych celéw:

® jako przejécie od otwierajacego inicjalu wpuszczonego do tekstu gléwnego
sktadanego wlasciwym stopniem,

® skiadania akroniméw, skrétéw i takich oznaczen, jak Bc lub AD — zasad-
niczo bez kropek, cho¢ niektére domy wydawnicze zalecaja inaczej,

= dla takich skrétow, jak AM lub PM — bez odstepéw ani kropek, choé obecnie
dominuje styl pisowni uzywajacy matych liter: 3pm, 7pm itp."?

® imion postaci w sztukach teatralnych.

O ile nie dysponujemy dobrym fontem OpenType albo Expert Set (fontem z uzu-
pelniajacym zestawem znakéw), kapitaliki tworzone sa w oparciu o wspétczynnik
zdefiniowany w zaawansowanych preferencjach tekstu. Takie generowane
przez oprogramowanie ,falszywe” kapitaliki powstaja ze zwyktych wielkich
liter odpowiednio zmniejszonych, a nie sa to oddzielne znaki, zaprojektowane
zgodnie z wlasciwymi proporcjami, dopasowanymi tak do wielkich, jak i matych
liter danego kroju. Poniewaz zmniejszenie stopnia pociaga za soba réwniez
zmniejszenie gruboéci poszczegdlnych kresek, czesto wydajg sie zbyt ,jasne”
w zestawieniu z normalnym tekstem tego samego stopnia. Prawdziwe kapita-
liki nie stwarzaja tego problemu, gdyz s3 to odrebne znaki, dopasowane waga
do reszty fontu, ale 0 odpowiednio zmniejszonej wysokosci i szerokosci.

Przy korzystaniu z fontéw OpenType dostepna jest réwniez opcja wykorzy-
stania samych kapitalikéw (All small caps — Tylko kapitaliki), bez stosowania
~pelnowymiarowe;j” wielkiej litery dla pierwszego znaku stowa.

THE CONSTITUTION OF THE
UNITED STATES OF AMERICA P2

THE CONSTITUTION OF THE
UNITED STATES OF AMERICA [

12 Skroty te, podobnie jak te z poprzedniego przyktadu, nie sa stosowane w jezyku
polskim, zatem te zalecenia mozna stosowa¢ tylko do sktadu w jezyku angielskim.
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The BBC and CNN reported the
decision by the IMF and the World
Bank to cancel all debts as of 8 A.M.
on October 4, 2010. Poverty, AIDS,
malnutrition, and illiteracy will be
significantly reduced by 2015.

The BBC and CNN reported the
decision by the IMF and the World
Bank to cancel all debts as of 8 AM
on October 4, 2010. Poverty, AIDS,
malnutrition, and illiteracy will be
significantly reduced by 2015.
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Indeksy gérne i dolne

Indeks gérny jest uzywany tradycyjnie dla odsytaczy przypiséw lub zaznacze-
nia liczebnikéw porzadkowych'’, a takze w zapisie poteg liczb. Indeksy dolne
spotykane sa gléwnie w réznych notacjach naukowych. Jesli dysponujemy
fontami OpenType, nalezy raczej unikaé korzystania z przyciskéw indekséw
w palecie sterujacej i zamiast tego uzywac opcji Superscript / Superior (Indeks
gérny / podniesienie) lub Subscript /Inferior (Indeks dolny / obnizenie) w menu
podrecznym OpenType. W wiekszosci przypadkéw znaki wyktadnikéw i indek-
séw s3 tym samym. S3 to oddzielne glify, ktérych grubosci kresek s3 dopasowane
do wagi zasadniczego tekstu. Jeéli jednak nie dysponujemy takim luksusem,
jak font zawierajacy wlasciwe indeksy, musimy stworzy¢ ,fatszywe” indeksy,
ktoére niestety beda odrézniac sie od reszty tekstu zmniejszona waga, jako
ze powstajg ze zwyklych liter i cyfr w drodze prostego przeskalowania. Okno
preferencji tekstu umozliwia zmiane wielko$ci generowanych indekséw w sto-
sunku do wlasciwego stopnia pisma. Domyslna warto$¢ 58% jest za mata dla
niemal kazdego kroju pisma. W kazdym wypadku nalezy dobra¢ ja indywidu-
alnie, ale raczej nigdy nie powinno to by¢ mniej niz 60%. Wiecej informacji
na temat indekséw i ich wykorzystania do budowania utamkéw zawiera roz-
dzial 6, ,Drobne (ale wazne) szczegéty”.

13 Ta ostatnia opcja dotyczy oczywiscie jezyka angielskiego i niektérych innych (np.
wloskiego).

RYSUNEK 3.15 Tekst skia-
dany ,zwyczajnie” (po lewej)

i uzycie kapitalikow dla akroni-
mow itp. (po prawej).

RYSUNEK 3.16 Opdja
OpenType All Small Caps
(ponizej) w porownaniu z uzy-
ciem wersalikdw i kapitalikow
(powyzej).

WSKAZOWKA: Pracujemy
z réwnaniami? Jesli mamy
ich tylko kilka, mozna
siegnac po taki kréj, jak
Mathematical Pii ,pobawic
sie” przesunieciami linii
bazowej, tabulatorami

itp. Jesli jednak jest to cos,
CO pojawia sie w naszej
pracy czesto i reqularnie,
warto rozwazyc¢ zainwe-
stowanie w dodatkowg
wtyczke, taka jak InMath
albo MathMagic Pro.
Witryna InDesign Secrets
zawiera ciekawa dys-

kusje na temat réznych
rozwiazan tego typu (http:/
indesignsecrets.com/typeset-
ting-math-in-indesign.php).
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RYSUNEK 3.17 ,Generowany”
indeks gérny w poréwna-

niu do OpenType Superior

(po lewej) oraz indeks dolny
zestawiony z OpenType Inferior
(po prawej).

RYSUNEK 3.18 Underline
Options (Opcje podkreslen)

w palecie sterujacej i kilka roz-
nych podejs¢ do podkreslen.

RYSUNEK 3.19 Podkreslenia
zastosowane jako styl zna-
kowy w celu zaznaczenia
hipertaczy.

InDesign i tekst Profesjonalna typografia w Adobe InDesign

April1¢ H,0O

Indeks gorny Indeks dolny
(przesunigcie 20%)
L]
April 15t H,0
OpenType OpenType
Superior Inferior

Podkreslanie

W zamierzchlych czasach, gdy nagrania ukazywaly si¢ na winylowych plytach,
a ludzie stukali w klawisze maszyn do pisania, podkreslanie byto obowiazko-
wym sposobem wyrézniania tekstu — ale byto tak jedynie z tego powodu,
ze maszyna do pisania nie umozliwiala osiggniecia tego celu zadna inna
metodg. Podkreslania, co mozna przeczyta¢ w kazdym podreczniku sktadu,
nigdy nie powinno sig uzywac do uwydatnienia tekstu. Jesli za$ musimy uzy¢
podkreslen do zaznaczenia hipertaczy, trzeba koniecznie zmieni¢ grubos¢,
odsuniecie, a w miare mozliwos¢ kolor linii w opcjach podkreslenia — nadal
bedzie to wygladato brzydko, ale moze choé troche mnie;j.

groovy

Podkreslenie przecinajace
wydtuzenia dolne

groovy

Tekst obramowany
kolorem biatym (paper)

groovy

Podkreslenie odsuniete
od tekstu, linia falista

Charles Robert Darwin (pol. Karol Darwin), ERS, ur. 12 lutego 1809
w Shrewsbury, zm. 19 kwietnia 1882 w Downe - angielski przyrodnik,
tworca teorii ewolucji, zgodnie z ktérg wszystkie gatunki pochodza
od wczesniejszych form, autor publikacji, w ktorych przedstawit argu-
menty na poparcie swej tezy. Darwin uwazal, ze rozgaleziony schemat
ewolucji wynika z procesu, ktéry nazwat doborem naturalnym.




1is text is highlighted

vith an underline

style - useful for reverse

out captions. Choose

a contrasting color for

the type, make the rule
veight about the same

size as the type and
offset it

Dobierajac grubos¢, przesuniecie i kolor podkreslenia mozna utworzy¢ styl

znakowy, ktéry nada fragmentowi tekstu efekt ,podswietlenia” lub ,,odwré-
cenia”. Wigcej informacji zawiera rozdziat 12, ,Globalne formatowanie przy
uzyciu styléw”.

Przekreslenie

Zwyczajowo przekreslenie jest stosowane do zaznaczenia tekstu, ktéry powi-
nien zosta¢ usuniety, gdy dokument przechodzi przez kolejne fazy cyklu
redakcyjnego. Jesli jednak popracujemy nad opcjami dostgpnymi w oknie
Strikethrough Options (Opcje przekreélenia), mozna wykorzysta¢ przekreslenie
jako inny efekt specjalny, samodzielny lub w potaczeniu z podkresleniem™.

Przesuniecie linii bazowej

Opcja ta umozliwia przesuniecie zaznaczonych znakéw w pionie wzgledem
linii bazowej (wyimaginowanej linii, na ktérej ,stoja” wszystkie znaki). Oprécz
wpisania warto$ci numerycznej w pole w palecie sterujacej, mozna uzy¢ skro-
téw Option/Alt+Shift+strzatka w gére lub w dét — skok jest definiowany
w zaawansowanych preferencjach tekstu. Opcji tej nigdy nie powinno sig
uzywac do korygowania odstepéw miedzyakapitowych lub miedzywierszo-
wych — za te wartosci odpowiada interlinia i odstepy akapitowe.
Przesuniecie linii bazowej moze stuzy¢ do nastepujacych celéw:

® Dopasowania pozycji punktoréw, ornamentéw, grafiki inline oraz nie-
ktérych symboli, takich jak ®, ™, © lub §.

® Dopasowania pozycji ozdobnego inicjalu wpuszczonego.

® Recznego tworzenia utamkéw, jakkolwiek preferowane jest stosowanie
skryptu generujacego utamek albo jeszcze lepiej, fontu OpenType Pro
zawierajacego prawdziwe utamki.

® Wartosci pienieznych, gdy symbol waluty ma zredukowana wielkosé.

14 Warto zauwazy¢, ze linia podkreslenia jest dodawana ,pod” tekstem, a przekresle-
nia — ,nad”. Inaczej méwiac, tekst zakrywa podkreslenie i jest zakrywany przez
przekreslenie.
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RYSUNEK 3.20 Podkreslenie
wykorzystane do podswietle-
nia tekstu.

Ten tekst jest podswietlony

za pomoca podkreslenia —
1biate na czarnym”. Dla tekstu
wybieramy kontrastujacy
kolor, dobieramy grubos¢ linii
podkreslenia zblizona do stop-
nia pisma i przesuwamy ja
odpowiednio, aby znalazta sie
«pod tekstem”.

fap Colour: o] : GapTine: ©
= Owwrpeint Cap

RYSUNEK 3.21 Nadrukowane
przekreslenie w potaczeniu

z grubym podkresleniem,
ktére zostato przesuniete pod
tekst.
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RYSUNEK 3.22 Niektore
zastosowania przesuniecia linii
bazowej

(415) (415)

Po prawej: nawiasy podniesione w gore

$10.99 *10%

Po prawej: Superscript Superior i przesuniecie
linii bazowej

me Ishmael. Some years
ago—never mind how long
precisely—having little or no
ey in my purse, and nothing
particular to interest me on shore,
I thought I would sail about a little

Wpuszczony inicjat kolidujacy z tekstem

glyph glyph
(SHIFT) (SHIFT)

Automatyczne przesuniecia gliféw (Glyph Shifting)
w foncie OpenType (po prawej).

bUmp

Podkreslanie znaczenia

all me Ishmael. Some years

ago—never mind how long

precisely—having little or no
money in my purse, and nothing
particular to interest me on shore,
I thought I would sail about a little

Przesunigcie linii bazowej wpuszczonego
inicjatu w celu eliminacji kolizji z tekstem

® Formul matematycznych lub chemicznych.

= Korygowania polozenia nawiaséw, klamer i nawiaséw kwadratowych.
W opinii wigkszosci typograféw nawiasy powinny by¢ wycentrowane
w poziomie wzgledem znakéw, ktore im towarzysza — zatem powinny
zajmowac inng (nizsza) pozycje w sasiedztwie matych liter bez wydtuzen,
a inng, gdy obok znajduja sie wersaliki. Fonty OpenType nie wymagaja
recznego korygowania dzieki funkcji zecerskiej przesunigcia gliféw, czyli
dopasowywania pozycji wybranych znakéw, takich jak otwierajace i zamy-
kajace nawiasy, w zaleznosci od tego, jakie znaki z nimi sasiaduja (patrz

ramka , Pozycjonowanie gliféw”).

Pozycjonowanie glifow

Przy stosowaniu kroju tytutowego z uzyciem samych wersalikéw potozenie poziomych kresek oraz nawiasow
wymaga korekty. Kreski s3 standardowo wycentrowane wzgledem x-height, co jest wtasciwym polozeniem
dla matych liter, ale zbyt nisko dla wersalikéw. Oznacza to, ze wszystkie takie znaki (a takze nawiasy) powinny
w takiej sytuacji zostac przesuniete.

Pigkno fontéw OpenType — i wsparcia dla tych fontéw w programie InDesign — polega miedzy innymi
na tym, Ze przesunigcia takie nastepuja automatycznie. Jesli sformatujemy tekst uzywajacy fontu OpenType jako
wersaliki (All Caps), towarzyszace im dywizy, mysiniki, nawiasy czy klamry automatycznie zostana przesuniete
w pionie. Trzeba jednak pamigtac, ze efekt ten wystepuje wtedy, gdy uzyjemy opcji formatujacej, a nie wtedy,
gdy wpiszemy tekst z wciénietym klawiszem Caps Lock!
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Czcionki zwezone i poszerzone

Duze rodziny krojéw czcionek moga zawierac (i czesto zawieraja) zwezone

(condensed) i poszerzone (extended) wersje. Wersje zwezone s3 przydatne, gdy
zachodzi koniecznos$¢ zmieszczenia wiekszej ilosci tekstu w ograniczonej prze-
strzeni. Analogicznie, wersje poszerzone pozwalaja wypelnié ustalone miejsce

stosunkowo niewielkim tekstem. Nalezy zawsze wybiera¢ prawdziwe zwezone

lub poszerzone odmiany krojéw, zamiast symulowania tego efektu poprzez

zmiane poziomej lub pionowej skali. Przeskaluj czcionke nieproporcjonalnie,
a najlepsi swiatowi rzemieslnicy rozdepcza w proch wszystkie twe dokonania!

Falszowanie skondensowanego kroju (zwezanie go horyzontalnie) albo posze-
rzonego (rozcigganie) sprawi, ze ksztalty znakéw stana sie niezgrabne, a praca

bedzie sprawia¢ wrazenie amatorszczyzny. Kto$ przytapany na uzywaniu tych

opcji moze sig spodziewac, ze policja projektancka wkrétce zatlomocze do jego

drzwi (www.design-police.org). Tym niemniej, kazda reguta moze zostaé ztamana

kreatywnie. Po prostu — jesli tamiemy reguty, rébmy to z petna swiadomoscia,
a nie dlatego, ze nie znamy lepszego rozwigzania.

Coaign Potce s Il
oparmegin risasa Il

um|

Design Pobios sre.
opermeg n pin s

(R)||

Dvain Policn are.
opuenring In i3 ars

| ILLEGIBLE

GRIL.L

I.EWE T.OBSITER

SEAFOOD

EFEFIRESEL FF'ISEX

(www.design-police.org).

DRUM AND BASS
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AgAg

Sciénieta Zwezona

We quickly seized the
black axle and just saved
it from going past him
Sciénieta (72%)

We quickly seized the
black axle and just saved
it from going past him
Zwezona

RYSUNEK 3.23 Scisnigta
czcionka: fatszywa skonden-

sowana” i dla poréwnania,
prawdziwa odmiana zwezona

RYSUNEK 3.25 Strona Design Police

Nie daj im powodu, aby Cie cytowali!

RYSUNEK 3.24 Kilka przy-
ktadow krojow poszerzonych:
Wide Latin oraz Blackoak

(u gory) oraz Univers Extra
Black Extended (na dole).
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RYSUNEK 3.26 Kroje zwe-
zone robig wigksze wrazenie,
Zajmujac tyle samo miejsca
w poziomie.

Helvetica Neue Black 44 pt

Man Bites Dog

Helvetica Neue Condensed Black 56 pt

Helvetica Ultra Compressed 100 pt g

Kroje zwezone sa uzyteczne w nagléwkach. Poniewaz ich znaki sa wezsze,

mozna powigkszy¢ stopien pisma i nadal zmiescic tresé nagtéwka na przewi-
dzianej szerokosci.

Innym miejscem, w ktérym kroje zwezone sie sprawdzaja, s tabele oraz
podpisy ilustracji.

Kroje poszerzone najczesciej bywaja stosowane w plakatach i szyldach. Jesli
pojawia sie w towarzystwie tekstu gléwnego, ztozonego typowym krojem dzie-
towym, w takiej roli czesciej widuje sie kroje bezszeryfowe, takie jak Helvetica
Neue Expanded lub Univers Extended.

Czytelnos¢

Stowo czytelnosé (by¢ moze lepiej byloby méwié przyswajalnosé) odnosi sie
do fatwodci, z jaka odbiorca jest w stanie zrozumie¢ czytany tekst, rozpozna-
jac stowa i zdania jako ksztalty. Z punktu widzenia projektanta czytelnoé¢
oznacza, Ze na pierwszym miejscu stawiamy czytelnika, swoje ego odsuwajac
w cienl — a przynajmniej ograniczajac je do poczatkowych szkicéw projektu.
Méwi sig, ze dobra typografia jest ,niewidzialna” czytelnik w ogéle nie powi-
nien jej zauwazac. Pismo jest jedynie przekaznikiem dla tresci niesionych przez
tekst. Moze si¢ wydawac, ze takie podejscie pomniejsza role projektanta, jednak
wprawdzie czytelnicy nie musza zauwazac dobrej typografii, ale niewatpliwie
dostrzega, gdy bedzie ona zta. Jan Tschichold (1902-1974), uznany niemiecki
typograf i projektant ksigzek, tak podsumowat to w swej ostatniej ksigzce
Form of the Book: ,Pozosta¢ bezimiennym i niedocenionym, ale mie¢ swoéj udziat
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w wartoéciowych dzielach i zosta¢ dostrzezonym przez niewielka liczbe wraz-
liwych czytelnikéw — to z reguly jedyne zadoséuczynienie za dlugie i w istocie
nigdy sie niekonczace terminowanie typografa”.

Tym niemniej, nie kazdy tekst jest tworzony z my$la o czytelnoéci. Cynik
mégltby tu wspomnie¢ przystowiowy ,drobny tekst” w drukach uméw lub
warunkéw ubezpieczen jako przyklad typografii, w ktérej czytelno$é ma niski
priorytet. Na drugim krancu skali typograficznej mozna umiesci¢ niektére
dekoracyjne kroje, ktére zdecydowanie stanowia wyzwanie dla kryteriéw czy-
telnosci, ale sa bez watpienia lepiej, a nie gorzej rozpoznawalne. Czcionki moga
by¢ zrozumiate bez konieczno$ci bycia czytelnymi*®.

Szeryfowe kontra bezszeryfowe

[stnieje powszechne przekonanie, ze kroje szeryfowe s3 bardziej czytelne
od bezszeryfowych. Spotka¢ mozna rézne préby uzasadnienia tego pogladu.
Moze to wynikac z faktu, ze szeryfy dzialaja jak szyny, prowadzac oko od litery
do litery. By¢ moze postrzegamy szeryfowe kroje jako bardziej ,ludzkie”, gdyz
ich kreski odzwierciedlaja reczng kaligrafie. Kroje bezszeryfowe moga wydawa¢
sie mniej czytelne, gdyz niektére litery w nieunikniony sposéb upodobniaja sie
do innych — w krojach takich na przyklad trudno jest odrézni¢ wielka litere
I od matej litery L.

A jesli po prostu — i ide o zaklad, ze to wlasnie o to chodzi — jest to przy-
padek ,samospelniajacej sie przepowiedni”? Latwiej nam przychodzi czyta¢
szeryfowe czcionki, gdyz jesteémy do nich znacznie bardziej przyzwyczajeni.
Cytujac Zuzanne Licko (1961- ), wspélzatozycielke Emigre Graphics: ,Najtatwiej
jest czytac to, co widzimy najczedciej”.

Mozna przyzwyczaic sie do wszystkiego, ale czcionki szeryfowe towarzysza
nam od stuleci i ten nawyk jest juz zaszyty w naszym DNA. Czcionki bezsze-
ryfowe to nowi gracze na boisku, jedli uzyé przenoéni — pojawily sie dopiero
na poczatku X1x wieku, a do szerszego uzycia trafily jeszcze pdzniej. Jeszcze
15 lat obcowania z Web i okaze sie, ze wolimy kroje bezszeryfowe — przynaj-
mniej do czytania online.

Pojecie czytelnoéci ma wiecej niuanséw, niz prosta lista ,,zréb to” i ,nie
réb tego”. Wiaze sie nie tylko z wyborem tej lub przeciwnej klasy krojéw, ale
z takze z tym, jak potraktujemy wiele innych zmiennych okreélajacych uktad
tekstu. Nie istnieje zaden powdd, dla ktérego czcionka bezszeryfowa w rekach

15 W srodowisku oséb zwigzanych z tworzeniem publikacji od jakiego$ czasu krazy
stowo czytalnosé (to, co da sie czytaé — a wiec w znaczeniu przyswajalnosci) w opozycji
do czytelnosci (w znaczeniu rozpoznawalnosci). Moze warto bytoby rozpowszechni¢
ten neologizm.
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RYSUNEK 3.27 Wiek XV (po
lewej - czcionka Jenson) kon-
tra XXl (po prawej - Gotham).
Czy ktorys jest bardziej
czytelny od drugiego?

dobrego projektanta nie miataby by¢ réwnie czytelna, jak szeryfowa. Ujmujac
to z innej strony — sam wybér kroju szeryfowego nie gwarantuje, ze zlozony
tekst bedzie czytelny.

Czytelnos¢ staje si¢ mniejszym problemem, gdy chodzi o wielki tytut lub
szyld. Poniewaz mamy tu do czynienia z krétkimi fragmentami, a nie dtugim
ciagiem znakéw, typografia nie prébuje by¢ niewidzialna w tym wypadku, ale
przeciwnie, ma przyciaga¢ uwage. Srédtytuly natomiast powinny zaréwno
zwracac uwage, jak i by¢ czytelne.

Inne czynniki wptywajace na czytelnoéé¢

Wybér kroju pisma to tylko jeden z wielu czynnikéw, ktére musza wspétdzia-
ta¢, aby stworzy¢ czytelny tekst. Nalezg do nich, ale — méwiac prawniczym

jezykiem — bez ograniczenia do, takie jak:

® Interlinia.

Justowanie.
Marginesy.

Wymiar famu (stosunek wielkosci czcionki do szerokosci famu).

Warunki druku (o ile oczywiscie praca ma by¢ wydrukowana): Jaki rodzaj

papieru zostanie uzyty do wydrukowania tego dzieta?

Warunki czytania. Ta zmienna wydaje si¢ tu doé¢ zaskakujaca, gdyz typo-

graf nie ma nad nig wielkiej kontroli. Nie mozemy przewidzie¢, czy nasi

odbiorcy beda czytac gotows ksiazke przy swiecach, stojac w zattoczonym

wagonie metra, czy tez w trakcie kapieli. Jednak zaleznie od typu tworzo-

nego dokumentu mamy pewne podstawy do spekulacji. Jeli na przyktad

projektujemy rozklad jazdy autobuséw, raczej porzucimy pomysty rodem

z wyrafinowanej typografii postmodernistycznej i wybierzemy wariant

mozliwie najprostszy, bezposrednio przekazujacy sama tresé.

One morning, when Gregor Samsa
woke from troubled dreams, he found
himself transformed in his bed into

a horrible vermin. He lay on his
armour-like back, and if he lifted his
head a little he could see his brown
belly, slightly domed and divided by
arches into stiff sections. The bedding
was hardly able to cover it and seemed
ready to slide off any moment. His
many legs, pitifully thin compared
with the size of the rest of him, waved
about helplessly as he looked.

One morning, when Gregor Samsa
woke from troubled dreams, he
found himself transformed in his
bed into a horrible vermin. He lay
on his armour-like back, and if he
lifted his head a little he could see
his brown belly, slightly domed
and divided by arches into stiff
sections. The bedding was hardly
able to cover it and seemed ready
to slide off any moment. His many
legs, pitifully thin compared with
the size of the rest of him, waved
about helplessly as he looked.



RozDziAt 4

Interlinia

INTERLINIA (ang. leading, wymawiane jak ledding”) to przestrzen pomiedzy
kolejnymi linijkami tekstu, czasem nazywana odstepem (albo swiattem) mie-
dzywierszowym. Angielski termin pochodzi z czasow sktadu metalowego, gdy
do tworzenia tych odstepow stuzyly cienkie paski otowiu (ang. lead), zwane
reglets, wsuwane pomiedzy szeregi zlozonych czcionek. Wiersze bez takich

paskow otowiu byly — i sg nadal — okreslane terminem ,ciasno ztozonych”,
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Biada podrzednym

istotom, gdy wehodza

pomiedzy ostrza

poteiﬂlchsmmieﬁ;

RYSUNEK 4.1 Odstepy mie-
dzywierszowe zaznaczone
paskami pomiedzy wierszami
tekstu. Catkowita wielkos¢ in-
terlinii jest mierzona od jednej
linii bazowej do nastepnej.

RYSUNEK 4.2 Miarka
typograficzna umozliwia
zmierzenie wielkosci interlinii
w drukowanym tekscie.

Interlinia® gra wielka role w zapewnianiu (lub nie) czytelnosci tekstu. Tekst
gléwny zazwyczaj staje si¢ bardziej czytelny, gdy otrzyma dodatni odstep mie-
dzywierszowy (czyli interlinie o wartosci wiekszej niz stopier pisma). Z kolei
pismo nagtéwkowe lub tytulowe moze lepiej wyglada¢, gdy zostanie ztozone
z ujemnym odstepem (czyli z interlinig mniejsza niz stopien pisma).

Dobieranie wtasciwych odstepow

Przy ustalaniu interlinii nie istnieje zaden idealny wymiar, dobry dla wszystkich.
Z jednej strony ciasny ukiad (mala interlinia) zwigksza gestos¢ tekstu i nadaje
mu bardziej autorytatywny wyraz. Z drugiej strony zbytnie $ciesnienie wierszy
sprawia, ze tekst zaczyna wygladac , klaustrofobicznie”, a wydtuzenia gérne
lub akcenty z jednego wiersza zaczynajg kolidowa¢ z wydtuzeniami dolnymi
innego. Luzno rozmieszczone wiersze (duza interlinia) daja wyglad elegancki
i luksusowy. Jednak zbyt duza interlinia sprawia, ze poszczegélne wiersze
przestaja sig faczy¢ ze soba i zaczynaja sprawia¢ wrazenie indywidualnych
ciaggéw znakow, ktore nie tworza juz wigkszych caloséci. Efekt taki moze by¢
szczegolnie widoczny, jesli nie stosuje si¢ dodatkowego odstepu ani wciecia dla
zasygnalizowania poczatkéw akapitéw.

Interlinia jest wyrazona w punktach odlegloscia pomiedzy dwiema kolej-
nymi liniami bazowymi pisma. Warto$¢ interlinii zawiera zatem stopien pisma
powiekszony o wlasciwy odstep pomiedzy wierszami. Tak wiec ,czcionka
o wielkoéci 10 punktéw z 12-punktows interlinig” oznacza w rzeczywistosci,
ze pomigdzy kolejnymi wierszami znajdzie sie dwupunktowy odstep. Wymiar
taki czesto zapisywany jest jako utamek 10/12, wymawiane ,dziesie¢ na dwa-
nascie”. Inne czesto spotykane kombinacje stopnia pisma i wielkosci interlinii
dla tekstu gléwnego to 9/11, 11/13 lub 12/15.

1 Mamy tu niespéjnoé¢ terminologiczng. Interlinia to ,coé pomiedzy liniami”, czyli
wlasénie owe paski metalu, ktére niegdy$ wsuwano pomiedzy szeregi czcionek (obecnie
za$ po prostu przestrzen, ktérg taki pasek zajmowal). Takze odstep miedzywierszowy
wskazuje, ze chodzi o co$ pomigdzy wierszami. W jezyku angielskim ta wielkos¢ okre-
$lana jest terminem lead (nie leading) albo interline — w odréznieniu do line space, ktéra
oznacza catkowitg wysokos¢ wiersza (czyli stopien pisma powigkszony o interlinie).
Prawdopodobnie z powodu btedéw popetnionych podczas ttumaczenia pierwszych
bardziej zaawansowanych programéw edycyjnych na jezyk polski (i ,zasiedzenia sie”
tych bledéw wjezyku) obecnie w kazdym programie — czy to typograficznym, czy tez
edytorze tekstu — to, cow angielskiej wersji nazywa sie leading albo line space, u nas
nazywane jest interlinig, cho¢ zgodnie z tradycja typograficzna wartosé¢ ta powinna
by¢ nazywana stopniem wiersza albo interlinig bezwzgledng. Poniewaz jednak nie da sie
wygrac z wiatrakami, uzywam rozpowszechnionego terminu interlinia w znaczeniu
interlinii bezwzglgdnej, warto jednak sobie zdawa¢ sprawe, ze jest to termin bledny.
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Interlinia

Pour and drink; and according to vour choice of goblet, I shall
know whether or not You are a connoisseur of wine, For if you
have no feelings about wine one way or the other, you will want
the sensation of drinking the stuff out of a vessel that may have
cost thousands of pounds; but if you are a member of that vanish-
ing tribe, the amateurs of fine vintages, you will choose the
crystal, because everything about it is caleulated to reveal rather

than hide the beautiful thing which it was meant to contain,

Perpetua 9/11

Pour and drink; and according to vour choice of goblet, I shall
know whether or not you are a connoisscur of wine. For if you
have no lbelings about winc one way or the other, you will want
the sensation of drinking the stuff out of a vessel that may have
cost thousands of pounds; but if you are a member of that vanish-
ing tribe, the amateurs of finc vintages, you will choose the
crystal, because everything about it is calculated to reveal rather
than hide the beautiful thing which it was meant to contain.

1012

Pour and drink; and according to your choice of goblet, I shall
know whether or not vou are a connoisseur of wine. For if you
have no feelings about wine one way or the other, you will want
the sensation of drinking the stuff out of a vessel that may have
cost thousands of pounds; but if you are a member of that vanish-
ing tribe, the amateurs of fine vintages, you will choose the
crystal, because everything about it is calculated to reveal rather
than hide the beautiful thing which it was meant to contain.

11/13

Pour and drink; and according to your choice of goblet, I shall

know whether or not you are a connoisseur of wine. For if you

have no feelings about wine one way or the other, you will want

the sensation of drinking the stuff out of a vessel that may have

cost thousands of pounds; but if you are a member of that vanish-

ing tribe, the amateurs of fine vintages, you will choose the

crystal, because everything about it is calculated to reveal rather

than hide the beautiful thing which it was meant to contain.

12/15

RYSUNEK 4.3 Wyjatek z wplywowego eseju Beatrice Ward z 1932 roku na temat typografii, The Crystal

Goblet, ukazujacy typowe kombinacje interlinii i stopnia pisma.

65
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WSKAZOWKA: Latwa

do zapamietania (i dajaca
nienajgorsze wyniki)

reguta ustalania interlinii:
bierzemy szeroko$¢ tamu
(dtugosc wiersza) wyrazong
w pica, dzielimy to przez
stopien pisma w punktach,
po czym zaokraglamy
wynik do najblizszej
potowki — wynik to odstep
miedzywierszowy wyrazony
w punktach. Na przyktad,
dla 10-punktowego tekstu
w tamie o szerokosci 24
pica (288 punktow, czyli
101,6 mm) otrzymujemy

2,4 (po zaokragleniu 2,5),

co daje interlinie wyno-
523cq 12,5 punktu (wielkosé¢
odstepu dodang do stopnia
pisma).

lle wystarczy?

Niewlasciwe $wiatlo miedzy wierszami sprawia, ze tekst trudniej jest czytac,

gdyz oko z trudnoscig lokalizuje kolejny wiersz liter. Dobranie wlasciwej inter-

linii zalezy od wielu zmiennych:

Charakter tekstu. Tekst przeznaczony do ciaglego czytania bedzie tat-
wiejszy w odbiorze, gdy zapewnimy mu nieco miejsca na oddech; krétkie
fragmenty, takie jak ogloszenia lub tytuly, moga by¢ bardziej efektywne,
gdy wiersze zostana ulozone ciasno.

Stopien pisma. W miarg zwigkszania wielkosci czcionki nalezy odpowied-
nio (cho¢ nie proporcjonalnie) powiekszaé przestrzen migdzywierszowa.
Przy wielkosciach tytulowych taka sama wzgledna wielkos¢ odstepu robi
wrazenie wiekszej, przez co czesto w takich sytuacjach nalezy stosowa¢
mniejsza interlini¢ (nawet negatywna w niektérych przypadkach).
Szerokos¢ tamu. Wigksze dlugosci wiersza (szersze tamy) wymagaja
powigkszenia interlinii. Juz powigkszenie jej o pét punktu moze poprawi¢
czytelnoé¢ dzigki zapewnieniu odseparowania poszczegdlnych wierszy
i zabezpieczy¢ sig przed sytuacja, ze oko wracajace na poczatek kolejnego
wiersza ,przeskoczy”, pomijajac kolejny wiersz — a takze unikajac proby
ponownego odczytywania tego samego wiersza.

Wielkosc odstepow miedzytamowych. Interlinia, podobnie jak wszystkie
inne atrybuty tekstu, musi pozostawa¢ w harmonii ze wszystkimi innymi
elementami strony. Szeroko$¢ odstepéw miedzy tamami tekstu powinna
by¢ réwna interlinii lub nieco wigksza. Zbyt maty odstep miedzy tamami
moze spowodowac, ze oko bedzie probowato czyta¢ ,w poprzek taméw”.
Zbyt duzy odstep sprawi, ze famy stang si¢ odrebnymi, niepowigzanymi
ze sobg blokami tekstu.

Wielkos¢ spacji pomiedzy wyrazami. Justowany tekst w waskich tamach,
czgsto spotykany w gazetach, moze spowodowad, ze szerokos¢ spacji
migdzy wyrazami stanie si¢ wigksza niz wielkos¢ odstepu miedzywier-
szowego. Moze to spowodowac, ze oko przeskoczy do nastepnego wiersza,
zamiast do kolejnego stowa w tym samym wierszu. W takiej sytuacji
zwigkszenie interlinii gwarantuje, ze odstep miedzywierszowy bedzie
przynajmniej réwny szerokosci spacji. Jeszcze lepszym rozwigzaniem
jest unikanie justowania tekstu w bardzo waskich tamach.

Kolor t}a. Poniewaz jestesmy przyzwyczajeni do czytania czarnych
liter na bialym papierze, wybér odwrotny gwarantuje przyciagniecie
uwagi. Jednak tekst w kontrze ma sktonnosé do ,migotania”, co utrudnia
jego czytanie. Nieznaczne powigkszenie interlinii — a takze unikanie
stosowania czcionek z delikatnymi szeryfami — moze kompensowa¢
te utrudnienia.
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[ told you that you knew the
answer already. Everyone knows
it. The thing that is in Room 101
i1s the worst thing in the world.

B

The thing that is
in Room 101 is
the worst thing
in the world.

“oefler Text 9.5/Auto (11.4) Hoefler Text 17/Auto (21.6)

RYSUNEK 4.4 Dodatni odstep miedzywierszowy dobrze sprawdza sie w wielkoéciach typowych dla tekstu dzietowego (A), ale jest zbyt

duzy, gdy stopieri pisma jest wigkszy (B) — tu potrzebny jest mniejszy odstep (C).

How will the struggle for existence, briefly discussed in the last chapter, act in
regard to variation? Can the principle of selection, which we have seen is so potent
in the hands of man, apply under nature? I think we shall see that it can act most
efficiently. Let the end}l)css number of slight variations and individual differences
occurring in our domestic productions, and, in a lesser degree, in those under
nature, be borne in mind; as well as the strength of the hereditary tendency. Under
domestication, it may be truly said that the whole organisation becomes in some

C

The thing that is
in Room 101 is
the worst thing
in the world.

Hoefler Text 17/18

I RYSUNEK 4.5 Interlinia

wierszy.

How will the struggle for existence, briefly discussed in the last chapter, act in
regard to variation? Can the principle of selection, which we have seen is so potent
in the hands of man, apply under nature? I think we shall see that it can act most
efficiently. Let the endless number of slight variations and individual differences

| occurring in our domestic productions, and, in a lesser degree, in those under
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RYSUNEK 4.6 Po lewej: odstep miedzylamowy réwny interlinii. Na $rodku: wielkos¢ odstepu migdzytamowego jest zbyt duza i strona
rozpada si¢ na dwa niezalezne bloki tekstu. Po prawej: zbyt maty odstep miedzylamowy powoduje, ze zamiast dwéch laméw widzimy

jeden, szeroki blok tekstu.
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How will the struggle for exis-
tence, briefly discussed in the
last chapter, act in regard to
variation? Can the principle of
selection, which we have seen
is so potent in the hands of man,
apply under nature? I think we
shall see that it can act most effi-
ciently. Let the endless number
of slight variations and individ-
ual differences oceurring in our
domestic productions, and, in
a lesser degree, in those under
nature, be borne in mind; as well
as the strength of the hereditary
tendency. Under domestication, |

How will the struggle for exis-
tence, briefly discussed in the
last chapter, act in regard to
variation? Can the principle of
selection, which we have seen
is s0 potent in the hands of man,
apply under nature? I think we
shall see that it can act most effi-
ciently. Let the endless number
of slight variations and individ-
ual differences occurring in our
domestic productions, and, in

| alesser degree, in those under

nature, be borne in mind; as well

silhouette, B:

supplied London

electricity
gned by on with
hose other zen 1933 and 19
2rlo Sir Giles Gilbert

design credits include Waterloo

RYSUNEK 4.8 Tekst w kontrze na jednolitym tle zyskuje na czytelnosci
po zwiekszeniu interlinii (po prawej).

RYSUNEK 4.7 Przy justowanym tekscie w waskich famach
mozna poprawic¢ czytelnosc powiekszajac interlinie tak, by
odstep miedzywierszowy nie byt mniejszy niz szerokos¢
spacji pomiedzy wyrazami.

® Charakterystyka kroju pisma. Kroje z wigksza wartoscia x-height, takie
jak Helvetica, wydaja si¢ by¢ wigksze niz inne czcionki w tym samym stop-
niu. Litery minuskulowe s3 stosunkowo duze w poréwnaniu do ogélnej
wielkodci znakéw, a tym samym wymagaja wigkszego $wiatla miedzy
wierszami.

Kroje klasycystyczne i romantyczne, takie jak Bodoni, ktére maja silnie
zaakcentowang pionowa 0§, prowadza oko raczej w dét, niz w poziomie.
Zwigkszenie interlinii przy stosowaniu fontéw tego typu ulatwia utrzy-
manie oka w wierszu i poprawia sprawno$é¢ czytania.

Skroty klawiaturowe dotyczace interlinii

Do zmiany interlinii dla zaznaczonego fragmentu tekstu mozemy uzyé
Option /Alt+strzatka w gdre (Sciesnianie wierszy) lub Option/ Alt+strzatka w d6t
(rozluznianie). Wielko$¢ zmiany po jednym nacisnieciu okreslana jest w karcie
preferencji Units & Increments (Jednostki i skoki). Mozna réwniez zmieni¢ wielkoé¢
interlinii o pigciokrotng wartos¢ ustawionego skoku, przytrzymujac dodatkowo
klawisz Cmd /Ctrl.

WSKAZOWKA:
(Niedrukowalny) znak korica
(pilcrow) na koricu kazdego
akapitu rowniez ma przy-
pisane cechy formatujace.
Nie uwzglednienie go przy
zaznaczaniu tekstu moze
dac w efekcie niejednolita
interlinie. Aby zaznaczy¢
caly akapit, lepiej kliknac
poczwdarnie wewnatrz tego
akapitu, zamiast zaznaczac
go narzedziem Tekst —

i oczywiscie, nalezy wlaczy¢
wyswietlanie znakéw
ukrytych.

Kroje pisma, w ktérych niewielka wysokosé matych liter zostata polaczona

ze szczegblnie wysokimi wydluzeniami gérnymi, wymagaja specjalnego trak-
towania. Mala wartosé x-height sklania do zmniejszenia interlinii, ale to z kolei

moze prowadzic¢ do kolizji pomiedzy gérnymi i dolnymi wydtuzeniami. Wiele

tu zalezy od samych znakéw. Jesli sktadamy tytut lub nagléwek, przeedytowa-
nie — o ile mamy na to odpowiednia ,licencje redakcyjng” — moze rozwiaza¢

wszystkie problemy. Pozostawmy sprawe zdrowemu rozsadkowi i bagdzmy
otwarcina to, ze nawet nakladajace si¢ wydtuzenia liter moga wyglada¢ dobrze

w pewnych sytuacjach.
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Adobe Caslon Pro 10/12

Skoro ksigzki s3 drukowane po to,

by byly czytane, musimy odrézni¢
czytalnosc (przyswajalno$é tekstu)

od czytelnosci w rozumieniu okulisty.
Strona zlozona 14-punktowg czcionka
Bold Sans jest, zgodnie z testami
laboratoryjnymi, bardziej czytelna

niz taka, do ktérej uzyto 10-punk-
towego kroju Baskerville. W tym
sensie publiczny méwea jest lepiej
styszalny, gdy wrzeszczy. Jednak u do-
brego méwcy nie zwracamy uwagi

na glos — on réwniez powinien by¢
sprzezroczysty”!

Adobe Caslon Pro 10/12

Skoro ksigzki sg drukowane po to,

by byly czytane, musimy odréznié
czytalnosé (przyswajalnoéé tekstu)

od czytelnosci w rozumieniu okulisty.
Strona zlozona 14-punktows czcionka
Bold Sans jest, zgodnie z testami
laboratoryjnymi, bardziej czyte/na

niz taka, do ktérej uzyto 1o-punk-
towego kroju Baskerville. W tym
sensie publiczny méwca jest lepiej
styszalny, gdy wrzeszczy. Jednak u do-
brego méwcy nie zwracamy uwagi

na glos — on réwniez powinien by¢
nprzezroczysty”!

Tnp Hat,

\\’]1 ite Tic

& Tails

T_op | [al.'_,
White Tie
& Tails

Helvetica 10/13

Skoro ksigzki sg drukowane po to,
by byly czytane, musimy odrézni¢
czytalnosc (przyswajalnosc tekstu)
od czytelnosci w rozumieniu oku-
listy. Strona ztozona 14-punktowg
czcionkg Bold Sans jest, zgodnie
z testami laboratoryjnymi, bardziej
czytelna niz taka, do ktérej uzyto
10-punktowego kroju Baskerville.
W tym sensie publiczny méwca
jest lepiej styszalny, gdy wrzesz-
czy. Jednak u dobrego méwcy nie
zwracamy uwagi na gtos — on

Bodoni10/13

Skoro ksigzki sy drukowane po to,
by byly czytane, musimy odroznié
czytalnosé (przyswajalnosé tekstu)
od czytelnosci w rozumieniu okulisty.

Strona zlozona 14-punktowg czcionky

Bold Sans jest, zgodnie z testami
laboratoryjnymi, bardzicj ezvtelna niz
taka, do ktérej uzyto 10-punktowego
kroju Baskerville. W tym sensie pu-
bliczny mowca jest lepiej styszalny,
gdy wrzeszezy. Jednak u dobrego
mowcy nic Zwracamy uwagi na

glos — on rowniez powinien by¢
spreezroczysty”!

RYSUNEK 4.10 Mimo

Zze czcionka Bernhard Modern
ma znaczne wydtuzenia gdrne,
jego niewielka wysokos$¢ ma-
tych liter i krotkie wydtuzenia
dolne sprawiaja, ze moze by¢
sktadana ciasno.

Rozdziat 4 Interlinia
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RYSUNEK 4.9 Kroje, w kto-
rych wielkos¢ x-height jest sto-
sunkowo duza, jak Helvetica,
wymagaja wiekszej interlinii.
Antykwy klasycystyczne, takie
jak Bodoni, rowniez potrze-
bujq wiekszej interlinii, aby
uniknac ,przekierowania oka
w pionie’, wymuszanego przez
silng pionowa os pisma.

Co['o‘lru[ vintage
nudcrl[naurﬁ. designs

adua-‘lﬁ:.hu] tpur.

I— )[l.LI,i.l‘llj ,Run i

RYSUNEK 4.11 Raniscript
ma znaczne wydluzenia gérne
i dolne, ale jego niewielka
wysokosc x sprawia, ze dobrze
wyglada z niewielka interlinig.
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The quick brown |THE QUICK
fox jumps over |BROWN FOX
thelazydog | JUMPS OVER

Chaparral Pro Semibold 28/31

RYSUNEK 4.12 Ten sam na-
gltéwek ztozony wersalikami
wymaga mniejszej interlinii,
gdyz nie ma w nim wydtuzen
dolnych.

RYSUNEK 4.13 Wersaliki

Z negatywnymi swiattami
miedzywierszowymi, tworzace
JSciane liter”,

THE LAZY DOG

Chaparral Pro Semibold 28/27

Kroje wyttuszczone lub lekko pogrubione (Bold i Semibold) zazwyczaj wyma-
gaja dodatkowego odstepu miedzywierszowego, aby szaros¢ tekstu (zaciemnienie,
czy tez zaczernienie tworzone przez blok liter) nie stata sig zbyt intensywna.

Kroje o niewielkiej wysokosci x, takie jak Caslon lub Garamond, wydaja sie
miec wigcej poziomej przestrzeni pomigdzy wierszami, a tym samym wymagaja
mniejszych interlinii.

Tekst zlozony samymi wersalikami wymaga mniejszej interlinii, gdyz wiersze
wydaja si¢ odsuniete dzigki brakowi wydluzen dolnych.

O ile uzywamy punktéw jako podstawowej jednostki miary, mozemy tatwo
ustali¢ interlinie, ktéra zapewni okreslong z gory liczbe wierszy w kolumnie
tekstowej. Najpierw narysujemy prostokatna ramke pomiedzy gérnym i dolnym
marginesem strony. Nastepnie umieszczamy kursor w polu okreslajacym wy-
sokos¢ tej ramki w palecie sterujacej (za wyswietlang wartoscia), po czym
wpisujemy /N (gdzie N jest pozadang liczbg wierszy). Po naciénieciu klawisza
Tab InDesign wykona dzielenie. Nowa wysokosé naszego prostokata to potrzeb-
na warto$¢ interlinii. Teraz mozemy juz usunac niepotrzebny prostokat.

ADMIRATI
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| CHER|

T1N I] DISHEARTEN
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(Nie)stosowanie automatycznej interlinii

Automatyczna interlinia jest stosunkowo nowa koncepcja, ktéra pojawila sie
wraz z pierwszymi programami DTP w polowie lat osiemdziesiatych xx wieku.
Funkcja ta pozwala przypisa¢ wartosé interlinii na podstawie stopnia pisma,
pomnozonej przez staly wspdlczynnik. Domysélnie automatyczna interlinia
w InDesignie wynosi 120% stopnia pisma, jakkolwiek mozna zmieni¢ te wartoé¢
w opcjach justowania. Jesli warto$é interlinii w palecie sterujacej wyswietlana
jest w nawiasach, jest to interlinia automatyczna.

Jedyna dobra rzecza, jaka mozna powiedzie¢ o tym rozwiazaniu, jest to,
ze jest wygodne. Mozemy zmienia¢ wielko$¢ tekstu tak czesto, jak tylko ze-
chcemy i zawsze bedzie on czytelny. W miare zwiekszania lub zmniejszania
stopnia pisma wraz z nim zmienia sie¢ interlinia.

Najwigksza wartos¢ interlinii w wierszu okresla interlinie dla calego wiersza,
co oznacza, ze bedzie ona niejednolita, jesli niezamierzenie sprawimy, ze jeden
znak jest wigkszy od pozostatych. Zachowanie to mozna zmieni¢ w preferen-
cjach tekstu, zaznaczajac opcje Apply Leading to Entire Paragraphs (Zastosuj
interlinig do calych akapitéw). Zagwarantuje to, ze tylko jedna wartoé¢ zostanie
przypisana calemu akapitowi. Zmiana tego ustawienia nie ma jednak wptywu
na interlinie w istniejacych ramkach. Mogtaby to by¢ cenna funkcja ,zabez-
pieczajaca”, ale o dziwo, nie dotyczy ona akapitéw, ktére maja zastosowana
interlini¢ automatyczna! Dodatkowy problem wynikajacy z wlaczenia tej opcji
to niemozno$¢ zastosowania ,,optycznego wyréwnania” interlinii, ktére moze
by¢ potrzebne niekiedy przy komponowaniu tytutéw lub nagtéwkoéw, a ktére
wymaga uzycia wigcej niz jednej wartosci interlinii w obrebie akapitu.

Automatyczna interlinia jest przydatna podczas eksperymentowania z réz-
nymi rozmiarami czcionek, jednak gdy juz podejmiemy decyzje co do stopnia
pisma, warto$¢ interlinii nalezy zmienié na bezwzgledna — nawet jeéli bedzie
to ta sama wielko$¢, ktérg ,wyliczyl” mechanizm automatyczny. Oto kilka
powodéw, dla ktérych nie powinni$my uzywac automatycznej interlinii:

® Automatyczna interlinia jest proporcjonalna do stopnia pisma — ale
dotyczy znakéw o najwiekszym rozmiarze w danym wierszu. Oznacza
to, ze jesli mamy jedno stowo, a nawet jeden znak wigkszy niz pozostate,
interlinia w tym wierszu wyniesie 120% tej powiekszonej wartosci.

® Automatyczna interlinia nie zapewnia nam wystarczajacej kontroli.
Oczywiscie, jesli uzywamy 10-punktowej czcionki, automatyczna inter-
linia wyniesie 12 punktéw, tadna i wygodna w uzyciu liczbe. Jesli jednak
zmienimy stopieni pisma na 11 punktéw, automatyczna interlinia wynie-
sie 13,2 punktu — trudng w przeliczaniu i praktycznie uniemozliwiajaca
korzystanie z siatek linii bazowych.

Justification
Minimum Desired M
Word Spacing: 80% 100%
Letter Spacing: 0%

Glyph Scaling: 100% 10

rd Justification. Full Justify B

Composer: Adobe Paragraph Cor
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RYSUNEK 4.14 Domyslna
wartoé¢ automatycznej in-
terlinii wynosi 120% stopnia
pisma. Wybranie trybu auto-
matycznego sygnalizowane
jest wyswietlaniem wielkosci
interlinii w nawiasach.

Type Optioas o

# Use Typographer's Quotes
# Type Too! Converts Frames to Text Fi

Ei‘mlﬁ'ﬂdm Te | Large

RYSUNEK 4.15 Opcja Apply
Leading to Entire Paragraphs
zapewnia utrzymanie jednoli-
tej interlinii w obrebie catego
akapitu — jednak nie dziata
przy interlinii automatycznej.

We are met on a great
battlefield of that war.
We havc come to dedicate

Q, f that field

as a final resting place
for those who here gave
their lives that that nation
might live. It is altogether

RYSUNEK 4.16 Przyktad
problemu wynikajacego z au-
tomatycznej interlinii — 120%,
ale czego? Poniewaz jeden,

w dodatku niewidoczny znak
(spacja na koricu piatego
wiersza) jest wiekszy niz reszta
znakow, pojawit sie powiek-
szony odstep pomiedzy tym
wierszem a poprzedzajacym.



Sedit aut ut optaspitias
dolorpor aut qui dolo. See
picture below:

Blabor apero omnis
renihit quos vel erio. Nam,
atempori dolorae rferspe
ligenditibus. See picture
below:

Dunt quatusam quis
aliquatis as quaspit, sinit
quaeprem res opture.

RYSUNEK 4.17 Automa-
tyczna interlinia dla grafik

w wierszu pozwala samoczyn-
nie zapewnic potrzebna prze-
strzen, stosownie do wielkosci
ilustracji.

n Il InDesign i tekst  Profesjonalna typografia w Adobe InDesign

® Jakkolwiek automatyczna interlinia moze si¢ zupetnie dobrze sprawdzac¢
dla tekstu gléwnego, bedzie wygladata okropnie w duzych rozmiarach,
na przyktad tytulach, ktére zazwyczaj wymagaja mniejszych swiatet
miedzywierszowych.

Automatyczna interlinia i grafika w wierszu

Istnieje jedno uzasadnione zastosowanie dla automatycznej linii — gdy uzywamy
grafik wstawionych w wierszu (inline), czyli wéwczas, gdy umieszczamy ramke
graficzna w pustym akapicie wewnatrz watku tekstowego. Jesli tekst zawiera
bezposrednie odwotania do ilustracji, takie obrazki s naturalnymi kandydatami
do umieszczenia ich w ten sposéb, dzieki czemu nigdy nie stracimy powigza-
nia kontekstowego pomiedzy tekstem a ilustracja. Grafika w wierszu stanowi
hybryde pomiedzy tekstem i autonomicznymi ilustracjami: odstepy przedi po ilu-
stracji kontrolujemy przy uzyciu interlinii. Automatyczna interlinia gwarantuje,
Ze w wierszu zawsze bedzie dos¢ miejsca na ilustracje, gdyz wielkos¢ interlinii
ro$nie lub maleje stosownie do wysokosci grafiki. W takiej sytuacji nalezy zadba¢
o to, aby akapit zawierajacy grafike w wierszu miat wlaczona automatyczna
interlinie (warto réwniez skorygowac procentowa wartosc), zapewniajac mu
réwniez odpowiednie odstepy powyzej i ponizej akapitu.

Zachowajmy spoéjnos¢, z wyjatkiem...
Interlinia, tak jak wiele innych elementéw typografii, okresla rytm — i, podobnie
jak w utworze muzycznym, chcieliby$my, aby rytm byt staty i niezaktécony.
Najlepsza metoda osiagniecia tego celu jest zdefiniowanie interlinii w stylu
akapitowym. Jesli zajdzie potrzeba zmiany tej wartosci, wystarczy przeedy-
towac ustawienia stylu, zamiast poprawiania tekstu lokalnie.

Jesli zachodzi potrzeba poradzenia sobie z szewcami lub bekartami, nie
prébujmy miesza¢ w to interliniil Mamy do dyspozycji inne sztuczki — zmiane
$wiatet, dzielenie wyrazéw, wymuszone zlamania wiersza, a nawet przereda-
gowanie tekstu — pozwalajace naprawia¢ takie problemy. Kuszaca jest mysl,
ze by¢ moze wystarczyloby troche scisna¢ lub rozluzni¢ interlinie tu lub tam,
ale jako$¢ dokumentu by na tym bardzo ucierpiata. Zawsze trzeba zachowa¢
jednolita interlinie gtéwnego tekstu, inaczej rytm tekstu bedzie sie kolebat
jak bicie nietrzezwego perkusisty.

Nie nalezy tez da¢ sie skusi¢ szybkiemu, ale nieeleganckiemu ,rozwiazaniu”,
jakim jest opcja justowania pionowego. Powoduje ono powiekszanie interlinii
w krétszym tamie, aby wyréwnac jego spéd (czyli spowodowad, ze bedzie sie
konczyt na tej samej linii bazowej, co tam dtuzszy). Faktem jest, ze kolejne
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tamy lub strony w tekscie ciaggtym powinny mie¢ jednakowa wysokos¢, ale
jeszcze istotniejsze jest utrzymanie registru, czyli jednakowego polozenia
wszystkich (a nie tylko ostatnich) wierszy w poszczegélnych tamach. Jesli za$
chodzi o wyréwnanie wysokosci w uktadzie wielotamowym, InDesign cs5
pozwala osiagnac to nowa funkcja Balance Columns, ktéra dopasowuje wysokosci
wszystkich laméw, zamiast rozciagga¢ ten najkrotszy.

Olesequatie magna feu faci blam illa feu feummy nibh ercillam jure digna
dolorem zztit nosto euip ea adigna
faccum velit autet lummod tem
quametumn quamcommod dolore molor ~ modolore veliquat ipisl dolessequat.
sit, quat vent il et nonsc commod tat Put in ut alis ad molor sumsandigna I
iureet irit lortie dolorercin volobor I staly sie zle: wysokosci faméw
peratueros nulput laor sed dolum ad f sq wyréwnane, ale za cene
magnim incilit wisi bla facipit. Endrem Perostrud tem eniametum quiscil. W I niejednakowej interlinii w s3-
i siednich famach.

faccum ing eniamet lore exer in etue

RYSUNEK 4.18 Dobre Swiatla

feuipsu sciduisim acidunt nulla alis alisi.

Interlinia i siatki linii bazowych

Jesdli nasz tekst ma by¢ wyréwnany do siatki linii bazowych, rozmieszczenie
siatki przebija ustawienie interlinii. Na przykfad, jesli mamy 12-punktowa siatke
linii bazowych i zmienimy interlini¢ na 13 punktdw, zostanie ona zaokraglona
w gére do najblizszej wielokrotnosci skoku siatki, czyli w tym przykladzie do 24
punktéw. Wiecej informacji na ten temat zawiera rozdziat 14, ,Strony, marginesy,
tamy i siatki”.

Ebis deria aut porepuda Ebis deria aut porepuda RYSUNEK 4.19 Przy korzysta-
. . niu z siatki linii bazowych ma
con'sendcxe repuda simus, int _ _ ora plenwszerisiwe nad st-
maiorecto exerae velecab consendae repuda simus, int wieniami interlinii. W prawym
oreptur as ides est vo]uptam przykfadzie nieznaczne zwick-
. .s . g szenie interlinii powoduje,
fcn.:enb usciis reserl:lm fugit maiorecto exerae velecab s wisnszn copascuniiy e
alibeario blaccus sitatem dopiero do nastepnej (co dru-
excesti atiissu ndipidus dolest oreptur as ides est voluptam giej) linii siatki.
Memphis Medium 10/12, aligned to grid Memphis Medium 10/12.1, aligned to grid

Ponad wszystko jednak nalezy zawsze bardziej ufa¢ wtasnym oczom, nie zas
liczbom. Zdarzaja si¢ sytuacje, w ktérych konieczne jest odstapienie od mate-
matycznej jednolitosci na rzecz optycznego dobierania §wiatet i skorygowanie
interlinii poszczegdlnych wierszy, aby calos¢ wyglgdata nadal jednolicie. Sytuacje
takie moga czesto pojawiac sie w tytutach czy nagléwkach, na przyktad wtedy,
gdy ktérys wiersz pozbawiony jest wydtuzen dolnych.
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RYSUNEK 4.20 Interlinia
optyczna: w przyktadzie

po prawej interlinia dla
czwartego wiersza zostala
zredukowana, aby skompen-
sowac brak wydtuzen dolnych
w wierszu poprzednim,

Litatem sereptatias doluptatur,
ipsam reptas alit maximinis dal-

cum volutem deni voloreh ende-
lesti doleniet que alignihilis solup-

tatium eum venel et aute nus sit,

nit ention conetur, ut et, sequiducil

_modipsumquam et ulpa aditati sin___

cus simoluptatia ea ni cusapelles
a aboreptas rem que jum aci ut
occuscidel estrum.

amnis re rem. Lt et et enecaest-

TEMPTATION
is to yield to it.

The only way
to get rid of a

The only way
to get rid of a

TEMPTATION
is to yield to it.

— Oscar Wilde
The Picture of Dorian Gray

— Oscar Wilde
The Picture of Dorian Gray

Pomijanie zgodnie z interlinig

Istnieje pewna (zastuzenie) ignorowana opcja preferencji, ktora okresla, jak
na interlinie wptywa oblewanie tekstem. Karta Preferences > Composition
(Preferencje > Sktad) udostepnia opcje Skip by leading (Pomiri wg interlinii), ktéra
ma gwarantowac, Ze tekst ponizej oblewanego obiektu zostanie przesuniety
do najblizszej dostepnej wielokrotnosci interlinii. Jak mozna sie domysle¢, celem
tej opcji jest osiggnigcie wyréwnania linii bazowych wzgledem sasiedniej strony
lub famu (czyli zachowania registru). Brzmi to doskonale, ale opcja ta dziata
tylko wtedy, gdy tekst przeptywa ponad — nie wokét — oblewanego obiektu.
Co wiecej, jesli oblewany obiekt znajdzie sie na szczycie famu, ustawienie to jest
ignorowane. Jakkolwiek jego wiaczenie nie sprawi nam zadnej krzywdy, nie zrobi
réwniez wiele dobrego. Znacznie lepszym sposobem osiagniecia tego samego
efektu jest uzycie siatki linii bazowych.

arcillabor re pa cone estiis isim
es ipici dolut dis cullandi reiciun-
labore, quam sin platemodi bea  tem quam, nis delibus anihic te

~ modiorepere non poritem hit ali-

Ne landebit_ipsapid manl;ru ‘quo quassum quiaeriandi tem ad
P quat aboreperiae quia qui optam
est_que eatis conecto_quatibe _asperchil ius.

Litatem sereptatias doluptatur, _arcillabor re pa cane estiis isim
ipsam_reptas alit maximinis dol- __es ipici dolut dis cullandi reiciun
labore, quam sin_platemodi bea  tem quam, nis delibus anihic te

_cum volutem deni voloreh ende-
lesti doleniet que alignihilis solup-
latium eum venet et aute nus sit,

_nit ention conetur, ut et, sequiducil 8
modipsumguam et ulpa aditati sin
cus simoluptatia ea ni cusapelles
a_aboreptas rem que ium aci ut
occuscidel estrum,

__Ne landebit ipsapid ma pro
omnis re rem. Ut et et enecaest-
est_gue eatis conecto quatibe

modiorepere non_poritem_hit ali-
quo.quassum_quiaeriandi tem ad
quat aboreperiae quia qui optam
asperchil ius,

RYSUNEK 4.21 Opcja Skip by Leading powoduje przesunigcie wiersza ponizej oblewanej grafiki
do nastepnej wielokrotnosci interlinii (po prawej). Jednak jesli zalezy nam na zachowaniu registru,
lepszym wyjsciem jest wykorzystanie dopasowania do siatki (patrz rozdziat 14).

[ Justify Text Next to an Object
™ Skip by Leading
[ Text Wrap Only Affects Text |




RozbpziAL 5

Odstepy miedzyliterowe,
Swiatfa i kerning

PISMO TO NIE TYLKO LITERY, ale rowniez przestrzer pomiedzy nimi, a takze od-
stepy miedzy stowami. Typografia to nie tylko czarne na biatym, ale tez biate
na czarnym. Ksztah kazdej litery i kazdego stowa obejmuje réwniez negatywowy

obszar biatego miejsca, ktore tez buduje rytm tekstu.
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Mozemy wnies¢ rownie
wiele wlasnych cech

w $wiatta kroju pisma,
co w sam krdj.

Danny van den Dungen
ze studia graficznego
Experimental Jetset
[cytowany w Helvetica,
rez. Gary Hustwit,
2007]

RYSUNEK 5.1 Szare paski
ukazuja odstepy miedzywy-
razowe (1 wiersz) i miedzylite-
rowe (3 wiersz).

Odstepy pomiedzy znakami pisma zaleza w jakims stopniu od osobistych pre-
ferencji, jak i trendéw typograficznych, ale niezaleznie od tego, czy bedziemy
faworyzowac ciasne, czy luzne ulozenie liter, czytelnos¢ tekstu i niezaklé-
cone przekazywanie tresci wymaga, aby odstepy te byty jednolite, a rytm
réwnomierny.

InDesign oferuje trzy rézne, ale powigzane ze soba podejicia dopasowywania
odstgpéw pomigdzy stowami i znakami. Odstepy miedzy literami (letterspa-
cing) to ogdlny parametr regulujacy przestrzen migedzy znakami wewnatrz
stéw i pomiedzy wyrazami. Swiatta (tracking) odpowiadaja za modyfikowanie
odstepéw w wybranym zakresie tekstu. Kerning za$ to korygowanie prze-
strzeni wewnatrz par liter w celu wizualnego skompensowania nieréwnych
odstepéw.

Odstepy miedzyliterowe kontra swiatta

W Adobe InDesign za regulacje odstepéw miedzy znakami odpowiadaja dwie
opcje dostgpne w oknie dialogowym Justification (Justowanie): Word Spacing
(Odstepy miedzy wyrazami) oraz Letter Spacing (Odstepy miedzy znakami).
Opcje pozwalaja osiagnac taki sam rezultat, jak zmiana swiatla, ale istnieje
pomiedzy nimi wazna réznica: odstgpy miedzyznakowe sa globalne, podczas
gdy zmiany $wiatel s i powinny by¢ lokalne.

Opcje odstepéw zawarte w oknie Justification stuzg do nadawania ,ciasno-
sci” lub ,luznosci” okreslonej klasie akapitéw, jako czeéé definicji stylu. Takie
podejscie jest preferowane, jesli jesteSmy w stanie przewidzie¢ potrzebe zmo-
dyfikowania odstepéw pomigdzy znakami, na przyktad wtedy, gdy chcemy
zmniejszyc odstepy wewnatrz tytuléw lub rozswietli¢ podpisy do ilustracji.
W calym rozdziale bede odwolywat si¢ do obydwu opcji Word Spacing i Letter
Spacing tacznie jako odstepéw.

Regulacja $wiatet powinna by¢ wykorzystywana do lokalnego dopasowywania
fragmentéw tekstu, na przyklad w celu eliminowania probleméw kompozy-
cyjnych (patrz podrozdzial ,Szewce, bekarty i wdowy” w dalszej czesci tego
rozdziatu) albo w celu skorygowania odstepéw migdzy znakami w pewnym
zakresie tekstu wewnatrz akapitu.

ThefNellie Jafcruisinglyawl Jswungltofherfanchorwithoutfalflutterjod]

the sails, and was at rest. The flood had made, the wind was nearly

calim, and being bound down thie rivel, the oplly thinig for it whs tb domie

to and wait for the turn of the tide.



ill Millennium Bridge

Foster And Partners, Anthony Caro, Arup, 2000-01

lhe first completely new pedestrian bridge to be built over the
Thames for a hundred years, the Millennium Bridge is a combina-
tion of art, design and technology. The three main contributors:
cngineer, architect and sculptor, designed the bridge to be stream-
lined, using an innovative and complex structure to achieve a simple
form: a shallow suspension bridge that spans the river as an ‘elegant
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Millennium Bridge

Foster And Partners, Anthony Caro, Arup, 2000-01

The first completely new pedestrian bridge to be built over the
Thames for a hundred years, the Millennium Bridge is a combina-
tion of art, design and technology. The three main contributors:
engineer, architect and sculptor, designed the bridge to be stream-
lined, using an innovative and complex structure to achieve a simple
form: a shallow suspension bridge that spans the river as an ‘elegant

Zazwyczaj nie ma potrzeby zmieniania odstepéw miedzyznakowych w tek-
$cie gléwnym. Taka ingerencja przypomina prébe zagrania utworu muzycznego
w zupelnie innym tempie, zastepujac to, co projektant pisma uznat za opty-
malng proporcje pomiedzy ksztattami i ttem w swoim kroju.

Stosujac ciasne odstepy, nalezy zwrécié¢ uwage, co dzieje sig z takimi parami
liter, jak rn; zbyt male odstepy moga spowodowaé, ze znaki skleja sie i w rezul-
tacie zobaczymy cos, co mozna pomyli¢ z m; ri moze wygladac jak n, a cl jak d.
Jezeli czgsto musimy zmniejszac odstepy miedzy znakami, warto zastanowic
sig, czy nie lepszym rozwigzaniem byloby uzycie wezszego (skondensowanego)
kroju, ktéry zostat zaprojektowany z mysla o bardziej efektywnym wykorzy-
staniu przestrzeni.

Zwigkszanie odstepéw w celu osiagniecia wrazenia jasno$ci wiaze sig z innymi
zagrozeniami. Jesli posuniemy sie zbyt daleko, moze sig okazaé, ze zerwiemy
powigzania miedzy poszczeg6lnymi znakami i zamiast dobrze znanych ksztal-
téw stéw i fraz dostaniemy rozsypane, pojedyncze litery. Kursywy i pisanki,
w ktorych ksztatty liter zostaly zaprojektowane tak, by taczyly sie ze soba,
nigdy nie powinny by¢ rozéwietlane w ten sposéb. Zbyt luzne uktadanie liter
moze nie wydawac si¢ jakims wielkim problemem, ale wielu typograféw prak-
tyki takie bardzo irytuja. Amerykanski typograf Frederic Goudy (1865-1947)
mial rzec: ,Kto§, kto rozswietla minuskute, gotéw jest tez kraéé owce” — i jest
to ponoc¢ ztagodzona wersja cytatu.

Przypomnijmy jednak, ze zadne z tych napomnieni nie jest absolutne. Nie-
kiedy musimy dokonywacé jakiego$ dopasowania odstepéw w naszym tekscie, zas
niektérzy projektanci odnosza wrazenie, ze ciasniejsze utozenie znakéw podnosi
czytelnoé¢ i poprawia zrozumialos¢. Niczego nie nalezy uwaza¢ za objawiona
prawdg. Zamiast tego, po prostu wydrukujmy nasza strone i przyjrzyjmy sie
jej krytycznie, w razie potrzeby siegajac po opinie innych oséb.

Ciasny uktad moze by¢ uzyteczny w nastepujacych przypadkach:

® W nagtéwkach i tytutach sktadanych czcionkami bezszeryfowymi
zmniejszenie odstep6éw ulatwia taczenie sie znakéw w formy latwiej
rozpoznawalnych ksztaltow stéw, a jednoczesnie tworzy wrazenie wigk-
szej gestosci, wzmacniajac efekt wyrézniajacy.

Minimum Deslred Maximum
Word Spacing: 85% 110K 115%
Letter Spacing: [10%  10%  10%
Chvoh Scaling: 97% ]

RYSUNEK 5.2 Pierwsze dwa
wiersze w przykiadzie po pra-
wej maja dodatnie odstepy,
zaaplikowane jako cze$c¢ defi-
nicji stylu akapitowego.

bum

RYSUNEK 5.3 Zbyt mate
odstepy miedzyliterowe moga
sprawi¢, ze niektére pary liter
zaczng sie myli¢ z innymi
znakami.
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DRAMA
COMEDY
TRAGEDY TRAGEDY

Odstepy miedzyliterowe 0%

DRAMA

DRAMA
COMEDY

DRAMA
COMEDY
TRAGEDY

Odstepy miedzyliterowe -20%

DRAMA

Odstepy miedzyliterowe 50%

DRAMA

COMEDY COMEDY COMEDY
TRAGEDY TRAGEDY TRAGEDY

RYSUNEK 5.4 Wplyw od-
stepéw na pismo tytulowe
ztozone wersalikami. Dodatnia
Zzmiana nadaje czcionce sze-
ryfowej (Trajan, u gory) ele-
gancki wyglad, podczas gdy
ujemna prowadzi do sklejania
sie szeryféw. Przy czcionce
bezszeryfowej (Verlag Bold,

u dotu) dodatnie odstepy spra-
wiaja, ze stowa tracg spéjnosc
i oko prébuje odczytywad
Znaki w pionie, a nie w pozio-
mie, podczas gdy zmniejszone
swiatto tworzy efektowny,
Jgesty” obraz.

® Przy korzystaniu z krojéw w odmianie waskiej: ich ,pionowa” natura
domaga sie zredukowania odstepéw miedzy znakami. Zbyt wiele ,powie-
trza” i slowa utraca swéj dynamizm.

Powiekszone odstepy mozna stosowaé w nastepujacych sytuacjach:

® W tytutach sktadanych czcionka szeryfowa samymi wersalikami dodat-
kowe $wiatlo miedzyliterowe moze zapewni¢ elegancki wyglad.

®  Przy tekscie w kontrze umieszczonym na jednolitym (ciemnym) tle dodat-

. kowe odstepy miedzy znakami poprawiaja czytelnosé.

® Przy uzywaniu bardzo matych stopni pisma, np. w podpisach lub me-
tryczkach fotografii, zwiekszenie odstepéw moze zapewnié¢, ze ksztalty
poszczegolnych liter beda dobrze rozpoznawalne.

Swiatta kontra kerning

Gwarantowanym sposobem rozjuszenia typografa-purysty jest zamienne
uzywanie pojec swiatlo (tracking) i kerning. Cho¢ oba s3 blisko powiazane,
znacza jednak co$ odmiennego. Oto réznica: jesli zaznaczamy ciag (kilka)
znakéw, stosujemy $wiatlo. Jesli kursor znajdzie si¢ wewnatrz pary liter,
wykonujemy kernowanie. Obydwa dziatania korzystaja z tego samego skrétu
klawiaturowego (Option/Alt+lewa strzatka w celu zmniejszenia odstepu lub
prawa w celu zwigkszenia). Regulacja $wiatet dziala w powiazaniu z innymi
ustawieniami typograficznymi. Jesli opcje justowania i dzielenia wyrazéw
s3 wlasciwie dobrane, znacznie rzadziej bedzie pojawiata si¢ potrzeba recznej
interwencji w postaci modyfikowania $wiatet.
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Szewce, bekarty i wdowy

Wymienione dramatis personae sugeruja jakis bardzo interesujacy temat, jednak
faktyczne definicje szewca, bekarta i wdowy moga sie okazaé rozczarowujace.
W dodatku zmieniaja sie one zaleznie od zrédla, jednak w tej ksigzce zdefiniu-
jemy je nastepujaco:

Szewc to pierwszy wiersz akapitu, pozostawiony na samym dole (koricu)
tamu lub strony. Szewce sa niezalecane, choé dopuszczalne w szczegélnych
sytuacjach.

Bekart to ostatni wiersz akapitu, ktéry zawist na szczycie nowego tamu lub
strony. Bekartéw zawsze nalezy unika¢.

Wdowa (ang. runt — termin ukuty przez Davida Blatnera, guru w dziedzinie
InDesigna) to konicowy wiersz akapitu ztozony z pojedynczego, krétkiego stowa,
albo, co jeszcze gorsze, fragmentu wyrazu powstalego po przeniesieniu kon-
cowego slowa (tego ostatniego mozna uniknaé, wybierajac wladciwe opcje
przenoszenia wyrazow). Wiersz taki zlozony z pojedynczego wyrazu nie musi
by¢ bledem, jesli stowo to jest dostatecznie dlugie. W opinii wiekszosci typo-
graféw taki wiersz nie powinien by¢ krétszy niz jedna piata szerokosci famu
lub niz podwojone wciecie akapitowe (o ile jest stosowane)’, zaleznie od tego,
ktéra z tych wielkosci bedzie wigksza.

Eliminacje szewcéw, bekartéw i wdéw mozna osiagnaé, modyfikujac nieznacznie
$wiatlo w kwestionowanym akapicie (albo tez w jednym lub kilku poprzedza-
jacych akapitéw). Warto zauwazy¢, ze zalecane jest raczej zmienianie §wiatta
w calym akapicie, a nie tylko w jednym wierszu lub (co gorsza) w pojedynczych
stowach. Regulacja swiatel stanowi szybka i elastyczna metode poprawiania
wygladu ztamanego tekstu, jednak jest to tylko kompromis, stanowi bowiem
zlamanie zlotej zasady jednolitoéci. Wazne jest, aby czytelnik nie zauwazat

1 Wijezyku polskim w tej dziedzinie panuje znaczne ,materii pomieszanie”. Wymienione
terminy s3 pojeciami tradycyjnymi, wywodzacymi si¢ jeszcze z czaséw sktadu meta-
lowego i w wigkszosci maja swoje zrédto w terminologii niemieckiej, jakkolwiek
mozna tez spotkaé termin ,sierota” na okreslenie nadmiernie krétkiego wiersza
koncowego. Wraz z wejéciem do uzytku programéw komputerowych ttumaczo-
nych z jezyka angielskiego pojawily sie niestety liczne kalki jezykowe. Angielskim
odpowiednikiem bekarta jest widow, czyli wdowa, za$ szewca — orphan, czyli sierota.
W polskiej wersji programu Microsoft Word (a péZniej rowniez w wielu innych)
pojawily sie wiec ,wdowy i sieroty”, ale w zupelnie nieadekwatnych znaczeniach.
Niestety, ta tendencja przybiera na sile i coraz wigksza liczba 0séb, w ten czy inny
spos6b pracujgcych z tekstem, uzywa tych wlasnie terminéw — gtéwnie z tego
powodu, ze nie znaja prawidlowych. W tej ksigzce jednak staram sie¢ — w miare
mozliwosci — stosowaé terminologie poprawng.
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Xerio expelen imaiorro berum
ressunt adios perum hiciunt am,
volorem re dolorio nserspe ribeatibus,
quibercimi, ut alit quam exceperovit
voluptusam, sum auda quostem
olecab idessi utem dolupta tiatiorum
nonectur, et rehentiorrum ut et
accus aceate volendandam explit
quiam voloreprorro omnim id quibus
et vendae dolut hillor magnihit
pratur? Quia velique cum nonse
cus et autempo ssitatem faccature,
cus quam, tenduntio cuptate ra
voluptatur? Rumet omnihic ianduntis
di volupit optaspi squossimos apid
eatemoditas is ex et esto etur? Ost
omnihil idem re mincit alibus eum
voluptum quias re sum laut aliquam

RYSUNEK 5.5 Bekart, wdowa i szewc

F Bekart

I idem ipsum.
Rumquistia guam, commole
nihicid qui que maximoluptas sandi
doluptam endictus, con nam labor aut

fuga. Nam sediam facesti susanda
[ ectur? I

Hendae moluptatur, ut aut doluptio
offictur a quost etur aspiciis magnam
sapisimi, nemquam, con experehendi
idendunt voluptu saepero ere
molorrore sum eum, verio duci blabo.
Itate pra quo erio voles ante sam,
cori ditassi mposam, corrorp oribusc
imilibea se laut exercium into cusda
quuntur audae nimil in perum hit lam
quas enistior sollenti nem quam,
Feriae ni volum facitiis enditiuntias.

Verro ma is renis aceseris aliqui

Wdowa

Szewc

tego, ze odstepy pomiedzy stowami w jakims miejscu sa mniejsze, niz w innym.

Rozwigzaniem jest zastosowanie minimalnego (niedostrzegalnego) ujemnego

$wiatla dla kilku wierszy lub calego akapitu. Nalezy jednak ostroznie stoso-

wac te metode — niektére akapity mogg by¢ odporne na préby skrécenia ich

w ten sposéb. Jesli uzyjemy zbytniej sily, lekarstwo moze sig okaza¢ gorsze

od choroby. Rézne domy wydawnicze i projektanci maja odmienne standardy,

jakie modyfikacje s3 dopuszczalne — moja sugestia to nieprzekraczanie war-

tosci —15/1000 firetu. Wigksza ingerencja w $wiatto moze sprawi¢, ze tekst

zacznie sig ,sktada¢ w harmonijke”, co czytelnicy na pewno zauwaza, a tego

powinni$my unika¢.

Usuwanie szewcéw i bekartéw powinno odbywac sie¢ w ostatniej fazie pracy

nad dokumentem. Nie ma powodu zajmowa¢ sig nimi, dopéki uktad lub sam

tekst nie maja jeszcze ostatecznej postaci. Istnieja tez inne uwarunkowania,

ktére warto uwzgledni, jesli chcemy uzy¢ modyfikacji $wiatet do eliminowania

szewcow i bekartéw:

® Nalezy zacza¢ od poczatku tekstu i posuwa¢é sie metodycznie az do konca.

Nie nalezy cofac si¢ ani skaka¢ w przéd z jednej strony na inng — inaczej

okaze sig, ze naprawiamy jeden blad tylko po to, aby stworzy¢ inny.
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RYSUNEK 5.6 Zmienianie $wiatfa w celu usuniecia bekarta na szczy- :

cie strony — rozktadowka z bekartem (po lewej) i ta sama rozktadéwka E ﬂ' —4 -
L} "

po jego usunieciu dzieki zmniejszeniu swiatet 0 4/1000 firetu.

= Niekiedy latwiej jest Sciagna¢ akapit, ktéry poprzedza miejsce wystapie-
nia bledu (zamiast samego problematycznego akapitu) w nadziei, ze da
to pozytywny efekt dodatkowy.

® Przydatna jest opcja preferencji, ktéra podswietla na zielono kazdy
fragment tekstu, dla ktérego zastosowano niestandardowe éwiatto. Poma-
ranczowe linie wewnatrz ogélnie zielonych obszaréw wskazuja miejsca,
gdzie pojedyncze odstepy zostaly mocniej zmodyfikowane. W celu wia-
czenia tej opcji nalezy na karcie Preferences > Composition (Preferencje >
Sktad) zaznaczy¢ pole wyboru Custom Tracking/Kerning (Wtasny kerning/
$wiatlo). Opcja moze by¢ szczegélnie przydatna, jeéli dokument otrzy-
malis$my od kogos i chcemy sprawdzié, czy tekst nie zostat sciggniety lub
rozswietlony przez nazbyt zapalczywego poprzednika, a takze wéwczas,
gdy tres¢ zostala przeedytowana i byé moze reczne modyfikacje swiatet
nie s3 juz potrzebne. Opcja ta jest réwniez dodatkowym powodem, dla
ktérego nie nalezy nigdy stosowa¢ zmian $wiatel w ramach stylu akapi-
towego: jesli dodatkowe $wiatlo (ujemne lub dodatnie) jest stosowane
wszedzie, nie ma jak zauwazy¢ wyjatkéw!



WSKAZOWKA: Najlepsza
metoda dostrzezenia
korytarzy jest wydruko-
wanie strony i odwrocenie
jej do gory nogami, dzieki
czemu sam tekst i odstepy
pomiedzy stowami stajg
sie abstrakcyjne. Poniewaz
mdzg nie bedzie proébowat
interpretowac (rozumiec)
tekstu, wszelkie rysy czy luki
stang sie lepiej widoczne.

RYSUNEK 5.7 Okropne
spacjowanie stow i kanaliki

(a raczej cate rzeki i jeziora!)
spowodowane wyjustowa-
niem tekstu w waskim tamie.
Zastosowanie nieznacznej
modyfikacji swiatta (-s/1000
firetu) do wiersza 4 i 5 usuneto
przynajmniej kanaliki.

WSKAZOWKA: Inne
zastosowanie swiatet: warto
rozwazyc stosowanie dodat-
niego swiatta (najlepiej

w formie stylu znakowego)
do akronimow, takich jak
NATQO, AIDS lub skrotow
(USA, HTML), w ktorych
zapewnienie rozréznialnosci
poszczegolnych znakow jest
wazniejsze od bycia spoj-
nymi jako ksztatty stow.
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Korytarze

Podczas dopasowywania $wiatel nalezy zwracaé uwage na szaros¢ catego akapitu,
anie tylko poprawianego wiersza, wypatrujac korytarzy (kanalikéw) — innego
bledu skiadu, ktéry moze zaburzy¢ jednolita barwe bloku tekstu. W terminologii
typograficznej korytarz (ang. river) to linia lub rysa biegnaca pionowo poprzez
akapit, tworzona przez przypadkowe (i nieszczesliwe) rozmieszczenie spacji
w sasiednich wierszach. Korytarze czesciej tworza sie w waskich tamach justo-
wanego tekstu, ale mogga sie réwniez pojawic¢, gdy litery sa rozmieszczane zbyt
ciasno. Przy stosowaniu wtasciwych proporcji szerokosci tamu oraz popraw-
nych ustawien dzielenia wyrazéw i justowania, korytarze pojawiaja sie rzadko.
Czasami jednak po prostu mamy pecha — wéwczas zastosowanie nieznacznej
modyfikacji §wiatel lub zmiana miejsca podziatu wyrazéw moze by¢ rozwia-
zaniem problemu.

Oreo similiquid que consecto et
escitat. Arit facearum, status quo
omiimint. Ebistio rrovidis eiusae
nam,%sinverunt, nosame/dolut
abore,§test repeliqui/optatur
aboribuiint. Culpa des Que volessi
audae nos et verepre mporenis eniti
net doluptiis evelici autem.

Oreo similiquid que consecto et
escitat. Arit facearum, status quo
omi mint. Ebistio rrovidis eiusae
nam, sinverunt, nosame dolut abore,
test repeliqui optatur aboribu int.
Culpa des que volessi audae nos et
verepre mporenis eniti net doluptiis
evelici autem.

Inne sposoby usuwania szewcdw, bekartéw i korytarzy

Jesli problematyczny wiersz jest gluchy na wdzieki Swiatel, nie nalezy prze-
ciggad struny. W takiej sytuacji nalezy raczej usunaé wszystkie zmiany
$wiatel (Cmd+Option+Q albo Ctrl+Alt+Q), po czym wyprébowa¢ jedna z nas-
tepujacych opcji:

Dostosowanie odstepéw miedzywyrazowych. Wielkos¢ spacji mozna zmniej-
szy¢ lub powiekszy¢ w zaznaczonym obszarze bez wptywania na $wiatta
migdzyliterowe. Cmd+Option+Backspace / Ctrl+Alt+Backspace zmniejsza
szerokos¢ spacji, zas Cmd+Option+Shift+\ (odwrotny ukosénik) powoduje ich
poszerzenie,

Bez dzielenia. Dobieranie $wiatel i wielkosci spacji nie daje efektu? Zastosujmy
opcje No Break (Bez dzielenia) do fragmentu tekstu, aby zmusi¢ go do zmiesz-
czenia si¢ w jednym wierszu. Mozna stosowac ja w wybranych miejscach,
zaznaczajac co najmniej dwa ostatnie slowa akapitu i wybierajac opcje No Break
z menu palety sterujacej.
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Swiatla i uktadacz akapitowy

Wiersze akapitu uktadane przy uzyciu Adobe Paragraph Composer (domys$lna
metoda ukfadania tekstu) nie zawsze tamia sie zgodnie z oczekiwaniem, jesli
zmodyfikujemy swiatto. Wynika to z faktu, ze wiersze s3 komponowane na pod-
stawie zawartosci cafego akapitu, nie za$ wiersza — kazda zmiana w obrebie
akapitu powoduje, ze InDesign ponownie uktada go w catosci, a nie tylko wiersz,
w ktérym dokonalismy poprawek. Cho¢ moze to by¢ frustrujace dla redaktoréw
i korektoréw, zalecane jest korzystanie z tego mechanizmu, a nie przestarzatego
Single line composer (uktadacza jednowierszowego), gdyz zapewnia lepsza szaroé¢
tekstu. Wiecej informacji zawiera rozdziat 7, ,Wyréwnanie”.

© Highlight ol
.\Mhnﬁvlﬂﬂ ke ghus b than was B unded | Okeep d Fonts
r ! | O ) Substituted Clyphs
| Custom Tracking/Kerning

RYSUNEK 5.8 Wiaczenie opcji Custom
Tracking/Kerning w preferencjach podswietla
fragmenty, w ktérych zostaly zmienione $wiatla
miedzyliterowe.

Przeedytowanie tekstu. Nie zawsze mamy taka mozliwos¢, zaleznie od rodzaju
dokumentu, nad ktérym pracujemy, jesli jednak mamy prawo dokonywac popra-
wek, zrébmy to — czesto minimalna zmiana szyku lub wymiana stowa na jego
synonim zalatwi sprawe.

Trzymanie wierszy razem. Keep Options (Opcje przenoszenia) to parasol, pod
ktérym kryja sie rézne metody sterowania, jak akapity sie przetamuja — albo
nie przelamuja. Mamy tu takie mozliwosci, jak Keep with Previous (Razem
z poprzednim), Keep with Next (Razem z nastepnym), Keep Lines Together (Nie
dziel wierszy), a takze opcje Start Paragraph (Poczatek akapitu), ktéra mozemy
wymusié rozpoczecie danego akapitu od nowej strony, tamu lub ramki. Jesli
nie zalezy nam na tym, aby wszystkie famy ,staly réwno” (tzn. mialy te sama
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WSKAZOWKA:
Przegladanie stron
dokumentu w duzym
pomniejszeniu, z tekstemn
symulowanym maczkiem
(greeked) czesto utatwia
identyfikacje miejsc, w kto-
rych wystepuja problemy
skiadu.

RYSUNEK 5.10 Opcje No
Break mozna nadac recznie,
aby utrzymac razem dwa lub
wiecej stow. Alternatywnie
mozna zastosowac styl GREP,
aby nadac ten atrybut spacji
pomiedzy dwoma ostatnimi
wyrazami akapitu, automa-
tycznie eliminujac mozliwosc
wystapienia wdowy.

koricows lini¢ bazows), mozna uzy¢ tych opcji, aby okresli¢, po ilu poczatkowych
wierszach (i przed iloma koricowymi) akapit moze przetamac sig na kolejna
strong lub fam. Ostrzezenie: zbyt agresywne stosowanie tych opcji moze spra-
wi¢, Ze tekst bedzie si¢ zachowywat bardzo dziwnie, z akapitami skaczacymi
od ramki do ramki, zupelnie jakby miaty wlasne zdanie na temat tego, gdzie
powinny si¢ znalez¢! Co powiedziawszy, trzeba podkreslic, ze Keep with Next jest
bardzo uzyteczne, jesli chcemy zapewnic, ze tytuty ani podtytuty nie wezma
rozwodu z tekstem, ktéry po nich nastepuje. Wiecej informacji zawiera roz-
dzial g, ,Dzielenie (i niedzielenie) stéw, wierszy, akapitéw i stron”.

Wykorzystanie stylow GREP do usuwania wdéw

Style GREP (dostepne w InDesignie od wersji CS4 w gore) umozliwiajg zmiane
formatowania na podstawie kontekstowego warunku sformutowanego jako
wyrazenie regularne. W szczegdéinosci mozemy nada¢ atrybut No Break dwom
ostatnim stowom akapitu. Zagwarantuje to, ze ostatni wiersz kazdego akapitu
bedzie zawierat przynajmniej dwa stowa, o ile nadamy mu odpowiedni styl.
Stylami GREP zajme sig blizej w rozdziale 12, ,Globalne formatowanie przy uzyciu
styléw”, ale poniewaz to zastosowanie styléw GREP dotyczy szczeg6lnie unikania
probleméw skfadu, zaprezentuje odpowiednie wyrazenie bez wnikania w zasady
jego funkcjonowania. Wskazéwka ta powstata dzieki uprzejmosci eksperta w
dziedzinie InDesigna, Michaela Murphy‘ego. Polecam wszystkim zapoznanie sie
z jego artykutem ,Learning GREP”" w witrynie Lynda.com.

Najpierw nalezy utworzy¢ styl znakowy nadajacy atrybut No Break (Bez dzie-
lenia). Nastepnie trzeba otworzy¢ do edycji styl akapitowy, w ktérym chcemy
uniknaé wdow. W sekcji GREP Style okna opgji stylu akapitowego wybieramy
zdefiniowany wczesniej styl z menu Apply Style (Zastosuj styl), za$ w pole To Text
(Do tekstu) wpisujemy:

(2<=\wh\s(?=\w+[[:punct]]+$)

CpenType
+ Ligatures

Underline Options....
Strikethrough Options...

« Adobe Paragraph Composer
Adobe Single-line Composer

Ay Sevkn: o break
To Fant: (Pl oo+l ot [+ 51

A Pretew (o) (——



RYSUNEK 5.9 Dostosowywanie wielkosci spacji w celu eliminacji zbyt krétkiego wiersza koricowego
{wdowy). Akapit drugi ukazuje skutek zmniejszenia tylko odstepéw miedzywyrazowych. Akapit 3
ukazuje skutek wiaczenia wyswietlania niestandardowych $wiatet w preferencjach dokumentu.

Alice was beginning to get very tired of sitting by her sister on the
bank, and of having nothing to do: once or twice she had peeped into
the book her sister was reading, but it had no pictures or conversations
in it, ‘and what is the use of a book,” thought Alice ‘without pictures or
conversation?’

Alice was beginning to get very tired of sitting by her sister on the bank,
and of having nothing to do: once or twice she had peeped into the book

her sister was reading, but it had no pictures or conversations in it, ‘and
whatistheuse ofabook, thought Alice ‘without pictures or conversation?’
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Kerning

Kerning dziata na najnizszym poziomie dopasowywania §wiatet. Jego cel jest

conversation®

korekcyjny: skompensowanie wrazenia nieréwnego rozmieszczenia znakéw
w pewnych szczegélnych parach znakéw, zwlaszcza gdy jedna lub obie sa nachy-
lone lub zakrzywione. W celu zapewnienia lepszego wrazenia konieczne jest
uzycie kerningu w celu wyréwnania takich niejednolitych swiatel. Zazwyczaj
wigze sig to ze zmniejszaniem $wiatla pomiedzy znakami, cho¢ w niektérych
sytuacjach moze wymagaé powiekszenia odstepu. Niejednolicie rozmiesz-
czone znaki moga zniszczy¢ dobre wrazenie, jakie powinna sprawia¢ strona.
Jakkolwiek wigkszos¢ czytelnikéw nie bedzie umiata sprecyzowa¢, ze to zty
kerning jest winowajca, beda intuicyjnie wiedzie¢, ze co$ jest nie tak.

Automatyczny kerning

Jesli dopasowywanie $wiatet dla kazdej pary liter wyda sie komus czyms$
podobnym do nerwicy natrectw, a na pewno absurdalnie czasochlonnym przed-
sigwzigciem, moze sig uspokoi¢: wigkszos¢ naszych potrzeb w tej dziedzinie
zapewniaj automatyczne mechanizmy wbudowane w InDesigna, zatem nie
musimy doprowadzac sie do szalenistwa, wyszukujac wszystkie problematyczne
pary liter i recznie poprawiajac ich odstepy. Istnieja dwie automatyczne metody
kerningu, obie doskonale sprawdzajace si¢ w niewielkich stopniach pisma:
kerning metryczny i optyczny. Bez wzgledu na to, ktéra metode wybierzemy,
zawsze mozemy dodac kerning reczny w razie potrzeby.

Rozdziat 5 Odstepy miedzyliterowe, swiatta i kerning

Bez korekgji Swiatet

Z dopasowaniem odstepow
miedzywyrazowych

WSKAZOWKA: Domysiny
skok kerningu i $wiatet

w preferencjach programu
to 20/1000 firetu, co jest zde-
cydowanie za duzo. Warto
utatwic sobie prace i zmie-
nic te wartos¢ na 1/1000
firetu bez zadnego otwar-
tego dokumentu, dzigki
czemu nowa wielkos¢ stanie
sie domyslng preferencjg
programu dla wszystkich
nowych dokumentéw.



RYSUNEK 5.11 Tekst ty-
tutowy bez kerningu, z ker-
ningiem automatycznym
(opartym na metryce fontu)
i z kerningiem nadanym
recznie.

WSKAZOWKA:
Uzytkownicy programu
QuarkXPress, przechodzacy
do InDesigna, powinni
pamietac, aby przemnozyc
uzywane przez nich stare
wartosci kerningu przez

5, aby uzyska¢ odpowied-
nie liczby. W terminologii
Quarka zmiana $wiatta czy
kerningu o ,1" oznacza
1/200 firetu. W InDesignie
" 0znacza jedna tysieczng
firetu. Jesli wiec tekst
otrzymat $wiatto réwne
1w QuarkXpress, teraz
bedziemy musieli uzy¢
wartosci s.

RYSUNEK 5.12 Kwadrat fire-
towy i oczko litery
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WAVE
WAVE
WAVE

Aby zobaczy¢, jak automatyczny kerning jest nadawany dowolnej parze liter,

umies$émy kursor tekstowy pomiedzy tymi literami; w polu Kerning pojawi sie

pewna liczba w nawiasach. Kroje pism s3 projektowane jako czeé¢ kwadratu

o boku wynoszacym 1000 u

mownych jednostek, co odpowiada jednemu firetowi.

Kerning (a takze swiatta) w InDesignie wyrazane sa w tych jednostkach, czyli

w tysiecznych czesciach fi

retu. Poniewaz s to jednostki wzgledne, dostoso-

wania kerningu czy tez $wiatel wykonane w jednym stopniu pisma skaluja sie

wraz ze zmiang tego stopnia i maja proporcjonalnie taki sam efekt w dowolnej

innej wielko$ci.
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One morning, when Gregor Samsa woke from troubled
dreams, he found himself transformed in his bed into

a horrible vermin. He lay on his armour-like back, and

if he lifted his head a little he could see his brown belly,
slightly domed and divided by arches into stiff sections.
The bedding was hardly able to cover it and seemed ready
to slide off any moment. His many legs, pitifully thin
compared with the size of the rest of him, waved about
helplessly as he looked.

Kerning
metryczny

Kerning

One morning, when Gregor Samsa woke from troubled
optyczny

dreams, he found himself transformed in his bed into

a horrible vermin. He lay on his armour-like back, and
if he lifted his head a little he could see his brown belly,
slightly domed and divided by arches into stiff sections.
The bedding was hardly able to cover it and seemed
ready to slide off any moment. His many legs, pitifully
thin compared with the size of the rest of him, waved
about helplessly as he looked.

Kerning metryczny kontra optyczny

Kerning metryczny opiera sie na warto$ciach metryk wbudowanych w wiekszoé¢
fontéw. Wartosci te s instrukcjami, nakazujacymi skorygowanie odstepéw
pomiedzy okre§lonymi kombinacjami liter. Odzwierciedlaja one decyzje podjete
przez projektanta kroju, jak — jego zdaniem — litery powinny by¢ rozmieszczane
imaja znaczacy wplyw na ocene jakosci danego kroju. Programy do tworzenia
font6w moga zautomatyzowac budowanie par kerningowych, jednak wiekszos¢
projektantéw woli dobieraé je samodzielnie — przynajmniej dla tych kombinacji
liter, ktdre sa znane jako klopotliwe.

Kerning optyczny jest rozwigzaniem numerycznym, ktére ignoruje wartosci
metryczne zapisane w foncie, zamiast tego dopasowujac $wiatla wewnatrz
par liter do ich ksztaltéw. Zazwyczaj kerning optyczny daje nieco ciasniej-
szy uklad tekstu. Dodatkowo, poniewaz jest to rozwiazanie matematyczne,
jest tez bardziej ujednolicone. Jednak czy optyczny kerning wyglada lepiej?
Odpowiedz zalezy od jakosci metryki, ktéra zostanie uzyta do poréwnania.
Metryki kerningu zawieraja w sobie subiektywne decyzje projektanta kroju,
ajak mozna uslyszec od kazdego projektanta, dobry kréj to ten, ktéry dobrze
wyglada — tworzenie znakéw jest bardziej sztuka niz nauka écista.
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RYSUNEK 5.13 Ten sam
fragment tekstu ukazujacy
poréwnanie obu metod
kerningu automatycznego
w InDesignie.

UWAGA: Kerning i swiatta
kumuluja sie: uzycie
jednego nie uniewaznia
drugiego. Mozna uzyc
$wiatet do zmiany ogélnego
wygladu tekstu, po czym
zastosowac kerning

do poprawienia potozenia
okreslonych kombinaciji liter.
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Welcome

Metryczny

Welcome

Optyczny

RYSUNEK 5.14 Optyczny ker-
ning jest preferowang metoda
przy taczeniu dwach fontow
w jednym wyrazie.

Istnieje kilka spraw, ktére nalezy rozwazy¢, decydujac sig na kerning metryczny

lub optyczny:

Teoretycznie kerning optyczny zapewnia bardziej jednolite rozmieszcze-
nie znakéw. Kazda para znakéw — nawet najdziwniejsze i najrzadziej
spotykane polaczenia, takie jak zh, xw lub gk — jest kernowana na pod-
stawie ksztaltéw znakéw’.

Jesli uzywany font zawiera niewiele lub wcale par kerningowych, nie
mamy wyboru — jestesmy zmuszeni do stosowania kerningu optycznego.
Fonty dekoracyjne lub nowo zaprojektowane czgsto maja tylko niewielka
liczbe par kerningowych w metryce.

Optyczny kerning nalezy stosowac, jesli faczymy rézne kroje w obrebie
tego samego slowa (bezsprzecznie rzadkie zjawisko), poniewaz w tym
przypadku nie istnieja zadne metryki dla sasiadujacych ze soba liter z réz-
nych krojéw. Metryki kerningowe stosowane s3 dla par liter. Jeli jedna
litera pochodzi z jednego kroju, a sasiednia z innego, nie istnieje zadna
wczeéniej przewidziana para dla nowego potaczenia.

Reczny kerning

Reczny kerning zazwyczaj nie jest potrzebny dla tekstu ztozonego typowym

rozmiarem tekstu gléwnego, ale odgrywa wazna role w tytulach i nagléwkach.

W miare zwiekszania stopnia pisma wszelkie anomalie odstepéw staja sie bar-

dziej widoczne, zatem wzrasta tez potrzeba ingerencji, aby osiagnac wizualnie

jednolite spacjowanie znakéw.

Do mozliwych kandydatéw na reczne dopasowywanie kerningu mozna

zaliczyé:

Tytuly, nagléwki, szyldy i inne teksty sktadane bardzo duzymi stopniami
pisma.

Spuszczone inicjaty, gdy otwierajaca litera koliduje z nastgpujacym po niej
tekstem.

Potaczenia krojow (szczegdlnie zestawienia antykwy z kursywa).

® Kroje pisankowe — aby zagwarantowac, ze litery wlasciwie tacza sie

ze soba.

2 Dla polskiego uzytkownika waznym argumentem bedzie tez fakt, ze bardzo wiele
dostepnych fontéw, nawet tych ,z wyzszej pétki”, nie zawiera par kerningowych
dla ,polskich liter”.
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Metody kernowania pism tytutowych

Wydwiczenie oka tak, aby dostrzegalo dobry kerning, wymaga czasu. Dopéki
nie nabierzemy wprawy, powinni$my zachowywac¢ si¢ delikatnie i dokonywa¢
jedynie drobnych dostosowan. Reczny kerning musi by¢ wykonany ze staran-
noécig i pelnym zrozumieniem zaréwno celéw, jak i skutkéw — w przeciwnym
razie bedzie tylko gigantycznym marnotrawstwem czasu. Zanim wiec zaczniemy
korygowac kerning w wielkoformatowym napisie, powinniémy sie upewni¢,
ze mamy wlasciwe (docelowe) opcje odstepéw miedzyznakowych i ze usta-
wiliémy ostateczna warto$¢ §wiatet. Drobne dopasowania par kerningowych
moga okaza¢ si¢ nadmiarowe lub uniewaznione, jesli pézniej trzeba bedzie

wykonaé zmiane swiatel.
RYSUNEK 5.15 Kernowanie
pisma tytutowego (Helvetica
Neue Bold Condensed 62 pt).
Liczby ponizej tekstu ukazuja
[ | wartosci przesuniec stoso-
| | | | I | [ wane do poszczegéinych

par liter.
0 0 0 0 -18 -55 0 0 -150
Automatyczny kerning
0 -0 0 0 -48 -75 0 -10 -200
Kerning niestandardowy
ETHER I shall turn . HETHER I shall turn RYSUNEK 5.16 Spuszczony

inicjat kolidujacy z pierwszym

whether that station whether that station wierszem tekstu; blad popra-
must show. To begin must show. To begir wiony poprzez zaaplikowanie
d ni kernin ie-
record that I was bor record that I was bo d:: a,;,.'f?_'o, erningu pomig
4 4
RYSUNEK 5.17 Kernowanie
czcionki pisankowej.
Kerning metryczny Kerning reczny

Reczny kerning nie jest czyms statycznym, ale kinetycznym. Dowolna zmiana
w kerningu wybranej pary liter ma wptyw nie tylko na te pare, ale na wszystkie
znaki w napisie, nad ktérym pracujemy. Dlatego tez nalezy zacza¢ od naprawy
najgorszego problemu i pozwoli¢ parom kerningowym dobra¢ $wiatta dla
reszty tekstu. Oczywiscie, jesli korygowana para wystepuje wiecej niz jeden
raz, wszystkie te miejsca trzeba potraktowa¢ w taki sam sposéb.
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Nie nalezy tez przesadzaé. Wraz z odkryciem, jak tatwo mozna zmienia¢
kerning, przychodzi skfonnos¢ do naprawiania wszystkiego, takze tego, co wcale
si¢ nie popsulo. Wiekszosé ksztaltéw liter pasuje dobrze do wiekszosci swoich
prawdopodobnych sasiadéw.

Podczas wykonywania poprawek kerningu nalezy powiekszy¢ obraz, aby
dobrze widzie¢ najdrobniejsze detale znakéw — po czym powréci¢ do widoku

»jeden do jednego”, aby upewni¢ sie, ze zmiany wygladaja zadowalajaco.
Pamigtajmy tez, aby zawsze dokonac ostatecznej oceny na wydruku — wyglad

RYSUNEK 5.18 Bluza,kernin- . . . T
gowa’, znaleziona w serwisie ekranowy bardzo czesto jest niewystarczajacy do wlasciwej oceny.

Veer.com.

RYSUNEK 5.19 Najwiekszym

problemem w przykladzie
po lewej byt nadmierny a e t a e t
odstep pomiedzy W"i,a"

Od tego miejsca zaczatem,

po czym probowatem optycz- ° ° ]
nie wyréwnac odstepy po- | -1

miedzy pozostatymi literami, RI 1

co doprowadzito do koniecz-

nosci zwiekszenia odstepu
pomiedzy ,R"i,i"

Kerning metryczny Kerning reczny

Anegdota z dawnych czasow

Gdy bylem jeszcze dzieciakiem dorastajacym w potudniowym Londynie (na dtugo
przed tym, zanim w ogéle dowiedziatem sie, czym sa czcionki), zauwazytem
kiedys$ wielki neon reklamujacy nowy sklep wideo — znajdowat sie jakie$ sto
metréw ode mnie. Nazwa sklepu brzmiata FLICKERS, napisana samymi wersa-
likami. Litery byly rozmieszczone bardzo ciasno, totez — z pewnego dystansu —
kombinacja ,LI” wygladata jak ,U".

Bez watpienia, neon ten zwracat uwage...




ROZDzIAL -6

Drobne (ale wazne)
szczegoty

TYPOGRAFIA ZAJMUJE SIE przede wszystkim detalami i bycie dobrym typogra-
fem wymaga przynajmniej niewielkich sktonnosci do obsesji. Jednak to ,dopiesz-
czanie”drobnych elementow jest czyms wiecej, niz czepianiem sie nieistotnych
rzeczy — wynika z checi zapewnienia jasnosci przekazu. Zwracanie sie ku deta-
lom wymaga, abysmy to my przejeli kontrole nad naszymi komputerami, aby
nie skfanialy nas do popetniania amatorskich btedéw. Wszystkie programy
do projektowania maja jakie$ ustawienia domysine, ktére s3 po prostu gtu-
pie — InDesign nie stanowi tu wyjatku. Unikanie ztych ustawien nie gwarantuje,
ze gotowa praca bedzie wygladata dobrze, ale przynajmniej pomaga uchronic
przed zlym wygladem. Aby osiggna¢ dobry efekt, musimy wykorzysta¢ wiele
sposréd opcji InDesigna, ktore pozwalaja poprawi¢ wyglad strony — zrozumiec
réznice pomiedzy rodzajami spacji i ich stosowaniem, wiedziec, czym réznig
sie najrozmaitsze kreski poziome i umie¢ wykorzystac funkcje dostepne w fon-
tach OpenType. Skupienie si¢ na szczegdtach jest tym, co pozwoli naszej pracy

wyréznic sie w ttumie innych.
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“Don’t count the
days, make the

days count.”

"Don’t count the
days, make the
days count."

— Muhammad Ali

Type
| Atomatically Use Comact Optical Size
| Triple Click to Select a Line:

RYSUNEK 6.1 Cudzystowy
typograficzne (u gory) i znaki
cala (u dotu)

«Plus ¢a change, plus
c’est la méme chose.»

RYSUNEK 6.2 Zmienianie
ustawieri w preferencjach
stownikowych w celu
umozliwienia stosowania
cudzystowow wiasciwych
dla jezyka. W tym wypadku
francuskie szewrony uzyte
jako podwajne cudzystowy
typograficzne.

Cudzystowy typograficzne

Zaden szanujacy sie typograf nie da sie ztapa¢ na uzywaniu sprostych cudzy-
stowéw” (znakéw cala) w miejsce sparowanych cudzystowéw typograficznych.
Domyslnie ta opcja preferencji jest wigczona. Uzycie typograficznych cudzysto-
wéw jest tez dostgpne podczas umieszczania tekstu — znajdziemy ja w oknie
dialogowym opcji importu, wyswietlanym po zaznaczeniu pola Show Import
Options (Pokaz opcje importu). W amerykariskiej odmianie jezyka angielskiego
podwéjne znaki cudzystowéw stuza do zaznaczenia cytatu, zas pojedyncze —
do wskazania cytatu wewngtrz cytatu. Podobna reguta obowiazuje w jezyku
polskim, cho¢ same znaki cudzystow6w s3 odmienne od amerykanskich. W bry-
tyjskiej odmianie pojedyncze i podwéjne cudzystowy sa stosowane odwrotnie.
Dodatkowo zasady amerykanskiej wersji wymagaja, aby przecinki lub kropki
konczace cytowany tekst powinny sie znalezé w jego wnetrzu (przed zamykaja-
cym cudzystowem), nawet jesli nie stanowia czesci cytatu. Dwukropki i §redniki
jednak powinny znalez¢ sig na zewnatrz. Brytyjczyk lub Polak umiesci kazdy
konczacy znak przestankowy poza cytatem, co by¢ moze ma wiecej sensu, ale
czesto nie wyglada zgrabnie.

Preferencje stownikowe pozwalajg wybra¢ wariant (wyglad) cudzystowéw
pojedynczych i podwdjnych dla réznych jezykéw. Oto kilka przyktadéw:

‘O’ Angielskie cudzystowy pojedyncze

“O” Angielskie cudzystowy podwéjne

«0»> Francuskie cudzyslowy pojedyncze

«O» Francuskie cudzystowy podwéjne (szewrony)
«O» Nie-francuskie szewrony (bez odstepu)

,0° Niemieckie cudzystowy pojedyncze

»0“ Niemieckie cudzystowy podwéjne

,O’  Polskie cudzystowy pojedyncze

»O”  Polskie cudzystowy podwéjne

Proste znaki cudzystow6w stanowia spadek po czasach, gdy inzynierowie
(na pewno nie typografowie) dostosowywali uktad klawiatury maszyny do pisa-
nia do kodéw Ascil. Niewlasciwe stosowanie prostych cudzystowéw stato sie
powszechne, gdy programy DTP pozwolily, aby niemal kazdy mégt sktada¢ swoje
wlasne teksty. Jedli konieczne jest wprowadzanie w tekscie liczb okreslajacych
wymiary w stopach i calach, mozna wylaczyé tworzenie cudzystowéw typogra-
ficznych, naciskajac Cmd+Option+Shift+ (Ctrl+Alt+Shift+) — od tego momentu
naciénigcie odpowiednich klawiszy wstawi ,prosty” cudzystéw (ponowne wta-
czenie cudzyslowow typograficznych zapewnia ta sama sekwencja klawiszy).
Lepszym wyborem moze by¢ unikanie prostych cudzystowéw w kazdej sytu-
acji i uzycie znaku prim (prime) dla st6p lub minut oraz bis (double prime) dla



cali czy sekund. Znaki te mozna wstawia¢ za pomoca panelu Glify. S3 one
dostgpne w niektérych fontach, a jesli uzywany kréj ich nie zawiera, mozna
siggna¢ po kréj Symbol. Jesli czesto korzystamy z tych znakéw, warto utworzy¢é
sobie wlasny, podreczny zestaw gliféw zgodnie z opisem zawartym w czesci
~Iworzenie zestawu gliféw” dalej w tym rozdziale.

Apostrofy

Apostrof jest tym samym znakiem, co pojedynczy cudzystéw zamykajacy.
Niekiedy moga pojawi¢ si¢ nieporozumienia, gdy InDesign niewtasciwie ,domy-
8li si¢”, czego chcemy, i wstawi pojedynczy otwierajacy cudzystéw w miejsce
apostrofu. Efekt taki moze wystapi¢ w zwrotach, w ktérych apostrof zastepuje
brakujace litery albo datach, gdzie apostrof sygnalizuje brakujace cyfry”. W celu
wstawienia apostrofu, a nie otwierajacego cudzystowu pojedynczego, nalezy
uzyc¢ skrétu Shift+Option+] (Shift+Alt+]).

Wyb6r podrecznika stylu

Kazdy wigekszy wydawca ma swoj wlasny podrecznik stylu, ktéry okresla zasady
uzycia i skladu znakéw przestankowych, odstepéw i innych elementéw., Wiele
z nich jako punktu wyjécia wykorzystuje The Chicago Manual of Style. Na rynku
dostepne s3 podreczniki stylu kilku wielkich wydawcéw, takich jak New York
Times, The Guardian (Wielka Brytania) lub Associated Press. Bez wzgledu jednak
na to, ktéry podrecznik wybierzemy jako punkt wyjscia do tworzeniu wlasnego
stylu, najistotniejsze jest zachowanie spéjnosci’.

Znaki przestankowe
W ciagtym tekscie, jesli kropka, przecinek lub dwukropek nastepuja po wyrazie

zlozonym kursywg lub czcionka wyttuszczona, one same réwniez powinny
by¢ kursywa lub wyttuszczone. Cudzystowy, znaki zapytania i wykrzykniki
powinny by¢ skladane ta sama odmiana, ktérej uzywa reszta zdania.

Znaki przestankowe (i dywizy) wypadajace na krawedzi famu powinny nie-
znacznie wystawac poza jego obrys — co$, co mozna tatwo osiagna¢ uzywajac

1 Uwaga ta nie ma zastosowania w jezyku polskim, gdyz nie zdarza sie uzycie apostrofu
na poczatku wyrazu.

2 Niestety nie ma na rynku analogicznych wydawnictw dotyczacych zasad stylu dla
jezyka polskiego.

|
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UWAGA: ,Nie-francuskie”
0znacza uzycie szewronow
w nieoficjalnej wersji, bez
spacji. Oficjalny francu-

ski styl wymaga spacji
oddzielajacej szewrony

od cytowanego tekstu.

Max Headroom: 6’ 11”
Bedroom One: 15’ x 10’
Letter Size: 8%"x 11"

Cudzystowy

Max Headroom: 6' 11"
Bedroom One: 15'x10'
Letter Size: 8 %" x 11"

Znaki stop i cali (minut i sekund)

Max Headroom: 6’ 11"
Bedroom One: 15’ x 10"
Letter Size: 8%'x11"

Znaki Prime i Double
RYSUNEK 6.3 Znaki prim i bis
z fontu Symbol w poréwnaniu

do cudzystowow i znakow
stop i cali.

Fish ‘n’ Chips
Rock ‘n’ Roll
‘90s

Nieprawidfowo

Fish 'n’ Chips
Rock 'n’ Roll
’90s

Prawidlowo

RYSUNEK 6.4 Apostrofy
kontra pojedyncze otwierajace
cudzystowy
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Frankenstein! If thou| Optyczne wyréwnanie marginesow
: of revenge against mej
han in my destruction
xtinction that I might
if yet, in some mode

Czy zwrdciliécie kiedys uwage, ze znaki przestankowe na krawedziach ramki
tekstowej sprawiajg, ze lewy lub prawy bok tamu wydaje sie nieréwny? Gdy
wiersz zaczyna si¢ znakiem przestankowym, takim jak otwierajacy cudzystow,
albo koriczy kropka, przecinkiem lub dywizem, powstaje wizualna luka.

Do niedawna ta niedoskonato$¢ byta postrzegana jako czesé ceny, jaka pta-
cimy za postep. Ostatecznie, mozemy zrobi¢ duzo wiecej dzieki programom
do skfadu publikacji! Uwzgledniajac wszystkie korzysci, czy naprawde to ma

# optical Margin Alignment znaczenie, ze musieliSmy przy tym pogodzic sie z pewnym brakiem finezji?
@ m I tu pojawia sie ratunek w postaci programu InDesign.

Funkcja Optical Margin Alignment pozwala znakom przestankowym i kreskom,
a takze krawedziom liter, ,zwisa¢” poza krawedz tekstu, dzieki czemu brzeg tamu

RYSUNEK 6.5 Optyczne wydaje sie réwniejszy. Co zaskakujace, niektére osoby nie lubia takiego wygladu,
:yo:jo::a “':;esx;g::f ::;g: preferujac zmieszczenie wszystkiego wewnatrz bloku tekstu. Sa jednak réwniez
przestankowych poza granice tacy, ktérzy tak polubili smak kawy rozpuszczalnej, ze wola jq od prawdziwe;j.

ramki tekstowej.

funkcji Optical Margin Alignment (Optyczne wyréwnanie margines6w), stosowa-
nych albo lokalnie za posrednictwem panelu Story (Watek), albo globalnie jako
cze$¢ stylu obiektowego (patrz rozdziat 12, ,Globalne formatowanie przy uzyciu
styléw”). Parametr numeryczny okresla wielko§¢ tego wysuniecia. Zazwyczaj

RYSUNEK 6.6 Dostosowy- powinna by¢ to wielko$¢ réwna lub zblizona stopniowi pisma, ale mozna sko-
wanie wielkosci znakéw prze-
stankowych w nagtéwkach:
bez korekcji (u géry) i z roz- Znaki przestankowe w pismach tytulowych moga wydawac sie nieproporcjo-
miarem zmniejszonym z 30
do 24 punktéw (na dole).

rygowac ja wizualnie, dazac do najlepszego wygladu tamu.

nalnie duze, zatem czesto konieczne jest zredukowanie wielkosci przecinkéw,
kropek, dwukropkéw lub cudzystowéw, aby skompensowa¢ ten efekt.

“One Small Step For Man,
One Giant Leap For Mankind”

“One Small Step For Man,
One Giant Leap For Mankind”



Kreski poziome
Istnieja trzy dtugosci poziomej kreski — a nawet pie¢, jesli uwzglednimy znak
minus oraz kreske cyfrowa — przy czym kazda z nich stuzy innym celom.

Dywiz (ang. hyphen) jest najkrotsza kreska, zazwyczaj o dtugosci pomiedzy jedna
czwartg a jedna trzecia firetu. Dywizy stuza do rozdzielenia pojedynczych stéw
na sylaby podczas dzielenia wyrazéw, do laczenia zazwyczaj odrebnych stéw
w nowy wyraz zlozony®, a takze do faczenia stéw frazy, ktora jest uzywana przy-
miotnikowo®. Dywizowi nie powinny towarzyszy¢ odstepy po zadnej stronie,
zwyjatkiem l3cznika zawieszonego, ktéry wymaga spacji nastepujacej po nim.
Zawieszony lacznik stosowany jest wowczas, gdy wymieniamy kilka stéw réz-
nigcych si¢ przedrostkami i dla lepszej ptynnosci pomijamy gtéwny czion
wyrazu we wszystkich wystapieniach oprécz ostatniego — tak jak w zwrotach

»jedno- lub dwustronny”, ,gérno- i dolnozaworowy” lub ,,przed- i powojenny”.

Pétpauza (en dash), wywolywana skrétem Option/ Alt+— (minus), zwana tez
»kreska potfiretowa”, jako ze jej dtugosé wynosi w przyblizeniu pét firetu, sto-
sowana jest do oznaczania przedzialéw. Jesli podczas glosnego odczytywania
tekstu bedziemy chcieli wstawi¢ ,do” (i by¢ moze poprzedzajace ,0d”), w zapisie
uzyjemy pélpauzy. W takim zastosowaniu nie uzyjemy spacji ograniczajacych
kreskg. Inne zastosowanie to funkcja tacznika, gdy przynajmniej jeden z taczo-

nych wyrazéw sam jest wyrazem zlozonym, zawierajacym dywiz.

Pauza (em dash) (Shift+Option/Alt+-), inaczej kreska firetowa, pelni przede
wszystkim funkcje myslnika, czyli separatora oznaczajacego wtracenie
w zdaniu®.

Pauzy nie powinny nigdy dotyka¢ znakéw, ktére je poprzedzaja ani tych,
ktére po nich nastepuja. Mozna w tym celu zastosowac¢ cienkie spacje (Cmd+
Option+Shift+M / Ctrl+Alt+Shift+M), aby mieé pewno$¢, ze kreska nie zetknie

Em dashes —also known as long Em dashes —also known as long
dashes —are used to set off a phrase.
They also indicate an abrupt change

in thought —like this.

dashes —are used to set off a phrase.
They also indicate an abrupt change
in thought —like this.

Pauzy z cienkimi spacjami przed i po Pauzy zwezone poziomo do 75%

3 Wtym wypadku w jezyku polskim wystepuje okreslenie ,}acznik” — jest to ten sam
znak, jesli chodzi o forme, ale rézni sie funkcja.

4 To ostatnie zastosowanie jest doé¢ czgste w jezyku angielskim, ale nie powinno by¢
stosowane w polskim tekscie.

5 W jgzyku polskim myslnik ma znacznie wigcej zastosowan, niz w jezyku angielskim —
przede wszystkim w sktadaniu dialogéw.

I DauZa

RYSUNEK 6.7 Cztery rézne
diugosci kreski poziomej
(Adobe Caslon Pro, 60 pt)

Otwarte 9-17
1914-1918
lipiec-sierpien
Zle

Otwarte 9-17
1914-1918
lipiec-sierpien
Dobrze

RYSUNEK 6.8 Pdipauza
zastosowana do oznaczenia
zakresow dat

RYSUNEK 6.9 Uzycie pauzy
w jezyku angielskim

Rozdziat 6 Drobne (ale wazne) szczegdty 95
— dywiz
—— minus
— potpauza
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Znak wielokropka
Option-; / Alt-; ($rednik)

A...7Z

Kropki rozdzielane cienkimi
spacjami
Cmd-+Shift+Option+M /
Ctrl+Shift+Alt+M

...all men are created
equal...they are
endowed...with certain
unalienable Rights...
Life, Liberty and the
pursuit of Happiness.

Znak wielokropka

...all men are created
equal...they are
endowed...with certain
unalienable Rights...
Life, Liberty and the
pursuit of Happiness.
~Wiasny” wielokropek

RYSUNEK 6.10 Rozne podej-
scia do wielokropka

sig z sasiednimi znakami. Zwykla spacja miedzywyrazowa jest zbyt szeroka,
a ponadto w justowanym skladzie bedzie sie rozszerzaé lub zweza¢, aby wyréw-
nac dlugoé¢ wiersza. Cienka spacja ma szerokos¢ jednej 6smej firetu, nie podlega
podzialom (co oznacza, ze kreska nie zostanie oddzielona od otaczajacych stéw)
i nie zmieni szerokosci w justowanym tekscie®.

Niektorzy ludzie uwazaja, ze pauza jest zbyt dtuga i decyduja si¢ na uzycie
w funkcji myslnika pétpauzy albo poziome przeskalowanie pauzy do 75-80%
normalnego wymiaru. Jesli wybierzemy te drugg opcje, mozna wykorzystac styl
GREP (patrz rozdzial 12) do zautomatyzowania tego procesu. W istocie jest to méj
wtlasny wybér, ale styl wydawnictwa wymaga stosowania petnych pauz’.

W czasach maszyn do pisania pauze tworzono jako podwéjny dywiz. Poniewaz
niektére osoby s3 z natury niezdolne do oduczenia sie tego nawyku, nadal
mozna czesto spotka¢ takie (i wiele podobnych) przyblizenia, ktére trzeba
bedzie wyszukad w tekscie i zastapi¢. Wiecej informacji na ten temat zawiera
fragment ,Sprzatanie tekstu” w rozdziale 2, ,Wprowadzanie tekstu”.

Zaawansowane fonty OpenType moga réwniez zawiera¢ kreske cyfrowa,
ktorej dlugosc odpowiada szerokosci cyfr tabelarycznych i ktéra jest prze-
znaczona do harmonijnego wspéldziatania z liczbami, a takze znak minus,
nieznacznie dluzszy od dywizu, ale (zazwyczaj) krétszy od pétpauzy, choé
ta ostatnia regula zalezna jest od konkretnego kroju.

Wielokropki

Wielokropek zazwyczaj oznacza opuszczenie fragmentu tekstu albo retoryczna
pauze w wypowiedzi. Jesli opuszczone wyrazy znajduja sie wewnatrz zdania,
wielokropek otaczamy spacjami®. Jesli jednak takie niedopowiedzenie lub
opuszczenie wypada na koncu zdania, umieszczamy go bezposrednio po ostat-
nim wyrazie, pomijajac koricowa kropke.

6 Polskie reguty skladu nie wymagajg stalego dystansu pomiedzy myslnikiem a pozosta-
tym tekstem — przeciwnie, zalecane jest stosowanie zwyktej spacji, takze w skladzie
justowanym. Dopuszczalne (a zdaniem niektérych typograféw wrecz zalecane) jest
lokalizowanie my$lnika na koricu tamu, zatem nierozdzielnoé¢ nie jest wymagana.
Zalecane jest natomiast unikanie umieszczania my$lnika na poczatku wiersza, o ile
nie jest on kreska dialogows. Warto natomiast zastosowac spacje o stalej szerokosci
po myslniku otwierajagcym wypowiedz w dialogach, aby zagwarantowa¢, ze wlasciwy
tekst w kolejnych wierszach bedzie zaczynat sie w tej samej pozycji.

7 W odréznieniu od autora mogltem pozwoli¢ sobie na zastosowanie tego rozwiazania
w calej ksigzce, ale ,méj” wybér to 70% dlugosci standardowej pauzy.

8 Polskie zasady interpunkcji nakazuja, by wielokropka nie oddziela¢ od poprzedza-
jacego wyrazu, a w przypadku umieszczenia go na poczatku wypowiedzi, réwniez
od naste¢pujacego po nim.



Prawdziwy znak wielokropka wystepuje w wiekszosci fontéw i jest osiagalny
poprzez skrét klawiaturowy Option / Alt+; (§rednik). W niektérych krojach
mozna jednak stwierdzi¢, ze znak ten jest zbyt waski (kropki rozmieszczone zbyt
ciasno). W takiej sytuacji mozna stworzy¢ ,wlasny” wielokropek z trzech kropek
rozdzielonych cienkimi lub wlosowymi spacjami. Uzyjemy wéwczas funkcji Find/
Change do wymiany wszystkich innych form wielokropka na wlasna wersje.

Znaki konca

Symbole takie s3 czgsto spotykane w czasopismach, gazetach i podobnych
wydawnictwach do zaznaczenia korica artykutu — szczegélnie wéwczas, gdy
artykul ten rozciaga si¢ na kilka stron. Moze by¢ to znak wybrany z jednego
z fontéw dekoracyjnych, takich jak niesmiertelny Zapf Dingbats, albo grafika
w wierszu, na przyklad logotyp wydawnictwa. Znaki kofica powinny zosta¢
dopasowane rozmiarem do stopnia pisma, aby nie byly wigksze niz wysokos¢
wielkiej litery w kroju tekstowym. Zaleznie od wybranego symbolu, mozna
nawet zazyczy¢ sobie, aby nie byl wiekszy od wysokoséci minuskul. Znak
konca moze by¢ oddzielony od kornica tekstu statym odstepem (na przyktad
spacja pétfiretowa, Cmd/ Ctrl+Shift+N) albo dosuniety do prawego marginesu
(Shift+Tab). Dla zachowania jednolitosci warto utworzy¢ w tym celu odpowiedni
styl znakowy.

and so, in conclusion, it’s fair to say  and so, in conclusion, it’s fair to say
that the quick brown fox jumped  that the quick brown fox jumped
over the lazy dog. = over the lazy dog. L]

Symbole

Czesto uzywane znaki specjalne mozna wprowadzaé uzywajac polecenia Type
> Insert Special Character > Symbols (Tekst > Wstaw znak specjalny > Symbole).
Wszystkie pozostale znaki tego typu sa dostepne za posrednictwem panelu
gliféw. Podobnie jak w przypadku znakéw przestankowych, niektére sposréd
symboli powinny mie¢ skorygowang (zwykle zmniejszona) wielkos¢, gdy uzy-
wamy wigkszych stopni pisma.

Bullet Character y
Markers > Copyright Symbol ©
Hyphens and Dashes > Ellipsis
Quotation Marks 3 Paragraph Symbol q
Other » Registered Trademark Symbol ®

~ Section Symbol §
Trademark Symbol ™

znalez¢ w panelu glifow.
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RYSUNEK 6.11 Znak korica,
zwymiarowany do wielkosci
x-height tekstu i oddzielony
spacjq poffiretowa (po lewej)
lub dosuniety do prawej

(po prawej).

RYSUNEK 6.12 Znaki specjalne dostepne
w menu Symbols — wszystkie inne mozna
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IEmkﬂ! THM
En Space ORN

Nanbreaking Space s
Nonbreaking Space (Fixed Width)

Hair Space

Sixth Space

Thin Space
Quarter Space
Third Space
Punctuation Space
Figure Space
Flush Space

NoxM

Em Space = spacja firetowa
= szerokos¢ rowna stopniowi
pisma (w tym wypadku 36
punktow)

En Space = spacja poffiretowa

Third Space = trzecianka
(% firetu)

Quarter Space = kwarcianka
(% firetu)

Thin Space = cienka spacja
(% firetu)

Hair Space = spacja wlosowa
(¥%a firetu)

RYSUNEK 6.13 Znaki od-
stepow dostepne w menu
Insert White Space. Ich szero-
kosci sa wzgledne w stosunku
do stopnia pisma.

InDesign i tekst Profesjonalna typografia w Adobe InDesign

Spacje i odstepy

Oprécz ,zwyklej” spacji miedzywyrazowej InDesign udostepnia dwanascie
innych znakéw odstepéw. Wszystkie one s3 dostepne w menu Type > Insert White
Space (Tekst > Wstaw znak odstepu) albo w menu kontekstowym narzedzia
Tekst, aktywowanym kliknieciem prawym klawiszem myszy.

Spacja firetowa (Em Space)

Spacja o szerokoéci jednego firetu, a zatem réwnej aktualnemu stopniowi pisma.
W pi$mie 12-punktowym spacja firetowa bedzie miata szerokos¢ 12 punktéw.
(Cmd/ Ctrl+Shift+M).

Spacja poffiretowa (En Space)

Spacja ta (Cmd/ Ctrl+Shift+N) ma szerokos¢ réwng potowie spacji firetowej.

Spacja justujgca (Flush Space)

Powoduje ,rozepchniecie” kilku stéw na szerokoéé tamu, bez zmieniania szero-
kosci pozostalych odstepé6w pomiedzy tymi wyrazami. Spacja justujaca dziata
tylko w trybie justowania wszystkich wierszy.

Spacja wtosowa (Hair Space)

Jest to spacja o szerokosci wynoszacej 1/24 firetu (Cmd+Option+Shift+I/
Ctrl+Alt+Shift+I). Mozna ja stosowa¢ jako alternatywe dla spacji cienkiej.

Spacja niedzielgca (Nonbreaking Space)

Majac tg sama szerokos$¢ co spacja zwykla, spacja niedzielaca’ (Cmd+Option+X/
Ctrl+Alt+X), zgodnie z nazwa, zabezpiecza nas przed podzialem wiersza pomie-
dzy stowami, ktére taczy. Przyktadem zastosowania takiej spacji moze by¢
»powiazanie” imienia lub inicjatu z nazwiskiem, tytutu (takiego jak dr lub mgr)
znazwiskiem —unikamy sytuacji, gdy jedna czes¢ calosciowego zwrotu znajdzie
si¢ na konicu wiersza, a reszta w wierszu nastepnym (lub, co gorsza, w nastep-
nym tamie)"’. Wykorzystanie niedzielacych spacji jest lepsza metoda zmiany

9 W polskiej wersji interfejsu InDesigna spacje te otrzymaty nazwe ,spacji twardych”,
co jest nieporozumieniem, gdyz ,twarda spacja” jest spacja niedzielaca o statej szero-
kosci (druga z dostgpnych opcji) — omawiang w tym miejscu spacje, ktérej szerokosé
zmienia si¢ w razie potrzeby podczas justowania wierszy, zgodnie z logika nalezy
nazywac niedzielaca lub nietamiaca.

10 Dla polskiego uzytkownika podstawowym zastosowaniem spacji niedzielacych
jest eliminacja wiszacych spéjnikéw, czyli jednoliterowych (a w niektérych wypad-
kach réwniez dwuliterowych) sléw ,zawieszonych” na koricu wiersza. Wstawienie
niedzielgcej spacji pomigdzy takim spéjnikiem i nastepujacym po nim wyrazem
skutecznie eliminuje takie niepozadane efekty.
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RYSUNEK 6.14 Spacje ju-

GRAPHIC DESIGN ILLUSTRATION PHOTOGRAPHY B . .
stujgce mozna wykorzystac
do rozszerzenia grup stow

Zwykle spacje na szerokos¢ famu bez zmie-
niania odstepow wewnatrz
tych grup.

GRAPHIC DESIGN ‘ ILLUSTRATION PHOTOGRAPHY

Spacje justujgce

Zadnych podwéjnych spaciji, prosze...

Nie istnieje Zadne usprawiedliwienie wstawiania gdziekolwiek w tekécie wiecej niz
jednej zwyklej spacji na raz. Tak, stysze, co chcecie powiedzie¢... Nie. Nigdy.

Konwencja wstawiania podwdjnych spacji po kropkach jest spadkiem
po czasach maszyn do pisania, gdy czcionka byla statopozycyjna, czyli wszyst-
kie znaki miaty zawsze te samg szerokos$¢, bez wzgledu na ich ksztatt. Tak wiec
litera i zajmowata tylez miejsca, co w. Litery w piémie maszynowym byty tak
szerokie i otwarte, ze pojedyncza spacja pomiedzy zdaniami nie zapewniata
dostatecznego odstepu.

Dzi$ jednak uzywane przez nas kroje pisma — o ile nie prébujemy naslado-
wac wygladu maszynopisu, aby nada¢ dokumentowi wyglad ,retro” — s3 pro-
porcjonalne, zatem kazdy znak ma unikalng szerokos¢ dopasowana do jego
ksztattu. Spacje w fontach proporcjonalnych maja wielkoé¢ tak dobrana, aby
perfekcyjnie oddziela¢ zdania. Wstawianie dwdch spacji po kropkach niweczy
mozliwos¢ uzyskania jednolitej szaroéci bloku tekstu i sprawia, ze strona wyglada
na amatorszczyzne. .

Obecnie mozna spotkac tekst wygladajacy jak z maszyny do pisania jako
zabieg artystyczny, nie jako dziatajace narzedzie, ale przyzwyczajenie do wsta-
wiania podwdjnych spacji przetrwato. Dlatego tez wéréd domyélnie zdefinio-
wanych zapytan w Adobe InDesign znajdziemy Multiple Spaces to Single Space
(Wielokrotne spacje na pojedyncza) i uzycie tego zapytania w mgnieniu oka
usunie wszelkie dodatkowe spacje.

miejsca podziatu wiersza (na przyklad przy eliminowaniu wdéw, czyli zbyt
krétkich wierszy konicowych) od wymuszonego ztamania. Jeli tekst zostanie
przeedytowany lub zmieniony w jakis inny sposéb, nie grozi nam sytuacja,
ze owo wymuszone zlamanie znalazlo sie nagle w érodku wiersza.

Niedzielaca spacja o stalej szerokoéci (Fixed Width), ktéra mozna nazwac
spacjq twardg, zgodnie z nazwa ma niezmienng szeroko$¢, réwniez w akapitach
justowanych. Mozliwe zastosowania sa podobne jak wszystkich innych spacji
o statych szerokosciach — na przyklad w celu zapewnienia statego odstepu
pomiedzy liczbami a jednostkami miary.
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1234567890
1|3|5|7|91

Spacje cyfrowe

RYSUNEK 6.15 Spacje cy-
frowe umozliwiaja wyréwna-
nie cyfr w pionie.

WSKAZOWKA: Zar6wno
Mac OS5, jak i Microsoft
Windows obstuguja wiele
uktadow klawiatury dla
réznych jezykow. Warto
upewnic sie, ze wybrali-
smy wiasciwy dla jezyka,
w ktérym pracujemy, gdyz
w przeciwnym razie dostep
do potrzebnych znakéw
specyficznych dla tego
jezyka moze okazac sie
bardzo utrudniony.

Warto tez zauwazy(, ze w miejsce spacji niedzielacej mozna stosowaé atrybut
No Break (Bez dzielenia) dla spacji zwyklej lub wigkszego zaznaczonego frag-
mentu tekstu. Wiecej informacji na ten temat zawiera rozdzial g, ,Dzielenie
(i niedzielenie) stéw, wierszy, akapitéw i stron”.

Cienka spacja (Thin Space)"

Spacja o szerokosci jednej 6smej firetu, uzyskiwana skrétem Cmd+Option+
Shift+M/Ctrl+Alt+Shift+M) — dobry wybér przy oddzielaniu od tekstu pauzy,
francuskich cudzystowéw lub kropek w recznie budowanym wielokropku.

Spacja cyfrowa (Figure Space)

Spacja o szerokosci réwnej szerokosci cyfr w ukladzie tabelarycznym, w ktérym
kazda cyfra zajmuje taka samga przestrzen. Cyfry tabelaryczne (zwane tez
cyframi o stalej szerokosci) uzywane s3 w sktadaniu tabel i w innych przypad-
kach, gdy konieczne jest pionowe wyréwnanie cyfr na poszczegélnych pozycjach
(kolumny czy tez ,stupki” liczb). Spacja cyfrowa, dzieki identycznej szerokosci,
jest pomocna przy wyréwnywaniu cyfr w takiej sytuacji.

Spacja interpunkcyjna (Punctuation Space)

Spacja interpunkcyjna ma identyczna szerokos¢, jak kropka, dwukropek lub
wykrzyknik w danym kroju pisma.

Panel glifow

Dostep do znakéw specjalnych, obcych liter akcentowanych, symboli walut lub

znakéw diakrytycznych, ktére nie s3 osiggalne w uzywanym ukladzie klawiatury,
zapewnia panel Glyphs (Glify). Aby go wyswietli¢, nalezy uzy¢ polecenia Type

> Glyphs (Tekst > Glify)'”. Trzeba niestety powiedzie(, ze panel ten jest dalece

niedoskonatym rozwigzaniem, gdy chodzi o wyszukiwanie okreslonych gliféw —
szczegdlnie gdy uzywany font zawiera wielki zbiér znakéw. Mozna wprawdzie

ograniczy¢ widok do podklas, posortowaé widok wedtug numeréw Unicode

(co jednak jest przydatne tylko wtedy, gdy znamy numer Unicode poszukiwa-

nego znaku), a takze zmieni¢ wielko$¢ wyswietlanych znakéw. Niemniej jednak

11 W polskiej wersji interfejsu InDesigna wystepuje jako ,chuda spacja”, jednak w tra-
dycji jezykowej takiej nazwy nigdy nie bylo, natomiast ,cienka spacja” znana jest
z czaséw skiadu metalowego jako justunek o szerokosci do 2 punktéw, ale wigkszej
niz 1 punkt - jak tatwo zauwazy¢, jedna 6sma firetu dla typowego pisma dzietowego
plasuje si¢ w tym przedziale.

12 Polecenie to jest réwniez obecne w menu Window > Type and Tables (Okno > Tekst
i tabele).
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zlokalizowanie okreslonego glifu nadal przypomina przystowiowe szukanie
igly w stogu siana. Gdy wreszcie uda nam sie odnalez¢ wlaéciwy znak, mozemy
wklei¢ go w miejscu kursora tekstowego, dwukrotnie klikajac glif w palecie.

Znaki i glify — co za réznica?

Glif to okreslona forma znaku w danym kroju pisma. Wigkszosci znakéw odpo-
wiada pojedynczy glif, ale niektére kroje pisma dla pewnych znakéw zawieraja

po kilka gliféw wariantowych. Paleta gliféw umozliwia dostep do tych form

Fonty CID to odmiana fontéw Type 1 (postscriptowych), opracowana w firmie
Adobe w potowie lat dziewigcdziesigtych XX wieku w celu obstugi wielkich
zbioréw znakéw — przede wszystkim nietaciriskich, takich jak alfabet chinski,
japorniski lub koreanski. Numer CID odnosi sie do identyfikatora indeksujacego
znaki, umozliwiajgce odszukanie wlasciwego glifu w foncie.

alternatywnych.
Ostatnio uzywane glify RYSUNEK 6.16 Panel glifow
=lltrowanie reamn Hide Options
oo 3 T LTI QT ol [ T [ T[] Sotes . Zmienaniesorto-
~yswietlenia 3, tmmmsee Edit Ghyph Set » ia glifé
“ylko podklasy T st $ § Veomhse wania glifow
-’Iriféw Pt $ s /58 % % & & § vdecionse >
= T e T T N T | AT 5y OO / GID
= ol N Y B N Rl el L,
S ‘ ela710]elofolo]e |1
B TaT~T-T7 T2T- 0T AT ’ Wyswietlanie gliféw alternatywnych dla
T Capmah From Eapt 2 3 4 Y g tywny
3 et 2. 2.; 210702, 3. 3. IR ES 4- zi;._'i - wybranego znaku. Kliknigcie i przytrzy-
—— 1*[s/6]6 Sle|7|7|7]712/8]8 manie pola znaku oznaczonego trGjkaci-
__: U o . - ? | - | kiem w prawym dolnym rogu powoduje
oI 1919,% ]9, s [ <[=[>|!)|? @ @A | wyswietlenie wyskakujacego menu, z kt6-
b “'_'-.._"'...2__.:“..« | c D_l D E' E'___P' F G’ G, H’ H _I IS ]} | rego mozemy wybra¢ odmienny wariant.
gﬁm LiL MMININIOlO/P|P ;Q Q R R f Inna n:'rozhwnsc tcopC{aﬁfrernarffor'
— e et St Bulel” i S S - e Selection, dostepna w liscie rozwijanej
== [Thit/Uju|VvWwX|x Y| Y| Z]z Show (Pokaz).
SANANR AR N “lajajal*|biB|b]|c a'[“‘[:l
@|cld p|4|ele E| | f|fb ff|fibffh fi M | |
fit/fh fi) 6§ |fk|fl ft)Flgicie|hjm/™ i) P8 B0
jlr kK|l o/ mm/M[™ nin/N|jojo|° =
— = g - -
Lista rozwijana fontéw, umotzliwiajaca wy- Powigkszanie lub zmniejszanie
branie innego fontu do wyswietlenia wielkosci glifow w palecie
Co to sa fonty CID?
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WSKAZOWKA: Liste
wszystkich znakow zawar-
tych w zestawie Adobe
Western 2 mozna pobrac

z witryny firmy Adobe:
www.adobe.com/type/
pdfs/AdobeWestern2.pdf.
Lista ta zawiera wartosci
Unicode dla wszystkich
znakOw zestawu oraz
kombinacje klawiszowe
umozliwiajace dostep

do tych znakow — jakkol-
wiek trzeba zauwazy¢,

Ze zestaw ten nie zawiera
znakéw srodkowoeuropej-
skich (na przyktad polskich),
a proponowane kombinacje
klawiszowe dziatajq tylko
w uktadzie klawiatury

US English.

RYSUNEK 6.17 Edytowanie
zestawu gliféw. Usuniecie
zaznaczenia z opcji Remember
Font with Glyph powoduje
wyswietlenie litery ,U" w le-
wym dolnym rogu pola glifu,
sygnalizujac, ze obecnie jest
on identyfikowany tylko przez
numer Unicode.

Tworzenie zestawu gliféw

Jesli musimy wielokrotnie uzy¢ tych samych niestandardowych gliféw, mozna
oszczedzi¢ sobie koniecznosci ich wyszukiwania za kazdym razem, tworzac
wlasny zestaw gliféw.

1. Otwieramy palete gliféw: Type > Glyphs.

2. W menu palety wybieramy polecenie New Glyph Set (Nowy zestaw glifow),
nadajemy mu nazwe i klikamy ok.

3. Po zlokalizowaniu i zaznaczeniu potrzebnego glifu klikamy go prawym
klawiszem myszy (takze Ctrl+klikniecie w Mac 0S) i z menu konteksto-
wego wybieramy polecenie Add to Glyph Set (Dodaj do zestawu gliféw).

Po utworzeniu zestawu gliféw mozna go modyfikowa¢ przy uzyciu polecenia
Edit Glyph Set (Edytuj zestaw gliféw) z menu palety. W razie potrzeby mozna
tu usungc opcje zapamigtywania fontu wraz z glifem (Remember Font with
Glyph), co pozwala lokalizowa¢ dany glif w réznych fontach. Trzeba jednak
pamigtac, ze jesli uzywany kréj nie zawiera danego znaku (na przyktad w kroju
Zapf Dingbats nie ma znaku wykrzyknika), glif z zestawu zostanie wybrany

wraz z oryginalnym fontem.

insert Order:| Unicode Order
1
Va |Va | %  Giyph Options |
AT 1 Unicode Value: 0131
s fp<[pe| @] | Crememberromwnahor |
» = Font Minion Pro 2
. Style Regular 4]
Qao / GID: 143 ]
Mame: LATIM SMALL LETTER DOTLESS |
[ ]
Unicode

Fonty OpenType opieraja sig na Unicode — miedzynarodowym i miedzyplatfor-
mowym standardzie kodowania, identyfikujacym znaki zawarte w fontach dla
(niemal) wszystkich jezykéw i mozliwych form znakéw. Przed wprowadzeniem
Unicode powszechnie uzywanym standardem byt Asci1 i jego modyfikacje,
obstugujace jednak do 256 znakéw jednoczesnie (w tym znaki kontrolne i ste-
rujace). Podstawowym problemem Ascii byt fakt istnienia réznych systeméw
kodowania — zaréwno jesli chodzi o alternatywne zestawy znakéw (na przy-
kiad srodkowoeuropejski), jak i rézne platformy systemowe (Windows kontra
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Wyszukiwanie i zastepowanie gliféw

Korzystanie ze znakow specjalnych w fontach nieunikodowych moze powo-
dowac szczegéine problemy. Poniewaz starsze fonty nie uzywaja standaryzo-
wanego kodowania dla znakéw specjalnych, po zmianie fontu na inny moze
okazac sie, ze czes¢ znakow ,znikta” lub zostata zamieniona na zupetnie inne
(i niewtasciwe).

Czeéciowym rozwigzaniem jest przejscie na fonty OpenType (oparte
na Unicode), ale nadal konieczne jest przepisanie znakéw specjalnych
na poprawne numery Unicode. P6zniej bedziemy mogli zmienia¢ kroje bez
dalszych problemadw.

Okno dialogowe Find/Change umozliwia wyszukanie dowolnego glifu
z dowolnego fontu i zastgpienie go innym z glifem z tego samego lub innego
fontu. Aby wybrac glif, ktéry chcemy wyszukaé, nalezy zaznaczy¢ go w palecie
gliféw, klikna¢ prawym klawiszem myszy i wybra¢ polecenie Load Selected Glyph
in Find (Zataduj wybrany glif do znalezienia).

Mac 0s — i nie tylko). Zgodnos¢ panowala jedynie w odniesieniu do pierwszych
128 kodéw, czyli wlasciwego AsciI z czaséw dalekopiséw. Druga potowa kodu
mogla zaleznie od wyboru platformy lub strony kodowej zawiera¢ zupetnie inne
znaki. Oznaczalo to, ze nawet przy tym samym zestawie znakéw (na przykiad
Western) te same znaki wymagaly innych sekwencji klawiszy w Windows,
ainnych w Mac 0s.

Z drugiej strony Unicode zapewnia miejsce dla ponad 65 tysiecy znakéw** —
i pomysle¢, ze powstal na chwale typograféw, ktérzy ,z dwudziestu szeéciu
olowianymi zolnierzykami” byli gotowi podbi¢ $wiat! W praktyce jednak zaden
font nie zbliza si¢ nawet do tej liczby znakéw. Fonty OpenType Pro zawieraja
rozszerzone zestawy znakéw, ktére obejmuja pelny zakres znakéw tacinskich,
w tym znaki akcentowane obstugujace jezyki srodkowo- i wschodnioeuropej-
skie, jak turecki czy polski, a takze znaki cyrylicy i alfabetu greckiego. Oprécz
ulatwiania pracy w wielu jezykach, fonty te zawieraja réwniez najrozmaitsze
»delikatesy” typograficzne, takie jak dodatkowe ligatury, prawdziwe kapitaliki,
utamki lub cyfry nautyczne (tekstowe) — wszystko to, co wczesniej wymagato
dokupienia ,Expert Set” dla danego fontu.

13 Nowe rozszerzenia Unicode pozwalaja zwigkszy¢ liczbe mozliwych znakéw prak-
tycznie bez ograniczeri — w razie potrzeby dtugos¢ kodu (numeru Unicode — obecnie
dwa bajty, w pierwszym rozszerzeniu cztery) moze by¢ zwiekszana dowolnie. Przy
numerze o diugosci czterech bajtéw liczba mozliwych do zakodowania znakéw
przekracza cztery miliardy, co juz daje wartosc¢ wieksza, niz taczna liczba znakéw
wystepujacych we wszystkich znanych systemach pisma.

With love

comes the day

e
Copy =

RYSUNEK 6.18 Wstawianie
wybranego znaku do okna
dialogowego Find
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W systemie Windows mozna uzyska¢ znaki ,spoza klawiatury”, uzywajac
sekwencji Alt+numer z klawiatury numerycznej (jakkolwiek nadal nie obejmuje
to wszystkich dostepnych znakéw). Podobna opcja istnieje w systemie Mac 0s,
jakkolwiek jest jeszcze bardziej nieprzejrzysta. Po wybraniu uktadu klawiatury
»Unicode Hex Input” w Language & Text System Preferences — opcja ta jest
blisko korica listy uktadéw klawiatur — mozna wpisa¢ kod Unicode przytrzy-
mujac klawisz Option. Jednak zastosowanie tego uktadu klawiatury powoduje,
ze wszystkie skroty klawiszowe wykorzystujace Option przestaja dziala¢, zatem
raczej nie jest to co$, czego chcieliby$émy uzywac na co dzien.

Wyszukiwanie znakéw w systemie Mac OS

Zaréwno systemowa paleta Character Map (Tablica znakéw) w Windows, jak
i Character Viewer w Mac OS wyswietlaja numery Unicode dla poszczegéinych
znakéw i umozliwiaja wyszukiwanie znakéw poprzez fragment nazwy albo numer.
Character Viewer dodatkowo pokazuje, ktére sposréd zainstalowanych fontéw
zawieraja wskazany znak. Jak fatwo dostrzec, narzedzie to ma przewage nad
paleta gliféw w InDesignie, gdyz umozliwia szybkie poréwnanie tego samego
znaku w réznych fontach.

W celu wyswietlenia Character Viewer nalezy przejéc do System Preferences >
Language & Text, wybra¢ Input Sources, po czym zaznaczy¢ opcje Keyboard &
Character Viewer, aby dodac ja do paska menu. Jesli na przyktad szukamy znaku
bis (nazwa Unicode double prime), mozemy wpisa¢ jego numer Unicode (ale
kto tak naprawde chciatby go pamietac?) albo jego nazwe w polu wyszuki-
wania. W rezultacie uzyskamy liste wszystkich zainstalowanych fontéw, ktére
zawieraja ten glif. Pozwala to poréwnac wyglad tego znaku w kilku fontach
jednoczesnie — co$, czego nie umozliwia panel gliféw w programie InDesign.
Znaleziony znak mozna skopiowac do schowka, a nastepnie wklei¢ go do tekstu
w dokumencie InDesigna.

RYSUNEK 6.19 Narzedzie
Character Viewer w systemie
Mac OS 10.6 (B), dostepne po-

przez preferencje systemowe

Language & Text (z wybranym

uktadem klawiatury Unicode |

Hex Input) (A). F e e o e




Budowanie utamkow

Fonty postscriptowe i TrueType zawieraja w swoich zestawach nastepujace znaki
utamkowe: %, % i %. Niektére kroje OpenType Pro moga zawieraé réwniez %, %,
%, %, % i %. Wazniejsze jest jednak to, ze fonty OpenType umozliwiaja budowe
wlasnych utamkéw. Po zaznaczeniu liczb, ktére chcemy przeksztalcié na utamki,
nalezy wybraé polecenie Fractions (Utamki) z menu OpenType w palecie ste-
rujacej. Nie nalezy wlaczac tej opcji jako stale zaznaczonej (na przyklad jako
czesci definicji stylu), gdyz spowodowaloby to ,utamkowanie” wszystkich cyfr
wystepujacych w tekscie, zatem nalezy opcje te stosowa¢ jedynie tam, gdzie
jest faktycznie potrzebna.

Jesli uzywamy fontu Type 1 lub TrueType, mozemy nadal stworzy¢ w miare
poprawne utamki, nie meczac sie nadmiernie. Istnieje wiele skryptéw two-
rzacych utamki, takich jak Proper Fraction autorstwa Dana Rodney'a, ktére
mozna znalezé w witrynie Adobe Exchange lub na réznych stronach poswieco-
nych programowi InDesign. Skrypty takie konwertuja licznik do frakeji gérnej
(indeksu gérnego), mianownik do frakeji dolnej i zastepuja ukoénik prawdziwa
kreska utamkowga (solidus). Aby uzyskaé w miare dobry wyglad, trzeba zmieni¢
w zaawansowanych preferencjach tekstu wielkos¢ indekséw gérnych i dolnych
(dobrym punktem wyjscia moze by¢ 60% stopnia pisma) oraz odpowiednio
dobra¢ pozycje indekséw, aby dolny mial przesuniecie o (zero), a gérny siegal
gornej linii pisma’*. Bez wzgledu jednak na to, jak utworzymy nasz utamek, jesli
nastepuje on po liczbie oznaczajacej calosci, nie trzeba go poprzedza¢ spacja.

10 5/16 x 8 3/16

Stan wyjsciowy

1046 X 836

Utamki reczne

10346 X 8346

Utamki OpenType

Licznik Kreska Discretionary Ligatures.

utamkowa Ordinal
[Swash]

[Titling Alternates]
[Contextual Alternates]
All Small Caps.

Slashed Zero

Stylistic Sets 3
Positianal Forms. 3
Superscript/Superior
Subscript/Inferior
Numerator

Denaminator

Tabular Lining
Proportional Didstyle
Proportional Lining
Tabular Oldstyle

+ Default Figure Style

Mianownik

14 Trzeba jednak zauwazy¢, ze ustawienia te sa globalne dla dokumentu — jesli w tekscie
wystepuja prawdziwe indeksy gérne lub dolne, zmiana ta wplynie réwniez na ich
wyglad. W takiej sytuacji lepszym rozwigzaniem jest stworzenie wtasnych gérnych
i dolnych frakeji na potrzeby utamkéw jako styléw znakowych. Warto tez zauwazyc,
ze tak tworzone utamki sa optycznie ,zbyt lekkie” w stosunku do wlasciwego tekstu.
Jesli dysponujemy odmiang nieco cigzsza od uzywanej (np. Semibold lub Medium
wobec Regular), uzycie jej w tym miejscu moze poprawic efekt.
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UWAGA: Przez krotki czas
funkcjonowato rozwiaza-
nie eliminujace niektére
ograniczenia fontéw

Type 1 — fonty multiple
master, ktére pozwalaty
uzytkownikom na tworze-
nie réznych wag i szerokosci
kroju z ograniczonej liczby
«wzorcowych” obryséw.
Fonty te nie przyjety

sie jednak w szerszym
zakresie, gtéwnie z powodu
wysokiej ceny i trudnosci
stosowania. Nazwy, takie
jak MyriadMM 215LT, nigdy

‘nie zagoscity w codzien-

nym uzyciu. Fonty multiple
master zostaty zarzucone
w roku 2001, ale nadal poja-
wiaja sie na listach fontéw
niektorych uzytkownikow.

RYSUNEK 6.20 A) Elementy
utamka. B) Budowanie utam-
kow: przed przetworzeniem

(u gory); utamki nie-OpenType,
tworzone recznie lub przy
uzyciu skryptu utamkowego
(posrodku); utamki OpenType
(u dotu). €) Opcje OpenType

w menu palety sterujace;j.
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8x10 8x10

RYSUNEK 6.21 Poprawny
znak mnozenia (po prawej)
w poréwnaniu z malg literag x
(po lewej).

€ € €

RYSUNEK 6.22 Euro Mono,
Euro Sans i Euro Serif z rodziny
krojow Adobe Euro.

UWAGA: InDesign CSs
dostarczany jest wraz z kil-
koma fontami OpenType,
w tym Adobe Garamond
Pro, Chaparral Pro, Adobe
Caslon Pro, Caflisch Pro,
Minion Pro i Myriad Pro.

Znak mnozenia

Symbol oznaczajacy mnozenie (uzywany tez niekiedy przy wymiarowaniu ele-
mentéw) to oddzielny znak, prostszy i bardziej symetryczny niz mata litera x.
Mozna go znalez¢ w foncie Symbol i w wielu fontach OpenType (szczegélnie
w wersjach Pro). Aby znalezé ten znak (i inne symbole matematyczne), mozna
w palecie gliféw ograniczy¢ wyswietlanie, wybierajac z listy rozwijanej opcje
Math Symbols.

Znak euro

Fonty wyprodukowane po roku 1998 powinny zawieraé znak euro (€) jako czes¢
standardowego zestawu. Znak ten mozna uzyska¢ kombinacjg Option+Shift+2
(Mac 0s) lub Alt+0128 z klawiatury numerycznej (Windows). Jeéli uzywamy
kroju starszego (a takze, jesli nie podoba nam si¢ postaé tego symbolu w uzy-
wanym foncie), mozna pobra¢ rodzine fontéw Euro z witryny firmy Adobe:
http://store.adobe.com/type/euroreg.html. Euro Sans to font o wadze teksto-
wej (regular), zawierajacy znak zgodny z oficjalna postacia znaku stosowana
w Europie. Euro Mono to skondensowana wersja Euro Sans, zaprojektowana
do wspélpracy z krojami statopozycyjnymi. Euro Serif jest przydatny przy
tekstach skladanych fontami szeryfowymi. Wszystkie te fonty dostepne
sa bezplatnie.

Ligatury, dyftongi, i bez kropki...
Ligatura to dwa (lub wigcej) nakladajace si¢ znaki, zespawane w pojedynczy
glif. Stosowane s3 zwykle w polaczeniach liter, ktére inaczej prowadza do koli-
zji — najbardziej znanym przykladem sa problemy powodowane przewieszka
litery f w potaczeniu z kropka nad i lub wydluzeniem gérnym litery I. InDesign
moze samoczynnie stosowac ligatury standardowe przy korzystaniu z fontéw
OpenType, Type 11ub TrueType. Mechanizm sprawdzania pisowni jest dostatecz-
nie inteligentny, aby rozpoznawac te znaki i nie oznacza¢ stéw je zawierajacych
jako blednie napisanych. Stosowanie ligatur moze by¢ niepotrzebne w krojach
bezszeryfowych, w ktérych mniejsze jest ryzyko kolizji znakéw. Jesli znaki
nachodza na siebie, lepiej wlaczy¢ opcje stosowania ligatur. Jesli jednak nie ma
kolizji, to nalezy stosowac si¢ do zasady ,jesli sig nie zepsulo, nie naprawiaj!”.
Ligatury moga bowiem powodowad, ze takie kombinacje liter wydaja sie nazbyt
ciasne w poréwnaniu do pozostalej czesci tekstu. Ligatury mozna wiaczaé
lokalnie za posrednictwem palety sterujacej lub jako czes¢ definicji stylu w sekcji
Basic Character Format (Podstawowe formatowanie znakéw).

Fonty OpenType (szczegdlnie odmiany Pro) udostepniaja wieksza liczbe stan-
dardowych ligatur, takich jak ffi, ffl, fj i ff, a ponadto moga zawiera¢ opcjonalne



film film film
flirt flirt  flirt
office office office

waffle waffle waffle
fjord Ijord fiord

Adobe Caslon Pro
Bez ligatur

Adobe Caslon Pro
Z ligaturami

Futura
Bez ligatur

ligatury ozdobne (discretionary) dla takich par liter, jak ct, sp lub st. Ozdobne
ligatury nie s3 przeznaczone do codziennego uzytku, jednak moga by¢ dosko-
nalym wyborem w szczegdlnych zastosowaniach. Gdy nastepny raz bedziemy

projektowac co$ tak efektownego, jak zaproszenie §lubne, ligatury ozdobne
moga by¢ tym szczegélnym wyréznikiem, ktérego bedziemy potrzebowad.
Dyftong{ to szczegdlna odmiana ligatur, wizualnie reprezentujaca wymowe
polaczonych samogtosek. Najbardziej znane przyktady to kombinacje ae, AE
oraz oe, O, ktére mozna znalez¢ w jezykach germanskich, a takze w takich
stowach angielskich (pochodzacychjednak z taciny), jak Caesar, mediaeval czy
francuskie|oeuvre. Uzycie dyftongpw w tekscie angielskim tworzy wrazenie

archaiczne;atemozebyéobowigzKowe w innych jezykach, jak niemiecki lub
jezyki skandynawskie.

Zaréwno ligatury ozdobne, jak i dyftongi mozna wstawiaé recznie za posred-
nictwem panelu gliféw. Aby ograniczy¢ widok do wymaganego zestawu znakéw,
mozemy wybra¢ opcje Discretionary Ligatures (Ligatury ozdobne).

Poniewaz ligatury moga wygladaé dziwacznie w wigkszych stopniach pisma,
lepszym rozwigzaniem moze by¢ poprawienie kerningu w celu uniknigcia kolizji
znakéw. W przypadku zestawienia fi rozwiazaniem moze by¢ réwniez zasta-
pienie ,zwyklej” litery i wariantem bez kropki (dotless i). W systemie Mac 0s
znak ten mozna wpisa¢ kombinacja Shift+Option+B. Skrét ten (a icislej jego
odpowiednik z Alt) nie dziata w systemie Windows. W tym wypadku najlepiej
uruchomié narzedzie Character Map (Tablica znakéw), wlaczy¢ widok zaawan-
sowany i w polu numeru wpisa¢ 0131 (identyfikator Unicode dla tego znaku).
Mozna réwniez wpisa¢ fragment nazwy, np. ,dotless” w polu wyszukiwania.
Jesli wybrany font zawiera ten znak, zostanie on zaznaczony. Po kliknieciu przy-

cisku Copy mozemy przejs¢ do InDesigna i tam uzy¢ normalnego mechanizmu
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RYSUNEK 6.23 Ligatury:
niezbedne w fontach szery-
fowych, ale zazwyczaj niepo-
trzebne lub wrecz szkodliwe
w fontach bezszeryfowych.

picture
castle

spring

RYSUNEK 6.24 Ligatury
ozdobne w foncie Minion Pro

oeuvre
vite

RYSUNEK 6.25 Dyftongi

fickle
fickle

RYSUNEK 6.26 W wiekszych
stopniach pisma uzycie znaku
dotless i (na gbrze) zamiast li-
gatury fi sprawia, ze latwiejsze
jest wyrdwnanie spacjowania
znakéw w catym tytule.
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RYSUNEK 6.27 Coming
Together — font OpenType za-
wierajacy 400 wersji znaku &,
utworzonych w ramach pro-
jektu Font Aid IV. Caly dochod
Z jego sprzedazy przezna-
czony jest na pomoc dla ofiar
trzesienia ziemi na Haiti.

e S

Little Dorrit
P s o

~Santa Fe -~
pegq

RYSUNEK 6.28 Przyozdo-
bienie tytutu ornamentami
z fontu Adobe Caslon Pro
(u gory) i Chaparral Pro

(u dotu).

wklejania (Ctrl+V), aby wstawi¢ ,,1” do naszego dokumentu. Obie metody s3 szyb-
sze, niz przegladanie calego fontu w palecie gliféw, ktéra nie oferuje zadnego
mechanizmu wyszukiwania.

Font Aid IV: Coming Together

Przyktadem znaku, ktory wyewoluowat z ligatury w samodzielny znak, jest etka
(ampersand), czyli &, bedaca stylizowanym skrétem taciriskiego et, oznaczajacego
i (oraz). Angielski termin ampersand jest z kolei skrétem frazy ,and per se and”.
Po katastrofalnym trzesieniu ziemi w styczniu 2010 roku na Haiti, grupa projektan-
téw pism z réznych stron $wiata wspdlnie zaprojektowata font Coming Together,
stanowiacy forme pomocy dla ofiar trzesienia. Kréj ten zawiera wylacznie naj-
rozmaitsze formy znaku &, symbolizujac idee ludzi lgczacych si¢ we wspoinym
dziataniu na rzecz innych. Kréj ten mozna zakupic w cenie 20 dolaréw w witrynie
www.ascenderfonts.com.

W& EE
&Méet &G

Ornamenty

Nazywane tez z francuska fleurons (kwiatony), ornamenty typograficzne

od dawna byly stosowane w celu rozszerzenia palety srodkéw. Uzyte wspét-
cze$nie, moga nadac publikacji styl historyczny lub archaizujacy, szczegélnie
na oktadkach lub stronach tytulowych. Mozna je powieli¢ wielokrotnie, aby
stworzy¢ forme typograficznej tapety, pasujacej na wyklejke ksigzki. Niektore
moga si¢ tez przydac jako rodzaj ozdobnych punktoréw lub znakéw konco-
wych. Czgé¢ z nich zostata zaprojektowana tak, aby mozna ich byto uzywa¢
tacznie, budujac ozdobne ramki — jakkolwiek znacznie tatwiej bedzie osiag-
nac taki sam efekt w programie ilustracyjnym, takim jak Adobe Illustrator.
Niektore kroje pism OpenType, takie jak Chaparral Pro, zawieraja znaczny
wybér ornamentéw.
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Znaki kaligraficzne

Oszczednie stosowane, znaki kaligraficzne moga doda¢ wiele uroku naszemu
tekstowi. Najczesciej stosowane sa na poczatku stéw lub zdan. Niektére fonty
OpenType w kursywach zawieraja takie znaki — mozna to sprawdzi¢ otwierajac
palete gliféw i sprawdzajac opcje Swash (Znaki kaligraficzne) nalicie rozwijanej
Show. Bardziej zaawansowane fonty moga tez zawiera¢ odmiany stylistyczne,
przeznaczone do stosowania na koricu wyrazu lub wiersza. Wielkie glify (A, B,
Citd.) umieszczone na stronach otwierajacych poszczegélnych rozdzialéw tej
ksiazki to warianty kaligraficzne.

Ahoy There, From qp"ﬁ“ to the
Shipmates!  Nodolk Broads

cAhoy There, “From gp"”
J/szmates’ Nmfomq%u.dﬁ

Bez znakow
kaligraficznych

Kaligraficzne
wielkie litery

Cyfry nautyczne (tekstowe)

W wigkszosci krojéw pisma domyslna postaé cyfr to wersalikowe cyfry tabela-
ryczne, ktére zostaly wymyslone okoto 200 lat temu. Cyfry takie maja ustalong
szeroko$¢, dzigki czemu mozna je wyréwnywac w pionie, tworzac kolumny
liczb, a takze jednolita wysokosé, réwna wysokosci wielkich liter. Powoduje
to, Ze wyrdzniaja si¢ nadmiernie, jesli s3 uzyte wewnatrz bloku tekstu zawie-
rajacego zaréwno male, jak i wielkie litery.

12345
09876

1234567890
1234567890

1234567890

'31234567:8913

to tpw)

In French with English
subtitles 107 minutes.
2:35, 4:45, 6:00, 9:10.
C

In French with English
subtitles 107 minutes.
2:35, 4:45, 6:00, 9:10.

1234567890

RYSUNEK 6.29 Znaki kaligra-
ficzne w fontach Adobe Caslon
Pro Italic (po lewej) i Raniscript
(po prawej).

Z odmianami stylistycznymi
dla poczatkowych i korico-
wych znakow

RYSUNEK 6.30 Roine wersje
cyfr. Tabelaryczne (o statej
szerokosci) cyfry wersalikowe
majg ustalong szerokos¢ i wy-
sokosc¢ (A). Cyfry nautyczne
maja wydtuzenia gorne i dolne
(B). Zestawienie wyréwnania
cyfr dla odmiany o statej sze-
rokosci i proporcjonalnej (C).
Cztery rézne wersje dostepne
w krojach OpenType Pro (D).

Tabular Lining

Proportional Lining

Proportional Oldstyle

Tabular Oldstyle



RYSUNEK 6.31 Wiele krojow
OpenType Pro zawiera po-
kazny wybdr alternatywnych
form znakéw, ktére moina
zaaplikowac za posredni-
ctwem palety gliféw albo
automatycznie, przy uzyciu
opcji Contextual Alternates.
U gory — Bickham Script Pro
bez odmian i po zastosowa-
niu odmian kontekstowych,
u dotu — Adobe Jensen Pro
przed i po zastosowaniu wa-
riantow kaligraficznych.

Proporcjonalne cyfry nautyczne (Oldstyle) maja wymiar oparty na wysokosci
matych liter (x-height) i s3 spacjowane proporcjonalnie do ksztattu. Dzieki
temu zapewniaja bardziej jednolita szaros¢ bloku tekstu i nie wyrézniaja sie
tak w wierszu, jak cyfry wersalikowe pelnej wysokosci. Cyfry 3, 4, 5,71 9 maja
wydluzenia dolne, podczas gdy 6 i 8 — wydtuzenia goérne.

Fonty OpenType czesto udostepniaja réwniez proporcjonalne cyfry wersali-
kowe (przydatne w tekscie sktadanym samymi wersalikami) oraz tabelaryczne
cyfry nautyczne (o stalej szerokosci) — identyczne jak zwykle cyfry nautyczne,
ale bez dobierania szerokosci do ksztattu znaku, przez co bardziej nadaja sie
do zastosowania w tabelach i kolumnach liczb.

Odmiany kontekstowe

Niektére kroje pisankowe w formacie OpenType zawieraja alternatywne znaki,
pozwalajace na lepsze taczenie w okreslonych kombinacjach par liter, dzieki
czemu zlozony tekst bardziej przypomina reczne pismo. W celu uzycia tych
opcjonalnych znakéw nalezy uzy¢ polecenia Contextual Alternates (Warianty
kontekstowe) w menu OpenType — podczas pisania glify nalewo od kursora beda
zmieniac sie w zaleznoéci od tego, jaki znak pojawit si¢ po ich prawej stronie.
Mozna tez recznie wybiera¢ warianty kontekstowe z palety gliféw, uzywajac
polecenia Alternates for Selection (Warianty dla zaznaczenia) z menu Show.

rite

docwr recatreds

AR,
arnd cecre
fovs fovcwrd '

Quiver Quiver
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Warianty nagtowkowe

Niektére fonty OpenType udostepniaja specjalne ,tytutowe” znaki, przezna-
czone do stosowania w tekstach sktadanych stopniem 72 punkty lub wigkszym.
Znaki takie odrézniaja sie od podstawowej formy zwykle drobnymi niuansami.
Cienkie czedci kresek sa zwykle nieco cierisze, szeryfy sa staranniej dopracowane,
za$ same znaki sa nieco zwezone, nadajac pismu bardziej elegancki wyglad.

Wielkosci optyczne

Niektére fonty OpenType s przygotowywane w czterech'® odmianach optycz-
nych, zaleznych od zamierzonego zastosowania: do podpiséw (caption), tekstu
gléwnego (text — to tu znajdziemy dobrze znane warianty, jak Regular, Italic lub
Bold), podtytuléw (subhead) i nagtéwkéw (display). Zaleznie od przeznaczenia
mozemy wiec wybra¢ odmiane, ktéra lepiej pasuje do stosowanego stopnia
pisma. Nazwa odmiany optycznej (na przyklad caption) sugeruje wtasciwe
zastosowanie. Podobnie jak w przypadku wariantéw nagtéwkowych, im wigkszy
planowany rozmiar, tym bardziej dopracowane s detale znakéw.

Niektére fonty OpenType sa przygotowywane

w czterech odmianach optycznych, zaleznych -

od zamierzonego zastosowania. Caption (7 pt) R?SUNE,K Sa% Rozne‘
wielkoéci optyczne kroju

Niektére fonty OpenType Caption T Warnock Pro.
$3 przygotowywane w czterech Regular (10 pt)

Niektore fonty OpenType subhead 04pt A g A

Niektér e fonty Display (24 pt) Regular Display

15 Istniejg nawet rodziny OpenType przygotowane w pigciu odmianach, np. Arno Pro,
ktéry oprécz wymienionych zawiera jeszcze wariant Smtext (drobny tekst), albo
Brioso Pro, oferujacy dodatkowo wariant Poster (plakat).






114

InDesign i tekst  Profesjonalna typografia w Adobe InDesign

Wyréwnanie w poziomie

W codziennym uzyciu mozemy spotkac kilka réznych terminéw opisujacych
poziome wyréwnanie tekstu. To, co w InDesignie nazywa sie Left (Do lewej),
bywa okreslane mianem chorggiewki wyréwnanej do lewej (ragged right — doslow-
nie ,poszarpany z prawej”) albo (co bywa mylace) sktadem justowanym do lewej
(left justified). W terminach programu InDesign opcja Left Justify (Justowanie,
ostatni do lewej) oznacza, ze wszystkie wiersze akapitu z wyjatkiem ostat-
niego maja te sama dlugosé. InDesign udostepnia trzy dodatkowe opcje sktadu
justowanego, cho¢ ich zastosowanie jest raczej ograniczone do szczegélnych
przypadkéw: Center Justify (Justowanie, ostatni do $§rodka), Right Justify
(Justowanie, ostatni do prawej) oraz Full Justify (Pelne justowanie). Réznia
sie one tylko tym, jak traktowany jest ostatni wiersz akapitu. W dalszym ciagu
tego rozdzialu, gdy uzyje terminu sktad wyjustowany, bede mial na mysli akapit,
w ktérym ostatni wiersz wyréwnany jest do lewej.

Sklad chorggiewkowy moze dotyczy¢ tekstu dosunietego do lewej, do prawej
lub wycentrowanego. Mamy do dyspozycji réwniez opcje wyréwnania wzgle-
dem grzbietu. Towards Spine (Do grzbietu) powoduje, ze tekst na stronach
lewych wyréwnywany jest w prawo, a na stronach prawych — wlewo. Jak latwo
sie domysleé, druga z tych opcji, Away From Spine (Od grzbietu) tworzy efekt
odwrotny — na lewych stronach tekst jest wyréwnany do lewej, a na prawych
do prawe;j.

Skroty klawiszowe sterujace wyréwnaniem

Do lewej Cmd/Ctri+Shift+L
Do srodka Cmd/Ctrl+Shift+C
Do prawej Cmd/Ctrl+Shift+R
Wyjustowany Cmd/Ctrl+Shift+)

Justowanie wszystkich wierszy  Cmd/Ctrl+Shift+F

Poniewaz dlugo$¢ kazdego wiersza jest inna, istotng réznica pomiedzy czterema
podstawowymi sposobami wyréwnywania jest to, co dzieje sie z nadmiaro-
wym, wolnym miejscem w konkretnym miejscu. W sktadzie choragiewkowym
wielkoé¢ odstepé6w miedzywyrazowych jest stala. Wszystkie spacje w calym
akapicie maja te samga szerokosé. Nadmiarowa przestrzen jest umieszczana
na prawym koricu poszczegélnych wierszy (przy ukladzie do lewej) albo naich
poczatku po lewej (przy wyréwnaniu do prawej). W skladzie wycentrowanym
owa dodatkowa przestrzen dzielona jest réwno pomiedzy lewy i prawy brzeg
wiersza. W skladzie wyjustowanym szerokosci spacji s3 modyfikowane, aby
uzyskac jednakowa dlugos¢é wszystkich wierszy (oprécz ostatniego). Jednak dla
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uzyskania jednolitej szarosci bloku tekstu przy justowaniu wierszy staramy sie

utrzymac iluzje, ze wszystkie spacje w tym akapicie maja te sama szerokosé.

Wyrdéwnanie do lewej

W skladzie wyréwnanym do lewej wszystkie wiersze zaczynaja sig na tej samej
pozycji. Szerokosci spacji sa jednolite, co gwarantuje réwnomierna szaroé¢
bloku tekstu. Wiersze maja zmienne dlugosci, co sprawia, ze blok tekstu ma
,poszarpany” prawy brzeg i trudno go uzna¢ za prostokat. Asymetria tekstu
zlozonego w choragiewke moze robi¢ wrazenie ,nieformalne”, gdyz wywotuje
skojarzenia z nieréwnymi wierszami recznego pisma.

Jesli zdecydujemy sie na zastosowanie sktadu do lewej, nalezy zwrécié uwage
na ksztalt chorggiewki — prawej nieré6wnej krawedzi. Ksztalt ten wynika z szeroko-
$ci tamu, charakteru tekstu (tego, czy zawiera on raczej dlugie, czy krétkie stowa)
oraz tego, czy stosujemy dzielenie wyrazéw. W idealnym wariancie choragiewka
jest tylko nieznacznie modulowana, bez gwattownych ,dziur” lub niezrecz-
nych ksztattéw. Dlugosé wierszy powinna byé zauwazalnie nieregularna — blok
nie moze wygladac jak niestarannie zlozony tekst justowany. Nieregularnosci
te nie moga by¢ jednak réwniez zbyt wielkie, gdyz tworzy to odwracajace uwage
ksztalty, utrudniajace czytanie. Przykladem ,zlej” choragiewki moze by¢ uktad,
w ktérym kilka kolejnych wierszy jest dtugich (niemal réwnych), po czym naste-
puje kilka znacznie krétszych, co tworzy falszywe wrazenie ,oddzielenia” jedne;j
czeéci tekstu od drugiej. Réwnie ztym przypadkiem jest naprzemienny uktad
bardzo dtugich ibardzo krétkich wierszy, rozbijajacy tekst na oderwane od siebie
fragmenty. Aby wyeliminowac takie przypadki, mozna recznie nadaé tekstowi
ksztalt, stosujac wymuszone ztamania wiersza lub warunkowe dzielenie stéw.
Konieczne tez moze by¢ zablokowanie podzialu pomiedzy wiersze okreslonych
fraz, takich jak nazwy produktéw, nazwiska lub adresy Web. Wiecej informaciji
na ten temat zawiera rozdzial 9, ,Dzielenie (i niedzielenie) stéw, wierszy, akapi-
tow i stron”. W razie potrzeby mozna tez zastosowa¢ niewielka korekte $wiatet,
aby spowodowac zmiane ksztaltu choragiewki.

Opcja formatowania akapitu o nazwie Balance Ragged Lines (Balans nieréw-
nych wierszy) powoduje, ze program stara si¢ nadaé poszczegélnym wierszom
mozliwie jednolita dlugoéé¢. Jest to przydatne przy sktadaniu nagtéwkéw
i srédtytutéw, redukujac liczbe niezbednych recznych interwencji (w formie
wymuszonych zlaman wiersza lub wstawiania niedzielacych spacji), ale nadal
trzeba bedzie sprawdzic¢ uklad tekstu pod katem jego znaczenia. Funkcja ta nie
zawsze podzieli tekst tam, gdzie bysmy chcieli. To na projektancie spoczywa
odpowiedzialnoéc za to, ze wiersze zostana podzielone w miejscach podkre-
$lajacych, a nie zaklécajacych przekazywana mysl.
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Wyréwnanie do lewej i justowanie

Przy wyréwnywaniu tekstu przeznaczonego do cigglego czytania musimy przede
wszystkim rozwazy¢ wady i zalety zaréwno sktadu wyréwnanego do lewej, jak
i wyjustowanego. Nie istnieje zadna ,$wieta requta”, ktéra bytaby rozstrzyga-
jaca — podstawowym kryterium pozostajg osobiste upodobania. Bez wzgledu
na to jednak, kt6ry wariant wybierzemy, kazdy wymaga podjecia okreﬁlonych

RYSUNEK 7.1 Cztery podsta-
wowe typy wyrdwnania w po-

dziatan i przygotowar, aby osiggnac dobry rezultat.

ziomie: do lewej, wyjustowany,
wycentrowany i do prawe;j.

Congress shall make no law respecting an establishment
of religion, or prohibiting the free exercise thereof; or
abridging the freedom of speech, or of the press; or

the right of the people peaceably to assemble, and to
petition the Government for a redress of grievances.

Do lewej

Congress shall make no law respecting an establishment
of religion, or prohibiting the free exercise thereof; or
abridging the freedom of speech, or of the press; or
the right of the people peaceably to assemble, and to
petition the Government for a redress of grievances.

Congress shall make no law respecting an establishment
of religion, or prohibiting the free exercise thereof; or
abridging the freedom of speech, or of the press; or the
right of the people peaceably to assemble, and to petition
the Government for a redress of grievances.

Wyjustowany, ostatni do lewej

Congress shall make no law respecting an establishment
of religion, or prohibiting the free exercise thereof; or
abridging the freedom of speech, or of the press; or

the right of the people peaceably to assemble, and to
petition the Government for a redress of grievances.

Wycentrowany

RYSUNEK 7.2 Dzielenie
wyrazéw ma wplyw na uklad
choragiewki w tekscie wy-
rownanym do lewej. Ciemne
prostokaty pokazuja wolng
przestrzeri na koricu poszcze-
gblnych wierszy. Akapit

po prawej ma wlaczone dzie-
lenie wyrazdw, co powoduje
mniejsze ,zaktdcenia” diu-
gosci wierszy, niz w akapicie
po lewej.

Do prawej

Scrooge was better than his word. He did itll
all, and infinitely more; and to Tiny Tim, il
who did not die, he was a second father. N
He became as good a friend, as good a N
master, and as good a man, as the good old @
city knew, or any other good old city, town, Bl
or borough, in the good old world. Some Bl
people laughed to see the alteration in him, B
but he let them laugh, and little heeded Hl
them; for he was wise enough to know thatill
nothing ever happened on this globe, for Bl
good, at which some people did not have Il
their fill of laughter in the outset; and .
knowing that such as these would be blind Bl
anyway, he thought it quite as well that theyll
should wrinkle up their eyes in grins, as havel
the malady in less attractive forms. His ownl
heart laughed: and that was quite enough Bl
for him.

Scrooge was better than his word. He did il
it all, and infinitely more; and to Tiny Tim
who did not die, he was a second father. I
He became as good a friend, as good a mas-lI
ter, and as good a man, as the good old cityl
knew, or any other good old city, town, or/iil
borough, in the good old world. Some peo-ll
ple laughed to see the alteration in him, butl
he let them laugh, and little heeded them; il
for he was wise enough to know that noth- il
ing ever happened on this globe, for good, il
at which some people did not have their Bl
fill of laughter in the outset; and knowing il
that such as these would be blind anyway, Bl
he thought it quite as well that they shouldlll
wrinkle up their eyes in grins, as have the Bill
malady in less attractive forms. His own il
heart laughed: and that was quite enoughiill
for him.
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Everyhody’s Got Something to Hide Except
for Me and My Monkey Bez balansu

Everyhody's Got Something to Hide 5.2~
Except for Me and My Monkey

Zastosowana do tekstu gléwnego, opcja Balance Ragged Lines moze stworzy¢é  RYSUNEK 7.3 Wiaczenie
opcji Balance Ragged Lines dla
tytutdw i nagtowkow zapew-
akapitu, reczne doprowadzenie do podzielenia wierszy w pozadanych miej- nia, ze wiersze maja w przybli-
zeniu wyrdwnane diugosci.

wiecej probleméw, niz je rozwigzac. Gdy wlaczymy ja dla wielowierszowego

scach okaze si¢ bardzo trudne lub wrecz niemozliwe. Opcja ta nie ma zadnego
wplywu na tekst wyjustowany.

Typografia asymetryczna

Asymetria w typografii powigzana jest z konkretna filozofia projektowania, Nowg

typografig, powstalg w Niemczech na przetomie lat dwudziestych i trzydzie-
stych XX wieku, ktérej oredownikami byli Jan Tschichold i Bauhaus. W swojej

ksigzce Die Neue Typographie Tschichold twierdzit, ze praktyka ,starej typografii”
wyréwnywania tekstu wzgledem centralnej osi jest nieelastyczna, nieorganiczna

i nieodpowiednia dla potrzeb nowoczesnej typografii, ,gdyz ogromna liczba

drukowanych sygnatéw zada naszej uwagi, co wymusza najwyzsza skutecznosé

ekspresji”. Po Il wojnie Swiatowej Tschichold znalazt sie w Anglii, gdzie pracowat

dla Penguin Books, stosujgc sie do klasycznych zasad symetrii, ktore wczesniej

krytykowat. Jesli wynika z tego jaki$§ morat, to moim zdaniem brzmi on tak: zaden

spos6b wyréwnania nie jest zty ani dobry, o ile wybierzemy taki, ktéry najlepiej

pasuje do potrzeb danego tekstu.

Sklad wyjustowany (z ostatnim wierszem
wyrownanym do lewej)

Jesli zaczniemy ukladacélitere po literze, jak dawny zecer uzywajacy metalowych
czcionek, okaze sig, ze w kazdym wierszu zostanie nam troche niewykorzysta-
nej przestrzeni na konicu, w ktérej nie mozemy juz zmiesci¢ zadnego stowa ani
sylaby. W skladzie justowanym, gdy prawe korice wierszy musza byé wyréwnane
w pionie tak samo, jak lewe, ta niewykorzystana przestrzen musi zosta¢ ela-
stycznie rozdzielona pomiedzy spacje miedzy stowami i (potencjalnie) pomiedzy
same litery wewnatrz stéw, aby nada¢ wszystkim wierszom te sama dlugosé.
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Hitler knows that he will have to break us in this
Island or lose the war. If we can stand up to him,
all Europe may be free and the life of the world
may move forward into broad, sunlit uplands. But
if we fail, then the whole world, including the
United States, including all that we have known and
cared for, will sink into the abyss of a new Dark Age
made more sinister, and perhaps more protracted,
by the lights of perverted science.

Let us therefore brace ourselves to our duties,
and so bear ourselves that if the British Empire and
its Commonwealth last for a thousand years, men
will still say, “This was their finest hour’

Winston Churchill —June 18, 1940

Hitler knows that he will have to break us in this
Island or lose the war. If we can stand up to him, all
Europe may be free and the life of the world may
move forward into broad, sunlit uplands. But if we
fail, then the whole world, including the United States,
including all that we have known and cared for, will
sink into the abyss of a new Dark Age made more
sinister, and perhaps more protracted, by the lights
of perverted science.

Let us therefore brace ourselves to our duties, and
so bear ourselves that if the British Empire and its
Commonwealth last for a thousand years, men will
still say, “This was their finest hour’

Winston Churchill —June 18, 1940

RYSUNEK 7.4 Ten sam tekst
ztozony jako wyréwnany do le-
wej (po lewej) i wyjustowany
(po prawej).

TR T ¥
| OpenType >
I«Uginms

Underline Options....
Strikethrough Options....
No Break
+ Adobe Paragraph Composer
Adobe Single-line Composer
+ Only Align First Line ta Crid
+ Balance Ragged Lines
Ignore Optical Margin

Keep Options.... TRK ;
Hyphenation... §
Drop Caps and Nested Styles... MR |

i i

RYSUNEK 7.5 Opcje justo-
wania stosowane jako cze$c
definicji stylu akapitowego

(u gory) i lokalnie za posredni-
ctwern menu palety sterujacej
(u dotu).

Sklad wyjustowany jest symetryczny. Gtadka krawedz po prawej stronie tamu
tworzy wrazenie réwnowagi. Jednolitoéé prawego marginesu nadaje stronie
wyglad formalistyczny. Sktad wyjustowany jest réwniez bardziej wydajny niz
choragiewkowy, pozwalajac zmiesci¢ wiecej tekstu w takim samym bloku tekstu.
Réznica moze byé niezauwazalna w krétkich dokumentach, ale w czasopi$mie
lub ksigzce moze oznaczaé oszczedno$é kilku stron. Az nazbyt czesto jednak
sktad wyjustowany jest stosowany w zbyt waskich tamach, dajac w rezultacie
co$, co Robert Bringhurst tak opisal w Elementarzu stylu w typografii: ,«biata
wysypka> zbyt duzych przestrzeni miedzywyrazowych albo «$wiriska szcze-
cina» — epidemia dywizéw na krawedzi tamu”. Jeéli jednak kazdy wiersz zawiera
dostatecznie wiele znakéw (typowo od 50 do 80) i uzyjemy wlasciwych ustawien
justowania i dzielenia wyrazéw, nie ma powodu, dla ktérego nie moglibysmy
uzyskac jednolitej szarosci kolumny dla justowanego tekstu.

Jak InDesign justuje tekst

Ustawienia justowania, okreslajace sposéb ukladania tekstu przez program,
najlepiej definiowa¢ na poziomie stylu akapitowego, ale mozna réwniez nada-
wac je recznie poszczegdlnym akapitom, korzystajac z polecenia Justification
(Justowanie) w menu palety sterujacej.

Justowanie realizowane jest poprzez modyfikacje wielkosci spacji pomiedzy
wyrazamiw wierszu — lub calym akapicie — dazac do mozliwie jednolitego roz-
mieszczenia stéw i liter w stowach, a przynajmniej do tego, by odstepy miedzy
wyrazami i literami robily wrazenie réwnych. Istnieja trzy wazne opcje, ktére
maja wplyw na justowanie tekstu przez InDesigna: Word Spacing (Odstepy
miedzy wyrazami), Letter spacing (Odstepy miedzy literami) i Glyph Scaling



The world will little note, nor long
remember what we say here, but it can never
forget what they did here. It is for us the
living, rather, to be dedicated here to the
unfinished work which they who fought
here have thus far so nobly advanced.

Rozdziat 7 Wyrownanie L'IW

'The world will little note, nor long remember
what we say here, but it can never forget what
they did here. It is for us the living, rather,
to be dedicated here to the unfinished work
which they who fought here have thus far
so nobly advanced.

Justification RYSUNEK 7.6 llustracja ukazuje moje preferowane ustawienia dla

: justowanego tekstu. Dopuszczenie nieznacznych (+ 29) modyfikacji
odstepow miedzyliterowych i réwnie niewielkiego (+ 3%) skalowa-
nia znakéw zdecydowania poprawia szaros¢ tekstu. Akapit po lewej
zostat ztozony przy uzyciu domysinych ustawier; po prawej ten sam
tekst po zastosowaniu moich niestandardowych ustawiern. Warto
zwrocic uwage na zroéznicowanie wielkosci spacji, pokazanych jako
ciemne prostokaty ponizej przyktadow tekstu.

Minimum Desired Maximum
Word Spacing: 85% 100% 115%

Letter Spacing: -2% 0% 2%
Clyph Scaling: 97% 100% 103%

(Skalowanie glifé6w). Zmienianie tych opcji moze spowodowaé radykalng zmiane
wygladu naszego tekstu.

Jesli wyréwnania dlugoéci wierszy nie da sie osiaggnaé samym tylko zmie-
nianiem dlugosci spacji, InDesign koryguje odstepy miedzyliterowe, zgodnie
z warto$ciami zawartymi w polach Minimum, Desired (Optymalnie) i Maximum.
Dopiero gdy i ten srodek okaze sie niewystarczajacy, program zaczyna defor-
mowac¢ znaki zgodnie z ustawieniami Glyp Settings.

Im wigcej stéw zawiera wiersz, tym wieksza liczba spacji podlega dopasowaniu, =~ WSKAZOWKA: Nawet jesli
tekst gtéwny jest wyju-
stowany, inne elementy
powinny pozostac nie
wyréwnane zaréowno

w celu unikniecia prob-
lemdw kompozycyjnych,
jak i zapewnienia wtasci-
wego kontrastu wzgledem
symetrycznego tekstu
gtéwnego. Nie powinno sie
justowac takich elementéw,
jak nagtowki i podtytuty,
nazwisko autora, spisy
tresci, podpisy ilustracji,
wyciagniete cytaty, indeksy
lub spisy bibliograficzne.

a tym samym mniej widoczne beda te zmiany. Zwiekszenie liczby stéw w wierszu
mozna osiagnac albo uzywajac mniejszej czcionki, albo poszerzajac tam. Trzeba
jednak pamietaé o zachowaniu réwnowagi: jesli szerokoéé tamu stanie sie zbyt

duza w stosunku do uzywanego stopnia pisma, jedno zlo zastgpimy innym.

Odstepy miedzy wyrazami
Nie przewiduje zadnej nagrody za domyslenie sie, ze chodzi o wielko$¢ zwyklej
spacji — tej, ktéra uzyskujemy naciskajac najwiekszy klawisz na klawiaturze.
Ustalenie wlasciwej wielkosci odstepéw miedzywyrazowych jest kwestiag
bardziej estetyczna, niz naukowa. Zazwyczaj dobrym punktem wyjscia jest
warto$c¢ 100 procent, co odpowiada wielkosci spacji zdefiniowanej przez pro-
jektanta fontu. W niektérych przypadkach mozna jednak zechcie¢ zmniejszyé
te wartos¢ do 90% lub nawet mniej, jesli korzystamy z krojéw takich, jak:

® (Czcionka zwezona
® Kroje w lekkich odmianach
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UWAGA: Zaréwno przy
dobieraniu ustawieri odste-
péw miedzywyrazowych,
jak i miedzyliterowych
trzeba znalez¢ ztoty $rodek
pomiedzy rozsadkiem

a regutami. Nie ma sensu
ustalanie Scistych i restryk-
cyjnych ustawien, jesli
typowa dtugosc¢ wiersza
(czyli stosunek szerokosci
tamu do stopnia pisma)
spowoduje, ze niemozliwe
bedzie przestrzeganie tych
ustawien przez program.

UWAGA: Trzeba pamietac,
Ze ustawienia justowa-

nia i dzielenia wyrazéw

w InDesign wspotpracuja
ze soba. Dobrego spacjowa-
nia stéw nie da sie osiagnac
tylko dziataniem Adobe
Paragraph Composer, jesli
nie zostanie on wsparty
innymi funkcjami wyréw-
nywania dostepnymi wsrod
narzedzi InDesign.

InDesign i tekst  Profesjonalna typografia w Adobe InDesign

® Kroje, ktére maja écisty uklad (jesli wiatta miedzyliterowe sa niewielkie,
bedziemy chcieli, aby same stlowa réwniez byly ulozone dos¢ ciasno)

® Tytulariaiinne teksty sktadane duzym stopniem pisma

Odstepy miedzy znakami

Parametr ten okreéla dystans pomiedzy literami i zawiera dowolne zmiany
zwigzane z kerningiem lub modyfikacja $wiatel. Szerokos¢ znaku jest deter-
minowana nie tylko przez sam znak (wielkos¢ oczka), ale réwniez obszarem,
ktéry projektant kroju dodal wokoét niego, zwanym odsadkg (side bearing).

Poniewaz w wierszu jest zawsze wiecej $wiatel miedzyliterowych, niz spacji
pomiedzy wyrazami, zmiana odstepéw miedzyliterowych o niedostrzegalna
wartoéé — plus lub minus 2 procent — moze radykalnie poprawi¢ jednostajnosé
wyjustowanego tekstu.

Skalowanie glifow

Skalowanie (zwezanie lub poszerzanie) gliféw polega na dopasowywaniu szero-
koséci znakéw w celu osiggniecia mozliwie dobrego wyjustowania — i nieznaczne

skalowanie w rozsadnych granicach jest odpowiednie. Nawiazujac do wezeéniej-
szych rozwazan, skalowanie gliféw moze brzmie¢ jak zbrodnia $cigana z urzedu.
W rzeczywistoéci jednak niewielka ingerencja w ksztalt znakéw moze — w pola-
czeniu z innymi ustawieniami justowania — znaczgco poprawic szaro$¢ tekstu.
Kluczem jest umiarkowanie: ustawienie to powinno mieécié sie w zakresie

od 97% (minimalne) do 103% (maksymalne). Nikt nie bedzie w stanie zauwa-
zy¢ tak nieznacznej ingerencji w szerokos¢ znakéw, ale za to latwo dostrzeze

jednolite odstepy miedzy stfowami.

Tekst wyjustowany i jego szarosc

Wszystkie typy wyréwnywania oddziatujg na szaros¢ (barwe) tekstu, ale najsil-
niejszy wplyw ma justowanie. Ustawienia justowania okreélajg zgodnos¢ spa-
cjowania stéw i liter, okreslajac granice, w ktorych InDesign moze rozciggac lub
zwezac spacje i $wiatta miedzy znakami. Jesli granice te zostang okreslone zbyt
wasko, tekst bedzie wydawat sig Scisniety. Gdy ustalimy je zbyt luzno, blok tekstu
stanie sie zbiorem plam, petnym ,dziur” tworzonych przez zbyt szerokie spacje,
albo tez stowa utraca sp6jno$c z powodu zbyt duzych przerw miedzy literami.
Ciasne wiersze wydaja cie ciemniejsze, luzne za$ jasniejsze. Zadne nie s fadne
i obydwa s3 trudne w czytaniu. Ideatem jest sytuacja, gdy tekst ma umiarkowang,
jednolita szaro$¢, ktéra sama z siebie nie zwraca uwagi czytelnika.
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RYSUNEK 7.7 Opcja Preference > Composition > H&J Violation

and-silver, which-at first-were-alone-supposed-to
be -photographic, we are - now-aware:that-copper,

the elements, are-equally liably to-changeunder "o~
the sun’s-influence. This fact-may-be-of-benefit e
| L Custom Tracking Keming

photographic-impressions, the more-laborious

Adobe Paragraph Composer

Funkcja programu InDesign, ktéra odpowiada za to, jak beda dopasowywane
i dzielone wiersze tekstu, jest Adobe Paragraph Composer (Ukladacz akapitowy
w polskiej wersji programu) — mechanizm malo widoczny, ale niezwykle istotny.
Przed pojawieniem sie pierwszej wersji InDesigna programy do skiadu publika-
cji uktadaty tekst wiersz po wierszu. Ze wzgledu na ograniczona liczbe spacji,
pomiedzy ktére mozna bylo rozdziela¢ nadmiarowa przestrzen pojawiajaca
sie na konicu wiersza, czesto tworzylo to niejednolita szaros¢ tekstu — jedne
wiersze byly zauwazalnie luzniejsze lub ciaéniejsze od innych, nierzadko bezpo-
érednio sasiadujacych. Przy uzyciu Adobe Paragraph Composer (co jest wyborem
domyslnym) InDesign analizuje wielko$¢ odstepéw w calym akapicie, sprawdza
potencjalne miejsca podzialu wierszy i optymalizuje réwniez wczesniejsze wier-
sze akapitu, aby unikna¢ ztych podzialéw w dalszej jego czeséci. Ocenianie catego
akapitu jest krytyczne, gdyz w ten sposéb program ma do dyspozycji znacz-
nie wigksza liczbe spacji, ktére mozna zwezi¢ lub poszerzy¢, zanim stanie sig
to dostrzegalne. Rezultatem jest mniejsza liczba dywizéw i lepsze spacjowanie

We need to stop the World Bank and Inter-
national Monetary Fund (1mF) forcing poor
countries to open their markets to trade
with rich countries, which has proved so
disastrous over the past 20 years; the Eu
must drop its demand that former Euro-
pean colonies open their markets and give 7
more rights to big companies; we need 8
to regulate companies — making them 9
accountable for their social and environ- 10
mental impact both here and abroad; and 11
we must ensure that countries are able to 12
regulate foreign investment in a way that 13
best suits their own needs. 14
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Paragraph Composer

We need to stop the World Bank and Inter-
national Monetary Fund (1MF) forcing poor
countries to open their markets to trade
with rich countries, which has proved so
disastrous over the past 20 years; the Eu
must drop its demand that former Euro-
pean colonies open their markets and give
more rights to big companies; we need to

accountable for their social and environ-
mental impact both here and abroad; and
we must ensure that countries are able to
regulate foreign investment in a way that
best suits their own needs.

Single Line Composer

powoduje podswietlenie na zétto wierszy, w ktdrych wystepuja
problemy z odstepami. Im ciemniejszy odcien podswietlenia, tym
powazniejszy problem wystepuje w tym miejscu.

RYSUNEK 7.8 Tekst zlozony
przy uzyciu Adobe Paragraph
Composer (po lewej) i Single
Line Composer (po prawej).
W lewym przykladzie wyste-
puja tylko pomniejsze prob-
lemy spacjowania w wierszach
8i9.W tekscie ztozonym

za pomocg ukladacza jedno-
wierszowego wystepuje po-
wazny problem w wierszu 9.
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WSKAZOWKA: Podczas
edycji tekstu sktadanego
przy uzyciu Paragraph
Composer tekst zmienia sie
(.porusza”) zaréwno przed,
jak i po miejscu, w ktérym
dokonujemy zmian. Kazda
wstawiona lub usunieta
litera powoduje, ze InDesign
dokonuje rekompozycji
catego akapitu, dopasowuje
odstepy i ztamania wierszy.
Moze to by¢ ktopotliwe,
jesli klient zaakceptowat
okreslone miejsca podzia-
téw wiersza w poprzedniej
wersji. Zmiany koncow
wierszy bez oczywistego
powodu moga zdenerwo-
wac klienta, ktory w efekcie
moze uznac, ze musi jeszcze
raz przeczytac caty tekst,
aby sie upewnic, ze nic

nie zostato zgubione.

Jesli wiec stosowane
zasady pracy wymagaja

w kolejnych iteracjach
dokumentu zachowania
zakoriczen wierszy tam,
gdzie 53, mozna rozwazy¢
przefaczenie sie na Single
Line Composer (Uktadacz
jednowierszowy).

RYSUNEK 7.9 Ten sam tekst
wysrodkowany (po lewej), wy-
srodkowany z opcja balansu
nieréwnych wierszy (w srodku)
oraz z wierszami podzielonymi
recznie stosownie do tresci

za pomoca wymuszonych
zlamar wierszy (Shift+Return).

tekstu. Adobe Paragraph Composer dziala zaré6wno przy skladzie justowanym,
jak i uktadanym w choragiewke, ale to przy tym pierwszym naprawde mozna
dostrzec jego zalety.

Bez wzgledu jednak na to, jak znakomity jest ten mechanizm, nie oczekujmy
cudéw. Dobra barwa tekstu nie przychodzi tatwo i nadal bedziemy musieli
poprawiaé niektére problemy recznie. W tym miejscu przyda sie ustawienie
preferencji Composition > H&J Violations (Sktad > Naruszenia dzielenia wyra-
z6w i justowania). Wlaczenie tej opcji pozwala tatwo zidentyfikowaé problemy,
a skoro je rozpoznamy, mozemy sprébowa¢ je naprawié — a $cislej, musimy
to zrobi¢. Schodzac na ziemie, musimy mie¢ na uwadze to, ze nawet przy najsta-
ranniej dobranych szerokosciach taméw, naukowo dowiedzionych ustawieniach
justowania i najrozumniejszym wykorzystaniu preferencji programu, problemy
ze spacjowaniem nadal bedg pojawiaé sie od czasu do czasu. Tak wiec, jeszcze
za wczeénie na zwalnianie korektoral!

Tekst wysrodkowany

Wyréwnanie do $rodka tworzy choragiewke obustronng — nadmiarowa prze-
strzen kazdego wiersza jest rozdzielana réwno na obydwa korice wiersza, przez
co caly akapit zostaje wycentrowany wzgledem $rodowej osi symetrii bloku
tekstu. Uklad ten jest szeroko stosowany w projektach czasopism do tytutéw,
podobnie jak na stronach tytulowych ksigzek. Czesto jest tez spotykany w zapro-
szeniach slubnych, powiadomieniach o narodzinach i... tablicach nagrobkowych.
Wysrodkowanie najlepiej sprawdza sie przy tekstach jedno- lub co najwyzej

Congress shall make no law
respecting an establishment of
religion, or prohibiting the free

exercise thereof; or abridging the
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or the right of the people peaceably
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EESSEMOTION OF LIGHT EEEEMOTION OF LIGHT s RYSUNEK 7.10 Wysrodko-
Rays of light are thrown off from luminous bodies Rays of light are thrown off from luminous bodies wany nagtéwek wydaje sie

in every direction, but always in straight lines, which in every direction, but always in straight lines, which 2'? wyn‘}wnany: jesli pierwszy
cross each other at every point; but the particles of cross each other at every point; but the particles of “{'ersz nastgpu;qu po tytu'le‘
which each ray consists are so minute that the rays do which each ray consists are so minute that the rays do nie wypetnia calej szerokosci

tamu (po lewej). W celu skom-
pensowania tego wrazenia
mozna wstawi¢ w nagtéwku
dodatkowy odstep jako wcig-
cie z prawej (po prawej).

parowierszowych. Centrowanie dluzszego akapitu jest zwykle nienajlepszym

pomystem, gdyz kazdy wiersz zaczyna sie na innej pozycji, co pomniejsza czy-
telnosé tekstu. Dobrze wykonane wysrodkowanie moze nadaé stronicy wyglad

formalnyiklasyczny, nadajac interesujacy ksztalt blokowi tekstu. Jednak uzyte

bez przemyslenia moze spowodowad, ze powstaly uklad wyda sie powazny

i nudny. Réwne biale przestrzenie po obu stronach kazdego wiersza sprawiaja,
ze tekst jest statyczny, jak uchwycony w imadlo. Poczatkujacy projektanci czesto

siegaja po wyréwnanie do $rodka, gdyz czuja sie pewniej z jego solidnoscia —
kazdy wiersz jest podtrzymywany z obu stron przez pusta przestrzen.

Laczenie wyréwnania do srodka z innymi typami wyréwnania rowniez moze
powodowac¢ trudnosci. Réwne odstepy z obu stron wysrodkowanego wiersza
tworza symetrie, ktdra jest sprzeczna z asymetryczna natura tekstu zlozonego
w choragiewke. Wysrodkowany tytul ponad tekstem wyréwnanym do lewej nie
bedzie si¢ wydawal naprawde wycentrowany, jesli (co prawdopodobne i czeste)
pierwszy wiersz tekstu gléwnego nie bedzie mial dtugosci réwnej szerokosci
lamu. Mozna to poprawié, ale nadal réznica sposobu wyréwnywania niweczy
zwigzek pomiedzy nagléwkiem i tekstem gtéwnym. Jeszcze gorsze wydaje
sie tylko wysrodkowanie tytulu zlozonego kursywa ponad tekstem pisanym
odmiang prosta — pochylenie kursywy jeszcze wzmocni wrazenie, ze tytul nie
znajduje sie na $rodku.

Naturalnie wy$rodkowany tekst moze wyglada¢ dobrze, ale wymaga to troche
wiecej, niz tylko klikniecia przycisku Wysrodkuj. Sposéb, w jaki polamia sie
wiersze, moze obnizy¢ zrozumialoéé tekstu, jak réwniez stworzyé brzydki
ksztalt akapitu, zatem trzeba by¢ przygotowanym na koniecznoéé recznego
podzielenia wierszy we wlasciwych miejscach, uzywajac wymuszonych zltaman
wiersza. Miejsca te powinny wynika¢ przede wszystkim z tresci, ale zarazem
podkreslié centralng o$ tekstu — dla czytelnika powinno by¢ oczywiste, ze tekst
jest wysrodkowany, a nie po prostu zle wyjustowany.



RYSUNEK 7.11 Wyréwnany
do prawej lid zestawiony
z justowanym blokami tekstu.

RYSUNEK 7.12 Na tej rozkia-
déwce podpisy zdjec sg wy-
réwnane w strone grzbietu,
podczas gdy paginy s3 wyréw-
nane od grzbietu.

Tekst wyréwnany do prawej

Wyréwnanie do prawej, czy tez choragiewka z lewej, jest uzywane rzadko, a tym
samym wyrézniajace. Moze by¢ przydatne dla krétkich fragmentéw tekstu, jak
podpisy ilustracji, wyciagniete cytaty, a niekiedy dla $rédtytutéw. Jesli zostanie
uzyte na stronach widzacych, wyglada lepiej na lewej stronie, gdy tekst ,cigzy”
w strong grzbietu, niz na stronie prawej, skierowany w strone marginesu, gdyz
taki uklad moze sprawi¢, ze tekst wyglada, jakby prébowatl uciec ze stronicy.

Nadmierne stosowanie wyréwnania do prawej moze byé irytujace dla czytel-
nikéw, gdyz wéwczas oko prébuje sie skupiaé raczej na koricu, a nie na poczatku
wiersza. Poszarpany lewy brzeg utrudnia lokalizacje poczatku i zakléca ptyn-
noé¢ czytania. Jednak rozsadnie stosowane, wyréwnanie do prawej moze nadaé
dynamizm i $wiezo$¢ ukladowi strony.

Tekst wyréwnany do prawej przycigga uwage do siebie samego. Jesli decydu-
jemy sie juz na zastosowanie tego rozwigzania, nalezy raczej podkreslaé jego

Align it right

This form of alignment
can be effective for
headlines and straplines
when the alignment is
towards the spine
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odmienno$é¢ i bardziej wyrézniaé, niz ograniczaé nieréwnomiernoéé chora-
giewki. Podobnie jak w przypadku wysrodkowania, moze to wymagaé recznego
dzielenia wierszy. Ponad wszelka watpliwoéé nalezy unika¢ dzielenia wyrazéw
w takim uktadzie — nie po to budujemy gltadka prawa krawedz bloku tekstu, by
tworzy¢ na niej szczecing dywizéw!

Inne opcje justowania

Oprécz typowych metod wyréwnania tekstu istnieja jeszcze rzadziej stosowane
opcje, ktére moga byé przydatne w szczegélnych sytuacjach.

Wyréwnanie do i od grzbietu

Opcje te gwarantuja, ze wyréwnanie tekstu bedzie zamienialo sie na wlasne
przeciwienstwo, jesli tekst przejdzie ze strony lewej na prawa lub odwrot-
nie. Jesli na przyklad chcemy, aby podpisy ilustracji byly wyréwnane do lewe;j
na stronach prawych, ale w prawo na stronach lewych, uzyjemy opcji Towards
Spine (Do grzbietu). Do pagin, ktére na stronach lewych powinny by¢ wy-
réwnane w lewo, a na prawych w prawo, zastosujemy opcje Away from Spine
(Od grzbietu).

Justowanie z wysrodkowaniem ostatniego wiersza

Opcja o stosowalnoéci typu ,na $wiety nigdy”, choé¢ wyjatkowo moze by¢ uzy-
teczna przy skladaniu poezji lub tworzeniu ciekawych ksztattéw z blokéw
tekstu — jednak w istocie takie efekty tworzy sie wychodzac z uktadu wysérod-
kowanego lub wrecz recznie w programach ilustracyjnych.

Petne justowanie

Ta opcja, zwana tez justowaniem wymuszonym, powoduje wyjustowanie
wszystkich wierszy akapitu — lacznie z ostatnim. Jest uzyteczna, jesli chcemy
np., by treé¢ tytulu caltkowicie wypelnila okreslona przestrzen pozioma.
Tworzenie takiego tytulu mozemy zacza¢ od narzucenia pelnego justowania
(Cmd/ Ctrl+Shift+F), po czym bedziemy stopniowo zwicksza¢ stopien pisma
(Cmd/ Ctrl+Shift+>), aby zobaczy¢, jak duzy moze by¢ nasz tekst, zanim ,wyleje
si¢” z ramki. Gdy posuniemy si¢ zbyt daleko, naci$niecie Cmd / Ctrl+Z pozwoli
wroci¢ do poprzedniego kroku.

A CERTAIN LOOK IN THE EYE AND AN EASY SMILE

A CERTAIN LOOK IN THE EYE AND AN EASY SMILE
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Down, down, down. Would
the fall never come to an end!
'l wonder how many miles
I've fallen by this time?"
she said aloud. 'l must
be getting some-
where near the
centreofthe
earth.

RYSUNEK 7.13 ,Zbiezne wy-
srodkowanie” — co$, czego nie
zZapewni opcja wycentrowania
ostatniego wiersza, ktéra
databy efekt znacznie mniej
interesujacy.

RYSUNEK 7.14 Wykorzy-
stanie pelnego justowania
do rozciagniecia tytutu

na petng szerokos¢ famu.



Laczenie wyrownania do prawej i lewej

Potaczenie podpisu réwnanego do prawej z tekstem gléwnym réwnanym do lewej

moze efektownie wizualnie wykorzysta¢ bialg przestrzen strony. Wymaga

to utworzenia oddzielnej ramki tekstowej dla wyréwnanego w prawo podpisu

i umieszczeniu go na lewo od gléwnego tekstu. Aby zapewni¢ kontekstowe

polaczenie pomiedzy dwoma rodzajami tekstu, konieczne jest zakotwiczenie

ramki z podpisem do okreslonego punktu w tekscie gléwnym. O to prosty
sposéb osiagnigcia tego efektu:

1. Wycinamy ramke tekstowg (Cmd+X/Ctrl+X).
2. Umieszczamy kursor tekstowy na poczatku akapitu tekstu gtéwnego,

RYSUNEK 7.15 Umieszczone
obok siebie akapity, przy czym
tekst wyréwnany do prawej
umieszczony jest w zakotwi-
czonej ramce,

do ktérego chcemy ,podtaczyé” podpis i wklejamy zawartos¢ schowka
(Cmd+V/Ctrl+V).

. Aby zmienié polozenie wklejonej ramki, zaznaczamy ja narzedziem wyboru

iklikamy prawym klawiszem myszy, aby z menu podrecznego wybrac pole-
cenie Anchored Object > Options (Obiekt zakotwiczony > Opcje). Nastepnie
ustawiamy poszczegélne opcje, takie jak punkt odniesienia, polozenie
wzgledem tekstu gléwnego, przesuniecie w poziomie (X) i w pionie (Y),
aby umieéci¢ ramke podpisu we wlaéciwym potozeniu wzgledem tekstu.
Dla wartoéci Y dobrym punktem wyjécia bedzie Line (Cap Height) (Wiersz
(Wysokos¢ wersalikéw)) i wartosé o (zero), ktérg mozna nastepnie sko-
rygowa¢. Pomocne bedzie zaznaczenie opcji Preview (Podglad), dzigki
czemu bedziemy mogli na biezaco $ledzi¢ efekty dokonywanych zmian.
Na zakoniczenie mozna zaznaczy¢ opcje Prevent Manual Positioning
(Zablokuj pozycjonowanie reczne), aby unikna¢ przypadkowego prze-
suniecia zakotwiczonej ramki wzgledem gléwnego tekstu.

115 g unsalted butter  Chill the butter and water to prex
25 g all-purpose flour the flour. Stir the flour, salt, and
60 ml water butter — the resulting mixture s}
1 teaspoon salt

leggyolk Pour in the chilled water a tablesy

I | addition.

Split the dough into two equal an
slightly, and wrap them in plastic
for at least 30 minutes to absorb




Innym przykladem ljczenia przeciwstawnych wyréw- Alison Steadman| Wendy
nan moze by¢ spis aktoréw i odgrywanych rél. Aby Jim Broadbent | Andy
utworzy¢ taka ,liste ptac”, mozemy przeksztalcié Claire Skinner | Natalie
tekst na tabele, nadajac lewej kolumnie wyréwnanie Jane Horrocks | Nicola

do prawej, a prawej kolumnie — do lewej i ukrywajac Stephen Rea | Patsy
poziome i pionowe linie siatki tabeli. Wiecej informacji Timothy Spall | Aubrey
zawiera rozdzial 10, ,Tabulatory, tabele i listy”. David Thewlis | Nicola's Lover

Wysuniecie znaku przestankowowego

Wysuwanie poczatkowego znaku przestankowego jest forma optycznego
wyréwnania w celu zachowania gladkiego lewego brzegu tekstu. Wysuwanie
poczatkowego wiersza jest powszechnie stosowane w listach wypunktowanych
lub numerowanych (rozdzial 10), ale moze réwniez by¢ przydatne w tekstach
wielkoformatowych, szczegdlnie w wyciagnietych cytatach i wstawkach, ktére
zaczynaja sie od znaku cudzystowu. Otwierajacy cudzysiéw tworzy optyczna
luke w lewej krawedzi tekstu, zatem lepszym rozwigzaniem wydaje sie¢ wysu-
niecie go przed krawedz. W istocie realizujemy to, przesuwajac sam brzeg tekstu
za pomoca znaku Indent to Here (Wciecie tutaj), wstawianego sekwencja Cmd+\
(Ctrl+\). Ten niewidoczny i niedrukowalny znak powoduje wciecie wszystkich
pozostaltych wierszy akapitu do pozycji, w ktérej zostal ustawiony.

Wyréwnanie w pionie

Wyréwnanie tekstu z zasady dotyczy poziomego rozmieszczenia znakéw w wier-
szu. Jednak InDesign udostepnia tez opcje dotyczace pionowego umieszczenia
tekstu wewnatrz ramki tekstowej. Domyslna opcja jest rozpoczynanie tekstu
od gérnego brzegu ramki, co jest najbardziej wlasciwa wersja w wiekszosci
przypadkéw. Sg jednak sytuacje, gdy przydatne okaze si¢ wyréwnanie tekstu
w ramce do $rodka lub do dotu. Aby uzyskaé dostep do opcji wyréwnania (a takze
innych opcji ramki tekstowej), nalezy po jej zaznaczeniu (lub wstawieniu kur-
sora tekstowego) nacisnaé¢ Cmd+B (Ctrl+B).

Do gory Wyjustowany
Wyrownywa-
nie w pionie
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RYSUNEK 7.16 Wyréwnanie
typu, filmowa lista ptac”: tekst
wyrownany do prawej obok
wyrownanego do lewej, roz-
dzielone pionowa osig.

RYSUNEK 7.17 U gdry: ot-
wierajacy cudzystow w pierw-
sZym wierszu wyciggnietego
cytatu powoduje wrazenie
wciecia pierwszego wiersza.

U dotu: wstawienie znaku
Indent to Here powoduje wy-
rownanie akapitu za otwieraja-
cym cudzystowem.

“Life is what
happens while
you’re making
other plans.”
— John Lennon
“Life is what
happens while
you’re making
other plans.”

— John Lennon

RYSUNEK 7.18 Cztery typy wyrownania pio-
nowego w ramce tekstowej

w obrebie ramki

tekstowej - justo-
wanie w pionie
ma pierwszen-

stwo przed [ Ignore Text Wrap

interlinia.
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# Aligning a
picture to the
Cap Height
of a column

8 of text.

Aligning a
picture to the
Cap Height
¥ of a column
5 of text,

RYSUNEK 7.19 Wyréwnywa-
nie ilustracji do gérnej krawe-
dzi ramki tekstowej powoduje
optyczne niewyréwnanie
tekstu i grafiki (u gory). W celu
poprawy sytuacji ilustracje
trzeba wyréwnac do linii wy-
dtuzen gérnych pierwszego
wiersza tekstu (na dole).

RYSUNEK 7.20 Wyrdwnanie
tekstu wewnatrz kolistego
ksztattu

Wyréwnanie do gory

Dokladna pozycje poczatku tekstu przy tym ustawieniu okresla opcja First
Baseline Offset (Przesuniecie pierwszej linii bazowej), dostepna w zaktadce
Baseline Options (Opcje linii bazowej) okna dialogowego wtasciwosci ramki
tekstowej. Jedynie w wyjatkowych sytuacjach potrzebna moze by¢ zmiana
domyslnego ustawienia Ascent (Wydtuzenie gérne), szczegélnie jesli wezmiemy
pod uwage, ze zastosowanie siatki linii bazowych zastepuje to ustawienie,
w ostatecznosci dajac taki sam efekt, jak wybranie ustawienia Leading (pod
warunkiem wszakze, zZe sama ramka réwniez jest wyréwnana do siatki linii
bazowych). Trzeba jednak zauwazy¢, ze powoduje to powstanie niewielkiego
pustego miejsca pomiedzy gérna krawedzia ramki tekstowej i gérna linia pierw-
szego wiersza tekstu. Oznacza to, ze na przyklad wyréwnywanie ilustracji
i tekstu wymaga szczegélnej uwagi. W takiej sytuacji pomocne jest dodanie
linii pomocniczej na wysokosci wydtuzen gérnych pierwszego wiersza tekstu
i docigganie ilustracji do tej linii. Wiecej informacji na ten temat zawiera roz-
dzial 14, ,Strony, marginesy, famy i siatki”.

Wysrodkowanie

Opcja wysrodkowania w pionie na pierwszy rzut oka wydaje si¢ bardzo przy-
datna, szczegélnie dla tytulariéw i innych efektéw specjalnych. Trzeba jednak
zauwazy¢, ze jesli tekst zawiera wydluzenia dolne, nie bedzie robit wraze-
nia wyréwnanego optycznie i konieczne bedzie skorygowanie jego potozenia
za pomoca przesuniecia linii bazowej.

Tekst w kotku

Czestym zabiegiem estetycznym jest umieszczanie réznego typu wyréznikéw
(np. numer6w rozdziatéw) jako tekst w kontrze wewnatrz kolistego tta. Préby
dokladnego wyréwnania tekstu wewnatrz ramki o takim ksztalcie czesto
okazuja sie tak klopotliwe i pracochlonne, ze tatwiej jest utworzyé 6w tekst
oraz ksztalt tla jako oddzielne obiekty. Oto, jak mozna to zrobi¢:

1. Ustawiamy odpowiednia wielko$¢ tekstu.

2. Zaznaczamy ramke tekstowa i wybieramy opcje Fit Frame to Content
(Dopasuj ramke do zawartosci) — Cmd+Option+C lub Ctrl+Alt+C, aby
ramka $cisle dopasowala sie o tekstu.

3. Zaznaczamy zaréwno ramke, jak i narysowane oddzielnie kétko, po czym
wyréwnujemy je centralnie w poziomie i pionie przy uzyciu palety Align
(Wyréwnanie). W razie potrzeby mozemy skorygowa¢ potozenie, aby
uzyska¢ optyczne wysrodkowanie napisu w kole.

4. Grupujemy oba obiekty, naciskajac Cmd+G/ Ctrl+G.
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RYSUNEK 7.21 Tekst wysrod-
kowany w pionie wewnatrz
ramki (po lewej) robi wrazenie
przesunietego w dét. Dopiero
podniesienie linii bazowej
zapewnia optyczne wrazenie
wycentrowania (po prawej).

Typography | Typography

Wycentrowane w pionie Optyczne wyrownanie przesunieciem linii bazowej

Wyroéwnanie do dotu

Wyréwnanie tekstu do dolnej krawedzi ramki jest uzyteczne w przypadku
podpiséw do ilustracji, gdy umieszczamy je obok grafiki i chcemy, aby podpis
ten pasowal do dolnej krawedzi ilustracji.

Pionowe justowanie tekstu

Opcja pionowego justowania tekstu pozwala wymusi¢ wypelnienie tekstem
calej przestrzeni w pionie, a przy kilku tamach zapewnienie, ze spody wszyst-
kich taméw wypadna na tej samej linii bazowej. Funkcja ta dziata, dodajac
dodatkowa przestrzen miedzy akapitami, a potencjalnie réwniez zwiekszajac
interlinie w krétszych tamach.

Funkcja ta jest bardzo tatwa w uzyciu, ale pozwalam sobie na jej stosowanie
tylko wéwczas, gdy spodziewam sie, ze nikt nie zauwazy tego zabiegu — albo gdy
brak czasu na staranniejsze wyréwnanie. Jednak justowanie w pionie jest czyms§
w rodzaju paktu z diablem. Tak, spowoduje, ze nasze famy beda sie konczy¢
w tym samym miejscu, ale zaplacimy za to wysoka cene. Justowanie w pionie
ma pierwszenstwo wzgledem ustawien interlinii, wyrzucajac tekst z siatki linii
bazowych, o ile jej uzywamy, a potencjalnie prowadzi do nieréwnomiernych
szaroéci tekstu w poszczegoélnych tamach. Jednak funkcja ta nie pozbawia nas
zupelnie kontroli: ustawienie Paragraph Spacing Limit (Ograniczenie odstepow
miedzy akapitami) w opcjach ramki tekstowej okresla maksymalna wielkos¢,
do ktérej program moze powieksza¢ odstepy miedzy akapitami. Gdy wartosé
ta zostanie osiggnieta, dalsze wyréwnywanie odbywa sie poprzez zwiekszanie
interlinii. Ustawienie dostatecznie duzej wartoéci tego parametru (maksymalna

RYSUNEK 7.22 Wyrownanie
do dotu utatwia dopasowywa-
nie podpisow do ilustracji.

A picture caption vertically
aligned to the bottom
of the text frame.
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RYSUNEK 7.23 Justowanie
w pionie prowadzi do nie-
jednolitych wartosci interlinii
i tym samym nieréwnej szaro-
éci tekstu (po prawej). Balans
kolumn (po lewej) sprawia,
ze tamy uzyskujg zblizong
dtugoéé, choé nie koricza

sie w tym samym miejscu,

co tamy na innych stronach
dokumentu.

dopuszczalna wielkoéé to 8640 punktéw!) sprawia, ze dodatkowe swiatto wsta-
wiane jest tylko pomiedzy akapitami (co jest mniejszym ztem), za$ interlinia
pozostaje nietknieta.

Skutecznoéc takich zabiegéw zalezy od liczby akapitéw w bloku tekstu. Jesli
zawiera on podtytuly i tekst gtéwny, dodatkowa przestrzen moze zazwyczaj
zostaé niezauwazenie dodana ponad podtytulami. Jesli jednak tam zawiera
tylko jeden akapit, podejscie takie nie zadziala w ogéle. Zazwyczaj lepszym roz-
wigzaniem dla nieréwnych faméw jest dopasowanie ich dtugosci, a nie pionowe
justowanie do pelnej wysokosci ramki. Nowa funkcja Balance Columns (Balans
kolumn), dostepna w InDesign ¢S5 w opcjach ramki tekstowej, pozwala dopa-
sowac dlugosé taméw, aby zawieraly w przyblizeniu réwna liczbe wierszy.

Osto delis arumsandic
autem il pratismolore dune
praesequat in ex ex enim
zzrit dolore doluptat wis
adit enis at, vel eliquat
ulput lor sum ing ero
commod molore molore
velit ullum num zzriliscip
esed mincillam ad eum
irillan eu feugait ipit adio
dolum alit adionsectem amet
wis nim vulla faccum in ea
aci et, quam velit volore te
dolore tie dolore velenibh

eniam in hent dolutacet

adigna faccummy nissequat
aciliqu iscing eu feugait lor
secte dolorercip endre tem
vullam ipismol oreriurero
estrud excraese feum quipisi
bla cor sequar. Olesequarie
magna feu faci blam
dolorem zzrit nosto euip ca
adigna faccum velit auter
lummod tem quametum
quamcommeod dolore molor
sit, quat vent il et nonse
commod tat iureet irit lortie
dolorercin volobor.

Dziatanie funkcji Balance Columns

Osto delis atumsandit
autem il pratismolore dunt
pragsequart in ex ex enim
zzrit dolore doluprat wis

adit enis at, vel eliquar

ulput lor sum ing ero
commod molore molore
velit ullum num zeriliscip
esed mincillam ad eum
irillan eu feugait ipit adio
dolum alit adionsectem amet
wis nim vulla faccum in ea
aci et, quam velit volore te
modolore tie dolore velenibh
eniam in hent dolutatet
adigna faccummy nissequat
aciliqu iscing eu feugait lor

H:ﬂ_"

secte dolorercip endre tem
vullam ipismol oreriurero
estrud exeraese feum quipisi
bla cor sequat. Olesequatie
magna feu faci blam
dolorem zzrit nosto euip ea
adigna faccum velit aurer
lummod tem quametum
quamcommod dolore molor
sit, quat vent il et nonse
commod tat iureet irit lortic

dolorercin volobor.

Wyréwnanie w pionie



RozDzIAL 8

Wciecia i odstepy akapitowe

?
5 TYPOGRAFIA, TAK JAK INNE MEDIA, opiera sie na uznanych powszechnie konwen-
) cjach, ktore sg rozumiane, czesto nieswiadomie, przez odbiorcow. Manipulo-
wanie poziomymi lub pionowymi lukami w formie wcie¢ lub odstepow tworzy
wazne wizualne wskazowki, ktére umozliwiajg odroznianie akapitow od siebie.
Akapity reprezentuja jednostki znaczeniowe szersze od zdan, zas rozpoczecie
nowego akapitu jest sygnatem, ze zaczynamy nowa mysl. Jakkolwiek istnieje
wiele sposobéw zaznaczenia poczatku nowego akapitu, najczesciej spotykane
sg dwie metody: wciecie pierwszego wiersza (albo po prostu ,wciecie akapi-
towe”) lub dodanie odstepu przed akapitem. W tym rozdziale zajme sie przede
wszystkim tym, jak i dlaczego stosowac jedna z tych uznanych konwencji, ale
pokaze réwniez zastosowanie innych typow wcie¢ do odrézniania szczegéinych

typow akapitow.
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Wciecie pierwszego wiersza

Proste wcigcie pierwszego wiersza odgrywa kluczowa role w czytelnosci do-
kumentu, zwracajac uwage czytelnika na fakt, ze jeden akapit sie skonczyt
i wlasnie zaczyna sie kolejny. Tworzy ono réwniez wizualng pauze i wolna
przestrzen w bloku tekstu, ktéry w przeciwnym razie wygladatby odpychajaco
i nieczytelnie.

Mogloby sie wydac, ze nic wigcej nie da sie powiedzieé¢ o wcigciach akapito-
wych — po prostu poczatek pierwszego wiersza odsuniety w prawo i to wszystko.
Nie tak jednak sadzil Jan Tschichold. Wielki typograf napisat kilka artykuléw
poéwieconych wcigciu akapitowemu i jednoznacznie przedstawil swoje poglady
na ten temat: , Poczatki akapitéw musza by¢ wciete. Akapity bez wcigcia... to zle
zachowanie i muszg by¢ wyeliminowane”. A takze: ,Sklad tekstu bez wcieé¢
powoduje, ze czytelnikowi trudniej przychodzi zrozumienie tego, co zostato
wydrukowane. Jest to najwazniejsza wada. Jakkolwiek stepione poczatki wydaja
sie tworzy¢ jednolity i konsekwentny wyglad, gdy poréwnany je z tradycyjnym
sktadem, za wrazenie to musimy zaplacié ceng znaczacej utraty zrozumiatosci”
(w The Form of the Book: Essays on the Morality of Good Design).

Jak duze powinny by¢?

Nie istnieje zadna szybka i jednoznaczna metoda okreslajaca poprawna wielkos¢
weciecia, ale mozna przyja¢, ze dobrym punktem wyjscia jest jeden firet. Jesli
sktadamy tekst czcionka w stopniu 10 punktéw, wciecie pierwszego wiersza
wynoszace 10 punktéw moze byé wystarczajace. Mniejsza wartosé wciecia moze
sprawi¢, ze nie bedzie wyréznialo sie dostatecznie i moze zostaé przeoczone
podczas lektury. Alternatywa jest uzaleznienie wciecia od interlinii: jesli tekst
gléwny to 10/12, sprébujmy wciecia wynoszacego 12 punktéw. Niektérzy wola
nieznacznie wigksze wciecia, szczegblnie przy relatywnie szerokich tamach.
W praktyce jednak trzeba sie upewnié, ze wciecia s3 mniejsze niz dtugosci
konicowych (niepelnych) wierszy, aby uniknaé powstawania niezrecznych
ibrzydkich ,pulapek” pomiedzy akapitami.

Jak tworzy¢ wciecia akapitowe (a jak nie)
Weigcie pierwszego wiersza mozna zaaplikowaé za posrednictwem palety ste-
rujacej, panelu Paragraph (Akapit), wywolywanego skrétem Cmd+Option+T/
Ctrl+Alt+T, albo najlepiej jako czes$¢ definicji stylu akapitowego. Nigdy nie nalezy
tworzy¢ wcigcia przy uzyciu tabulatoréw, albo co jeszcze gorsze, kilku kolej-
nych spacji.

Cho¢ wciecia pierwszego wiersza akapitu w ogélno$ci sprawdzaja sie dosko-
nale w tekstach zwartych, na przyktad w artykutach w czasopismach lub
w beletrystyce, odstepy miedzy akapitami moga byé¢ lepszym rozwigzaniem
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w materialach zrédtowych lub podrecznikach. Do pewnego stopnia jest to kwe-
stia upodoban, warto jednak uwzgledni¢ kilka regut ogélnych:

= Nie nalezy jednoczeénie stosowal wcigé akapitowych oraz odstepow
miedzy akapitami. To jest alternatywa albo/albo, nie lub.

= Nie uzywamy wcie¢ akapitowych dla tekstu wysrodkowanego lub wyréw-
nanego do prawe;j.

m Jesli akapit nastepuje bezposrednio po tytule lub podtytule, wciecie
pierwszego wiersza jest niepotrzebne (nie ma powodu zaznaczaé nowej
mysli — tytul zapewnia to wyréznienie w wystarczajacym stopniu).

® Pominigcie wcigcia i dodanie §lepego wiersza przed akapitem to prosty
sposéb oddzielenia fragmentu tekstu bez sugerowania réznicy hierarchii
pomiedzy tymi akapitami.

“Not of late years. It is fifteen years since we—since I —came last from France.”

“Indeed, sir? That was before my time here, sir. Before our people’s time here,
sir. The George was in other hands at that time, sir.”

“I believe so.”

“But I would hold a pretty wager, sir, that a House like Tellson and Company
was flourishing, a matter of fifty, not to speak of fifteen years ago?”

“You might treble that, and say a hundred and fifty, yet not be far from the truth.”

“Indeed, sir!”

“Not of late years. It is fifteen years since we—since I —came last from
France.”

“Indeed, sir? That was before my time here, sir. Before our people’s time
here, sir. The George was in other hands at that time, sir.”

“I believe so.”

“But I would hold a pretty wager, sir, that a House like Tellson and Com-
pany was flourishing, a matter of fifty, not to speak of fifteen years ago?”

“You might treble that, and say a hundred and fifty, yet not be far from
the truth.”

“Indeed, sir!”
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RYSUNEK 8.1 Goérny frag-
ment zostat ztozony z wcie-
ciem akapitowy wynoszacym
1 firet (w tym przykladzie 10
punktéw). Fragment na dole
uzywa wciecia 3-firetowego.
Jest to zdecydowanie zbyt
duza wartos¢, tworzaca
niezdarne dziury pomiedzy
koricem jednego akapitu i po-
czatkiem nastepnego.

RYSUNEK 8.2 Pole nume-
ryczne sterujgce wcieciem
pierwszego wiersza w palecie
sterujacej (po lewej) oraz usta-
wienia wciec i odstepow sta-
nowigce czed¢ definicji stylu
akapitowego (po prawej).
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RYSUNEK 8.3 Wciecia pierwszego wiersza w poréwnaniu do odstepow miedzy akapitami jako metody odrézniania akapitow.

‘Ugh!’ said the Lory, with a shiver. To colour correct using an eyedropper tool:

Theg your palfdonf’ said the Mouse, frowning, but 1. (Optional) Place a colour sampler on a pixel in an area
very politely: ‘Did you speak?’ of the image that should be neutral gray. Choose a pixel
‘Not I'’ said the Lory hastily. in the shadows, midtone, or highlight, depending on
I thought you did, said the Mouse. ‘- I pro- the eyedropper tool that you plan to use. Use the Info

ceed. “Edwin and Morcar, the earls of Mercia and palette to help you locate an appropriate pixel.

Northumbria, declared for him: and even Stigand, 2. Choose Layer > New Adjustment Layer > Levels

the Patriotic archbishop of Canterbury, found it 3. Double-click the Set Black Point, the Set Gray Point, or

advisable - the Set White Point Eyedropper tool. Use the Adobe
‘Found what?” said the Duck. Colour Picker to specify a neutral target colour.
‘Found it the Mouse r.ep]ied rather crossly: ‘of If you're working in RGB, enter the same values for R, G,

course you know what “it” means. and B to specify a neutral colour. The neutral colour should
‘I know what “it” means well enough, when I find a be close as possible to the values of the colour sampler.

Wciecie pierwszego wiersza

RYSUNEK 8.4 Alternatywa
dla oddzielania akapitéw:
znak 1 uzyty do podzielenia
tekstu na logiczne frazy
(akapity).

Odstep miedzyakapitowy

Alternatywy dla wciecia akapitowego

Nie wszyscy lubig akapity z wcietym pierwszym wierszem. W Niemczech popu-
larne jest stosowanie akapitéw zaczynajacych sie réwno od lewego marginesu
bez zadnych wcigé. Praktyka taka jest réwniez czesta w niektérych gazetach,
gdzie miejsca jest naprawde niewiele. Moze to by¢ problematyczne, jesli ostatni
wiersz poprzedniego akapitu biegnie przez prawie calg szerokos¢ tamu, gdyz
woéwczas czytelnikowi trudno jest odrézni¢ jeden akapit od kolejnego.

Potaczenie akapitéw jeden za drugim i uzycie dekoracyjnego znaku pomig-
dzy nimi daje wrazenie ciaglosci bez utraty zdolnosci zrozumienia tekstu.
W sredniowiecznych manuskryptach stosowano taki zapis, umieszczajac znak
akapitu jako wyréznik. W niektérych sytuacjach nadal mozna zastosowaé
to rozwigzanie.

“Brave and generous friend, will you let me ask you one last question? I am very
ignorant, and it troubles me—just a little.” § “Tell me what it is.” § “I have a
cousin, an only relative and an orphan, like myself, whom I love very dearly.
She is five years younger than I, and she lives in a farmer’s house in the south
country. Poverty parted us, and she knows nothing of my fate—for I cannot
write—and if I could, how should I tell her! It is better as it is.” § “Yes, yes:
better as it is.” § “What I have been thinking as we came along, and what I am
still thinking now, as I look into your kind strong face which gives me so much
support, is this:—If the Republic really does good to the poor, and they come
to be less hungry, and in all ways to suffer less, she may live a long time: she
may even live to be old.” § “What then, my gentle sister?”
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Podciecia

Istnieja dwa typy podcie¢ (hanging indent): podcigcie z lewej, w jezyku angielskim
zwane outdent, czyli po prostu wysuniecie pierwszego wiersza w lewo, oraz
podciecie z prawej, czyli wysuniecie ostatniego wiersza w prawo. Podciecia
z lewej s3 powszechnie spotykane w stownikach lub bibliografiach, a takze
w podsumowaniach i innych wyréznionych fragmentach. Podciecia z prawej

mozna spotkaé w cennikach, menu restauracyjnych lub spisach tresci.

Podciecia z lewej

W akapicie zlozonym z podcieciem, wszystkie wiersze akapitu sa wciete (prze-
sunigte wzgledem lewego brzegu tamu) z wyjatkiem pierwszego, ktéry w efekcie
sprawia wrazenie wysunietego poza lewy margines. Efekt ten uzyskujemy nada-
jac calemu blokowi tekstu wciecie z lewej, a nastepnie ujemna wartoé¢é wciecia
pierwszego wiersza, zazwyczaj o tej samej wartosci, o ktora przesunelismy
lewy brzeg tekstu. Na przyklad, jesli wciecie z lewej ma warto$é 12 punktéw,
weciecie pierwszego wiersza powinno miec¢ —12 punktéw.

Podcigcie z lewej mozna zdefiniowaé w palecie sterujacej lub panelu Paragraph.
Mozna réwniez do tego celu wykorzysta¢ panel Tabs (Tabulatory): najpierw
okreslamy wartos$¢ wciecia z lewej wieksza od zera, po czym mozemy prze-

ciggna¢ goérny znacznik w lewo.

Podciecia z prawej

Podciecia z prawej, czy tez wysuniecia ostatniego wiersza, uzyte w polaczeniu
z wcieciem z prawej, pozwalaja wysuna¢ ostatni wiersz akapitu poza prawy
brzeg tekstu, aby zaakcentowaé jego zawartos¢.

Caribbean Pumpkin Curry Served over a quinoa corn
cake with a red Calypso bean, smoked pepper sofrito, a spicy
mango-coconut mojo, and crispy plantain slices ............ $15.25

Wild Mushroom Roulade Marinated seitan, wild
mushroom ragout, truffled mashed potatoes and celery root
wrapped in yuba and baked in a crisp phyllodough . ........ $16.50

SE Sz
e

‘Z!E |
__

RYSUNEK 8.5 Wysuniecie
ostatniego wiersza powoduje,
Ze wystaje on poza prawy
brzeg bloku tekstu.
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Wciecia z prawej i lewej

Niekiedy korzystne jest zastosowanie obustronnych wciec akapitu dla fragmen-

JE Sz, e
AP (E Sow ‘

téw o szczegblnym znaczeniu. Wciecie calego bloku tekstu z lewej, z prawej lub
z obu stron moze by¢ przydatne w nastepujacych sytuacjach:

= Do zasygnalizowania cytowania wiekszego fragmentu tekstu. Czesto

RYSUNEK 8.6 Sonet przed-

w takim przypadku warto nieznacznie zmniejszy¢ stopiet pisma. Wciety

obustronnie blok tekstu dobrze jest tez oddzieli¢ réwnymi odstepami

z gory i dotu od tekstu gtéwnego, zazwyczaj o wartosé zblizona do potowy

interlinii.

W spisach tresci i dokumentach technicznych, w ktérych wciecia sygna-

lizuja kolejne poziomy hierarchii.

Przy umieszczaniu poezji wewnatrz gléwnego tekstu sktadanego proza.

Fragment taki powinien byé wyréwnany do lewej, a caly blok tekstu

wciety tak, aby najdtuzszy wiersz wydawal si¢ wycentrowany wzgledem

tekstu gléwnego.

Dobranoc! juz dzi§ wigcej nie b¢dziem bawili,

] R ; : ) . . 15057 pt
stawiony w tym przykladzie Niech snu aniot modrymi skrzydly ci¢ otoczy, du

zostat wycentrowany wzgle- . .

dem najdhuzszego wersu, Dobranoc, n¥ech u‘dpoczng po l‘zach twoje oczy,

za$ pozostate wersy zostaly Dobranoc, niech si¢ serce pokojem zasili. Pozioma pozycja
dopasowane do niego. W tym kursora

celu najpierw wysrodkowatem Dobranoc, z kazdej ze mna przeméwionej chwili

wers zaczynajacy sie od stéw

«Pozwdl lica...” (Cmd+Shift+C), .

umieszczajac kursor na jego
poczatku. Z palety sterujacej
odczytatem pozycje kursora
(w tym wypadku 15,057 pt).
Nastepnie zaznaczytem
wszystkie wiersze sonetu

i wpisatem te wartos¢ w polu
weciecia z lewej (dwa ostatnie
wiersze zostaly dodatkowo
wciete 0 1 firet, w tym wy-
padku o 10 punktow).

Niech zostanie d#wigk jaki$ cichy i uroczy,
Niechaj gra w twoim uchu; a gdy mysl zamroczy,
Niech si¢ méj obraz sennym Zrenicom przymili.

Dobranoc, obréé jeszeze raz na mnie oczeta,
Pozwél lica. — Dobranoc — cheesz na stugi klasnaé?
Daj mi pier$ ucalowaé. — Dobranoc — zapigta.
Dobranoc, juz uciekias i drzwi chcesz zatrzasnaé.

Dobranoc ci przez klamke — niestety! zamknigta!
Powtarzajgc: dobranoc, nie datbym ci zasnaé.

Adam Mickiewicz, Dobranoc
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health of those who were to live there. Conditions in such towns
were frequently appalling. Frederick Engels, writing in 1844,

described them thus:

Every great city has one or more slums, where the working-class is
crowded together. The streets are generally unpaved, rough, dirty,
filled with vegetable or animal refuse, without sewers or gutters,
but supplied with foul, stagnant pools instead. '

Moreover, the harsh, and all-too-frequently cruel, regime of
the factories, if it did not daily inflict injuries upon the workers,

A
Alignment, 35-47, 80, 91-92, 101,
150-156
Left, 36, 39, 67,
Right, 37, 40
Center, 38, 40-41
Justified (Left Justified), 42-45
Align towards spine, 46
Align away from spine, 46
Adobe Paragraph Composer, 6o
Compared with Single line
composer, 60

Politics, n. A strife of interests masquer-
ading as a contest of principles. The
conduct of public affairs for private
advantage.

Politician, n. An eel in the fundamental
mud upon which the superstructure of
organized society is reared. When we
wriggles he mistakes the agitation of his
tail for the trembling of the edifice. As
compared with the statesman, he suffers
the disadvantage of being alive.

— Ambrose Bierce, The Devil's Dictionary
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CASSIO

Thanks, you the valiant of this warlike isle,
That so approve the Moor! O, let the heavens
Give him defence against the elements,

For I have lost us him on a dangerous sea.

MONTANO Is he well shipp'd?

CASSIO

CASSIO

His bark is stoutly timber'd, his pilot

Of very expert and app allowance;
Therefore my hopes, not surfeited to death,
Stand in bold cure,

A cry within: ‘A sail, 2 sail, a sail!’

Enter a fourth Gentleman.

What noise?

RYSUNEK 8.7 Cytowany
fragment zlozony stopniem
mniejszym o 1 punkt niz tekst
gtéwny, z wcieciami z lewej

i prawej wynoszacymi 1 firet

i odstepami wielkosci potowy
interlinii z géry i z dotu.

RYSUNEK 8.8 Kilka zastoso-
wan podcied. (A) Podciecia

z lewej w skorowidzu.

(B) Stownik, w ktorym wszyst-
kie wiersze sy wciete 012 pt,

a pierwszy wiersz ma wciecie
-12 pt, powodujac wysu-
niecie hasta poza margines.
(C) Wciecia wyrdzniajace hie-
rarchie tytutéw w spisie tresci.
(D) W tym przykladzie tekst
po nazwie postaci wyrownany
jest do ustalonego punktu
przy uzyciu tabulatora, dzieki
czemu tres¢ dialogu zaczyna
sig zawsze na tej samej

pozycji.
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RYSUNEK 8.9 ,Ramka in-
formacyjna” z ttem o szarosci
16,5%, z odstepami krawedzio-
wymi ze wszystkich stron.

Dash Dash to Em-dash
| Straight Double to Typographers
| Straight Single to Typographers C

Dash to En-dash
Multiole Rety

Multiple Return to Single Return
. Multiple Space to Single Space
Phone Number Conversion (dot fe
Remove Tralling Whitespace

-; Drop Shadow
. Owerprint Black Stroke

RYSUNEK 8.10 Szybkie usu-
wanie nadmiarowych koricow
akapitu przy uzyciu zapytania
GREP.

Odstepy krawedziowe

Odstepy krawedziowe (insets) to dodatkowe marginesy wewnatrz ramki teks-
towej. Daja podobny efekt, jak zastosowanie prawych lub lewych wcig, ale
sa wygodniejsze w uzyciu, jesli pracujemy z tekstem informacyjnym umiesz-

czonym w kolorowym lub cieniowanym prostokacie.

Odstepy przed i po akapicie

Czas na nastepny slogan do zapamietania: nigdy, w zadnej sytuacji, pod zadnym

warunkiem nie wolno sie zgodzié, aby nasz dokument zawieral dwa lub wigcej

kolejnych koricéw akapitu. Ujmujac to inaczej — nigdy nie nalezy tworzy¢

poziomych odstepéw naciskajac klawisz Enter. Od reguty tej nie ma wyjatkéw —
aw kazdym razie zadnego nie umiem wymysli¢. Jeéli tekst, ktéry umieszczamy

w InDesignie, zawiera takie nadmiarowe kotice akapitéw (co jest bardzo prawdo-
podobne), trzeba je wyrzucié. Najprostszym sposobem osiagniecia tego celu jest

uzycie funkcji Find/Change i wstepnie zdefiniowanego zapytania GREP Multiple

Return to Single Return (Znaki tamania wiersza na jeden znak tamania).

Kto$ moégtby zada¢ pytanie: , Po co tyle hatasu? Dlaczego nie mozna wstawic
nieszkodliwego pustego wiersza pomiedzy akapity — przeciez nikomu nic sig
nie stanie”. I to jest prawda, poniekad. Storice nadal bedzie wschodzi¢ na wscho-
dzie i zachodzi¢ na zachodzie, jesli ktos uprze sie przy podtrzymywaniu takich
zachowan. Jednak istnieja dobre powody, aby unika¢ stosowania nadmiarowych
koncéw akapitéw:

® Wykorzystanie ich jako odstepéw miedzyakapitowych nie daje elastycz-
noéci w zakresie wielkoéci tego odstepu. Naci$nigcie Enter tworzy pusty
akapit o okreslonej wielkosci interlinii i odstepéw przed lub po.

m Jesli tekst plynie przez wiele ramek tekstowych (wiele faméw lub stron),
pusty wiersz wypadajacy w okolicach korica strony (na konicu lub poczatku
tamu) tworzy niepotrzebne wolne miejsce, ktérego w tym wypadku nie
potrzeba i ktérego byé nie powinno.

'EFue | Bl Zamiast dwukrotnego — albo co gorsza, jeszcze licz-
e o B o

tworzy¢ uzywajac opcji Space Before (Odstep przed) albo Space After (Odstep po)

niejszego — naciskania klawisza Enter odstepy nalezy

w sekcji formatowania akapitu palety sterujacej, panelu Paragraph lub w definicji
stylu akapitowego. Napisatem albo, gdyz uzywanie obu opcji jednoczesnie, cho¢
niekiedy niezbedne, tatwo prowadzi do nieporozumien. To, czy uzywamy gtéw-
nie odstepéw przed, czy po, jest raczej kwestia przyzwyczajenia — na przykiad
ja zawsze wolatem odstepy przed akapitami, totez gtéwnie tych uzywam. Bez
wzglqdu na to, ktéry wariant wybierzemy, nalezy sie go trzymac konsekwentnie.
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RYSUNEK 8.11 Oddzielanie akapitéw nalezy uzyskiwac opcja Space Before (albo Space After), a nie dodatkowym pustym akapitem.

Flowering begins along the s Flowering begins along the  Visitors who find it difficult

parks southern boundary Visitors who find it difficult parks southern boundary telling the “Hairy Sand

as early as February and telling the “Hairy Sand as early as February and Verbena" from a “Forget

at higher elevations in Verbena" from a“Forget at higher elevations in Me Not" might seek

March and April. Regions Me Not" might seek March and April. Regions further information in

over 4000 feet will show further information in over 4000 feet will show one of the parks visitor

blooms much later, notably  one of the parks visitor blooms much later, notably  centers. Flowers are often

the higher Bernardino centers. Flowers are often the higher Bernardino recognized first by color

mountain region. The recognized first by color mountain region. The group. They often carry

Joshua tree will flower in group. They often carry Joshua tree will flower in descriptive names such

February or March but descriptive names such February or March but as Canterbury Trumpet,

trees have been known to as Canterbury Trumpet, trees have been known to Enlemann Hedgehog and

skip a season. Enlemann Hedgehog and skip a season. Beavertail cactus.

Nadmiarowy ,Enter” pomiedzy akapitami powoduje Opcja Space Before jest ignorowana na poczatku famu

pojawienie sie pustego wiersza na szczycie famu i nie tworzy zbednego odstepu

Book the First— Recalled to Llfe RYSUNEK 8.12 Puste miejsce

A oznaczone A utworzone jes_t
poprzez odstep przed akapi-

I. The Period tem 2,The Period". Przestrzeri

B B tworzy odstep przed akapi-
tem 3. Ten sam efekt mozna
bylo osiagnac tworzac od-

stepy po akapicie 1i2.

age of wisdom, it was the age of foolishness, it was the epoch of
belief, it was the epoch of incredulity, it was the season of Light,

it was the season of Darkness, it was the spring of hope, it was the

Zapewniajac pelna elastycznoéé i precyzje w okreélaniu odstepéw miedzy aka-
pitami, s3 one wystarczajaco ,inteligentne”, aby znikna¢, gdy nie s3 potrzebne
(tak jak wowczas, gdy wypadaja na koricu lub poczatku tamu lub strony).

Sasiedztwo

Nalezy zadba¢ o to, aby odstepy miedzy akapitami raczej uwypuklalty zwiazek
pomiedzy kolejnymi partiami tekstu, a nie rozrywaly go. Méwiac wprost,
rzeczy, ktére s3 ze soba powigzane, powinny znajdowa¢ sie blisko siebie.
Porzadkowanie treéci w porcje informacji — na przyklad w podrozdziaty
i akapity — pomaga w nadaniu tekstowi odpowiedniego rytmu. Czytelnik
bedzie wéwczas interpretowal przerwy miedzy takimi porcjami jako pauzy,
sygnalizujace rozpoczecie nowej mysli w kolejnej porcji. Aby lepiej podkreéli¢
taki zwigzek, podtytuly powinny znajdowa¢ sie blizej tekstu, ktéry nastepuje
po nich, niz tekstu przed nimi. Moze sie to wydawa¢ oczywiste, ale regula
ta jest bardzo czesto tamana.
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Wazne jest tez, aby zwiazek logiczny pomiedzy podtytulem i nastepujacym
po nim tekstem nigdy nie byl niweczony przez podzial famu lub strony. Mozna
w tym celu wykorzysta¢ Keep Options (Opcje przenoszenia) w definicji stylu
nadawanego podtytutom, wlaczajac opcje Keep with Next (Razem z nastep-

nym) i nadajac jej warto$¢ 2 wierszy (wiecej informacji na ten temat zawiera

rozdzial 12, ,Globalne formatowanie przy uzyciu stylow”).

remains of the Blackfriars Rail Bridge, which once ran
parallel, are the red columns in the river and the brightly
colored cast-iron insignia of the company: London,
Chatham and Dover Railway.

Tate Modern

Giles Gilbert Scott, 1947-63

Jacques Herzog and Pierre de Meuron, 1995-2000

The Tate Modern is now one of the most successful and
popular art galleries in the world and LondonOs most pop-
ular free tourist attraction. The building was originally
Bankside Power Station, a monolithic steel construction

RYSUNEK 8.13 W przykiadzie po lewej podtytut,.ptywa” pomiedzy
akapitem poprzedzajacym i nastepnym, powodujac niepewnosc,
ktérego akapitu w istocie dotyczy. Po prawej podtytut jest jedno-
znacznie powiazany z tekstem nastepujacym po nim.

Zwiazek pomiedzy podtytutem i tekstem jest wymuszany przez
ustawienie Keep with Next.

remains of the Blackfriars Rail Bridge, which once ran
parallel, are the red columns in the river and the brightly
colored cast-iron insignia of the company: London,
Chatham and Dover Railway.

Tate Modern

Giles Gilbert Scott, 1947-63

Jacques Herzog and Pierre de Meuron, 1995-2000

The Tate Modern is now one of the most successful and
popular art galleries in the world and LondonOs most pop-
ular free tourist attraction. The building was originally
Bankside Power Station, a monolithic steel construction

- | Keep Lines Together
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Start: 52 lines

End: 152 lines
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Dzielenie (i niedzielenie)
stow, wierszy, akapitow
i stron

KOLEJNYM WAZNYM ASPEKTEM typografii jest kontrola nad tym, jak podziela
sie — albo jak s utrzymywane razem — stowa, wiersze i akapity, aby podkresli¢
znaczenie tekstu i usprawnic proces czytania. Na najnizszym poziomie mamy
tu opcje dzielenia wyrazdw, ktére okreslaja, czy i w jaki sposéb wyrazy mogg by¢
dzielone pomiedzy wiersze. Dodatkowo niektére kombinacje stow — na przy-
ktad tytuty naukowe i nastepujace po nich imiona lub nazwiska — réwniez nie
powinny by¢ oddzielane od siebie, co mozna osiggna¢ nadajac spacji pomiedzy
nimi atrybut No Break lub wymieniajac ja na spacje niedzielgca. Na bardziej
ogolnym poziomie uzyjemy opcji dostepnych w oknie Keep Options. Pozwa-
lajg one wymusi¢ niedzielenie akapitu albo okresli¢ minimalng liczbe wierszy
w oddzielonych czesciach, utrzymaé tytut lub podtytut razem z nastepujacym
tekstem, a takze zagwarantowac, ze okreslone klasy akapitéw beda zawsze

zaczynaly sie od nowej ramki lub strony.
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RYSUNEK 9.1 Wybieranie
stownika jezykowego dla me-
chanizmu dzielenia wyrazéw
w palecie sterujacej (A) lub

w opcjach stylu akapitowego
(B). Przyktad réznicy dzielenia
wyrazow wedtug stownika
jezyka angielskiego w wersji

amerykanskiej i brytyjskiej (C).

Dzielenie wyrazow

Dywiz, cho¢ jest znakiem drobnym, wzbudza nieraz emocje i uprzedzenia.
Niektérzy projektanci uwazaja, ze dywizy s brzydkie i ze nalezy ich unika¢
za wszelka cene — tak jakby podzielony wyraz byt czymé gorszym od stowa
nie zawierajgcego dywizu. Jednak uzyte wlasciwie, dzielenie jest praktycznym
narzedziem, ktére pozwala osiagna¢ najistotniejszy cel — jednolita szaroéé
bloku tekstu. Umozliwiajac tamanie stéw wypadajacych w poblizu krawedzi
bloku, dzielenie wyrazéw umozliwia maksymalne zmniejszenie nadmiarowej,
niewykorzystanej przestrzeni na koricu wiersza. Dopéki podzialy wykonywane
sa w zgodzie z gramatyka i logika danego jezyka, s3 lepszym wyjéciem, niz
nieré6wne odstepy w tekscie wyjustowanym lub wielkie nieréwnosci w sktadzie
choragiewkowym. Jestesmy przyzwyczajeni do dzielenia wyrazéw i nie utrudnia
to czytania — realizujemy to odruchowo, bez zastanawiania sie, rzadko tylko
(jesli w ogdle) zatrzymujac sie, gdy nieszczesliwy (niezreczny) podziat wyrazu
powoduje niejednoznacznoéé i wymaga chwili namystu, aby zrozumieé¢ tekst.

Reguly dzielenia wyrazéw sa zmienne nie tylko w zaleznosci od jezyka,
ale tez od ,podrecznika stylu” uzywanego w danym wydawnictwie. Wplyw
jezyka jest oczywisty — oczekujemy, ze stownik lotewski wlaczony w InDesignie
spowoduje podzialy stéw w innych miejscach, niz English:usa. Ciekawszym
(i mniej oczekiwanym) efektem jest to, ze stowa zostana podzielone inaczej, gdy
stownik jezyka angielskiego dla Stanéw Zjednoczonych zastapimy brytyjskim
(English:UK). Okazuje si¢ bowiem, ze brytyjskie reguly nakazuja dzielenie stéw
wedlug etymologii, za§ amerykanskie — wedlug wymowy. Jaki jest morat tej
historii? Zawsze musimy sprawdzi¢, czy wybralismy stownik wtasciwy dla

jezyka i regionu, w ktérym pracujemy.

=— Inge- Ingen-
== nious ious

English: USA Dictionary English: UK Dictionary
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Dzielenie wyrazéw moze by¢ czynnoécig pracochtonng. Dobre ustawienia
pozwola unikna¢ wiekszosci probleméw, ale InDesign nie jest w stanie przenik-
naé koncepcji autoréw (a méwiac wprost — nie rozumie tekstu!). Beda sie zdarzaé
sytuacje, w ktérych niezbedna bedzie interwencja, aby zapewnié, ze stowa
zostana podzielone tak, jak chcemy (lub jak by¢ powinny). Reczne korygowanie
dzielenia wyrazéw powinno zosta¢ wlaczone do planu ,koricowego szlifu” pub-
likacji. Wezesniejsze zabiegi sa strata czasu, gdyz tekst zawsze jest zmieniany
w trakcie procesu wydawniczego, co powoduje zmiany miejsc podziatu wierszy
isprawia, ze inne stfowa powinny (lub nie powinny) by¢ dzielone. Dopiero gdy
tekst uzyska ostateczny ksztalt, mozemy skupié sie na poprawianiu dzielenia
wyrazow. Warto wezesniej uzyskac akceptacje tekstu, aby mieé pewnosé, ze nie
bedzie juz w nim zadnych zmian. No i — co oczywiste — zawsze nalezy zaczyna¢
od samego poczatku tekstu i posuwaé sig naprzéd, bez ,,skoké6w” i nawracania
do wczeéniejszych czeéci.

Opcje dzielenia wyrazow

Ustalanie opcji dzielenia to jeden z tych obszaréw, ktérym stosunkowo niewielu
uzytkownikéw InDesigna poswieca uwage, choé¢ maja one znaczacy wplyw
na wyglad zlozonego tekstu. Okno dialogowe Hyphenation Settings (Ustawienia
dzielenia wyrazéw) jest dostepne za posrednictwem menu palety sterujace;j,
panelu Paragraph lub jako czeé¢ opcji stylu akapitowego.

Words with at Least (Wyrazy z przynajmniej)

Opcja ta odnosi si¢ do dlugosci wyrazu (wyrazonej jako liczba liter), ktéry moze
zosta¢ podzielony. Zwiekszenie tej wartosci z domyélnych 5 znakéw spowoduje
niedzielenie krétszych sléw i w konsekwencji zmniejszenie liczby podziatéw.

After First (Po pierwszych) i Before Last (Przed ostatnimi)

Opcje te maja nieco mylace nazwy, ale odnosza sie do minimalnej liczby liter
na poczatku lub na koricu wyrazu, ktére moga zostaé pozostawione w wierszu
lub przeniesione do kolejnego wiersza. Zasada podstawowa, ktéra mozna zasto-
sowa¢ w niemal kazdym jezyku, brzmi — zostawiamy co najmniej dwie litery
na koncu wiersza i przenosimy przynajmniej trzy. Jak dla kazdej reguly ogélnej,
od tej réwniez zdarzaja sie wyjatki. Jesli na przykiad dwie pierwsze litery tworza
przedrostek, zaréwno logika, jak i reguty ortografii nakazuja podziat w tym
miejscu. Stowa takie, jak ,realign” lub ,,reappear” moga sprawiaé mylace wraze-
nie, jeéli zostana podzielone po ,real” lub ,reap”, gdyz pozostawiony fragment
wyglada jak pelne stowo. Ustawienia dzielenia wyrazéw powinny zatem by¢ sta-
nowcze, ale elastyczne. Przenoszenia jedynie dwuliterowych koricéwek nalezy
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RYSUNEK 9.2 Pokazane

tu restrykcyjne ustawienia
dzielenia wyrazéw spowoduja
mniejsza liczbe podziatow.

o e G e b e e i _Hyphenation W b RS R e 5
— [ Hyphenate -
mmam@i? hﬁ“ :!
After First: =13 letters
Before Last: =3 letters L} Previee
Hyphen Limit: :!: 1 | hyphens
Hyphenation Zone: [31. 0 pt
el - |
Better Spacing = Fewer Hyphens 'm sﬁ
M Hyphenate Capitalised Words (| Hyphenate Last Word Ui/ Ooene... :
. No Break
] Hyphenate Across Column e b
Adabe Single-line Composer 2
Owly Align First Line to Grid i
Balance Ragged Lines
Justification... ~ox |
Keep Options... a4
Drop Caps and Nested Styles_.. TXR
CREP Styles... 7

zwykle unikad, ale zdarzaja sie sytuacje, w ktdrych taki wybér jest mniejszym
zlem. Zawsze jednak rozstrzygniecie zalezy najpierw od ustalenia, czy podziat
ma sens i jest zgodny z zasadami pisowni danego jezyka, a dopiero w dalszej
koniecznosci mozemy bra¢ pod uwage to, jak bedzie wygladaé.

Hyphen Limit (Limit dywizéw)
Ustawienie to okresla maksymalng liczbe dywizéw wystepujacych jeden
po drugim w kolejnych wierszach. W tekscie ksigzkowym nalezy zwykle
unika¢ wigcej niz dwéch kolejnych przeniesien’, aby uniknaé ,drabinki dywi-
z6w” na prawej krawedzi bloku tekstu. Mozna dyskutowac, czy zmniejszenie
tego ustawienia na 1 jest najlepsza metoda eliminowania powtarzajacych sie
dywizéw. Jeéli przylozymy sie nieco do pracy, mozemy osiagna¢ lepsze efekty
wstawiajac w tym polu zero, co pozwala na nieograniczong liczbe kolejnych
dywizdw, a nastepnie recznie korygujac problemy z nadmierna liczba podzialéw,
laczac takie metody dzialania, jak regulacja $wiatet i dodawanie uznaniowych
miejsc podziatu.

Oto kilka wskazéwek pozwalajacych na eliminacje ,drabinek” i eliminacje
powtarzajacych sie podzialéw:

= Wyszukanie lepszego miejsca podzialu kilka wierszy wczeéniej i wsta-
wienie miekkiego dywizu: Cmd/ Ctrl+Shift+- (dywiz z klawiatury).

1 Polskie standardy typograficzne dopuszczaja trzy kolejne przeniesienia wyrazéw
w skladzie ksigzkowym, w ktérym przecigtna dlugosé wiersza przekracza 60 znakéw
i wieksza liczbe przy wezszych tamach.
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Whereas disregard and contempt for Whereas disregard and contempt for ~ RYSUNEK 9.3 Ustawienie
human rights have resulted in bar- ~ human rights have resulted in bar- ~ ¥PhenLimit na wartos¢ 3
. N (po lewej) i 1 (po prawej).

barous acts which have outraged the barous acts which have outraged

conscience of mankind, and the the conscience of mankind, and

vent of a world in which human the advent of a world in which hu-

ings shall enjoy freedom of speec man beings shall enjoy freedom of

and belief and freedom from fear speech and belief and freedom from

and want has been proclaimed as fear and want has been proclaimed

the highest aspiration of the com- as the highest aspiration of the com-

mon people. mon people.

® Wyszukanie wiersza lub wierszy, w ktérych mozna zmniejszy¢ swiatlto
miedzyliterowe, aby zmieni¢ punkt podziatu wiersza.

® Znalezienie najciaéniejszego wiersza z podzialem wyrazu i nadanie
ostatniemu wyrazowi atrybutu No Break, co spowoduje przeniesienie
go w catosci do kolejnego wiersza®.

® Przeredagowanie tekstu, o ile mamy takie upowaznienie i moze ono

zapewnié pozadany efekt.

Hyphenation Zone (Strefa dzielenia wyrazéw)

Whbrew atrakcyjnej nazwie, opcja ta oznacza jedynie niewidzialng granice
odmierzang od prawego marginesu. Wieksza wartos¢ tego parametru pozwala
na przerzucanie dluzszych stéw do kolejnego wiersza, tym samym powodu-
jac zmniejszenie liczby podzialéw i bardziej nieréwny prawy brzeg. Mniejsza
warto$é wymusza wigkszg liczbe podzialéw i ,,splaszczenie” prawej krawe-
dzi. Uzyteczno$¢ tej opcji jest jednak ograniczona, gdyz ma ona znaczenie
tylko w skladzie w choragiewke i jest ignorowana w tekécie wyjustowanym,

Suppose we wish to copy by the Suppose we wish to copy by the RYSUNEK 9.4 Opcja

Daguerreotype, or Calotype process, Daguerreotype, or Calotype process, Hyphenation Zone dotyczy
tylko wyréwnania do lewej

any objects highly colored-blue, red any objects highly colored-blue, red ik ia 2 Sinale Li
and yellow, for instance predominat- and yellow, for instance predominat- éo?r:zystama zSingle Line
N X poser.

ing- the last of course reflects the ing- the last of course reflects the most

most light, the blue the least; but the light, the blue the least; but the rays

rays from the blue surface will make from the blue surface will make the

the most intense impression, whilst most intense impression, whilst the red

the red radiations are working very radiations are working very slowly, and

slowly, and the yellow remains en- the yellow remains entirely inactive.

tirely inactive. This accounts for the This accounts for the difficulty

difficulty experienced in copying experienced in copying bright green

2 Ten sam efekt mozna osiagna¢, wstawiajac miekki dywiz na poczatku wyrazu (przed
pierwszym znakiem).
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chicken-houses? But it was no
use, he could not remember:
nothing remained of his child-
hood except a series of bright-lit
tableaux occurring against
no background and mostly
unintelligible.

chicken-houses? But it was no
use, he could not remember:
nothing remained of his child-
hood except a series of bright-lit
tableaux occurring against no
background and mostly unin-
telligible.

RYSUNEK 9.5 Zazwyczaj
lepiej unikac dzielenia ostat-
niego wyrazu w akapicie

(u gory), ale jesli to stowo jest
bardzo dlugie, a tam waski, po-
dzielenie go poprawi spacjo-
wanie catego akapitu (u dotu).

a ponadto dziala tylko przy korzystaniu z Single Line Composer (ukladacza
jednowierszowego).

Suwak

Przy dazeniu do dobrego (réwnomiernego) spacjowania i zmniejszania liczby
podzialéw zawsze mamy do czynienia z sytuacja ,,co$ za co§”, szczeg6lnie
w skladzie wyjustowanym. Nic nie demonstruje tego tak wyraznie, jak suwak
umieszczony ponizej opcji dzielenia. Lepsze odstepy albo mniej podzialéw:
mozemy wybra¢ tylko jedno z dwojga albo, co moze by¢ najlepszym wyjsciem,
pozostawi¢ suwak w jego domyslnym, srodkowym polozeniu.

Hyphenate Capitalized Words

(Dzielenie wyrazéw pisanych wielka literg)?

Opdja ta dziata dokladnie tak, jak sie nazywa. Zazwyczaj bedziemy woleli unika¢

dzielenia nazw wlasnych, imion i nazwisk, jesli jednak wystepuja one czesto

lub jest ich bardzo wiele (albo jedno i drugie), zaznaczenie tej opcji pozwoli

na lepsze wyréwnanie odstepéw miedzy wyrazami. Jesli jednak zdecydu-
jemy sie na dzielenie wyrazéw pisanych wielka litera, nalezy stara¢ sie unika¢

podziatu jakiego$ nazwiska, gdy pojawia sie ono po raz pierwszy — p6zniej

mozemy na to pozwoli¢, o ile da nam to w efekcie lepsza szaros¢ bloku tekstu.
Warto tez zauwazy¢, ze pospolite, czesto spotykane nazwiska i nazwy latwiej

beda rozpoznawalne mimo podziatu, niz takie, ktére czytelnik spotyka rzadko,
zatem warto uwzglednié réwniez i to kryterium.

Hyphenate Last Word (Podziel ostatni wyraz)

Opdja ta to sposéb na unikniecie dzielenia ostatniego wyrazu akapitu. Usuniecie
zaznaczenia spowoduje, ze ostatni wiersz nigdy nie bedzie zawieral tylko
fragmentu slowa — co zazwyczaj jest dobre i godne zalecenia. Jednak nawet
ta zasada nie zostala wykuta w kamieniu: jesli ostatnie stowo akapitu jest bardzo
dlugie, mozemy rozwazy¢ jego podzial, szczegélnie przy stosunkowo waskich
tamach. Opcje te nalezy zwykle dotaczyé¢ do definicji stylu akapitowego, aby
wyeliminowa¢ dzielenie ostatnich sléw w wiekszosci przypadkoéw, a tylko w tych
nielicznych, gdzie podzial jest usprawiedliwiony, zmienié¢ j3 recznie. W tym celu
nalezy po zaznaczeniu akapitu (albo po prostu umieszczeniu w nim kursora
tekstowego) wywolaé okno dialogowe Hyphenation i wlaczy¢ te opcje.

3 W polskiej wersji interfejsu InDesigna wystepuje oczywisty btad przektadu: ,Dzielenie
wyrazéw pisanych duzymi literami”. Nie chodzi o akronimy i inne stowa ztozone
wersalikami, ale o wyrazy, ktore maja tylko pierwsza wielka litere.



Rodzaje dywizow

Majac okoto 1/3 firetu diugosci, w wiekszosci fontdw dywiz jest brzydki, brutalny
i krotki — i czesto mozna podmieni¢ go dywizem z innego fontu, a nikt tego nie
zauwazy. W niektoérych krojach jednak dywizy sa bardzo charakterystyczne —
i piekne. Cytujac Roberta Bringhursta, ,w republice typografii nawet najmniej
znaczacy, najbardziej przypadkowy znak jest pelnoprawnym obywatelem”
[Elementarz stylu w typografii, str. 86].

Dywizy miekkie i twarde

Dywiz miekki (discretionary hyphen), wywolywany skrétem Cmd/Ctrl+Shift+-
(dywiz z klawiatury), jest przydatny, gdy stowo, ktére chcemy podzieli¢, nie
figuruje w uzywanym stowniku lub gdy chcemy dokonaé podziatu w innym miej-
scu, niz wybrane przez algorytm programu. Dywizy miekkie sa na tyle dobrze
wychowane, ze znikaja, gdy nie s3 potrzebne. Jesli tekst zostanie przeredago-
wany tak, ze recznie podzielone stowo nie wypada juz w poblizu korica wiersza,
dywiz miekki stanie si¢ niewidoczny. Tym samym miekkie dywizy sa lepsza
metoda korygowania podzialéw wierszy, niz wymuszone zlamania wiersza

t was a bright cold day in April, and the clocks were striking thir-
teen. Winston Smith, his chin nuzzled into his breast in an effort
to escape the vile wind, slipped quickly through the glass doors
of Victory Mansions, though not quickly enough to prevent a swirl of

t was a bright cold day in April, and the clocks were striking
hirteen. Winston Smith, his chin nuzzled into his breast in
an effort to escape the vile wind, slipped quickly through the
glass doors of Victory Mansions, though not quickly enough to

t was a bright cold day in April, and the clocks were striking
thirteen. Winston Smith, his chin nuzzled into his breast in an
effort to escape the vile wind, slipped quickly through the glass
doors of Victory Mansions, though not quickly enough to prevent a

t was a bright cold day in April, and the clocks were striking thirteen.
Winston Smith, his chin nuzzled into his breast in an effort to escape
the vile wind, slipped quickly through the glass doors of Victory
Mansions, though not quickly enough to prevent a swirl of gritty dust
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@ Vag Rounded

-

Adobe Jenson Pro

-

Goudy Old Style

MW Hiroshige
RYSUNEK 9.6 Kilka przy-
ktadow réznych ksztattow
dywizow

RYSUNEK 9.7 Miekkie dywizy
sg lepsza metoda korygowania
zlych podziatéw, niz wymu-
szone ztamania wiersza.

Btedny podziat na koricu
pierwszego wiersza.

Dodanie korica akapitu (Enter)
przed problematycznym
stowem pogorszylo jeszcze
sytuacje, gdyz nowy akapit
odziedziczyt formatowanie
pierwszego akapitu.

Zmiana korica akapitu na wy-
muszone zlamanie wiersza
naprawia sytuacje, ale powo-
duje, ze pierwszy wiersz jest
zbyt luzny.

Poprawienie bledu dzielenia
poprzez dodanie miek-
kiego dywizu przed stowem
Jthirteen”.
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The quick brown
fox jumped over
the www.web-
address.com

The quick brown
fox jumped

over the www.
web-address.com

RYSUNEK 9.8 Niedzielacy
dywiz chroni adres Web przed
podzieleniem w miejscu
dywizu, ale nie zabezpiecza
przed podziatem w innym
punkcie,
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uzyskiwane przez Shift+Enter. Jesli uzyjemy wymuszonych ztaman wierszy,
mogg one pézniej powrdci¢, by sie zemscid, jesli tekst zostanie przeredagowany,
a dyskusyjne miejsce znajdzie sie¢ w srodku wiersza, a nie na jego koricu.

Migkki dywiz ma jeszcze jedno zastosowanie: umieszczenie go na poczatku
wyrazu powoduje, ze dane stowo w ogéle nie zostanie podzielone.

Twarde lub niedzielgce dywizy (nonbreaking hyphen), uzyskiwane kombina-
cja Cmd+Option+dywiz (Ctrl+Alt+dywiz) stuza do wstawienia dywizu, ktéry
zawsze jest widoczny, ale ktéry nie zostanie uzyty jako miejsce podziatu wier-
sza. Samo jego uzycie nie powoduje jednak, ze fraza nie zostanie podzielona
w innym miejscu. Typowymi zastosowaniami twardych dywizéw s3 np. numery
telefonéw lub adresy Web.

Dokumenty wielojezyczne

InDesign CS5 wyposazony jest w 39 stownikéw, obstugujacych 27 jezykéw, z czego

czes¢ w kilku odmianach regionalnych (angielski, niemiecki, holenderski, nor-
weski i portugalski)*. Stownik, ktéry zostat przypisany do tekstu, okreéla sposéb

jego dzielenia, a takze sprawdzanie pisowni. Jesli pracujemy z dokumentem

wielojezycznym, co nie jest niczym nadzwyczajnym w takich krajach, jak Kanada

lub Szwajcaria, trzeba przede wszystkim pilnowa, aby przypisa¢ whasciwy jezyk

i stownik do odpowiednich fragmentéw tekstéw. Nawet jesli chodzi tylko o nie-
wielki cytat — na przyktad pojedynczy akapit w obcym jezyku — nalezy wybra¢

dla niego wiasciwy stownik, aby tekst mégt zosta¢ podzielony zgodnie z requ-
tami danego jezyka.

Dzielenie wyrazow i stownik uzytkownika

Jesli dany wyraz — czesto bedzie to termin techniczny, nazwa wlasna lub
wykrzyknik — nie wystepuje w wybranym stowniku, mozna zechcie¢ dodaé
go do wlasnego stlownika uzytkownika, dzieki czemu zostanie rozpoznany
w pézniejszych pracach. Po wstawieniu kursora do tego stowa nalezy klikna¢
prawym przyciskiem myszy (albo przytrzymacé Ctrl i klikng¢, jeéli nasz kom-
puter to Mac z jednoprzyciskowa mysza), po czym wybra¢ Spelling > Dictionary
(Pisownia > Stownik). Przycisk Add (Dodaj) pozwala dotaczyé stowo do stownika
uzytkownika.

4 Dla jezyka polskiego InDesign zawiera dwie wersje stownika, opracowane przez
firmy Winsoft oraz Proximity. R62nig sie one w niewielkim stopniu, jesli chodzi
o dzielenie wyrazéw, natomiast znaczaco, gdy uzyjemy ich do sprawdzania pisowni
(stownik Winsoft jest znacznie obszerniejszy).
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Jesli podczas dodawania stowa chcemy okresli¢ preferowane miejsca podziatu,
po wyéwietleniu okna Dictionary nalezy kliknaé Hyphenate (Dziel wyrazy),
aby zobaczy¢ sugerowane przez program miejsca podzialu. Mozna nastepnie
usunaé sugerowane i doda¢ wlasne punkty podziatu, wstawiajac znak tyldy (~)
w odpowiednich miejscach. Mozemy réwniez okresli¢ ,ranking” tych miejsc.
Pojedyncza tylda oznacza najlepszy (preferowany) punkt, podwéjna miejsce,
ktére powinno zostaé wybrane w nastepnej kolejnosécii tak dalej. Jesli chcemy,
aby wyraz w ogéle nie podlegal dzieleniu, tylde nalezy wstawi¢ przed jego
pierwszym znakiem.

Notin Dictionary: L W oo )
e )
Suggested Correcti ( ignore Al ) _

( Change Al ) |

@

_| Case Sensitive

Udostepnianie i taczenie stownikow uzytkownika

Jesli pracujemy w zespole, trzeba zadbac o to, aby wszyscy jego czlonkowie
uzywali tego samego stownika uzytkownika, aby w dokumencie byly stosowane
te same reguly dzielenia wyrazéw bez wzgledu na to, kto akurat nad nim pra-
cuje. Jakkolwiek mozliwe jest, aby wielu uzytkownikéw wykorzystywalo ten
sam slownik w trybie do odczytu, tylko jedna osoba powinna mie¢ mozliwos¢
dodawania lub edytowania zawartych w nim wyrazéw. Z tego wzgledu trzeba
przypisac tej osobie odpowiedzialnoé¢ za niestandardowy stownik.

Jeéli przyjmiemy, Zze to na nas spoczywa ta odpowiedzialnoéé, mozemy
udostepni¢ nasz stownik innym cztonkom zespolu, otwierajac okno preferencji,
przechodzac do sekeji Dictionary (Stownik) i klikajac ikone New User Dictionary
(Nowy stownik uzytkownika). Po nadaniu nazwy stownikowi zapisujemy go
w folderze, do ktérego dostep maja inni czlonkowie zespolu — na przyktad
na serwerze plikéw. Plik ten otrzyma rozszerzenie .udc, identyfikujace go
jak stownik programu InDesign. Po kliknieciu OK na liicie pojawia sie dwa
slowniki — domy$lny i nowo utworzony. Przy sprawdzaniu pisowni InDesign

RYSUNEK 9.9 Dodawanie

wyrazu do stownika uzytkow-
nika i jednoczesne okreslanie
wiasciwego punktu podziatu.
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WSKAZOWKA: Najszybsza
metoda dodawania
wyrazow do stownika
uzytkownika jest sporza-
dzenie pliku tekstowego
zawierajacego stowa, ktére
chcemy dofgczy¢, po czym
wybranie polecenia Edit >
Spelling > Dictionary (Edytuj
> Pisownia > Stownik)

i zaimportowanie tego
pliku. Nastepnie mozna
uzupetniac ten stownik

w razie potrzeby, uzywajac
opisanej wczesniej techniki
dodawania stow.

RYSUNEK 9.10 Tworzenie

i udostepnianie stownika
uzytkownika (po lewej).
Alternatywnie mozna dofaczy¢
stownik uzytkownika do doku-
mentu (po prawej).

najpierw wyszuka wyraz w stowniku domyélnym, a nastepnie w stowniku nie-
standardowym. Jesli zaden z nich nie zawiera sprawdzanego sfowa, zostanie
ono wyréznione jako — by¢ moze — bledne.

Kazdy czlonek zespotu moze teraz zatadowa¢ niestandardowy stownik,
wybierajac polecenie Preferences > Dictionary, klikajac symbol plus w celu dodania
stownika i wskazujac udostepniony plik na serwerze.

Alternatywnie mozna dolgczy¢ stownik uzytkownika do dokumentu
InDesigna. W tym celu na karcie Dictionary preferencji programu nalezy zazna-
czy¢ opcje Merge User Dictionary into Document (Dolacz stownik uzytkownika
do dokumentu). Zaletg tego rozwigzania jest to, ze o jedna rzecz nie musimy
sie juz martwi¢ — mamy pewno$¢, ze tekst zostanie podzielony w taki sam
sposéb, jesli dokument zostanie otwarty na innym komputerze, przez innego
uzytkownika. Z drugiej jednak strony nie bedziemy mogli stosowa¢ tego samego
stownika uzytkownika dla wielu dokumentéw.

Zapisywanie stownika uzytkownika

Co robi¢, a czego unika¢
przy dzieleniu wyrazéw

TAK: Sprawdzic¢ stownik jezyka. Reguly dzielenia (i pisowni) wyrazéw zmie-
niaja si¢ w zaleznosci od jezyka okreslonego dla danego tekstu i stownika
wybranego dla tego jezyka w preferencjach programu. Jezyk dla tekstu okre-
$la lista Language (Jezyk) w palecie sterujacej, ale lepszym rozwigzaniem jest
ustawienie go jako czesci definicji stylu akapitowego. Domyslny jezyk mozna
okresli¢ na karcie Dictionary w preferencjach programu.

TAK: Wysuniecie dywizéw. Opcja optycznego wyréwnania margineséw
pozwala nieznacznie wysuna¢ dywizy poza prawa krawedz famu, dzieki czemu



wydaje sie prostszy, niz przy faktycznie (geometrycznie) wyréwnanym brzegu.
Wigcej informacji na ten temat zawiera rozdzial 7, ,Wyréwnanie”.

TAK: Sprawdzi¢ miejsca podzialu w stowniku ortograficznym. Przy wsta-
wianiu migkkich dywizéw nalezy przestrzega¢ regul ortograficznych. Zasady

podzialu zmieniaja sie w zaleznosci od jezyka i nie da sie podaé uniwersalnej

reguly, stad zalecenie sprawdzenia w wydawnictwie zrédlowym. Warto tez

pamietad, ze przed regula podzialu na sylaby pierwszenstwo ma zasada kon-
strukcyjna — jesli na przyklad wyraz zawiera przedrostek, wlasciwym punktem

podzialu bedzie miejsce pomiedzy przedrostkiem a rdzeniem. Stowo przedrostek

podzielimy zatem przed-rostek, a nie prze-drostek. Podobny przyklad z jezyka

angielskiego (re-appear) zostal wspomniany wczeéniej w tym rozdziale.

NIE: ,Glupie” podzialy. Nalezy unika¢ podzialtu, ktéry tworzylby czastki samo-
dzielnie bedace stowami o innym znaczeniu, jak the-rapist lub crap-ulous.

NIE: Dzielenie tytulariéw lub tekstu wyréwnanego do prawej albo wysrod-
kowanego. W takich sytuacjach nalezy sie upewnié¢, ze definicja odpowiedniego
stylu ma wylaczong opcje dzielenia wyrazéw.

NIE: Dzielenie stéw koniczacych akapit. Opcja Hyphenate Last Word powinna
by¢ z zasady wylaczona i wlaczana recznie tylko w wyjatkowych sytuacjach.

NIE: Dwukrotne dzielenie wyrazu. Moze sie¢ to przytrafi¢, jesli mamy dlugie

stowo zlozone z tacznikiem utworzonym przy uzyciu twardego dywizu, ktére

wypada w poblizu korica wiersza i musi zosta¢ podzielone. Twardy dywiz unie-
mozliwia podzial, zatem pojawi sie drugi podziat sylabe wczesniej lub péznie;j.
W takiej sytuacji mozna zastosowa¢ opcje No Break dla odpowiedniej czesci

zlozonego wyrazu, aby unikna¢ podziatu®.

NIE: Stosowanie wiecej niz dwéch kolejnych podzialéw. Nadmierna liczba
dywizéw na prawym marginesie tworzy brzydko wygladajaca ,drabinke” lub

.szczecing”. Taka sytuacje mozna zwykle wyeliminowaé, modyfikujac miejsce
podzialu lub ustawiajac dla jednego z tych stéw opcje No Break®.

5 W jezyku polskim wyrazy ztozone moga byé dzielone w miejscu tacznika, ale wyma-
gane jest wéwczas powtdrzenie dywizu na poczatku kolejnego wiersza. Mozna
to osiagnaé, stosujac sekwencje ,miekki dywiz — twardy dywiz” — w miejscach
oddalonych od korca wiersza widoczny bedzie tylko pojedynczy twardy dywiz,
a przy przeniesieniu dywiz pojawi sie dwukrotnie, na koficu i poczatku wiersza.

6 Zalecenie to dotyczy w zasadzie tylko jezyka angielskiego. W jezyku polskim,
ze wzgledu na wigksza $rednia dtugosé stowa, dopuszczalne sg trzy kolejne przenie-
sienia w skladzie ksigzkowym (w ktérym wiersz zawiera $rednio ponad 60 znakéw),
ado pieciu w skladzie wezszym (ponizej 5o znakéw). Dla sktadu gazetowego w waskich
tamach limitu nie okreéla si¢ w ogéle.
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WSKAZOWKA: Poniewaz
opcja ta jest ukryta dos¢
gteboko w menu palety
sterujacej, warto stworzyc
dla tego atrybutu wlasny
skrét klawiszowy.

Naruszenia dzielenia wyrazéw i justowania

Ustawienia dzielenia wyrazéw i justowania sg bardzo wazne, ale nawet przy
najlepszych InDesign nie dokona niemozliwego. Istnieja sytuacje, w ktérych
nie bedzie mégt stosowac sie do narzuconych parametréw. Wybranie opcji
H&J Violations (Naruszenia dzielenia wyrazéw i justowania), wspomnianej juz
w rozdziale 7, powoduje pods$wietlenie trzema odcieniami koloru zéitego wierszy,
ktére wykraczaja poza okreslone przez nas ustawienia justowania i dzielenia
wyrazow. Im ciemniejszy odcien, tym powazniejszy jest problem. Podobnie jak
opcja wyswietlania niestandardowych Swiatet, wlaczenie tej mozliwosci zwykle
przeszkadza podczas projektowania kolejnych stron, ale jest bardzo przydatne
podczas ,dopieszczania szczeg6téw” na koniec pracy.

Atrybut No Break

Atrybut No Break (Bez dzielenia) w pewnym stopniu nak}ada si¢ w swoim zakre-
sie stosowania na dzialanie niedzielacej spacji i miekkiego dywizu. Jesli chcemy,
aby okreslone slowo lub fraza nie zostaly podzielone, mozemy je zaznaczy¢
i wybrac opcje No Break z menu palety sterujacej. O ile wstawienie w takiej
frazie niedzielgcych spacji nadal pozwala na podzielenie wyrazéw, uzycie
No Break gwarantuje, ze zaznaczone slowa nie zostana pofragmentowane. Ten
sam efekt mogliby$my osiagna¢, stosujac oprédcz niedzielacych spacji miekkie
dywizy na poczatku poszczegélnych stéw, ale uzycie pojedynczego atrybutu
dla calej frazy jest po prostu wygodniejsze.

Oprécz nazw wlasnych czy tez sléw o szczegélnym znaczeniu, atrybut ten
moze by¢ uzyteczny w nastepujacych sytuacjach:

m Zabezpieczenie sie przed wystapieniem stowa ,1” na konicu wiersza.

® Zabezpieczenie przed pojawieniem sie pauzy lub pétpauzy na poczatku
wiersza.

® Wyeliminowanie ”wiszécych spéjnikéw”, czyli krétkich (jedno- lub dwu-
literowych) stéw na koricu wiersza’.

® Powiazanie ze soba wyrazen zawierajacych liczby, takich jak ,2 kg”, ,8 cali”,
»May 23" lub ,Rozdzial 9”.

Wyeliminowanie rozpoczynania dwéch lub wiecej kolejnych wierszy

od tego samego wyrazu.

7 Wjezyku angielskim zastrzezenie to dotyczy tylko przedimkéw stanowiacych czeéé
tytulu. W jezyku polskim (a takze czeskim) dotyczy bezwzglednie wszystkich jed-
noliterowych wyrazéw (spéjnikéw), a — w opinii wielu ekspertéw — powinno by¢
stosowane réwniez do wiekszosci wyrazéw dwuliterowych.
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Every single surface of a modern For-  Every single surface of a modern RYSUNEK 9.11 Niedzielace
mula One car, from the shape of the Formula One car, from the shape of spacje pozwalaj na dzielenie

suspension links to that of the driver’s  the suspension links to that of the wyrazow, kiGrym towarzysza.
No Break pozwala utrzymac

Niepodzielna spacja pomiedzy .,Formula”i ,One”  Opcja No Break dla catego wyrazenia caly fraze w jednym wierszu.

Tym, co stanowi prawdziwg przewage atrybutu No Break wzgledem niedzielacych =~ WSKAZOWKA: Aby
spacji i migkkich dywizéw, jest fakt, ze moze on stanowi¢ czes¢ stylu znakowego, ~ zobaczyc, gdzie zostat
zastosowany atrybut
No Break, mozna chwi-
lowo zmieni¢ kolor tekstu
na pewno nie zostana one podzielone pomiedzy dwa wiersze. dla stworzonego stylu
Oto przyklad, jak mozna zrealizowac¢ taki styl: znakowego, nada¢ mu pod-
kreslenie albo przekreslenie,
1. Na poczatek utworzymy styl znakowy. W palecie Character Styles (Style dzigki czemu wszystkie
miejsca jego stosowania
stang sie jawnie widoczne.

aw konsekwencji moze by¢ aplikowany automatycznie jako styl GREP dla nazw
wlasnych iinnych ciaggédw tekstu, ktére spelniaja pewne warunki, dzieki czemu

znakowe) wybieramy New Character Style (Nowy styl), nadajemy mu nazwe
(np. ,No Break”), po czym na karcie Basic Character Formats (Podstawowe
formatowanie znakéw) zaznaczamy opcje No Break (Bez dzielenia).

2. Definiujemy styl GREP dla stylu akapitowego, w ktérym ma by¢ stosowany
warunek niedzielenia stéw. Po kliknieciu prawym klawiszem nazwy
stylu w palecie Paragraph Styles (Style akapitowe) wybieramy Edit z menu
podrecznego, po czym otwieramy karte GREP.

3. Klikamy przycisk New GREP Style (Nowy styl GREP), po czym wybieramy
z listy rozwijanej Apply Style (Zastosuj styl) ,No Break”. W polu To Text
(Do tekstu) wpisujemy regule identyfikujaca nasz tekst. Na przyklad, aby
zastosowaé go do pewnych nazw wtasnych, mozemy wpisac je kolejno,
rozdzielajac znakami | (pionowsa kreska).

RYSUNEK 9.12 Stosowanie stylu
znakowego jako stylu GREP.
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RYSUNEK 9.13 Menu Insert
Break Character (po lewej) oraz
odpowiadajace poszczegdl-
nym znakom opcje karty Keep
Options w definicji stylu akapi-
towego (po prawej).

Znaki tamania

Menu podrzedne Insert Break Character (Wstaw znak tamania), dostepne w menu
Type (Tekst), a takze w menu podrecznym narzedzia Tekst, zawiera kilka réz-
nych znakéw powodujacych ztamanie ciaglosci tekstu. Oprécz korica akapitu
(Paragraph Return), uzyskiwanego naci$nigciem klawisza Enter, najbardziej
znanym z nich jest Forced Line Break (Wymuszone tamanie wiersza), wymie-
nione juz kilkakrotnie we wczesniejszych rozwazaniach, a ktére powoduje
przejscie do nowego wiersza bez rozpoczynania nowego akapitu (Shift+Enter).
Dzigki temu mozemy uniknaé niepozadanego wciecia lub odstepu zwigzanego
z atrybutami akapitu. Wymuszone ztamanie wiersza jest réwniez jednym z pod-
stawowych sposob6w ksztaltowania bloku tekstu sktadanego w choragiewke,
a takze przy wprowadzaniu podzialéw odzwierciedlajacych sens, szczegélnie
w tytulach.

Discretionary Line Break (Migkki podzial wiersza) dziala podobnie do wymu-
szonego podzialu, ale ma te zalete, ze znika, gdy wypadnie w oddaleniu od konica
wiersza — okre$la po prostu miejsce, w ktérym wiersz ma by¢ podzielony, ale
jedynie wéwczas, gdy podzial tak czy inaczej wypadiby w poblizu.

Pozostale rodzaje znakéw lamania dzialaja zgodnie z tym, co sugeruja ich
nazwy. Wstawienie ich w pozycji kursora wprowadza do tekstu niewidoczny
symbol, ktéry mozna jednak zobaczy¢, gdy wlaczymy wyswietlanie znakéw
ukrytych: . ¥ ® & *: Wstawienie jednego z nich wymusza rozpoczecie tekstu
od nowego famu, w kolejnej ramce, na nastepnej stronie, na kolejnej stronie
nieparzystej lub parzystej — zgodnie z nazwa. Jeéli jednak mozemy przewidzie¢
z gory potrzebe takiego ztamania cigglosci — na przyklad jesli chcemy, aby
wszystkie rozdzialy rozpoczynaly sie na prawych (nieparzystych) stronach
ksiazki — preferowana metoda jest wykorzystanie opcji przenoszenia w defi-

nicji stylu akapitowego.
| Tvpe | it e s S O 0 e A
Font > o Sayhe Marmes Thapter Head '
Size » R e
3 L S L U e T ol e B ¥
Character =T | g 3
Paragraph <%t | - e
Tabs oXT | I | et 0 e
Glyphs Xom' i = (- B Lints Together
Srory o ok A Lines i Paragraph E
Character Styles - P S 2 b |
Patagraoh 4 - :::-—- | ek 2 L] ]
- T SpaE » "“'"':"-: i Coemn .
Column Break = - i ::rm
Fill with Placeholder Text Framve Break o= | A i
i Break x= | g
Show Hidden Characters R o e wreak i ———
| Even Page Break i
Paragraph Return i
Forced Line Break o |
Discretionary Line Break )
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Keep Options (Opcje przenoszenia)

Oprécz sterowania utrzymywaniem razem wierszy akapitu, oméwionego wczes-
niej, Keep Options pozwalaja okresli¢, jak akapit przemieszcza sie pomiedzy
kolejnymi ramkami. Opcje Keep with Previous (Razem z poprzednim) oraz Keep
with Next (Razem z nastepnym) pozwalaja zagwarantowad, ze podtytuty nie
zostang oddzielone od tekstu, ktéry nastepuje po nich. Nadanie pierwszemu
akapitowi tekstu gléwnego atrybutu Keep with Previous zapewni, ze tytul nie
znajdzie sie¢ osamotniony na koricu tamu, ale wymusi obecnoéé tylko jednego
wiersza teksu gléwnego w tym miejscu. Lepszym rozwigzaniem jest nadanie
nagléwkowi atrybutu Keep with Next i okreslenie minimalnej liczby wierszy
kolejnego akapitu, ktére musza towarzyszy¢ temu nagtéwkowi.

Opcje w sekcji Keep Lines Together (Nie dziel wierszy) umozliwiaja wymusze-
nie trzymania w calos$ci calego akapitu albo okreslenia, jak wiele poczatkowych
i koficowych wierszy musi znajdowa¢ sie w tym samym lamie. Pozwala sie
to zabezpieczy¢ przed powstawaniem szewcéw i bekartéw, co oméwitem juz
w rozdziale 5, ,Odstepy miedzyliterowe, $wiatla i kerning”. Nie jest to jednak
wygodne rozwiazanie, jeéli zalezy nam na wyréwnaniu taméw, aby koniczyty
sie na tej samej linii bazowe;j.

Lista Start Paragraph (Poczatek akapitu) pozwala narzucié¢ przejscie akapitu

do nowego tamu, ramki, strony i tak dalej. Opcje te s3 szczegdlnie przydatne

s . . . e - Highli
dla akapitéw zawierajacych numery lub tytuly rozdziatéw. ﬂhh o
Oczywiste, ze akapity musza sig jako$ dzieli¢. Zadanie niemozliwego i usta- (] Had Violations
wianie zbyt wielu opcji przenoszenia spowoduje powstawanie naruszen, ktére [_] Custom Tracking/Kerning

mozna uwidocznié, wybierajac opcje Keep Violations (Naruszenia zasad) w pre-

ferencjach sktadu (Preferences > Composition). Przede wszystkim jednak moze RYSUNEK 9.14 Wiaczanie
opcji wyswietlania naru-

spowodowac, ze tekst bedzie ,uciekal” z ramki, a w skrajnym przypadku spo- V% przenoszenia wierszy

woduje, ze cala reszta tekstu pozostanie nieumieszczona. i akapitow.
Ro eumsandion vel ullutpat enibh el ilit la-  vulput lut diat lorper sed tat. Os aute cons i ey Options
oreril iustrud molor juscilit, si. alit ulluptate dolessisl ut auguer adigniat ke with Previous

Oboreriurem etue vullan ulput ulputat. Irit
in utpat alis er illandi psuscin henisi.

Podtytut

Umsan hent alit am, cor sequi blam, conum

volore feum zzrit ut la ad tis aut augueros
adit adio core conse delit, volortie dunt
nit ilisim dolortisim volor aliquat. Duip
eu feugiatumsan ulla facillam vero enibh
eriustrud magnim eugue feugiam velit amet

Ro eumsandion vel ullutpat enibh el ilit la-
oreril iustrud molor iuscilit, si.
Oboreriurem etue vullan ulput ulputat. Irit
in utpat alis er illandi psuscin henisi.

Podtytul

Umsan hent alit am, cor sequi blam, conum
vulput lut diat lorper sed tat. Os aute cons
alit ulluptate dolessisl ut auguer adigniat
volore feum zzrit ut la ad tis aut augueros
adit adio core conse delit, volortie dunt

Keep with Hext: =0 lines

RYSUNEK 9.15 Keep with
Previous zastosowane

do gtéwnego tekstu po pod-
tytule (u gory) oraz Keep with
Next 2 lines zastosowane do sa-
mego tytutu (ponizej).
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- B Keep Lines Together -

RYSUNEK 9.16 Wyrozniony
akapit ma wiaczona opcje
trzymania razem co najmniej
dwdch wierszy na poczatku

i koricu (u gory); wyrézniony
akapit ma wtaczona opcje
trzymania wszystkich wierszy
razem (u dotu).

RYSUNEK 9.17 Atrybut Start
Paragraph > Next Frame (W na-
stepnej ramce) jest przydatny
przy tworzeniu podrecznika
praktycznego .krok po kroku’,
gdy kazdy punkt powinien
znalei¢ sie w nowej ramce
tekstowej.

Odipsum deliqui tio et lute feugiamet
dolor ipismol orperat lutat. Olore dole-
strud magnibh er si. Ad mincing esec-
tetue magna feugueriure magna conse
consequam velit alis ex exeros aciduiscin
eugiat. Na facilit vel dipit at niat.

Raesto diam, consequis aut aliqui-
sim elesectem zrit dolor se facidunt ad
miniamconse vullutem ozrillut venibh

Odipsum deliqui tio et lute feugiamet
dolor ipismol orperat lutat. Olore dole-
strud magnibh er si. Ad mincing esec-
tetue magna feugueriure magna conse
consequam velit alis ex exeros aciduiscin
eugiat. Na facilit vel dipit at niat.

4 Velorestinm sa dalls

T Torla sequas que quam :‘-‘Iﬂﬂlm ot

v oplatati eren. ptatis
0t e e ot .

offecaties ub raod minciet faceics e ot ot dohapisnn
o b e ko el st i




RozbpziAt 10

Tabulatory, tabele i listy

TABELE SPOTYKAMY WSZEDZIE: w rozktadach jazdy tramwajow lub autobusow,
poréwnaniach produktéw, spisach towardw, zestawieniach wynikéw sporto-
wych lub programach telewizyjnych — zeby wymienic cho¢ kilka. W odréznieniu
od tekstu narracyjnego, tabele powinno dac sie czyta¢ w obu kierunkach tak
samo fatwo, zatem wazne jest, aby utrzymac prostote projektu. Tworzac tabele,
nalezy zacza¢ od projektu homogenicznego i jednolitego, a potem wprowadzac
obramowania, szarosci i wyr6znienia tylko tam, gdzie s3 niezbedne — i tylko
wowczas, gdy bedziemy umieli powiedzie¢, dlaczego sa one niezbedne. Listy
s rownie rozpowszechnione: dziesie¢ najlepszych tych, sto najlepszych onych,
dziesieciokrokowy program rzucania palenia, 50 sposobow na rzucenie dziew-
czyny, i tak dalej, i tym podobnie... W tym rozdziale przyjrzymy sie funkcjom
formatowania tabel, a nastepnie przejdziemy do opcji tworzenia punktowanych
i numerowanych list, a przy okazji wspomnimy o kilku przydatnych efektach,

ktére mozemy osiggnac przy uzyciu tabulatorow.
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Praca z tabelami

Nikt nie zaprzeczy, ze tabele sg nudne. W obliczu koniecznosci posktadania
wielkiej liczby informacji tabelarycznych wypelnianie deklaracji podatkowej
wydaje si¢ atrakcyjna alternatywa. Na szczescie opcje tworzenia i formato-
wania tabel w Adobe InDesign pozwalaja zmniejszy¢ te cierpienia. Oprécz
zapewnienia narzedzi, ktére sa w kazdej chwili pod reka, pomagaja réwniez
przyjac rozsadne, a nie nonsensowne podejécie do estetyki tabel.

Niestety, klienci az nazbyt czesto traktuja tabele jak skiad rupieci — chcie-
liby wcisnaé w nie wszystko, co tylko sie da, a potem dopchna¢ drzwi na sile.
Zapamietajmy to: nawet jesli jest to tylko tabela, nadal kto$ bedzie musial ja
czytaé. Normalne reguly dotyczace czytelnosci nadal obowigzuja.

Gdy przychodzi do wyboru czcionki, tekst tabel zazwyczaj sklada sie stop-
niem o punkt lub dwa mniejszym niz tekst gléwny. Bez wzgledu na wczeéniejsze
rozwazania na temat czytelnosci, w tej sytuacji korzystne moga by¢ kroje
waskie, gdyz sa bardziej ekonomiczne, jesli chodzi o zajmowana przestrzen.
Bezszeryfowe pisma o stosunkowo duzej wartosci x-height i obszernych puncach
(Helvetica, Univers, Myriad) w matych stopniach s3 czytelniejsze, niz kroje
szeryfowe. Trzeba tez sprawdzi¢, czy kréj zawiera cyfry wersalikowe (to jest
cyfry bez wydluzen gérnych i dolnych) — w tabelach nie powinni$my stosowa¢
cyfr nautycznych (ktére sa uzywane wszedzie gdzie indziej w tej ksigzce). Jesli
jest to font OpenType pozwalajacy na wybér stylu cyfr, nalezy wybra¢ Tabular
Lining (Cyfry o stalej szerokosci) jako styl domyslny. W odréznieniu od zwyktego
tekstu, w tabelach chcemy, aby kazda cyfra zajmowala te sama szerokoé¢, by
dalo si¢ je wyréwnac takze w pionie.

Mantra ,Robié jak najprosciej” chyba nigdzie nie jest wazniejsza niz podczas
tworzenia tabel. Hierarchie informacji powinien okreslaé¢ sam sposéb skon-
struowania tabeli, a nie stosowanie najrozmaitszych krojéw, wag i wielkosci
znakéw. InDesign umozliwia stosowanie obramowan, kresek pomiedzy kolum-
namiiwierszami, a takze kolorowanie tla poszczegélnych komérek. Wszystkie
te elementy powinny by¢ jednak stosowane z umiarem. Zbyt wiele kresek
iréznobarwnych (czy tez ,réznoszarych”) blokéw spowoduje zamazanie komor-
kowej struktury tabeli, powodujac, ze nasze dane beda sie ukrywaly wewnatrz
komérek, zamiast by¢ widoczne na pierwszy rzut oka. Zamiast pelnego obra-
mowania tabeli warto rozwazy¢ zastosowanie tylko gérnej i dolnej kreski, aby
stworzy¢ bardziej ,,otwartg” tabele, majaca do$¢ miejsca na oddech.

Pod wzgledem opcji wyréwnywania tekstu, tabele wymagaja elastycznoéci.
Wysrodkowanie nagtéwkéw kolumn moze by¢ dobrym wyborem, jesli zawieraja
one liczby o zréznicowanej dtugosci. Odwrotnie, gdy wszystkie liczby w kolum-
nie sa takiej samej dlugosci, lepszym wyborem moze by¢ wyréwnanie do lewej.



Rozdziat 10 Tabulatory, tabele i listy 159

W kazdym przypadku jednak nalezy nastawi¢ si¢ na to, ze konieczne moze by¢
optyczne skorygowanie wyréwnania w razie potrzeby.

Wyréwnanie w pionie jest szczegdlnie istotne dla nagléwkéw kolumn. Jesli
niektére zajmuja wiecej niz jeden wiersz, wyréwnanie nagtéwkéw do dotu daje
bardziej czytelny zwiazek pomiedzy nagléwkiem i treécig kolumny. Justowanie
tekstu ani wcigcia pierwszego wiersza nie maja zastosowania w tym kontek-
$cie — komérki tabel s3 zbyt waskie. Jesli tekst stanowiacy zawartosé komérki
zajmuje wiecej niz jeden akapit, warto rozdzieli¢ go na kilka kolejnych komérek
(wierszy tabeli). Jesli tabela zawiera wartosci walutowe, pozycja symbolu waluty
powinna by¢ wyréwnana w pionie w calej kolumnie. Nie stanowi to problemu
dla walut, ktére umieszczane s3 za liczbg, ale wymaga nieco pracy w przypadku
walut uzywajacych zapisu prefiksowego. W takim wypadku pozycja waluty
wynika z dtugosci (liczby cyfr) najwiekszej wartosci w kolumnie. We wszystkich
innych komérkach waluta powinna znalez¢ sie na tej samej pozycji, zas same
liczby powinny zosta¢ wyréwnane do prawej.

Jesli mamy do czynienia z dtuga tabela, biegnaca przez wiele stron, wiersz
(lub wiersze) nagléwka powinny by¢ powtarzane na kolejnych stronach. Rzadko
jednak zachodzi potrzeba umieszczania wierszy stopki tabeli gdziekolwiek
poza jej rzeczywistym koficem.

. . . RYSUNEK 10.1 Dwa przy-
Brighton—London Victoria klady tabel, w kt6rych cienio-
. wanie wymusza pozadany
Mondays—Fridays kierunek czytania: pionowy

Outward Time  Time Time  Time  Time  Time w przypadku rozktadu jazdy
Brighton - 07:04 07:06 07:15 075 0719 07:30 pociagéw i poziomy w tabeli
Preston Park 0218 0718 * ' wynikéw ligowych.
Burgess Hill 028 0728
Hassocks 07:20 07:20 07:39
Haywards Heath 07:44 07:44
Balcombe 0759
Three Bridges . 08:05 L
Gatwick Airport 0730 0747 07:47  08:02  08:02
East Croydon 0746 0757 0757 0756 083
Clapham Junction 08:02  08:06 08:06 08:05 | 0839 el
LondonVictoria 0809 0816 0816 = 0820 _ 0820 0812 0835
Duration : 01:05' 01:10 01:10 01:05 01:05 0053 01:05
| Home Away

Team plw o L f a|lw Db L F aleo ers
---]-.“Ma.nUtd . 3T 14 1 1 37 5 -.;-__-_3 .......... 3“. 2;7 10 ] 49 73
2 Chelsea SRR e R e e B T et
3 Arsenal 31 | 12 4 0 33 10 7 6 2 26 14 35 &7
P R B s Gt T el B e OGP R T L
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RYSUNEK 10.2 Anatomia tabeli

Tworzenie tabeli

Tabela jest czym$ w rodzaju ,,pseudo znaku” — elementem tekstu, umieszcza-
nym w ramce tekstowej. Jesli wstawimy tabele do istniejacego watku tekstu,
bedzie przemieszczaé si¢ wraz z nim i przelewaé pomiedzy kolejnymi ramkami.
Tabele lepiej umieszczaé w oddzielnym akapicie, ktéry nie zawiera niczego
wiecej. Jesli okaze sie, ze konieczne jest zmniejszenie szerokosci, mozemy
wyréwnac tabele wzgledem ramki tekstowej, uzywajac opcji wyréwnania tekstu
dla tego akapitu. Narzedzie Tekst postuzy nam réwniez do edycji zawartosci
tabel — opcje formatowania tekstu w tabelach nie réznij sie od tych, ktére mamy
do dyspozycji w kazdym innym miejscu. Wygodnie jest mysle¢ o komérkach
tabeli jako o indywidualnych ramkach tekstowych, choé o nieco zmienionych
wlasciwosciach.

Obramowanie tabeli

Wiersz naglowkowy (opcjonalny)

Kolumna

kolumny

Wiersz stopki (opcjonalny)

Obrys wiersza

Istnieja trzy podstawowe sposoby utworzenia tabeli w InDesignie: recznie
(,na piechote”), przekonwertowanie na tabele istniejacego tekstu oraz zaim-
portowanie tabeli z programu Microsoft Word lub Microsoft Excel.

Na piechote

1. Tworzymy ramke tekstowa narzedziem Tekst albo wstaw kursor do istnie-
jacej ramki tekstowe;j.

2. Wybieramy polecenie Table > Insert Table (Tabela > Wstaw tabele).

3. Okreslamy liczbe wierszy i kolumn tabeli.

4. Klikamy OK.
Krok opcjonalny: jesli spodziewamy sie, ze tabela bedzie zajmowata wiecej
niz jednga strone (kolumne tekstowa), mozemy okresli¢ liczbe (powta-
rzanych) wierszy nagléwka lub stopki. Jeéli jednak nie zadeklarujemy
nagiéwka (stopki) w momencie tworzenia tabeli, mozna bedzie w p6zniej-
szym czasie przetworzyc pierwszy wiersz (lub kilka wierszy) na nagléwek
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RYSUNEK 10.3 Reczne
tworzenie tabeli

Table Dimensions
Body Rows: ::‘C}

Columns: ::EE: i
Header Rows: <0 |

Footer Rows: ?—’;6_ 1 .
Tabe Style: Bk Tabiel )

(albo ostatnie wiersze na stopke), wybierajac polecenie Table > Convert
Rows (Konwertuj wiersze). W momencie tworzenia tabeli mozna réwniez
okresli¢ styl tabeli, o ile zostal wczeéniej zdefiniowany. Wiecej informacji
na temat styléw tabel i komérek zawiera rozdzial 12, ,Globalne forma-

towanie przy uzyciu styléw”.

Konwertowanie tekstu na tabele

Jesli planujemy przeksztalci¢ tekst na tabele, musimy go najpierw przygotowac,
wstawiajac tabulatory oddzielajace kolumny i korice akapitéw w miejscach
podzialu na wiersze. Nastepnie zaznaczamy tekst i wybieramy polecenie Table
> Convert Text to Table (Konwertuj tekst na tabele). ,Surowa” tabela nie bedzie
wygladac zbyt pieknie, ale dopasowujac szerokosci kolumn, taczac komérki tam,
gdzie jest to potrzebne i nadajac odpowiednie style akapitowe mozna to szybko
poprawi¢. Mozliwe jest réwniez odwrécenie tego zabiegu i przeksztalcenie

tabeli na tekst rozdzielany tabulatorami i koficami akapitéw.

Brighton-London Victoria - . T T
Mondays-Fridays - . » * » . . 1
Outward-Time = Time » Time « Time » Time » Time = Timet
Brighton - 07:04 - 07:06 - 07:06 - 07:15 07:15 «» 0719 « 073m

Preston Park » 0718 - 0718 - 07:36 » » » 1
Burgess Hill » 07:28 -~ 07:28 - 0745 . » » » L]
Hassocks~07:20 « 07:20 - 07:39 - 07:39 - * » 1 |
Haywards Heath - 07:44 . 07:44 . 07:48 - » » . | RYSUNEK 10.4 Konwerto-
Balcombe.07:59 « » » » » | wanie tekstu podzielonego
ThreeBridges »  08:05 » N N N N - 1 | tabulatorami na tabel
Gatwick Airport  »  07:30 » 07:47 » 07:47 » 08:02 . 0802 » - 1 €
EastCroydon - 07:46 » 07:57 » 07:57 - 07:56 - 0823 - .
Clapham Junction » 08:02 - 08:06 » 08:06 » 08:05 . 0839 - » 1
LondonVictorla - 0809 » 08:16 » 08:16 » 08:20 - 08:20 - 08:12 = 0833
Duration-01:05 » 01:10 - 01:10 - 01:05 - 01:05 . 00:53 » 01:05¢

Brighton- # # # # # # #

London

Victoriar

Mondays- | # # # # # # #

Fridays

Outwarde Times Times Times Times Times Times Times

Brighton# 07:04¢ 07:06¢ 07:06¢ 07:15¢ 07:15¢ 079 07:30¢

Preston. 07:18 07:18- 07:36¢ * # # #

Parke

Burgess Hilke | 07:28¢ 07:28¢ 07:45¢ # # # »
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Importowanie tabeli

UWAGA: Jesli w momencie Nie ma sensu wywazanie otwartych drzwi: jesli mamy juz tabele zdefiniowang
umieszczania tabelinie uzy- vy arkuszu programu Excel albo w dokumencie Microsoft Word, mozemy ja zaim-
wamy kursora tekstowego,

tabela zostanie wczytana portowac do dokumentu InDesigna. Uzyjemy w tym celu polecenia File > Place,

jako oddzielny obiekt, (Cmd/ Ctrl+D) zaznaczajac opcje Show Import Options (Pokaz opcje importu).
niezalezny od tekstu. Jesli umieszczamy dokument programu Word albo plik RTF, mozemy nastepnie
Aby wstawic tabelg wybra¢ zachowanie lub usuniecie styléw i formatowania z tekstu i tabel, a takze

do istniejgcego watku,

nalezy ja najpierw wyciaé przeksztalcenie tabel na niesformatowane tabele lub na tekst rozdzielany tabu-

do schowka (Cmd/ Ctrl+X), latorami. Jesli importowana tabela stanowi czeé¢ dluzszego tekstu, lepszym
wybra¢ narzedzie Tekst wyborem jest zwykle zachowanie styléw formatowania, po czym poprawienie
| umiesci¢ kursor w poza- wygladu tabeli po umieszczeniu calego watku w InDesignie. Aby usuna¢ forma-

danym miejscu (w razie
potrzeby wstawiajac pusty
akapit), po czym wklei¢
tabele ze schowka.

towanie z zaimportowanej tabeli, mozemy wykona¢é nastepujace czynnoéci:

1. Zaznaczamy calj tabele, wstawiajac kursor tekstowy do jednej z komérek
i naciskajac Cmd+Option+A/ Ctrl+Alt+A.

2. Przechodzimy do panelu Paragraph Styles (Style akapitowe) i klikamy przy-
cisk Clear Overrides (Wyczy$¢ przestoniecia), aby usunaé wszystkie lokalne
zmiany formatowania. © @ W & 3

3. Otwieramy panel Cell Styles (Style komérki) i wykonujemy analogiczna
czynnos¢. Spowoduje to wymazanie formatowania komérek (gruboéci
i kolory obryséw kolumn i wierszy, kolory tta i tak dalej), dzieki czemu
mozemy dalej pracowac z ,czysty”, niesformatowang tabela, aby nada¢
jej wlasny ksztaltiwyglad. Merd @ Qb B B 3

Przy umieszczaniu arkusza programu Excel mozna okresli¢ zakres odczytywa-
nych komérek i nada¢ importowanej tabeli zdefiniowany wczesniej styl.

¥ include Inline Graphics . ¥ Inclurte Infine Graphics
| Number of Decimal Places to lnclude: 1 | |
4 Use Typographer's Quotes |

RYSUNEK 10.5 Importowanie tabeli z arkusza programu Excel (pliku z rozszerzeniem .xls).



Zaznaczanie tabeli i jej fragmentéw

Zaznaczenie calej tabeli pozwala zmienié¢ formatowanie wszystkich komé-
rek jednoczesnie. W tym celu nalezy (uzywajac narzedzia Tekst) przesunaé
wskaznik myszy do lewego gérnego naroznika tabeli — kursor zmieni ksztatt
na strzatke skierowana w prawo i w dét — i kliknaé. Alternatywnie, jesli
kursor tekstowy znajduje si¢ gdzie§ wewnatrz tabeli, mozna uzy¢ polecenia
Table > Select > Table (Tabela > Zaznacz > Tabela) albo skrétu klawiszowego
Cmd+Option+A/ Ctrl+Alt+A.

W celu zaznaczenia kolumny nalezy przesunaé wskaznik myszy ponad
g6rna krawedz tabeli. Kursor przybierze ksztalt strzatki skierowanej
w dél. Klikniecie powoduje zaznaczenie catej kolumny. Naciéniecie skrétu
Cmd+Option+3/ Ctrl+Alt+3 powoduje zaznaczenie kolumny, w ktérej znajduje
sie kursor tekstowy. Aby zaznaczy¢ wiersz, trzeba przesunaé wskaznik myszy
ponad lewy brzeg tabeli, az przybierze ksztalt strzalki skierowanej w prawo.
Skrot Cmd/ Ctrl+3 zaznacza wiersz, w ktérym znajdowal sig kursor tekstowy.
Mozna réwniez uzy¢ polecen zawartych w menu Table > Select. Pozwalaja one
réwniez na zaznaczenie wierszy stanowiacych nagltéwek (Header Rows), stopke
(Footer Rows) lub podstawowa tres¢ tabeli (Body Rows).

W celu zaznaczenia komérki nalezy umiesci¢ w niej kursor tekstowy i nacis-
na¢ Cmd/Ctrl+/ (ukoénik).

Aby zaznaczy¢ tekst w komérce, nalezy uzy¢ zwykltych metod zaznaczania
tekstu.

Insert Table... XOo®RT
Convert Text to Table...
Convert Table to Text...

Table Options »
Cell Options 4
Insert »
Delete b -
Cell ®/
- Row ®3
Merge Cells Column ®3
Unmerge Cells Table XA

Split Cell Horizontally
Split Cell Vertically
Convert Rows >

Header Rows
Body Rows

i Footer Rows
Nicrribara Rowe Fuanhs -
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UWAGA: Zaznaczanie
komorki i tekstu w komérce
to dwie rézne czynnosci.
Aby zaznaczy¢ komorke,
mozemy przeciggnac mysza
od lewego gornego rogu
komorki. W ten sposéb
jednak mozna niechcacy
zmieni¢ wymiary wierszy

i kolumn, wiec wygodniej-
sza metoda zaznaczenia
indywidualnej komorki jest
umieszczenie w niej kursora
tekstowego, po czym
wybranie polecenia Table >
Select > Cell albo nacisniecie
Cmd/ Ctrl+/ (ukosnik).

WSKAZOWKA: Klawisz Esc
domyslnie powoduje prze-
faczenie pomiedzy trybem
zaznaczania komorek

i tekstu. Jesli nacisniemy go
majac zaznaczong komorke,
zostanie zaznaczony caly
tekst w tej komoérce i vice
versa.

RYSUNEK 10.6 Zaznaczanie
wiersza, kolumny lub catej
tabeli.
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RYSUNEK 10.7 Schemat
obramowania w palecie
sterujacej pozwala okresli¢,
ktérych czeséci obramowania
komérek dotyczy aktualnie
wprowadzana zmiana. Kreski
zaznaczone wyswietlane sa
na niebiesko, a ignorowane
na szaro.

Tworzenie polaczenia z plikami arkuszy

Przy wstawianiu ilustracji do InDesigna tworzone jest pofaczenie z oryginal-
nym plikiem graficznym. Zarzadzanie tymi polgczeniami umozliwia paleta

Links (kacza), w ktérej mozna wywotac edycje pliku w aplikacji odpowiadaja-
cej jej typowi (Adobe Photoshop, Adobe lllustrator lub innej) albo aktualizacje
potaczenia, jedli oryginalny plik zostat zmieniony. Nie jest to jednak domysine

zachowanie przy umieszczaniu plikéw tekstowych lub arkuszy: po wstawieniu

ich do InDesigna stajg sie niezalezne od oryginalnego pliku, o ile nie zostata

wigczona opcja Create Links (Twérz tacza), dostepna w preferencjach programu

na karcie File Handling (Obstuga plikow).

Utworzenie taczy do arkuszy programu Excel oznacza, ze za kazdym razem,
gdy oryginalny plik arkusza zostanie zmieniony, pojawi sie mozliwos¢ zaktuali-
zowania odpowiadajgcej mu tabeli w dokumencie inDesigna. Brzmi to $wietnie,
ale ma dwie powazne wady.

Po pierwsze, zaktualizowanie tabeli o zmieniong zawartos¢ arkusza Excel
spowoduije utrate catego formatowania nadanego w InDesignie. Nieprzyjemna
sprawa. Dlatego lepszym pomystem moze by¢ skopiowanie nowych danych
z arkusza i wklejenie ich w dokumencie InDesigna. Jesli nasze tabele zawieraja
bardzo wielka liczbe danych, ktére ulegajg czestym zmianom, utworzenie taczy
do oryginalnych plikéw moze byc¢ uzyteczne — o ile ponowne nadanie wiasci-
wego formatowania przy uzyciu styléw bedzie trwato krécej, niz skopiowanie
i wklejenie nowych danych.

Po drugie, wigczenie opcji tworzenia taczy powoduje, ze réwniez pliki teks-
towe tworza takie facza, co jedynie wyjatkowo jest dobrym pomystem. Jesli zatem
chcemy stworzy¢ tacze do pliku arkusza, warto pamietacé, aby wylaczyc te opcje
preferencji zaraz po umieszczeniu arkusza w naszym dokumencie.

Dodawanie obramowan, obryséw i wypetnien

Nowo wstawiona tabela, oparta na podstawowym stylu, domyélnie ma wlaczone
obramowanie oraz linie rozdzielajace wiersze i kolumny (obrysy kolumn i wier-
szy). Pierwszym naszym krokiem bedzie wiec usuniecie tych linii i nastepnie
dodanie tylko tych, ktérych faktycznie potrzebujemy.

1. Zaznaczamy tabele, klikajac jej lewy gérny rég. Zawartoé¢ palety sterujacej
przelaczy sie w tryb formatowania tabeli.

2. Zwréémy uwage na pole symbolizujace obramowania — zewnetrzna ramka
odpowiada obramowaniu calej tabeli (lub zaznaczonej grupy komérek),
za$ linie wewnatrz obrysom wierszy i kolumn. Potréjne klikniecie tego
pola zaznacza lub wylacza wszystkie linie. Klikniecie poszczegélnych
linii zaznacza lub usuwa zaznaczenie dla tej linii. Zmiany wykonywane
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sa na tych liniach, ktére s3 zaznaczone w podgladzie. Aby usunaé wszyst-
kie obrysy, zaznaczamy wszystkie linie (o ile jeszcze nie sa wybrane),
po czym wpisujemy warto$¢ o (zero) w polu grubosci obrysu.

Poziome kreski lub wypelnienia wierszy moga podniesé¢ czytelnoé¢ zlozonych
tabel zawierajacych wiele kolumn, ulatwiajac utrzymanie oka w okreslonym
wierszu. Zaleznie od rodzaju prezentowanych danych, mozemy sprébowac
eksperymentéw z przemiennymi wzorami wypelnieni lub kresek. Mozemy
wiec zastosowaé wypelnienie lub obrys w co drugim wierszu, co dwa lub trzy
wiersze, a takze uzy¢ opcji wylaczajacych z tego schematu pewnga liczbe wier-
szy poczatkowych lub zdefiniowaé wlasny wzér przemiennoéci wypelnien lub
obryséw. Te same reguly dotycza réwniez kolumn.

Cieniowanie wierszy lub kolumn powinno przede wszystkim stuzy¢ wymu-
szeniu podstawowego kierunku odczytywania danych. Zaleznie od rodzaju
danych musimy okresli¢, czy czytelnik bedzie potrzebowal porusza¢ si¢ w pozio-
mie, czy raczej w pionie i odpowiednio dobra¢ styl kolorowania.

Wstawianie i usuwanie wierszy i kolumn

Dodatkowe wiersze lub kolumny mozna dodawa¢ do tabeli uzywajac opcji menu
albo przy uzyciu myszy, przytrzymujac klawisz Option (Alt) podczas przeciaga-
nia granicy kolumny lub wiersza. Nowy wiersz zostanie réwniez utworzony, jesli
naci$niemy klawisz Tab, gdy kursor tekstowy znajduje sie w ostatniej komérce
tabeli. Warto zadba¢ o wyswietlanie krawedzi ramek poleceniem View > Extras
> Frame Edges (Widok > Dodatki > Pokaz krawedzie ramki), aby méc zobaczyé
indywidualne komérki tabeli.

Usuniecie wiersza lub kolumny mozna osiaggnaé poleceniem z menu Table >
Delete albo uzywajac Cmd/ Ctrl+Backspace w celu usuniecia wiersza lub
Shift+Backspace, by usunaé¢ kolumne.

Aby usungé zawarto$é komoérki bez usuwania samej komérki, nalezy zazna-
czy¢ cala jej zawartos$é (w razie potrzeby przechodzac do trybu zaznaczania
zawartosci klawiszem Esc), po czym nacisngé Delete lub Backspace.
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RYSUNEK 10.8 Stosowanie
przemiennego kolorowania
wierszy w celu ulatwienia

poréwnywania statystyk
ligowych.

WSKAZOWKA: Podczas
dodawania kolumn

przy uzyciu myszy, jesli
przytrzymamy klawisz
Option/Alti przeciggniemy
brzeg kolumny ponad
péttorakrotng szerokosc tej
kolumny, nowe kolumny
otrzymaja te sama szero-
kos¢, co kolumna stuzaca
jako wzér.

RYSUNEK 10.9 Dodawanie
i usuwanie wierszy

Table Head#

Insert Res(s)
o ey
Number: = 4 |
) e
© Below i
Bk R A L ] |
[ 75 I

Insert Table...
Comwert Text to Table,..

Column @
Table
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RYSUNEK 10.10 Zmienianie
szerokosci kolumn (u gory)
i wysokosci wierszy (u dotu)

WSKAZOWKA: Wybranie
opcji Exactly (Doktadnie)

w palecie sterujacej lub
panelu Table okresla
sztywna wysokos¢ wiersza.
Wiersze takie nie sq powigk-
szane, gdy przybywa tekstu.
W sytuacji, gdy tekst nie
miesci sie w komaree,
wyswietlana w nie jest tylko
czerwona kropka sygnalizu-
jaca tekst nieumieszczony.
Ta sama sytuacja moze
wystapi¢, gdy komoérka jest
zbyt waska, by pomies-

ci¢ najdtuzsze stowo

lub liczbe, a takze przy
szczegdlnych ustawieniach
przenoszenia stow i wierszy.
Jesli w komérce mamy
nieumieszczony tekst,

do wyboru sa dwie mozli-
wosci: zmniejszyc tekst albo
powiekszy¢ komorke tabeli.

Hznrse |

H /e

Zmienianie wielkosci wierszy i kolumn

Zmiane wymiaréw wierszy i kolumn mozna wykonaé za pomoca myszy, prze-
ciggajac odpowiednie granice, albo numerycznie w palecie sterujacej. Przy

przecigganiu mozna uzy¢ klawisza Shift, co powoduje, ze catkowity wymiar

tabeli nie ulega zmianie — przesuwana jest tylko granica pomiedzy danymi

kolumnami lub wierszami, zatem jedno pole robi sie wieksze, a s3siednie —
mniejsze. Aby proporcjonalnie zmieni¢ wszystkie wysokoéci wierszy lub

szerokosci kolumn, nalezy przytrzymac Shift i przeciaggnaé odpowiednio dolna

lub prawa krawedz tabeli.

W celu zmiany wielkosci calej tabeli mozna umiesci¢ wskaznik w poblizu pra-
wego dolnego naroznika tabeli, az zmieni ksztatt na skoéna strzatke, po czym
pociagnal mysza, aby zmniejszy¢ lub zwiekszy¢ wielkos¢ tabeli. Aby zachowa¢
proporcje, mozna uzy¢ klawisza Shift. Warto jednak zauwazy¢, ze nie mozna
w ten sposéb zmniejszy¢ wysokosci wierszy ponizej ustalonego minimum, jesli
jest ona zdefiniowana jako At Least (Co najmniej), a takze, ze metoda ta nie
dziala, jesli tabela rozciaga sie na wiecej niz jedng ramke tekstows.

Zaznaczonej grupie wierszy lub kolumn mozna nada¢ jednolita wysokos¢ (sze-
roko$c), uzywajac polecenia Table > Distribute Rows/Columns Evenly (Rozmies¢
wiersze/kolumny réwnomiernie).

Pewnym utrudnieniem podczas wymiarowania tabel jest fakt, ze InDesign
nie pokazuje wierszy tabeli, ktére nie mieszcza sie w aktualnej ramce teksto-
wej (cho¢ ,wystajace” kolumny sa widoczne i drukowalne). Wiaczenie opcji
wyéwietlania ramek (Cmd/ Ctrl+H) jest przydatne, ale zawsze warto sprawdzi¢,
czy po zmianie rozmiaréw koficowe wiersze nie znalazly sie winnej ramce lub
nie staly sie tekstem nieumieszczonym.

Okreélanie wysokosci wiersza

Wysokosc wiersza moze rosnaé samoczynnie, wraz ze zmianami zawartoéci
komérek, albo mie¢ wartos¢ absolutna. Domyslnie wysoko$é wiersza wynika
z interlinii zdefiniowanej dla tekstu w komérkach. Opcja At Least (Co najmniej)
okresla minimalng wysokoéé, ktéra jest zwiekszana wraz z wartoécia interlinii
iiloécig tekstu. Opcja Exactly (Doktadnie) narzuca sztywna wysokosé¢ wiersza,
niezaleznie od jego zawartosci. Jesli tekst lub grafika wstawiona do komérki prze-
kracza te wartos¢, w prawym dolnym rogu komérki pojawi sie czerwona kropka,
sygnalizujaca, ze jakas cze$¢ zawartosci jest nieumieszczona. Przy wstawianiu
grafik do komérek tabeli mozna unikna¢ takiej sytuacji, ustawiajagc wewnetrzne
marginesy komoérek na o (zero) i wybierajac opcje Clip Contents To Cell (Przytnij
zawarto$¢ do komoérki) w opcjach komoérki przed wstawieniem grafiki.

RYSUNEK 10.11 Okreslanie wysokosci wiersza i szerokosci kolumny w palecie sterujacej.
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Dzielenie tabeli pomiedzy ramki tekstowe

Jesli tabela jest dtuzsza niz wysoko$¢ ramki, w ktérej sie znajduje, mozna konty-
nuowac ja w kolejnych watkowanych ramkach, analogicznie jak zwykly tekst.

Okreslenie opcji przenoszenia w oknie dialogowym Cell Options > Rows and
Columns (Opcje komérki > Wiersze i kolumny) pozwala ustali¢, gdzie powinien
znalez¢ si¢ dany wiersz. Domy$lng wartoscia jest Anywhere (Gdziekolwiek), czyli
bezposrednio po poprzedzajacym wierszu, ale mozemy tu wymusié przejscie
do nowego tamu, ramki lub strony, podobnie jak w opcjach przenoszenia akapi-
téw. Mozemy réwniez zazadadé, aby wiersz lub kilka wierszy zawsze wystepowaly
razem w jednej ramce tekstowej, zaznaczajac pole Keep with Next Row (Przeno$
razem z nastgpnym wierszem).

Jesli chcemy, aby zawartos¢ gtowki tabeli byta powtarzana na kolejnych
stronach, musimy najpierw zdefiniowa¢ nagléwek. Mozna to wykona¢ podczas
tworzenia tabeli, ale jesli nie zrobilismy tego wtedy, mozemy teraz zaznaczy¢
jeden lub kilka poczatkowych wierszy i uzy¢ polecenia Table > Convert Rows
> To Header (Tabela > Konwertuj wiersze > Do nagléwka), po czym w opcjach
tabeli ustali¢, gdzie nagléwek tabeli ma by¢ powtarzany. Analogicznie mozna
zdefiniowac stopke, czyli koncowy wiersz lub wiersze, ktére powinny pojawia¢
sie na dole kazdej ramki zawierajacej tabele.

| Column Width: 517175 pt|

# Keep with Next Row

.~ Keep Op
{muw

Formatowanie komoarek tabeli

Komérki stanowia podstawowe cegietki budujace tabele i kazda z nich ma
wlasciwosci podobne do tych, jakie mozna okresli¢ dla indywidualnych ramek
tekstowych.

Okno dialogowe Cell Options pozwala zdefiniowaé takie parametry, jak
wewnetrzne marginesy komérki oraz wyréwnanie tekstu w pionie. Dla
poszczegélnych komérek mozna takze zmienié linie poziome i pionowe, wypetl-
nienie tla, polozenie pierwszej linii bazowej oraz zastosowanie linii ukoénych
(przekreslen). Tekst w tabeli mozemy formatowa¢ tak samo, jak kazdy inny
tekst, takze przy uzyciu styléw akapitowych i znakowych (patrz rozdziat 12).
Opcja niedostepna dla zwyklych ramek, ale wystepujaca w komérkach tabel,

RYSUNEK 10.12 Opcje dostepne na karcie
Rows and Columns wiasciwosci komérki po-
zwalajq okresli¢, czy dany wiersz ma by¢ po-
wigzany z nastepnym, a takze wskaza¢, gdzie
powinien sie zaczynac.

UWAGA: Dla komérek tabel
nie mozna zdefiniowacd
parametru okreslajacego
odlegtos¢ pomiedzy ich
zawartosciami, ktéry odpo-
wiadatby odstepowi miedzy
famami w ,zwyklej" ramce
tekstowej. Aby wyliczy¢

te odlegtos¢, nalezy dodaé
wartosci prawego margi-
nesu w pierwszej i lewego
marginesu w drugiej
kolumnie.
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jest mozliwo$¢ obrécenia tekstu o 9o°, 180° lub 270° (jesli naprawde potrzebu-
jemy obrécic tekst o inny kat, mozemy sformatowacé tekst w jego wtasnej ramce,
obracajac ja odpowiednio, po czym wklei¢ cala te ramke — nie tekst! — jako

obiekt do komérki tabeli).

Full
YouPay | 1YearPrice | YouSave

_g5765 | swral | 30%

£139.02 . 23%

. CelOptions . . s
2 revew (Gl ) G — -

RYSUNEK 10,14 Stosowanie
RYSUNEK 10.13 Okno dialogowe Cell Options linii ukosnych dla komérek

Wycinanie/kopiowanie i wklejanie danych

Zal6zmy, ze chcemy skopiowaé dane zawarte w jednej tabeli do innej tabeli,
zawierajacej te sama liczbe kolumn i wierszy. W tym celu nalezy zaznaczy¢
najpierw pierwsza tabele (Cmd+Option+A/ Ctrl+Alt+A), skopiowaé lub wyciagé
ja do schowka (Cmd / Ctrl+C lub Cmd/ Ctrl+X), po czym przejéé do drugiej tabeli,
wstawi¢ kursor do pierwszej komoérki i nacisnaé Esc, aby zaznaczyé komérke.
Ten ostatni ruch jest niezbedny — gdybyémy zaznaczyli tylko zawartosé komérki,
w rezultacie otrzymaliby$my ,tabele w tabeli”. Po wybraniu polecenia Paste
(Wklej) lub nacisnieciu Cmd/ Ctrl+V skopiowane dane zastapig dane zawarte
w tabeli. W ten sam sposéb mozna tez wkleja¢ dane skopiowane z arkusza
programu Excel, dzigki czemu mozna tatwo aktualizowa¢ dane nie niszczac
formatowania tabeli.

taczenie i dzielenie komoérek

Paleta sterujaca zawiera ikone laczenia komérek [}, ktéra uaktywnia sie,
gdy zaznaczonych jest wigcej niz jedna komérka. Po jej kliknieciu powstaje
komérka o wymiarach sumarycznych. Jesli obie zaznaczone komérki zawie-
raly jakis tekst, po polaczeniu beda to dwa oddzielne akapity. Po zaznaczeniu
polaczonej komérki uaktywnia sie ikona rozdzielania &, ktérej klikniecie



Rozdziat 10 Tabulatory, tabele i listy 169

Pl View _Help Merging Merging Cells RYSQNFI( 10.15 _Clpréalql
Insert Table... v OoRT Cells czenia (i roztaczania) komoérek
Convert Text to Table... mozna takze podzieli¢ ko-
Convert Table to Text... — maorki w poziomie (po prawej)

_ Splitting lub pionie (po lewej).
E:‘lfemowo:s < Splitting |12 Cell 1 2

Cells els

Insert »
Delete >
Select >

Split Cell Horizontally
Split Cell Vertically
Convert Rows >

przywraca podzial na oryginalne komérki. Opcje te dostepne sa réwniez w menu
Table, gdzie dodatkowo mozna jeszcze dokonaé podziatu komérki na potowy —
w pionie lub w poziomie.

Grafika w komaérkach tabel

Umieszczanie ilustracji w tabelach moze by¢ uzyteczne przy tworzeniu arkuszy
ze specyfikacjami technicznymi lub poréwnaniach produktéw albo po pro-
stu w celu uatrakcyjnienia dokumentu, ktéry inaczej mégtby by¢ $§miertelnie
nudnym ciggiem danych. Poniewaz komérki s3 — zasadniczo — ramkami
tekstowymi, ilustracje w komérkach sa grafikami w wierszu albo obiektami
zakotwiczonymi, a tym samym poruszaja sie wraz z tabela, jesli tekst zostanie
przelany inaczej. Aby umiesci¢ grafike w komérce tabeli, czesto wygodniej jest
zaczac¢ od niezaleznej ilustracji. Zamiast wstawiania jej bezposrednio w koméree,
co moze prowadzi¢ do nieoczekiwanych efektéw, jesli ilustracja jest znacz-
nych rozmiaréw, najpierw mozna umiesci¢ ja gdzie$ obok, ale poza tabels.
Nastepnie trzeba nada¢ ilustracji odpowiednie wymiary, skalujac ja i przycinajac

Album Year Label Producer RYSUNEK 10.16 W tym przy-

ktadzie komdrki zawierajace
grafike majg wewnetrzne mar-
ginesy wynoszace zero, dzieki
czemu ilustracja dopasowuje
si¢ do brzegéw komorki tabeli.

1 Nazewnictwo tych opcji jest nieco mylace — podzial w pionie oznacza wprowadze-
nie pionowej linii rozdzielajacej, zas w poziomie — poziomej, a wiec odwrotnie, niz
w pierwszym, intuicyjnym rozumieniu.
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RYSUNEK 10.17 Obrazek
wraz z oblewajacym go teks-
tem zostaly przygotowane
poza tabelg, po czym wklejone
do niej jako zgrupowany

obiekt.

Profesjonalna typografia w Adobe InDesign

na wymiar komérki, po czym trzeba tylko wycia¢ dopasowany obrazek i wklei¢
go w odpowiedniej komoérce. Jesli grafika jest wigksza od komérki, mozna tez
uzy< opcji przyciecia zawartosci do komérki, dostepnej w opcjach komérki
tabeli. W takiej sytuacji mozna wyzerowaé wewnetrzne marginesy. Grafika
wypeini komérke w pionie, ale nie w poziomie — szerokos¢ kolumny trzeba
bedzie odpowiednio dopasowa¢.

Tabele i oblewanie tekstem

B
Fre
(1:15),

Marx

)

Teoretycznie istnieje mozliwo$¢ wstawienia do tabeli grafiki oble-

il wanej tekstem, umieszczajac obraz jako zakotwiczony obiekt.

¥ i ?

Tos.,

Zazwyczaj jednak bardzo trudno jest doktadnie ustawi¢ oble-
wanie tekstu zgodne z zamierzeniami, szczegélnie wéwczas,

gdy chcielibyémy, aby oblewanie dotyczylo réwniez pierwszego
wiersza tekstu. W takim przypadku latwiejsze jest przygotowa-
140  nie oblanego tekstu z grafika jako oddzielnej ramki poza tabels
wsi 1ustawienie szerokodci tej ramki na warto$¢ réwna lub mniejsza

e od szerokoéci komérki, w ktérej ma sie znalez¢. Po zgrupowa-

niu tekstu i obrazu cala te grupe mozna wyciaé, po czym wklei¢

“1/| 6) . do komérki tabeli.

RYSUNEK 10.18 Tabela o za-
okraglonych rogach — obra-
mowanie jest w rzeczywistosci
oddzielng ramka mieszczaca

tabele.

( Historical Populations
Census Population %%
1900 658111 —
1910 925,708 40.7%
1920 1182911 27.8%
1930 1,578,009 33.4%
1940  1,734308 9.95%
1950 2,681,322 54.6%
1960 3638939 35.7%
1970 4628199 27.2%
1980 5,179,784 11.9%
1990 6,023,577 16.3%

LZOOO 6,783,760 12.6% J

Zaokraglone narozniki

Osobiscie mam fobie na zaokraglone prostokaty, ale klienci czgsto zycza sobie,
aby tabele mialy zaokraglone rogi. InDesign nie oferuje takiej opcji dla tabel,
ale mozna to obejé¢ w stosunkowo prosty sposéb:

1. Tworzymy tabele, nie nadajac jej obramowania.

2. Wycinamy ramke tekstowa zawierajaca tabele (Cmd/ Ctrl+X).

3. Rysujemy prostokat z zaokraglonymi rogami o odpowiednim obrysie
i wymiarach, po czym klikamy prawym klawiszem myszy i wybieramy
opcje Paste Into (Wklej do). Ramka tekstowa zostanie umieszczona jako
obiekt podrzedny (zawartosc) prostokata i bedzie mozna ja przemieszczaé,

uzywajac narzedzi zaznaczania.

taczenie i rozdzielanie tabel

InDesign nie oferuje wprost narzedzi ani polecen umozliwiajacych potaczenie
dwoch tabel, ale mozna to zawsze wykonacé recznie. Najpierw nalezy w pierw-
szej tabeli doda¢ na koricu puste wiersze w ilosci niezbednej do pomieszczenia
drugiej tabeli, a w razie potrzeby, dodaé réwniez puste kolumny. Nastepnie
trzeba skopiowac lub wyciaé zawartosé drugiej tabeli. Kolejnym krokiem jest
zaznaczenie pierwszego pustego wiersza i wklejenie zawartogci schowka. Nalezy
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Team P w D L F
Tt Manltd 3 | 14 1 1 35 Everton 3 | i
2 Chelsea n 0 5 0 3 6 Portsmouth N6 7 2 22
3 Arsenal 31 |12 4 0 33 7 Astonvilla SEEEIE G
4 Liverpool n 9 & 1 L & Blackburn 31 | 7 5 4 21
Tabela 1 Tabela 2

Team P | w D L F
R
2 Chel.se.a. 3 10 5 o n
3 Arsenal STl A e 05
4 Liverpool 3 ] 6 1 38
5 Everton SEaliel iy e iy
6 Portsmouth 31 | 6 7 2 22
7 AstonVilla N | 8 3 5 25
8 Blackburn n 7 5 4 21

uwazacd, aby zaznaczy¢ caly wiersz, a nie tylko jedna komérke, gdyz spowodo-
waloby to wklejenie nowej zawartoéci jako grafiki w wierszu.

Podzial tabeli jest prostszy — wystarczy zaznaczy¢ wiersze, ktére chcemy
oddzieli¢, wyciaé je (Cmd/ Ctrl+X), po czym wklei¢ w dowolnym innym
miejscu.

Tabele i edytor watkéw

Edytor watkow, jak wspominatem juz wezedniej, jest szczegélnie przydatny, gdy
mamy do czynienia z tekstem niemieszczacym sie — zjawisko to czesto pojawia
sie przy pracy z tabelami. W takiej sytuacji mozemy klikna¢ prawym klawi-
szem myszy symbol nie mieszczacego sie tekstu (czerwona kropke w komérce
lub czerwony znak plus na brzegu ramki tekstowej) i wybra¢ polecenie Edit in
Story Editor (Edytuj w Edytorze watkéw). Poczawszy od wersji InDesign €s4,
edytor watkéw daje dostep do zawartosci komérek tabeli. Klikniecie czarnego
tréjkata obok symbolu tabeli rozwija lub ukrywa jej zawartoéé. Edytor watkéw
moze by¢ réwniez przydatny, jesli chcemy umiescié kursor przed lub po tabeli,
szczegblnie w sytuacjach, gdy umiescimy dwie tabele w jednym wierszu, nie
rozdzielajac ich koricem akapitu.

RYSUNEK 10.19 taczenie
tabel poprzez skopiowanie

i wklejenie tabeli 2 do pustych
wierszy w tabeli 1.

Wrignish: Londom Victeriar
Ilennns‘.!Friﬂa,sr T
froyree- Outwardd

e\ et Briantons
[rep— o7

RYSUNEK 10.20 Niekiedy
tatwiej jest edytowac zawar-
tosc tabeli w edytorze watkow.



I
7m | InDesign i tekst Profesjonalna typografia w Adobe InDesign

Nietypowe zastosowania tabel

Oprécz oczywistej uzytecznosci, tabele moga by¢ przydatne réwniez w innych
zastosowaniach.

Jesli chcemy umiesci¢ okreslony akapit na kolorowym tle, tabela jest elegan-
ckim rozwigzaniem. W tym celu nalezy zaznaczy¢ tres¢ calego akapitu — ale
bez koriczacego go, ukrytego znaku konica — i wybrac polecenie Table > Convert
Text to Table (Tabela > Konwertuj tekst na tabele), aby utworzy¢ tabele zawie-
rajaca tylko jedng komoérke. Tabele te mozemy nastepnie sformatowaé wedle
zyczenia — nada¢ lub usunaé obrys, okresli¢ wypelnienie komérki, okresli¢
marginesy. A poniewaz jest to tabela, jej pionowy wymiar bedzie samoczynnie

RYSUNEK 10.21 Tabele dopasowywatl sie¢ do rozmiaréw zawartoéci i przemieszczal wraz z tekstem
uzyte do utworzenia tta pod
akapitem, ramki informacyjnej
oraz efektu,,plakatowego’, akapitu zawierajacego tabele albo poprzez opcje dostepne w oknie dialogowym
9dy czes¢ tekstu ukladana jest Table Setup (Opcje tabeli).

jedno-, a cze$¢ dwuwierszowo

obok siebie.

w razie potrzeby. Odstepy przed i po tym akapicie mozna okresla¢ parametrami

Et assintur re experere evelis res natinci minisciis magnimus
ut volo es moditi asperit, nossequi sundae ducius ea dellen-
des dolum que sequam, ut es audi con rest.

Duration: 2 Weeks

s . - ; Cost per person: $5000 (based
Convert tha H B fnte a singh 11 tabl 5 upon double occupancy)
and then apply a fill color to that cell. Use Cell Departure Dates: March 10,

: S June 15, September 24.
Options to control the inset spacing of the text.

Dus maio mi, ne et voloris nones etur aceaqui aturia volore si | { |
IR e (R R RIS

ut aspit dolut aut maionse catur?

Listy wypunktowane i numerowane

Listy wypunktowane i numerowane s3 formatowane jako akapity z podcigciem,
przy czym albo znak punktora (bullet), albo numer s3 pierwszymi (wysunietymi)
znakami. Punktorom lub numerom mozna automatycznie nadaé styl znakowy,
aby zmieni¢ ich kolor, wielkoé¢ lub potozenie linii bazowej. Wszystkie te opcje
formatujace moga stanowié czesé definicji stylu akapitowego.

Aby zastosowad wypunktowanie lub numerowanie dla zaznaczonego tekstu
(lub po prostu akapitu zawierajacego kursor tekstowy), nalezy kliknaé ikone
listy wypunktowanej lub numerowanej w palecie sterujacej i , przytrzymujac
klawisz Option / Alt. Spowoduje to wyswietlenie okna dialogowego Bullets and
Numbering (Punktory i numeracja), w ktérym mozna bedzie okreslié¢ typ listy,
styl punktora lub numerowania, opcje wyréwnania i tak dalej. Jak zwykle, warto
uzy¢ opcji Preview, aby na biezaco §ledzi¢ efekt dokonywanych ustawien. Mozna



tez wybrac styl znakowy, ktéry bedzie automatycznie stosowany do punktora
lub numeru. Jedli taki styl nie zostal jeszcze zdefiniowany, opcja New Character
Style (Nowy styl znakowy) pozwala utworzy¢ go na poczekaniu. Po uzyskaniu
zadowalajacego wygladu listy nalezy klikna¢ oK. Warto pézniej zapisa¢ for-
matowanie w postaci stylu akapitowego, wybierajac polecenie New Paragraph
Style (Nowy styl akapitowy) w menu panelu Paragraph Styles. Wigcej informacji
na temat korzystania ze styléw zawiera rozdzial 12.

Listy wypunktowane

Istnieje kilka regul, ktére warto wzia¢ pod uwage przy tworzeniu list
wypunktowanych:

= Niekiedy, szczegblnie w sytuacji, gdy znak punktora pochodzi z innego
fontu niz tekst, punktor moze mieé¢ niewlasciwa pozycje w pionie
w stosunku do tekstu. W takiej sytuacji konieczne jest skorygowanie
przesuniecia listy bazowej w stylu znakowym stosowanym do punktora.
Jesli poszczegdlne pozycje zaczynaja sie wielka litera, punktor powinien
by¢ wycentrowany w pionie wzgledem wysokosci wielkiej litery. Jesli
poszczegolne akapity listy zaczynaja sie malj litera, punktor powinien
zostaé¢ wyréwnany w pionie do §rodka malych liter.

= Jeden firet jest zazwyczaj wystarczajaca wielkoscia weiecia tekstu wzgle-
dem punktora.

= O ile zalecenia stylu wydawnictwa nie stanowig inaczej, nalezy do mini-
mum ograniczy¢ interpunkcje w listach wypunktowanych. Jeéli pozycje
nie s3 pelnymi zdaniami, nie nalezy konczy¢ ich kropka.

Rozdziat 10 Tabulatory, tabele i listy
RYSUNEK 10.22 Okno dialogowe Bullets
and Numbering, pozwalajace okresli¢
wszystkie atrybuty listy wypunktowanej lub
numerowanej.
Solomon Grundy...
= Urodzil sie
w poniedziatek
® Zostal ochrzczony
we wtorek

® Ozenil sie w $rode

® Zachorowat

w czwartek
Poczul sie gorzej
w piatek

= Zmarl w sobote

= Pochowano go

w niedziele

Taki byt koniec
Solomona Grundy’ego

RYSUNEK 10.23 Lista wy-
punktowana z odstepami
przed pierwszym i po ostat-
nim punkcie, wynoszacym pét
wiersza.
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Unt utpatie min et =
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Dunt wisl ing ent
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Duis elit niam au
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Jeéli nie s3 stosowane odstepy miedzyakapitowe, przed pierwszym
i po ostatnim akapicie listy nalezy umiesci¢ odstep. Pelna wysokoé¢
wiersza to zazwyczaj zbyt wiele, zatem dobrym wyjsciem jest odstep
réwny polowie wiersza. Po utworzeniu stylu dla listy mozna sporzadzi¢
dwa dodatkowe warianty: poczatkowy z odstepem przed akapitem i kon-
cowy z odstepem po akapicie. Trzeba tez pamigtad, ze jesli korzystamy
z siatki linii bazowej, przyciaganie do niej ma wyzszy priorytet, niz inne
ustawienia odstepéw i interlinii, zatem style listy wypunktowanej nie
powinny mieé wlaczonego przyciagania do siatki.

Nawet jesli gléwny tekst jest wyjustowany, listy wypunktowane zazwy-
czaj uktadajg sie lepiej ulozone w choragiewke, szczegdlnie przy krétkich
akapitach.

Weciecie tekstu po punktorze oznacza, ze tracimy efekt wyréwnanego
lewego brzegu (szczegélnie, gdy tekst gléwny jest sktadany w choragiewke).
Z tego powodu niektérzy projektanci uwazaja, ze punktory powinny by¢
wysuniete poza ogélny lewy margines tekstu. Aby to osiagna¢, konieczne
jest wciecie z lewej gléwnego tekstu o te sama wartoé¢, o jaka weieta jest
lista wypunktowana.

RYSUNEK 10.24 Wysunigcie Przy dlugiej liscie krétkich pozycji znacznie bardziej wydajne i lepiej wygla-

punktorow poza lewy

margines calego tekstu po- dajace moze by¢ podzielenie listy na kilka taméw wewnatrz ogélnej kolumny
prawia widocznos¢ lewego tekstowej. W tym celu nalezy zaznaczy¢ cala liste i uzy¢ gadzetu Split Columns
brzegu tekstu ztozonego . . . . . . . . . . .

w choragiewke. w palecie sterujacej. Mozna tez wlaczy¢ polecenie dzielenia na okreslona liczbe

taméw w definicje stylu akapitowego. Trzeba jednak pamietaé, ze opcja podziatu

na wigcej taméw rujnuje ustawienia opcji przenoszenia, szczegélnie gdy niektére

akapity zawieraja po wiele wierszy.

Professional cameras and video/audio equipment are strictly prohibited. Live i R St Options i

video/audio recordings made without the permission of the artiste/promoter Comrs Style Mame: builets

are prohibited. oo P iy

Indurrts s Lot ng

Not allowed through the campsite gates . —— nirah it gl Calammaeensisi

-« Glass +  Unauthorised Fireworks — s _:._:_._..__..._
lllegal substances Professional Film or - Flares e u"&'x 35: .................. 4
Portable Laser Video Equipment +  Animals (other than e Com et e s éig;m &
Equipment and Pens + Audio Recorders registered guide or el v e Outside Gutter: 510 pt P

+ Spray Cans hearing dogs) okl :

RYSUNEK 10.25 Rozdzielanie listy wypunktowanej na trzy tamy

przy uzyciu opgji Split Columns.
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Listy numerowane

Wszystkie wymienione wczesniej reguly dotycza takze list numerowanych.
Automatyczne numerowanie wydaje si¢ proste — zamiast listy wypunktowanej
wybieramy numerowang, a potem odpowiedni styl numeracji, styl znakowy dla
liczb, wyréwnanie i gotowe. Istnieje jednak kilka aspektéw list numerowanych,
ktére moga prowadzi¢ do frustracji: jak ustawi¢ wyréwnanie do prawej, czy
tez dziesietne, jeéli lista zawiera zaréwno jedno-, jak i wielocyfrowe numery?
Problemy sprawia tez zachowanie spéjnoéci numeracji w listach, ktére prze-
chodza przez kilka niepolaczonych ramek tekstowych.

Numery wyréwnane do prawej. Wybranie opcji Right (Do prawej) z listy roz-
wijanej Alignment (Wyréwnanie) powoduje, Ze numeracja zostanie wyréwnana
w pionie do najbardziej prawego znaku lub kropki. Poniewaz InDesign nie
pozwala tekstowi wystawaé poza ramke, nie bedzie to dzialalo, jeéli nie zwiek-
szymy odpowiednio wciecia z lewej i nie zmniejszymy wciecia (a wlasciwie
wysuniecia) pierwszego wiersza, aby przesuna¢ tekst i pozostawi¢ numerom
dostatecznie wiele miejsca, by zmiescily sie pomiedzy marginesem i tekstem.

Jesli planujemy wyeksportowanie watku InDesigna do pliku RTF, konieczne
jest wczeéniejsze przeksztalcenie automatycznego numerowania (a takze
punktoréw) w tekst, gdyz w przeciwnym wypadku znikna one z przekonwer-
towanego dokumentu. W tym celu nalezy zaznaczyé¢ liste i wybraé polecenie
Type > Bulleted and Numbered Lists > Convert Numbering To Text (Tekst > Listy
wypunktowane i numerowane > Konwertuj punktory i numeracje¢ na tekst).
Po tym zabiegu mozna bedzie zaznaczaé i edytowaé punktory lub numery jak
kazdy inny tekst i przetrwaja nienaruszone eksport watku — jednak numery
przestana by¢ ,zywe”.

Numerowanie poprzez niewatkowane ramki. Moze sie zdarzy¢, ze doku-
ment wymaga ciggloéci numeracji pomiedzy wieloma nie potaczonymi ze soba
ramkami, rozmieszczonych na réznych stronach, a nawet — w skrajnym przy-
padku — w réznych plikach. Najbardziej oczywistym przyktadem takiej listy
moga by¢ podpisy do ilustracji.

Aby to osiagnaé, konieczne jest utworzenie nowej listy stylu. Liste taka
mozemy sobie wyobrazi¢ jako wirtualny spis kolejnych pozycji z danej listy
numerowanej i zaleznoéci pomiedzy nimi. Standardowo w momencie nadawa-
nia numeracji akapit (lub styl akapitowy) jest przypisywany do listy o nazwie
[Default], ktéra nie umozliwia kontynuacji numerowania w niewatkowanych
ramkach tekstowych.

Utworzenie nowej listy mozna wykona¢ na etapie definiowania stylu aka-
pitowego, ale réwniez w dowolnym momencie w péZniejszym czasie. W oknie
dialogowym Bullets and Numbering trzeba wybra¢ opcje New z rozwijanego

Karma Police
Fitter Happier
Electioneering
Climbing Up The Wa
10 No Surprises
11 Lucky

RYSUNEK 10.26 Wyr6wny-

wanie numeracji do prawej

na listach, w ktérych wyste-
puja zaréwno jedno-, jak
i dwucyfrowe numery.

175
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RYSUNEK 10.27 Wybieranie
wiasciwej listy stylu w celu
zagwarantowania, Ze numera-
cja bedzie poprawnie biegta
poprzez niepowatkowane
ramki tekstowe.

UWAGA: Jesli akapit
sformatowany jest z pod-
cieciem (czyli z wcieciem

z lewej i ujemnym wcieciem
pierwszego wiersza),
pozycja wciecia w pierw-
szym wierszu funkcjonuje
jako znak tabulacji z lewej,
nie ma zatem potrzeby
definiowania dodatkowego
tabulatora w tym miejscu.

+ |3 |+

¥ — " -~ [l
»  Left]
° » Centen
» Rig hm
_»99.99%#

RYSUNEK 10.28 Rézne ro-
dzaje tabulatoréw

1 Youjustslip outtheback, Jack ‘s

2 Make a new plan, Stan

(= Options
. # Continue Mumbers across Stories
| M Continue Numbers from Previous Document in Baok

3 You don’t need to be cog, Rog

menu List, nazwa¢ nowa liste, po czym zaznaczy¢ opcje Continue Numbers Across
Stories (Kontynuuj numerowanie z poprzedniego watku).

Liste te nalezy nastepnie przypisa¢ do akapitéw, ktére maja mie¢ zachowana
cigglosé numeracji pomiedzy ré6znymi watkami, a nawet plikami. Najlepszym
rozwiazaniem jest wiaczenie tej listy do definicji stylu akapitowego. Zrébmy co$
porzadnie tylko jeden raz, a potem korzystajmy z tego nieograniczona liczbg
razy! — to wlasnie zasada dziatania styléw, ktérymi zajme si¢ szczegétowo
w rozdziale 12.

Tabulatory

Tabulatory umozliwiaja ustawienie fragmentu tekstu precyzyjnie w okres-
lonej pozycji, odmierzanej od lewego brzegu wiersza. Listy wypunktowane
inumerowane automatycznie maja przypisywane tabulatory ustawiajace pozy-
cjonowanie, ale mozna recznie utworzy¢ analogiczne efekty, aby wyréwnac
stupek liczb wzgledem separatora dziesigtnego albo ulozy¢ elementy informacji
w ,tabelopodobny” sposéb, choé bez rzeczywistego tworzenia tabeli. Tabulatory
wystepuja w czterech odmianach: tabulator lewy, prawy, wysrodkowany oraz
dziesietny.

Ustawianie tabulatorow

1. Ustaw kursor tekstowy w miejscu, w ktérym chcesz wstawi¢ dodatkowy
odstep w poziomie, po czym naci$nij klawisz Tab.

2. Wybierz polecenie Type > Tabs (Tabulatory) albo naci$nij Cmd / Ctrl+Shift+T.
Klikniecie ikony magnesu w narzedziu Tabs powoduje wyréwnanie i ,przy-
klejenie” linijki tabulatoréw do gérnej krawedzi ramki tekstowej.

3. Wybierz rodzaj tabulatora i jego pozycje, klikajac mysza lub wpisujac nume-
ryczna pozycje w polu narzedzia Tabs.



Tworzenie tabulatoréw dziesietnych

Tabulator dziesietny stuzy do wyréwnania fragmentéw tekstu wzgledem usta-
lonego znaku. Najczesciej uzywany jest zgodnie z nazwa do ustalenia pozycji
separatora dziesietnego, ale mozna wybraé dowolny inny znak, na przyklad
symbol waluty. Warto zauwazy¢, ze znaki na lewo od tego symbolu beda wyréw-
nywane do prawej wzgledem pozycji tabulatora, a znaki za nim — do lewe;j.

Korzystanie ze znakéw wiodacych

Znaki wiodace tabulatoréw sa powszechnie wykorzystywane w menu, cen-
nikach lub spisach tresci. Ich celem jest poprowadzenie wzroku od jednego
fragmentu tekstu do nastepnego. Istnieja tez inne, czesto lepsze rozwigzania
problemu ,powiazania” takich fragmentéw, ale w sytuacjach, gdy odlegtos¢
pomiedzy tekstem iliczba nie jest zbyt wielka, znaki wiodace dobrze speiniaja
swoja funkcje.

Aby zapewni¢ 1zejszy wyglad kropkowanej linii wiodacej, w polu Leader
Character® mozna wpisaé sekwencje ,kropka spacja”. Wieksza kontrole nad
wygladem takiej linii mozna uzyska¢ stosujac styl znakowy.

Znaki wiodace nie musza koniecznie by¢ kropkami. Uzycie znaku pod-
kreslenia w tym charakterze jest prostym sposobem utworzenia linii dla
zaznaczenia tekstu do wypelnienia, czesto spotykanych w najrozmaitszych

Rozdziat 10 Tabulatory, tabele i listy
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RYSUNEK 10.29 Tabulator
dziesietny zazwyczaj powo-
duje wyréwnanie do separa-
tora dziesietnego, ale moze
zostac uzyty w celu wyréwna-
nia do jakiegokolwiek innego
znaku.

formularzach.
——

Leader:| !
B | ; ... Wild Mushroom Roulade Marinated seitan, wild mushroom
S S ragout, truffled mashed potatoes and celery root wrapped in
Name yuba and baked in a crisp phyllo dough. Served with grilled
Address pears and a porter porcini mushroom sauce.................... $163°
iy Stte 2 ]

Portobello Potato Salad Breaded portobello mushrooms,

Name - — pan sautéed and served over a warm gold and purple potato
Address — — salad with cucumbers, tomatoes, Mandarin oranges, French
City. _— State._ Zip. lentils, mint, and winter greens

RYSUNEK 10.30 Rézne przykfady stosowania znakéw wiodacych. W przyktadzie po lewej u goéry
zastosowany zostat znak podkreslenia. W drugim (dolnym) przyktadzie formularza adresowego uzyto
stylu znakowego z podkresleniem zamiast znaku wiodacego, co daje wieksza kontrole nad gruboécia
i typem linii. Przyktady menu restauracyjnego po prawej demonstruja uzycie jako znaku wiodacego
kropki (u géry) oraz sekwencji kropka spacja” (u dotu).

2 W polskiej wersji InDesign S5 wystepuje oczywisty blad ttumaczenia — pole Leader
otrzymato nazwe , Linia odniesienia”, podczas gdy powinno nazywac sie ,Znaki
wiodgce”.

$13.5%



178 InDesign i tekst

UWAGA: Mozna tatwo
ustawic powtarzajgce

sie pozycje tabulacji

(w réwnych odstepach).
Zaznaczenie istniejgcego
znaku i wybranie polece-
nia Repeat Tab (Powtérz
tabulator) powoduje wsta-
wienie do korica wiersza
pozycji tabulacji w odste-
pach réwnych odlegtosci
pomiedzy wcieciem z lewej
a wybranym tabulatorem
albo odlegtosci od poprzed-
niej pozycji tabulacji, o ile
istnieje. Wszystkie pozycje
tabulacji w wierszu mozna
usunac poleceniem Clear All
(Wyczysc wszystkie).

RYSUNEK 10.31 Tabulator
wciecia z prawej (Shift+Tab)
powoduje dosuniecie pozo-
statej czesci tekstu do prawej
krawedzi ramki tekstowe;j.

Profesjonalna typografia w Adobe InDesign

Tabulatory w tabelach

Gdy pracujemy z tabela, nacisniecie klawisza Tab powoduje przeniesienie kur-
sora do kolejnej komérki tabeli. Aby wstawié znak tabulacji do tekstu w tabeli,
trzeba postuzy¢ sie poleceniem Type > Insert Special Character > Other > Tab
(Tekst > Wstaw znak specjalny > Inny > Tabulator). To niezbyt wygodna metoda,
jesli znakéw tabulatoréw potrzebujemy czesciej niz okazjonalnie. Warto wiec
w tym celu zdefiniowac wlasny skrét klawiaturowy (w systemie Mac 0s skrét
ten juz istnieje — Option+Tab). Alternatywnie, po wstawieniu pierwszego tabu-
latora mozna go skopiowac do schowka, po czym wkleja¢ w miejscach, w ktérych
powinien sie pojawic.

Tabulator wciecia z prawej

Right Indent Tab, wywoltywany skrétem Shift+Tab, powoduje dosuniecie calego
pozostatego tekstu do prawej krawedzi ramki tekstowej — co$, co czesto bywa
przydatne w paginach lub podpisach. Symbol ten nie umozliwia okreslenia
znaku wiodacego, ale ograniczenie to mozna obejs¢, stosujac do niego styl
znakowy. Alternatywnym rozwigzaniem jest umieszczenie na prawym margi-
nesie pozycji tabulatora do prawej i ustawienie dla niego odpowiedniego znaku
wiodgcego, po czym zastosowanie tabulatora.

31 | Magazine Title 4 October 2010
Part of the reason for the ugliness of

adults, in a child’s eyes, is that the

child is usually looking upwards, and

few faces are at their best when seen

frombelow. %  — George Orwell



RozpziAat 11

Inicjaty wpuszczone

SmSOWKNIE DEKORACYJNYCH PIERWSZYCH LITER jako elementu projektu strony
wyewoluowato z diugiej tradycji ozdabiania manuskryptéw, siegajacej znacznie
dalej, niz wynalazek druku. Przed pojawieniem sie prasy drukarskiej ksigzki byty
przepisywane recznie przez skryboéw i kazda byta postrzegana jako unikatowy
skarb. Chcac odrézni¢ swa prace od innych, skrybowie wprowadzali wiasne,
ozdobne elementy. Jednym z najczestszych zabiegéw tego typu byto ozdabianie
pierwszej litery, gdzie wykonawca manuskryptu magt sobie pozwoli¢ na za-
demonstrowanie catego swego mistrzostwa. Kazdy rozdziat dzieta zazwyczaj
rozpoczynat sie iluminowanym znakiem, namalowanym metalicznymi, mine-
ralnymi lub rodlinnymi pigmentami, potgczonymi klejem lub guma z papierem

albo pergaminem karty tytutowej.
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RYSUNEK 11.1 Dwie strony
z Biblii Gutenberga (1455).
Lewa ukazuje iluminowang
pierwsza litere namalowana
przez skrybe; na prawej widac
mniejszy inicjat, sygnalizujacy
poczatek nowego rozdziatu,

RYSUNEK 11.2 Przykiady
inicjatow stosowanych we
wspotczesnych czasopismach.

Prawdziwym celem wyréznienia otwierajacej litery, czyli inicjatu, bylo zwrécenie
uwagi na to, ze nastepuje poczgtek — ksiazki, rozdzialu lub istotnej myéli. Do X1v
wieku inicjaly przeksztalcily sie z prostych, powiekszonych liter w niebywale
zlozone dziela sztuki, najczesciej wykorzystywane do dekorowania tekstéw reli-
gijnych. [luminowany inicjal még}l siega¢ w dét az do spodu karty albo rozciagaé
sig na calj jej szerokos¢. Niekiedy inicjat zawieral ilustracje i mégl wypelnia¢
calg strone dzieta. W 1455 roku, gdy Gutenberg wydrukowal swa 42-wierszowa
Biblie — pierwsza w $wiecie zachodnim ksiazke wydrukowana przy uzyciu rucho-
mych czcionek — potwierdzil waznos¢ tej tradycji, pozostawiajac w drukowanym
tekscie wolne miejsce, w ktérych skryba mégl umiesci¢ iluminowang pierwsza

litere. W miare ewolucji i udoskonalania technik druku rozwijaly sie tez formy
otwierajacych liter uzywane przez projektantéw. Spotykane dzi$ warianty
obejmuja inicjaly wysuniete i wiele odmian inicjatéw wpuszczonych lub pod-
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niesionych (doklejonych). W InDesignie termin drop cap (inicjal wpuszczony)

uzywany jest dla wszystkich sposobéw stylizowania poczatkowe;j litery.

HERE WAS NO POSSIBILITY of taking a walk that day. We had

been wandering, indeed, in the leafless shrubbery an hour in the
morning; but since dinner (Mrs. Reed, when there was no company,

dined early) the cold winter wind had brought with it clouds so sombre,

A and a rain so penetrating, that further out-door exercise was now out

HERE WAS NO POSSIBILITY of taking a walk that day. We had

been wandering, indeed, in the leafless shrubbery an hour in

the morning; but since dinner (Mrs. Reed, when there was no
company, dined early) the cold winter wind had brought with it clouds

8 so sombre, and a rain so penetrating, that further out-door exercise

THERE WAS NO POSSIBILITY of taking a walk that day. We had been
wandering, indeed, in the leafless shrubbery an hour in the morning;
but since dinner (Mrs. Reed, when there was no company, dined early)

c the cold winter wind had brought with it clouds so sombre, and a rain so

THERE wAS NO possibility of taking a walk
that day. We had been wandering, indeed, in the leafless shrubbery an
hour in the morning; but since dinner (Mrs. Reed, when there was no
company, dined early) the cold winter wind had brought with it clouds

D so sombre, and a rain so penetrating, that further out-door exercise

HERE WAS NO POSSIBILITY of taking a walk that day. We had been
wandering, indeed, in the leafless shrubbery an hour in the morning;
but since dinner (Mrs. Reed, when there was no company, dined early)
e the cold winter wind had brought with it clouds so sombre, and a rain so

been wandering, indeed, in the leafless shrubbery an hour in

the morning; but since dinner (Mrs. Reed, when there was no

company, dined early) the cold winter wind had brought with it clouds

F so sombre, and a rain so penetrating, that further out-door exercise

T HERE WAS NO POSSIBILITY of taking a walk that day. We had

RYSUNEK 11.3 Przyktady
potaczenia inicjatu i wyrdznie-
nia poczatkowych stow: (A)
trzywierszowy inicjat wpusz-
czony i kapitaliki zastosowane
do czterech pierwszych stéw
tekstu. (B) Wielkos¢ inicjatu
zostata powigkszona, aby
uzyskac hybryde inicjatu
wpuszczonego i podnie-
sionego. (C) Prosty inicjat
podniesiony. (D) Polaczenie
podniesionego inicjatu

z bardzo duzym wcieciem
pierwszego wiersza. (E) Inicjat
zostat wyciety i wklejony jako
osobna ramka tekstowa zako-
twiczona w gtéwnym tekscie,
aby utworzy¢ efekt inicjatu
wysunietego. (F) Inicjat wy-
ciety i wklejony do oddzielnej
ramki, ktéra zostata zakotwi-
czona w gtéwnym tekscie

z narzuceniem oblewania.



182 InDesign i tekst  Profesjonalna typografia w Adobe InDesign

Tworzenie prostego inicjatlu wpuszczonego
Wspélczesna praktyka wydawnicza kontynuuje liczaca setki lat tradycje rozpo-

czynania rozdzialéw lub artykuléw wielkimi inicjatami. Dzialanie takie moze
zosta¢ wlaczone do stylu akapitowego albo zastosowane lokalnie za posred-

nictwem palety sterujace;j.

RYSUNEK 11.4 Wyko- he Nellie, a cruising yawl, swung to her anchor  [Hue

rzystanie palety sterujacej without a flutter of the sails, and was at rest. The | # ot tiguram
do utworzenia prostego . ETox B
inicjatu wpuszczonego. Warto flood had made, the wind was nearly calm, and

Zwrbcic uwage na wiaczenie being bound down the river, the only thing for it

opcji Optical Margin Alignment . .

w panelu Story, dzieki czemu as to come to and wait for the turn of the tide.

poprzeczka w literze ,T" nie-
znacznie wystaje poza lewy
margines.

A

=
B =

=l
El

08 Tl

BT Eeisow [ Soo | S Sow |
L Ao i o O

-
!
Jr]

Aby utworzy¢ inicjal wpuszczony, nalezy umiesci¢ kursor tekstowy w pierw-
szym akapicie tekstu, po czym w palecie sterujacej wpisa¢ liczbe wierszy, o ktére
ma zostac obnizony inicjal, oraz liczbe znakéw, do ktérych zostanie zastosowany
efekt — zazwyczaj tylko do jednego, ale nie musi tak by¢ w kazdej sytuacji.

Chcac uzyskac dostep do wiekszej liczby opcji, musimy uzyé polecenia Drop
Caps and Nested Styles (Inicjaty wpuszczone i style zagniezdzone), dostgpnego
w menu palety sterujacej. Wyswietlone okno dialogowe udostepnia opcje wyréw-
nania lewego brzegu inicjatu do krawedzi ramki tekstowej, a takze skorygowanie

RYSUNEK 11.5 Optyczne T WAS THE best of times, it was the ellorrum quia secea qui con cones
g;igﬁf\::?:ﬁsﬁz:;::i;p@ times, it was the age of wisdom, it v conemolor amusdae con renimus s
do ksztattu litery. of foolishness, it was the epoch of b ventiberum consequi di nimi, te v«

the epoch of incredulity, it was the sea: qui dolut essi dion repellantio ipiend

it was the season of Darkness, it was tt | mostios andaesenimos et voluptatia dit

T WAS THE best of times, it was the 1 ellorrum quia secea qui con cones :
it was the age of wisdom, it was the : conemolor amusdae con renimus s
ishness, it was the epoch of belief, it ventiberum consequi di nimi, te v

of incredulity, it was the season of Lig] | a qui dolut essi dion repellantio ipiend
season of Darkness, it was the spring ¢ | mostios andaesenimos et volupratia dit

Wyréwnanie lewego brzegu Skalowanie wydtuzeri dolnych

[ :'-:nw Ourscsen Characne St gm . S iy i
=i | =t | {dopapidrpanc) ) =0 =R N E———
 ign Lokt Edge () Scale for Descenders L] Align Left Edge 4 Scale for Descenders ;
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RYSUNEK 11.6 Wiaczanie
atrybutéw inicjatu do definicji
stylu akapitowego

General Style Name: first par |

e Charactes Formats Location:

Achvanced Characier Fomatsy Drop Caps and Nested Styles

i i ::’ i = Stosowanie stylu znako-
Puaagraph Rutes =T - - — wego doinicjatu

- wr =L (dropcap —————194~ 9 )

s e Wiaczanie wyréwnania
[T | | [omat caps through 5 Words optycznego na podstawie
P Siyte ) ksztattu litery tworzacej
o inicjat

DpenType Fratures

Underhoe Optioas TR e Zastosowanie zagniezdzo-
J— ‘New Nested Style } | Delete ¥ WA

s & J € ) - nego stylu do stéw nastepu-
Nested Line Styles - jacych po inicjale
o E Zastosowanie zagniezdzo-
nego stylu do wierszy na-
............. - stepujacych po inicjale
{ NewlineStyle 3} [ Delete A v
o Preview ()

skalowania inicjatu, jesli zawiera on wydluzenia dolne — w przeciwnym razie
mogloby dojé¢ do nakladania sie inicjalu na znaki w pierwszym niewcietym
wierszu ponizej.

Niektore litery sprawiaja wrazenie niewyréwnanych optycznie, gdyz ich
lewa odsadka (wolna przestrzeri wchodzaca w sklad pola znaku) powoduje,
ze znak wydaje sie nieznacznie wciety. Wrazenie to mozna wyeliminowaé,
zaznaczajac opcje Align Left Edge (Wyréwnaj lewa krawedz) w opcjach inicjatu
wpuszczonego.

Jesli zamierzamy stosowa¢ takie samo formatowanie dla wigkszej liczby
akapitéw (na przyklad na poczatku kazdego rozdziatu lub artykutu w czasopi-
$mie), znaczna oszczedno$é( czasu (i gwarancje jednolitego wygladu) mozemy
uzyska¢, wlaczajac atrybuty inicjatu do definicji stylu akapitowego. Styl taki
najczesciej jest oparty na stylu uzywanym przez gtéwny tekst, ale bez zadnego
wcigcia pierwszego wiersza. Najprostsza metoda utworzenia takiego stylu jest

sdefinicja przez przyklad™

1. Zakladajac, ze styl dla gléwnego tekstu zostal zdefiniowany wczeéniej,
nadajemy go pierwszemu akapitowi, w ktérym ma sie znalez¢ inicjal.

2. Usuwamy wciecie pierwszego wiersza (o ile jest stosowane), po czym doda-
jemy inicjal poleceniem Drop Caps and Nested Styles, formatujac go zgodnie
z koncepcja estetyczna. Tak jak w kazdym innym wypadku, pomocne
bedzie zaznaczenie opcji Preview (Podglad) w oknie dialogowym.

3. Pouzyskaniu zadowalajgcego wygladu akapitu wraz z inicjalem, w panelu
Paragraph Styles (Style akapitowe) wybieramy polecenie New Paragraph
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RYSUNEK 11.7 Kernowanie
inicjatu. Przyktad po lewej
ukazuje skutek zastosowania
trzywierszowego inicjatu

w foncie Adobe Garamond
Pro. Szeryf w literze W" na-
kiada sie na wydluzenie gérne
litery ,h". Po prawej sytuacja
zostala skorygowana poprzez
niewielkie zwiekszenie swiatta
pomiedzy pierwszg a druga
litera.

Style (Nowy styl akapitowy), po czym nadajemy mu nazwe. Warto tu zwré-
ci¢ uwage na stosowanie jakiej$ konwencji nazewniczej, utatwiajacej

rozpoznanie przeznaczenia stylu. Jesli np. styl dla tekstu gléwnego nosi

nazwe ,body”, styl pierwszego akapitu (z inicjatem) mozna nazwa¢ ,body
first”. W takim wypadku pole Based On (Oparty na) definicji stylu bedzie

zawieralo wpis ,body”.

Atrybuty inicjalu mozna zmienié¢ lub dopracowaé w pézniejszym czasie, edytujac
utworzony styl akapitowy. Mozna réwniez wykorzysta¢ menu Character style
(Styl znakowy) w definicji inicjatu, aby nadaé znakowi inicjatu szczegélny styl
znakowy, zmieniajac np. czcionke, kolor, przesuniecie linii bazowej i tak dalej.
Jesli styl taki jeszcze nie zostal utworzony, mozemy zdefiniowa¢ go w biegu,
uzywajac opcji New Character Style.

Estetyka inicjatow

Nie istnieja zadne ,proste i szybkie” reguly, z ktérych wynikatoby, jak duzy
powinien by¢ inicjal — decydujacy powinien by¢ zdrowy rozsadek. Wielkoéé
ma znaczenie i w tym kontekscie ,wiekszy” niekoniecznie oznacza ,lepszy”.
Przeznaczeniem inicjalu jest zasygnalizowanie czytelnikowi, gdzie powinien
rozpoczad lekture. Aby to osiagna, inicjal nie musi krzyczeé, a zwlaszcza nie
powinien dominowac¢ nad tytulem, ktéry go poprzedza. Inicjal wypada ponizej
tytutlu w znaczeniu hierarchii elementéw strony — zazwyczaj, choé nie zawsze,
powinien by¢ mniejszy od nagléwka.

Oprécz poczatkowego inicjalu w pierwszym akapicie artykutu lub rozdziatu,
czesta praktyka jest stosowanie mniejszych inicjatéw jako znacznikéw pod-
rozdzialéw czy tez czesci artykulu (zdefiniowanych w oparciu o nadrzedny
inicjal). Ten sposéb pozwala skutecznie ztamaé monotonie ciaglego tekstu,
co moze by¢ niezbedne, jesli tekst nie zawiera ilustracji, podtytutéw lub innych
element6éw urozmaicajacych jego wyglad. Jesli jednak zaczniemy stosowac
inicjaly zbyt czesto, utracg one zaréwno swa elegancje, jak i funkcjonalnoséé
jako wyrézniki, a zaczna by¢ odbierane jako monotonne i irytujace. Na jednej
stronie nigdy nie powinny pojawic sie wiecej niz dwa inicjaly, a w szczegélno-
§ci akapity z inicjalami nie powinny znalez¢ sie w bezposrednim sasiedztwie.
Szczegdlnie niedobrym za$ przypadkiem bytoby, gdyby dwa inicjalty widoczne
réwnoczeénie uzywaly tej samej litery.

hether I shall turn out to
whether that station will be
must show. To begin my lif
I record that I was born (as I have bee

her I shall turn out to be

whether that station will be he

must show. To begin my life

I record that I was born (as I have been
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RYSUNEK 11.8 Przy bardzo
ozdobnych inicjatach opcje

/) OR A MINUTE or two she stood looking at Align Left Edge (Wyréwnanie
. lewego brzegu) oraz Scale
the house, and wondering what to do next, for Descenders (Skalowanie
when suddenly a footman in livery came wydiuzen dolnych) moga
nie wystarczyc do wilas-
running out of the wood—(she considered ciwego pozycjonowania

inicjatu, co widad w gérnym
himtobea footman because he was in livery: otherwise, judging przykladzie. Na ilustracji po-

by his face only, she would have called him a fish)—and rapped nizej przed inicjatem zostata
wstawiona cienka spacja

(Crmd+Shift+Option+M),

po czym zostata ona skerno-

wana ujemnie, powodujac

" OR A MINUTE or two she stood looking at the house, :ﬁ;?;gfe inicjatu poza lewy
and wondering what to do next, when suddenly a
footman in livery came running out of the wood—

. (she considered him to be a footman because he

was in livery: otherwise, judging by his face only, she would

have called him a fish)—and rapped loudly at the door with his

Kernowanie inicjatéw

Typowym problemem, z jakim mozemy mie¢ do czynienia przy automatycznie
generowanych inicjalach, jest fakt, ze powiekszona pierwsza litera czesto wcho-
dzi w kolizje z nastepujacym po niej tekstem. W takich sytuacjach konieczne
moze by¢ zastosowanie recznego kerningu. Warto zauwazy¢, ze jesli doko-
namy poprawek kerningu pomiedzy inicjalem i pierwszym znakiem zwyklego
tekstu, przesuniecie to jest stosowane do wszystkich wierszy stykajacych sie
z inicjatem.

Przy korzystaniu z dekoracyjnych liter opcja wyréwnania lewej krawedzi
moze nie wystarczy¢ do optycznego wyrdéwnania inicjalu. Co wiecej, niekiedy
pozadane moze by¢ wysuniecie inicjatu w lewo, poza margines. Na pierw-
szy rzut oka wydaje sie to niewykonalne — przeciez InDesign nie pozwala
na wychodzenie tekstu poza ramke! W istocie jednak mozna to osiagna¢ pro-
stym trikiem. Najpierw nalezy doda¢ spacje przed pierwszym znakiem tekstu.
Zauwazmy, ze musimy wéwczas zmienié ustawienia inicjatu, aby obejmowal dwa
znaki — inaczej inicjal bedzie dotyczyl tylko tej spacji, a tym samym stanie sie
niewidoczny. Nastepnie zaznaczamy te spacje i nadajemy jej kerning ujemny
o takiej wartosci, by przesuna¢ wlaéciwy inicjat (wraz z nastepujacym po nim
tekstem) do pozadanej pozycji. Zamiast zwyklej spacji, jako pomocniczego
»znaku sterujacego” lepiej uzy¢ jakiejs spacji o ustalonej szerokosci, na przyktad
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RYSUNEK 11.9 Wykorzysta-
nie pierwszej litery jako ramki
dla obrazu: pomyst trudny

do odparcia, ktéry jednak
rzadko dziata zgodnie z zamie-
rzeniami. ,Okno’, przez ktére
bedzie widac obraz, musi by¢
stosunkowo duze, aby foto-
grafia lub inna ilustracja byta
widoczna i rozpoznawalna.

RYSUNEK 11.10 Inicjat ob-
lany tekstem. Litera ,W" znaj-
duje sie w oddzielnej ramce,
ktérej nadano oblewanie

o ksztalcie odpowiadajacym
literze.

spacji cienkiej lub wlosowej. Po pierwsze, zmniejszy to wartos¢ koniecznego
przesuniecia, a po drugie, zagwarantuje niezmiennos$¢ polozenia inicjatu
w justowanym tekscie.

Tworzenie inicjatu z ilustracji

Przekonwertowanie wpuszczonego inicjalu na krzywe — poprzez uzycie
polecenia Type > Create Outlines (Zamien na krzywe) — tworzy z litery ramke
(zakotwiczong w tekécie), ktérag mozna nastepnie wypetniéjaka$ ilustracja lub
zdjeciem. To atrakcyjna koncepcja, ale jeéli inicjal nie jest naprawde bardzo duzy
i nie uzyto do niego bardzo ciezkiej odmiany kroju, mato jest prawdopodobne,
aby w jego wnetrzu znalazlo sie dostatecznie wiele miejsca, by ilustracja byta
rozpoznawalna. Pojawia sie tu réwniez ryzyko wizualnego ,,oderwania” inicjalu
od tekstu, przez co czytelnik pominie go i bedzie prébowat czytaé pierwszy
wiersz bez jego pierwszej litery.

RIGHTON IS CONSIDERED to be one of the UK’s
premier night-life hotspots and is also associ-
4 ated with many popular music artists. There are

Iso live music venues including the Concorde 2,
Brighton Centre and the Brighton Dome, where
ABBA received a substantial boost to their career when they won

Tworzenie oblanego inicjatu

Umieszczenie inicjalu w jego wlasnej ramce tekstowej daje mozliwos¢ oblania
tekstem ksztalttu pierwszej litery. Jest to doé¢ pracochlonne, ale efekt moze
by¢ bardzo interesujacy. Po oddzieleniu inicjalu mozna nadac jego ramce opcje
oblewania tekstem, po czym uzy¢ narzedzia Direct Selection (Zaznaczanie bez-
posrednie) do wyrzezbienia odpowiedniego ksztaltu granic oblewania. Nalezy
przy tym zadbac, aby odstep pomiedzy inicjalem i tekstem na prawo od niego
robil wrazenie takiego samego, jak odstep pomiedzy inicjatem a pierwszym
niewcietym wierszem.

hether I shall turn out to be the hero

of my own life, or whether that station

will be held by anybody else, these

pages must show. To begin my life with

the beginning of my life, I record that I was born (as
I have been informed and believe)
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Dodawanie kapitalikow

Czesto spotykanym zabiegiem, tworzacym wizualny most pomiedzy inicjalem
i zasadniczym tekstem, jest zlozenie kapitalikami kilku stéw nastepujacych
po inicjale. Daje to tagodniejsze przejscie pomiedzy wielkim (i byé moze ozdob-
nym) znakiem inicjatu a zwyklym tekstem, taczacym minuskuly i majuskuty,
dzieki czemu inicjal nie robi wrazenia odizolowanego elementu graficznego.
To, ile znakéw po inicjale powinno by¢ kapitalikami, jest kwestia wyboru este-
tycznego — moze to by¢ tylko jedno stowo, okreslona liczba stéw lub caly wiersz.
Cokolwiek jednak wybierzemy, powinno zosta¢ zastosowane jednolicie w calej

publikacji.

T WAS THE BEST OF times, it was the worst of times, it was the age
of wisdom, it was the age of foolishness, it was the epoch of belief,
it was the epoch of incredulity, it was the season of Light, it was the
season of Darkness, it was the spring of hope, it was the winter of
despair, we had everything before us, we had nothing before us, we were
all going direct to Heaven, we were all going direct the other way—in

Osiagniecie takiego efektu mozna zrealizowac¢ jako styl zagniezdzony, narzu-
cajac formatowanie na poziomie znakéw dla okreslonego przedzialu tekstu
na poczatku akapitu. Jesli znak inicjalu ma uzywaé odmiennego koloru lub kroju
(albo obu cech na raz), warto zdefiniowa¢ styl znakowy zawierajacy te atrybuty,
po czym zagniezdzi¢ go w stylu akapitowym. Dzigki temu mozna bedzie narzuci¢

wszystkie elementy formatowania pojedynczym kliknieciem.

Tworzenie zagniezdzonego stylu dla kapitalikow

1. Utworzstyl znakowy narzucajacy kapitaliki. Jesliuzywany font to OpenType,
mozna wykorzysta¢ opcje OpenType All Small Caps (Same kapitaliki),
dostepna w menu OpenType — pozwoli to utrzymac¢ jednolita wielkosé¢
kapitalikéw, bez koniecznoéci recznego zamieniania ewentualnych wiel-
kich liter wystepujacych w zmienianym fragmencie.

2. Aby zagniezdzi¢ styl znakowy w stylu akapitowym, otwérz styl akapitowy
do edycji (klikniecie prawym klawiszem nazwy stylu w palecie i wybra-
nie opcji Edit — albo po prostu podwéjne kliknigcie, o ile styl ten jest
wlasnie uzywany), po czym przejdz do karty Drop Caps and Nested Styles
(Wpuszczone inicjaly i style zagniezdzone), wybierajac odpowiednia opcje

w lewej czesci okna dialogowego.

RYSUNEK 11.11 Kapitaliki
przypisane pierwszym pieciu
wyrazom akapitu zapewniajg
gtadkie przejsicie od po-
wiekszonego znaku inicjatu
do zwyklego tekstu. Aby prze-
ksztalci¢ caly pierwszy wiersz
na kapitaliki, moZna uzy¢ stylu
zagniezdzonego.
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ALL ME ISHMAEL. SOME YEARS AGO— NEVER MIND HOW St oyt
long precisely— having little or no money in my purse, “pean

and nothing particular to interest me on shore, I thought
I would sail about a little and see the watery part of the world.
It is a way I have of driving off the spleen and regulating the

RYSUNEK 11.12 tjczenie stylow zagniezdzonych z opcjg inicjatow
w celu przeksztatcenia surowego tekstu. Pojedynczym kliknieciem
wraz z atrybutami akapitu i znakéw dla tekstu zasadniczego nada-
wane s3 cechy inicjatu (styl znakowy,drop cap”) oraz same kapitaliki 1o sl e Mok
(»all small caps”) dla pierwszego wiersza tekstu. |

RYSUNEK 11.13 Jedli tylko
s3 dostepne, nalezy uzy¢ opgji
OpenType dla kapitalikow.

3. Kliknij New Nested Style (Nowy styl zagniezdzony), po czym wybierz z listy
zdefiniowany wczeséniej styl znakowy i okresl liczbe stéw, ktérych ma
dotyczy¢ styl zagniezdzony. Mozna go réwniez utworzy¢ dopiero teraz,
wybierajac New Character Style z menu rozwijanego. Warto jednak zauwa-
zy¢, ze menu to pojawia sie dopiero wéwczas, gdy zostang wybrane inne
opcje w tym oknie dialogowym.

Aby zastosowa¢ kapitaliki dla calego wiersza, mozna uzy¢ zagniezdzonego
stylu wiersza.

Inne zastosowania inicjatéw wpuszczonych

Mechanizm tworzenia inicjaléw mozna wykorzystaé w réznych nietypowych sy-
tuacjach, znacznie wykraczajacych poza oczywiste zastosowanie ,standardowe”.
Rysunek 11.14 ukazuje kilka przyktadéw uzycia inicjaléw w celu osiggniecia
efektéw specjalnych, ktére inaczej bylyby trudne do zrealizowania.

Trudne inicjatly

Inicjaly to tylko jedna z metod uwypuklenia akapitu; nie zawsze stanowia
najlepsze rozwiazanie. Jesli tylko okazjonalnie konieczne jest reczne dosto-
sowywanie otwierajacego akapitu, nie ma klopotu — dopéki jest to sytuacja
wyjatkowa. Jesli okaze sig, ze w kazdym rozdziale musimy poswiecié czas
na wiasciwe ,ustawienie” pierwszego akapitu, warto rozwazy¢ zastosowanie
innego sposobu jego wyréznienia — na przyklad wersalikéw dla kilku pierwszych

1 Mozliwoé¢ definiowania zagniezdzonego stylu ,w biegu” dostepna jest w Adobe ,
InDesign w wersji ¢S4 lub wyzszej.
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What's the difference between Insert your Type tool into the

Optical and Metrics kerning? paragraph you want to affect.
Metrics kerning uses a font’s built-in
kerning information. Its effectiveness
depends on how many kerning pairs
are in the font. Optical kerning

In the Control Palette Paragraph
Formats type a number for
Drop Cap Number of Lines.

ignores the built-in kerning pairs Type the number of drop cap
and adjusts the space between the characters you want (usually 1)
characters based upon the character in the Drop Cap One or More
shapes. B Characters field.

How do | prevent certain text frames

from being affected by a text wrap?
Select the text frame then Choose
Object > Text Frame Options (Cmd+B/
Ctrl+B), then check Ignore Text Wrap.,

2 Hilary, Cate and friends dazzle 45 We've shopped around to find
at the Oscars and BAFTAs you all the biggest trends

37 Style file: Get in line for the 6 0 How to outshine everyone in
designer’s pattern of choice the season’s best occasionwea

stéw — albo po prostu zrezygnowac z wcigcia pierwszego wiersza i doda¢ odstep
przed akapitem rozpoczynajacym rozdziat lub artykut.

Zanim zdecydujemy sig na stosowanie okreslonego sposobu wyrézniania
poczatkéw, warto zaznajomic sie z samym tekstem. Istnieje kilka sytuacji, w kt6-
rych ani inicjal, ani wersaliki na poczatku tekstu nie beda dziataty dobrze:

® Gdy pierwszym znakiem akapitu jest cyfra.

® Gdy poczatkowy akapit zaczyna si¢ cudzystowem. W takiej sytuacji
konieczne jest wlaczenie do inicjatu réwniez otwierajacego cudzystowu,
ktéry jednak wyda sie wéwczas nieproporcjonalnie wielki. Mozna oczy-
wiscie skorygowac jego wielkosé¢, dopasowac jego polozenie pionowe
zmieniajac przesuniecie linii bazowej i poprawié¢ kerning pomiedzy nim
awladciwym inicjalem. Konkretne wartosci beda jednak zmienne w zalez-
nosci od charakteru uzytej czcionki, co oznacza, ze ostateczna postaé
zawsze bedzie dobierana subiektywnie. Warto tez rozwazy¢ wysuniecie
cudzyslowu poza lewy margines lamu.

® Jesli poczatkowy akapit jest krétszy, niz uzywana ,gltebokos¢” inicjatu.
Préba obnizenia inicjatu o trzy wiersze w jednowierszowym akapicie
moze stworzy¢ mylne wrazenie, choé InDesign wykonuje éwietng robote,
wcinajac odpowiednio réwniez wiersze kolejnych akapitéw. Jesli jednak
okaze sig, ze wielokrotnie prébujemy zastosowaé trzywierszowy inicjat

RYSUNEK 11.14 Inicjaty
uzyte niestandardowo: Do za-
Znaczenia pytan w wywiadzie
prasowym lub poradnikach
typu .pytanie — odpowiedz”
(A), do wyrézniania instrukcji
<krok po kroku” (B) i dla nume-
réw stron w spisie tresci (C).
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w akapitach majacych zaledwie jeden lub dwa wiersze, mozna zasta-
nowic sieg, czy zamiast inicjalu wpuszczonego nie nalezy zastosowaé
podniesionego.

= Jedliartykullub rozdzial zaczyna sie od poezji lub innego cytowanego frag-
mentu. Zastosowanie tu inicjatu byloby dodatkowym (i niepotrzebnym)
ozdobnikiem, w dodatku wprowadzajacym czytelnika w blad. Mozna by
uzy¢ inicjatu po takim wprowadzeniu, ale — skoro nie jest to juz sygnat
poczgtku — takie zastosowanie byloby nadmiarowe i tworzyloby wrazenie
chaotycznoéci i nieporzadku.

RYSUNEK 11.15 W tym ( CURIOUSER AND CURIOUSER!’ cried Alice (she was so much surprised,
rzykfadzie akapit rozpoczyna . .

2e Eudzysbwe,ﬂ‘ wieffo o that for the moment she quite forgot how to speak good English); ‘now

dzystow stal sig,inicjatem’, I'm opening out like the largest telescope that ever was! Good-bye, feet!”

co na pewno nie jest zgodne

2 naszymi oczekiwaniami (for when she looked down at her feet, they seemed to be almost out

u gory). Rozszerzenie ini- . : .

(Cia?u nrya} dvea anaki (u dok) of sight, they were getting so far off). ‘Oh, my poor little feet, I wonder

rozwigzuje ten problem, who will put on your

ale ze wzgleddw estetycz-

nych koniecznie jest jeszcze

zmniejszenie cudzystowu oraz C URIOUSER AND CURIOUSER! cried Alice (she was so much

skorygowanie jego potozenia . .

w pionie i w poziomie. surprised, that for the moment she quite forgot how to speak
good English); ‘now I'm opening out like the largest telescope
that ever was! Good-bye, feet!” (for when she looked down

at her feet, they seemed to be almost out of sight, they were getting so far
off). ‘Oh, my poor little feet, I wonder who will put on your

RYSUNEK 11.16 Inicjat INSTON was dreaming of his mother.

wpuszczony w jednowier-

szowym akapicie, InDesign He must, he thought, have been ten or eleven years

powoduje wcigcie réwniez old when his mother had disappeared. She was a tall,

tkowych wierszy kolej- . .

E:;)aak:;{; n‘:;‘g;?usgég_ statuesque, rather silent woman with slow movements

jac o ;natozenia si¢” inicjatu and magnificent fair hair. His father he remembered more vaguely as

i tekstu, a nawet zachowuje
wciecie pierwszego wier-

sza — jednak efekt finalny

nie zachwyca. Jedli okaze sie,
ze takie wyjatki zdarzaja sie
czesto, warto rozwazyc¢ zasto-
sowanie innego wyréznika
poczatku tekstu, niz wpusz-
czony inicjat.
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Globalne formatowanie
przy uzyciu stylow

STYLE SA CZYMS, co towarzyszy nam od samego zarania DTP. Przez minione
Cwieréwiecze (tak, to juz 25 lat!) ewoluowaly, zwiekszajac zaréwno swa uzytecz-
nos¢ i tatwos¢ stosowania, jak i oferowane mozliwosci. Stanowiac fundament
kazdego programu do skfadu publikacji, style pozwalaja tworzyc lepsze projekty
i zarazem usprawniaja przebieg pracy. Bez wzgledu na to, jak oryginalne lub
$wieze bedg czyjes koncepcje typograficzne, nie beda wiele warte, jesli nie
zapewni sie spojnosci formatowania, a te mozna sprawnie osiggna¢ jedynie

uzywajac stylow.
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Kilka definicji

Style akapitowe i znakowe to zestawienia atrybutéw, ktére mozna nada¢ tekstowi
pojedynczym kliknigciem lub skrétem klawiszowym. Style akapitowe zawieraja
zaréwno elementy formatowania znakéw, jak i calego akapitu — moga okresla¢
font, stopien: pisma, wyréwnanie, odstepy przed i po akapicie, kolor — méwiac
wprost, wszystkie atrybuty, ktére mozna przypisa¢ do tekstu. Style znakowe zawie-
raja tylko atrybuty dotyczace znakéw. Zgodnie z nazwa, style akapitowe stosowane
sa do catych akapitéw, podczas gdy style znakowe dotycza zawsze wybranego zakresu
tekstu wewnatrz akapitu.

Style obiektowe dotycza ramek — tekstowych lub graficznych — i moga zawiera¢
dowolne atrybuty, ktére mozna tym ramkom nada¢: kolor wypelnienia, kolor, gru-
bos¢ i styl linii obrysu, opcje ramki tekstowej (takie jak liczba faméw lub wewnetrzne
marginesy), opcje dopasowania ilustracji i wiele wiecej.

Style tabel i komérek, jak mozna si¢ domysli¢, stosowane sa do tabel. Styl tabeli
obejmuje atrybuty dotyczace calej tabeli, takie jak zewngtrzny obrys lub stosowanie
naprzemiennych wypelnien wierszy albo kolumn. Style komérek okreslaja atrybuty
poszczegélnych komérek — takie jak marginesy wewnetrzne — ktére buduja tabele.

Ta, juz nieprosta struktura staje sie jeszcze bardziej skomplikowana, ale tez
ciekawsza i nieporéwnywalnie bardziej efektywna, gdy uwzglednimy mozliwos¢
zagniezdzania styléw. Styl znakowy moze zosta¢ zagniezdzony w stylu akapitowym,
ktéry z kolei moze by¢ czescig stylu obiektowego lub komérkowego. Dodajmy do tego
style GREP (powodujace automatyczne zaaplikowanie stylu znakowego do fragmentéw
tekstu spetniajacych okreslone warunki) i sekwencje, pozwalajace na zastosowanie
réznych styléw do serii nastepujacych po sobie akapitéw, a mozliwosci staja sie
niewyobrazalne.

Caly zbiér styléw akapitowych, znakowych i obiektowych stosowanych w danym
dokumencie bede nazywat arkuszem stylow.

Po co uzywac stylow?

Réznica pomigdzy uzywaniem i nieuzywaniem styléw sprowadza sie do tego,
ze w pierwszym wypadku to my, uzytkownicy, sterujemy programem, a w drugim
to InDesign steruje nami. Oto kilka powodéw, dla ktérych nalezy uzywac styléw:

= Style gwarantuj jednolitosé formatowania w catym dokumencie, dajac w rezul-
tacie lepiej zaprojektowane i wykonane dzieto.

= Style pozwalaja jednym ruchem zmienié wybrana opcje formatowania w catym
dokumencie, bez wzgledu na to, jak bardzo bylby on ztozony — wystarczy
zmodyfikowa¢ definicje stylu.

® Inajlepsze na koniec: style oszczedzaja czas i nerwy!
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Pomimo tych niezbitych faktéw, wielu projektantéw albo w niedostatecznym
stopniu korzysta ze styléw, albo wrecz sie ich boi. Az nazbyt czgsto jestem zadzi-
wiony, jak liczni s3 projektanci — z ktérych wielu naprawde powinno wiedzie¢
to lepiej — ktérzy w ogoéle nie uzywaja styléw albo uzywaja ich sporadycznie.
Co z wami, ludzie? Czy naprawde tak bardzo lubicie haréwke w kétko powta-
rzanych tych samych czynnosci? A moze po prostu placg wam od godziny?

Slyszalem takie wypowiedzi, jak ,Nie lubie uzywa¢ styléw, bo wole mieé
swobode eksperymentowania z réznymi wariantami” albo ,Nie chce, aby
wszystkie moje prace wygladaty jednakowo”. Rzecz w tym, ze oba te argumenty
to powody, dla ktérych powinnismy uzywaé stylow. Style nie dusza kreatywnosci,
ale ja uwalniaja, sprawiajac, ze eksperymentowanie staje sie szybkie i tatwe.
A z faktu, ze nazwy styléw w jednym dokumencie moga by¢ takie same lub
podobne do tych z dokumentu obok nie wynika, ze same dokumenty nie moga
by¢ zupelnie odmienne.

[Basic Paragraph]

Jesli moge udzieli¢ jakiejs rady dotyczacej domyslnego stylu [Basic Paragraph]
([Podstawowy akapitowy]), to brzmi ona: zignorujmy go i nie uzywajmy w swoich
dokumentach, nawet jako podstawy definicyjne;j innych styléw. Jesli w réz-
nych dokumentach wystapia odmienne definicje tego stylu i skopiujemy tekst
z jednego dokumentu do drugiego, rezultat moze by¢ bardzo niemita niespo-
dzianka. Styl ten jest domysélnie przypisywany do wpisywanego tekstu. Nie
mozna zmienic¢ jego nazwy, ale mozna przeedytowac¢ jego atrybuty, podobnie
jak kazdego innego stylu. By¢ moze jeszcze lepszym wyjsciem jest zmiana stylu
domyslnego: wystarczy wybra¢ ten styl, gdy nie jest zaznaczona zadna ramka
tekstowa ani fragment tekstu.

Tworzenie stylow

Czas poswiecony na zbudowanie arkusza styléw to inwestycja, ktéra zwréci
sie wielokrotnie podczas calego procesu projektowania publikacji. Mozna zde-
finiowa¢ swoje style na samym poczatku projektowania, ale mozna réwniez
uzupelniac i edytowac style w miare pracy nad dokumentem. W moim przy-
padku arkusze styléw nigdy nie sa ,ukoniczone” — do ostatniej chwili pracy nad
publikacja moge w nich co$ jeszcze poprawié lub usprawnié.

Tworzenie styléow ,na Slepo”

Uzywajac okna dialogowego Paragraph Style Options (Opcje stylu akapitowego)
mozna utworzy¢ dowolna liczbe styléw bez koniecznoéci wpisywania cho¢by
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RYSUNEK 12.1 Okno
New Paragraph Style

zawiera wszystkie opcje
formatowania akapitow
i znakéw dostepne
w InDesignie.

Drop Cagn and Mebed Styles. Mo  Aadohe _Ill;iﬁllﬂ;-‘

—— e R - L,

Bty aned Mg

Character Coor

Open Ty Featwres

Unathe i Opstiona.

Sarduetheough Options 1 Apply Style to Selection

o Preview (ol ) (G

jednego znaku na projektowanej stronie. Majac dodwiadczenie, mozna sobie
wyobrazi¢, jak styl bedzie wygladat, bez koniecznosci ogladania tego na przy-
ktadzie, co pozwala na znacznie szybsze budowanie arkusza styléw.

Budowanie stylu na podstawie innego stylu

Wazna koncepcja typografii jest hierarchiczno$é. Hierarchia tworzy struk-
ture dokumentu i pomaga w efektywnym przekazywaniu treéci. Opcja Based

On (Na podstawie) pozwala ustanowi¢ hierarchie wéréd naszych styléw. Czesto,
cho¢ nie zawsze i nie obowigzkowo, hierarchia budowana jest na podstawie

wielkosci. Oto prosty przyklad: tytut i podtytuly czesto wykorzystuja ten sam

kréj pisma, ale Head1 bedzie wiekszy niz Headz2, ktéry z kolei jest wigkszy niz

Head3 (,wielko$¢” nie musi tu koniecznie oznaczaé¢ zmiany stopnia pisma —
ciezsza odmiana, np. Bold, réwniez jest ,wieksza” niz odmiana podstawowa).
Budujac nowy styl na podstawie drugiego tworzymy nie tylko wizualny zwigzek

pomiedzy stylami. Jedli zmodyfikujemy styl wyjéciowy (,rodzica”), atrybuty,
ktore s3 wspélne dla niego i jego ,potomkéw”, zostana zmienione réwniez w tych

pochodnych stylach. Pozwala to wprowadza¢ zmiany w calej rodzinie styléw

jednym ruchem. Wyobrazmy sobie, ze postanowiliémy zmieni¢ font uzywany
przez tytuly z Helvetiki na Univers. Jesli style zbudowane s3 hierarchicznie,
musimy tylko przedefiniowa¢ Head1 (styl zrédlowy) i wszystkie style potomne

réwniez sie zmienia, z wyjatkiem tych atrybutéw, ktére s3 unikatowe dla nich,
jak stopien pisma lub odmiana kroju.



Wykorzystanie opcji Based On do utworzenia
powigzanych styléw i zbudowania hierarchii

1.

4,

Dobierz ustawienia formatowania znakowego i akapitowego dla wybranego
tekstu, aby uzyskat pozadany wyglad.

Majac kursor w zmienionym akapicie, otwérz panel Paragraph Styles
i wybierz polecenie New Paragraph Style z menu panelu. Ustawienia
w oknie dialogowym beda odzwierciedlaly zmiany dokonane w tym
akapicie.

Nazwij styl i (opcjonalnie) okreél skrét klawiaturowy. W tym momencie
mozna dokona¢ dowolnych poprawek lub dopasowa¢ ustawienia, wybie-
rajac odpowiednig sekcje z listy atrybut6éw po lewej stronie okna dialogo-
wego. Zaznaczenie opcji Preview pozwala na biezaco weryfikowac efekty
wprowadzanych ustawien.

Kliknij OK.

HEADING 1 ——

Lecaton:
Ibh eugait niam, conulla faccumsan veri fanmdly,  rae
etum del erosto odiat alit am iriliquissi e Basedon: headl W)
do dolobore consequ amcore consed tit Next Style: {{Sarme style} -

num aut la augiat.

HEADING 2

Equisit nisim zzril eugait, consent ad tin
henibh ex et, consectem dolor sit wis ali
dolortionsed magnit, quam ad enim alic

HEADING 3

Secte vel iurer sim volorem eum er in el

Stosowanie stylow

Po zaznaczeniu tekstu lub umieszczeniu kursora tekstowego wewnatrz ramki,

style zaaplikowane w tym miejscu zostaja wyrdznione w paletach Paragraph

Styles lub Character Styles (albo w obydwu). Jesli zaznaczony fragment obejmuje

wiegcej niz jeden styl, zaden nie zostanie wyrdzniony, a w gornej czesci palety

pojawi sie stowo Mixed (Mieszane).

Aby zastosowac styl akapitowy, nalezy umiescié kursor tekstowy gdziekol-

wiek w tym akapicie — nie ma potrzeby zaznaczania calego akapitu — i kliknaé¢

nazwe stylu w palecie Paragraph Styles. Po zaznaczeniu kilku kolejnych akapitéw
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RYSUNEK 12.2 Tworzenie
stylu na podstawie innego
stylu,rodzicielskiego” (w tym
przykfadzie Heads jest
oparty na Headz, a ten z kolei
na Head1) sprawia, ze modyfi-
kacja stylu nadrzednego daje
«efekt domina’, przenoszac
sie do wszystkich stylow
potomnych.



RYSUNEK 12.3 Czasami
szybsze jest nadawanie styléw
w edytorze watkéw, bez spo-
wolnienia wywolanego przez
grafiki i zmiany stron.
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mozna im wszystkim nada¢ ten sam styl. Ponownie nie trzeba zaznaczaé catych
akapitéw — wystarczy, ze zaznaczenie ,zahaczy” o dany akapit.

Nadanie stylu akapitowego nie usuwa istniejacego formatowania znakéw ani
styléw znakowych, o ile nie uzyjemy opcji wyczyszczenia przestonie¢ (patrz
kolejny podrozdzial). Jesli tekst zawiera dodatkowe opcje formatujace, ktére
nie sa czescig definicji stylu, po jego zastosowaniu w palecie obok nazwy stylu
pojawi si¢ znak plus (+), informujacy, ze cze$¢ atrybutéw formatujacych odbiega
od zdefiniowanych.

Przypisanie do stylu skrétu klawiszowego pozwala na jeszcze szybsze
jego stosowanie. Skréty dla styléw wykorzystuja klawisze cyfrowe z klawia-
tury numerycznej (przy wlaczonej funkcji Num Lock) w kombinacji z Shift,
Option/Alt oraz Cmd/ Ctrl'. Funkcjonalnoé¢ ta ma dwa ograniczenia: nie
mozna uzy¢ innych skrétéw (na przyktad kombinacji klawiszy z literami ani
klawiszy funkcyjnych), a przede wszystkim klawiatura musi w ogéle zawiera¢
blok numeryczny i musi on pracowa¢é w trybie Num Lock, a nie sterowania
kursorem.

W dokumentach, w ktérych ciagly tekst jest wymieszany z wielka liczba
grafik, wygodniejsze moze by¢ nadawanie styléw w trybie edytora watkéw,
gdyz pozwala on na szybsze przemieszczanie si¢ pomiedzy partiami tekstu,
niz widok ukladu strony.

LReheh | pl:Catilon. Saablond Axslas fCalfornin b
Lo a1 Azalea “California Snow™
descration —. Large double. Good grower. heavy bioomer.
4l Early- to- mid-seasen, acid loving plants.
_I Flant in moist well drained sofl with pH of
4 4.0-5.5.9
e —sul HP10-51. = $15.909
Bower 4 Tibouchina. Semidecandrad
dncrpton 4 Beautiful. large royal purple flowers adorn
| attractive satiny green leaves that turn
4 orangefred 1n cold weather. Grows Lo up to 18
A feet,- or prune. annually. to. shorten,
o HP1O-52.|  $33.99% }
price 4 Hipiscus “Halght Ashbury™y . B ———
e KP10-Blaoms 1n summer,. 20-35 1nches high. g |§-i"m-c'nb"'hm' |
4 Fertilize regularly for best results. Full | . Barh . )
s3] sun, drough tolerant.q | faving & m‘;\ﬂ“mm
pece HPL0-53.1  412.99% T ey et o dee
Howwer 4 Flectranthus “Mona Lavender™|
description Guick-growing, herbaceous,. shrub reaching up
| to 30 inches in height, forming a rounded, o

1 W Mac OS X mozna stosowa¢ dowolne kombinacje pojedyncze (Cmd/Option/
Shift+klawisz), podwéjne (np. Cmd+Option albo Shift+Option) i potréjne (Cmd+
Option+Shift+klawisz). W systemie Windows dostepne s3 kombinacje Ctrl albo
Shift+klawisz oraz wszystkie podwéjne i potréjne — sekwencja Alt+klawisz nume-
ryczny jest zastrzezona i obstugiwana przez sam system operacyjny, a tym samym
nie moze stanowic¢ skrétu klawiszowego.
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Czyszczenie przestoniec

Kazda reczna zmiana formatowania tekstu, ktéry ma juz nadany styl aka-

pitowy (lub znakowy), nazywana jest przestonieciem (override) definicji tego
stylu. Ujmujac to inaczej: definiujemy styl akapitowy, nadajemy go jakiemus
fragmentowi tekstu, po czym znieksztatcamy ten styl, stosujac dodatkowe for-
matowanie. To, czy jakis tekst ma przestoniecia, mozna rozpoznaé po znaku plus,

ktéry pojawia sig obok nazwy stylu po zaznaczeniu tego tekstu. Przesuniecie

wskaznika myszy ponad nazwe stylu ,z plusem” powoduje wy$wietlenie etykiety

podpowiedzi z informacjami, jakie formatowanie lokalne zostalo zastosowane

w tym miejscu.

To lokalne formatowanie moze by¢ czymé, czego potrzebujemy, ale czeéciej
jest niepozadane. Dokument odziedziczony po innym uzytkowniku — kims,

kto nie lubi i nie uzywa styléw — czgsto zawiera wiele takich przestonieé lokal-

nych, ktére najlepiej usunaé, aby méc przystapi¢ do wlasciwego dostrajania

uktadu stony.
Istnieje kilka metod usuwania przestonieé:

= Aby wyczysci¢ cale formatowanie zadane lokalnie, ale pozostawié style

znakowe zaaplikowane do fragmentéw tekstu, nalezy przytrzymac kla-

wisz Option/Alt w momencie klikania nazwy stylu w palecie Paragraph

Styles. Ten sam efekt uzyskamy klikajac przycisk Clear Overrides (Wyczy$¢
przesloniecia) w palecie sterujacej lub tak samo nazwane polecenie

W menu.

® Kliknigcie przycisku Clear Overrides (ikona 9+) z przytrzymaniem klawisza

Cmd/ Ctr]l powoduje usuniecie tylko przestonieé formatowania znako-

wego — reczne formatowanie dotyczace akapitu (na przyklad weiecia lub

odstepy) pozostanie nienaruszone.

® Klikniecie przycisku Clear Overrides z przytrzymaniem klawiszy Cmd/

Ctrl+Shift powoduje usuniecie tylko formatowania akapitu, ale nie naru-

sza formatowania znakéw.

We hold these truths to be self-
evident, that all men are created
equal, that they are endowed
by their Creator with certain

equal, that they are endowed
by their Creator with certain

unalienable Rights, that among unalienabli - hat among
these are Life, Liberty and the these are Life, Liberty and the

pursuit of Happiness. pursuit of Happiness.

Akapit wyjsciowy Przestoniecia lokalne

hold these truths to be self-
evident, that all men are created

RYSUNEK 12.4 Po lewej: akapit w for-
matowaniu wyjsciowym (zgodnym

z definicjg stylu). Po prawej: lokalne
przestoniecia zaznaczone elipsami.
Wytluszczenia zostaly zadane stylem
znakowym i dlatego nie sa traktowane
jako przestoniecia.
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RYSUNEK 12.5 Meny Quick
Apply (u gory), dostepne
poprzez skrét Cmd+Return
(Ctrl+Enter). Po wyswietleniu
menu zaczynamy wpisywac
nazwe, aby przej$c do pierw-
szego pasujgcego stylu. Menu
wyskakujace panelu (ponizej)
umozliwia okreslenie, jakie
elementy maja by¢ zawarte
w menu Quick Apply.

® Przytrzymanie klawiszy Option/Alt+Shift i klikniecie nazwy stylu
w panelu Paragraph Styles powoduje usuniecie calego formatowania lokal-
nego oraz wszystkich styléw znakowych zastosowanych w wybranym
akapicie lub akapitach.

Szybkie stosowanie

Jesli uzywamy wielu styléw, czesto konieczne jest przewijanie dtugiej listy
i przeskakiwanie pomiedzy trzema réznymi panelami w celu zlokalizowania
tego wlasciwego. Zdecydowane przyspieszenie pracy umozliwia wpisanie kilku
pierwszych znakéw nazwy stylu w palecie Quick Find (Szybkie stosowanie),
aczacej wszystkie zdefiniowane style w jedna liste. Oto jak to dziala:

1. Zaznacz tekstlub ramke, dla ktérej chcesz zastosowaé styl, po czym naciénij
Cmd+Return/Ctrl+Enter, aby uaktywni¢ panel Quick Apply.

2. Zacznij wpisywac nazwe stylu — w panelu zostanie zaznaczona pierwsza
pasujaca nazwa (wszystkie style s3 ulozone alfabetycznie).

3. Jesli poszukiwany styl nie jest pierwszym znalezionym, mozna przemiesz-
czad sie po liscie uzywajac strzalek w gére i w dét.

4. Po wskazaniu wlasciwego stylu nacisnij Return/Enter.

Panel Quick Apply zapamietuje ostatnio uzywany styl, zatem w celu ponow-
nego uzycia tego samego stylu wystarczy nacisniecie sekwencji Ctrl+Enter
i nastepnie Enter.

Przy korzystaniu z panelu Quick Apply mozna wykorzystaé te same skréty
do usuwania przestonie¢, ktére s3 dostepne w menu Clearing Overrides. Aby
zastosowac styl przy uzyciu szybkiego stosowania, jednoczesnie usuwajac cate
formatowanie lokalne, trzeba nacisnaé¢ Cmd+Return (Ctrl+Enter), aby uaktywnié
panel, po czym przytrzyma¢ Option /Alt w momencie wybierania odpowied-
niego stylu (kliknieciem mysza lub klawiszem Return/Enter).

Edytowanie stylow
Piekno koncepcji styléw polega miedzy innymi na tym, ze mozna ich defini-
cje zmienia¢ w dowolnym momencie. Zmiana taka powoduje, ze caly tekst
sformatowany przy uzyciu tego stylu zostanie przeskladany, odzwierciedlajac
nowg definicje. Ta cecha styléw stanowi podstawowa wilasciwosé programéw
DTP od czaséw epoki kamiennej.
Style zapewniaip nieznany wezesnie) swobode eksperymentowania z esketyka,
dokumentu. Wystarczy kilka kliknie¢ i mozna kompletnie przetransformowaé
AL SIEGRITENU S VI O S T R
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Najbezpieczniejsza metoda przejscia do edycji stylu jest klikniecie nazwy stylu
prawym klawiszem myszy i wybranie Edit z menu podrecznego. W ten spos6b
nie ma ryzyka, ze niechcacy zastosujemy styl nie tam, gdzie bysmy chcieli.

Po otwarciu okna dialogowego opcji stylu mozna zmienia¢ pojedyncze
atrybuty albo dokona¢ wielu zmian jednoczesnie — po kliknieciu OK zostana
wprowadzone do dokumentu. Aby poczué sie bezpieczniej, mozna najpierw

utworzy¢ duplikat stylu, aby méc tatwo powréci¢ do poprzednich ustawien.

W tym celu wystarczy przeciaggnaé nazwe stylu na ikone Create New Style
(Utwérz nowy styl) w dolnym pasku panelu.

Przedefiniowywanie stylu

Inng metoda modyfikowania stylu jest ,zmiana przez przyktad”. Mozemy
po prostu zmieni¢ atrybuty wybranego akapitu, aby wygladat zgodnie z nowa
koncepcja, uzywajac lokalnych przestonieé, po czym uzyé polecenia Redefine Style
(Zmien definicje stylu) w menu podrecznym wyséwietlanym po kliknieciu nazwy
stylu prawym klawiszem myszy. Trzeba jednak zauwazy¢, ze opcja ta nie bedzie
dostepna, jesli przestoniecia w zaznaczonym tekscie beda niejednolite.

T PARACRAPH STYLES Py ——
iz L dascripions &y
| by i A
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Apply "description® then Next Style, Clear Overrides | Copy to Group... | i
| Copy to Group... i __ New Group fmmSMts | E
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- i TOC Bady Text |
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Ladowanie stylow z innego dokumentu

Wiele mozna powiedzie¢ na temat bardziej i mniej wydajnych technik pracy

w InDesignie, ale jedna z rzeczy, na ktére warto poswiecié czas, jest przy-

gotowanie rozbudowanego, ale elastycznego zbioru styléw (arkusza styléw)
i wykorzystywanie go wielokrotnie w réznych pracach. Kazda publikacja, czy

bedzie to kolejny numer czasopisma, wydanie gazety, czy wreszcie ksigzka nale-

z3ca do serii wydawniczej, zawiera okreslony typ struktury, ktéry nie zmienia
si¢ pomigdzy wydaniami. W kazdym takim wydawnictwie znajdziemy tytuly
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RYSUNEK 12.6 Klikniecie
prawym klawiszem myszy
nazwy stylu wywoluje menu
podreczne, pozwalajace

na edycje stylu (po lewej)
albo na wiaczenie biezacych
przestonie¢ do definicji stylu
(po prawej).
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RYSUNEK 12.7 Wybranie
polecenia Load All Text Styles

w menu palety styléw akapito-
wych lub znakowych pozwala
zaimportowac style z innego
dokumentu.

Wew Parsgraph Style...

Delete Seyde... o\ onesscrn s
Radefine Stybe Coxs |l oo
Style Options._.. B e
Chear Overndes .

Covmonrt “(Bauthc Paraarant?” Sullers and Mumbeing to Text

Break Link to Style D e
\oad : P
Select All Unused . bt
Hew Stk Grosp... i s
Dpers Al Stybe i omscrs ;

Chte Al Style Croups g
Copy to Groug... § o

Rew Group Brom Seykes. Q =

Sort by Mame Ty mrwess

réznych pozioméw hierarchii, §rédtytuly, cytowania, podpisy ilustracji i wiele
$cisle powigzanych ze soba wariantéw tekstu gtéwnego. Podczas wstepnego
tworzenia takiej struktury styléw wazniejsze jest zbudowanie powiazati pomie-
dzy nimi — czyli tego, ktére style s3 oparte na ktérych (i tym samym dziedzicza
z nich wszystkie te cechy, ktére nie zostaly w nich jawnie zmienione) — niz
to, jak owe style beda faktycznie wygladaé. Dysponujac taka hierarchiczna
strukturg, wystarczy zmieni¢ styl rodzicielski, aby rozpowszechnié¢ dokonana
zmiang na wszystkie style wywodzace sie z niego. Gdy uzywa sie takiego arku-
sza, kompletne przekomponowanie dokumentu i zmiana jego wygladu wymaga
wykonania tylko kilku ruchéw.

Gdy zdefiniujemy juz style w jednym dokumencie, mozna je ponownie wyko-
rzystac (wszystkie lub tylko ich podzbiér) w innych dokumentach. Ta sama
regula dotyczy tez takich elementéw, jak strony wzorcowe, prébki koloréw
i inne cegietki, z ktérych budowany jest dokument. Aby skopiowa¢ style aka-
pitowe, nalezy uzy¢ polecenia Load Paragraph Styles (Wczytaj style akapitowe)
z menu panelu Paragraph Styles. Dostepna jest tez opcja Load All Text Styles
(Wczytaj wszystkie style tekstowe), ktéra powoduje skopiowanie takze styléw
znakowych. Po wskazaniu dokumentu zrédlowego i kliknigciu Open pojawi sie
okno dialogowe, w ktérym mozna dokonaé wyboru podzbioru styléw do skopio-
wania, a takze okresli¢, jak program ma sie zachowa¢ w przypadku konfliktu
nazw, czyli wéwczas, gdy obydwa dokumenty zawieraja style o identycznych
nazwach. Dostepne opcje to zastgpienie definicji importowanym stylem albo
przemianowanie wczytywanego stylu, co spowoduje dotaczenie do jego nazwy
stowa ,copy”. Styl taki mozna pézniej przemianowaé w razie potrzeby.
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Porzadkowanie stylow

Dobrze uporzadkowany arkusz stylu to prawdziwy dar dla produktywnoéci. Oto ~ UWAGA: W nazwach styléw
kilka wskazéwek (i moich osobistych preferencji), ktére moga poméc w zbudowa-  rozrézniane sa wielkosci
liter; na przyktad Body

Text i body text to dwa
Nazewnictwo. Warto mieé na uwadze, ze mozemy musieé wrécié¢ do naszego rozne style. Nalezy zatem
utrzymac precyzje podczas
tworzenia styléw — w prze-
ciwnym razie moze sie

go bedzie dopracowywac albo wykorzystywac jako wzorzec dla nastepnych prac.  okazac, 7e mamy dwie

niu takiego arkusza, z ktérego bedzie mozna sprawnie i wygodnie korzystaé.

dokumentu za kilka miesiecy lub nawet lat, wiec nazwy styléw powinny by¢
przejrzyste. Moze si¢ tez zdarzy¢, ze nasz dokument trafi do innej osoby, ktéra

W kazdym wypadku nie chcielibyémy traci¢ czasu na odkrywanie lub thumacze- ~ wersje styluizadnej
wskazdéwki, ktory z nich jest

nie komus, co ktéry styl miat realizowaé — powinno to jednoznacznie wynikaé tadd
wiasciwy.

zich nazw. Nie nalezy ba¢ sie nazw opisowych — czestym, ale moim zdaniem
fatalnym nawykiem, jest stosowanie trzy- lub czteroliterowych skrétéw, ktére
jednak juz po paru tygodniach staja sie zupelnie nieczytelne. Znacznie lepszym
pomyslem jest uzywanie pelnych wyrazéw i stosowanie si¢ do konwencjonal-
nego podziatu na ,kategorie”, takiej jak body, head, caption i tak dalej’.

Sortowanie. Opcja Sort by Name (Sortuj wedlug nazwy) w kazdej palecie styléw
powoduje uporzgdkowanie ich alfabetycznie wedlug nazw. Z tego wzgledu
przydatne jest rozpoczynanie nazw styl6w powiazanych ze soba od tego samego
wyrazu — zapewni to logiczne uporzadkowanie ich obok siebie. Mozna tez roz-
wazy¢ umieszczenie na poczatku najczedciej uzywanych styléw identyfikatora
cyfrowego — po posortowaniu samoczynnie znajda sie one na poczatku listy,
a ponadto latwiej bedzie je odnajdywac w panelu Quick Apply. Na przyklad styl
dla tytuléw pierwszego poziomu mozemy nazwac o1_head — wéwczas wpisa-
nie tylko dwéch pierwszych cyfr w trybie szybkiego stosowania spowoduje
przeskok do wlasciwego stylu. Nalezy jednak zadba¢ o to, aby oprécz takiego
»skrétu” nazwa stylu zawierala czytelng informacje, czym styl jest i jakie jest
jego przeznaczenie,

Grupy styléw. Podobnie do folder6w w systemie plikéw, grupy styléw pozwalaja
logicznie uporzadkowaé powigzane ze sobg style, a takze ulatwiaja nawigacje
w bardzo rozbudowanych arkuszach styléw dzieki mozliwoéci ukrycia (zwinie-
cia) rzadziej uzywanych grup. Grupe styléw mozna utworzy¢, klikajac przycisk
Style group w dolnym pasku palety styléw, po czym nalezy poda¢ jej nazwe.
Alternatywnie mozna zaznaczy¢ kilka styléw, klikajac je kolejno z wcisnietym
klawiszem Cmd/ Ctrl (albo zaznaczajac kilka nazw z wcisnietym klawiszem

2 Polskiuzytkownik moze oczywiscie zechcie¢ stosowac polskie nazwy styléw, oparte
na takich stowach kluczowych, jak tekst, tytut lub podpis. Ze wzgledu na przenognosé
danych pomigdzy réznymi wersjami InDesigna i r6znymi platformami zalecane jest
jednak niestosowanie polskich liter w nazwach styléw.
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WSKAZOWKA: Styl, ktéry
nie jest jawnie uzyty

W pracy, nie zostanie zazna-
czony jako nieuzywany,
jesli stanowi czesc definicji
innego stylu. Dotyczy

to przede wszystkim stylow,
na ktérych oparta jest
definicja stylu potomnego.
Takze styl znakowy, ktéry
nie jest jawnie zastosowany,
ale zostat uzyty jako styl
zagniezdzony w definicji
stylu akapitowego, nie
zostanie zaznaczony,

nawet jesli odpowiedni

styl akapitowy nie jest
uzyty nigdzie w publikacji.
To samo dotyczy styléw
akapitowych wskazanych
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Shift), po czym wybrac polecenie New Group From Styles (Nowa grupa ze styléw),
aby umiesci¢ zaznaczone style w nowym folderze.

Mate wiersze w panelach. Opcja Small Panel Rows w menu panelu powoduje
wy$wietlanie nazw mniejsza czcionka i bez rozdzielajacych linii. Moze by¢
przydatna, jesli uzywamy bardzo wielu styléw i chcemy, aby panel styléw uka-
zywal ich wieksza liczbe (o ile mamy dobry wzrok).

Usuwanie nieuzywanych styléw. W trakcie pracy nad projektem czesto moze
si¢ zdarzy¢, ze w paletach znajdzie sie kilka styl6w, ktére zostaty przygotowane
do jakiegos celu, ale pézniej zdecydowali$émy sie na uzycie w tym miejscu innych
styléw. W rezultacie tylko zajmuja miejsce i utrudniaja rozpoznanie, ktére style
s istotne i powinny by¢ uzywane, a ktére nie. Opcja Select All Unused (Zaznacz
wszystkie nieuzywane) powoduje zaznaczenie kazdego stylu, ktéry nie jest
w zaden sposéb wykorzystywany w dokumencie. Po zaznaczeniu zbedne style

mozna usungc, klikajac ikone kosza na $mieci w dolnej czeéci panelu.

jako domyslne w defini- aske Paragraph]  § oomody Godystvied New Paragraph Style...
. . [Basic Paragraphi Duplicate Styles
cjach styléw obiektowych ¥ i3 bodrityies Delete Styles...
) ¥ (3 bodarves [ ;
i komérkowych. Z tego =Y pems Gy Redefine Style
wzgledu sprzatanie arkusza 00Body ro indent i Style Options...
stylow nalezy wykonywac w"‘""“"‘ Head?  Cndvm2 Clear Overrides
»0d géry do dotu”: najpierw ofiuice i Convert Style's Bullets and Numbering to Text
trzeba usuna¢ nieuzywane thady Y = bink 12 s
ityle oblektow.e i komhér— z: Crd+tlum 2 Cagtion Load Al Text Styles...
owe..nastepme akapitowe, — ]  SelectANUASSd
a dopiero na koncu style g
¥ [ sidebarandcaptions New Style Group...

znakowe. skdebar Open All Style Groups

sidebar head Close All Style Groups

Capraon

caption reverse

pull Guote

@ % 8 3 @ % B 3 .
A B C

RYSUNEK 12.8 Porzadkowanie stylow. (A) style akapitowe uporzadkowane w grupy; (B) te same
style wyswietlane w trybie matych wierszy; (C) przydatne opcje porzadkowe, tu w menu panelu
Paragraph Styles.



Tworzenie stylow domysinych

Utworzenie stylu — akapitowego, znakowego czy tez obiektowego, a takze
probek koloréw — bez zadnego otwartego dokumentu powoduje, ze style takie
beda obecne w kazdym nowo utworzonym dokumencie. T metoda mozna sobie
przygotowac szkielet arkusza stylow, ktéry bedzie od razu dostepny za kazdym
razem, gdy zaczniemy nowy dokument. To, ze nazwy tych stylow beda zawsze
takie same, nie musi oznaczac, ze muszg one wygladac tak samo. Wiekszos¢
dokumentéw zawiera takie elementy, jak tytuty, podtytuty, tekst gtéwny, podpisy,
paginy i tak dalej. To, jak one beda wygladalty, zalezy wylacznie od nas. Wazne
jest jednak, aby utrzymac wtasciwa hierarchie stylow. ;

Zbidér domysinych styléow mozna utworzy¢ ,na piechote”, nie majgc otwartego
zadnego dokumentu, ale mozna tez je zatadowa¢ w takim momencie z istnie-
jacego juz dokumentu. W ten sposéb pojawig sie nastepnie w kazdym nowym
dokumencie, ktory utworzymy p6zniej.

Laczenie krojow pisma

Definiowanie styléw akapitowych wymaga w szczegSlnoéci wybierania i dobie-
rania krojéw pisma — umiejetnosci, ktéra podobnie jak gotowanie, zalezy przede
wszystkim od intuicji i do$wiadczenia. Nie ma zadnych ,jedynie stusznych”
sposobéw postepowania, gdy chodzi o dobieranie krojéw pisma, ale mozna
wymieni¢ kilka czynnikéw, ktére ulatwia dokonanie dobrych wyboréw.

Wszechstronnos¢

Wybieranie czcionki dla publikacji w jakim$ stopniu podobne jest do wyboru
obuwia. Jezeli planujemy spacer po plazy, para klapek moze by¢ wszystkim,
czego potrzebujemy. Jeéli jednak po tym spacerze chcemy sie powspinac po ska-
tach, a nastepnie uda¢ sig na obiad, bedziemy potrzebowali czego$ bardziej
uniwersalnego — i to samo mozna powiedzie¢ o krojach pisma.

Uniwersalna rodzina krojéw powinna zawiera¢ szeroki zakres wag — od wersji
lekkich, przez standardowe, péltluste, ttuste i tak dalej — ktére pozwola
na zaznaczenie hierarchii informacji. Gdy londynski The Guardian przecho-
dzil wielkie zmiany projektowe na jesieni 2005 roku, wprowadzono w nim
stosowanie tylko jednej rodziny krojéw — Guardian Egyptian — ktéra zawiera
96 odmian o réznych wagach i szerokosciach. Naturalnie potrzeby codziennej
gazety i powiazanych z nig dodatkéw s3 znacznie wieksze od typowych, ale
pozwala to zrozumieé, w czym rzecz.

.....
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Korzysci z OpenType

Fonty w formacie PostScript Type 1 zawieraja do 256 znakéw. Fonty OpenType
moga potencjalnie zawiera¢ dziesiatki tysiecy znakow. Jesli nasz projekt wymaga
stosowania kapitalikéw, utamkéw, cyfr nautycznych lub odmian kontekstowych,
wybdr fontu OpenType (a zwlaszcza wersji Pro), zawierajacego poszerzony zestaw
znakéw, znacznie utatwi prace. Dodatkowa (i potezna) zaleta OpenType jest
ich wieloplatformowos¢: te same pliki fontéw moga by¢ stosowane zaréwno
w Windows, jak i Mac OS oraz innych systemach operacyjnych.

Konotacje historyczne

Zaleznie od natury naszego tekstu, mozna siggnaé po uwarunkowania his-
toryczne, aby podkresli¢ charakter treéci. Na przyktad tekst poswiecony
architekturze modernistycznej bedzie dobrze wspélgra¢ z Futura, podczas
gdy dla xviiI-wiecznej poezji wloskiej nalezatoby raczej wybraé Bodoni lub
inng antykwe klasycystyczna. By¢ moze wazniejsze od wyboru historycznie
odpowiedniego kroju jest to, aby nie wybra¢ kroju niepasujacego. Zgrzytem
moze by¢ na przyklad uzycie w tekscie historycznym kroju, ktérego koncepcja
zostala stworzona znacznie p6zniej, niz przedstawiany okres.

Ten sam projektant

Czesto pojawia sig potrzeba znalezienia kroju dopelniajacego dla wybranego
kroju (na przyktad kroju tytulowego dla ustalonej juz czcionki tekstu gtéwnego).
W takiej sytuacji nienajgorszym pomyslem jest przejrzenie innych czcionek
zaprojektowanych przez autora juz wybranego kroju w nadziei, ze znajdziemy
drugie pismo niosace podobna wrazliwos¢ i charakterystyke. Niektére kroje
zostaly wrecz zaprojektowane w parach przez swoich twércéw, przy czym
to dopasowanie jest czesto sugerowane przez ich nazwy, jak Stone Serif i Stone
Sans autorstwa Sumnera Stone’a. Oto inne przyklady par jednego autora (cho¢
juz bez wspélnoty nazw):

® Optima i Palatino (Hermann Zapf)
m Gill Sans i Perpetua (Eric Gill)
® Gotham i Mercury (Jonathan Hoefler i Tobias Frere-Jones)

Kontrast

Jednym z najbardziej skutecznych sposobéw ustanowienia hierarchii informa-
cji jest kontrast, a wyboér réznych fontéw jest jedna z metod osiagniecia tego
efektu. Inne parametry, ktére réwniez moga wprowadzaé kontrast, to wielkos¢,



Lorem ipsum dolor

Sit amet, consectetur adipiscing
elit. Quisque id massa quam, in
tempor nisi. Nunc fermentum
varius ipsum nec rutrum. Sapien
ut orci ultrices consectetur quis
vitae nisl.

Quisque lobortis

Posuere elit, eu cursus nisl ulla-
mcorper vitae. Quisque vehicula
metus nec quam ultricies tempus.
Sed eu turpis odio.

Optima/Palatino

waga, kolor, odmiana i forma. Na przyklad wersaliki tworza kontrast z malymi
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Lorem ipsum dolor
Sit amet, consectetur adipiscing elit.
Quisquc. id massa quam, in tempor

nisi, Nunc fermentum varius ipsum nec
rutrum, Sapicn ut orci ultrices consecte-

tur quis vitae nisl.

Quisque lobortis

Posuere elit, eu cursus nisl ullamcor-
per vitac. Quisque vehicula metus nec
quam ultricies tempus, Sed eu turpis
odio. Quisque vulputate diam vitae pu-
rus luctus sit amet rhoncus nisi iaculis.

Gill Sans/Perpetua

literami, antykwa z kursywa i tak dalej.

Lorem ipsum dolor

Sit amet, consectetur adipiscing elit.
Quisque id massa quam, in tempor
nisi. Nunc fermentum varius ipsum
nec rutrum. Sapien ut orci ultrices
consectetur quis vitae nisl.

Quisque lobortis

Posuere elit, eu cursus nisl ullamcor-
per vitae. Quisque vehicula metus
nec quam ultricies tempus. Sed eu
turpis odio. Quisque vulputate diam
vitae purus luctus sit amet rhoncus

Gotham/Mercury

RYSUNEK 12.9 taczenie
ze sobg krojow zaprojekto-
wanych przez tego samego
autora

Jesli potrzebujemy kontrastu, to zrébmy go. Nie uzywajmy krojéw, ktére

s3 zbyt podobne do siebie. Czytelnik nie dostrzeze réznicy albo tez réznica

ta bedzie zbyt subtelna i zadziala niepokojaco. Co gorsza, moze zosta¢ uznana

po prostu za blad. Analogicznie, przy taczeniu réznych wag tego samego kroju,

nalezy zachowa¢ odpowiedni dystans — light polaczymy z semibold, regular

z bold i tak dalej.

Helter Skelter

Cigzki/lekki

RYSUNEK 12.10 Kilka przy-
ktadéw faczenia krojow w celu
stworzenia kontrastu

Helter Skelter
Helter Skelter

Hel
He

He
He

He

ter Skelter
te rSkelter

SdSkelter

ter Skelter

ter et rellor-

Skondensowany/poszerzony

Reczny/maszynowy

Prosty/pochyly

Wielki/maty

Pozytyw/negatyw

Bezszeryfowy/szeryfowy

Minimalistyczny/dekoracyjny
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Moze to zabrzmie¢ jak zbytnie uproszczenie, ale raczej nie popelnimy duzego
bledu wybierajac kréj szeryfowy dla gléwnego tekstu i bezszeryfowy dla tytu-
lariéw. Kroje bezszeryfowe zwykle sprawiaja wrazenie solidniejszych, a tym
samym lepiej spelnia funkcje przyciagania uwagi czytelnika. Ponadto brak
szeryfoéw powoduje, Ze mozemy ciaéniej sktadac takie tytuly, nadajacim dodat-
kowego ciezaru. Aby odrézni¢ podtytul od zasadniczego tekstu, wystarczy

wybdr kontrastowego kroju — litery wcale nie musza by¢ wigksze.

Dopasowywanie wysokosci x

Jezeli kontrastujgce kroje maja by¢ uzyte w tym samym wierszu — na przyktad
w zywej paginie — nalezy dopilnowac, aby miaty te sama warto$¢ x-height (wyso-
kosci matych liter), w razie potrzeby tak korygujac stopien pisma dla jednego
lub drugiego kroju. Zmiana wysokosci x w obrebie jednego wiersza powoduje
wyrazny zgrzyt.

POVERTY

RYSUNEK 12.11 Dopasowy-
wanie wysokosci x i wysokosci
wersalikow

POVERTY

Bez dopasowania

Ucit lant audae volupta turernatem
dolo officabore lautem audae velluptis
inullaut ulparum, est inverae que sita

Bez dopasowania

Wyréwnana wysokos¢ wersalikow

Ucit lant audae volupta turernatem
dolo officabore lautem audae velluptis
inullaut ulparum, est inverae que sita

Wyréwnana wysokos¢ x

Typowy arkusz stylow

Projektanci dziet drukowanych i stron Web czesto odwoluja sie do list styléw,
uzywajac terminu arkusz styléw. Podrozdzial ten zawiera przykladowy, podsta-
wowy arkusz styléw, nadajacy sie do skladania czasopisma lub gazety.

Head1

Tytuly, szczegélnie te najwyzszego poziomu, czesto wykorzystuja ciezsze
odmiany kroju, takie jak bold lub black. Zaleznie od uzywanego kroju pisma,
moga wymagac ujemnych $wiatel i zmniejszonej interlinii, co da w efekcie
wzmocnienie szaroéci tekstu. Celem stylu Head1 jest wyréznienie fragmentu
tresciisklonienie czytelnika, aby chcial czytaé dalej. Tytul tego poziomu zazwy-
czaj osiaga ten cel, stawiajac pytanie lub sygnalizujac cze$¢ — najwazniejsza
czesé — informaciji.
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Head?2

Tytutl drugiego poziomu, inaczej podtytul, czesto wykorzystuje ten sam krdj,
co Heads, i jest generalnie oparty na nim, ale ze zmniejszonym stopniem
pisma w celu zaznaczenia nizszego poziomu w hierarchii. Podobnie jak tytut
najwyzszego poziomu, wykorzystuje odstepy przed akapitem (i by¢ moze po)
do odseparowania tytulu od tekstu. Takie formatowanie ulatwia czytelnikowi
przejsécie do odpowiedniego fragmentu i dzieli catoé na fragmenty, ktére buduja
widoczng strukture tresci.

Head3

Trzeci poziom tytuléw moze by¢ réwniez tytulem wlamanym, czyli takim,
w ktérym tresé tytutu stanowi czesé akapitu tekstu gléwnego, nastepujacego
po nim. Tytul wlamany moze zosta¢ zrealizowany jako zagniezdzony styl
znakowy. Nadrzedny styl dla tego typu tytulu moze albo wskazywa¢ poprze-
dzajacy styl tytutowy, albo styl dla tekstu podstawowego, z ktérym jest blizej
spokrewniony.

Body

Podstawowy, najczesciej uzywany styl, nadajacy formatowanie tekstu gléwnego
izarazem zwykle ten, ktéry jest tworzony jako pierwszy. Rozpoczynajac prace
nad dokumentem, jesli nie dysponujemy zadnym wstepnym formatowaniem
(na przykiad zaimportowanym z dokumentu Word), mozemy zacza¢ od nadania
stylu Body calemu tekstowi, a potem wprowadza¢ inne, rzadziej wystepujace
style tam, gdzie s3 potrzebne. Styl Body zwykle (cho¢ nie zawsze) wykorzystuje
font szeryfowy w odmianie podstawowej i stopniu od 8 do 11 punktéw, z wcie-
ciem pierwszego wiersza dla uwidocznienia poczatku akapitu.

Body No Indent

Styl oparty na Body, pozbawiony wcigcia pierwszego wiersza. Styl ten jest zwykle
stosowany po Heads3 (jesli jest to styl samodzielny, a nie tytul wlamany).

Body First

Modyfikacja stylu Body No Indent z inicjalem wpuszczonym lub innym wyréz-
nieniem poczatkowego fragmentu (na przyklad przy uzyciu kapitalikéw), majacy
na celu wyréznienie poczatku tresci albo waznych czesci wewnatrz historii.

Byline

Wiersz zawierajacy imie i nazwisko autora. Czesto oparty na definicji stylu Body,
ale odrézniajacy si¢ zmiang wagi lub odmiany kroju oraz odstgpem przed lub
po akapicie (lub obydwoma).
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Caption

Podpis do ilustracji, zazwyczaj uzywajacy mniejszego stopnia pisma niz tekst
gléwny, a czesto rowniez innego kroju. W dzisiejszym, pelnym pospiechu swie-
cie, podpisy do zdjec s3 czesto tym, na co czytelnicy zwracaja uwage w pierwszej

kolejnosci. Podpis powinien zawiera¢ dos¢ informacji, aby czytelnik mégt
zdecydowac, czy chce sie zaglebi¢ w treé¢ zasadniczego artykutu. Projektant
zwykle nie jest odpowiedzialny za tres¢ podpiséw, ale jesli miesci sig to w jego

obowigzkach, powinien pamietaé¢, ze oprécz oczywistych informacji na temat
ilustracji, podpis powinien przede wszystkim tworzy¢ powiazanie pomiedzy
obrazem a tekstem.

Intro

Aby stworzy¢ dobry punkt do rozpoczecia lektury, w wielu projektach czasopism
poczatkowy akapit artykutu (lub jego kilka pierwszych wierszy) sktadany jest
wigkszym stopniem pisma, czgsto pogrubionym albo uzywajacym innego, kon-
trastujacego kroju. Taki akapit wprowadzajacy moze byé réwniez umieszczony
w szerszym tamie niz tekst gléwny (na szerokosé dwéch taméw lub nawet calej
kolumny). Do tej czesci moze by¢ réwniez wlaczony wiersz zawierajacy autora
iinne informacje o zrédle informacji.

Picture Credit

Informacje o autorze fotografii (agencji lub innym zrédle jego pochodzenia)
zazwyczaj sklada sie bardzo malym stopniem pisma, takim jak 5 lub 6 punktéw,
przy czym czesto sa one obrécone o 9o stopni i umieszczone obok fotografii,
na marginesie lub na dole strony, poza gléwnym tekstem. Ze wzgledu na maty
stopien zwykle wybierany jest tu font bezszeryfowy, zapewniajacy wieksza
czytelnoéé w matych rozmiarach.

Pull Quote

Wyimek to fragment ,wyrwany” z gtéwnego tekstu i uzyty podobnie jak
element graficzny. Jego cel to zwrécenie uwagi czytelnika i podkreslenie
szczegdlnie istotnego fragmentu informacji lub wypowiedzi. Powinien by¢
zarazem prowokujacy i zwiezly. Wyimki dodatkowo moga urozmaicaé wyglad
strony, szczegdlnie w sytuacji, gdy brak materiatu ilustracyjnego lub jest go
bardzo malo.

Wyimek sktadamy czcionka tytulows. Powinien zapewnia¢ znaczny kon-
trast wizualny w stosunku do tekstu gléwnego i zosta¢ umieszczony tak, aby
przyciagnac wzrok potencjalnego czytelnika, ktéry tylko przeglada czasopismo,
wertujac kartki.
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Matka wszystkich stylow: funkcja ksiegi

Mozna znacznie usprawnic zarzadzanie stylami, uzywajac funkcji Book (Ksiega)
programu InDesign, dzieki ktorej mozna nadac jeden zestaw stylow catej grupie
dokumentow. Ksiege tworzymy poleceniem File > New > Book (Plik > Nowy >
Ksiega). Panel Book umozliwia dotaczenie dowolnej liczby plikéw, ktére tacznie
tworza jedna publikacje. Dodanie kolejnego dokumentu mozna wykonac klika-
jac ikone plus w dolnej czesci panelu lub przeciggajac do niego pliki z Findera,
Eksloratora Windows albo z Bridge. Po utworzeniu ksiegi mozna synchronizowac
style, probki koloréw i inne atrybuty dokumentéw we wszystkich plikach skta-
dowych lub po jednym na raz. Funkcja ta umozliwia tez szybkie dodanie stylow
z jednego dokumentu do catej grupy innych.

W celu wykonania synchronizacji nalezy najpierw wskaza¢ dokument zr6-
dtowy (,wzorcowy”), klikajac pole obok nazwy w lewej kolumnie panelu, po czym
klikna¢ ikone synchronizacji w dolnej czesci panelu. Style, prébki koloréw, strony
wzorcowe, zmienne tekstowe i inne elementy zostang skopiowane z pliku wzor-
cowego do pozostatych, zastepujac istniejace juz, tak samo nazwane elementy
(oile istnieja). Style, probki i inne skfadniki, ktére nie istnieja w pliku wzorcowym,
pozostana niezmienione.

To, jakie komponenty uktadu dokumentu beda synchronizowane, mozna
ustali¢ przy uzyciu opcji Synchronize Options w menu panelu.

Synchronizacje ksiegi mozna wykonac bez koniecznosci otwierania poszcze-
gdlnych dokumentéw. InDesign otworzy kolejno te dokumenty, dokona zmian,
po czym zapisze i zamknie pliki. Dokumenty, ktére sg otwarte w momencie
synchronizacji, zostang zmienione, ale nie zapisane.

Aby zsynchronizowac tylko wybrane dokumenty, nalezy zaznaczy¢ je w panelu
przed kliknigeciem ikony synchronizacji. Jesli zaden dokument nie jest zaznaczony,
synchronizacja bedzie dotyczyta wszystkich plikow ksiegi.

S Add Document...
Replace Document...
Remove Document

Save Book
Save Book As...
Close Book

Preflight Book...
Package Book For Print...

Expart Book for Digital Editions...
Export Book to PDF...

Print Book...

Document Information...

Zrédto
synchronizacji

Synchronise Book
Synchronise Options. ..
Update All Cross-References

Update Numbering
Book Page Numbering Options....
Document Numbering Options..,

69-70 Automatic Document Conversion

f e ? = Small Panel Rows.

Marge kdentically Named Layers on Export

Synchronizuj Dodaj pliki do ksiegi

RYSUNEK 12.12 Panel Book
i jego menu
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Cytat powinien znajdowac si¢ na tej stronie, na ktérej zlokalizowany jest
cytowany tekst, albo na stronie poprzedzajacej. Dlugie zdania powinny zosta¢é
przeedytowane, aby stworzy¢ krétka, zwracajaca uwage wypowiedz. Mozna
tu zastosowaé rézne formy wyrézniania — obramowanie, odmienny kolor tekstu
lub tta albo uzupelnienie o dekoracyjne znaki interpunkcyjne.

Sidebar

Ramka boczna zwykle zawiera artykul zwigzany z gléwnym tekstem, ale bedacy
odrebng caloécig — na przyklad komentarz redakcyjny lub informacja uzupet-
niajaca. Zwyczajowo umieszczana jest obok gléwnego tekstu, skad pochodzi
zaréwno polska, jak i angielska nazwa (side — bok, bar — pasek). Powinna by¢
graficznie odseparowana od gléwnego tekstu, ale taczy¢ sie z nim kontekstowo.
Dlatego tez definicje tego stylu nalezaloby oprze¢ na stylu Body, po czym zmo-
dyfikowa¢ go tak, aby jednoczesnie zachowal podobieristwo i si¢ odrézniat.

Sidebar Head

Nagléwek ramki bocznej, czesto oparty na stylu Head1.

Style znakowe

Style znakowe umozliwiaja nadawanie formatowania wybranym fragmentom
tekstu wewnatrz akapitéw. Style te moga by¢ wzgledne wobec stylu akapitowego,
w ktérym s3 stosowane, ale moga by¢ réwniez niezalezne i jawne. Na przyktad
styl znakowy zmieniajacy odmiane pisma na kursywe moze zostaé zdefinio-
wany jako styl jednoparametrowy, ktéry bedzie wspéldziatal z kazdym stylem
akapitowym, o ile ten ostatni uzywa kroju, w ktérym istnieje taka odmiana.
Oto przyklad tworzenia takiego stylu:

1. Otwérz panel Character Styles (Style znakowe) i wybierz polecenie New
Character Style z menu panelu.

2. Nazwij nowy styl, po czym kliknij opcje Basic Character Formats (Podsta-
wowe formatowanie znakowe) w lewej czeéci okna dialogowego.

3. Z listy Font Style (Styl czcionki) wybierz Italic, pozostawiajac wszystkie
inne atrybuty bez ingerencji.

Jesli styl taki zastosujemy do tekstu wewnatrz akapitu ostylowanego przy
uzyciu fontu Garamond 10 pt, font zmieni sie na Garamond Italic 10 pt. Jesli
nastepnie zmienimy styl akapitowy (lub definicje aktualnego stylu), wybierajac
jako font podstawowy Caslon 11 pt, tekst z ,naszym” stylem znakowym bedzie
zlozony przy uzyciu Caslon Italic 11 pt. Z drugiej strony jednak, jesli chcemy,
aby nasze wyréznienie zawsze stosowalo font Centaur Italic 10 pt, mozemy
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Aebemncrd Characie Femans
Charmctnr Colsur
OpenType Fastares
ndevins Opcion:
Sarhthmgh Optioa

RYSUNEK 12.13 Po lewej:
tworzenie jednoparametro-
wego stylu znakowego, ktory
od styléw akapitowych, style znakowe zmieniaja tylko lokalne formatowanie  zachowa wszystkie atrybuty
przekazywane ze stylu akapi-
towego z wyjatkiem zmiany
w tym samym miejscu, aplikacja nowego stylu znakowego usuwa poprzednio stylu czcionki. Po prawej: styl
bardziej bezposredni, definiu-
jacy wieksza liczbe atrybutow.

uwzgledni¢ wszystkie te atrybuty w definicji stylu znakowego. W odréznieniu
dla zaznaczonego tekstu. A poniewaz nie mozna zastosowaé dwéch styléw

zastosowany.

Ze stosowaniem wzglednych styléw znakowych wiaze si¢ pewne ogranicze-
nie. Poniewaz istnieja réznice w konwencjach nazewniczych réznych krojéw
pisma, czasami uzywanie takich styléw prowadzi do komunikatu o braku-
jacych czcionkach. Zalézmy, ze uzywamy stylu dla kursywy, stworzonego
w opisany wczesniej sposob i zastosowalismy go do akapitu wykorzystujacego
font Helvetica. Zaleznie od tego, jaka to wersja Helvetiki (od jakiego producenta
pochodzi), Helvetica moze uzywaé albo cztonu ,Oblique”, albo oznaczenia
numerycznego zamiast okreélenia ,Italic”. W rezultacie tekst zostanie pod-
$wietlony na rézowo, aby zasygnalizowa¢ fakt, ze nie ma takiego fontu, jak
»Helvetica Italic”.

Importowanie styléw z dokumentéw Microsoft Word

Zaznaczenie pola Show Import Options w oknie dialogowym Place podczas
importowania plikéw programu Microsoft Word, takich jak .doc, .docx lub
rtf, wyéwietla rozbudowane okno dialogowe, w ktérym mozna okreéli¢, czy
chcemy zachowad, czy raczej usuna¢ style i formatowanie z dokumentu. To,
co nalezy wybraé, w istocie zalezy od tego, jak dobrze (lub jak zle) zostalo
wykonane formatowanie pliku Word. Jeéli autor (operator programu Word)
dobrze wykonal swoja prace, nie ma sensu powielanie jego wysitkéw. Z drugiej
strony jednak, jesli dokument zawiera zbyt wiele dziwacznego formatowania,
zmuszajacego nas do mozolnego domyslania sie, ,,co poeta mial na mysli”, czesto
lepszym (i szybszym) wyjsciem jest wyrzucenie tego catego $mietnika pod-
czas importu i rozpoczecie pracy od czystej tablicy. Nieco mniej drastycznym
podejéciem jest odrzucenie styléw i formatowania, ale zachowanie lokalnych
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przeslonieé — w ten sposéb bedziemy mogli je pézniej przeksztalci¢ na style
znakowe, co opisalem w ramce ,Zachowywanie formatowania znakowego
w importowanych dokumentach Microsoft Word”
Jesli mamy do czynienia z dobrze przygotowanym tekstem, mozna wia-
czy¢ opcje Customize Style Import (Dostosuj importowanie), po czym kliknaé
Style Mapping (Przypisanie styléw), aby wyswietli¢ okno ukazujace liste styléw
obecnych w importowanym dokumencie Microsoft Word. Dla kazdego z nich
mozemy wskazac¢ istniejacy juz (zdefiniowany w naszym dokumencie) styl
lub poleci¢ wezytanie go jako nowego stylu. Co wiecej, jesli nazwy w doku-
mencie Word s3 identyczne, jak w InDesignie, style zamapuja sie na siebie
automatycznie. W takiej sytuacji ustawienia zdefiniowane w InDesignie zawsze
RYSUNEK 12.14 Zamapo- maja pierwszenstwo, zatem nie musimy martwic sie o dopasowywanie stylow.
wanie stylow Word na style Dodatkowo dla poszczegdlnych styléw znakowych dostepna jest opcja catko-
InDesigna powoduje,

ze umieszczony tekst jest
automatycznie formatowany.

witego ich zignorowania (zamiany na brak stylu znakowego).
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Zachowywanie formatowania znakowego
w importowanych dokumentach Microsoft Word

Pliki dokumentéw Microsoft Word (niemal) zawsze i niezmiennie zawieraja mase
skandalicznego formatowania, ktore nalezy wymazac jak najszybciej, zanim
w ogdle zaczniemy ksztattowac tekst zgodnie z przyjetym uktadem. Problem
w tym, ze w tym catym $mietniku moga by¢ réwniez informacje uzyteczne —
typowym przyktadem sa wyrdznienia tekstu — ktore chcielibysmy zachowac.
W takiej sytuacji przed zaaplikowaniem naszych styléw i wyczyszczeniem prze-
stonie¢ powinnismy przeksztatcic lokalne formatowanie oznaczajgce wyréznienia
na style znakowe.

Aby zademonstrowac to na przyktadzie, zat6zmy, ze trzeba zachowac miejsca
wyréznione kursywa w zaimportowanym dokumencie:

1. Otwieramy okno dialogowe Find/Change, klikamy pole Find Format, po czym
w oknie dialogowym Find Format Settings przechodzimy do karty Basic
Character Format i tam z listy odmian kroju czcionek wybieramy ,Italic”.

2. Klikamy pole Change Format, po czym wybieramy zdefiniowany w naszym
dokumencie styl znakowy dla kursywy z listy styléw.

3. Klikamy Change All.

Teraz wszystkie teksty z nadang kursywa maja przypisany styl znakowy. Mozna
teraz zaznaczy¢ caty tekst (Cmd/Ctrl+A), po czym klikng¢ prawym klawiszem
myszy i wybrac Clear All Overrides (Wyczys¢ wszystkie przestoniecia). Polecenie
to wymaze cate niepotrzebne formatowanie, ale kursywy pozostawi nietkniete,
gdyz czyszczenie przestonie¢ nie dotyka styléw znakowych. Co wiecej, uzyska-
lisSmy w ten sposéb kontrole nad wygladem wyréznieri w tekscie — aby zmienic
sposob wyréznienia, wystarczy przeedytowac definicje nadanego im stylu zna-
kowego. To réznica pomiedzy zrobieniem tylko jednej zmiany a koniecznoscig
wykonywania ich bardzo wielu.

:,_._..
'~

RYSUNEK 12.15 Zmienianie
lokalnego formatowania (prze-
stonied) na style znakowe przy
uzyciu Find/Change.
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RYSUNEK 12.16 Ustawienia
formatujace mozna skopio-
wacé za pomoca narzedzia
Eyedropper. Podwdjne klik-
niecie narzedzia pozwala
okresli¢, jakie atrybuty beda
uwzglednione. Klikniecie

pustym kroplomierzem powo-

duje zapamietanie ustawier,
ktdre nastepnie mozna nadaé
w innym miejscu.

UWAGA: Przesuniecie

linii gérnej ani dolnej nie
zmienia odstepéw gérnych
i dolnych zdefiniowanych
dla tego akapitu.

Nadawanie styléw przy uzyciu kroplomierza

Narzedzie Eyedropper (Kroplomierz) umozliwia szybkie skopiowanie forma-
towania (w tym styléw akapitowych i znakowych) z jednego miejsca do wielu
innych. Po wybraniu narzedzia wystarczy klikna¢ akapit, ktéry juz zostat
wlasciwie sformatowany. Ikona narzedzia zmieni sig na ,,napetniony kroplo-
mierz” — kliknigcie nim w dowolnym innym akapicie nada mu formatowanie
odczytane ze zrédla. Mozna réwniez klikna¢ i przeciagna¢ narzedziem, aby
zaznaczyc fragment tekstu, jesli chcemy przeniesé styl znakowy. Kroplomierz
pozostanie napelniony, wiec mozemy nastepnie nadac¢ to formatowanie kolej-
nym akapitom lub fragmentom tekstu. Podwéjne kliknigcie narzedzia pozwala
okresli¢, jakie atrybuty formatowania maja by¢ kopiowane.

Linie akapitowe

Kazdy, kto cho¢ raz rysowat kreske ponad wierszem tekstu tylko po to, aby
pézniej zobaczy¢, ze tekst odjechal w sing dal, pozostawiajac ja gdzies w tyle,
uzna funkgje linii akapitowych (Cmd+Option+J/ Ctrl+Alt+J) za nieoceniona.
Pozwala ona dodac¢ linie ponad lub pod akapitem i gwarantuje, ze beda sie one
przemieszcza wraz z tekstem, jesli nastapi przesklad, bez obawy, ze oderwa
si¢ od niego i znajda w zupelnie nieoczekiwanym miejscu.

Opcja Rule Above (Linia gérna) tworzy kreske, ktérej dolna krawedz spoczywa
na linii bazowej i rozcigga w gére. Uzycie dodatniego przesuniecia (Offset) pod-
nosi kreske w gére wzgledem linii bazowej, za$ przesuniecie ujemne — w dét.
Rule Below (Linia dolna) dziala analogicznie, ale przy przesunigciu réwnym
zero to gérna krawedz kreski pokrywa sie z linig bazowa, zas dodatnie prze-
sunigcie powoduje odsuniecie kreski w dét. Obie linie umieszczane s3 pod
tekstem, co oznacza, ze mozna w ten sposéb w prosty sposéb utworzy¢ tto dla
pojedynczego wersu.

Przyklady zademonstrowane na rysunku 12.17 obejmuja przesuwanie tych
linii o r6zne wartosci, niekiedy tak duze, ze terminy ,gérna” i ,dolna” przestaja
miec sens.

Sekwencje stylow

Bardzo czesto mamy do czynienia z sytuacja, gdy pewien okreélony styl powi-
nien zawsze nastgpowac po innym. Opcja Next Style (Nastepny styl) w definicji
stylu akapitowego pozwala zdefiniowa¢ sekwencje styléw, ktéra nastepnie moze
zostac zaaplikowana jednym kliknieciem. W dokumentach, ktérych ostylo-
wanie tekstu jest oparte na spéjnym wzorze — czyli w wigkszosci — pozwala
to skréci¢ do minimum czas potrzebny na mozolne nadawanie wtaéciwych



COLUMN WIDTH RULE

Linia gérna o szerokosci tamu. Tekst otrzymat
mate (2 punkty) wciecie z lewej, aby utworzy¢
niewielki margines po lewej stronie linii.

TEXT WIDTH RULE

Jak wyzej, ale dtugosc linii zostata ograniczona
do szerokosci tekstu i wciecie z lewej ustawiono
na -2 punkty.

RULE ABOVE AND BELOW

Jednopunktowa linia dolna na szerokos¢ ko-
lumny, umieszczona na szczycie 12-punktowej
linii gérnej na szerokosc tekstu.

—
RULE ABOVE AND BELOW

6-punktowa linia dolna z wcieciem z lewej i pra-
wej, ustawiona na jednopunktowej linii gérnej.

LOZENGE RULE

11-punktowa linia dolna z wigczonym stylem
kropkowanym natozona na ciggta linie gérna.
Linia dolna ma ujemne wciecia z lewej i prawej.
Efekt ten wyglada najlepiej, jesli tekst tytutu zlo-
2ony jest wersalikami, co ufatwia optyczne wy-
réwnanie tekstu wzgledem linii tworzacych ,tio”.
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RYSUNEK 12.17 Kilka
réznych zastosowan linii
akapitowych, niektére faczace
zarowno linie gorne, jak

s i dolne, z réznymi przesunie-

- [ Rute Above i) ¥ il ciami i wcieciami. Kazde z nich
! m:i 3o L] - - {— wymaga starannego dopaso-
Colour: | IRPANTONE 302 C Tint: = 100% i | i e ioni
. ; wania przesuniec w pionie.

Offset: & -0p4.122

Right Indent. = -0p10.393 | |

Nadanie linii nad tekstem koloru dodatkowego,
ustawienie koloru tekstu na [Paper] i trybu przezro-
czystosci ramki tekstowej na Multiply tworzy efekt,

w ktorym litery s3 ,oknami’, przez ktére widad ilustra-
cje pod spodem.

Sarikethough Options. .

Mo Break N
 Adobe Paragraph Composer

Adobe Single-line Composer

Omily Align First Line to Grid
Balance Ragged Lines

. <ol ||
Keep Optices... THK
Span Columes...
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RYSUNEK 12.18 Jedno
klikniecie robi wszystko: za-
aplikowanie sekwencji stylow
do tekstu po lewej daje w re-
zultacie sformatowany tekst
widoczny po prawej.

styléw, jednoczesnie gwarantujac sp6jnosé i jednolito$¢. Prostym przyktadem
takiej sekwencji moze byé¢ styl podtytulu, po ktérym zawsze powinien nastapic
styl tekstu gtéwnego bez wcigcia akapitowego. Co wigcej, sekwencje stylow
moga by¢ do wykorzystane w réznego typu listach — takich jak spis zawartosci
w czasopi$mie — pozwalajac szybko wykona¢ prace, ktéra inaczej wymagataby
sporo zmudnej dlubaniny.

Zatézmy dla przyktadu, ze mamy do czynienia z listg imprez, w ktérej
wystepuja kolejno: data wydarzenia, jego nazwa, a po nim opis — kazde
w oddzielnym akapicie i dla kazdego mamy zdefiniowany odpowiedni styl
akapitowy — nazwijmy je kolejno date, title i description. Dla stylu formatujacego
date ustawimy jako nastepny styl dla nazwy imprezy, a dla tego z kolei — styl
dla oméwienia. Zaznaczamy cala sekwencje tekstu. W panelu Paragraph Styles
klikamy prawym klawiszem myszy nazwe date i z menu podrecznego wybieramy
Apply ‘date’ then Next Style (Zastosuj ‘date’ i nastepny styl) — w menu zawsze
pojawi sie nazwa kliknigtego stylu. Wszystkie trzy akapity zostana sformato-
wane jednoczeénie. Zwréémy uwage, ze musimy zaznaczy¢ wiecej niz jeden
akapit, aby opcja ta w ogdle pojawila sie w menu! Jesli taka sekwencja powtarza
sig regularnie, mozna p6jé¢ jeszcze krok dalej i ustawi¢ styl date jako nastepny
dla description, po czym zaznaczy¢ caly tekst i ostylowaé go jednym kliknigciem!
Jest to jednak tylko teoretyczna opcja, poniewaz takie regularne powtarza-
nie sie wzorca w rzeczywistoéci rzadko sie zdarza — dla ktéregos wydarzenia
moze brakowac¢ opisu albo tez nazwa lub opis beda zajmowac wiecej niz jeden
akapit i cala wymyslna struktura zawali si¢ jak domek z kart. Wprawdzie, gdy
mamy blok informacji jednego rodzaju rozciggniety na kilka akapitéw, mozemy

18 West 18 West
Mutations features hip house and Mutations features hip house

soulful beats from Mutiny, Raymon- and soulful beats from Mutiny,

do Rodriguez and Kris Bones. Raymondo Rodriguez and Kris Bones.
AKA Bar, West Central Street, WCI ?g; ‘:::3 ;";;‘; g)ﬂe;r:_ i:f::;ﬂ'ﬂ
(020-7836 0110) 6pm-4am, £7, free free before 9pm il
before 9pm .

ART ~ART

Acquired Rhythm Taste sees John Acquired Rhythm Taste sees John
Shepeard (Juno) select vinlage elec- Shepeard (Juno) select vintage

_ electronic dance.
tronic dance.

The Warwick, Essex Road, N1
(020-7688 2882) 8pm—lam, free.
Bang Face

Neo-rave explosion of acid, jungle,
old school rave, drum’n’basss, nu
skool, break core and techno with
Andrew Weatherall, Remarc, DMX
Krew and the Hard Crew.
Electrowerkz, Torrens Street, EC1
(020-7837 6419) 9pm—S5am, £10.

The Warwick, Essex Road, N1
(020-7688 2882) 8pm-1am, free.

“'Bang Face

Neo-rave explosion of acid, jungle,
old school rave, drum'n'basss, nu
skool, break core and techno with
Andrew Weatherall, Remarc, DMX
Krew and the Hard Crew.
Electrowerks, Torrens Street, EC1
(020-7837 6419) 9pm-5am, £10.
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prébowac zastapié konce akapitéw wymuszonymi ztamaniami wiersza, dzigki
czemu zostanie zachowany podzial, ale z technicznego punktu widzenia bedzie
to pojedynczy akapit — jednak nie zadziala to dobrze przy sktadzie justowanym,
apoza tym, czas potrzebny na poprawianie akapitéw wecale nie bedzie krétszy
od czasu niezbednego do ich recznego stylowania.

Opcja Next Style okresla réwniez styl, ktéry zostanie przypisany kolejnemu
akapitowi po naci$nieciu Enter — ale tylko wtedy, gdy kursor tekstowy znajduje
sie na konicu akapitu. W innym wypadku nastapi po prostu podzial akapitu
na dwa, ostylowane identycznie. Funkcja ta jest zatem przydatna, jesli wpi-
sujemy tekst bezposérednio w InDesignie, za$§ w innych sytuacjach jest malo
przydatna.

Style zagniezdzone
Zagniezdzanie stylow polega na osadzaniu stylu znakowego — lub kilku styléw
znakowych — w definicji stylu akapitowego, dzieki czemu mozna jednym kliknie-
ciem lub skrétem klawiszowym nada¢ zmienne formatowanie wewnatrz akapitu,
eliminujac konieczno$¢ wielogodzinnej haréwkii dajac sobie czas na wigcej kre-
atywnoéci. Najlepsze za$ w stylach zagniezdzonych jest to, ze ich konfiguracja
jest prosta, dzieki czemu mozemy ich uzywac czesto i bez wysitku.

Aby utworzy¢ styl zagniezdzony, nalezy najpierw zdefiniowa¢ styl znakowy,
ktéry bedzie dolaczony do stylu akapitowego. Nastepnie trzeba wykona¢ naste-
pujaca procedure:

1. Otwérz styl akapitowy do edycji.

2. Naliscie po lewej stronie okna dialogowego wybierz Drop Caps and Nested
Styles (Inicjaly wpuszczone i style zagniezdzone).

3. Kliknij New Nested Style (Nowy styl zagniezdzony), po czym wybierz przy-
gotowany styl znakowy z listy rozwijane;j.

4. Okresl, jak ma sie ,wylaczy¢” styl znakowy. Domyslnie styl zagniez-
dzony biegnie od poczatku akapitu do miejsca okreslonego warunkiem
w definicji. Moze zatem ciggnac sie przez okreslong liczbe znakéw lub
stéw albo do warunku wybranego z menu rozwijanego, pojawiajacego sie
po kliknieciu ostatniej pozycji w wierszu definicyjnym. Mozna tez wstawi¢
tu okreglony znak korica, na przyktad érednik lub dwukropek. Jesli taki
delimiter nie pojawi sie w danym akapicie, styl znakowy nigdy nie zosta-
nie wylaczony i zostanie zastosowany do calego akapitu. Opcja Through
(Przez) okresla, ze dany delimiter ma mieé przypisany styl zagniezdzony,
podczas gdy opcja Up To (Do) powoduje, ze styl znakowy zakonczy sie
na ostatnim znaku poprzedzajacym wskazane miejsce.

WSKAZOWKA: InDesign
udostepnia tez niewi-
doczny i niedrukowalny
znak End Nested Style

Here (Tutaj zakorncz
zagniezdzony styl). Warto
zdefiniowad sobie wiasny
skrot klawiszowy dla tego
symbolu. Méj wiasny wybaor
to Ctrl+Cmd+Option+X
(w Mac 0S).
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WSKAZOWKA: Pole
delimitera w definicji stylu
zagniezdzonego moze
zawierac wiecej niz jeden
znak. Taka sekwencja nie
jest jednak interpretowana
jako wyrazenie, ale jako
lista. Na przyktad, jesli
wpiszemy tam liste kilku
znakow przestankowych —
17 — styl zagniezdzony
zakoriczy sie po natrafieniu
na pierwszy znak z tej listy.

WSKAZOWKA: Przy
tworzeniu arkusza stylow
warto pomyslec o tym,

ze by¢ moze nie bedziemy
jedynymi uzytkownikami
tego arkusza. Moze sie

tez zdarzyc, ze wrocimy

do niego za kilka mie-
siecy lub nawet lat. Warto
zatem wprowadzic jakas
konwencje nazw, ktora
bedzie zwracata uwage

na to, ze dany styl akapi-
towy wykorzystuje style
zagniezdzone. Przyktadem
moze by¢ pokazana obok
koricéwka ,_ns" dolgczona
do nazwy stylu.

Jesli potrzebny jest nam wiecej niz jeden styl zagniezdzony, ich kolejnos¢
mozna zmienic uzywajac ikon ze strzatkami w gére i w d6t w oknie opcji stylu
akapitowego. Formatowanie okreélone przez drugi styl znakowy zaczyna sie
bezposrednio po zakoficzeniu dzialania stylu pierwszego. Réwniez odliczanie
znakéw, stéw itp. identyfikujacych miejsce zakoniczenia rozpoczyna sie od korica
pierwszego stylu, nie zachodzi zatem ryzyko, ze pierwszy styl ,przykryje” drugi —
chyba ze w calym akapicie nie wystapi jego warunek koricowy.

Wszystko to brzmi pieknie, ale co zrobig, jesli nasze akapity nie gwarantuja
nam zadnej jednolitej reguly, ktéra mozna by wykorzystaé do zakorniczenia stylu
znakowego? W takim wypadku mozna wstawi¢ do tekstu znak specjalny End
Nested Style Here (Tutaj zakonicz zagniezdzony styl), ktéry robi doktadnie to,
co wynika z jego nazwy — wylacza dzialanie stylu zagniezdzonego w punkcie
wstawienia. Oto kilka praktycznych zastosowan styléw zagniezdzonych.

Lista produktéw lub utworéw

W tym przykladzie style zagniezdZone uzywane s3 w polaczeniu z lista nume-
rowang. Styl dla tytutu (,title”) jest przypisany do pierwszej spacji pétfiretowej.
Dalsza czeé¢ akapitu nie ma przypisanego stylu zagniezdzonego (czyli [None])
przez dlugoé¢ jednego zdania. Jako koniec zdania przyjmowane sa kropka, znak
zapytania i wykrzyknik. Kolejny styl znakowy przypisany jest do stowa, ktére
w tym wypadku jest dtugoscia utworu (zwréémy uwage, ze ,,stowo” moze by¢
ciagiem cyfr, ktére nie s rozdzielane spacjami, ale moga zawiera¢ kropke lub
inne znaki przestankowe).

Tytut wikamany

Tytuly wlamane stanowia czesto ostatni (najnizszy) poziom srédtytultéw, gdzie
tytul znajduje sie w tym samym wierszu, co nastepujacy po nim tekst. Jest
on odrézniany od tekstu kontrastowym krojem pisma. Kluczem przy stosowaniu
tytuléw wlamanych (i wszystkich innych zastosowan styléw zagniezdzonych)
jest ustalenie jednolitego elementu koricowego. Moze nim by¢ dwukropek, kropka

lub jedna ze spacji o ustalonej szerokosci, oddzielajaca tytut od tekstu.

Spis tresci

Jeden z czesto spotykanych styléw spiséw tresci polega na umieszczeniu
na poczatku wysunietego numeru strony w zmienionym formatowaniu (inng
czcionka, wagg lub kolorem). Dalsze zagniezdzone elementy moga obejmowaé
nagléwki wskazujace dzial czasopisma, do ktérego nalezy dany artykut. W poka-
zanym przykladzie znaczniki dzialéw uzywaja innego koloru niz reszta tekstu.
Poniewaz niektoére z nich s3 jednowyrazowe, a inne dtuzsze, separacje znacznika
dziatu od reszty pozycji musi realizowaé znak End Nested Style Here (Type > Insert
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Special Character > Other > End Nested Style Here). Znak ten nie ma domyslnego
skrétu klawiszowego i na pewno warto zdefiniowaé sobie wtasny.

Powtarzanie stylow

Aby powtérzy¢ sekwencje styléw, tworzac w rezultacie petle naprzemiennego
formatowania obejmujaca caly akapit, nalezy na koncu doda¢ kolejny styl
zagniezdzony i wybra¢ [Repeat] ([Powtarzanie]) z listy nazw styléw znakowych RYSUNEK 12.19 Cztery

515212 s - . . ; proste i praktyczne przy-
f)raz okreslié liczbe st}-rlow, ktére maja by¢ powtarzane. Domy$lnym wyborem Kiady stosowania stylow
jest tu cala poprzedzajaca sekwencja. zagniezdzonych

1 EVERYTHING IN ITS RIGHT
PLACE Enit prate feugueril ute
faciliquat auguercipsum dunt
dolor il ex ea auguera esequate
dolum velesectet luptat. 4.11.

2 KID A Nulla feu facilit aliquam,
venis nullut lor summy nulla
atumsan ulla con ulputat ipisim

vero dolore feuipsu! 4.44. e D
3 THE NATIONAL ANTHEM Scilit s _ [ B
lobore esendre raesent inciniam, R | B o [ Tndum o e Charcin

core magna feugiam conullaore
doluptat luptat, cor senim quis L
nisim illa facilit? 5.51. I reviem B St At Page Number

Lista produktéw lub utwordw

This is a run-in head: elessendio el exero | (oot
consenisit iliquat velesed tatie velessenibh erilisit > :
niscin et nulputpat diat illa feuipisl utpat ex etue

Tytut wiamany

37 FILM Don’t Judge The Damned United by =~ temecsyw
| page through 1 Words

David Pearce’s novel, says Richard Kelly | o ey vt ]

40 TV Gives Peace another chance with C4's
Red Riding Trilogy

45 TABLE TALK Everything you needed to

know about skyscrapers
Spis tresci
one two three four five six = —]
seven eight nine ten == ma s )

Powtarzanie styléw — zamienne stosowanie formatowania przy uzyciu opcji [Repeat], pozwalajace
np. na wyrodznienie poszczegdélnych cztonéw, gdy lista wypunktowana zajmowataby zbyt wiele miejsca.
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RYSUNEK12.20 Dwa przy-
ktady uzycia zagniezdzonych
styléw wierszy: zastosowanie
kapitalikéw dla pierwszego
wiersza akapitu (u gory) oraz
wyrdznienie naprzemiennych
wierszy za pomocg opgji po-
wtarzania sekwencgji styléw
(u dotu).

Zagniezdzone style wierszowe

Standardowe style zagniezdzone s3 stosowane do okreslonego punktu wewnatrz
tekstu — obejmuja ustalong liczbe znakéw, stéw, zdan albo tez koricza sie
na jakims delimiterze, ktéry jednak réwniez jest czescia tekstu jako takiego.
We wczeéniejszych wersjach programu InDesign nie istniala jednak mozliwoéé
automatycznego przypisania stylu dla okreslonej liczby wierszy akapitu — tego
typu rozwigzanie musialo by¢ tworzone recznie. Dlatego od wersji InDesign ¢S4
pojawil sie wariant stylu zagniezdzonego, ktéry dopasowuje zasieg stylu
do jednego lub kilku kolejnych wierszy tekstu. Oczywiste zastosowanie tej
opcji to wyréznienie pierwszego wiersza, na przykltad poprzez sformatowa-
nie go kapitalikami. Inne mozliwe zastosowanie to wzmocnienie kontrastu
miedzy wierszami wewnatrz akapitu poprzez naprzemienne ich sformatowa-
nie — na przyklad zastosowanie tla.

i |
T ALICTIO RRUMQU! AUTATUR? GENT RERIBUS A e meses soie 3 |
dolligni bla venim ab idelicias id que perit, quas  wwaoesm
et volorem nus evelic temporit, occusae plicim [ == o i ] i
I
i

venis duntio. Hil ipsum, ut et, sediorpor adi ut
asin nimin cuptisti voluptatem faces enda con cuscimp

At alictio rrumqui autatur? Gent reribus a dolligni bla

o !

venim ab idelicias id que perit, quas et volorem nus et
H 1 11 1 1, HE blue Hned for 1 Nems il

evelic temporit, ocusaepllcmvenls ul:lo, Hil ipsum, [ (e ] {H |

ut et, sediorpor adi ut asin nimin cuptisti voluptatem L) 2|

3 AT

faces enda con cuscimp orent, sus dolore arcitia qui

Style GREP

Mechanizm wyrazen regularnych, czyli GREP, rozszerza mozliwosci wyszu-
kiwania tekstu, pozwalajac definiowaé wzorce wyszukiwania zawierajace
najrozmaitsze zmienne, symbole wieloznaczne itp. GREP kojarzy sie przede
wszystkim z funkcjami wyszukiwania i zastepowania (Edit > Find/Change albo
Cmd+F/ Ctrl+F), gdzie mozemy wyszukaé tekst spetniajacy warunki wzorca
i zamieni¢ go na co$ innego lub nada¢ mu okreslone formatowanie. Te druga
funkcje mozna czesto zrealizowaé prosciej, uzywajac styléw GREP. Zamiast
przeszukiwania tekstu i nadawania formatowania tekstowi spetniajacemu
warunek, mozemy warunek ten uczynic czescia definicji stylu akapitowego —
dzieki temu formatowanie zostanie nadane automatycznie, réwniez po edycji
lub podmianie fragmentéw tekstu.

Konstruowanie stylu GREP wymaga dwéch elementéw: wyrazenia GREP
identyfikujacego tekst, ktéry ma zosta¢ sformatowany — czyli tego, co wpi-
saliby$my w pole Find What — oraz stylu znakowego, ktéry ma zostaé nadany
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pasujacemu tekstowi. Caly tekst pasujacy do wzorca, ktéry zostal sformato-
wany stylem akapitowym zawierajacym styl GREP, otrzyma wskazany styl
znakowy. Najprostszym przykladem zastosowania tego mechanizmu moze
by¢ wyréznienie pewnych okreslonych nazw (produktéw, ksigzek) wyttuszcze-
niem lub kursywa. Gdy styl GREP zostanie utworzony, ma wplyw na wszystkie
wystapienia ciagéw znakéw pasujacych do wzorca, ktére znajda si¢ w akapicie
uzywajacym tego stylu (i wszystkich styléw potomnych)®. Jesli styl GREP ma
by¢ stosowany dla kilku réznych wzorcéw, mozemy je wymienic kolejno, roz-
dzielajac kreska pionowa (|). Jesli na przyktad chcemy nada¢ styl znakowy
nazwom Ford, Volvo i Mazda, w polu To Text definicji stylu GREP wpiszemy
Ford|Volvo|Mazda. Warto tu przypomnieé, ze w wyrazeniach GREP domy$lnie
rozrézniana jest wielkosé liter — stowo ford nie zostanie sformatowane przy
zastosowaniu takiego warunku. Podczas definiowania stylu GREP warto wigczy¢
podglad efektéw na zywo, szczegélnie podczas budowania bardziej ztozonych
wyrazen sterujacych.

6.00am Breakfast 10.00 Sy ... Paragraph Style Options
Saturday Kitchen 11.30 T
Football focus 12.10
The Politics Show
13.00 FILM The GREP
Adventure

3 Dla polskiego czytelnika najbardziej oczywistym zastosowaniem tego mechanizmu
bedzie eliminacja wiszacych spéjnikéw. Aby to zrealizowaé, musimy utworzy¢ styl
znakowy, narzucajacy atrybut No Break (Bez dzielenia). Styl ten powinien zostac
nadany kazdej spacji, ktéra nastepuje po jednoliterowym spéjniku. Wyrazenie regu-
larne identyfikujace taka spacje ma postaé ,(?:)(?<=\<[aiouwz]) ” — bez cudzystowéw,
ale ze spacja po zamykajgcym nawiasie.

UWAGA: Wiecej informa-
¢ji na temat GREP mozna
znalez¢ w publikacji
«InDesign C54: Learning
GREP", dostepnej w biblio-
tece online Lynda.com oraz
w ksigzce Petera Kahrela
+GREP in InDesign CSz/
CS4”", wydanej przez O'Reilly
Media.

RYSUMNEK 12.21 Prosty styl
GREP, zastosowany do pro-
gramu telewizyjnego w celu
wyréznienia kolorem stowa
FILM. Styl zagniezdzony nie
zadziatatby w tym wypadku,
gdyz potozenie stowa FILM

w akapicie moze byc zmienne,
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UWAGA: InDesign CSs
umozliwia generowanie
aktywnych lub statycznych
podpisdéw na podstawie
metadanych obrazu,
jednoczesnie nadajac styl
akapitowy tworzonemu
podpisowi. Niestety, nie
ma mozliwosci nadania
stylu obiektowego ramce
z podpisem.

Style obiektowe

Style obiektéw powstaly poprzez przeniesienie koncepcji lezacej u podstaw
stylow akapitowych i znakowych na struktury wyzszego poziomu — ramki
tekstowe i graficzne. Style akapitowe i znakowe pozwalaja zapamieta¢ wszelkie
atrybuty tekstu. Analogicznie, styl obiektowy moze zawiera¢ dowolne atrybuty
ramki: grubosc i kolor obrysu, styl linii, kolor wypelnienia, opcje oblewania
tekstem, efekty specjalne, takie jak cien lub przezroczystosé i tak dalej. Jesli styl
dotyczy ramki tekstowej, dodatkowo moze tez definiowaé atrybuty specyficzne
dla tej klasy ramek: liczbe laméw, wewnetrzne marginesy, wyréwnanie w pionie,
a nawet domyslny styl akapitowy dla zawartego w ramce tekstu. Definicja
stylu moze ré6wniez okresla¢ opcje dopasowania zawartosci, co moze znacznie

przyépieszy¢ umieszczanie ilustracji w dokumencie.

Formatowanie ramek opisowych

Jedna z czesci definicji stylu obiektowego moze by¢ styl akapitowy, ktéry ma
by¢ przypisany do tekstu w danej ramce, co pozwala okre§li¢ zaré6wno atrybuty
ramki, jak i tekstu jednym kliknieciem. Style obiektowe staja si¢ w ten sposéb
bardzo wygodnym narzedziem formatowania takich elementéw, jak podpisy
do zdje¢ lub uwagi na marginesie (takie jak w tej ksigzce).

Przechodzac na nastepny poziom automatyzacji mozemy zauwazy¢, ze oprécz
mozliwoéci wskazania stylu akapitowego mamy do dyspozycji opcje Apply Next
Style (Zastosuj nastepny styl). Jak mozna sie domysle¢, jej uzycie dziata podob-
nie do opisanego wczeéniej sekwencyjnego aplikowania styléw — jesli ramka
zawiera wiecej niz jeden akapit, kolejne zostana ostylowane zgodnie z tym,
co zostalo zdefiniowane w stylu wskazanym jako pierwszy w stylu obiektowym.
Sprébujmy pokazac to na przykladzie.

Zalézmy, ze projektujemy miesiecznik, w ktérym wszystkie artykuly stosuja
si¢ do tego samego schematu stylistycznego: tytut (head), podtytut (strapline),
autor (byline), pierwszy akapit tekstu gtéwnego (body 1st) i wiasciwy tekst gléwny
(body). Zaczniemy wigc od ustalenia opcji Next Style dla poszczegélnych styléw,
a nastepnie:

1. Otwieramy panel Object Styles (Style obiektowe) i wybieramy polecenie
New Object Style z menu panelu.

2. Nazywamy nowy styl, po czym klikamy opcje Paragraph Styles na liscie
Basic Attributes (Atrybuty podstawowe).

3. Zlisty styléw wybieramy head i zaznaczamy pole wyboru Apply Next
Style.

Teraz bedzie mozna nada¢ tekstowi cala sekwencje styléw, aplikujac nowo
utworzony styl obiektowy pierwszej ramce zawierajacej artykut.
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Powtarzalnos¢ wygladu elementéw, takich jak notki na marginesach lub
wyimki, mozna zapewni¢ zapisujac je w bibliotekach, dzieki czemu mozna
ich latwo uzy¢ ponownie, jedynie zmieniajac zawartos¢. Alternatywnym roz-
wigzaniem jest zdefiniowanie stylu obiektowego, ktory jednoczeénie narzuci
formatowanie ramki i sekwencje stylow akapitowych dla zawartoéci.

Did you know?

The oldest living tree in the
world is a California Bristle-
cone Pine named Methuselah,
It is about 4600 years old.

- Theoldest living treein
‘theworld is a California
Bristlecone Pinenamed
Methuselah. Itisabout
s600yearsold.

Style i obiekty zakotwiczone

Kto z nas nie ustawial pracowicie ilustracji, podpisu lub wyimka obok powia-
zanego miejsca w tekscie tylko po to, aby robi¢ to ponownie, gdy tekst zostat
przeedytowany? Tu wlasnie pojawiaja sie¢ zakotwiczone obiekty. Grafiki
w wierszu byly znane i uzywane od lat. Jesli grafika ma znalez¢ sie wewnatrz
strumienia tekstu, wystarczy wyciaé ja do schowka, wstawi¢ kursor tekstowy
w miejscu, w ktérym chcemy ja umiesci¢ (zazwyczaj w oddzielnym, pustym
wierszu), po czym wklei¢ zawarto$¢ schowka. Teraz ilustracja na pewno bedzie
sig przemieszcza wraz z tekstem, jesli ten przeleje sie inaczej — czy to z powodu
jego przeredagowania, czy tez zmiany formatu. Oczywiscie, konieczne jest sta-
ranne okreélenie pozycji grafiki wzgledem tekstu, a niekiedy moga tez pojawié
sie dziwne i nieprzewidywalne efekty, ale w wiekszosci sytuacji to podejscie
dziala zgodnie z oczekiwaniem — dopéki nie zechcemy, aby ilustracja znajdo-
wala sie¢ w okreslonej pozycji wzgledem ustalonego miejsca w tekscie, ale poza
ramka tekstowa. I to wlasnie jest zakotwiczony obiekt...

Obiekty takie moga znajdowa¢ sie w dowolnym miejscu, w szczeg6lnosci
poza ramka tekstowa i zachowywa¢ wzgledna pozycje w stosunku do tej ramki
ipolozenia kotwicy. Mozna tez nakazad, aby polozenie obiektu bylo okreslane
wzgledem grzbietu publikacji, na przyktad w ten sposob, aby obiekt zakotwiczony

RYSUNEK 12.22 Jedno
klikniecie, wiele rzeczy zrobio-
nych: niesformatowana ramka
tekstowa jest transformowana
w pole informacyjne z cienio-
wanym wypetnieniem i od-
powiednim formatowaniem
zawartego w niej tekstu.



RYSUNEK 12.23 Okno
dialogowe Anchored Object
Options umozliwia precyzyjne
okreslenie pozycji obiektu
zakotwiczonego. Mozna
oszczedzic wiele czasu zapi-
sujac raz dobrane ustawienia
w stylu obiektowym. W przy-
ktadzie ilustracje maja zasto-
sowany styl, ktéry umieszcza
je na prawo od ramki teksto-
wej na stronach prawych,

a na lewo na stronach lewych.
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byl zawsze po zewnetrznej stronie w stosunku do tekstu — na lewym marginesie
dla stron parzystych (lewych), ale na prawym dla nieparzystych.

Obiekt zakotwiczony moze by¢ ramka tekstowa, graficzna albo dowolng
kombinacja zgrupowanych obiektéw.

Aby utworzy¢ obiekt zakotwiczony, wystarczy umiescic¢ kursor tekstowy
w pozadanym miejscu (najlepiej na poczatku akapitu, ale nie jest to konieczne),
po czym uzy¢ polecenia Object > Anchored Object > Insert (Obiekt > Obiekt zako-
twiczony > Wstaw) — otrzymamy pusta ramke zakotwiczong w tekicie, ktéra
nastepnie mozna wypelnié odpowiednia zawartoscia. Jesli obiekt (ramka lub
grupa), ktéry chcemy zakotwiczy¢, juz istnieje, wystarczy wyciac go do schowka
i nastepnie wklei¢ jako grafike w wierszu. Pézniej nalezy kliknaé¢ go prawym
klawiszem myszy i wybra¢ polecenie Anchored object > Options, po czym zmieni¢
opcje Position (Pozycja) z (domyslnego) ustawienia Inline or Above (W wierszu
lub nad wierszem) na Custom (Wtasna).

Dokladne ustawienie zakotwiczonego obiektu w pozadanym miejscu wymaga
delikatnego dostrajania i jest do$¢ pracochlonne — dlatego warto ustawienia
te wlaczy¢ do stylu obiektowego. Po zaznaczeniu obiektu zakotwiczonego
nalezy otworzy¢ panel Object Styles i wybra¢ New Object Style z menu panelu.
Nowy styl bedzie zawieral wszystkie ustawienia pozycjonujace nadane temu
obiektowi. PézZniej mozemy zastosowac ten styl do ramek, ktére powinny by¢
zakotwiczone w tekscie. Warto zauwazy¢, ze nie bedzie to mialo zadnego efektu
na ramki niezalezne — dopiero po wklejeniu ich w tekst atrybuty zakotwiczenia
moga sie ujawnié i ramka znajdzie si¢ na wlasciwej pozycji wzgledem punktu
zakotwiczenia.

6 The evolution of hate Am quissecte
tie dit alit lam, vent accum velit ad
i vel digna feugiatet incip-
sum quis nummy nostrud esequi bla.
Re euissit la faccumsandre feui tate
commy niam zzriure min henim quip-
sum irit, con hendree tummod.

12 Arctic Monkey magic conseniam
vel euipsusto dolor se ver in ecte
dunt utpat. Iriustie mincidunt autat.
Lummy nibh eugiamet lobore tie
dolore min velenim vullum vel euguer
inibh elestrud eugue endiam.

14 Life after Castro Ut aliquisis aliquisi
tie velendi psuscipsusto od mincili
quationsed. Endipsum quam, con
henim jurem vercipit accum alit in
henit, consequiscip erosto odolum-
san esecte consequisi eugiam velenim
dolessim quissi et wismodo eugiam.

18 Style nulla faciduissi el ullamet
venim verillandre commolor senim.
aliquis nos eros nonsectet venisl in vercip
etum vel ut elit nim quamet prat, corem
ip ercip erilisit, sum nisit lorper in vel
exero commy nisit do odolore vulputa
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Podobnie jak w przypadku styléw tekstowych, style obiektowe moga E::;:-’::m Sty
opiera¢ sie na innych, co pozwala na zbudowanie zaleznoéci rodzic- Redefin stye
-potomek — zmiana atrybutéw stylu zZrédlowego powoduje zastosowanie S
. e . . . . .. L.  Clear Overrides When Applying Style
tej modyfikacji réwniez w stylu potomnym, o ile nie jest to wlasnie o s NotOufned by Sefe
ta cecha, ktéra styl potomny zmienia. _— Defauk Text Frame Siie .
Kazdy dokument zawiera dwa domy$lne style obiektowe: [Basic Text —*lucroarmm | LoxtObica Svs..
BETE sciect Al Unused
Frame] (Podstawowa ramka tekstowa) oraz [Basic Graphics Frame] = ™7™ e cronp..
Ogren AN Groups
(Podstawowa ramka graficzna). Style te s3 standardowo przypisywane Close A1 Groops
Copy to Groug...
do wszystkich ramek tworzonych w dokumencie. Style te mozna mody- Mew Gooup e Sk
Soet by Marme
fikowac, ale nie mozna ich usungé ani przemianowaé. Jesli chcemy, Smal Panel Rows
aby inny styl obiektowy byt domyslny dla nowo tworzonych ramek, o )
RYSUNEK

mozemy wskaza¢ go uzywajac polecenia Default Text/Graphics Frame Style 12.24 Wskazywanie domyél-
(Domyélny styl ramki tekstowej/graficznej) i wybierajac odpowiedni styl nego stylu obiektowego.
spoéréd istniejacych w dokumencie.

Style tabel i komorek

Style dla tabel i komérek to dalsze rozwiniecie tego samego podejscia ,,zrébmy to raz

iuzywajmy wielokrotnie”. Jakkolwiek stanowia znaczna pomoc przy pracy z doku-
mentem pelnym tabel, nie s3 rozwigzaniem wyczerpujacym. Style tabel zawieraja
takie atrybuty, jak obramowania lub kreski miedzy wierszami i kolumnami. Style

komoérek zawieraja atrybuty formatujace, takie jak wewnetrzne marginesy, domyslne

style akapitowe, kolory i grubosci obramowan lub wypelnienie. Jednak zadne z nich

nie zawieraja innych cech, takich jak okreslanie szeroko$ci (ani jawnych, ani wzgled-
nych) kolumn albo ustalenie, ktére komérki nalezaloby potaczy¢ (w istocie, skad

styl mialby to wiedzie¢?). Oznacza to, ze po zastosowaniu styléw nadal konieczne

jest dopasowanie szerokosci kolumn i potaczenie odpowiednich komérek.

W konstrukeji tych styléw istnieje pewna zawiloéé: styl tabeli zbudowany jest
troche jak rosyjska ,matrioszka”. Wewnatrz stylu tabelowego mozemy zawrzeé style
komérkowe, ktére z kolei moga zawiera¢ style akapitowe. Jeéli na przyktad definiu-
jemy styl tabeli, mozemy okresli¢, ktére jej czesci powinny uzywaé jakich styléw
komérkowych. Do wyboru mamy tu wiersze nagtéwka i stopki, lewa i prawa kolumne
oraz ,cialo” tabeli (czyli wszystkie te komérki, ktére nie s3 zadnymi z wymienionych).
Jesli nie okredlimy stylu komérkowego dla ktérego$ elementu, InDesign zastosuje
domyslna opcje Same As Body Rows (Tak samo jak wiersze podstawowe).

Style komérkowe nie musza koniecznie zawiera¢ wszystkich atrybutéw forma-
tujacych dla danej komoérki. Podczas tworzenia stylu okreslamy, ktére atrybuty
beda narzucane przez ten styl. W ten sposéb zastosowanie stylu zmienia tylko
te atrybuty, na przyktad kolor tla, ale pozostawia nietknigte wszystkie inne cechy,
ktére nie zostaly zdefiniowane w stylu.
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RYSUNEK 12.25 Okno Table Style
Options (Opcje stylu tabeli) zawiera
definicje obryséw wierszy i kolumn,
przemienne wypelnienia oraz ob-
ramowanie calej tabeli. Styl moze
réwniez okreslac, jakie style komaor-
kowe sa przypisywane poszczegol-
nym czesciom tabeli. W opcjach
stylu komérkowego (posrodku)
mozemy zdefiniowa¢ wewnetrzne
marginesy, obrysy (oddzielnie dla
kazdej krawedzi komérki — dolny
rysunek), a takze styl akapitowy,
ktdry zostanie narzucony tekstowi
w danej komérce.

aige s Tabl Seyle Opalons - 08t s 2.

[T | Stle Name: league table _ ]

Table Seup R
R Srroles G al
. - Style Info

el : o]

+ [Peome] + Paragraph Style: table + Top Szoke Calour: .
Sottors Siroke Colewr: [Nome] + Left Sroke Colour: [None] +

Style Settings
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Oblewanie tekstem

OBLEWANIE TEKSTEM TO POTEZNY SRODEK WYRAZU, oferujacy efektywna metode
zwiekszenia wizualnej atrakcyjnosci strony. Dzieki oblaniu tekstem nudny rysu-
nek moze stac sie intrygujacym ksztattem, a ,cegietkowa” konstrukcja strony
przeksztatca sie w co$ unikatowego i ciekawego. Jednak podobnie jak przy
innych zabiegach kompozycyjnych, oblewanie powinno by¢ uzywane roz-
waznie i z zachowaniem ostroznosci. Dobrze wykonane oblanie poprawia
wyglad zaréwno tekstu, jak i ilustracji. Jesli zostanie zrobione niestarannie,
ukfad strony bedzie robit wrazenie bylejakosci i amatorszczyzny. Gdy juz raz
zwrdcimy uwage na zle zrobione oblewania, zauwazymy, ze mozna je znalez¢
wszedzie. To zaskakujace, jak fatwo mozna zrobi¢ kiepskie oblanie tekstem. Tym,
co projektanci najczesciej przeoczaja, jest fakt, ze wstawienie grafiki wewnatrz
bloku tekstu powoduje zwezenie tamu. Ginie caly efekt starannego planowa-
nia i dobierania proporcji stopnia pisma do szerokosci tamu. W tym rozdziale
skoncentruje sie nad tym, jak tworzyc¢ dobre oblewanie tekstem — i jak unikng¢

typowych putapek, ktore prowadza do zlego.
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Stosowanie oblewania tekstem

Stworzenie dobrego oblania nie wymaga uzycia kosmicznych technologii,

potrzebuje za to zdrowego rozsadku — a do tego nieco recznego dopasowania.

Oto kilka prostych zastrzezen, ktére trzeba uwzgledni¢, jesli chcemy uzy¢

oblewania w naszym dokumencie:

Unikajmy oblewania, w ktérym tekst przeptywa wokét catego ksztattu
(po obu jego stronach). Taki sposéb oblania rozcina poziomy przebieg
tekstu, utrudniajgc lub wrecz uniemozliwiajac czytelnikowi odbiér tresci,
zmuszajac go do decydowania, czy ciag dalszy znajduje sie ponizej, czy
po drugiej stronie ilustracji. Jakkolwiek taki uktad jest technicznie wyko-
nalny i dostepny w InDesignie, nie znam sytuacji, w ktérej jego stosowanie
byloby uzasadnione i dopuszczalne.

Oblewanie powinno by¢ stosowane w potaczeniu z tekstem justowa-
nym. Tekst zlozony w choragiewke ma nieréwny, poszarpany brzeg,
a tym samym nie bedzie podkreslal ksztaltu grafiki w taki sposéb, jak
moze to uczynic tekst wyjustowany. Co powiedziawszy, trzeba zauwa-
zy¢, ze trudniej jest utrzymac jednolita szaro$¢ bloku tekstu podczas
justowania, zatem trzeba zadba¢ o to, by tam nie zostal nadmiernie
Zwezony.

Nalezy unika¢ sytuacji, w ktérej kolejne wiersze zaczynaja sie w innych
pozycjach horyzontalnych (z wyjatkiem wcigcia pierwszego wiersza).
Taki uktad utrudnia czytelnikowi odnalezienie kontynuacji i zmusza go
do szukania poczatku kolejnego wiersza. Przy znacznej nieregularnosci
mozemy utraci¢ rytm wierszy i w rezultacie obnizy¢ czytelnoé¢ tekstu.
Jedna z wazniejszych rzeczy jest wizualne wyréwnanie przestrzeni wokét
grafiki. To wiecej, niz tylko wybranie réwnych wartosci dla wszystkich
czterech stron. Pionowe odstgpy wokét oblanej grafiki zaleza od tego,
jak jest ona umieszczona w stosunku do linii bazowych otaczajacego
ja tekstu.

Jesli oblewamy tekstem ilustracje prostokatne, gérng krawedz ilustracji
nalezy wyréwnaé do linii wersalikéw albo linii minuskut tekstu w sasied-
nim lamie. Cokolwiek wybierzemy, trzeba zachowa¢ konsekwencje. Dolna
krawedz ilustracji powinna zosta¢ wyréwnana do linii bazowej pisma.
Sprawdzmy wszystkie wiersze, ktérych dotyczy oblanie. Jesli pojawia
si¢ problemy kompozycyjne, mozna sprébowac nieznacznie skorygowac
polozenie lub przeskalowa¢ grafike. Jesli to nie wystarczy, trzeba sieg-
nac po modyfikacje §wiatel, zmiane punktéw dzielenia wyrazéw, a jesli
to dopuszczalne, przeredagowanie tekstu.
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Jesli dokument zawiera wiecej oblewanych obiektéw, wszystkie powinny
uzywa¢ takiego samego odsuniecia od tekstu.

Nie prébujmy osiagnaé rzeczy niemozliwych. Jeéli ksztalt oblewanego
obiektu jest bardzo nieregularny, w wyniku otrzymamy zmienne dtugosci

wierszy, zbyt wiele podzialéw stéw, a takze wiele bialych dziur w tekscie,

Jesli uzywamy skiadu wielolamowego, grafike nalezy umiesci raczej

na krawedzi jednego z taméw, niz pomiedzy nimi.

Panel Text Wrap

Oblewanie tekstem jest definiowane za posrednictwem panelu Text Wrap
(Oblewanie tekstem). Opcje A-E zaznaczone na rysunku pozwalajg wybraé tryb
oblewania, podczas gdy F-H umozliwiaja dostrojenie wtasciwosci oblania.

A. Bez oblewania

B. Oblewanie dookota obwiedni — tworzy prostokatne oblanie wokét ramki
zawierajacej oblewany obiekt.

C. Oblewanie wokét ksztattu tworzy oblanie dopasowane do obrysu obiektu.
D. Pomijanie obiektu — tekst nie pojawi sie obok obiektu, a ,przeskoczy” nad
nim zgodnie z zadanymi odsunieciami.

E. Przejscie do kolejnego tamu — powoduje, Ze tekst nie pojawi sie ponizej
obiektu, lecz przejdzie do kolejnego tamu lub ramki tekstowej.

F. Odsuniecia od gory i od dotu okreslaja dystans pomiedzy oblewanym obiektem
a tekstem. Wartosci dodatnie odsuwaja tekst od krawedzi ramki oblewanego
obiektu. Warto$¢ ujemna pozwala umiescic granice oblewania wewnatrz ramki
obiektu. Zaleznos¢ ta staje sie swoim przeciwienstwem, jesli odwrécimy oble-
wanie uzywajac opdji Invert (Odwroc).

G. Opcja Wrap To (Oblewayj) okresla, z ktorej strony obiektu powinien pojawic sie
tekst (aktywne tylko przy oblewaniu wokét obwiedni lub ksztattu).

H. Contour Options (Opcje konturu) okreslaja sposob rozpoznawania ksztattu,
jesli uzywana jest opcja C.

A B C D E

é gi é ”£“ 0 RYSUNEK 13.1 Panel Text Wrap
e
[

1 Include Inside Edges
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WSKAZOWKA: Dodajac
oblanie do ilustracji nalezy
pilnowac, aby nadawac ten
atrybut ramce graficznej,

a nie samemu obrazkowi

w tej ramce. Ten drugi przy-
padek moze spowodowaé
znaczne i nieoczekiwane
problemy, jesli ilustracja
zostata przycieta, gdyz
oblewanie bedzie dotyczyto
petnego formatu obrazu,

a nie jego przycietych
rozmiardw.
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RYSUNEK 13.2 Nalezy unika¢
oblewania tekstu,ze wszyst-
kich stron” w pojedynczym
famie — taki uktad powoduje,
2e czytelnik nie wie, czy ma
tekst czytac jako dwa réwno-
legte tamy, czy ,przeskakiwaé”
ponad grafika do dalszego
ciagu wiersza.

RYSUNEK 13.3 Tekst wyju-
stowany (po prawej) lepiej
podkresla kontur oblewanej
grafiki niz tekst wyréwnany
do lewej. Jest to jeszcze lepiej
widoczne, gdy ukryjemy oble-
wany obiekt (u dotu).

RYSUNEK 13.4 Pozycjono-
wanie obiektu w pionie ma
wplyw na potrzebna wielko$¢
odstepu z gory i zdotu. Po le-
wej obraz zostat umieszczony
niestarannie, dajac nieréwne
odstepy powyzej i ponizej.

Po prawej gorna krawedz
obrazu zostata wyréwnana
do linii wersalikow tekstu,

a dolna do linii bazowej pisma
w odpowiednim wierszu ota-
czajacego tekstu.

InDesign i tekst  Profesjonalna typografia w Adobe InDesign

Poppies have long been used as a symbol of both sleep and
death: sleep because of the opium extracted from them, and
death because of their (commonly) blood-red color. In Greco-

Roman myths, pop-
ferings to the dead.
emblems on tomb-
eternal sleep. This
fictionally, in The
of Oz to create
fields, dangerous

pies were used as of-
Poppies are used as
stones to symbolize
aspect was used,
Wonderful Wizard
magical
because they caused

poppy

those who passed through them to sleep forever.

doluptis utecae moluptatus et fugiam doluptas
pero doluptatam, cum am fugitinciae nosan-
dandam dolorem. Itatur aspient quam que
latatis dolecat volut ut min nulloriam
dit, arum rere doluptate porepre

nobis aditi aut laborepudis explacearis
porestium faccus dolorum, unt. Usdanda
volupta que lignimolora ditiame et prat. Andi
con ra volorem quo quis autatusam que ped
moluptatur? Quist quiam quae. Ut que estis et
quati dolum hici odiciis dolum sent eicient nihil.

doluptis utecae moluptatus et fugiam doluptas
pero doluptatam, cum am fugitinciae nosan-
dandam dolorem. Itatur aspient quam que
latatis dolecat volut ut min nulloriam dit,

arum rere doluptate porepre nobis

aditi aut laborepudis explacearis

porestium faccus dolorum, unt. Usdanda
volupta que lignimolora ditiame et prat. Andi
con ra volorem quo quis autatusam que ped
moluptatur? Quist quiam quae. Ut que estis et
quati dolum hici odiciis dolum sent eicient nihil.

Wyréwnany do lewej

Raessequ atisisci tie ea alit irilisissim diam, cor aliquipit
aliquam consed tisi blam, sim nulla faci bla faccummy nos
nonullu mmodign iscilit augiat lutpatinis et do exer sum-
moloborem velissed te tisi et, consectet, consequis niat,
Ut duiscipis dipsum zzrit nullut lor sustin ut am, quate min
vercidui ea alit volore dit dolortio
dolore tisim voluptat, consequa-
met, quissi tem velent in hent alit,
quam aliqui ercillummodo dip es-
tie consenim nonsendrem volum
ing eugueros am iriurem vel iusto
dunt digna ad ming essequamet
nos dolorer si te magna feumsan
dignim nos atuerat. Equis num-
modi onulput acilis num il illut
loreet vel ullam veliquat. Ugue vel
ip eum zzrilis| utpat, vel ulla facilis
nostrud molor si te min volumsa
ndigniscil iurer incipisi.Met iure
endionum do esto dit lumsan ut
nostrud dolor si. Nos nim er at nulputem zzriure vel ut
adipisl utemn acipit incilla faccum velit nonulput utate do-
lore conulla ndiatuer iusto dolor sim doluptatie dionumsan
ullum do od eugiamet, consectem illam, quisci et volore
tem autem ex erat, sed tissi.Erilis ea faci te min ut ing et

doluptis utecae moluptatus et fugiam doluptas
pero doluptatam, cum am fugitinciae nosan-
dandam dolorem. Itatur aspient quam que
latatis dolecat volut ut min nulloriam dit,
arum rere doluptate porepre nobis aditi
aut laborepudis explacearis porestium
faccus dolorum, unt. Usdanda volupta que
lignimolora ditiame et prat. Andi con ra volorem
quo quis autatusam que ped moluptatur? Quist
quiam quae. Ut que estis et quati dolum hici odiciis
dolumn sent eicient nihil.

doluptis utecae moluptatus et fugiam doluptas
pero doluptatam, cum am fugitinciae nosan-
dandam dolorem. Itatur aspient quam que
latatis dolecat volut ut min nulloriam dit,

arum rere doluptate porepre nobis aditi

aut laborepudis explacearis porestium

faccus dolorum, unt. Usdanda volupta que
lignimolora ditiame et prat. Andi con ra volorem
quo quis autatusam que ped moluptatur? Quist
quiam quae. Ut que estis et quati dolum hici odiciis
dolum sent eicient nihil.

Wyjustowany

Raessequ atisisci tie ea alit irilisissim diam, cor aliquipit
aliguam consed tisi blam, sim nulla faci bla faccummy
nos nonullu mmaodign iscilit augiat lutpatinis et do exer
summoloborem velissed te tisi et, cc consequis
niat. Ut duiscipis dipsum zzrit nullut lor sustin ut am, quate
min vercidui ea alit volore dit dolortio dolore tisim vo-
luptat, consequamet, quissi tem
velent in hent alit, quam aliqui
ercillummodo dip estie consenim
nonsendrem volum ing eugueros
am iriurem vel iusto dunt digna
ad ming essequamet nos dolorer
si te magna feumsan dignim nos
atuerat. Equis nummodi onulput
acilis num il illut loreet vel ullam
veliquat. Ugue vel ip eum zzrilis!
utpat, vel ulla facilis nostrud mol-
or si te min volumsa ndigniscil
iurer incipisi.Met iure endionum
do esto dit lumsan ut nostrud do-
lor si. Nos nim er at nulputem zzriure vel ut adipisl utem
acipit incilla faccum velit nonulput utate dolore conulla
ndiatuer iusto dolor sim doluptatie dionumsan ullum do
od eugiamet, consectem illam, quisci et volore tem autem
ex erat, sed tissi.Erilis ea faci te min uting et velis nulputet




Rozdziat 13

Oblewanie wokoét nieregularnych ksztattow

Przygotujmy naszj ilustracje w Adobe Photoshop, tworzac warstwe maski
i zapisujac ja jako plik PsD albo dodajac $ciezke odcinania — w tym wypadku
mozemy uzy¢ formatu JPEG (PSD i TIFF tez beda dzialaé, ale JPEG zapewnia
mniejsza wielkoé¢ pliku). Po umieszczeniu obrazu w dokumencie InDesigna
i wlaczeniu oblewania mozemy uzy¢ opcji konturu i wybraé¢ Alpha Channel
(Kanat Alfa) albo Photoshop Path (Sciezka programu Photoshop), aby okresli¢
ksztalt obrysu ,,odpychajacego tekst”. Mozemy wéwczas skorygowaé wartosé
w polu odsunigcia gérnego (tylko to jedno jest wéwczas dostepne), aby ustali¢
wielko$¢ odsuniecia tekstu od tej $ciezki.

Co jednak, jesli nie mamy programu Photoshop? Mozemy sprébowaé utwo-
rzy¢ $ciezke odcinania bezposrednio w InDesignie. Opcja ta dziata dobrze
w przypadku ilustracji, ktérych tlo jest wyraznie skontrastowane w stosunku
do tresci (jednobarwne). Po zaznaczeniu ramki obrazu wybieramy polece-
nie Object > Clipping Path > Options (Obiekt > Sciezka przycinajaca > Opcje)
izlisty Type (Typ) wybieramy Detect Edges (Wykryj krawedzie). Funkcja ta jest
tez dostepna skrétem klawiszowym Cmd+Option+K (Ctrl+Alt+K). Konieczne
moze okazac sie przeniesienie ilustracji ,ponizej” tekstu, aby go nie zakrywala.
Mozemy to zrealizowaé poleceniem Object > Arrange > Send To Back (Obiekt >
U6z > Przesun do tylu) — Cmd/Ctrl+Shift+[.

Pudit, te re omnim nonsed que ipicillabo. Ut pora‘-
tusa con pelitas venihil iciistia nlend1
igentust et eni te everovi tent ’

|

res doluptati arumque moluptas’
dolori que nonsequae re corro om-
nis simaio ipiente mporest vepist
omnitam voluptus autem. Modit
lam, offici accus, ventis magnamet. -
plaboratem Is pa siminctecte. 4
pariorrum eate verit utasped
itatae volum si audioris cul{
lorrore nit ent explabor sumj
electibust, volupta venihici *
dollabore nobis doluptaest =* g
et occusa inveliae vel magnate-

mquatquo dolorem aut dit optatur sima dem nis
rehentia ne sunt doluptat

Aby zdefiniowa¢ oblewanie dla obiektu o nieregularnym ksztalcie, nalezy
zaznaczy¢ go i wybrac opcje oblewania ksztaltu w panelu Text Wrap. Nastepnie
mozna skorygowac przebieg linii odpychania tekstu przy uzyciu narzedzia Direct
Selection oraz Pen (Pi6ro). Wraz z opcjami edycji wezléw, umozliwiaja one nada-
nie §ciezce ksztaltu wedle wlasnego uznania i precyzyjne ustawienie oblewania.
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WSKAZOWKA: Jeéli mamy
obiekt oblewany na stronie
wzorcowej, ale nie chcemy,
aby ten efekt oddzia-

tywat réwniez na tekst

na zwyktych stronach,

po zaznaczeniu tego
obiektu mozna w panelu
Text Wrap wybra¢ polecenie
Apply to Master Page Only
(Zastosuj tylko do strony
wzorcowej).

RYSUNEK 13.5 Nieprzezro-
czyste biate tlo obrazu zostaje
~wyciete” przy uzyciu opcji
Detect Edges. Oblanie zostaje
ustawione na oblewanie we-
dhug ksztattu, co powoduije,
2ze tekst uktada sie wokdt
Sciezki przycinania. Krawedz
odpychania tekstu mozna sko-
rygowac uzywajac narzedzia
Direct Selection.



232 InDesign i tekst  Profesjonalna typografia w Adobe InDesign

RYSUNEK 13.6 Konwer-
towanie sciezki przycinania
na ramke graficzng w celu
natozenia lakieru na obraz

o nieregularnym ksztatcie.

Po skopiowaniu obiektu

i przeksztatceniu go na ramke
wypetniamy go kolorem
dodatkowym i umieszczamy
na oddzielnej warstwie, ktéra
pdiniej bedzie drukowana
oddzielnie.

RYSUNEK 13.7 Oblewanie
wokot kolistego ksztattu. Po le-
wej odlegtosc miedzy tekstem
a ksztattem w okolicy ,biegu-
now" wydaje sie wieksza, niz
w potowie wysokosci. Po pra-
wej $ciezka oblewania zostata
zmodyfikowana recznie, aby
zmniejszy¢ odsuniecie w gor-
nej i dolnej czesci ksztattu.

Aby doda¢ lub usunaé wezel na sciezce, nalezy przetaczy¢ sie na narzedzie

Piéro. Korzystanie z opcji edycji wezléw wymaga sporo wprawy, wiec warto

poswieci¢ troche czasu na wyéwiczenie wlasciwych nawykéw. Osoby, ktére

maja dosdwiadczenie w pracy z Adobe Illustrator, dostrzegg zapewne podo-
bienistwa, ale i réznice w funkcjonowaniu tych narzedzi. Po dopracowaniu

$ciezki odcinania mozna przeksztalci¢ ja na ramke graficzna, na przyktad

w celu dodania lakieru.

Object Layer Options...
Clipping Path
Image Colour Settings...

Options... TORK

Convert Clipping Path to Frame

Ukladanie sie tekstu wokél obiektu lepiej oceniaé wizualnie, niz polega¢ tylko
na liczbach wpisanych w panelu Text Wrap. Na przyktad przy oblewaniu owal-
nego ksztaltu moze sie okaza¢, ze powstaje wrazenie wigkszego odsuniecia

tekstu w gérnej i dolnej czeéci figury, niz w jego centrum, mimo ze wartos¢

odsuniecia jest ustalona jako jednolita odlegloéé¢ od jej brzegu.

Etum ex eriliquating enisl dunt la
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duipsum incilla facipisim iu-.-
reetue faccum quisi. Reet. 4
augue dolore magna
facidunt wis augueri-
usci eugait prat ipsus-|
cil dunt verat loboreet
lor sum zzriurem init’
num vullamet nullutpat
et wis del utem vent alit
utat. Em dolut augue tin .
voloreetuer sim in eugait at au-

giam nulla faccum init, se dip el eros
alisim zzrit am, core faccum in velis.

Etum exeriliquating enisl duntla feuis
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wisaugueriuscieugait,
pratipsuscil duntverat
loboreet lor sum-zzri-
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metnullutpatet wisdel -}
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dolutauguetinvoloreetuer.
simin-eugaitataugiam nullafaccum
init, se dipelerosalisim zzritam, core
faccum-in-velis.ent vendit ad molo-
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Zamiast polega¢ na funkcji wykrywania krawedzi (ktéra zadziata jedynie
wtedy, gdy obrys ksztaltu jest wyraZznie rozpoznawalny, czyli wystarczajaco
kontrastowy w stosunku do tla), mozna wykorzystaé narzedzie Pi6ro i recznie
narysowac ksztalt éciezki oblewania, po czym zastosowa¢ oblewanie dla tego
ksztaltu, a nie samego obrazu. Ksztalt taki oczywiscie nie powinien mie¢ obrysu
ani wypelnienia. Nastepnie mozna go zgrupowa¢ z obrazem (Cmd / Ctrl+G), aby
oba elementy mogly by¢ przemieszczane i przeksztalcane jako jeden.

Narzedzia utatwiajgce oblewanie tekstem: rysowanie
wiasnych ksztattow

InDesign, lllustrator i Photoshop zawierajg narzedzia rysunkowe, ktére umozli-
wiajg tworzenie wtasnych ksztattéw wektorowych.

Pen (Piéro). Kolejne klikniecia tworza linie tamana (proste odcinki z ,ostrymi’
weztami w miejscach klikniecia). Klikniecie i pociggnigcie tworzy segment krzy-
woliniowy z giadkimi zakoriczeniami. Przy takich weztach pojawiaja sie uchwyty,
ktére determinuja poczatkowy kierunek krzywej oraz stopien jej zakrzywienia.
Uchwytami tymi mozna manipulowac, przeciggajac punkty na ich koricach.
Dla nowicjusza dziatanie tego narzedzia moze wydawac sie nieco dziwne, ale

w praktyce okazuje sig, ze ma to sens.

Add/Delete Anchor Point (Dodaj/usun punkt kontrolny). Narzedzia te pozwa-
lajg dodac kolejny wezet w istniejgcej sciezce albo (odpowiednio) go usungc.
Mozina tez pozostac przy narzedziu Piéro i przesuna¢ kursor ponad segment
$ciezki — narzedzie zmieni sie chwilowo na dodawanie weztéw. Jesli narzedzie
Piéro umiescimy nad istniejacym weztem, zmieni sie ono chwilowo na usuwanie
weztow.

Convert Direction Point (Przeksztatcanie punktow kierunkowych). Aby prze-
ksztalci¢ wezet z ostrego naroza na gladki lub odwrotnie, nalezy uzy¢ tego narze-
dzia (mozna uaktywni¢ je chwilowo pracujac w trybie Piéra i przyciskajac klawisz

Option/Alt). Klikniecie gtadkiego wezla przeksztatca go na ostry, zas klikniecie

i pociagniecie ostrego wezla — na gladki z jednoczesnym wskazaniem kierunku

krzywej.

Selection (Zaznaczanie). Narzedzie umozliwia przemieszczanie lub transfor-
macje catej $ciezki.

Direct Selection (Zaznaczanie bezposrednie). Umozliwia wybranie poszczegol-
nych punktéw kontrolnych (weztéw lub uchwytéw), a takze catych segmentéw,
ktére nastepnie mozna przeciggac w celu zmiany ksztattu. Mozliwe jest zazna-
czenie (przy uzyciu klawisza Shift) i przeksztatcanie kilku weztéw jednoczesnie.
Dostep do narzedzia przy pracy z dowolnym sposréd narzedzi z grupy Piéro

mozna uzyskac przytrzymujac klawisz Cmd/Ctrl.

WSKAZOWKA: Skrypt
Dave'a Soundersa
WrapNudger utatwia
kompensacje nieregularnie
wygladajacych oblewan
obiektéw owalnych, mody-
fikujac sama grafike

bez poruszania tekstu.
Skrypt jest dostepny

w witrynie PDS Associates
(www.pdsassoc.com).

I. Q Pen Tool [
] () Kea anchor boint Teol =
3] {7 oot Anchor poine Tac!
@ I Comven Direction Poist Tool  ShiftsC

RYSUNEK 13.8 Narzedzia
grupy Picro
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RYSUNEK 13.9 Oblewanie

z obu stron obiektu moze
powodowac trudne do kon-
trolowania zachowanie tekstu
po jego prawej stronie (A).
Wybranie oblewania tylko

z lewej strony rozwiazuje
problem (B).

WSKAZOWKA: Jesli mimo
starannego ustawiania oble-
wania nadal nie jestesmy
zadowoleni z rezultatu,

a sciezka oblewania stata

sie juz zbyt skomplikowana,
mozna zaczac od poczatku,
wybierajac inng opcje

(na przyktad oblewanie
wokot ramki), a nastepnie
ponownie oblewanie wzgle-
dem ksztattu.

Opcje oblewania

Domyslnie oblewanie jest wlaczone dla obydwu stron obiektu, co, jak wspomi-
nalem wczesniej, jest zwykle niepozadane. Mozna unikna¢ nieoczekiwanych
efektéw, przelaczajac sie na oblewanie tylko z lewej lub prawej strony.
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Preferencje oblewania

Istnieje kilka ustawien preferencji, ktére maja wplyw na zachowanie tekstu
przy oblewaniu obiektéw, dostepnych na karcie Preferences > Composition
(Preferencje > Sklad). S to ustawienia dotyczace calego dokumentu i wszyst-
kie stanowig opcje typu ,wszystko albo nic™:

® Justify Text Next to an Object (Justuj tekst obok obiektu) powoduje

wyjustowanie tekstu znajdujacego sie na lewo od obiektu w pojedynczym
tamie. Ustawienie to nie powoduje wyjustowania tekstu sktadanego
w choragiewke, jesli wybrano tryb oblewania tylko z jednej strony lub
gdy obiekt rozciaga sie na wiecej niz jeden tam. W praktyce to ustawienie
nie ma wiekszej wartoéci, gdyz nie powinno sie stosowa¢é oblewania dla
tekstu zlozonego w choragiewke, a zwlaszcza nie nalezy oblewa¢ obiektu
z obu stron w ukladzie jednotamowym.

Skip By Leading (Pomin wedltug interlinii). Przy ukladzie wielotamo-
wym, gdy oblewanie dotyczy czesci, ale nie wszystkich taméw, ustawienie
to gwarantuje, ze tekst ponizej oblewanego obiektu zostanie przesu-
niety do kolejnej wielokrotnosci interlinii, gwarantujac wyréwnanie
linii bazowych w sasiednich lamach. Jednak lepsza metodg utrzymania
wyréwnanych wierszy w kolejnych tamach jest zastosowanie przyciaga-
nia do siatki (patrz rozdziat 4, ,Interlinia” oraz 14, ,Strony, marginesy,
tamy i siatki”).



® Text Wrap Only Affects Text Beneath (Oblewanie tekstem jest stoso-
wane tylko dla tekstu potozonego ponizej). Wiaczenie tej opcji powoduje,
ze InDesign bedzie sie zachowywal jak QuarkXPress, w ktérym oblewa-
nie ma wplyw tylko na tekst ponizej danego obiektu w stosie obiektow
na stronie. Dokumenty przekonwertowane z formatu QuarkXPress
przy uzyciu Q2ID firmy Markzware maja to ustawienie wlaczone. Dla
wszystkich innych dokumentéw lepiej jest pozostawi¢ je wylaczone.
Umieszczanie ilustracji ponad tekstem moze niekiedy powodowaé
trudnosci podczas drukowania, szczegélnie gdy nakladaja sie obiekty
z efektami przezroczystosci. Tekst oblewany wokét obiektu z cieniem lub
innym rodzajem przezroczystosci moze zosta zrastrowany, jesli znajdzie
sie ponizej obrazu w stosie obiektéw. Dla bezpieczenistwa zatem lepiej
jest, jesli tekst znajduje sie powyzej ilustracji, szczegélnie tych przezro-
czystych (ikona szachownicy w panelu Pages sygnalizuje, ze na danej
stronie lub rozkladéwece znajduja sie obiekty uzywajace przezroczystoéci).
Jesli chcemy, aby dany tekst nie podlegal dzialaniu oblewania, mozemy
to osiggnac w opcjach ramki tekstowej, zaznaczajac pole Ignore Text Wrap
(Ignoruj oblewanie tekstem). Wiecej informacji na ten temat zawiera
kolejny podrozdzial, ,Ignorowanie oblewania”.

Istnieje jeszcze jedna opcja, ktdra nalezy znad, ale nie jest to ustawienie prefe-
rencji dokumentu, lecz opcja warstw: Suppress Text Wrap When Layer is Hidden
(Pomin oblewanie tekstem, gdy warstwa jest ukryta). Aby wyswietli¢ opcje war-
stwy, wystarczy podwdéjnie kliknaé jej nazwe w panelu Layers (Warstwy). Jesli
ukryjemy warstwe zawierajaca obiekt z wlaczonym oblewaniem, tekst na innych
warstwach nadal uklada sie tak samo, omijajac oblewany obiekt. Dzieki temu
nie nastepuje przesklad, gdy ukryjemy lub ponownie wlaczymy widocznosé¢
warstwy. Mozna w ten sposdb osiagnaé interesujacy efekt ksztaltowania tekstu
bez pokazywania, wokél czego tekst sie przelewa. W istocie trudno jest mi sie
domysled, jaki cel przy$wiecal umieszczeniu tej opcji w programie, gdyz — jak
wida¢ — jej wiaczenie powoduje same problemy i nieprzewidywalno$é dziatania.
By¢ moze chodzilo o mozliwo$é wydrukowania wersji dokumentu zawierajacej
sam tekst, bez ilustracji — w praktyce jest jednak zupelnie bezuzyteczna i nie
powinna by¢ wlaczana.
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Skip by Leading ®Show Layer 8 Show Guides
(] Text Wrap Only Affects Text Beneath gmw« I Lock Guides
Print Layer

# Suppress Text Wrap When Layer is Hidden
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UWAGA: Po przekonwer-
towaniu dokumentéw
programu QuarkXpress

do formatu InDesigna
nalezy bardzo starannie
sprawdzi¢ wszystkie
oblewania. Poniewaz
mechanizmy oblewania

w obu programach dziataja
wedle innych regut i algo-
rytméw, moga wystapic
znaczace réznice pomiedzy
oryginalnym i przekonwer-
towanym dokumentem.

RYSUNEK 13.10 Opcje do-
tyczace oblewania tekstem

w preferencjach programu

(po lewej) i w oknie dialogo-
wym Layer Options (po pra-
wej). W tym ostatnim mamy
mozliwos¢ wylaczenia oblewa-
nia, gdy warstwa jest ukryta —
co$, czego raczej nigdy nie
bedziemy chcieli uzy¢.
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Odwrodcone i niewidoczne oblewanie

Zapewne nie jest to czesty przypadek, ale od czasu do czasu zdarza sie, ze chcie-

liby$my, aby tekst znalazl sie wewngtrz graficznego ksztaltu, a nie wokdf niego.

W tym celu musimy jedynie zaznaczy¢ opcje Invert (Odwréé) w panelu Text

Wrap. Efekt taki dziala najlepiej ze stosunkowo prostymi ksztaltami, gdy tekst

stanowi zwarty blok — bez koncéw akapitéw ani wcigé — ciasno ulozony i wyju-

stowany, dzieki czemu bedzie mégl lepiej odwzorowaé ksztalt obiektu.
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RYSUNEK 13.11 Tekst oblany
wokot litery Z, ktora zostata
przeksztatcona na krzywe
(Type > Create Qutlines albo
Cmd/Ctrl+Shift+0) (A). Oble-
wany obiekt zostat przenie-
siony na oddzielng warstwe,
ktdra zostata ukryta (B).
Oblewanie zostato odwrécone
zaznaczeniem pola Invert (C).

o eugue dolobor erabuer incillan velesenis dolore L, quamcomemaod tat. Unt inkisim

B

Ignorowanie oblewania

Istnieja zwykle takie elementy, na ktére oblewanie tekstem nie powinno

of, conse-

EElE T o

(]

mieé wplywu. Typowym przykladem moze by¢ podpis, ktéry jest umiesz-
czony bezposérednio pod zdjeciem — w normalnym trybie nie daloby sie go

umiesci¢ dostatecznie blisko obrazu. Moze si¢ tez zdarzy¢, ze jakis fragment
tekstu chcemy umieséci¢ wewngtrz obrazu (czy méwiac écislej, wewnatrz jego

$ciezki oblewania). W takim wypadku tekst znika — zostaje wypchniety

poza odstep oblewania, a jesli ramka nie siega tak daleko, staje sie tekstem

nieumieszczonym.

Rozwigzanie? Zaznaczamy ramke z problematycznym tekstem, otwieramy

jej okno dialogowe opcji (Object > Text Frame Options) i zaznaczamy pole Ignore
Text Wrap (Ignoruj oblewanie tekstem).

Jesli okaze sie, ze czynnoé¢ te trzeba powtérzy¢ dla kolejnych i kolejnych
ramek podczas tworzenia podpiséw, warto utworzy¢ styl obiektowy, ktéry
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n et volor si ut quia volorro doluptas
strum rate peditatiam rerferc iendel
ant rernam, sit et laut omni que pro
uas volupturit ide eum quam necte
it emposapit offictem volum atur 4
2qu ateniscia intem quamus ©
juam, ut alis arum eum quatia |
»que dolupta tquisci llabo. Ut lit
"imus et odit ero blaut que dolla
ducipicil inus nisti dolupta non-
atibus, ut qui odipsam, elestenditi 4
arsper ehentur? Mus. Seque corisquas .

n rem expel estiis dolupta tatem. Veniae nitaquate et
Jsam lanisto con repudandero esciene dolupid ucient
tis dipsam dicatem illaut ressus atiandi saperatiate
aspelis Qui doluptis utecae moluptatus et fugiam
otas pero doluptatam, cum am fugitinciae nosandan-
dolorem. ltatur aspient quam que latatis dolecat volut
n nulleriam dit, arum rere doluptate porepre nobis aditi

RYSUNEK 13.12 Ramka

podpisu ma wlaczong opcje

: . . - e et . : : ignorowania oblewania
bedzie zawieral te opcje (a przy okazji moze réwniez nadawac odpowiedni styl tekstem (A). Atrybut ten
akapitowi zawartosci ramki). oraz styl akapitowy zostaja
nastepnie zapisane jako styl
obiektowy (B).

Tworzenie elastycznych uktadow przy uzyciu oblewania

W projektach uktadu czasopism, gdzie czesto naktadajg sie ramki tekstowe i gra-
ficzne, wykorzystanie oblewania pozwala na tatwe edytowanie i eksperymenty
zréznymi opcjami uktadu. Szczegélnie wtedy, gdy potaczymy go z wykorzysta-
niem siatek linii bazowych i warstw (patrz rozdziat 14), oblewanie zastosowane
do obrazow, nagléwkow i ramek informacyjnych pozwala stworzy¢ modufowe
podejscie do uktadu.

Aby moéc naprawde wykorzystac takie rozwigzania, nalezy dopilnowac, by
ramki tekstowe rozciggaty sie przez cala wysokosc strony, od gérnego do dolnego
marginesu. Tekst wypetni wowczas tyle miejsca, ile tylko bedzie dostepne: jesli
nie mamy zadnej ilustracji, dostaniemy kolumne zawierajaca tylko tekst, a gdy
dodamy grafike, tekst samoistnie usunie sie jej z drogi. W ten sposéb bedziemy
musieli dopasowywac tylko jeden element — ramke graficzng — a nie dwa. Przy
korzystaniu z opcji wyréwnania do siatki tekst bedzie uktadat sie zgodnie z nig
od samego poczatku. Jesli umiescimy teksti ilustracje na oddzielnych warstwach,
tatwiej bedzie wybiera¢ ramki graficzne, blokujac lub ukrywajac warstwe teks-
towa podczas pracy z ilustracjami.
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WSKAZOWKA: Przy dopa-
sowywaniu sciezek warto
zmniejszyc¢ skoki klawiszy
kursora (Preferences > Units
& Increments), aby uzyskaé
wigkszg elastycznosc.

RYSUNEK 13.13 Oblewa-

nie tekstem jest stosowane
rowniez dla obiektow zako-
twiczonych, ale nieszczedliwie
nie dotyczy to wiersza tekstu
zawierajacego kotwice, zatem
obiekt umieszczamy nie w tym
akapicie, ktérego ma dotyczyc,
ale w poprzednim,

Oblewanie tekstem i obiekty zakotwiczone

Obiekty zakotwiczone s3 uzyteczne przy tworzeniu powiazanych ze soba ele-
mentéw — na przyklad wtedy, gdy chcemy zapewnié, ze notka na marginesie

lub wyimek beda zawsze wystepowaé obok odpowiedniego fragmentu tekstu.
Jednak precyzyjne pozycjonowanie zakotwiczonych obiektéw jest niekiedy
kiopotliwe. Jakkolwiek mozliwe jest dodanie do takiego obiektu opcji oblewa-
nia tekstem, nie ma ona wplywu na ten wiersz tekstu, ktéry zawiera kotwice

obiektu. Niezbyt eleganckie obejscie tego problemu polega na umieszczeniu

kotwicy w poprzednim akapicie i skorygowanie jego polozenia w pionie, aby

znalazt si¢ we wlasciwym miejscu. Najprostszym sposobem osiagniecia tego

ostatniego celu jest ustawienie obiektu ,mniej wiecej” we wlasciwym miejscu,
po czym (opcja Prevent Manual Positioning nie moze by¢ wlaczona!) zaznacze-
nie go i nastegpnie przesuniecie dokladnie w pozadane miejsce. Warto przy

tym wlaczy¢ widocznosé siatki linii bazowych i prowadnic, aby tatwiej byto

przesuwac zakotwiczony obiekt wzgledem nich. Po doszlifowaniu potozenia

mozna zapisa¢ ustawienie jako cze$¢ stylu obiektowego, ktéry nastepnie bedzie

mozna nada¢ jednym kliknieciem.

sis cincilit, quat et aut nit, secte tinim nonse er susto
corercipit la feuisl ilisi

Umsan-ut laor sequisl iriureet -ut wisix._

The sidebar frame in-the out=
side margin is-anchored to this [
paragraph. It will remain in the
same relative position-to this |

main text frame regardless of
how the text is edited. Because |
its alignment s Relative to Spine, |
if editing causes this paragraph |
to-movetoa right hand page, the |
sidebar frame will be positioned |

to its right in the outside margin. To create an anchored
object you-can either insert your cursor at the begin=
ning of the paragraph-and then choose Object > Anchored

Problematyczne oblewania

Przy pracy z bardzo zlozonymi ukladami moze si¢ zdarzy¢, ze chcielibysmy,
aby ta sama ramka tekstowa podlegata oblewaniu ze strony jednego obiektu,
ale ignorowata inny, ktéry z kolei ma mie¢ wplyw na inna ramke. Takie sytu-
acje sa rzadkie, ale jesli si¢ pojawig, moze sie wydawa¢, ze mamy do czynienia
zblednym kolem. Nie powinni$my w takiej sytuacji odwotywac sie do ustawie-
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nia preferencji powodujacego, ze oblewanie dziala tylko ,w d6t” — przyczyny
wylozylem juz wczesniej w czesci , Preferencje oblewania”.

Przyjrzyjmy sie przykladowi pokazanemu na rysunku 13.14. Gérne szare
kétko powinno oddzialywaé na tekst w lewym bloku, ale nie na tekst w wyju-
stowanej ramce po prawej. Z kolei dolne kétko powinno zostaé oblane przez
tekst w tej ramce. Jak to zrobi¢?

Libus sae. Desto cus quae expl
andaes doluptasetetod
et alique et volorerem 5

fugiamus qui dolo conse

qui odit et mi, sus est, tet
aditaturem res sitas solupta k-
quatem voloria eperovit lacepe-
rume id que veliae culpa nusam, si omnitin

ctisreptibus solum corrovid elestis et es

Isbart et auid
q

etur sequid ma quae velignamus consediti
guam gue doluptatquid que voluptate velit
adisci quae reperibus niatur aut aborem

et pla velest, qui secus sequam, suntibus

ut aut quat qui ducitib usandi utam, ut vo-

Tut i dol

culpa nusam, si omnitin
us solum corrovid elestis
etes repelectem laboristorro et quid
maximos etur sequid ma quae veligna-
mus consediti guam que doluptatquid
que voluptate velit adisci quae re-
peribus niatur aut aborem
et pla velest, qui secus
sequam, suntibus ut
aut quat qui ducitib
usandi utam, ut
volutem eiusaec
uscitatet dolor-
por ariorupta eos
molorit aute nim
aut maximolendam
eum inulpa dem des
quaeptassit, ommodi
pore dolorum et fuga. Cillorp
oressit odit, sime ligentior sit, unt, ini

blab ide ditet plique ipsamet ad

quia nus, quidente vid quaepudit aut
laborem porepudit alis quatur?

Jak zwykle rozwigzah moze by¢ kilka. Pierwsze rozwigzanie koncentruje sie
na samym oblewanym obiekcie. Mozemy po prostu zmieni¢ ksztalt jego éciezki
oblewania, aby wplywala na lewa ramke, ale omijala prawa — méwiac inaczej,
aby dotyczyla tylko czesci tego koétka.

Drugi wariant to siegnigcie po narzedzie Piéro i reczne zmodyfikowanie
ksztaltu ramki tekstowej, aby uzyska¢ efekt oblewania, na przyklad w taki
sposéb:

1. Wylaczy¢ oblewanie tekstem dla gérnego kétka.

2. Uzyé narzedzia Add Anchor Point, aby dodaé dwa punkty kontrolne w obry-
sie lewej ramki tekstowej, mniej wiecej tam, gdzie powinno zaczyna¢ sie
i koriczy¢ oblanie.

3. Uzyé narzedzia bezposredniego zaznaczania, aby zmieni¢ ksztalt ramki,
mozliwie dobrze ,dopasowujac” go do oblewanego obiektu. W razie
potrzeby mozemy wprowadzi¢ wiecej wezléw w éciezce obrysu ramki.

Inna metoda zmiany ksztaltu ramki tekstowej to wykorzystanie funkcji
Pathfinder (Filtry $ciezek). Po wylaczeniu oblewania dla gérnego kétka kopiujemy

RYSUNEK 13.14 Chcemy,

by tekst w ramce po prawej
oblewat dolne kétko, ale nakia-
dat sie na gorne, ktore z kolei
powinno ,odpychad” tekst

w lewej ramce wyréwnanej

do prawej.
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je do schowka (Cmd/ Ctrl+C) i upewniamy sie, ze znajduje sie ponad lewa ramka
w stosie obiektéw (w tym celu najlepiej przenies¢ je na samga gére, naciskajac
Cmd/ Ctrl+Shift+]). Nastepnie zaznaczamy kétko wraz z lewg ramka tekstowa,
po czym uzywamy polecenia Object > Pathfinder > Subtract (Obiekt > Filtry $cie-
zek > Odjecie), co spowoduje wyciecie z ramki ksztattu naktadajacego sie nan

kétka (a ono samo zniknie). Teraz pozostaje ponowne wklejenie oryginalnego

kétka w tym samym miejscu: Cmd+Shift+Option+V / Ctrl+Shift+Alt+V.
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Strony, marginesy,
lamy i siatki

DLA KAZDEGO PROJEKTU UKLADU STRONY krytycznymi elementami sg jej wymiary
i tworzone przez nig srodowisko. Proporcje i orientacja strony wraz z szero-
kosciami margineséw definiujgcymi wielko$¢ kolumny tekstowej oraz liczba
i szerokos$¢ tamoéw, determinujgce przeptyw tekstu na stronie, sg integralnymi
elementami projektu, ktére majg decydujacy wplyw na wrazenia i reakcje czy-
telnika wywotywane przez te strone — zaréwno drukowana, jak i wy$wietlang
ekranowo. W te wszystkie wymiary i zaleznosci geometryczne wpleciona jest
siatka, zbidr przecinajacych sie linii pomocniczych rozmieszczonych w regu-
larnych odstepach. Siatka jest nieocenionym narzedziem ukfadania tekstu,
sugerujac raczej, niz dyktujac, jak tekst i elementy graficzne powinny zostac

rozmieszczone na stronie.
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RYSUNEK 14.1 Opcje filtro-
wania w programie Bridge
pozwalajq okreli¢, ile obra-
26w w réznych orientacjach
znajduje sie we wskazanej
lokalizacji na dysku. Zaznacze-
nie jednego z typ6w orientacji
powoduje wyswietlanie tylko
obrazéw speiniajacych dany
warunek (panel ten nie jest
dostepny w Mini Bridge).

Definiowanie ustawien dokumentu

Gdy tworzymy nowy dokument, musimy zawczasu odpowiedzie¢ sobie na kilka
waznych pytan:

= Jakiego rodzaju publikacje tworzymy? Czy jest to powies¢ lub inna ciagla
proza zawierajaca pojedynczy strumien tekstu, czasopismo lub magazyn
z wieloma artykutami, czy tez broszura sktadana wielokrotnie, jedno-
stronny plakat lub ulotka?

® (Czy liczba stron jest ustalona z géry, czy tez objetoéé publikacji bedzie
wyplywala z dtugosci tekstu?

= Jak gotowy dokument bedzie drukowany? Czy moze sie zdarzy¢,
ze potrzebne beda spady — elementy wystajace poza obcieta strone?

® Ile réznych rodzajéw tekstu bedzie zawierat dokument? Czy pojawia sie
w nim marginalia, podpisy, wyimki, przypisy dolne lub konicowe? Jak
wiele pozioméw bedzie miata hierarchia tytutéw?

= Jedli publikacja ma zawiera¢ ilustracje, jak rozkladaja sie proporcje
pomigdzy zdjeciami poziomymi, pionowymi i (by¢ moze) kwadratowymi?
(rysunek 14.1 pokazuje, jak mozna sprawdzi¢ podziat ilustracji wedtug
orientacji we wskazanym folderze systemu plikéw). Czy s to fotogra-
fie, rysunki, mapy, ikony, czy tez wszystkie wymienione? Wreszcie, czy
powinny one zostac zintegrowane ze strumieniem tekstu, czy tez zostana
rozmieszczone na dedykowanych wkiadkach ilustracyjnych?

Wybieranie formatu strony

Czgsto zdarza sig, ze nie mamy mozliwosci wyboru formatu strony — a jesli
nawet mozemy dokona¢ wyboru, dostepne mozliwoéci w duzym stopniu
sa zalezne od kryteriéw ekonomicznych i technicznych. Standardowe formaty
stron, oprécz tego, ze s3 od razu dostepne, daja réwniez korzysci praktyczne:
broszury musza miescic¢ si¢ w standardowych kopertach, czasopisma i gazety
na typowych pétkach wystawowych, a wizytéwki w portfelach.

Niezaleznie od powyzszego, od kiedy tylko ludzie tworza materiaty drukowane,
poszukuja ,doskonatych” wymiaréw stron. Starannie wybrany, niestandardowy
format moze sprawic, ze publikacja uzyska wyglad unikalny, a nie typowy, bar-
dziej ,organiczny” niz wynikajacy z wymogéw technologicznych. Wiele ksiazek
poswigcono poszukiwaniu najlepszych proporcji strony — stosunkowi wysokosci
do szerokosci karty papieru. Oto kilka najczeiciej spotykanych rozwiazan.

Zloty podziat 1:1,618. Formula ta oparta jest na proporcjach, ktére mozna
odnalez¢ w ludzkim ciele lub budowie roslin. Byta uzywana jako standard

w $redniowiecznych manuskryptach, ale mozna ja takze spotka¢ w wielkich
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arcydzielach sztuki i architektury, jak Mona Lisa czy Partenon. Proporcja
ta oznacza, ze stosunek dluzszego boku do krétszego jest taki sam, jak krét-
szego do ich réznicy, a takze jak sumy obu bokéw do dluzszego.

Letter RYSUNEK 14.2 Tam, gdzie
Legal wszystko sie zaczyna: wybiera-
Document Preset: | [Custom]} : D Tabloid nie wymiarGw strony w oknie
Letter - Half i
intent:  Print e D dialogowym New Document.
: s Legal - Half Opcja Save Preset (Zapisz usta-
Number of Pages: § | [ Facing Pages A5 wienia) pozwala zapamietac
StartPage#: 1 | ] Master Text Frame _ wybrane ustawienia do poz-
i (_ Fewer Options ) A3 niejszego wykorzystania.
~ Page Size: (A4 e 3 yszego wykorzy
Width: [5/595.276 pt|  Orientation: [{g] @ Compact Disc
B L 600 x 300
e 640 x 480
- Columns z T 760 x 420
Number: (/1 | Gutter F12pt | 800 x 600
984 x 588
— Margins 1024 x 768
Top: 36pt |y nside Fwpt | -
Bottom: {36 pt | Outside: =]36 pt | Custom e

3 RYSUNEK 14.3 Rozkiadéwka
(para stron widzacych) uzywa-
jaca proporcji ztotego dziatu

i marginesow w sekwencji
3:5:8113 (ciag Fibonacciego,

w ktorym kazda liczba jest
sumg dwdch poprzednich).
Wprawdzie zapewnia to har-
monijne proporcje, jednak
tworzy marginesy nieprak-
tyczne (zbyt duze) z ekono-
micznego punktu widzenia.

1,618
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WSKAZOWKA: Dostepne
w InDesign formaty ekra-
nowe (640%480, 800X600
i1024x768) majg proporcje
3:4. Ekran 1280x800 ma
format zblizony do ztotego
podziatu.

WSKAZOWKA: Formaty
US Letter, A4, Tabloid

i tak dalej s3 wprawdzie
poreczne, ale $wiat peten
jest dokumentéw w tych
rozmiarach. Mozna ich
uzywac, ale wtedy, gdy
zapewniaja najlepsze
rozwigzanie dla tworzonego
projektu. Nie ograniczajmy
sie do nich tylko dlatego,
ze sa domyslne.

WSKAZOWKA: Jesli chcemy
uzyc¢ niestandardowego
formatu strony, nalezy uzy-
skac oszacowanie kosztéw
druku, zanim zaczniemy
projektowac publikacje

w tym rozmiarze. To dobrze
sie roznic, ale niekiedy owo
odréznianie sie moze kosz-
towac zbyt wiele.

WSKAZOWKA: Przydatng
funkcjonalnoscia jest moz-
liwos¢ zapisania wiasnych,
niestandardowych ustawien
jako predefiniowanych,
dzieki czemu bedzie mozna
wykorzysta¢ je ponownie
bez koniecznosci wpisy-
wania wszystkich liczb
definiujacych geometrie
strony.

Srebrny podziat 1:1,4142. Formaty papieru standaryzowane przez 1SO (sze-
regi A, B i C) oparte sa na tej proporcji (1 do pierwiastka kwadratowego z 2).
Jest to przejrzysty i ekonomiczny system, gdyz po zlozeniu standardowego
formatu na pét otrzymujemy inny standardowy format, o tych samych pro-
porcjach. Oznacza to, ze tworzac czterostronicowa broszure (czyli po prostu
kartke zlozona na pél), musimy po prostu siegnaé po kolejny, wiekszy format
z szeregu. Dwie strony A4 daja razem A3, a zlozenie kartki A4 na pét daje As
i tak dalej. Standardowy format amerykanski (Letter) o wymiarach 8,5 na 11
cali ma zblizona proporcje i wielko$¢ do strony A4 (210 na 297 mm, czyli 8,3
na 11,7 cali), ale jest nieco szerszy i nieznacznie krétszy.

Proporcja klasyczna 2:3. Jan Tschichold (1902-1974) opracowat kilka wariantéw
proporgcji klasycznych na podstawie wlasnych studiéw nad $redniowiecznymi
manuskryptami. Z bardziej wsp6lczesnych skojarzerr — format ten pasuje
réwniez do typowych rozmiaréw fotografii, takich jak 4 na 6 cali.

Proporcja klasyczna 3:4. Format czesto spotykany w wydawnictwach
ksigzkowych.

Wizytéwka 2:4,5. Takie proporcje ma wiekszos¢ kart wizytowych.

‘ A8 1\ RYSUNEK 14.4 Szereg formatow A wedlug
A6 normy 1SO i poréwnanie z formatem
A7 A 4 E US Letter.
A5 J{
Letter

A2
A3

2 3
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RYSUNEK 14.5 Klasyczne
proporcje opracowane przez
Jana Tschicholda, wykorzy-
stujace strone o stosunku
bokéw 2:3 i serie przecinaja-
cych sig linii pomocniczych,
wyznaczajacych wielkos¢

i potozenie kolumny teksto-
wej. Konstrukcje zaczynamy
od narysowania przekatnych
faczacych dolne zewnetrzne
narozniki z gérnym spojeniem
stron (1). Nastepnie rysujemy
przekatne catej rozktadowki
(2). Z punktéw przeciecia tych
linii prowadzimy linie pio-
nowo do gory (3), a nastepnie
do drugiego punktu prze-
ciecia (4). Miejsce przeciecia
tej ostatniej linii z pierwsza
(punkt A) wyznacza gérny
wewnetrzny naroznik obszaru
zadruku. Gérny zewnetrzny
naroznik (B) lezy na przecie-
ciu z przekatng rozktadéwki
(2), za$ dolny zewnetrzny (C)
na przecieciu z przekatng

strony. Dolny przykfad opiera

sie na tej samej konstrukgji,
ale wykorzystuje inng pare
przekatnych, dajac bardziej
praktyczna wielkos¢ dolnego
marginesu.
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RYSUNEK 14.6 Niektére
typowe formaty stron i ich
proporcje (wyszarzony prosto-
kat ukazuje wielkos$¢ kolumny
tekstowej).

6" x10" -, prawie” ztoty US Letter - 812" x 11" A4 - 210297 mm
podziat (proporcja 3:5) (proporcja 1:1,294) (proporcja 1:v2)

6" x9" - fotogra- 8%" x10%" - typowy format
ficzny” (proporcja 2:3) czasopisma amerykariskiego

Orientacja strony

Szybki rzut oka na pétke z ksigzkami pozwala sie upewnié, ze ogromna wigk-
szo$¢ ksiazek (a takze czasopism, gazet lub broszur) ma orientacje pionowa
(wysokos¢ wieksza od szerokosci), a jedynie nieliczne s3 szersze. Oczywiscie
istnieja wyjatki — okladki plyt cD s3 (niemal) kwadratowe, albumy fotografii
lub malarstwa czesto uzywaja uktadu poziomego, szczegélnie wéwczas, gdy
wiekszo$¢ prezentowanych prac ma taka wlasnie orientacje. Jednak w wiek-
szoéci wypadkéw drukowane materialy s3 wydtuzone w pionie, a te publikacje,
ktére nie s3, trudno ustawié wéréd innych.

Jesli jednak dokument tworzony jest z mysla o prezentacji na ekranie, for-
maty poziome sprawdzg sie lepiej — po prostu dlatego, ze nasze monitory maja
taki wlaénie ksztalt.
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Rézne formaty stron
InDesign CSs5 umozliwia zastosowanie stron o réznych formatach w jednym RYSUNEK 14.7 Niestandar-
dokumencie. Opcja ta moze by¢ szczegodlnie uzyteczna, jesli chcemy powiazaé dowe wielkosci stron pozwa-
ze soba rézne, ale spokrewnione projekty (na przyktad wizytéwk ier listow laja potaczy¢ rézne formaty
; ! q ' ; J y‘ B 2 € p-ap ) w jednym dokumencie. W tym
i wzor koperty — kazda o innym formacie) albo przy projektowaniu obu stron przykladzie rézne wielkosci
okiadki jako jednego dokumentu. Aby zmienié format strony (lub kilku stron), postuzyly do zaprojektowania
5 Y S ¢ s ; : z oktadki — skrzydetka, przednia
nalezy zaznaczyc je w panelu Pages i klikng¢ przycisk Edit Page Size (Edytuj rozmiar i tylna strona oktadki oraz
strony) w dolnej czeéci panelu. Alternatywnie mozemy uzy¢ narzedzia Page (%, grzbiet, wszystkie sg oddziel-
klikna¢ strone i zmienic jej wielkos¢ w palecie sterujacej. nymi stronami o réznych wiel-
kosciach, tworzacymi jedng
rozkladéwke.
T
| o rl i

191q216

tylne skrzydetko tylna strona oktadki

Ustalanie wielko$ci margineséw

Marginesy s3 czyms, czemu czesto poswieca sie zbyt malo uwagi. Najproéciej
jest oczywiscie wybraé réwne wielkoéci margineséw, takie jak pét cala lub

cal (co wigcej, takie jest domyélne zachowanie programu), ale postepujac tak,
tracimy okazje okreslenia wielko$ci margineséw jako integralnego elementu

projektu. Jesli spojrzymy na jakakolwiek zadrukowang strong, zauwazymy,
ze to marginesy s tym, co wida¢ w pierwszej kolejnosci: odgrywaja kluczows
role w tworzeniu pierwszego wrazenia. Marginesy maja do spelnienia kilka

istotnych funkcji i nie nalezy ich lekcewazy¢:

® Marginesy budujg wizualne obramowanie kolumny tekstowej — catego
zadrukowanego obszaru strony. Kazdy, kto kiedykolwiek oprawiat obraz,
wie, jak ogromny wplyw moze mie¢ rama na oddzialywanie obrazu.
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UWAGA: Przy definiowaniu
margineséw wewnetrznych
nalezy pamietac, ze oprawa
ksigzki zmieni ich wielkos¢
postrzegang przez czytel-
nika. W skrajnej sytuacji,
jesli wewnetrzne marginesy
53 zbyt male, tekst moze
»ginac” w cieniu pomiedzy
stronami.

WSKAZOWKA: Przed
rozpoczeciem tworzenia
uktadu strony warto spo-
rzadzi¢ szkic. Bez wzgledu
na to, jak wielkie mamy
doswiadczenie, prosciej
bedzie rozrysowac sobie
réine warianty, niz prébo-
wac coraz to inne wersje
w InDesign. Co wiecej,

w ten sposob zwykle
osiggniemy lepszy rezultat.
Kartka i otéwek nadal

53 najlepszym narzedziem
przedstawiania pomystow
i eksperymentowania.

= Cho¢ to oczywiste, jednak czesto pomijane — marginesy sa tym miejscem,
w ktérym trzymamy ksiazke lub karte. To tu czytelnik trzyma kciuki
i byloby dobrze, gdyby nie zastanialy one zawartoéci strony.

® Historycznie marginesy czesto byly wykorzystywane jako miejsce
do sporzadzania uwag i notatek (szerokie zewnetrzne marginesy czesto
sg nazywane podrecznikowymi), a w niektérych typach publikacji nadal
odgrywaja te role.

® Marginesy sa réwniez miejscem, w ktérym umieszczamy numery stron
i informacje o publikacji (paginy), zazwyczaj zlokalizowane w obsza-
rze gérnego lub dolnego marginesu, poza kolumng tekstowa. Ciekawe,
ze takie zastosowanie margineséw nadal jest widoczne w czasach Amazon
Kindle i Apple iPad.

Cho¢ marginesy definiuja obszar zajmowany przez tekst, nie stanowia abso-
lutnych granic. Niektére elementy, jak inicjaly, wyimki lub podpisy ilustracji
moga wchodzi¢ na marginesy — podobnie jak znaki przestankowe, jesli wyko-
rzystamy funkcje optycznego wyréwnywania margineséw. Réwniez ilustracje
czesto wychodzg poza obszar kolumny, famiac prostokatna regularnosé strony
i — niekiedy — dajac bardziej dynamiczny uktad.

Wzgledna wielkos¢ margineséw

Podczas gdy jednostronne dokumenty, takie jak plakaty, ulotki lub wizytéwki,
czesto uzywaja rownych margineséw, ustawienie takie w dokumentach wielo-
stronicowych ze stronami widzacymi nie daje dobrego efektu. Gdy spojrzymy
na pare stron widzacych, jak w czasopi$mie lub ksiazce, zauwazymy, ze wistocie
maja one wspdlny wewnetrzny margines, podzielony tylko linia zszycia. Ten
podwdjny margines jest istotnym czynnikiem wizualnym, ktéry nalezy wziaé
pod uwage przy projektowaniu rozktadéwki. Wielkoé¢ margineséw zwykle wzra-
sta od najmniejszego do najwiekszego w nastepujacej kolejnosci: wewnetrzny,
gbérny, zewnetrzny i dolny. Nie istnieja tu zadne zelazne reguly, ale poreczna
wskaz6wka ulatwiajaca ustalenie (choc¢by wstepnych) wielkosci jest szereg
1:1,5:2:2,25. Powstaja wéwczas marginesy o proporcjach znajomych dla dwu-
dziestopierwszowiecznego oka.

= Margines wewnetrzny powinien by¢ najmniejszy, gdyz styka sie z drugim
wewnetrznym marginesem. Z drugiej jednak strony dystans pomiedzy
linig szycia a tekstem nie powinien by¢ mniejszy niz 10 mm, aby uniknaé
utraty informacji wewnatrz oprawy.

® Nastepny w kolejnosci jest margines gérny. Powinien mie¢ rozmiar od 1,25
do 1,5 raza wigkszy niz margines wewnetrzny.
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® Margines zewnetrzny powinien by¢ dostatecznie duzy, aby tekst nie
sprawial wrazenia ,wciénietego” na strong i dawal czytelnikowi doéé
miejsca na trzymanie publikacji. Jego szerokoé¢ powinna by¢ od 1,75
do 2 razy wigksza niz szeroko$¢ marginesu wewnetrznego.

® Margines dolny powinien by¢ najwigkszy — od 2 do 2,5 raza wigkszy niz
wewnetrzny — zaréwno po to, aby unikna¢ wrazenia ,cigzenia” tekstu,
jak i w celu zapewnienia miejsca dla pagin. Wielkosci przewidziane dla
goérnych i dolnych margineséw mozna zamieni¢ miejscami, jesli paginy
bedg umieszczone ponad kolumna tekstowa.

Dokumenty obustronne

W dokumentach obustronnych (ze stronami widzacymi) lewe i prawe marginesy
stanowia swoje zwierciadlane odbicie na odpowiednich stronach i w takiej
sytuacji uzywamy terminéw wewnetrzny i zewnetrzny, a nie lewy i prawy, jak
w dokumentach, w ktérych strony biegna pojedynczo.

Po utworzeniu dokumentu ze stronami widzacymi domys$lna strona
wzorcowa zawiera dwie symetryczne strony z marginesami wewnegtrznym
izewnetrznym, rozmieszczonymi lustrzanie. Mozliwe jest réwniez stworzenie
asymetrycznego uktadu. W tym celu nalezy zacza¢ od utworzenia zwyklej roz-
ktadéwki, po czym prawym klawiszem myszy klikna¢ rozkladéwke wzorcowa
i z menu podrecznego wybraé Master Page Options (Opcje strony wzorcowej),
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RYSUNEK 14.8 Marginesy
oparte na szeregu 1:1,5:2:2,25.
Jesli paginy maja by¢ umiesz-
czone u gory, wielkosci gor-
nego i dolnego marginesu
nalezy zamienic.

RYSUNEK 14.9 Panel Pages
ukazujacy dokument z widza-
cymi stronami (u gory) i poje-
dynczymi (na dole).
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RYSUNEK 14.10 Dokument

z widzacymi stronami w ukfa-
dzie asymetrycznym (po lewej)
i symetrycznym (po prawej).

WSKAZOWKA: Pierwsza
strona dokumentu dwu-
stronnego jest domysinie
strong prawa (recto),

€o oznacza, ze dwie
pierwsze strony nie
pojawig sie obok siebie
jako rozktadéwka. Aby
zaczac od strony lewej,
nalezy zmieni¢ poczatkowy
numer strony dokumentu
na liczbe parzysta. Jesli nie
zrobiliémy tego w momen-
cie tworzenia dokumentu,
nalezy przej$¢ do pierwszej
strony dokumentu i w menu
panelu Pages wybrac
Numbering and Section
Options (Numeracja i opcje
sekcji), po czym wpisac
liczbe parzystg jako poczat-
kowy numer strony.

po czym zmieni¢ liczbg stron na 1. Rozkladéwka zostanie zastapiona poje-
dyncza strona wzorcowa.

Ustawianie tamow

Kolumna tekstowa (obszar strony zajmowany przez tekst, definiowany
za pomoca margineséw) moze zosta¢ podzielona na tamy. Stosunek stopnia
pisma do szerokoéci tamu, zwany measure, jest kluczowym czynnikiem wply-
wajacym na czytelnos$c tekstu. Jak w wielu innych przypadkach, nie ma jakiej$
zelaznej reguly okreslania szerokosci taméw. Dla wielu prac lepiej nadaja sie
bardziej obszerne lamy, jednak ekonomia czesto zmusza do stosowania taméw
wezszych niz optymalne.

Jako zgrubna zasade, mozna przyja¢, ze wiersz nie powinien by¢ krétszy niz
40 ani dtuzszy niz 70 znakéw (wliczajac spacje). To spory przedziat, zatem mamy
duze pole do manewru. Przy nadmiernie dtugich wierszach moze wystepowac¢
efekt ,dublowania” — oko wracajace na lewy brzeg tamu ponownie prébuje
odczytywac ten sam wiersz. Jesli wiec jestesmy zmuszeni pracowa¢ z bardzo
szerokim famem, mozemy starac sie poprawié czytelnos¢, zwigkszajac interlinie
tekstu. Po przeciwnej stronie mamy wiersze bardzo krétkie — jesli mamy mniej
niz 25 znakéw w justowanym skladzie, utrzymanie réwnomiernosci odstepéw
miedzy wyrazami staje sie praktycznie niewykonalne.

Spéjrzmy na typowa gazete codzienna — znajdziemy w niej justowane tamy
o wierszach znacznie krétszych niz 50 znakéw. Zauwazymy tez, i to bez nadmier-
nego wysitku, ze tekst jest podziurawiony licznymi, nadmiernymi spacjami. Jest
to efekt justowania zbyt waskiego tekstu. Przyzwyczailiémy sie juz do marnej
typografii w codziennych gazetach — pamigtajmy, ze powstaja w warunkach
wielkiej presji czasowej — i potrafimy je czytaé bez wysitku pomimo tych wad,
a nie dzigki nim. Patrzac historycznie, gazety uzywaty kiedy$ mniejszych stopni
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B AT i e ; RYSUNEK 14.11 The Guardian:
Inside the life of il# ' przyklad czytelnosci.

guardian

ight years in power Tony
_ Blair hears a new word: Defeat

pisma niz obecnie. Jednak podczas gdy czcionki staty sie wigksze, szeroko-
$ci taméw nie urosty proporcjonalnie, skad biora sig problemy justowania.
Co powiedziawszy, trzeba tez zauwazy¢ godne uwagi wyjatki — na przyktad
brytyjski The Guardian znaczaco podniést poprzeczke w dziedzinie typografii
gazetowej w ciggu ostatnich kilku dziesiecioleci.

Szeroko$é¢ tamu stanowi wiekszy problem przy skladzie justowanym, niz
w tekscie uktadanym w choragiewke. Jesli mamy taka mozliwos¢, przy waskim
skladzie lepiej utatwic¢ sobie zycie i przej$¢ na uktad wyréwnany do lewej,
zamiast justowanego.

Ustalanie szerokosci odstepu miedzytamowego

W dokumentach wielotamowych cata kolumna tekstu powinna sprawia¢ wra-
zenie monolitu. Jedli przestrzen pomiedzy tamami (gutter) jest zbyt duza, tamy
beda sprawialy wrazenie oderwanych od siebie, a cata kolumna rozpadnie sie
na poszczegoblne bloki. Jeéli jednak odstep bedzie zbyt maty, czytelnik moze
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WSKAZOWKA: Aby zmieni¢
wielko$¢ wszystkich stron

w dokumencie, nalezy

uzyc¢ opdji File > Document
Setup (Plik > Ustawienia
dokumentu).

RYSUNEK 14.12 Okna dia-
logowe Margins and Columns
oraz Layout Adjustment. Wia-
czenie opcji Enable Layout Ad-
justment w pierwszym z nich
powoduje, ze ramki tekstowe
i graficzne podazajq za doko-
nywanymi zmianami. Drugie
okno pozwala okresli¢, jakie
modyfikacje istniejacej zawar-
tosci moga by¢ wykonywane.

Profesjonalna typografia w Adobe InDesign

miec trudnoé¢ z odréznieniem, gdzie jest koniec wiersza, i prébowa¢ czytaé
jako ciag dalszy tekst z sasiedniego tamu.

Szerokos¢ odstgpu powinna byé powigzana z wielkoscia interlinii. Aby
utrzymac wrazenie jednolitych odstepéw, mozna uzyé wartosci réwnej sko-
kowi siatki linii bazowej albo jej wielokrotnosci (1,5 lub 2-krotna wartosé),
ktoéra z kolei narzuca interlinig tekstu. Warto tez zadba¢, by wielkos¢ odstepu
zachowywata odpowiednie proporcje do szerokosci tamu — im szersze tamy,
tym wiekszy odstep.

Zmienianie liczby famoéw

Liczbg tamoéw, odstgpéw pomigdzy nimi lub wielkosci margineséw (albo wszyst-
kie elementy naraz) mozna zmieni¢ globalnie dla calego dokumentu, uzywajac
polecenia Layout > Margins and Columns (Uktad > Marginesy i famy). Jakkolwiek
mozliwa jest zmiana liczby taméw i wielkosci stron w trakcie pracy nad doku-
mentem, nic nie doréwna rozpoczynaniu od razu od wtasciwych ustawien.
To, jak powiedzie si¢ przejscie z jednej siatki taméw na inna, zalezy nie tylko
od wyboru wtasciwych opcji, ale réwniez od tego, jak daleko od oryginatu lezy
nowa wersja. Znaczgce zmiany (np. zmiana liczby taméw) zawsze powoduja
nieoczekiwane rezultaty i nie obejdzie si¢ bez dlugotrwatego poprawiania.
Mowiac inaczej: nie oczekujmy cudéw.
Przy zmienianiu liczby taméw nalezy rozwazy¢ kilka uwarunkowarn:

® Aby zmieni¢ liczbe taméw na wszystkich stronach opartych na okreslonej
stronie wzorcowej, nalezy edytowac te strone wzorcowa (patrz ramka
»Strony wzorcowe” w dalszej czesci rozdziatu).

® Aby automatycznie dopasowac ramki tekstowe i graficzne (a nie tylko
same linie pomocnicze) na istniejacych stronach, mozemy wlaczy¢ opcje
Enable Layout Adjustment (Wlacz dopasowanie uktadu). Dziatanie tej opcji
mozna dostosowa¢ przy uzyciu okna dialogowego Layout Adjustment,
ktére réwniez jest dostepne w menu Layout.

® Aby zmieni¢ uklad taméw na lewych i prawych stronach rozkladéwek,
nalezy w panelu Pages zaznaczy¢ ikony obu stron. W przeciwnym wypadku
zmiana bedzie dotyczy¢ tylko zaznaczonej (lewej lub prawej) strony.

.mummm
Snap Zone: ;—]Zzpt [

# Allow Graphics and Groups to Resize

it

# Allow Ruler Guides to Move
[l ignore Ruler Guide Alignments

# Ignore Object and Layer Locks




® Mozemy zmieniaé marginesy i tamy dla okreslonego zakresu stron, zazna-
czajac je w panelu Pages.

Tworzenie tamoéw o ustalonej szerokosci

Niekiedy zdarza sig, ze z géry znamy szeroko$¢ taméw i ich odstepéw i musimy
rozmie$cié je na zadanym formacie kartki. W takiej sytuacji mozemy po prostu
wybraé ramke tekstowa i otworzy¢ okno jej wlasciwosci (Cmd/ Ctrl+B), po czym
zaznaczy¢ opcje Fixed Column Width (Stala szeroko$é taméw). Nastepnie uzyjemy
calkowitej szerokosci ramki do wyliczenia lewego i prawego marginesu. Na przy-
klad, jesli chcemy mie¢ dwa tamy o szerokosci 20 pica z odstepem wynoszacym
1 pica, catkowita szeroko$¢ ramki wyniesie 41 pica. Teraz musimy tylko odja¢
te wartos¢ od szerokosci strony i rozdzieli¢ otrzymany wynik pomiedzy lewy
i prawy margines. Méwiac inaczej, w tym wypadku marginesy staja sie cecha
pochodna szerokoéci tamu, a nie odwrotnie.

RYSUNEK 14.13 Tworzenie
- - tamow o statej szerokosci.

Korzystanie z siatek

Siatka to (niewidoczna w druku) struktura linii okreslajacych miejsca, w ktérych
powinny znalez¢ sie rézne elementy strony dokumentu. Zasadniczo stanowi
wizualng pomoc, utatwiajaca szybkie i spéjne rozmieszczanie tekstu i grafiki.
Cho¢ dobrze zaprojektowana siatka powinna by¢ niedostrzegalna dla typowego
czytelnika, bez zadnych watpliwo$ci pomaga mu w powiazaniu ze soba réznych
czeéci dokumentu. Eamy tekstu, nagléwki, zdjecia i inne ilustracje, podpisy,
wyimkiiinne elementy s3 lepiej ze soba powigzane — czy tez zjednoczone — jesli
uzyjemy siatki. Siatki narzucajg ograniczenia na projektanta, ale jednoczeénie
zwiekszaja jego kreatywno$é, pomagajac utrzymac spéjnosé strukturalng.
Dzieki wyeliminowaniu przypadkowosci i domystéw przy wybieraniu miejsca
dla poszczegélnych elementéw siatki znaczaco przyspieszaja prace.
Fundamentem niemal kazdego dobrze zaprojektowanego dokumentu jest
jakas forma siatki. Powie$¢ moze uzywac¢ prostej jednotamowe;j siatki, ale nawet
ona musi zostaé starannie przemyélana, poniewaz determinuje geometrie
kolumny tekstowej i polozenie pagin. Gazety i czasopisma uzywajace sktadu
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WSKAZOWKA: Jesli nasz
projekt wymaga stosowa-
nia taméw o nieréwnych
szerokosciach, mozna
odblokowat linie pomoc-
nicze tamow (View > Grids
and Guides > Lock Column
Guides) i przeciggnac

je winne miejsce. Pomocne
moze tez by¢ wykorzystanie
narzedzia do rysowania
ramek jako ,przymiaru” —
najpierw rysujemy ramki
imitujace famy tekstu,

a nastepnie ustawiamy
prowadnice tamow przy
tych ramkach. Po uzyskaniu
wiasciwego ukiadu pomoc-
nicze ramki mozemy usunac
i ponownie zablokowac¢ linie
pomocnicze, aby uniknaé
przypadkowej zmiany
uktadu.

WSKAZOWKA: Szwajcarski
projektant Josef Miiller-
-Brockmann jest mistrzem
systemow siatek. Jego
ksigzka Grid Systems in
Graphic Design, cho¢
napisana przed era cyfrowa,
pozostaje fundamentalng
pozycja w tej dziedzinie.

»Redukcja liczby uzywanych
wizualnych elementéw i ich
wigczenie w systematyczng
siatke tworzy wrazenie
zwartosci, zrozumiatosci
i przejrzystosci, a takze
sugeruje uporzgdkowanie
podczas projektowania.

To uporzadkowanie zwiek-
sza wiarygodnos¢ informacji
i ufnosc¢ odbiorcy”. [Josef
Miiller-Brockmann, Grid
Systems in Graphic Design,
wyd. szdste, Niggli 2008
(pierwsze wydanie 1961)].
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wielotamowego oraz mieszanki krojéw i stopni pisma — a takze fotografii
iinnych ilustracji — wymagaja bardziej zlozonych siatek. Tego typu schematy
korzystaja ze zmiennej liczby taméw i dzielenia strony nie tylko w pionie, ale
iw poziomie. Dodatkowo czgsto wykorzystuja drugi poziom struktury, znany
jako siatka linii bazowych, ktérego celem jest utrzymanie wyréwnania linii pisma
pomigdzy tamami i wzgledem innych elementéw strony.

Rzeczy do rozwazenia

= Przy dokumentach wielostronicowych siatki nalezy definiowa¢ na stro-
nach wzorcowych.

® Mozliwe jest, cho¢ rzadko wymagane, stosowanie wigcej niz jednej siatki
linii bazowych w dokumencie. InDesign umozliwia ustanowienie indy-
widualnych siatek dla poszczegélnych ramek tekstowych.

® Siatki powinny by¢ elastyczne. Siatka oparta na ustalonej liczbie taméw
moze tworzy¢ wrazenie nadmiernej symetrii (zeby nie powiedzie¢ — nudy),
jeéli tekst i grafika jest $cisle przywigzana do tych laméw na wszystkich
stronach publikacji. Przy uzyciu siatki o wiekszej liczbie moduléw (a zatem
»drobniejszej”) uzyskujemy wigkszg elastycznosé. Przy wielu modutach
pojedyncza ramka moze si¢ rozcigga¢ w poziomie na dwa, trzy lub nawet
cztery kroki. Na przyklad zastosowanie siatki o dwunastu modutach jest
prosta metoda uzyskania réznorodnosci, gdyz mozemy tatwo podzieli¢
calg strong na trzy lub cztery tamy — dwanascie dzieli si¢ zar6wno przez
trzy, jak i przez cztery. Innym czestym rozwigzaniem jest zastosowanie
nieparzystej liczby modutéw. Na przyktad siatka pigciomodutowa umoz-
liwia zastosowanie dw6ch faméw, z ktérych kazdy przykrywa po dwa
moduly, oraz jednego wezszego tamu o szerokosci modutu, mieszczacego
ilustracje, podpisy lub materiat uzupetniajacy. Wyglad strony mozna
urozmaica¢, zmieniajac polozenie tego ,plywajagcego” tamu.

® Siatka jest zawsze tylko punktem wyjécia, a nie celem samym w sobie.
Zbyt sztywne trzymanie si¢ siatki moze prowadzi¢ do statycznego ukladu.
Sformulowawszy zasady, nadal mozemy je tama¢, jeéli w rezultacie da
to lepiej wygladajaca strone.

Narzedzia dotyczace siatek

InDesign zawiera szereg narzedzi, ktére tacznie umozliwiaja konfigurowanie
i modyfikowanie siatek.

Widoczno$¢ poszczegdlnych komponentéw siatki reguluja opcje menu View >
Grids & Lines (Widok > Siatki i linie). Na przyklad w celu wyswietlenia siatki linii



Rozdziat 14 Strony, marginesy, tamy i siatki 255

Pie¢ lamow Siedem tamow

Osiem tamow

Dwanascie lamow

RYSUNEK 14.14 Eksperymentowanie ze zmienng liczba taméw na réznorodnych siatkach modutowych.
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UWAGA: Oprocz siatki

linii bazowych InDesign
udostepnia tez inng struk-
ture — Document Grid (Siatke
dokumentu), ktéra najbar-
dziej przypomina papier
milimetrowy, cho¢ z requ-
lowang czestotliwoicig

i liczba linii podrzednych.
Jakkolwiek moze by¢
przydatny podczas wyrow-
nywania elementow
jakiegos diagramu, nie jest
szczegolnie przydatny pod-
czas projektowania uktadu
strony tgczacego tekst

i grafike, totez nie bede sie
nim zajmowat.

Strony wzorcowe

Kazdy element umieszczony na stronie wzorcowej dokumentu pojawi sie
na kazdej stronie, do ktérej dana strona wzorcowa zostata zastosowana. Litera
w zewnetrznym narozniku ikony w panelu Pages wskazuje, ktérej strony wzor-
cowej uzyto w tym miejscu. Nie istnieje zaden limit (poza zdrowym rozsadkiem)
liczby stron wzorcowych zdefiniowanych i uzytych w dokumencie, ale jesli nasza
publikacja zostanie starannie zaplanowana, nawet najbardziej skomplikowana
bedzie potrzebowata tylko kilku. Aby zastosowac¢ strone wzorcowa do strony
dokumentu, mozna przeciagnac jej ikone na wiasciwa strone w panelu Pages.
Alternatywnie mozna zaznaczy¢ strone lub ich zakres w panelu, po czym kliknaé
je prawym klawiszem myszy i wybrac Apply Master Pages To (Zastosuj strone
wzorcowa do) z menu podrecznego. Nieztym pomystem jest tez przypisanie
skrétu klawiszowego do tego polecenia — choc trzeba pamietac, ze skrét ten
nie bedzie aktywny, jesli panel Pages jest ukryty lub zwiniety.

Warto zauwazyc, ze obiekty umieszczone na stronach wzorcowych sg zabloko-
wane, gdy pracujemy na zwyklej stronie dokumentu. Gdy wiaczymy wyswietlanie
obramowar ramek, ramki ze strony wzorcowej wyéwietlane sg kropkowana linia.
Jesli musimy zmodyfikowac obiekt ze strony wzorcowej lokalnie (tj. tylko na okre-
slonej stronie dokumentu), mozemy go odblokowaé, klikajac go z wciénietymi
klawiszami Cmd/Ctrl+Shift. Aby odblokowac¢ wszystkie elementy wzorcowe,
mozemy uzy¢ polecenia Override All Master Pages Items (Przestor wszystkie ele-
menty strony wzorcowej) w menu panelu Pages. Zauwazmy jednak, Zze od tego
momentu elementy te nie beda juz kontrolowane przez strone wzorcowa.

bazowych nalezy uzyé polecenia View > Grids & Lines > Show Baseline Grid (Pokaz
siatke linii bazowych) albo uzy¢ skrétu Cmd/ Ctrl+Option+Alt+ (apostrof).

Karta Preferences > Grids (Preferencje > Siatki) zawiera ustawienia okreslajace
wyglad, punkt startowy oraz skok siatki linii bazowych.

Color (Kolor): Osobiscie lubie zmienié kolor siatki linii bazowych. Jasnoszary
dziata dobrze, gdyz nie zakléca widoku tak mocno, jak domyélny blekit.

Start (Poczatek) oraz Relative To (Wzgledem): Ustawienia te okreslaja poloze-
nie pierwszej linii siatki oraz czy wielko$¢ jest odmierzana od krawedzi strony,
czy od gérnego marginesu. Preferuje ustawianie siatki wzgledem marginesu,
gdyz w razie jego zmiany siatka przesunie si¢ odpowiednio. Przy tym ustawie-
niu siatka wyswietlana jest tylko wewnatrz kolumny tekstowej, a nie na calej

stronie tacznie z marginesami.

Increment Every (Skok o): Wartos¢ ta powinna by¢ réwna interlinii tekstu gtéw-

nego. Wiasciwe dzialanie siatki wymaga czestego wykonywania elementarnych




General Grids
Interface
Type — Baseline Grid
Composition -
Units & Increments Start: (0 pt |
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Guides & Pasteboard
Dictionary Increment Every: 12 pt
Speliing 7 View Threshold: | 75%
Autocormect 3
Notes “
Track Changes — Document Grid w
Stoey Editor Display Colour: [ [ Light Grey
m"rh::: Horizontal — ~ Vertiel ——— -
file Handling Gridline Every: 72 pt Gridline Every: [72pt |
Clipboard Handiing Subdivisions: 8 | Subdivisions: 8

# Grids in Back

obliczen, zatem wygodniej jest, jesli jest to liczba catkowita, na przyktad 12
punktéw. Znacznie tatwiej bedzie wowczas wyliczy¢, jak duza powinna by¢
ramka graficzna odpowiadajaca g9 wierszom, niz gdyby skok siatki wynosil
13,3 punktu.

View Threshold (Prég wyswietlania): Ustawienie to okresla, powyzej jakiego
stopnia powiekszenia siatka linii bazowych bedzie widoczna, gdy wtaczone
jest jej wyswietlanie. Przy pracy na laptopie wygodniejsze moze by¢ wybranie
warto$ci mniejszej niz domyslne 75 procent.

Grids in Back (Siatki na spodzie): Jesli ta opcja jest wigczona (domyélnie), siatki
(ale nie recznie ustawiane linie pomocnicze) beda wyéwietlane pod wszystkimi
innymi obiektami.

Wyréwnywanie do siatki. Cala pracowicie ustawiona siatka linii bazowych
niewiele nam da, jesli nie wlaczymy przyciagania do niej tekstu. Na poziomie
lokalnym mozna wlaczyé przycigganie, klikajac ikone w palecie sterujacej.
Lepszym, bo globalnym podejéciem jest wlaczenie przyciggania w definicji
stylu akapitowego. W tym celu nalezy w oknie definicji stylu przejéé do karty
Indents and Spacing (Wciecia i odstepy). Lista Align to Grid (Wyréwnaj do siatki)
udostepnia trzy mozliwoéci: brak przyciagania, All Lines (Wszystkie wiersze)
oraz First Line Only (Tylko pierwszy wiersz). Ta ostatnia opcja ma zastosowa-
nie dla tekstu o innej interlinii niz tekst podstawowy, takiego jak podpisy
lub wyimki — po jej uzyciu jedynie pierwszy wiersz zostanie ustawiony
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RYSUNEK 14.15 Opcje siatek
w preferencjach programu

UWAGA: Linie pomocnicze
obiektow i linijek (ustawiane
recznie) zawsze znajduja sie
przed liniami margineséw,
tamoéw i siatki bazowej —
nawet jesli wylaczymy
ustawienie Grids in Back.
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RYSUNEK 14.16 Tekst niewy-
réwnany do siatki (po lewej)
i wyréwnany (po prawej).

Ut amenis volum nem senti
commost, torum ditatur aut
ad quae volupta tisqui ad
que int est vera pre consedi
gentibu samusandis ped

Ut amenis volum nem senti
commost, torum ditatur aut
ad quae volupta tisqui ad

que int est vera pre consedi

Ut amenis volum nem senti
commost, torum ditatur aut
ad quae volupta tisqui ad
que int est vera pre consedi ) ]
gentibu samusandis ped que int est vera pre consedi

Ut amenis volum nem senti
commost, torum ditatur aut
ad quae volupta tisqui ad

na najblizszej pasujacej linii siatki, za$ kolejne beda ukladaly sie zgodnie
z interlinig zadana w atrybutach akapitu.

Create Guides (Utwérz linie pomocnicze): Podczas gdy okno dialogowe Margins
and Columns jest tym miejscem, w ktérym tworzymy lub modyfikujemy podsta-
wowy podzial na tamy okreslajace sposéb uktadania sig tekstu, polecenie Create
Guides umozliwia stworzenie niestandardowej siatki pionowych lub poziomych
linii pomocniczych, co jest wygodna alternatywa dla pracochlonnego przecia-
gania wielu linii linijek. Narzedzie to mozna nazwaé ,maszynka do tworzenia
siatek” — a poniewaz dziala natychmiast, mozna latwo eksperymentowaé
z ré6znymi konfiguracjami. Aby uchroni¢ dokument przed utratg przejrzystosci
z powodu zbyt wielu linii pomocniczych, warto umiesci¢ niestandardows siatke
na jej wlasnej warstwie, kt6ra pézniej bedzie mozna w razie potrzeby ukry¢ lub
wyséwietlié, a takze zablokowaé, by uniknaé przypadkowych modyfikacji.

Ruler Guides (Linie pomocnicze miarki): Polecenie Layout > Ruler Guides
umozliwia zmiang koloru linii pomocniczych i ich progu wyswietlania. Co wiecej,
mozna tu zmieni¢ kolor indywidualnej linii, jesli zaznaczymy ja przed wywo-
laniem tego polecenia. W ten sposéb mozna okresli¢ rézne kolory dla linii
pomocniczych stuzacych do réznych celéw, budujac bardziej czytelny uklad.

Kolejne polecenia umozliwiaja utworzenie siatek nie z linii pomocniczych, ale
obiektéw:

Step And Repeat (Powielanie z przesunieciem): Polecenie to, zawarte w menu
Edit (Cmd+Option+U/ Ctrl+Alt+U), zawiera opcje Create Grid (Utwérz jako
siatke), powodujaca powielenie zaznaczonego obiektu w ustalonej liczbie wierszy
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i kolumn z zadanymi odstepami, poczynajac od pozycji obiektu wzorcowego.
Zwr6émy uwage, ze okreslajac odstep, musimy uwzglednic¢ wielkos¢ obiektu. Jesli
na przykiad chcemy powieli¢ kwadrat o boku 72 punkty w odlegtoséci 12 punktéw
w prawo od oryginatu, poziome przesunigcie bedzie wynosi¢ 84 punkty.

Gridyfy (Powielanie na siatke): Jest to nowa funkcjonalnos¢ dostepna w wersji

€ss5, umozliwiajaca narysowanie siatki obiektow (ramek) w pojedynczej czyn-
nosci. Nacisnigcie klawisza ze strzatka w gére lub w prawo podczas rysowania

ramki powoduje powielenie ramki odpowiednio w pionie lub poziomie. Kolejne

naciénigcia zwigkszaja liczbe kolumn/wierszy tworzonych ramek. Jesli przez

pomytke zbyt wiele razy nacisneliémy ktéras strzatke, mozemy zmniejszy¢é

liczbe wierszy/kolumn, uzywajac strzatki w dét albo w lewo. Funkcja dziata

tez z zaladowanym kursorem tekstowym po zaimportowaniu pliku — w takim

wypadku tworzone ramki s3 od razu powatkowane i tekst wypelni je kolejno.
Przytrzymanie klawisza Cmd / Ctrl podczas naciskania klawiszy ze strzal-
kami powoduje zmiang odstepéw miedzy kolumnami lub wierszami tworzonej

siatki. Niestety, nie ma zadnej numerycznej wskazéwki informujacej o wiel-
koéci odstgpéw, przez co trudne jest uzyskanie réwnych odstepéw w pionie

i w poziomie.

Mozliwe jest réwniez powielanie istniejacego obiektu do siatki. Przytrzymanie
klawisza Option/Alt podczas przeciagania powoduje stworzenie kopii obiektu.
Naciskajac klawisze ze strzatkami podczas przeciaggania zmieniamy liczbe dupli-

katéw w poziomie (strzatki w prawo i w lewo) oraz w pionie (w gére i w dét).

MakeGrid: Cho¢ w pewnym zakresie moze zosta¢ zastapiony przez nowa funkcje
Gridify, skrypt MakeGrid nadal stanowi szybka i skuteczna metode podziatu

ramki na siatke modulows, ztozona z okreslonej liczby wierszy i kolumn. Skrypt

RYSUNEK 14.17 Wykorzy-
stanie funkcji Step and Repeat
(po lewej) i Gridyfy (po prawej)
w celu utworzenia siatki
ramek.
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RYSUNEK 14.18 Skrypt
MakeGrid to prosty sposéb
przeksztatcenia ramki teksto-
wej w siatke modutowa.

WSKAZOWKA: Niekiedy
wygodne jest ustawienie
pionowe;j linijki na nie-
standardowa jednostke
réwng skokowi siatki

linii bazowych. W oknie
preferencji otwieramy
karte Units & Increments
(Jednostki i skoki), po czym
z listy Vertical (Poziomo)
wybieramy Custom (Wlasne)
i w polu obok wpisujemy
warto$¢ skoku w punktach.
Dzigki temu znaczniki

na pionowej linijce beda
odpowiadac liniom siatki.

Row Cutter: élzm

e
¥ Oelete Original Object

[~

=

ten jest dolaczony do programu jako jeden ze skryptéw przyktadowych. Aby go
uruchomi¢, nalezy wyswietli¢ panel Scripts (Window > Utilities > Scripts) i w nim
przejéc¢ do folderu Application/Samples/JavaScript. Majac zaznaczona ramke
tekstowa, podwéjnie klikamy skrypt MakeGrid.jsx w panelu Scripts, po czym
podajemy liczbe wierszy i kolumn oraz wartosci odstepéw pomiedzy nimi.

AddGuides: Ten skrypt dodaje linie pomocnicze dopasowane do zaznaczonego
obiektu lub obiektéw, co ulatwia wyréwnywanie innych elementéw strony.
Mozna go tez wykorzysta¢ do tworzenia siatek, jesli mamy juz rozmieszczone
obiekty symulujace ostateczny ksztalt strony. Wystarczy wéwczas utworzy¢
linie pomocnicze, po czym usunaé te obiekty.

Smart Guides (Inteligentne linie pomocnicze): Rozwigzanie to, znane juz
wezeéniej w Adobe Illustrator, ulatwia dopasowywanie elementéw strony
do siebie nawzajem. Podczas przeciaggania lub tworzenia obiektu pojawiaja sie
chwilowe linie pomocnicze, pokazujace, czy obiekt jest wyréwnany do brzegu
lub $rodka strony albo do innego elementu. Przy wiaczonych inteligentnych
liniach pomocniczych mozna utworzy¢ siatke obiektéw na oddzielnej, zablo-
kowanej warstwie, ktére w ten sposéb beda funkcjonowa¢ jako prowadnice.
Linie te s3 wlaczone domysélnie (View > Grids and Guides > Smart Guides albo
Cmd/ Ctrl+U). Ustawienia preferencji dotyczace inteligentnych linii pomoc-
niczych znajduja sie na karcie Guides and Pasteboard (Linie pomocnicze i stét
montazowy) okna preferencji programu.



RYSUNEK 14.19 Skrypt AddGuides automa-

Add Guides At B Top
ekt

™ Bottom
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tycznie tworzy prowadnice obramowujace
wybrany obiekt.

0
() Path Point Horizontal Anchor
([ Path Point Vertical Anchor

Add Guides Around: @ Each Object

iy RYSUNEK 14.20 Preferencje dotyczace
Guides Based On: § Geometric Bounds Smart Guides.
) Visible Bounds
Horizontal Offset: [ - Smart Guide Options
ot # Align to Object Centre {8 Smart Dimensions
84 Align 10 Object Edges 8 Smart Spacing

Dopasowywanie wysokosci kolumny tekstowej

W celu zapewnienia plynnosci czytania tamy powinny by¢ pionowymi blo-

kami tekstu (czyli powinny mie¢ wigksza wysoko$¢, niz szerokosc), za$ przy

stosowaniu siatki linii bazowych ich wysokoéé powinna stanowi¢ catkowita

wielokrotnoéé interlinii tekstu.

Aby ustali¢ wysokos¢ tamu na wielokrotnosé skoku linii bazowych, nalezy

wykona¢ nastepujace czynnosci:

1.

2.

W preferencjach programu wlacz opcje Grids in Back i uaktywnij wyswiet-
lanie siatki linii bazowych (Cmd/ Ctrl+Shift+’).

Przejdz do stron wzorcowych. Kolumna tekstowa niemal zawsze koriczy
sie utamkowa czescia skoku siatki. Powigksz widok dolnej czesci strony
inarysuj prostokatng ramke wypelniajaca ten utamek, aby zmierzy¢ jego

warto$é. Zanotuj wysokos$¢ prostokata (wyéwietlana w palecie sterujacej)

lub zaznacz ja i skopiuj do schowka.

Przejdz do okna dialogowego Layout > Margins and Columns. Wstaw kursor
w polu marginesu dolnego po istniejacej wartosci, po czym wpisz znak +
inastepnie zapamigtang wczesniej wysokosc prostokata, aby zwiekszyé

dolny margines o te wartoé¢.

Kliknij oK. Wysoko$¢ kolumny tekstowej bedzie teraz catkowita wielo-
krotnoscia skoku siatki linii bazowych.

Wyroéwnywanie tekstu do siatki

Skoro udato si¢ nam juz stworzy¢ siatke linii bazowych, mozemy wlaczyé przy-

ciaganie tekstu do tej siatki, wybierajac opcje All Lines (Wszystkie wiersze)
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WSKAZOWKA:

Witryna The Grid System
(thegridsystem.org) jest
doskonatym zrédtem infor-
macji i nauki na wszelkie
tematy zwigzane ze stoso-
waniem siatek.

WSKAZOWKA: Siatki,

co oczywiste, zostaty
wymyslone po to, aby
stuzyty tylko jako linie
pomocnicze w dokumen-
tach, ale moze sie zdarzy¢,
ze bedziemy chcieli wydru-
kowac te linie, na przyktad
w celu zademonstrowania
projektu czy sporzadzenia
instrukgji dla innych uzyt-
kownikéw. Na karcie General
okna dialogowego Print
(Drukowanie) dostepna jest
opcja Print Visible Guides
and Baseline Grids (Drukuj
widoczne linie pomocnicze
i siatki linii bazowych), ktéra
spowoduje wydrukowanie
tych linii, ktére w danym
momencie nie s ukryte.



262 InDesign i tekst  Profesjonalna typografia w Adobe InDesign

WSKAZOWKA: W éwiecie
doskonatym nasi klienci
zaznaczaliby swoje poprawki
redakcyjne elektronicznie

przy uzyciu Adobe Acrobat
albo, jeszcze lepiej, korzystali
zInCopy. W rzeczywistym
Swiecie jednak tacy klienci
stanowg rzadkosc, czesto zas
pojawiaja sie ci, ktérzy swoje
uwagi najchetniej przeka-

zujg przez telefon. W takiej
sytuacji przydatne moze by¢
sporzadzenie umieszczonej

na marginesie strony wzorco-
wej linijki, wskazujgcej numery
wierszy. Linijke taka umiescimy
na oddzielnej warstwie. W ten
sposéb klient moze tatwo
wskazac miejsce, w ktérym
chce dokonaé poprawki, poda-
jac numer strony i wiersza,

€0 znacznie przyspiesza edycje
dokumentu. Gdy publikacja
jest juz gotowa, mozemy albo
usungc warstwe z linijka, albo
po prostu ustawic ja jako nie-
drukowalng. W tym celu nalezy
podwajnie kliknag¢ nazwe war-
stwy w panelu Layers, po czym
usungac zaznaczenie z opcji
Print Layer (Drukuj warstwe).

RYSUNEK 14.22 Dodawanie
niedrukowalnej warstwy na stro-
nie wzorcowej w celu uprosz-
czenia wskazywania probleméw
redakcyjnych.

RYSUNEK 14.21 Dopasowywanie wysokosci kolumny

tekstowej, aby stanowita catkowita wielokrotnos¢ skoku

linii bazowych.,
ostatnia sekcja siatki

aofny margines

na lidcie wyboru Align to Grid (Wyréwnanie do siatki) w sekcji Indents and
Spacing (Wcigcia i odstepy) opcji stylu akapitowego. Mozna réwniez je wlaczy¢
(lub wylaczy¢) lokalnie, uzywajac ikon w palecie sterujacej.

Siatka linii bazowych narzuca rytm dokumentu. W publikacjach, w kté-
rych uzywane sa czcionki o réznych wielkosciach i interliniach, w peini
akceptowalne jest ztamanie tego rytmu poprzez oddzielenie od siatki niekté-
rych elementéw, takich jak tytuly i podtytuly, o ile kolejny fragment tekstu
podstawowego odnajduje wlasciwy takt i znowu dopasowuje sie do siatki,
przywracajac rytm.

Wyréwnywanie do siatki zawsze oznacza przyciagniecie tekstu do nastepnej
pasujacej pozycji, albo méwiac inaczej, zaokraglanie wartoéci interlinii w gére,
nigdy w d6l. Oznacza to, ze jesli na przyklad akapit o wartoéci interlinii 13
punktéw sprébujemy wyréwnac do siatki o skoku 12 punktéw, wynikowa
interlinia wyniesie 24 punkty. Przy wyréwnywaniu do siatki jej ustawienia
zawsze majg wyzszy priorytet niz ustawienia interlinii akapitu.

Moze to stworzy¢ pewien problem, jesli w dokumencie wystepuja akapity
z odmienna wartoscig interlinii, ktérej nie chcieliby$my zaokragla¢ w gére
do najblizszego skoku siatki, badz wtedy, gdy chcemy takiemu akapitowi da¢
nieco dodatkowej przestrzeni ponizej lub ponad nim. W takich sytuacjach
preferowanym rozwigzaniem jest wylaczenie takiego akapitu z przyciagania
do siatki, ale w taki sposéb, aby catkowita przestrzen, ktéra zajmuje (odstep
przed, interlinia i odstep po), stanowita catkowita wielokrotno$¢ skoku siatki,
dzigki czemu kolejny, wyréwnany do siatki akapit bedzie miat przewidywalny
odstep ponad soba. Jesli na przyklad siatka ma skok 12 punktéw, a podtytut
sktadamy czcionkg 14/14, mozemy ten podtytul wytaczy¢ z siatki, a nadmia-
rowe 10 punktéw (24-14) rozdzieli¢ na odstepy przed i po nim.
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Terminologia siatek

Kolumna lub obszar tekstu: Czes¢ strony, na ktérej pojawia sie tekst i inne elementy, wyznaczona przez mar-
ginesy. Siatka uktadu tworzona przez moduty i odstepy znajduje si¢ wewnatrz kolumny tekstowej.

Moduty siatki: Poszczegélne ,komarki” siatki. Im wiecej modutéw zawiera siatka (w granicach rozsadku), tym
jest bardziej elastyczna.

Odstepy: Poziome i pionowe przerwy oddzielajace moduly siatki. Ich szerokosci i wysokosci sa zazwyczaj
rowne wielkosci skoku siatki linii bazowych.

Aktywny naroznik: Lewy gérny rog kazdego modutu siatki, szczegélnie przy uzywaniu tekstu wyréwnanego
do lewej. Nie jest konieczne, aby tekst czy ilustracja catkowicie wypetniaty modut, ale zawarto$¢ powinna
by¢ wyréwnana do lewego gérnego naroznika, aby zachowac integralnosc¢ siatki. Jedynym wyjatkiem od tej
regutly jest sytuacja, gdy tekst petni funkcje podpisu do zdjecia, ale jest umieszczony ponad ilustracjg — w tym
wypadku powinien on zosta¢ wyréwnany do dolnej krawedzi modutu.

Modut siatki

Aktywny |
paroznk

]
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Poziome i pionowe Kolumna tekstowa RYSUNEK 14.23 Elementy
odstepy niestandardoweyj siatki
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RYSUNEK 14.24 Panel Layers
(Warstwy) w 16-stronicowym
biuletynie. Warstwa Text
zostata rozwinieta, ukazujac
elementy w niej zawarte,
Wszystkie te elementy czy
tez ,podwarstwy” to ramki
tekstowe — w panelu warstw
wyswietlane sg poczatkowe
stowa tekstu, Dla innych
obiektéw nazwy okreslaja typ
obiektu albo podaja nazwe
potaczonego pliku graficz-
nego. Te domyéine nazwy
podwarstw mozna zmienic.
Aby zaznaczy¢ element przy
uzyciu panelu Layers, nalezy
klikna¢ kwadracik na prawo
od nazwy podwarstwy. Moze
to by¢ bardzo przydatne, jesli
chcemy zaznaczy¢ obiekt
ukryty gdzies w mrowiu in-
nych albo stanowigcy cze$é¢
grupy.

Warstwy

Dla kogos, kto ma doswiadczenie w pracy z Adobe Photoshop lub Adobe
lllustrator, warstwy w programie InDesign beda czym$ dobrze znajomym.
Warstwy okreslajg sposéb ,pionowego” utozenia obiektéw na stronie. W przy-
kladzie pokazanym na rysunku 14.24 elementy warstwy Text s3 wyswietlane
(i drukowane) ponad dowolnymi elementami z warstw Pictures i Panels. Kazda
warstwa zawiera wlasny, wewnetrzny porzadek obiektéw, ktéry mozna zmienia¢
przy uzyciu poleceri z menu Object > Arrange (Obiekt > Ut6z). Warstwy jednak
ograniczajq dziatanie polecer Bring to Front (Przenie$ na wierzch) i Send to Back
(Przesun pod spéd). W pokazanym przyktadzie obiekt na samej g6rze warstwy
Pictures nadal znajduje sie ponizej obiektu, ktéry zajmuje najnizsza pozycje
w warstwie Text, Jesli w danym miejscu warstwa nie zawiera zadnego obiektu,
widzimy przez nig warstwy potozone nizej.

Warstwy umozliwiaja wyswietlanie i edycje wybranej czesci zawartosci doku-
mentu bez wptywania na inne elementy, co znaczaco przyspiesza prace. Mozemy
na przyktad ukry¢ warstwe Pictures, aby skoncentrowac sie tylko na tekécie lub
odwrotnie. Klikniecie matego kwadracika na prawo od nazwy warstwy powoduje
Zaznaczenie calej zawartosci tej warstwy w obrebie biezacej strony.

W wersji CSs warstwy w panelu mozna ,rozwija¢”, ukazujac ich zawartoé¢ — tak
samo jak w lllustratorze. Utatwia to sprawdzenie i zmiang kolejnosci obiektow
wewnatrz warstwy (wystarczy przeciagnac je mysza w panelu), a takze zazna-
czanie okreslonych obiektéw poprzez klikniecie ich ,kwadracika wyboru”. Jest
to szczegdlnie przydatne, gdy chcemy wybra¢ obiekt bedacy elementem grupy
lub chcemy ukry¢ (lub pokazac) albo zablokowa¢ indywidualne obiekty.

Warstwy przydaja sie réwniez do eliminowania potencjalnych problemoéw
zwigzanych z drukowaniem, ktére mogg wystapic, gdy stosowane s3 efekty
przezroczystosci. W InDesignie przezroczystos¢ (transparency) dotyczy takich
efektow, jak cier), zmigkczanie krawedzi lub dowolny tryb mieszania inny niz
zwykly (Normal) i krycie (opacity) o wartosci réznej od 100%. Przezroczystosc
pojawia sie tez, gdy wstawimy do publikacji obraz programu Photoshop z kana-
tem alfa. Jedli strona zawiera jakikolwiek element z przezroczystoscia, pod jej
ikona w panelu Pages pojawia sie symbol szachownicy. Ma on na celu przypo-
mnie¢ nam o potencjalnych trudnosciach i potrzebie sprawdzenia tych stron
przed wystaniem ich do drukarni. Podczas drukowania dokumentu tekst znajdu-
jacy sie w bliskim sasiedztwie przezroczystych elementéw — na przyklad tekst
oblewajacy wielowarstwowy obraz PSD — moze zostaé zrastrowany, co moze
spowodowad, ze bedzie wygladat ,.pikselowato” lub kanciasto.

Aby unikngc tego problemu, mozemy przenies¢ wszystkie obiekty tekstowe
(z wyjatkiem tych, ktére same uzywaja efektéw przezroczystosci) na najwyzsza
warstwe w dokumencie.
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."""'"", o e B R S RYSUNEK 14.25 Wyréwnywanie
e s S g.% e : tekstu do siatki linii bazowych
| e RETEE T rcertr 0w £ wdefinicji stylu akapitowego (po le-
| I} w“ﬂm : wej) i lokalnie w palecie sterujacej
o:::: T First Line Gnly ! {po prawej).

Opcja First Line Only (Tylko pierwszy wiersz), dostepna na liécie wyboru Align

to Grid w definicji stylu akapitowego (lub jako polecenie w menu palety steruja-
cej), przydaje sie dla podpiséwi innych pomocniczych tekstéw, gdy ich stopien
pismaiinterlinia nie pasuja do ustalonej siatki. Powoduje ona, ze jedynie pierw-
szy wiersz akapitu zostanie przyciagniety do najblizszej pasujacej linii siatki,
dzigki czemu poczatek akapitu bedzie wyréwnany z tekstem w sasiadujacych

tamach. Kolejne wiersze uloza sie zgodnie z zadang wartoécia interlinii.

Dostrajanie réznych wartosci interlinii

Do siatki linii bazowych, nadajacej rytm calemu dokumentowi, powinny réw-

niez dopasowywac sie inne stopnie pisma i interlinie uzywane w dokumencie
(na przykltad w marginaliach lub podpisach). Jednym ze sposobéw osiagniecia

tego celu jest wybranie takich wartoéci interlinii dla marginaliéw i pozosta-

lego pomocniczego tekstu, by dopasowywaly sie przynajmniej do niektérych

Lut e0s que pro volo esectotatur? Everia doles et aut
volore simi, que eostis autem ut aut qui voluptas nectest,
sit eossit et laborisincti odic te voluptatur aut elit, at qui
dolupta speriant. Am et eaquat omnihillit ped que vella-
nis am ent in pro is eos eosam fugitatur suntem ute natur,
commoloriti suntemporis quiae rent unti torum, qui alignis
quid escienis simus mos dolorib erchili busdandis volorunt
eum vilio venim re, velest veliatus estrunt.

Subhead

Ectiae. Tium id quo eius ea ium comnimint ulpa dolorum
accum desequa tionseque re, suntius reptaquae verfere
hentur, consed ma nobit enitae nonsequos ex experum

ad magnimo luptatecus et hicidus es apisquatum etusanis
aruntia iur? Ut quaspit ut molum nobis debit et pra nisciis
dolupid qui cum aspelent.

Lut eos que pro volo esectotatur? Everia doles et aut
volore simi, que eostis autem ut aut qui voluptas nectest,
sit eossit et laborisincti odic te voluptatur aut elit, at qui
dolupta speriant. Am et eaquat omnihillit ped que vella-
nis am ent in pro is eos eosam fugitatur suntem ute natur,
commoloriti suntemporis quiae rent unti torum, qui alignis
quid escienis simus mos dolorib erchili busdandis volorunt
eum vitio venim re, velest veliatus estrunt.

Subhead

Ectiae. Tium id quo efus ea ium comnimint ulpa dolorum
accum desequa tionseque re, suntius reptaquae verfere
hentur, consed ma nobit enitae nonsequos ex experum

ad magnimo luptatecus et hicidus es apisquatum etusanis
aruntia iur? Ut quaspit ut molum nobis debit et pra nisciis
dolupid qui cum aspelent.

WSKAZOWKA: Podczas
transformowania lub
przesuwania ilustracji ramki
graficzne sa przyciagane
do linii siatki, utatwiajac
wiasciwe pozycjonowanie
lub przycinanie obrazéw
zgodnie ze skokiem siatki.
Jesli korzystamy z oblewa-
nia tekstem, odsuniecie
oblewania powinno by¢
réwne lub zblizone do wiel-
kosci interlinii.

WSKAZOWKA: Zdarza

sie, ze podczas tworze-

nia siatki dokumentu
powstanie zbyt wiele nie-
prawidtowo umieszczonych
linii pomocniczych i zamiast
je poprawiaé, prosciej
bytoby zacza¢ od poczatku.
Aby usunac wszystkie linie
pomocnicze, wystarczy klik-
nac jedna z miarek prawym
klawiszem myszy, po czym
wybrac polecenie Delete

All Guides (Usur wszystkie
linie pomocnicze) zmenu
podrecznego.

RYSUNEK 14.26 W przykia-
dzie po lewej podtytut jest
wyrownany do siatki, co po-
woduje, ze caty dodatkowy
odstep (wymuszony wieksza
interlinia tego akapitu) zna-
lazt sie przed nim. Po prawej
podtytut nie ma wyréwnania,
ale ma zdefiniowany dodat-
kowy odstep przed akapitem.
Catkowita przestrzen zajmo-
wana przez podtytut nadal
jest petng wielokrotnoécia
skoku siatki, ale nadmiarowa
przestrzen jest rozdzielona
pomiedzy odstepy przed

i po akapicie.
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RYSUNEK 14.27 Dla tekstu
pomocniczego o mniejszej
wartosci interlinii mozna uzy¢
opcji przyciagania tylko pierw-
szego wiersza do siatki.

RYSUNEK 14.28 Jeéli inter-
linia tekstu pomocniczego
stanowi prosty utamek

(na przyktad 2/3 lub 3) interli-
nii tekstu gtéwnego, przynaj-
mniej niektore wiersze tekstu
pomocniczego dopasuja sie
do siatki linii bazowych, co za-
znaczono grubszymi liniami
na rysunku.

urna vel velit. Integer dignissim vulputare This is supporting text in
Myriad Pro 8/9.The first line
of the paragraph aligns to the
aante ut turpis pulvinar dignissim. Aliquam  grid; thereafter the text will
sync with the grid on every
third line.

clit in posuere. Suspendisse potenti. Donec

mattis rhoncus urna, ecuismod cursus ipsum
porta at. Pellentesque tempor sodales ante
sit amet mollis. Nullam rutrum vestibulum

wierszy gléwnego tekstu, na przyktad co trzeciego lub co czwartego. Jesli inter-
linia tekstu gtéwnego wynosi 13,5 punktu, a interlinia tekstu na marginesie
9 punktéw, linie bazowe obu tekstéw zgodz3 sie co drugi wiersz tekstu gtéw-
nego i co trzeci pomocniczego (13,5 x 2 = 27 = 9 x 3) — nawiasem moéwigc, takie
wiasnie proporcje interlinii stosowane sa w tej ksigzce.

Oto kilka innych przyktadéw par interlinii dla tekstu gléwnego i tekstu
pomocniczego, zapewniajacych ,spotykanie sie” linii bazowych co trzeci lub
co czwarty wiersz tego ostatniego:

12,75/8,5 co trzeci wiersz
B 12/9 co czwarty wiersz
® 11/8,25 co czwarty wiersz

Inng, czgsto spotykang metodg rozwiazania problemu wyréwnania podtytutéw
i zapewnienia im $wiatla jest uzycie potéwkowej siatki linii bazowych, czyli
siatki o skoku ré6wnym potowie wymaganej interlinii. Umozliwi to dodanie
przed podtytulem odstepu réwnego polowie, a nie calej interlinii, przy zacho-
waniu wyréwnania tych podtytuléw do siatki. Oznacza to jednak, ze linie
bazowe utraca zgodnos¢ (register) na sasiadujacych tamach, jesli w ktéryms$
znajdzie si¢ nieparzysta liczba podtytutéw. Ponowna zgodnosé registru pojawi
sig, gdy w kazdym famie wystapi parzysta liczba podtytuléw (zero takze jest
liczbg parzysta!). Mozna réwniez zauwazy¢, ze podwaja to liczbe prowadnic
siatki, co moze utrudnia¢ prace i ogélnie zmniejsza przejrzystos¢ strony, nad

ktéra pracujemy.
sectotatur? Everia doles et aut volore simi, que Lut eos que pro volo esect:
. ; : o : : et aut volore simi, que eos!
i volgptas nectest, sit eossit et laborisincti OdlC VOl OE TRETEST 5 =
\tqui dolupta speriant. Am et eaquat omnihillit v i i

: : : et eaquat omnihillit ped qu
it In prv.:) is eos eosz.am fug1tatu.r sgnte.m ut.e natur, pro i €08 eosam fugitatur
oris quiae rent unti torum qui allgnm quld €8~ commoaloriti suntemporis ¢

qui alignis quid escienis sir
busdandis volorunt eum v

rib erchili busdandis volorunt eum vitio venim re,
. . , . .. bus lor

ua tionseque re, suntius reptaquae verfere hentur,
112,75 7,5/85
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Lut eos que pro volo esectotatur? Everia doles et aut volore
simi, que eostis autem ut aut qui voluptas nectest, sit eossit
et laborisincti odic te voluptatur aut elit, at qui dolupta
speriant. Am et eaquat omuihillit ped que vellanis am ent
in pro is eos eosam fugitatur suntem ute natur, commol-
oriti suntemporis quiae rent unti torum, qui alignis quid -

escienis simus mos dolorib erchili busdandis volorunt eum

vitio venim re, velest veliatus estrunt.

The quick brown fox
Ectiae. Tium id quo eius ea ium comnimint ulpa dolorum

accum desequa tionseque re, suntius reptaquae verfere hen-
tur, consed ma nobit enitae nonsequos ex experum ad mag-

nimo luptatecus et hicidus es apisquatum etusanis aruntia
iur? Ut quaspit ut molum nobis debit et pra nisciis dolupid

facillessi assita quo quam in et litibus aut des molorer ehen-
ist quibusae quam, il ipis moluptam, nonsequi ut aspelitas
dem earionseque dus.

Jumps over the lazydog o
Ut estio eum, cus quissinvent, consequos earitatur sit qui

~solum vendeni hicipsam sa ventemperum quatur? Qui”

sequis sus nis eture, omnimus, totatis ad quos am etur ad
que nem ium nim vendita con porepe in rectur, quiature-
rum nonsequam, simi, temolla boribus expelitios etur, et
lab iureptatem. Nam, volupta dicaepro doluptati optios
molupienis sit, torum doluptatiur suntur molestent ut
fuga. Seceribus, volupta turitat ureperro qui consequo id
moluptatem quidele ctatibus volesti oruntem pelest, cupta
vendam, odipsum inctota qual facia dolloribus, quos es-

Wyréwnywanie obrazéw do goérnej linii pisma

Jesli wyréwnamy gérna krawedz ramki tekstowej do gérnej krawedzi ramki

graficznej, pojawi sie luka pomiedzy wizualnym brzegiem tekstu (linig wersali-

kéw) a brzegiem obrazu, dajac w efekcie wrazenie braku wyréwnania. W istocie

obraz powinien zostaé¢ wyréwnany wlasnie do linii wersalikéw tekstu. Aby

uproscic to zadanie, mozna utworzy¢ prowadnice (linie pomocnicza miarki)

na poziomie linii wersalikéw (albo mediany — wybér zalezy od charakteru

tekstu i zamierzonego efektu, ale powinien by¢ stosowany konsekwentnie)

dla pierwszego wiersza tekstu i dopasowaé ramke graficzna do tej prowadnicy.

Jesli projekt uktadu wymaga wzajemnego dopasowania wielu ramek graficz-

nych do tekstu w réznych miejscach strony, mozna utworzy¢ siatke takich

linii pomocniczych:

Narysuj linie pomocnicza na poziomie linii wersalikéw pierwszego wiersza

1.
tekstu.

2. Wytnij te linie pomocnicza (Cmd/ Ctrl+X) i przejdz na strone wzorcows.

3. Utwérz nowa warstwe dla linii pomocniczych wersalikéw — ciagta widocz-
nos¢ tych linii zbytnio by zakl6cata obraz dokumentu, zatem potrzebna
jest mozliwos¢ wlaczania ich tylko wtedy, gdy beda potrzebne.

4. Wklej linie pomocnicza z zachowaniem pozycji (Cmd+Option+Shift+V/
Ctrl+Alt+Shift+V).

5. Majac zaznaczona linie pomocnicza wybierz polecenie Edit > Step and
Repeat (Cmd+Option+U/ Ctrl+Alt+U) i wpisz liczbe linii, ktére chcesz
utworzy¢ (bedzie ona réwna liczbie skokéw siatki w obrebie kolumny
tekstowej, zmniejszonej o 1), w polu Count (Liczba) i wartos¢ skoku siatki
w polu Vertical Offset (Przesunigcie pionowo).

6.

Na koniec warto zmienié kolor tych linii pomocniczych, aby jednoznacznie
odréznialy sie od pozostalych (a zwlaszcza od réwnolegtlej siatki linii
bazowych). W tym celu zaznacz wszystkie linie pomocnicze na tej war-

stwie: prawym klawiszem myszy kliknij kwadracik na prawo od nazwy

267

RYSUNEK 14.29 Zastosowa-
nie potéwkowego skoku siatki
daje mozliwos¢ zastosowania
potéwkowego odstepu przed
podtytutem, ale sprawia,

2e wiersze w s3siadujacych
famach traca register (co za-
ZNaczono wyszarzeniem

na przykladzie), dopéki takze
w drugim famie nie pojawi sie
podtytut.
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RYSUNEK 14.30 Ciemniejsze
linie oznaczajg linie pomocni-
cze pasujgce do linii wersalikéw
tekstu gtéwnego, powielone

ze skokiern rownym skokowi
siatki linii bazowych. Gérne
krawedzie ramek graficznych
wyréwnywane s3 do tej siatki.

- Guide Options ————
Snap to Zone: 4 | px

RYSUNEK 14.31 Ustawienie
Snap to Zone w preferencjach
okresla dystans, na ktory
trzeba zblizy¢ obiekt do linii
pomaocniczej, aby zadziatat
efekt przyciggania.

warstwy i wybierz Select Items on <nazwa> (Zaznacz elementy na war-
stwie...). Nastepnie uzyj polecenia Layout > Ruler Guides (Uktad > Linie
pomocnicze miarki) i wybierz odmienny kolor prowadnic.

Ramki tekstowe z réznymi siatkami

Oprécz siatki linii bazowych ogélnej dla catego dokumentu mozna utworzy¢
odrebne siatki dla kazdej ramki tekstowej. Rozwigzanie takie moze by¢ sto-
sowane dla marginaliéw, tekstéw pomocniczych lub tekstu towarzyszacego
(komentarza), ktéry réwniez przeplywa przez kilka taméw, ale powinien uzywac
innego stopnia pisma i wielkosci interlinii niz tekst gtéwny. Niestandardowej

Przyciaganie do linii pomocniczych

Caty wysitek wlozony w zaprojektowanie siatek nie zda sie na wiele, jesli nie wia-
czymy opdji Snap to Guides (Przyciagaj do linii pomocniczych), ktéra znajdziemy
wmenu View > Grids and Guides (Widok > Siatki i linie); wiaczenie i wytaczenie tej
opcji mozna réwniez wykonac skrétem klawiszowym Cmd+Shift+;/ Ctrl+Shift+;
($rednik). Jesli opcja jest aktywna, podczas rysowania, przemieszczania lub
przeksztatcania obiektéw ich brzegi sa przyciaggane do najblizszej prowadnicy
lub linii siatki. Aby przyciaganie dziatato, prowadnice musza by¢ wyéwietlane.
Zastrzezenie to nie dotyczy siatki linii bazowych, ktére przyciagaja obiekty bez
wzgledu na to, czy s widoczne, czy nie.

Ustawienie Snap to Zone (Strefa przyciagania) dostepne na karcie Guides and
Pasteboard (Linie pomocnicze i stét montazowy) preferencji programu okreslaja
odlegtos¢ (wyrazona w pikselach ekranowych), w ktérej przyciaganie do pro-
wadnic i linii siatki zaczyna dziata¢.




consectetur auctor odio, vel diéni:sirn dolor
blandit non. Nulla auctor ornare nisl vel

faucibus.

Pracsent pellentesque magna et elit

bibend:

eu nisi ac dolor gﬂvk-ia rutrum eu eu lacus.
In ut diam sodales sem bibendum

volutpat. Morbi nec eros at magna tincidunt

I "d 1 A arcu
Maecenas in mollis mauris. Maecenas
iaculis rempus ligula, non venenaris
risus consectetur a. Ut pulvinar nisi eget
ipsum iaculis cget lobortis tortor aliquet.

wvenenatis. Vestibulum scelerisque leo
eleifend dui viverra clementum. Aenean
wvel erat quationse mos molupta tquiducit
venimint lab ipsus.

Ur, simolor ecatur? Seditac volorem es
pratum, cus, eum dolenimus maionse

Rozdziat 14

Lorem ipsum dolor sit amet,
consectetur adipiscing elit.
In arcu diam, vehicula non
condimentum mollis, sagittis
consectetur justo.
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Text Frame Options
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el dolobore do odicnulput ip vel llamet jure tie i
it Indng Toagiia Ut lndie magna eccn - nonects FnECkllsh seros tekst w wyszarzonym obsza-
ut velent ulluptat non erat. eum quismodip exero dolabor nis nonsequ amcorem volendre  ad te te conullu tpatum erilis rze nie biegnie obok tekstu
gtéwnego, zatem jest dobrym
kandydatem na odmienna,

siatki uzyjemy zatem w takich sytuacjach, w ktérych wazniejsze jest wyréwna-
nie tekstu pomocniczego wzgledem siebie samego, a nie wzgledem sasiadujacego
z nim tekstu gléwnego. Teoretycznie kazda ramka tekstowa moze mie¢ wlasna
siatke linii bazowych, jednak stosowanie zbyt wielu siatek w dokumencie dez-
aktualizuje calg koncepcje siatek: architekture dokumentu oparta na jednolitych,
modularnych jednostkach.

Dzielenie strony w poziomie

W zlozonych ukladach, czesto spotykanych w czasopismach i gazetach, kolumna
tekstowa wymaga modularnego podzielenia nie tylko w pionie (na tamy), ale
iwpoziomie. Sp6jnoéé i elastycznoéé zarazem mozna uzyskaé, tworzac siatke
~wierszy” modultéw, z ktérych kazdy ma okreslona wysokos¢, bedaca catkowita
wielokrotnoscia skoku siatki.

Poziome odstepy pomiedzy modulami powinny by¢ réwne skokowi siatki,
a same moduly réwniez mie¢ wysoko$é¢ wielokrotnoéci skoku. Liczba mozliwych
do utworzenia poziomych paséw moduléw zalezy od catkowitej wysokosci
kolumny tekstowej wyrazonej w skokach siatki. Jak latwo zauwazy¢, nie kazda
kombinacja jest wykonalna. Przykladowo, aby podzieli¢ kolumne na szeéé paséw,
trzeba od jej wysokosci odjaé 5 skokéw siatki (odstepy) i wynik podzieli¢ na 6 —
przy czym chcielibyémy, aby wynik byt liczba catkowita. Zazwyczaj jednak tak
sie nie stanie. W takim przypadku mozna odpowiednio zmodyfikowaé wielkosci
margineséw gérnego i dolnego, aby zwiekszy¢ lub zmniejszy¢ wysokoséé kolumny
tekstowej. Alternatywnie mozna pogodzi¢ sie z faktem, ze jeden pas moduléw
(najwyzszy lub najnizszy) bedzie mial wysokos¢ r6zniaca sie od pozostatych,
jednak réznica ta nie powinna by¢ wieksza niz pojedynczy skok siatki.

Dla przykladu, kolumne tekstowa wysokosci 53 wierszy mozna podzieli¢
na szeé¢ paséw: 53 — 5 = 48. Liczba ta jest podzielna przez 6 i daje 8 wierszy

niestandardowa siatke linii
bazowych. Podpis znajduje
sie w obszarze dziatania siatki
gtéwnego tekstu, ale wy-
réwnany jest tylko pierwszy
wiersz.
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RYSUNEK 14.33 Rozkta-
déwka formatu A4 z kolum-
nami tekstowymi wysokoéci
59 wierszy, podzielonymi

na szes¢ pasow po dziewiec
wierszy kazdy (6 x 9 =54,
do czego trzeba doda¢ s od-
stepdw — razem sg). Wiersze
stanowigce odstepy zostaly
wyrdznione na szaro.

WSKAZOWKA: Aby utwo-
rzy¢ poziomg prowadnice
przebiegajaca przez obie
strony rozktaddéwki, nalezy
przytrzymac klawisz
Cmd/Ctrl podczas jej
przeciagania. Pozycje
prowadnicy mozna okresli¢
precyzyjne, zaznaczajac

ja i wpisujac odpowiednia
wspotrzedna w palecie
sterujacej. W przeciwieri-
stwie do innych obiektéw,
prowadnice majg zawsze
tylko jedna wspoéirzedna:
dla prowadnic poziomych
jest to wspétrzedna y, dla
pionowych — x.

na kazdy modul. Kolumna wysokosci 55 wierszy moze zosta¢ podzielona na 7
paséw: 55 -6 = 49 = 7 x 7 wierszy namodul, albona8:55-7=48=8x6 wierszy
na modul.
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Tworzenie skosnych i krzywoliniowych linii pomocniczych

Adobe InDesign nie oferuje mozliwosci przeksztalcania narysowanych obiektéw
na prowadnice w taki sposob, jak robi to Illustrator, ale nic nie przeszkadza
nam w umieszczeniu ,pomocniczych obiektéw” na oddzielnej warstwie i wyla-
czeniu dla niej opcji drukowania. Alternatywnie mozna zaznaczy¢ pojedyncze
obiekty i uzy¢ panelu Output > Attributes (Wyjscie > Atrybuty), aby nada¢ im
atrybut niedrukowalnosci.



Numeracja stron i zywe paginy

Numery stron, czyli paginy, powinny by¢ umieszczone na stronie wzorcowej

dokumentu, aby byly widoczne na kazdej ,wtasciwej” stronie opartej na tej
stronie wzorcowej. Wprawdzie paginy znajduja si¢ poza obszarem kolumny
tekstowej, jednak musza by¢ do niej dostosowane. Stopien pisma zazwyczaj
jest taki sam lub nieznacznie mniejszy od tekstu gtéwnego. Jesli zastana-
wiamy si¢ nad miejscem, w ktérym powinna znalez¢ sie pagina, dostepne
polozenia to gérny lub dolny margines strony, przy czym lepsza lokalizacja
wydaje sie ktérys z zewnetrznych naroznikéw. Umieszczenie numeréw stron
w obszarze zewnetrznego marginesu zazwyczaj sprawia, ze s3 lepiej widoczne
i utatwiaja przeszukiwanie ksigzki, choé pozycja wyérodkowana réwniez jest
czesto spotykana, poparta dluga tradycja i nie mozna tego wariantu nazwac
niepoprawnym. Za to z pewnoscig mozna to powiedzie¢ o umieszczaniu pagin
w obszarze wewnetrznego marginesu — w tym miejscu sa niewidoczne przy
kartkowaniu ksigzki i w konsekwencji praktycznie bezuzyteczne.

Numer strony czgsto uzupelniony jest o informacje dodatkowe, takie jak
nazwa czasopisma i miesigc publikacji albo tytul rozdziatu. Elementy te czesto
oddziela sie od numeru spacja o stalej szerokosci (firetowa lub pétfiretows).
Na rozkladéwkach uklad pagin na lewej i prawej stronie stanowi odbicie zwier-
ciadlane, tak by numer strony stanowil najbardziej zewnetrzny element.
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RYSUNEK 14.34 Skosne linie
narysowane narzedziem Line,
przeksztatcone w linie pomoc-
nicze poprzez umieszczenie
ich na oddzielnej, niedruko-
walnej warstwie,

WSKAZOWKA: Naciéniecie
Cmd/ Ctrl+Shift+M wstawia
spacje firetowa (em space),
a Cmd/ Ctrl+Shift+N spacje
potfiretowa (en space).
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RYSUNEK 14.35 Wstawianie
numeru strony. Na stronie
wzorcowej bedzie on wyswiet-
lany jako prefiks tej strony: A,
B, Ciitd,; na stronach doku-
mentu w tym miejscu pojawi
sie biezacy numer strony.

Font |
Size > I
Character xT |
Paragraph TRT !
Tabs oRT |
Glyphs NOFn
Story

Character Styles Rl 1210
Paragraph Styles %
Create Qutlines a%0 |
Find Font... |
Change Case >
Type on a Path L
Notes >
Track Changes >
Insert Footnote

Document Footnote Options...

Hyperlinks & Cross-References .
Text Variables »

Bulleted & Numbered Lists >

Insert Special Character

Insert White Space »

Marcers Current Page Number

YYVYRAY

Insert Break Character > Hyphens and Dashes Next Page Number
Fill with Placeholder Text . Quotation Marks Previous Page Number i
Mide Hidden € . Other . Section Marker i

I Footnote Number

Tworzenie lustrzanych pagin

1.

Na lewej stronie wzorcowej narysuj ramke tekstowa wysokoséci okoto jed-
nego wiersza, umieszczajac ja w obszarze dolnego marginesu i nadajac jej

szeroko$¢ réwna szerokosci kolumny tekstowej. Zadanie to mozna sobie

ulatwi¢, rysujac linie pomocnicze pokrywajace si¢ z lewym i prawym

marginesem, ale réwnie dobrze mozna te ramke narysowaé w obszarze

kolumny tekstowej, po czym przesunaé ja w dét.

Wybierz polecenie Type > Insert Special Character > Markers > Current Page

Number (Tekst > Wstaw znak specjalny > Znaczniki > Biezacy numer

strony) albo naci$nij Cmd+Option+Shift+N/ Ctrl+Alt+Shift+B. Uzupelnij

symbol numeru strony o informacje dodatkowe (na przyktad tytut pub-
likacji) i sformatuj odpowiednio znaki powstalego tekstu.

Wybierz opcje Align Away From Spine (Wyréwnaj od grzbietu) i zapisz for-
matowanie paginy jako styl akapitowy.

Aby precyzyjnie umiesci¢ ramke paginy wzgledem kolumny tekstowej,
mozna najpierw podnies¢ ja tak, aby zetknela sie z dolnym marginesem,
po czym wpisa¢ odpowiednia warto$¢ odstepu w pole wspétrzednej y

w palecie sterujacej. Zazwyczaj taki odstep powinien byé réwny wielkosci

skoku siatki linii bazowych lub stanowi¢ jego wielokrotnos¢.



5. Zmien powiekszenie wyswietlania, aby widoczne byty obie strony — mozna
w tym celu uzy¢ polecenia Fit Spread in Window (Zmieé¢ strony widoczne
w oknie) z menu View (Widok) albo nacisnagé Cmd+Option+o/ Ctrl+Alt+o
(zero). Nastepnie przelacz sie na narzedzie Selection i zduplikuyj
ramke na prawa strone, przeciagajac ja z wcidnietymi klawiszami
Option/Alt+Shift. Klawisz Shift powoduje ograniczenie ruchu do kie-
runku poziomego, dzieki czemu kopia ramki znajdzie si¢ na tej samej
wysokosci, co oryginal.

6. Wiersz paginy samoczynnie ustawi si¢ w kierunku zewnetrznego margi-
nesu dzieki ustawieniu wyréwnania, ale konieczne bedzie reczne skory-
gowanie kolejnosci elementéw (tekstu dodatkowego i numeru strony).

Zywe paginy

Zawarto$¢ zywej paginy (nazywanej tez nagtéwkiem lub stopkg, zaleznie od poto-
Zenia na stronie) zmienia sig zaleznie od zwyczajéw panujacych w danym
wydawnictwie i rodzaju publikacji. Jednym z typowych rozwigzan jest umiesz-
czenie na lewej stronie autora, a na prawej tytutu ksigzki lub rozdziatu. Moze
to by¢ przydatne w antologiach czy zbiorach opowiadan réznych autoréw, ale
niepotrzebne w pracy jednego autora. Ostatecznie, ile razy trzeba nam przy-
pominaé imie i nazwisko autora albo tytut ksiagzki, ktéra czytamy?

W pracach, w ktérych zywa pagina znajduje sie u géry strony, czesto umiesz-
cza sie numeracje stron u dotu stron otwierajacych rozdzial, na ktérych pagina
goérna zaktécataby kompozycje tytutu rozdziatu. W takich sytuacjach warto
przygotowac oddzielna strone wzorcowa dla pierwszych stron rozdziatéw.

W ksigzkach podzielonych na czesci lub rozdzialy zywa pagina moze zawie-
ra¢ tytuly i numery tych rozdzialéw. Mozna to latwo osiagnaé, wykorzystujac
zmienne tekstowe:

1. Nalewejlub prawej stronie wzorcowej utwérz ramke tekstowa o szerokosci
kolumny i wysokoéci dostatecznej do pomieszczenia jednego wiersza tekstu,
umieszczong co najmniej o jeden pusty wiersz ponad kolumna tekstowa.

2. Wybierz polecenie Type > Text Variables > Define (Tekst > Zmienne tekstowe >
Zdefiniuj), po czym wybierz Running Header z listy wstepnie zdefinio-
wanych zmiennych i kliknij Edit, aby przejs¢ do opcji zmiennej (patrz
rysunek 14.36).

3. Wpybierz styl akapitowy zawierajacy tekst, ktéry ma sig pojawi¢ w nagtéwku
strony, w razie potrzeby okreslajac dodatkowe opcje, takie jak usuniecie
koricowego znaku interpunkcyjnego lub zmiana wielkoéci liter.

4. Kliknij OK, po czym kliknij Insert (Wstaw), aby umieéci¢ zmienna tekstowa

we wlasnie edytowanej ramce. Na stronie wzorcowej pojawi sie napis
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UWAGA: Wartosci zmien-
nych tekstowych moga

by¢ niekiedy dos¢ diugie,
jednak z logicznego punktu
widzenia stanowia one
pojedynczy symbol i tym
samym nie moga ,zawing¢
sie” do kolejnego wiersza.
To ograniczenie trzeba mie¢
na uwadze przy wybieraniu
stylu akapitowego, ktory
bedzie tworzyt tresc zywej
paginy. Jesli wybrany styl
odpowiada dtugim (wie-
lowierszowym) tytutom,
wynikowa zywa pagina
bedzie bardzo ,5cisnieta”.
W takiej sytuacji mozna
wybrac tworzenie zmiennej
na podstawie stylu zna-
kowego i nadac go kilku
pierwszym wyrazom ,ste-
rujgcego” akapitu — recznie
lub jako styl zagniezdzony
albo styl GREP.
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RYSUNEK 14.36 Definiowanie
zmiennej tekstowej na potrzeby
Zywej paginy

gt ]

wygladajacy podobnie do <Running Header> informujacy o tym, jaka
zmienna jest tu zastosowana, ale nie podajacy faktycznej zawartosci.
Ta pojawi sie dopiero na wlasciwych stronach dokumentu.

Znaczniki podrozdziatéow

Przy pracy z dtugimi dokumentami, podzielonymi na liczne czgéci, znaczniki
podrozdzialéw moga by¢ pomocne w upraszczaniu projektu dzieki znacznej
redukdji liczby potrzebnych stron wzorcowych lub odrebnych dokumentéw.
Moga postuzy¢ do zaznaczania granic dzialéw w czasopismach albo czesci
ksiazki — wszedzie tam, gdzie tres¢ dokumentu daje sig rozdzieli¢ na wyraznie
odrgbne fragmenty. Kazdy podrozdzial moze uzywaé oddzielnego schematu
numerowania stron — cyframi arabskimi, rzymskimi lub literami. Kazdy moze
miec¢ wlasny numer poczatkowy, niekoniecznie stanowiacy kontynuacje nume-
réw z poprzedniej czesci. Dodatkowo podrozdzialowi mozna przypisaé znacznik
(tytul), ktérego mozna uzyé w tekscie lub na stronach wzorcowych, podobnie
jak zmiennych tekstowych.

1. Utworz ramke tekstowa w czesci pagin na stronie wzorcowej.

2. Kliknij prawym klawiszem myszyiwybierz Insert Special Character > Markers
> Section Marker (Wstaw znak specjalny > Znaczniki > Znacznik podroz-
dzialu) z menu podrecznego. W ramce tekstowej pojawi sie stowo Section
(Podrozdzial).

3. Sformatuj znacznik zgodnie z potrzebami.
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RYSUNEK 14.37 Znacznik
podrozdziatu (section) wsta-
wiony na stronie wzorcowej
(A), nastepnie zdefiniowany
na odpowiedniej stronie do-
kumentu (B). Bedzie on wig-
czony" az do zdefiniowania
kolejnego podrozdziatu (C).

A

i
What's On

| 1) Same as Previcas Document in the Book
Book Name: NJA

4. Aby ,uaktywni¢” znacznik podrozdzialu na stronie dokumentu, w panelu
Pages zaznacz strone, na ktérej ma sie rozpoczaé nowy podrozdzial,
po czym wybierz polecenie Numbering and Section Options (Numeracja
i opcje sekcji') z menu panelu. Wpisz nazwe podrozdziatu w polu Section
Marker (Znacznik podrozdziatu) i kliknij OK. Wpisana nazwa pojawi sie
na wszystkich stronach uzywajacych danej strony wzorcowej az do miejsca
zdefiniowania nowego podrozdziatu.

1 W polskiej wersji interfejsu uzytkownika mamy tu btad thtumaczenia — oczywiscie
powinno by¢,Opcje numeracji i podrozdzialéw”, zgodnie z terminologia uzywana
w innych miejscach programu.
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ATypl. http://www.atypi.org

Before & After. http://www.bamagazine.com

Computer Arts. http://www.computerarts.co.uk/home

CreativePro.com. http://www.creativepro.com/topic/fonts

Design Police. http://www.design-police.org

FFFFOUND! http://ffffound.com

InDesign Magazine. http://www.indesignmag.com

InDesignSecrets. http://indesignsecrets.com
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Lynda.com. http://www.lynda.com
Microsoft typography.
http://www.microsoft.com/typography/links/default.aspx
P22 Terminal. http://www.p22.com/terminal/toc.html
pass4press. http://www.passqpress.com
Pentagram — What type are you?
http://www.pentagram.com/what-type-are-you/
Periodic Table of Typefaces.
http://www.behance.net/Gallery/ Periodic-Table-of-Typefaces/193759
The Grid System. http://www.thegridsystem.org
Learn: Anatomy of a Typeface.
http://typedia.com/learn/only/anatomy-of-a-typeface/
Typobituaries.
http://www. danielmall.com/archives/2006/08/22/typobituaries.php
typoGRAPHIC. http://www.rsub.com/typographic/timeline/
Typophile. http://typophile.com
Veer. http://www.veer.com
WhatTheFont! http://new.myfonts.com/WhatTheFont/
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A
Adobe Bridge 26, 28
Adobe InCopy 23, 262
Adobe InDesign. Zobacz InDesign
Adobe Paragraph Composer 82, 120-122
Adobe Type Library 45
Adobe Western 2, zestaw znakéw 102
akapitowe style 195-197. Zobacz takze style
[Basic Paragraph] 22,193
opisane 192
przestoniecia lokalne 196-199, 213
stosowanie 195-198
ustawienia justowania 118
wartoéci interlinii 72-74
wpuszczone inicjaly 182-183
akapity
formatowanie. Zobacz formatowanie
Keep Options 83, 155-157
linie 214-215
No Break, atrybut 83, 85, 144, 152-154
odstepy pomiedzy 12, 138-140
otwierajace 208
style. Zobacz akapitowe style
wcinanie 132-138
akcenty 100, 103
aktywny naroznik 260-261
apostrofy 93
arkusze kalkulacyjne 161, 163, 167
arkusze stylow 192-195, 206-210. Zobacz takze
style
ASCII 92,102
Auto Leading 71-72
automatyczna inspekcja wstepna. Zobacz Live
Preflight, funkcja

B

bezszeryfowe kroje pisma 4-5, 7
bekarty 73, 79-85, 155-157

bis (double prime) 92

Book, funkcja 209

Bridge 26, 28
brzuszek 4

C

cal, znak 92-93

CamelCase 53

Character Formats, widok 15-16
Character Viewer, Mac OS X 104
choragiewka, wyréwnanie 115, 117,123, 125
CID, fonty 100

Control Panel 15-16

Convert Direction Point, narzedzie 233
cudzystowy 92-93, 127

cyfrowa kreska 95

cytat wyciggniety 210

czcionki. Zobacz fonty; tekst; kroje pisma

D

Delete Anchor Point, narzedzie 233

diakrytyczne znaki 100

Dingbats 9, 97

Direct Selection, narzedzie 233

dokumenty. Zobacz takze strony
inspekcja wstepna 26
konfigurowanie 242-250
podrozdzialy 274-275
poruszanie sie po 16-18
wielojezyczne 148
wys$wietlanie 16-18
wzorcowe 209, 254

dolny indeks 54-55, 105

dwukropek 92-93

dyftongi 106-107

dywizy 58, 93, 95, 116, 142-152

dzielenie wyrazéw 117, 120, 125, 142-152

E

Edytor watkéw. Zobacz Story Editor
ekran 244, 246

elementy budujace znaki 4
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Euro, symbol 105
Expert Set 53

F
Fast Display, tryb 18
firetowa spacja 13, 98, 173, 271
fleurons 109
FontLab Studio 13
fonty. Zobacz takze tekst; kroje pisma
bezszeryfowe 4-5,7
brakujgce 211
CID 100
Dingbats 9
domyélne 22
ekranowe 9
Euro 105
jednorejestrowe 50-51
miedzyplatformowe 102-203
multiple master 105, 111
OpenType 45, 58, 103, 106, 203
opisane 4
PostScript 104, 105
rysunkowe 9
style 46-48
symbol 9
szeryfowe 4-5
TrueType 45,104, 105
Type 1 45,100, 105, 203
Unicode 102-105
wielko$é. Zobacz stopien pisma
zmienianie 45
Formatowanie akapitéw. Zobacz Paragraph
Formats, widok
Formatowanie znakéw. Zobacz Character Formats,
widok
formatowanie. Zobacz takze style
akapitéw 15-16
lokalne 196-198, 213
tekstu 15-16, 45-58, 106, 192
znakéw 15-16, 45-58, 106, 192

G
glify
kontra znaki 101
pozycjonowanie 58
skalowanie 118-120
wyszukiwanie i zastepowanie 103
Glyphs, panel 100-102, 104
gérny indeks 54-55, 105
graficzne ramki 36, 72, 228-229, 236, 267
grafika w wierszu 72, 97
grafiki
oblewanie tekstem 227-238
pozycjonowanie 264
uwarunkowania 242
w tabelach 168-169
w wierszu 72, 97
wyréwnywanie 267-268
GREP Queries 39
GREP, style 85, 154, 220-222
Grid System 260
Gridify, funkcja 259-260

H

H&J Violations 120, 122, 151

Hand, narzedzie 13-14, 16, 18

Hex Input, uklad klawiatury (Mac OS X) 103

|
ibez kropki (dotless i) 106-107
ilustracyjne kroje pisma 9
importowanie elementéw formatujacych
style 199, 201, 211-213
tabele 161-162
tekst 22, 23, 36-37
z programu Word 36-37
InCopy 23, 262
InDesign
opcje/preferencje 11-16
podstawy typografii 2
InDesign, dokumenty. Zobacz dokumenty
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informacje o ilustracji 210

inicjaly wpuszczone 179-190

inspekcja wstepna 26

interlinia 11-12, 63-74, 265-267

interlinia automatyczna. Zobacz Auto Leading
interpunkcja 92-94, 127

J
jednorejestrowe kroje pisma 50-51
jednostki miarek 12
justowanie
dodatkowe opcje 125-126
kontra wyréwnanie do lewej 116
niedzielgce spacje 99-100
oblewanie tekstem 228, 230, 234
pelne justowanie 115, 126
pionowe 73, 128-129
poziome 117-122, 125-126
tekst wyréwnany do lewej 117-122, 126
tekst wyréwnany do prawej 125-126

K

kaligraficzne znaki 109

kanaliki 81-85

Keep Options 83, 155-157

kerning 12-13, 78-90, 184-185
Zobacz takze $wiatto

klawiszowe skréty. Zobacz skréty

kolizje znakéw 106

kolor 67, 69, 120

kolumna tekstowa 71, 245-246, 248, 260, 262

kontekstowe odmiany 111

koncowe formy 109

konicowe znaki 109

krawedziowe odstepy 138

kreska pionowa 4

kreski poziome 95-97

kroje pisma. Zobacz takze fonty; tekst
bezszeryfowe 4-5,7
charakterystyka 68-71

dekoracyjne 7
historyczne konotacje 2-3, 203
identyfikowanie 45
klasyfikowanie 4-11
laczenie 203-206
opisane 4
pisanki 6
przejiciowe 6
stalopozycyjne 8
szeryfowe 4-5
terminologia 2, 4-5
uwarunkowania 2-4, 203
zwezone / poszerzone 58

ksztalty 36, 233

kursor 22, 24, 25

kursywa 46-47

L

ligatury 106-107

linia bazowa 4

linie akapitowe 214-215

listy 172-176, 220

litery. Zobacz znaki

Live Preflight, funkcja 26

lokalne formatowanie 196-198, 213

lozenge, linia 215

lamy
balans 73,129
dzielenie 32-33
interlinia 73
liczba 252, 255
marginesy 250, 252-253
odstepy miedzytamowe 12, 64, 66, 251, 260
rozciaganie 29-33, 215
szeroko$é. Zobacz szerokoéé tamu
ustawianie 250-253
watkowane ramki 28-37
wcinanie 134
wyréwnanie 94, 119, 126-129
wysokosé 262



M
Mac OS 99, 102-104
MakeGrid, skrypt 260
marginalia 210
marginesy
lustrzane paginy 272-273
lamy 250, 252-253
strony widzace 243, 249
ustalanie wielkodci 247-248
wielkodé 12, 248-249, 252
wyréwnywanie 93-94, 150, 182
maszyny do pisania 55, 99
matematyczne réwnania 54, 57
mediana (linia $rodkowa pisma) 4
metryczny kerning 86-90
Microsoft Word
importowanie styléw z 211-213
importowanie tekstuz 36-37
migdzyznakowe odstepy 76-78, 118-119
Mini Bridge 26, 28
miniatury 19, 33-35
minus, znak 95
mnozenia, znak 105

N
nagléwki tabel 273-274

Naruszenia dzielenia wyrazéw i justowania.

Zobacz H&J Violations
Narzedzia. Zobacz Tools, panel
naukowa notacja 54
nautyczne (tekstowe) cyfry 109-111
niedzielagce spacje 99-100, 152-154
nieumieszczony tekst 24, 26, 39
No Break, atrybut 83, 85, 144, 152-154
numerowane listy 172-176, 220
numery

indeks gérny/dolny 54-55

stron 248, 249, 271-272

utamki 54, 57
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(0]
obiekty
oblewanie tekstem 74, 227-238
prowadnice 271
przyciaganie do 259-260
siatki 253-260
style 192, 222-225
wyciggniety cytat 222-223
zakotwiczone 223-225, 238
oblewanie tekstem 74, 169, 227-238
obrazy. Zobacz grafiki
obszar roboczy, dostosowywanie 18-21
odciecia, §ciezki 231-232
odsadka 119
odstepéw, znaki 98-100
odstepy. Zobacz takze miedzyznakowe odstepy
miedzy akapitami 12, 138-140
miedzy wierszami 11-12, 63-74
miedzy wyrazami 67, 76-85, 118-120
miedzy znakami 76-78, 118, 119
niedzielace spacje 99-100, 152-154
podwdjne spacje 99
problemy 120-122
spacja cienka 97-98, 100
spacja cyfrowa 100, 159
spacja firetowa i pélfiretowa 13, 97-98, 173, 271
spacja interpunkcyjna 100
spacja justujagca 98-99
spacja wlosowa 98
usuwanie nadmiarowych spacji 40, 99
w parach liter 76-77, 86, 89-90
wiersze jako 138-140
znakéw 13, 81,120
odstepy miedzylamowe 12, 64, 66, 251, 260
oko (punca) 4
Opcje przenoszenia. Zobacz Keep Options
OpenType, fonty 45, 58, 103, 106, 203
Optical Margin Alignment 93-94, 150, 182
optyczne wielkosci 111
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Optyczne wyréwnanie margineséw. Zobacz
Optical Margin Alignment

optyczny kerning 86-88

ornamenty 8, 109

P
Pages, panel 18-19, 249, 252, 254, 263
paginy 248, 253, 271-273
Paleta sterujaca. Zobacz Control Panel
panele, porzagdkowanie 18-21
Paragraph Composer 82
Paragraph Formats, widok 15-16
pary liter 76-77, 85-90
pauzy 95-97
Pen, narzedzie 233
pica, jednostka 12-13
pilcrow 69, 134
pionowe wyréwnanie 73, 128-129
Piéro. Zobacz Pen, narzedzie
pisanki, kroje pisma 6
pliki. Zobacz dokumenty
pochylenie osi pisma 4
poczatkowe wersaliki 180-181, 187-189
podciecia 134, 172
zlewej 135
podkresdlanie 55-56
podpisy 50, 58, 208, 222-223
podreczniki stylu 93
podswietlanie tekstu 56
podtytuty 50, 139-140, 207, 265
podziatu, znaki 152, 154-155
pola siatki 254, 260-261
Pomin wedtug interlinii. Zobacz Skip by Leading,
opcja
porzadkowe liczebniki 54
PostScriptowe fonty 104-105
poszarpany ksztalt 116-117
powiekszanie i pomniejszanie widoku 16, 18
polfiretowa spacja 13, 97-98, 271
pélpauzy 95

prawe strony (recto) 155, 249, 273

prim 92

prostokatne ramki 36

prowadnice 23-34, 257-260, 271

prowadnice miarek 258-259, 264, 267

przekreslony tekst 56

Przeksztalcanie punktéw kierunkowych. Zobacz
Convert Direction Point, narzedzie

przeplyw tekstu 23-28

przesuniecie linii bazowej 12, 56-58

przezroczystodé 215, 235, 263

przyciaganie do obiektéw 259-260

przyciaganie do prowadnic 23, 268

przypisy 55

punca. Zobacz oko

punkt zakotwiczenia 231-233, 236-237

punkty 12-13, 71

Q
Quark 86, 235
Quick Apply 197-198, 201

R

ramki. Zobacz takze tekstowe ramki
graficzne/obrazkowe 36, 72, 228-229, 236, 267
polaczone 25
prostokatne 36

Raczka. Zobacz Hand, narzedzie

reglets 63

rozdzielczosé¢ 18, 212

réwnania 54

RTF, pliki 174-176

S
Selection, narzedzie 13-14, 25, 233
siatki 253-271
dokumentu 256
lini bazowych 73, 253, 256, 262, 264-269
obiektéw 258-260
opisane 253



preferencje 256-261
uwarunkowania 253-255
wyréwnywanie 74, 256-257, 264-265
siatki linii bazowych 73, 253, 256, 262, 264-269
skala liniowa 262
skala stopni pisma 49
skalowanie gliféw 118-120
skalowanie tekstu 48-49
Skip by Leading, opcja 74
skoki klawiaturowe 12
skréty
ladowanie niestandardowego obszaru
roboczego 18, 20-21
panel Tools 14
powigkszanie i pomniejszanie widoku 16, 18

przechodzenie pomiedzy polami w palecie 15

przelaczanie pomiedzy narzedziem Selection
i Type 14
przesunigcie linii bazowej 56-58
skoki klawiaturowe 12
stosowanie styléw 195-196
style GREP 220
ukrywanie i wyswietlanie paneli 18
wcinanie akapitéw 132
wklejanie tekstu 34
wymiarowanie i skalowanie tekstu 48-49
wyréwnywanie 115
wyszukiwania i zastepowania 103, 138, 220
wys$wietlanie znakéw ukrytych 41
zaznaczanie tekstu 44
zmiany rejestru (wielkosci liter) 52
skrypty 40, 259
stowa. Zobacz takze tekst
dzielenie 142-152
No Break, atrybut 83, 85, 144, 152-154
odstepy pomiedzy 67, 76-85, 118-120
stowniki 92, 142, 148-151
slowniki uzytkownika 148-150
Smart Cursor 22
Smart Guides 259-260

Indeks

spacja interpunkcyjna 100
specjalne znaki 35, 97, 100, 103
stopien pisma 9, 11, 48-50
automatyczna interlinia 71-72
ekranowe 50
interlinia 64-65, 71
optyczne wielkoéci 111
picaipunkty 12-13
preferencje 12
skréty klawiaturowe 48-49
typowe wielkoéci 50
uwarunkowania 9, 11, 13
wskazéwki 50
wyséwietlanie ,prawdziwych” wielkosci 49
zmienianie 12, 48-49
Story Editor 37-39, 170, 196
Strony, panel. Zobacz Pages, panel
strony. Zobacz takze dokumenty
dzielenie na rzedy 269
lustrzane 249, 272-273
numery 248-249, 271-272
orientacja 242, 246-247
poruszanie sie pomiedzy 16, 18
powiekszanie i pomniejszanie widoku 16, 18
widzace 18, 243, 249-250
wielkosé 242-247
wyswietlanie 16-18
wzorcowe 199, 254, 262, 271, 274
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style 191-226. Zobacz takze formatowanie; arkusze

styléw

akapitowe. Zobacz akapitowe style
domyslne 202

edytowanie 198-199

fonty 46-48

funkcja Book 209

GREP 85, 154, 220-222
importowanie 199, 201, 211-213
korzysciz 192-193

lokalne formatowanie 196-198, 213
ladowanie z innych dokumentéw 199-201
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style (cd.)
taczenie roznych krojéw 203-206
nazwy 195, 198, 201
nieuzywane 202
obiektowe 192, 222-225
oparte na istniejacych stylach 194-195
porzadkowanie 201-202
powtarzanie 220
przedefiniowywanie 198-199
przestoniecia lokalne 196-199, 213
Quick Apply 197-198
sekwencje 214-216
skréty 195-196, 220
sortowanie 201
stosowanie 195-198, 214
tabelowe 192, 225-226
terminologia 192
tworzenie 193-195
zagniezdzone 217-220
znakowe 197, 210-214
symbole 57, 97, 100
symbole, kroje pisma 9
systemy miar 13
szeroko$¢ tamu
interlinia 64, 66-67
nieréwne 253
stala 252-253
uwarunkowania 12, 62, 215, 250-251
szeryfowe kroje pisma 4-5
szewce 72, 79-85, 155
Szybkie stosowanie. Zobacz Quick Apply
Szybkie wyswietlanie. Zobacz Fast Display, tryb
$rédtytuly 139-140, 207, 210, 220
$wiatlo 12-13, 76-85, 88. Zobacz takze kerning

T
tabele
korzystanie z 158-172
style 20, 225-226

tabulatory 176-178
tekst glowny 50, 64, 72, 206, 208
Tekst, narzedzie. Zobacz Type, narzedzie
tekst. Zobacz takze fonty; kroje pisma
bekarty i szewce 73, 79-85
centrowanie 115, 122-123, 126, 128
czyszczenie 39-41
dzielenie stéw 117, 120, 125, 142-152
formatowanie. Zobacz formatowanie
gléwny 50, 64, 72, 206, 208
importowanie 22-23, 36-37
interlinia 11-12, 63-74
Keep Options 83, 155-157
kerning 13, 78-90, 184-185
kolor 67 69, 120
konwertowanie na tabele 161
kopiowanie i wklejanie 34-36
modyfikowanie 25, 37
nieumieszczony 24, 26, 39
No Break, atrybut 83, 85, 144, 152-154
oblewanie 74, 169, 227-238
odstepy. Zobacz odstepy
podswietlanie 56
powiekszanie i pomniejszanie widoku 16, 18
przeciaganie i upuszczanie 26-28
przeplyw 23-28
skalowanie 48-49
style. Zobacz style
szerokoé¢ 215
$wiatlo 12, 13, 76-85, 88
umieszczanie 23, 24, 26, 35
wielko$¢. Zobacz stopieri pisma
wyjustowany 67, 82, 116, 142, 145, 151
wyréwnywanie. Zobacz wyréwnanie tekstu
zastepczy 33-34
zaznaczanie 44
zmienianie rejestru. Zobacz zmienianie
rejestru
zrastrowany 18



tekstowe ramki. Zobacz takze ramki
edytowanie tekstuw 25, 37
przelewanie tekstu w 23-28
przesuwanie 25
skalowanie 49
tworzenie 22
usuwanie 28
usuwanie tekstuz 29
watkowanie 28-37
wymiarowanie 25
tekstowy kursor 22
tla 67,172, 231
Tools, panel 13-14
TrueType, fonty 45, 104-105
trzon. Zobacz kreska pionowa
Type 1, fonty 45, 100, 105, 203
Type, narzedzie 13-14
typografia
asymetryczna 117
poczatki 1-21
przeglad 2-4
wielojezyczna 103
wzgledne jednostki 13
typograficzne cudzyslowy 92
typograficzne ornamenty 8, 109
typograficzny obszar roboczy 18-21
tytulowa czcionka 50, 58
tytulowe odmiany 111
tytulowe znaki 111
tytuly 58

U

Ukladacz akapitowy Adobe. Zobacz Adobe
Paragraph Composer

ukryte warstwy 235

ukryte znaki 41, 69, 155

ultamki 54, 57, 104

umieszczanie tekstu 22, 23, 24, 26, 35

Unicode 100, 102-105

Indeks 287

Usun punkt kontrolny. Zobacz Delete Anchor
Point, narzedzie

w
waluty, symbole 57, 100, 105
warstwy 235, 262-263
watki 22, 29,44, 176
watkowanie ramek tekstowych 28-37
wcinanie akapitéw 131-138
wdowa, wiersz 79-85
wektorowe ksztatty 233
wielojezyczne dokumenty 148
wielokropki 97, 100
wiersze
dzielenie. Zobacz podzialy wierszy
Keep Options 83, 155-157
odstepy pomiedzy 11-12, 63-74
uzywane do rozmieszczania 138-140
wdowy 79-85
zagniezdzone style 220
Windows, systemy 99, 102-103, 104
wklejanie tekstu 34-36
wlamany tytul 207, 220
Word. Zobacz Microsoft Word
wspdlczynnik proporcji 242, 244-246
wyciggniety cytat 210, 222-223
wydluzenia dolne 4, 51, 64, 69, 74
wydluzenia gérne 4, 51, 64, 69
wyjustowany tekst 67, 82, 116, 142, 145, 151
wypunktowane listy 172-174
wyréwnanie tekstu 113-129
Adobe Paragraph Composer 120-122
choragiewka 115, 117,123, 125
do dotu 128
do géry 127-128
do lewej 115-117
do prawej 115,125
inicjaléw wpuszczonych 182, 183-185
list 173-176



wyréwnanie tekstu (cd.)
tamoéw 94, 119, 126-129
margineséw 93-94, 150, 182
obrazéw 267-268
optyczne 94
pionowe 73,127-129
poziome 115-127
skréty 115
tabel 158-159, 167
tabulatory 176-178
tekstu do siatki 74, 256-257, 264-265
wycentrowane 115,122-123, 126, 128
wyjustowane. Zobacz wyjustowany tekst
zawieszonych znakéw przestankowych 127
wyréwnywanie cyfr 109-111
wysokosé wersalikéw 4, 207
wysokosé x 4, 68-69, 207
wyszukiwanie i zastgpowanie 40, 99, 103, 138, 220
wytluszczony tekst 47-48
wzorcowe dokumenty 209, 254
wzorcowe strony 199, 254, 262, 271, 274

z

zakotwiczone obiekty 223-225, 237

zamiana na wielkie litery
inicjaty wpuszczone 179-190
kapitaliki 51, 53-54, 186-187
mate/wielkie litery 50-54
poczatkowe wersaliki 180-181, 187, 188-189
wersaliki 51, 52, 69-71, 78

Zapf Dingbats 97

Zapytania GREP. Zobacz GREP Queries

zastepczy tekst 33-34

zawieszone znaki przestankowe 127

Zaznaczanie bezposrednie. Zobacz Direct
Selection, narzedzie

Zaznaczanie, narzedzie. Zobacz Selection,
narzedzie

zdefiniowane formaty 244
zestawy gliféw 101- 102
zlamania wiersza
atrybut No Break 83, 85, 144, 152-154
i ,brzydkie brzegi” 116
i Adobe Paragraph Composer 120-122
i tekst wycentrowany 123
miekkie 155
wymuszone 41, 99, 123, 147-148, 154
zmienianie rejestru 50-53
znaczniki podrozdzialéw 274-275
znaki
alternatywne 111
formatowanie 15-16, 45-58, 106, 192
indeks gérny/dolny 54-55
kaligraficzne 109
kerning 12-13, 78-90, 184-185
kontra glify 101
kornicowe 109
Mac OS 104
odstepu 98-100
odstepy 13, 81,120
Zobacz takze miedzyznakowe odstepy
podziatu 152, 154-155
prim 92
specjalne 35, 97, 100, 103
style. Zobacz style
szeroko$é 13, 46
tytulowe 111
ukryte 41, 69, 155
Unicode 100, 102-105
Windows 104
znaki akapitu 69, 134, 138
znaki cytowania 92
znaki korica 97-98
znaki prim 93
zrastrowany tekst 18
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dﬁ dobe InDesign stal sie wiodacym narzedziem projektowania

i sktadu publikacji, w duzej mierze dzieki jego wyrafinowanym, cho¢
nadal przyjaznym dla uzytkownika funkcjom zapewniajacym kon-
trole nad wszelkimi aspektami typografii — zaréwno w skali global-
nej, jak i mikro. Uaktualnione wydanie swojej ksiazki Nigel French
poswiecit wytacznie funkcjom typograficznym Adobe InDesign,
udostepniajac przeglad ogromnych mozliwosci ksztattowania
tekstu, poczynajac od podstawowych funkcji formatowania znakow,
a konczac na wykorzystaniu siatek do projektowania ztozonych
uktadow, typowych dla czasopism i gazet. Dzieki przyktadom prak-
tycznym, licznym wskazéwkom i bogactwu ilustracji, InDesign i tekst
przedstawia zasady tworzenia mozliwie najlepszego wygladu tekstu
w mozliwie najprostszy i efektywny sposéb, stanowiac cenne zrodio
informacji dla kazdego, kto chce udoskonali¢ tworzone przez siebie
publikacje, pracujac w Adobe InDesign.

® Omowienie mozliwosci typograficznych oferowanych przez
Adobe InDesign

® Przedstawienie nowych funkcji dostepnych w InDesign CS5

® Przejrzyste i przekonujace wyjasnienia, jak i dlaczego warto
tworzyc dobra typografie

ADOBE www.adobepress.com
PRESS Poziom:Dla poczatkujacych

Srednio zaawansowanych

"‘ Kategoria: Projektowanie graficzne / Typogr.

Dotyczy: Adobe InDesign CS5
Adobe dia Microsoft Windows i Mac 05 X

Projekt oklyeki: Aren Howell

www.novatech.com.pl

JEDYNE MIEJSCE W POLSCE GDZIE KUPISZ
WSZYSTKIE KSIAZKI MICROSOFTZPRESS

' INOVATECH, N

«InDesign i tekst to niezbedna pomoc

dla kazdego, kto pracuje z tekstem.
Przyjazny ton i styl autora pozwala
tatwo przyswoic sobie podstawy
sztuki typograficznej, jednoczesnie
ukazujgc sposoby postugiwania sj€
catym bogactwem funkcji oferowa“
nych przez program.”

- Michael Ninnes; byly' menedzer

produktu AdobeInDesign,

VP w dzjédzipie tresci portalu

Lyndd.com

Nigel French jest projektantem
graficznym, fotografikiem i wyktadowca
w dziedzinie grafiki komputerowej

i typografii, zamieszkatym w Brighton,
w Anglii.
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